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Welcome!
This is the Operation Manual for Steinberg’s Nuendo. 
Here you will find detailed information about all the fea-
tures and functions in the program. 

About the program versions
The documentation covers two different operating systems 
or “platforms”; Windows and Mac OS X. 

Some features and settings are specific to one of the plat-
forms. This is clearly stated in the applicable cases. In 
other words:

If nothing else is said, all descriptions and procedures 
in the documentation are valid for both Windows and Mac 
OS X. 

The screenshots are taken from the Windows version of 
Nuendo.

About the Nuendo Expansion Kit
The Nuendo Expansion Kit adds a number of music com-
position functions from Steinberg’s Cubase (the “Cubase 
Music Tools”) to the standard Nuendo application. The 
Nuendo Expansion Kit (NEK) is a separate product and 
can be purchased through your Steinberg dealer.

Whenever procedures in this manual use functions avail-
able only when the NEK is installed, this is indicated in the 
text by “Nuendo Expansion Kit only”.

Key command conventions
Many of the default key commands in Nuendo use modi-
fier keys, some of which are different depending on the 
operating system. For example, the default key command 
for Undo is [Ctrl]-[Z] under Windows and [Command]-[Z] 
under Mac OS X.

When key commands with modifier keys are described in 
this manual, they are shown with the Windows modifier 
key first, in the following way:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means “press [Ctrl] 
under Windows or [Command] under Mac OS X, then 
press [Z]”. 

Similarly, [Alt]/[Option]-[X] means “press [Alt] under Win-
dows or [Option] under Mac OS X, then press [X]”.

Please note that this manual often refers to right-click-
ing, for example, to open context menus. If you are using a 
Mac with a single-button mouse, hold down [Ctrl] and click.
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2
System requirements and installation



About this chapter
This chapter describes the requirements and installation 
procedures for the Windows version and the Mac version 
of Nuendo. 

Minimum requirements
To use Nuendo, your computer must meet the following 
minimum requirements:

Windows
• Windows XP (Home or Professional, Service Pack 2, 32-bit), 

or Windows Vista (32-bit and 64-bit), or Windows 7 (32-bit 
and 64-bit)

• 2 GHz processor (Dual Core processor recommended)
• 1024 MB RAM
• Windows DirectX compatible audio hardware; ASIO compati-

ble audio hardware recommended for low latency performance.
• Display resolution of 1280x800 pixels recommended
• 4 GB of free hard disk space
• QuickTime 7.1 and video card supporting OpenGL 1.2 

(OpenGL 2.0 recommended) required for video playback
• USB-eLicenser and USB component connector
• DVD ROM drive required for installation
• Internet connection required for license activation

Macintosh
• Mac OS X 10.5.8 or 10.6
• Intel Core processor (Intel Core Duo recommended)
• 1024 MB RAM
• CoreAudio compatible audio hardware
• Display resolution of 1280x800 pixels
• 4 GB of free hard disk space
• QuickTime 7.1 and video card supporting OpenGL 1.2 

(OpenGL 2.0 recommended) required for video playback
• USB-eLicenser and USB component connector
• DVD ROM drive required for installation
• Internet connection required for license activation

General notes on how to set up your system

• RAM – There is a direct relation between the amount of 
available RAM and the number of audio channels that you 
can have running. 
The amount of RAM specified above is the minimum requirement, but as 
a general rule “the more the better” applies (see also “RAM” on page 
24).

• Hard disk size – The size of the hard disk determines 
how many minutes of audio you will be able to record. 
Recording one minute of stereo CD quality audio requires 10 MB of hard 
disk space. That is, eight stereo tracks in Nuendo use up at least 80 MB 
of disk space per recording minute.

• Hard disk speed – The speed of the hard drive also 
determines the number of audio tracks you can run.
That is the quantity of information that the disk can read, usually expressed 
as “sustained transfer rate”. Again, “the more the better” applies.

• Wheel mouse – Although a mouse without a wheel will 
work fine with Nuendo, we recommend that you use a 
wheel mouse.
This will speed up value editing and scrolling considerably. 

MIDI requirements
If you intend to use the MIDI features of Nuendo, you need 
the following:

• A MIDI interface to connect external MIDI equipment to your 
computer.

• A MIDI instrument.
• Any audio equipment required to listen to the sound from your 

MIDI devices. 

Audio hardware
Nuendo will run with audio hardware that meets the fol-
lowing specifications:

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Windows XP – The audio hardware must be supplied with a 

special ASIO driver, or a DirectX compatible driver, see below.

! On the Steinberg web site, under “Support–DAW 
Components”, you can find detailed information on 
what to consider when setting up a computer system 
dedicated to audio work.
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• Windows Vista/Windows 7 – If there is no dedicated ASIO 
driver available, you can also use the Generic Low Latency 
ASIO Driver.

• Mac – The audio hardware must be supplied with Mac OS X-
compatible drivers (CoreAudio or ASIO). 

Using the built-in audio hardware of the Macintosh  
(Mac only)

Although Nuendo is designed with multi-channel input 
and output in mind, it is of course possible to use the pro-
gram with “basic” stereo inputs and outputs. As of this 
writing, all current Macintosh models provide at least built-
in 16 bit stereo audio hardware. For detailed information, 
refer to the documentation describing your computer.

Depending on your preferences and requirements, using 
the built-in audio hardware may be sufficient for use with 
Nuendo. It is always available for selection in Nuendo – 
you do not have to install any additional drivers.

About drivers
A driver is a piece of software that allows a program to 
communicate with a certain piece of hardware. In this 
case, the driver allows Nuendo to use the audio hardware. 
For audio hardware, there are two different cases, requir-
ing different driver configurations:

If the audio hardware has a specific ASIO driver

Professional audio cards often come with an ASIO driver 
written especially for the card. This allows for direct com-
munication between Nuendo and the audio card. As a re-
sult, audio cards with specific ASIO drivers can provide 
lower latency (input-output delay), which is crucial when 
monitoring audio via Nuendo or using VST instruments. 
The ASIO driver may also provide special support for mul-
tiple inputs and outputs, routing, synchronization, etc.

Audio card-specific ASIO drivers are provided by the card 
manufacturers. Make sure to check the manufacturer’s 
web site for the latest driver versions.

If the audio card communicates via the Generic Low 
Latency ASIO driver (Windows Vista/Windows 7)

If you are working with Windows Vista or Windows 7, you 
can use the Generic Low Latency ASIO driver. This is a 
generic ASIO driver that provides ASIO support for all au-
dio cards supported by Windows Vista and Windows 7, 
thus allowing for low latency. The Generic Low Latency 
ASIO driver provides the Windows Core Audio technol-
ogy in Nuendo. No additional driver is needed.

Though the Generic Low Latency ASIO driver pro-
vides low latency for all audio cards, you might get better 
results with on-board audio cards than with external USB 
audio devices.

If the audio card communicates via DirectX  
(Windows only)

DirectX is a Microsoft “package” for handling various 
types of multimedia data under Windows. Nuendo sup-
ports DirectX, or to be more precise, DirectSound, which 
is a part of DirectX used for playing back and recording 
audio. This requires two types of drivers:

• A DirectX driver for the audio card, allowing it to communicate 
with DirectX. If the audio card supports DirectX, this driver 
should be supplied by the audio card manufacturer. If it isn’t 
installed with the audio card, please check the manufacturer’s 
web site for more information.

• The ASIO DirectX Full Duplex driver, allowing Nuendo to com-
municate with DirectX. This driver is included with Nuendo, 
and does not require any special installation.

! If your audio hardware comes with a specific ASIO 
driver, we strongly recommend that you use this.
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Hardware installation

Copy protection

Many Steinberg products use the USB-eLicenser (also 
referred to as a “dongle”), a hardware copy protection de-
vice. Nuendo will not run if there is no USB-eLicenser 
containing an activated license.

The USB-eLicenser is a USB device on which your Stein-
berg software licenses are stored. All hardware-protected 
Steinberg products use the same type of device, and you 
can store more than one license on one device. Also, li-
censes can (within certain limits) be transferred between 
USB-Licensers – which is helpful, e. g. if you want to sell a 
piece of software. 

The eLicenser Control Center (which can be found on the 
Start menu on Windows systems or the Applications 
folder on a Mac) is the place where you can check the li-
censes installed on your USB-eLicenser. 

• If you are using other copy-protected Steinberg prod-
ucts, you may want to transfer all licenses for your applica-
tions to only one USB-eLicenser, thus using up only one 
USB port of your computer.
Please refer to the eLicenser Control Center Help for information on how 
to transfer licenses between USB-eLicensers.

• Nuendo is sold with an USB-eLicenser and an Activation 
Code, which is found on the Essential Product License In-
formation card within the product package. The USB-eLi-
censer already contains a time-limited license that allows 
you to use Nuendo out-of-the-box for a total of 25 non-con-
secutive hours. However, to be able to make unlimited use 
of your version of Nuendo, you must activate your perma-
nent license manually, using the activation code.
To do so, click the “Enter Activation Code” button of the eLicenser Con-
trol Center and follow the instructions.

• Steinberg software products always come with a license 
activation code, but not always with an USB-eLicenser.
If you want to activate a license for such a Steinberg software (e. g. an 
update/upgrade, or a VSTi) on the USB-eLicenser you received with 
your original version of Nuendo, click the “Enter Activation Code” button 
of the eLicenser Control Center and follow the instructions.

More information on the transfer or activation of licenses 
can be found in the help for the eLicenser Control Center.

Installing the audio hardware and its driver
1. Install the audio card and related equipment in the 
computer, as described in the card’s documentation.

2. Install the driver for the card.
Depending on the operating system of your computer, there are different 
types of drivers that could apply: card-specific ASIO drivers, the Generic 
Low Latency ASIO Driver (Windows Vista/Windows 7 only), DirectX 
drivers (Windows) or Mac OS X (Mac) drivers.

Specific ASIO drivers

If your audio card has a specific ASIO driver, it may be in-
cluded with the audio card, but you should always make 
sure to check the audio card manufacturer’s web site for 
the most recent drivers. For details on how to install the 
driver, refer to the manufacturer’s instructions.

Generic Low Latency ASIO Driver (Windows Vista/ 
Windows 7 only)

On Windows Vista and Windows 7 systems, you can also 
use the Generic Low Latency ASIO Driver if there is no 
specific ASIO driver available. This driver is included with 
Nuendo and does not require any special installation.

DirectX drivers (Windows only)

If your audio card is DirectX compatible, its DirectX drivers 
will most likely be installed when you install the card. If you 
have downloaded special DirectX drivers for the audio 
card, you should follow the manufacturer’s installation in-
structions.

Mac OS X drivers (Mac only)

If you are using a Macintosh computer, make sure that you 
are using the latest Mac OS X drivers for your audio hard-
ware. Follow the manufacturer’s instructions to install the 
driver.

! Please read the following section before installing 
the Nuendo software.
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Testing the card

To make sure that the audio card works as expected, per-
form the following tests:

• Use any software included with the audio card to make 
sure that you can record and play back audio without 
problems.

• If the card is accessed via a standard operating system 
driver, try playing back audio using the computer’s stan-
dard audio application (e. g. Windows Media Player or 
Apple iTunes).

Installing a MIDI interface/synthesizer card
Installation instructions for a MIDI interface should be in-
cluded with the product. However, here’s an outline of the 
necessary steps:

1. Install the interface (or MIDI synthesizer card) in your 
computer or connect it to a “port” (connector) on the 
computer.
Which is right for you depends on which type of interface you have.

2. If the interface has a power supply and/or a power 
switch, turn it on.

3. Install the driver for the interface, as described in the 
documentation that comes with the interface.
You should also make sure to check the manufacturer’s web site for the 
latest driver updates.

Installing Nuendo
The installation procedure puts all files in the right places, 
automatically.

Depending on your system, the Nuendo 5 Start Center 
program on the DVD may start automatically. If no interac-
tive start screen appears, open the DVD and double-click 
the file “Nuendo 5 Start Center” to launch the interactive 
start screen. From there you can start the installation of 
Nuendo and browse through the additional options and 
information presented there.

In case you do not want to install Nuendo via the interac-
tive start screen, follow the procedure below:

Windows

1. Double-click the file called Setup.exe.

2. Follow the instructions on screen.

Macintosh

1. Double-click the file called “Nuendo 5.mpkg”.

2. Follow the instructions on screen.

Defragmenting the hard disk 
(Windows only)
If you plan to record audio on a hard disk where you have 
already stored other files, now is the time to defragment it. 
Defragmentation reorganizes the physical allocation of 
space on the hard disk in order to optimize its performance. 
It is done with a special defragmentation program.

Register your software
We encourage you to register your software! By doing so 
you are entitled to technical support and kept aware of up-
dates and other news regarding Nuendo. 

To register your software, proceed as follows:

• In Nuendo, open the Help menu and select the Regis-
tration option.
This option is an Internet link that will open the Registration page of the 
Steinberg web site. To register, simply follow the instructions on screen. 

• When you launch Nuendo, you will also be prompted to 
launch the registration process.

! It is crucial to the audio recording performance that 
your hard disk is optimized (defragmented). You 
should make sure to defragment regularly.
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Setting up your system



Setting up audio

Connecting audio
Exactly how to set up your system depends on many dif-
ferent factors, e. g. the kind of project you wish to create, 
the external equipment you want to use, or the computer 
hardware available to you. Therefore, the following sec-
tions can only serve as examples.

How you connect your equipment, i. e. whether you use 
digital or analog connections, also depends on your indi-
vidual setup.

Stereo input and output – the simplest connection

If you only use a stereo input and output from Nuendo, you 
can connect your audio hardware, e. g. the inputs of your 
audio card or your audio interface, directly to the input 
source and the outputs to a power amplifier and speaker.

A simple stereo audio setup

This is probably the simplest of all setups – once you have 
set up the internal input and output busses, you can con-
nect your audio source, e. g. a microphone, to your audio 
interface and start recording.

Multi-channel input and output

Most likely however, you will have other audio equipment 
that you want to integrate with Nuendo, using several in-
put and output channels. Depending on the equipment 
available to you, there are two ways to go: either mixing 
using an external mixing desk, or mixing using the Mixer in-
side Nuendo.

• External mixing means having a hardware mixing device 
with a group or bus system that can be used for feeding 
inputs on your audio hardware.
In the example below, four busses are used for feeding signals to the au-
dio hardware’s inputs. The four outputs are connected back to the mixer 
for monitoring and playback. Remaining mixer inputs can be used for 
connecting audio sources like microphones, instruments, etc.

A multi-channel audio setup using an external mixer

When connecting an input source (like a mixer) to the 
audio hardware, you should use output busses, sends or 
similar that are separate from the mixer’s master output to 
avoid recording what you are playing back. You may also 
have mixing hardware that can be connected via FireWire.

! Make sure that all equipment is turned off before 
making any connections!
17
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• When using the Mixer inside Nuendo, you can use the 
inputs on your audio hardware to connect microphones 
and/or external devices. Use the outputs to connect your 
monitoring equipment.
You can create very complex setups using external instruments and ex-
ternal effects, and integrate Nuendo seamlessly with all your external 
equipment using the Control Room feature (see the chapters “VST Con-
nections” on page 27 and “Control Room” on page 179).

Mixing inside Nuendo

Connecting for surround sound

If you plan to mix for surround sound, you can connect the 
audio outputs to a multi-channel power amplifier, driving a 
set of surround channels.

A surround sound playback configuration

Nuendo supports a number of surround formats. The ex-
ample connection above will work for mixing both LRCS 
(ProLogic for example) and 5.1, in which case the two sur-
round speakers will be playing the same material (from the 
single surround channel). The difference between the two 
formats is the LFE channel, which is not used with LRCS.

Recording from a CD player

Most computers come with a CD-ROM drive that can also 
be used as a regular CD player. In some cases the CD 
player is internally connected to the audio hardware so 
that you can record the output of the CD player directly 
into Nuendo (consult the audio hardware documentation if 
you are uncertain).

• All routing and level adjustments for recording from a 
CD (if available) are done in the audio hardware setup ap-
plication (see below).

• You can also grab audio tracks directly from a CD in 
Nuendo (see the chapter “File handling” on page 552).

Word clock connections

If you are using a digital audio connection, you may also 
need a word clock connection between the audio hard-
ware and external devices. Please refer to the documenta-
tion that came with the audio hardware for details.

About recording levels and inputs

When you connect your equipment, you should make sure 
that the impedance and levels of the audio sources and in-
puts are matched. Typically, different inputs may be de-
signed for use with microphones, consumer line level 
(-10 dBV) or professional line level (+4 dBV), or you may 
be able to adjust input characteristics on the audio inter-
face or in its control panel. Please check the audio hard-
ware documentation for details.

Using the correct types of input is important to avoid dis-
tortion or noisy recordings.

! It is very important that word clock synchronization is 
done correctly or there might be clicks and crackles 
in recordings that you make!

! Nuendo does not provide any input level adjustments 
for the signals coming in to your audio hardware, 
since these are handled differently for each card. Ad-
justing input levels is either done in a special applica-
tion included with the hardware or from its control 
panel (see below). 
18
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Making settings for the audio hardware
Most audio cards come with one or more small applica-
tions that allow you to configure the inputs of the hard-
ware to your liking. This includes:

• Selecting which inputs/outputs are active.
• Setting up word clock synchronization (if available).
• Turning monitoring via the hardware on/off (see “About moni-

toring” on page 21).
• Setting levels for each input. This is very important!
• Setting levels for the outputs, so that they match the equip-

ment you use for monitoring.
• Selecting digital input and output formats.
• Making settings for the audio buffers.

In many cases all available settings for the audio hardware 
are gathered in a control panel, which can be opened from 
within Nuendo as described below (or opened separately, 
when Nuendo isn’t running). In some cases, there may be 
several different applications and panels – please refer to 
the audio hardware documentation for details.

Plug and Play support for ASIO devices

The Steinberg MR816 hardware series supports Plug and 
Play in Nuendo. These devices can be plugged in and 
switched on while the application is running. Nuendo will 
automatically use the driver of the MR816 series and will 
re-map the VST connections accordingly.

Steinberg cannot guarantee that this will work with other 
hardware. If you are unsure of whether your device sup-
ports plug and play, please consult its documentation.

Selecting a driver and making audio settings 
in Nuendo
The first thing you need to do is select the correct driver in 
Nuendo to make sure that the program can communicate 
with the audio hardware:

1. Launch Nuendo and select Device Setup from the 
Devices menu.

2. In the Devices list to the left, click on “VST Audio Sys-
tem”.
The VST Audio System page is shown.

3. On the ASIO Driver menu, select your audio hardware 
driver.
There may be several options here that all refer to the same audio hard-
ware. When you have selected a driver, it is added to the Devices list.

4. Select the driver in the Devices list to open the driver 
settings for your audio hardware.

! If a device that does not support Plug and Play is 
connected/disconnected while the computer is run-
ning, it may get damaged.

! Under Windows, we strongly recommend that you ac-
cess your hardware via an ASIO driver written specifi-
cally for the hardware. If no ASIO driver is installed, 
we recommend that you check with your audio hard-
ware manufacturer if they have an ASIO driver avail-
able, for example, for download via the Internet.

! On Windows Vista and Windows 7 systems, you can 
also use the Generic Low Latency ASIO driver if no 
specific ASIO driver is available.
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5. Bring up the control panel for the audio hardware and 
adjust the settings as recommended by the audio hard-
ware manufacturer.

• Under Windows, you open the control panel by clicking 
the Control Panel button.
The control panel that opens when you click this button is provided 
by the audio hardware manufacturer – not Nuendo (unless you use 
DirectX, see below). Hence it will be different for each audio card brand 
and model. 
The control panels for the ASIO DirectX driver and the Generic Low La-
tency ASIO Driver (Windows Vista and Windows 7 only) are exceptions, 
in that they are provided by Steinberg and described in the dialog help, 
opened by clicking the Help button in the dialog. See also the notes on 
DirectX below.

• Under Mac OS X, the control panel for your audio hard-
ware is opened by clicking the “Open Config App” button 
on the settings page for your audio device in the Device 
Setup dialog.
Note that this button is available only for some hardware products. If 
“Open Config App” is not available in your setup, refer to the documen-
tation that came with your audio hardware for information on where to 
make hardware settings.

6. If you plan to use several audio applications simulta-
neously, you may want to activate the “Release Driver 
when Application is in Background” option on the VST 
Audio System page. This will allow another application to 
play back via your audio hardware even though Nuendo is 
running.
The application that is currently active (i. e. the “top window” on the desk-
top) gets access to the audio hardware. Make sure that any other audio 
application accessing the audio hardware is also set to release the ASIO 
(or Mac OS X) driver so Nuendo can use it when it becomes the active 
application again.

7. On the page for the driver, activate the Externally 
Clocked option if your audio hardware receives clock sig-
nals from an external sample clock source.
You should “tell” Nuendo that it receives external clock signals and 
therefore derives its speed from that source. It is essential that you set 
Nuendo’s project sample rate to the sample rate of the incoming clock 
signals for proper audio playback and recording, see “The Project Setup 
dialog” on page 57.

8. If your audio hardware and its driver support ASIO 
Direct Monitoring, you may want to activate the Direct 
Monitoring checkbox on the page for the driver.
Read more about monitoring later in this chapter and in the chapter “Re-
cording” on page 90.

9. Click Apply and then OK to close the dialog.

If you are using audio hardware with a DirectX driver 
(Windows only)

Nuendo comes with a driver called ASIO DirectX Full Du-
plex, available for selection on the ASIO Driver pop-up 
menu (VST Audio System page).

To take full advantage of DirectX Full Duplex, the audio 
hardware must support WDM (Windows Driver Model) in 
combination with DirectX version 8.1 or higher. In all other 
cases, the audio inputs will be emulated by DirectX (see 
the dialog help for the ASIO DirectX Full Duplex Setup di-
alog for details about how this is reported).

During the installation of Nuendo, the latest DirectX 
version will be installed on your computer. 

When the ASIO DirectX Full Duplex driver is selected in 
the Device Setup dialog, you can open the ASIO Control 
Panel and adjust the following settings (for more details, 
click the Help button in the control panel):

• Direct Sound Output and Input Ports
In the list on the left in the window, all available Direct Sound output and 
input ports are listed. In many cases, there will be only one port in each 
list. To activate or deactivate a port in the list, click the checkbox in the 
left column. If the checkbox is ticked, the port is activated.

• You can edit the Buffer Size and Offset settings in this 
list if necessary, by double-clicking on the value and typ-
ing in a new value. 
In most cases, the default settings will work fine. Audio buffers are used 
when audio data is transferred between Nuendo and the audio card. 
While larger buffers ensure that playback will occur without glitches, the 
latency (the time between the moment Nuendo sends out the data and 
when it actually reaches the output) will be higher.

• Offset
If a constant offset is audible during playback of Audio and MIDI record-
ings, you can adjust the output or input latency time using this value.

! If your audio hardware does not have a specific 
ASIO driver and your Windows version does not 
support the Generic Low Latency ASIO driver, a Di-
rectX driver is the next best option.
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Setting up the input and output ports
Once you have selected the driver and made the settings 
as described above, you need to specify which inputs and 
outputs will be used and name these:

1. In the Device Setup dialog, select your driver in the 
Devices list on the left to display the driver settings for 
your audio hardware.

All input and output ports on the audio hardware are listed.

2. To hide a port, click in the “Visible” column for the port 
(deselecting the checkbox).
Ports that are not visible cannot be selected in the VST Connections 
window where you set up your input and output busses – see the chap-
ter “VST Connections” on page 27.

3. To rename a port, click on its name in the “Show as” 
column and type in a new name.

• It is a good idea to give your ports names that are re-
lated to the channel configuration (rather than to the ac-
tual hardware model)! 
For example, if you are using a 5.1 surround audio setup, you could name 
the six ports Left, Right, Center, Lfe, Left Surround, and Right Surround. 
This makes it easier to transfer your projects between different comput-
ers, e.g. in different studios – if the same port names are used on both 
computers, Nuendo will automatically handle the bus connections prop-
erly when you open the project on the other computer.

4. Click OK to close the Device Setup dialog and apply 
your changes.

About monitoring
In Nuendo, monitoring means listening to the input signal 
while preparing to record or while recording. There are 
three ways to monitor:

External monitoring

External monitoring (listening to the input signal before it 
goes into Nuendo) requires an external mixer for mixing 
the audio playback with the input signal. This can be a 
classic mixing desk or a mixer application for your audio 
hardware, if this has a mode in which the input audio is 
sent back out again (usually called “Thru”, “Direct Thru” or 
similar).

Via Nuendo

In this case, the audio passes from the input into Nuendo, 
possibly through Nuendo effects and EQ and then back to 
the output. You control monitoring via settings in Nuendo.

This allows you to control the monitoring level from Nu-
endo and add effects to the monitored signal only. 

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may sup-
port ASIO Direct Monitoring (this feature may also be 
available for audio hardware with Mac OS X drivers). In 
this mode, the actual monitoring is done in the audio hard-
ware, by sending the input signal back out again. How-
ever, monitoring is controlled from Nuendo. This means 
that the audio hardware’s direct monitoring feature can be 
turned on or off automatically by Nuendo.

Monitoring is described in detail in the chapter “Record-
ing” on page 90. However, when setting up, there is one 
thing to note:

• If you want to use the external monitoring via your audio 
hardware, make sure that the corresponding functions are 
activated in the card’s mixer application. 

If you are using RME Audio Hammerfall DSP audio 
hardware, make sure that the pan law is set to -3 dB in the 
card’s preferences.

! If you attempt to hide a port that is already used by a 
bus you will be asked whether this is really what you 
want – note that this will disable the port!
21
Setting up your system



Setting up MIDI

This section describes how to connect and set up MIDI 
equipment. If you have no MIDI equipment, you can skip 
this section. Note that this is only an example – you might 
need or want to hook things up differently!

Connecting the MIDI equipment
In this example we assume that you have a MIDI keyboard 
and an external MIDI sound module. The keyboard is used 
both for feeding the computer with MIDI messages for re-
cording and for playing back MIDI tracks. The sound mod-
ule is used for playback only. Using Nuendo’s MIDI Thru 
feature (described later) you will be able to hear the cor-
rect sound from the sound module while playing the key-
board or recording.

A typical MIDI Setup

If you want to use even more instruments for playback, sim-
ply connect MIDI Thru on the sound module to MIDI In on 
the next instrument, and so on. In this hook-up, you will al-
ways play the first keyboard when recording. But you can 
still use all your devices for providing sounds on playback.

Setting MIDI Thru and Local On/Off
On the MIDI page in the Preferences dialog (located on 
the File menu under Windows and on the Nuendo menu 
under Mac OS X), you will find a setting called “MIDI Thru 
Active”. This is related to a setting in your instrument 
called “Local On/Off” or “Local Control On/Off”.

• If you use a MIDI keyboard instrument, as described earlier in 
this chapter, MIDI Thru should be activated and that instru-
ment should be set to Local Off (sometimes called Local Con-
trol Off – see the instrument’s operation manual for details). 
The MIDI signal from the keyboard will be recorded in Nuendo 
and at the same time be re-routed back to the instrument so 
that you hear what you are playing, without the keyboard “trig-
gering” its own sounds.

• If you use a separate MIDI keyboard – one that does not pro-
duce any sounds itself – MIDI Thru in Nuendo should also be 
activated, but you don’t need to look for any Local On/Off set-
ting in your instruments.

• The only case where MIDI Thru should be deactivated is if you 
use Nuendo with only one keyboard instrument and that in-
strument cannot be set to Local Off mode.

• MIDI Thru will be active only for MIDI tracks that are record en-
abled and/or have the Monitor button activated. See the chap-
ter “Recording” on page 90 for more information.

! Make sure that all equipment is turned off before 
making any connections!

! If you plan to use more than three sound sources, we 
recommend that you either use an interface with 
more than one output, or a separate MIDI Thru box 
instead of the Thru jacks on each unit.

When “MIDI Thru” is active in 
Nuendo, MIDI data received is 
immediately “echoed” back out.

When you press a key, it is sent out via MIDI to Nuendo.

MIDI data coming in to 
the instrument is played 
by the “Synth” inside it.

When Local Control is turned on in the instrument, the keys you press 
will be played by the “Synth” inside the instrument. When Local Control 
is turned off, this connection is cut off.

“Synth”
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Setting up MIDI ports in Nuendo
The Device Setup dialog lets you set up your MIDI system 
as follows:

When you change MIDI port settings in the Device 
Setup dialog, these are automatically applied.

Showing or hiding MIDI Ports

The MIDI ports are listed in the Device Setup dialog on the 
MIDI Port Setup page. By clicking in the “Visible” column 
for a MIDI input or output, you can specify whether or not 
it is listed on the MIDI pop-up menus in the program.

If you are trying to hide a MIDI port which is already se-
lected for a track or a MIDI device, a warning message will 
appear, allowing you to hide – and disconnect – the port 
or to cancel the operation and keep the MIDI port visible.

Setting up the “All MIDI Inputs” option

When you record MIDI in Nuendo, you can specify which 
MIDI input each recording MIDI track should use. How-
ever, you can also select the “In ‘All MIDI Inputs’” option 
for an input port, which causes any MIDI data from any 
MIDI input to be recorded.

The “In ‘All MIDI Inputs’” option on the MIDI Port Setup 
page allows you to specify which inputs are included when 
you select All MIDI Inputs for a MIDI track. This can be es-
pecially useful if your system provides several instances of 
the same physical MIDI input – by deactivating the dupli-
cates you make sure only the desired MIDI data is recorded.

If you have a MIDI remote control unit connected, you 
should also make sure to deactivate the “In ‘All MIDI In-
puts’” option for that MIDI input. This will avoid accidentally 
recording the data from the remote control when the “All 
MIDI Inputs” option is selected as input for a MIDI track.

Connecting a synchronizer

When using Nuendo with external tape transports, you will 
most likely need to add a synchronizer to your system. All 
connections and setup procedures for synchronization are 
described in the chapter “Synchronization” on page 496.

Setting up video
Nuendo plays back video files in a number of formats, 
such as AVI, QuickTime, or MPEG. QuickTime is used as 
playback engine. Which formats can be played back de-
pends on the video codecs installed on your system, see 
the chapter “Video” on page 520.

There are several ways to play back video, e. g. without any 
special hardware, using a FireWire port, or using dedicated 
video cards, see “Video output devices” on page 522.

If you plan to use special video hardware, install it and set 
it up as recommended by the manufacturer.

Before you use the video hardware with Nuendo, we rec-
ommend that you test the hardware installation with the 
utility applications that came with the hardware and/or the 
QuickTime Player application.

Optimizing audio performance
This section gives you some hints and tips on how to get 
the most out of your Nuendo system, performance-wise. 
Some of this text refers to hardware properties and can be 
used as a guide when upgrading your system. This text is 
very brief. Look for details and current information on the 
Nuendo web site!

Two aspects of performance
There are two distinct aspects of performance with re-
spect to Nuendo.

Tracks and effects

Simply put: the faster your computer, the more tracks, ef-
fects and EQ you will be able to play. Exactly what consti-
tutes a “fast computer” is almost a science in itself, but 
some hints are given below.

! Make sure that all equipment is turned off before 
making any connections!
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Short response times (latency)

Another aspect of performance is response time. The term 
“latency” refers to the “buffering”, i. e. the temporary stor-
ing, of small chunks of audio data during various steps of 
the recording and playback process on a computer. The 
more and larger those chunks, the higher the latency.

High latency is most irritating when playing VST instru-
ments and when monitoring through the computer, i. e. 
when listening to a live audio source via the Nuendo Mixer 
and effects. However, very long latency times (several 
hundred milliseconds) can also affect other processes like 
mixing, e. g. when the effect of a fader movement is heard 
only after a noticeable delay.

While Direct Monitoring and other techniques reduce the 
problems associated with very long latency times, a sys-
tem that responds fast will always be more convenient to 
work with.

• Depending on your audio hardware, it may be possible 
to “trim” your latency times, usually by lowering the size 
and the number of buffers.
For details, refer to the audio hardware documentation, or, if you are us-
ing a DirectX driver under Windows, the dialog help.

System factors that affect performance

RAM

Generally speaking, the more RAM is installed in your 
computer, the better.

This limitation is imposed by the operating system, and it 
is independent of the amount of RAM that you may have 
installed in your computer!

Only Windows 64 Bit is able to assign considerably 
more than 4 GB of RAM to a running application.

Some program functions may “eat up” all the available 
memory, e. g. recording, the use of effect plug-ins, and the 
pre-loading of samples (see also “RAM requirements for 
recording” on page 94 and “Smart plug-in processing” on 
page 196).

Always keep in mind the RAM limitation of your operating 
system when setting up your projects.

CPU and processor cache

It goes without saying that the faster the computer proces-
sor, the better. But there are a number of factors that affect 
the apparent speed of a computer: the bus speed and type 
(PCI is strongly recommended), the processor cache size 
and of course, the processor type and brand. Nuendo relies 
heavily on floating point calculations. When shopping for a 
processor, please make sure that you get one that is pow-
erful in calculating floating point arithmetics.

Note also that Nuendo features full support for multi-pro-
cessor systems. So, if you own a computer system with 
more than one processor, Nuendo can take advantage of 
the total capacity and evenly distribute the processing 
load to all available processors. For further information, 
see “The advanced options” on page 25.

Hard disk and controller

The number of hard disk tracks you can record and play 
back at the same time also depends on the speed of your 
hard disk and hard disk controller. If you use E-IDE disks 
and controllers, make sure that the transfer mode is DMA 
Busmaster. Under Windows, you can check the current 
mode by launching the Windows Device Manager and 
looking for properties of the IDE ATA/ATAPI Controller’s 
primary and secondary channel. DMA transfer mode is en-
abled by default, but may be turned off by the system 
should hardware problems occur.

! On computers running a Windows 32 Bit operating 
system, a running application can address a maxi-
mum of 2 GB of RAM. On a Macintosh computer 
running Mac OS X, this limit is 4 GB.

! When a function has used up all the memory made 
available by the operating system, the computer will 
crash.
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Audio hardware and driver

The hardware and its driver can have some effect on re-
gular performance. A badly written driver can reduce the 
performance of your computer. But where the hardware 
driver design makes the most difference is with latency.

This is especially true when using Nuendo for Windows:

• Under Windows, ASIO drivers written specifically for 
the hardware are more efficient than the Generic Low La-
tency ASIO Driver or a DirectX driver and produce shorter 
latency times.

• Under Mac OS X, audio hardware with properly written 
Mac OS X (Core Audio) drivers can be very efficient and 
produce very low latency times.
However, there are additional features currently only available with ASIO 
drivers, such as the ASIO Positioning Protocol.

Optimizing processor scheduling (Windows only)

To get the lowest possible latencies when using ASIO un-
der Windows XP (on a single-CPU system), the “system 
performance” has to be optimized for background tasks:

1. Open the Windows Control Panel from the Start menu 
and select System.

2. Select the Advanced tab and click the Settings button 
in the Performance section.
The Performance Options dialog opens.

3. Select the Advanced tab.

4. In the Processor Scheduling section, select “Adjust 
for best performance of: Background services”.

5. Click OK to close the dialogs.

Making settings that affect performance

Audio buffer settings

Audio buffers affect how audio is sent to and from the au-
dio hardware. The size of the audio buffers affects both 
the latency and the audio performance. Generally, the 
smaller the buffer size, the lower the latency. On the other 
hand, working with small buffers can be demanding for the 
computer. If the audio buffers are too small, you may get 
clicks, pops or other audio playback problems.

• Under Mac OS X, you can adjust the size of the buffers 
on the VST Audio System page in the Device Setup dia-
log.
You may also find buffer settings in the control panel for the audio hard-
ware.

• Under Windows, you adjust the buffer size settings in 
the control panel for the audio hardware (opened by click-
ing the Control Panel button on the driver page in the De-
vice Setup dialog).

The advanced options

On the VST Audio System page you will find the “Ad-
vanced options” section. Here you find advanced settings 
for the VST Engine, including a Multi Processing option. 
When this is activated and there is more than one CPU in 
your system, the processing load is distributed evenly to 
all available CPUs, allowing Nuendo to make full use of 
the combined power of the multiple processors. See the 
dialog help for details.

About the VST Performance window

The VST Performance window is opened from the De-
vices menu. The window shows two meter displays: The 
ASIO meter, which indicates CPU load, and the Disk 
meter, which shows the hard disk transfer rate. It is rec-
ommended that you check this from time to time, or keep it 
always open. Even if you have been able to activate a 
number of audio channels in the project without getting 
any warning, you may run into performance problems 
when adding EQ or effects.

• The ASIO meter (at the top) shows the ASIO time us-
age, i. e. the time required to complete the current pro-
cessing tasks. The more tracks, effects, EQ, etc. you use 
in your project, the longer processing will take, and the 
longer the ASIO meter will show activity.
If the overload indicator (on the far right) lights up, you need to decrease 
the number of EQ modules, active effects, and/or audio channels playing 
back simultaneously.

! Again, we strongly recommend that you use audio 
hardware for which there is a specific ASIO driver!
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• The lower bar graph shows the hard disk transfer load.
If the overload indicator (on the far right) lights up, the hard disk is not 
supplying data fast enough to the computer. You may need to reduce the 
number of tracks playing back by using the Disable Track function (see 
“About track disable/enable” on page 87). If this does not help, you need 
a faster hard disk. 

The overload indicator may occasionally blink, e. g. 
when you locate during playback. This does not indicate a 
problem, but happens because the program needs a mo-
ment for all channels to load data for the new playback po-
sition.

The ASIO and Disk load meters can also be shown on 
the Transport panel (as “Performance”) and on the Project 
window toolbar (as “Performance Meter”). There they are 
shown as two miniature vertical meters (by default at the 
left side of the panel/toolbar).
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About this chapter
This chapter focuses on the settings you can perform in 
the VST Connections window. Here you can set up input 
and output busses, group and FX channels, external ef-
fects, and external instruments. Furthermore you can use 
this window to configure the Control Room and access 
the Control Room itself.

Since input and output busses are vital for working with 
Nuendo, a large part of this chapter concentrates on bus-
ses and this is also the reason why you find this chapter at 
the beginning of the Operation Manual. How to use the 
busses is described in detail in the section “Routing” on 
page 168.

The VST Connections window

The VST Connections window is opened from the De-
vices menu. It contains the following tabs:

• The Inputs and Outputs tabs allow you to set up and configure 
input and output busses, see “Setting up busses” on page 28.

• The Group/FX tab allows you to create group and FX chan-
nels/tracks and to make output assignments for these, see 
“Setting up group and FX channels” on page 32. 

• The External FX tab allows you to create effect send/return bus-
ses for connecting external effects which can then be selected 
via the effect pop-up menus from inside the program. For further 
information, see “External instruments/effects” on page 32 and 
“Using external effects” on page 208.

• The External Instruments tab allows you to create input/output 
busses for connecting external instruments. For further informa-
tion, see “External instruments/effects” on page 32 and the 
chapter “VST instruments and instrument tracks” on page 215.

• The Studio tab is where you enable and configure the Control 
Room, see “VST Connections – Studio tab” on page 181.

Setting up busses
Nuendo uses a system of input and output busses to trans-
fer audio between the program and the audio hardware.

• Input busses let you route audio from the inputs on your audio 
hardware into the program. This means that when you record 
audio, you will always do this through one or several input 
busses.

• Output busses let you route audio from the program to the 
outputs on your audio hardware. When you play back audio, 
you will always do this through one or several output busses.

Once you understand the bus system and know how to 
set up the busses properly, it will be easy to go on with 
recording, playing back, mixing, and doing surround work.

Strategies
You can create any number of busses in Nuendo, in virtu-
ally any channel configuration – mono, stereo or a number 
of surround formats.

The bus configuration is saved with the project – 
therefore it is a good idea to add and set up the busses 
you need and save these in a template project (see “Save 
as Template” on page 53).

When you start working on new projects, you start from 
this template. That way you get your standard bus config-
uration without having to make new bus settings for each 
new project. If you need to work with different bus config-
urations in different projects, you can either create several 
different templates or store your configurations as presets 
(see “Presets” on page 31). The templates can of course 
also contain other settings that you regularly use – sample 
rate, record format, a basic track layout, etc.

So, which type of busses do you need? This depends on 
your audio hardware, your general audio setup (e. g. sur-
round speaker setup) and what kind of projects you work 
with.
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Let’s say you are using audio hardware with eight analog 
inputs and outputs and digital stereo connections (10 in-
puts and outputs all in all). Furthermore, you work with a 
surround setup in 5.1 format. In this scenario, you may 
want to add the following busses:

Input busses

• Most likely you need at least one stereo input bus assigned to 
an analog input pair. This will let you record stereo material. If 
you want to be able to record in stereo from other analog input 
pairs as well, you add stereo input busses for these, too.

• Although you can record mono tracks from one side of a ste-
reo input, it may be a good idea to add a dedicated mono in-
put bus. This can be assigned to an analog input to which you 
have connected a dedicated microphone pre-amp, for exam-
ple. Again, you can have several different mono busses.

• You probably want a dedicated stereo input bus assigned to 
the digital stereo input, for digital transfers.

• If you want to transfer surround material directly to a surround 
track, e. g. from surround-configured location recording equip-
ment, you need an input bus in that surround format – in this 
example, this will be a 5.1 input bus.

Output busses

• You will need one or several stereo output busses for routing 
stereo mixes to master recorders or other destinations.

• For digital transfers, you need a stereo bus assigned to a dig-
ital stereo output as well.

• You need a surround bus in the format of your speaker config-
uration (in this example, 5.1) assigned to the correct outputs. 
Only connect these outputs to the corresponding speakers if 
you are not using the Control Room (see the chapter “Control 
Room” on page 179). You may want additional surround bus-
ses if you tend to work in different surround formats.

Preparations
Before you set up busses, you should name the inputs and 
outputs on your audio hardware. For example, if you are us-
ing a 5.1 surround speaker setup, you should name the out-
puts according to which speaker they are connected to 
(Left, Right, Center, and so on). 

The reason for this is compatibility – it makes it easier to 
transfer projects between different computers and setups. 
For example, if you move your project to another studio, 
the audio hardware may be of a different model. But if 
both you and the other studio owner have given your in-
puts and outputs names according to the surround setup 
(rather than names based on the audio hardware model), 
Nuendo will automatically find the correct inputs and out-
puts for your busses and you will be able to play and 
record without having to change the settings.

To assign names to the inputs and outputs of your audio 
hardware, proceed as follows:

1. Open the Device Setup dialog from the Devices menu.

2. On the VST Audio System page, make sure that the 
correct driver for your audio hardware is selected.
If this is the case, your audio card is listed in the Devices list on the left of 
the Device Setup window.

3. In the Devices list, select your audio card.
The available input and output ports on your audio hardware are listed on 
the right.

4. To rename a port, click on its name in the Show As 
column and enter a new name.

• If needed, you can also disable ports by deactivating 
them in the Visible column.
Disabled ports are not shown in the VST Connections window. If you at-
tempt to disable a port that is used by a bus, you will be asked whether this 
is really what you want – note that this will remove the port from the bus!

5. Click OK to close the Device Setup dialog.

If you open a project created on another computer and 
the port names do not match (or the port configuration is 
not the same – e. g. the project is created on a system 
with multi-channel i/o and you open it on a stereo in/out 
system), the Missing Ports dialog will appear. This allows 
you to manually re-route ports used in the project to ports 
available in your system.

! Different busses can use the same inputs/outputs on 
the audio hardware! For example, you may want a 
stereo output bus assigned to the same outputs as 
the front stereo channels in your surround bus – this 
enables you to listen to stereo mixes without having 
to reconnect your speakers.
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Mac OS X only: Retrieving channel names

For some audio cards, you can automatically retrieve the 
ASIO channel names for the ports of your audio hardware. 
Proceed as follows:

1. Open the Device Setup dialog via the Devices menu.

2. On the VST Audio System page, select your audio 
card on the ASIO Driver pop-up menu.

3. In the Devices list on the left, select your audio card.
The available settings are displayed.

4. In the settings section on the right, click the Control 
Panel button.

5. In the control panel for your audio hardware, activate 
the “Use CoreAudio Channel Names” option.

6. When you now open the VST Connections window to 
set up the busses in your system, you will find that the port 
names in the Device Port column correspond to the 
names that are used by the CoreAudio driver.

If you want to use the project later on with an earlier 
version of Nuendo, you will have to re-assign the port con-
nections in the VST Connections window (see below).

Mac OS X only: Port selection and activation

On the settings page for your audio card (opened via the 
Device Setup dialog, see above), you can specify which 
input and output ports are active. This allows you to use 
the Microphone input instead of the Line input or even to 
deactivate the audio card input or output completely, if re-
quired.

This function is only available for Built-In Audio, stan-
dard USB audio devices and a certain number of other 
audio cards (e. g. Pinnacle CineWave).

Adding input and output busses
Depending on whether you have selected the Inputs or the 
Outputs tab in the VST Connections window, the corre-
sponding busses are listed, with the following information:

To add an input or output bus, proceed as follows:

1. Open the Inputs or Outputs tab depending on the type 
of bus that you want to add.

2. Click the Add Bus button.
A dialog opens.

3. Select a (channel) configuration.
The Configuration pop-up menu contains a Mono and a Stereo option as 
well as several surround formats. Additional surround formats are listed 
on the “More…” submenu. 

• Alternatively, you can right-click in the VST Connections 
window and add a bus in the desired format directly from 
the context menu.
The new bus appears with the ports visible.

4. For each of the speaker channels in the bus, click in 
the Device Port column to select a port on your audio 
hardware.
The pop-up menu that opens lists the ports with the names you have as-
signed in the Device Setup dialog.

Column Description

Bus Name Lists the busses. You can select and rename busses by 
clicking on them in this column.

Speakers Indicates the speaker configuration (mono, stereo, sur-
round formats) of each bus.

Audio Device This shows the currently selected ASIO driver.

Device Port If a bus entry is expanded to show all speaker channels, 
this column shows which physical inputs/outputs on your 
audio hardware are used by the bus. If the bus entry is col-
lapsed, only the first port used by this bus is visible here.

Click (Outputs 
tab only)

You can route the click to a specific output bus, regard-
less of the actual Control Room output, or even when the 
Control Room is disabled.
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Setting the Main Mix bus (the default output 
bus)
The Main Mix is the output bus that each new audio, group 
or FX channel is automatically routed to.

Any of the output busses in the VST Connections window 
can be the default output bus. By right-clicking on the 
name of an output bus, you can set it as the Main Mix bus.

Setting the default output bus.

Adding child busses
A surround bus is essentially a set of mono channels – 
6 channels in the case of the 5.1 format. If you have a 
mono track in the project, you can route it to a separate 
speaker channel in the bus (or route it to the parent sur-
round bus and use the SurroundPanner to position it in 
the surround image). But what if you have a stereo track 
that you simply want to route to a stereo channel pair 
within the bus (Left and Right or Left Surround and Right 
Surround, for example)? For this you need to create a 
child bus.

Proceed as follows:

1. In the Bus Name column, select the surround bus and 
right-click on it to open the context menu.

2. Select a channel configuration from the “Add Child 
Bus” submenu.
As you can see, you can create stereo child busses (routed to various 
speaker channel pairs in the surround bus) or other surround bus formats 
(with fewer channels than the “parent bus”).

The child bus that you created will be available for routing 
in the Mixer. It is a part of the parent surround bus, which 
means that it has no separate channel strip.

Although child busses are probably most useful in output 
busses, you can also create child busses within a sur-
round input bus – for example if you want to record a ste-
reo channel pair (e. g. front left-right) in the surround bus 
to a separate stereo track.

Presets
On the Inputs and Outputs tabs you will find a Presets 
menu. Here you can find three different types of presets:

• A number of standard bus configurations.

• Automatically created presets tailored to your specific 
hardware configuration.
On startup, Nuendo analyzes the physical inputs and outputs provided 
by your audio hardware and creates a number of hardware-dependent 
presets with the following possible configurations:

• one stereo bus
• various combinations of stereo and mono busses
• a number of mono busses
• one 5.1 bus (if you have 6 or more inputs)
• various combinations of 5.1 and stereo busses (if you have 6 

or more inputs)
• various combinations of 5.1 and mono busses (if you have 6 

or more inputs)

• Your own user presets that you can save by clicking the 
Store button (“+” symbol). You can then select the stored 
configuration directly from the Presets pop-up menu at 
any time. To remove a stored preset, select it and click the 
Delete button (“-” symbol).

! The Main Mix is indicated by an orange colored 
speaker icon next to its name.
31
VST Connections



Setting up group and FX channels
The Group/FX tab in the VST Connections window shows 
all group channels and FX channels in your project. You 
can create new group or FX channels by clicking the cor-
responding Add button. This is the same as creating 
group channel tracks or FX channel tracks in the Project 
window (see “Using group channels” on page 170 and 
the chapter “Audio effects” on page 195).

However, the VST Connections window also allows you 
to create child busses for group and FX channels. This is 
useful if you have group or FX channels in surround format 
and want to route stereo channels to specific channel 
pairs in these.

Creating a child bus for a group or FX channel in surround 
format is similar to creating a child bus for input and out-
put busses, see “Adding child busses” on page 31.

About monitoring
The VST Connections window allows you to set up the 
busses used for monitoring, activate/deactivate the Con-
trol Room and open the Control Room Mixer. For details 
about using the Control Room and setting up the Studio 
tab in the VST Connections window, see the chapter 
“Control Room” on page 179.

When the Control Room is disabled on the Studio tab of 
the VST Connections window, the Main Mix bus is used 
for monitoring. In this case you can adjust the monitoring 
level in the regular Project Mixer, see the chapter “The 
Mixer” on page 151.

External instruments/effects
Nuendo supports the integration of external effect devices 
and external instruments, e. g. hardware synthesizers, into 
the sequencer signal flow.

You can use the External Instruments tab and the External 
FX tab in the VST Connections window to define the 
necessary send and return ports and access the instru-
ments/effects through the VST Instruments window.

Requirements
• To use external effects, you need audio hardware with 
multiple inputs and outputs. To use external instruments, a 
MIDI interface must be connected to your computer.
An external effect will require at least one input and one output (or input/
output pairs for stereo effects) in addition to the input/output ports you 
use for recording and monitoring.

• As always, audio hardware with low-latency drivers is a 
good thing to have.
Nuendo will compensate for the input/output latency and ensure that the 
audio processed through external effects is not shifted in time.

Connecting the external effect/instrument
To set up an external effect or instrument, proceed as 
follows:

1. Connect an unused output pair on your audio hard-
ware to the input pair on your external hardware device.
In this example, we assume that the hardware device has stereo inputs 
and outputs.

2. Connect an unused input pair on your audio hardware 
to the output pair on your hardware device.

Once the external device is connected to the audio hard-
ware of your computer, you have to set up the input/out-
put busses in Nuendo.

! External instruments and effects are indicated by an 
“x” icon in the list next to their names in the respec-
tive pop-up menus.

! Please note that it is possible to select input/output 
ports for external effects/instruments that are already 
used (i. e. that have been selected as inputs/outputs 
in the VST Connections window). If you select a used 
port for an external effect/instrument, the existing port 
assignment will be broken. Note that you will not get a 
warning message!
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Setting up external effects
To set up an external effect in the VST Connections win-
dow, proceed as follows:

1. Open the External FX tab and click the “Add External 
FX” button.
A dialog opens.

2. Enter a name for the external effect and specify the 
send and return configurations.
Depending on the type of effect, you can specify mono, stereo or sur-
round configurations. 

• You also need a MIDI device that corresponds with the 
external effect. You can then click the “Associate MIDI 
Device” button to connect the two.
You can use the MIDI Device Manager to create a new MIDI device for 
the effect. Note that delay compensation will only be applied for the ef-
fect when you use MIDI devices. For information about the MIDI Device 
Manager and user device panels see the chapter “Using MIDI devices” 
on page 380.

3. Click OK.
This adds a new external FX bus.

4. Click in the Device Port column for the “left” and 
“right” ports of the Send Bus and select the outputs on 
your audio hardware that you want to use.

5. Click in the Device Port column for the “left” and 
“right” ports of the Return Bus and select the inputs on 
your audio hardware that you want to use.

6. If you like, make additional settings for the bus.
These are found in the columns to the right. Note that you can adjust 
these while actually using the external effect – which may be easier as 
you can hear the result. 

The following options are available:

Note that external device ports are exclusive, see 
“Connecting the external effect/instrument” on page 32.

How to use the external effect

If you now click an insert effect slot for any channel, you 
will find the new external FX bus listed on the “External 
Plug-ins” submenu.

When you select it, the following happens:

• The external FX bus is loaded into the effect slot just like a 
regular effect plug-in.

• The audio signal from the channel is sent to the outputs on the 
audio hardware, through your external effect device and back 
to the program via the inputs on the audio hardware.

• A parameter window opens, showing the Delay, Send Gain 
and Return Gain settings for the external FX bus. You can ad-
just these as necessary while playing back. The parameter 
window also provides the “Measure Effect’s Loop Delay for 
Delay Compensation” button. This is the same function as the 
“Check User Delay” option in the VST Connections window. It 
provides Nuendo with a Delay value to be used for delay com-

Setting Description

Delay If your hardware effect device has an inherent delay (la-
tency), enter this value here, as it allows Nuendo to com-
pensate for that delay during playback. You can also let 
the delay value be determined by the program: Right-
click the Delay column for the effect and select “Check 
User Delay”. Note that you do not have to take the latency 
of the audio hardware into account – this is handled auto-
matically by the program.

Send Gain Allows you to adjust the level of the signal being sent to 
the external effect.

Return Gain Allows you to adjust the level of the signal coming in from 
the external effect. 
Note however that excessive output levels from an exter-
nal effect device may cause clipping in the audio hard-
ware. The Return Gain setting cannot be used to 
compensate for this – you have to lower the output level 
on the effect device instead.

MIDI Device When you click in this column, a pop-up menu opens 
where you can disconnect the effect from the associated 
MIDI device, select a MIDI device, create a new device or 
open the MIDI Device Manager to edit the MIDI device. 
When Studio Manager 2 is installed, you may also select 
an OPT editor to access your external effect.

Used Whenever you insert an external effect into an audio 
track, this column shows a checkmark (“x”) to indicate 
that the effect is being used.
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pensation. When you have defined a MIDI device for the ef-
fect, the corresponding Device window will be opened. When 
Studio Manager 2 is installed, and you have set up a corre-
sponding OPT editor, this OPT editor is displayed.

The default parameter window for an external effect

Like any effect, you can use the external FX bus as an in-
sert effect or as a send effect (an insert effect on an FX 
channel track). You can deactivate or bypass the external 
effect with the usual controls.

Setting up external instruments
To set up an external instrument in the VST Connections 
window, proceed as follows:

1. Open the External Instrument tab and click the “Add 
External Instrument” button.
A dialog opens.

2. Enter a name for the external instrument and specify 
the number of required mono and/or stereo returns.
Depending on the type of instrument, a specific number of mono and/or 
stereo return channels is required.

• You also need a MIDI device that corresponds with the 
external instrument. You can then click the “Associate 
MIDI Device” button to connect the two.
You can use the MIDI Device Manager to create a new MIDI device. For 
information about the MIDI Device Manager and user device panels, see 
the chapter “Using MIDI devices” on page 380.

3. Click OK.
This adds a new external instrument bus.

4. Click in the Device Port column for the “left” and 
“right” ports of the Return Bus and select the inputs on 
your audio hardware to which you connected the external 
instrument.

5. If you like, make additional settings for the bus.
These are found in the columns to the right. Note that you can adjust 
these while actually using the external instrument – which may be easier 
as you can hear the result. The following options are available:

Note that external device ports are exclusive, see 
“Connecting the external effect/instrument” on page 32.

How to use the external instrument

Once you have set up the external instrument in the VST 
Connections window, you can use it as a VST instrument. 
Open the VST Instruments window and click on an empty 
instrument slot. On the Instrument pop-up menu, your ex-
ternal instrument is listed on the External Plug-ins submenu:

Measure Effect’s Loop Delay button

Setting Description

Delay If your hardware device has an inherent delay (latency), 
enter this value here. This allows Nuendo to compensate 
for that delay during playback. Note that you do not have 
to take the latency of the audio hardware into account – 
this is handled automatically by the program.

Return Gain Allows you to adjust the level of the signal coming in from 
the external instrument. 
Note however that excessive output levels from an external 
device may cause clipping in the audio hardware. The Re-
turn Gain setting cannot be used to compensate for this – 
you have to lower the output level on the device instead.

MIDI Device When you click in this column, a pop-up menu opens 
where you can disconnect the instrument from the asso-
ciated MIDI device, select a MIDI device, create a new 
device or open the MIDI Device Manager to edit the MIDI 
device. 
When Studio Manager 2 is installed, you may also select 
an OPT editor to access your external instrument.

Used Whenever you insert the external instrument into a VST 
instrument slot, this column shows a checkmark (“x”) to 
indicate that the instrument is being used.
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When you select the external instrument in the VST Instru-
ments window, the following happens:

• A parameter window for the external device opens automati-
cally. This may either be the Device window, allowing you to 
create a generic device panel, an OPT editor window or a de-
fault editor. For information about the Device window, the 
MIDI Device Manager and User device panels, see the chap-
ter “Using MIDI devices” on page 380.

The external instrument will behave like any other VST in-
strument in Nuendo.

About the Favorites buttons
In the VST Connections window, both the External FX tab 
and the External Instruments tab feature a Favorites button.

Favorites are device configurations that you can recall at 
any time, like a library of external devices that are not con-
stantly connected to your computer. They also allow you 
to save different configurations for the same device, e. g. a 
multi-effect board or an effect that provides both a mono 
and a stereo mode.

To save a device configuration as a favorite, proceed as 
follows:

• When you have added a new device in the VST Con-
nections window, select it in the Bus Name column and 
click the Favorites button.
A context menu is displayed showing an option to add the selected ef-
fect or instrument to the Favorites.

• You can recall the stored configuration at any time by 
clicking the Favorites button and selecting the device 
name from the context menu.

About the “plug-in could not be found” 
message
When you open a project that uses an external effect/in-
strument, you may get a “plug-in could not be found” mes-
sage. This will happen when you remove an external 
device from the VST Connections window although it is 
used in a saved project, or when transferring a project to 
another computer on which the external device is not de-
fined. You may also see this message when opening a 
project created with an earlier version of Nuendo.

In the VST Connections window, the broken connection 
to the external device is indicated by an icon in the Bus 
Name column.

To reestablish the broken connection to the external de-
vice, simply right-click the entry for the device in the Bus 
Name column and select “Connect External Effect”. The 
icon is removed, and you can use the external device 
within your project as before.

Freezing external effects/instruments
Just as when working with regular VST instruments and 
effects, you can also choose to freeze external effects and 
instruments. The general procedure is described in detail 
in the chapters “Audio effects” on page 195 and “VST in-
struments and instrument tracks” on page 215.

When freezing external instruments or effects, you can ad-
just the corresponding tail value in the Freeze Channel 
Options dialog:

! To send MIDI notes to the external instrument, open 
the Output Routing pop-up menu in the Inspector for 
the corresponding MIDI track and select the MIDI 
device to which the external instrument is connected. 
This ensures use of delay compensation. The instru-
ment will now play any MIDI notes it receives from 
this track and return them to Nuendo through the re-
turn channel(s) you have set up. 

! Note that busses set up for external effects or exter-
nal instruments are saved “globally”, i. e. for your par-
ticular computer setup.

! Note that you have to perform Freeze in realtime. 
Otherwise external effects will not be taken into ac-
count.
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• Use the arrow buttons next to the Tail Size value field to 
set the desired Tail length, i. e. the range after the part 
boundary is also to be included in the freeze. You can also 
click directly in the value field and enter the desired value 
manually (the maximum value being 60 s).

• When the Tail Size is set to 0 s (default), the freezing will 
only take into account the data within the Part boundaries.

Editing operations
On the different tabs of the VST Connections window the 
corresponding busses or channels are shown in a table 
containing a tree view with expandable entries. After you 
have set up all the required busses for a project it might 
be necessary to edit the names and/or change port as-
signments. Nuendo provides a number of features to 
make such tasks easier.

Expanding and collapsing entries

• Bus entries can be expanded or collapsed to show or 
hide the corresponding speaker channels or sub-busses 
by clicking the “+” or “-” sign in front of the corresponding 
list entry.

• To expand or collapse all entries on a tab at the same 
time, use the “+ All” button or the “- All” button (respec-
tively) above the tree view.

Determining how many busses a device port is 
connected to

To give you an idea how many busses a given port is al-
ready connected to, the busses are shown in square 
brackets on the Device Port pop-up menu, to the right of 
the port name.

Up to three bus assignments can be displayed in this way. 
If more connections have been made, this is indicated by a 
number at the far right.

Therefore if you see the following:

Adat 1   [Stereo1] [Stereo2] [Stereo3] (+2)...

this means that the Adat 1 port is already assigned to 
three stereo busses plus two additional busses.

Identifying exclusive port assignments

In some cases (i. e. for certain channel types such as Stu-
dio channels) the port assignment is exclusive. Once a 
port has been assigned to such a bus or channel, it should 
not be assigned to another bus since the assignment to 
the first bus is broken in that case.

To help you identify such exclusive port assignments and 
avoid accidental reassignment, the corresponding ports 
are marked in red on the Device Port pop-up menu.

Selecting/Deselecting multiple entries

• Using the key commands [Ctrl]/[Command]-[A] (Select 
All) and [Shift]-[Ctrl]/[Command]-[A] (Select None) you 
can select or deselect all entries in the Bus Name column.
Note that for this to work the table on the current tab needs to have the 
focus. This can be achieved by clicking anywhere on the background of 
the table.

• By holding [Shift] when selecting entries in the Bus Name 
column, you can select multiple entries at the same time.
This is useful for automatic renaming or changing the port assignments 
globally, see below.

If you select a sub entry (e. g. a speaker channel in a 
bus) the parent entry is automatically selected as well.

Selecting entries by typing the name

In the Bus Name list you can jump to an entry by typing the 
first letter of the bus name on the keyboard.

Navigating the Bus Name list using the [Tab] key

By pressing the [Tab] key you can jump to the next entry in 
the Bus Name list, allowing you to rename your busses 
quickly. Similarly, by pressing [Shift]-[Tab] you can return 
to the previous list entry.

! This will only work if the table has the focus. To do 
this, simply select any list entry.
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Automatically renaming selected busses

You can rename all the selected busses at once using in-
crementing numbers or letters from the alphabet.

• To use incrementing numbers, select the busses that 
you want to rename and enter a new name for one of the 
busses, followed by a number.
For example, if you have eight inputs that you want to be named “In 1, 
In 2, …, In 8”, you select all the busses and enter the name “In 1” for the 
first bus. All other busses are renamed automatically.

• To use letters from the alphabet, you proceed as with 
numbers, but enter a capital letter instead of a number.
For example, if you have three FX channels that you want to be named 
“FX A, FX B, and FX C”, you select all the channels and enter the name 
“FX A” for the first. All other channels are renamed automatically. The last 
letter to be used is Z. If you have more selected entries than there are let-
ters available, the remaining entries will be skipped.

You do not have to begin renaming with the topmost 
selected entry. The renaming will start from the bus where 
you edit the name, will go down the list to the bottom and 
then continue from the top until all selected busses have 
been renamed.

Changing the port assignment for a single bus

To change the port assignment for a single bus, you pro-
ceed as when you added it: Make sure that the channels 
are visible and click in the Device Port column to select 
ports.

Changing the port assignment for multiple busses

To change the port assignment (or the output routing in 
case of groups/FX channels) for multiple entries in the 
Bus Name column at the same time, you need to select 
the corresponding busses first.

• To assign different ports to the selected busses, press 
[Shift], open the Device Port pop-up menu for the first se-
lected entry (i. e. the topmost bus) and select a device port.
All subsequent busses are automatically connected to the next available 
port.

• To assign the same ports to all selected busses, press 
[Shift]-[Alt]/[Option], open the Device Port pop-up menu 
for the first selected entry (i. e. the topmost bus) and select 
a device port.

Using this procedure, you can also set all selected 
busses or channels to Not Connected.

Removing busses

To remove a bus you do not need, select it in the list, right-
click and select Remove Bus from the pop-up menu, or 
press [Backspace].

! When using letters instead of numbers it is important 
to note that these must be preceded by a space. If 
you leave out the space before the letter or if you do 
enter neither a letter nor a number, only the first se-
lected entry is renamed.

! Exclusive ports (e. g. ports already assigned to Con-
trol Room channels) will be skipped!
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5
The Project window



Window Overview
The Project window is the main window in Nuendo. This provides you with an overview of the project, allowing you to 
navigate and perform large scale editing. Each project has one Project window. 

About tracks
The Project window is divided vertically into tracks, with a 
timeline running horizontally from left to right. The follow-
ing track types are available:

Project 
overview

The event display, showing audio parts and events, MIDI parts, automation, markers, etc.

Inspector

Ruler

Info line

Toolbar

The track list with various track types

Status line

Track type Description

Audio For recording and playing back audio events and audio 
parts. Each audio track has a corresponding audio chan-
nel in the Mixer.
An audio track can have any number of automation tracks 
for automating Mixer channel parameters, effect settings, 
etc.

Folder Folder tracks function as containers for other tracks, mak-
ing it easier to organize and manage the track structure. 
They also allow you to edit several tracks at the same 
time, see “Folder tracks” on page 65.

FX Channel FX channel tracks are used for adding send effects. Each 
FX channel can contain up to eight effect processors – by 
routing effect sends from an audio channel to an FX chan-
nel, you send audio from the audio channel to the effect(s) 
on the FX channel. Each FX channel has a corresponding 
channel strip in the Mixer – in essence an effect return 
channel, see the chapter “Audio effects” on page 195. 
All FX channel tracks are automatically placed in a special 
FX channel folder in the track list, for easy management.
An FX channel can also have any number of automation 
tracks for automating Mixer channel parameters, effect 
settings, etc.

Group  
Channel

By routing several audio channels to a Group channel, 
you can submix them, apply the same effects to them, etc. 
(see “Using group channels” on page 170).
A Group channel track contains no events as such, but 
displays settings and automation curves for the corre-
sponding Group channel. Each Group channel track has 
a corresponding channel strip in the Mixer. In the Project 
window, Group channels are organized as tracks in a 
special Group Tracks folder. 

Track type Description
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About parts and events
The tracks in the Project window contain parts and/or 
events. Events are the basic building blocks in Nuendo. 
Different event types are handled differently in the Project 
window:

• Video events and automation events (curve points) are always 
viewed and rearranged directly in the Project window.

• MIDI events can always be found in MIDI parts, which are con-
tainers for one or more MIDI events. MIDI parts are rearranged 
and manipulated in the Project window. To edit the individual 
MIDI events in a part, you have to open the part in a MIDI edi-
tor (see “The MIDI editors” on page 403). 

• Audio events can be displayed and edited directly in the 
Project window, but you can also work with audio parts con-
taining several events. This is useful if you have a number of 
events which you want to treat as one unit in the project. Au-
dio parts also contain information about the time position in 
the project.

An audio event and an audio part

Getting on-the-fly info with the Arrow tool

If the “Select Tool: Show Extra Info” option is activated in 
the Preferences dialog (Editing–Tools page), a tooltip will 
be shown for the Arrow tool, displaying information de-
pending on where you point it. For example, in the Project 
window event display, the tool will show the current pointer 
position and the name of the track and event you are point-
ing at.

Instrument This allows you to create a track for a dedicated instru-
ment, making VST instrument handling easier and more in-
tuitive. Instrument tracks have a corresponding channel 
strip in the Mixer. Each instrument track can have any num-
ber of automation tracks in the Project window. However, 
Volume and Pan are automated from within the Mixer. It is 
possible to edit instrument tracks directly in the Project 
window, using the Edit In-Place function (see “The In-
Place Editor” on page 422). For more information on in-
strument tracks, see the chapter “VST instruments and in-
strument tracks” on page 215.

MIDI For recording and playing back MIDI parts. Each MIDI 
track has a corresponding MIDI channel strip in the Mixer. 
It is possible to edit MIDI tracks directly in the Project 
window, using the Edit In-Place function (see “The In-
Place Editor” on page 422).
A MIDI track can have any number of automation tracks 
for automating Mixer channel parameters, insert and send 
effect settings, etc. 

Marker Marker tracks display markers which can be moved and 
renamed directly in the Project window (see the chapter 
“Using markers” on page 136).

Arranger The arranger track is used for arranging your project, by 
marking out sections in the project and determining in 
which order they are to be played back. See the chapter 
“The arranger track” on page 122 for details.

Ruler Ruler tracks contain additional rulers, displaying the time-
line from left to right. You can use any number of ruler 
tracks, each with a different display format if you wish. 
See “The ruler” on page 47 for more information about 
the ruler and the display formats.

Signature Time signature events can be added and edited on the 
signature track, or in the Tempo Track Editor. A project 
can have only one signature track. See the chapter “Edit-
ing tempo and signature” on page 452 for details.

Tempo You can create tempo changes within a project using the 
tempo track. A project can have only one tempo track. 
See the chapter “Editing tempo and signature” on page 
452 for details.

Transpose The transpose track allows you to set global key changes. 
A project can have only one transpose track, see the 
chapter “The transpose functions” on page 129.

Video For playing back video events. A project can have two 
video tracks.

Track type Description
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The track list
The track list displays all the tracks used in a project. It con-
tains name fields and settings for the tracks. Different track 
types have different controls in the track list. To see all the 
controls you may have to resize the track in the track list 
(see “Resizing tracks in the track list” on page 59).

• The track list area for an audio track:

• The track list area for an automation track (opened by 
clicking the Show/Hide Automation button on a track):

• The track list area for a MIDI track:

• You can decide for each track type which controls are 
shown in the track list – see “Customizing track controls” 
on page 573.

The Inspector
The area to the left of the track list is called the Inspector. 
This shows additional controls and parameters for the 
track you have selected in the track list. If several tracks 
are selected, the Inspector shows the setting for the first 
(topmost) selected track.

Opening the Inspector
To show the Inspector, proceed as follows:

1. On the toolbar, click the “Set up Window Layout” 
button.
A transparent pane appears, covering the Project window.

2. In the gray area in the middle, activate the Inspector 
option.

Mute & 
Solo

Record Enable & 
Monitor

Track 
name

Lane Display 
Type

Show/hide 
automation

Indicate whether effect sends, EQ, or insert effects are activated for 
the track. Click to bypass.

Musical/Linear 
Time Base

Lock 
track

Automation Read/Write Edit Channel Settings

Track  
activity  
indicator

Freeze Audio 
Track

Automation Read/Write

Automation parameter  
(click to select parameter)

Append 
automation 

track

Mute Lock track

Record Enable & 
Monitor

Track 
name

MIDI OutputBank Patch MIDI channel

Lock track and Lane display type

Automation 
Read/Write

Edit Channel 
Settings

Mute & 
Solo

Effect sends/
insert effects 
indicators and 
bypass

Edit 
In-Place

Track 
activity 
indicator
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Inspector handling
For most track classes, the Inspector is divided into a 
number of sections, each containing different controls for 
the track. Which sections are available in the Inspector 
depends on the selected track.

• You can hide or show sections by clicking on their 
names. 
Clicking the name for a hidden section brings it into view and hides the 
other sections. [Ctrl]/[Command]-clicking the section name allows you 
to hide or show a section without affecting the other sections. [Alt]/[Op-
tion]-clicking a section name shows or hides all sections in the Inspector.

• You can also use key commands to show different In-
spector sections.
These are set up in the Key Commands dialog, see “Setting up key com-
mands” on page 581.

Hiding a section does not affect its functionality. For 
example, if you have set up a track parameter or activated 
an effect, your settings will still be active even if you hide 
the respective Inspector section.

Not all Inspector tabs are shown by default. You can 
show/hide Inspector sections by right-clicking on an In-
spector tab and activating/deactivating the desired op-
tions on the Inspector Setup context menu.

Make sure that you right-click on an Inspector tab and 
not on the empty area below the Inspector, as this will 
open the Quick context menu instead.

Inspector sections
The Inspector contains the controls that can be found on 
the track list, plus some additional buttons and parame-
ters. In the table below, these additional settings and the 
different sections are listed. Which sections are available 
for which track type is described in the following sections.

Parameter Description

Auto Fades 
Settings 
button

Opens a dialog in which you can make separate Auto 
Fade settings for the audio track, see “Making Auto Fade 
settings for individual tracks” on page 121.

Edit Channel 
Settings

Opens the Channel Settings window for the track, allow-
ing you to view and adjust effect and EQ settings, etc., 
see “Using Channel Settings” on page 163.

Volume Use this to adjust the level for the track. Changing this 
setting will move the track’s fader in the Mixer window, 
and vice versa. See “Setting volume in the Mixer” on page 
157 to learn more about setting levels.

Pan Use this to adjust the panning of the track. As with the 
Volume setting, this corresponds to the Pan setting in the 
Mixer.

Delay This adjusts the playback timing of the audio track. Positive 
values delay the playback while negative values cause the 
track to play earlier. The values are set in milliseconds.

Input  
Routing

This lets you specify the input bus or MIDI input for the 
track. See “Setting up busses” on page 28 for informa-
tion about input busses.

Output 
Routing

Here you decide to which output the track is routed. For 
audio tracks you select an output bus (see “Setting up 
busses” on page 28) or Group channel, for MIDI tracks 
you select a MIDI output and for instrument tracks, you 
select the instrument to which it is routed.
42
The Project window



Audio tracks

For audio tracks, all settings and sections listed above are 
available.

Instrument tracks

As explained in the chapter “VST instruments and instru-
ment tracks” on page 215, the Inspector for an instrument 
track shows some of the sections from VST instrument 
channels and MIDI tracks.

MIDI tracks

When a MIDI track is selected, the Inspector contains a 
number of additional sections and parameters, affecting the 
MIDI events in realtime (e. g. on playback). Which sections 
are available for MIDI tracks is described in the chapter 
“MIDI realtime parameters and effects” on page 372.

Arranger track

For the arranger track, the Inspector displays the lists of 
available arranger chains and arranger events. See the 
chapter “The arranger track” on page 122 for details.

Folder tracks

When a folder track is selected, the Inspector shows the 
folder and its underlying tracks, much like a folder struc-
ture in the Windows Explorer or Mac OS X Finder.

You can click one of the tracks shown under the folder 
in the Inspector to have the Inspector show the settings 
for that track. This way, you do not have to “open” a folder 
track to make settings for tracks within it.

FX channel tracks

When an FX channel track is selected, the following con-
trols and sections are available:

• Edit button
• Volume control
• Pan control
• Output Routing pop-up menu
• Inserts section
• Equalizers section
• Equalizer Curve section
• Sends section
• Studio Sends section
• Surround Pan section
• Channel section
• Notepad section

Inserts section Allows you to add insert effects to the track, see the chap-
ters “Audio effects” on page 195 and “MIDI realtime pa-
rameters and effects” on page 372. The Edit button at the 
top of the section opens the control panels for the added 
insert effects.

Equalizers 
section

Lets you adjust the EQs for the track. You can have up to 
four bands of EQ for each track, see “Making EQ set-
tings” on page 164. The Edit button at the top of the sec-
tion opens the Channel Settings window for the track. 

Equalizer  
Curve section

Lets you adjust the EQs for the track graphically, by click-
ing and dragging points in a curve display.

Sends section Allows you to route an audio track to one or several FX 
channels (up to eight), see the chapter “Audio effects” on 
page 195. The Edit button above a slot opens the control 
panel for the first effect in each FX channel.  
For MIDI tracks, this is where you assign MIDI send ef-
fects. Clicking the Edit button above a slot opens the 
control panel for the corresponding MIDI effect.

Studio Sends The Studio Sends are used to route cue mixes to Control 
Room Studios. For a detailed description of Studios and 
Studio Sends, see the chapter “Control Room” on page 
179.

Surround Pan When the SurroundPanner is used for a track, this is also 
available in the Inspector. For further information, see 
“Using the SurroundPanner V5” on page 230.

Channel 
section

Shows a duplicate of the corresponding Mixer channel 
strip. The channel overview strip to the left lets you acti-
vate and deactivate insert effects, EQs and sends.

Notepad 
section

This is a standard text notepad, allowing you to jot down 
notes about the track.  
If you have entered any notes about a track, the icon next 
to the “Notepad” heading will light up to indicate this. 
Moving the pointer over the icon will display the Notepad 
text in a tooltip.

Network sec-
tion

This contains controls related to the Network functions of 
the program. For further information, see the chapter 
“Networking” on page 482.

User Panel Here you can display device panels, e. g. for external MIDI 
devices, audio track panels or VST insert effect panels. 
For information on how to create or import MIDI device 
and user panels, see the separate PDF document “MIDI 
Devices”.

Quick Controls Here you can configure quick controls, e. g. to use remote 
devices, see the chapter “Track Quick Controls” on page 
362.

Parameter Description
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FX channel tracks are automatically placed in a special 
folder, for easier management. When this folder track is 
selected, the Inspector shows the folder and the FX chan-
nels it contains. You can click one of the FX channels 
shown in the folder to have the Inspector show the set-
tings for that FX channel – this way you do not have to 
“open” a folder track to access the settings for the FX 
channels in it.

Group channel tracks

When a group channel track is selected, the following 
controls and sections are available:

• Edit button
• Volume control
• Pan control
• Output Routing pop-up menu
• Inserts section
• Equalizers section
• Equalizer Curve section
• Sends section
• Studio Sends section
• Surround Pan section
• Channel section
• Notepad section

Just like FX channel tracks, all group channel tracks are 
placed in a separate folder – when this is selected, the In-
spector shows the folder and the group channels it con-
tains. You can click one of the group channels shown in the 
folder to have the Inspector show the settings for that group 
channel – this way, you do not have to “open” a folder track 
to access the settings for the group channels in it.

Marker tracks

When the marker track is selected, the Inspector shows 
the marker list. For more information, see the chapter “Us-
ing markers” on page 136.

Ruler tracks 

For ruler tracks, the Inspector is not used.

Transpose track

When the transpose track is selected, the following con-
trols and sections are available:

• Mute button
• Keep Transpose in Octave range
• Toggle Timebase button
• Lock button
• Notepad section
• Network section

The transpose track controls are described in detail in the 
chapter “The transpose functions” on page 129.

Signature track and tempo track

For the signature track and the tempo track, the Inspector 
displays a list of all time signature events or tempo events. 
See the chapter “Editing tempo and signature” on page 
452 for details.

Video tracks

When a video track is selected, the Inspector contains a 
lock button for locking the track (see the section “Locking 
events” on page 74), a Mute button for interrupting video 
playback and two settings for video thumbnails: Show 
Frame Numbers and Show Thumbnails (see the section 
“Video files in the Project window” on page 524).

Video tracks make use of the Notepad and Network In-
spector tabs.

The toolbar
The toolbar contains tools and shortcuts for opening other 
windows and various project settings and functions.

You can show/hide most of the toolbar elements (except 
the Activate Project and “Set up Window Layout” buttons) 
by activating/deactivating the corresponding options on 
the context menu. The following options are available:

Option Description

Constrain Delay 
Compensation

This is described in the section “Constrain Delay 
Compensation” on page 225.

Media & Mixer 
Windows

When this is activated, buttons for opening or clos-
ing the MediaBay, the Pool, the Mixer, and the Con-
trol Room Mixer are displayed on the toolbar.
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How to further set up the toolbar is described in the 
section “Using the Setup options” on page 572.

The status line
The status line is displayed below the toolbar in the 
Project window. 

It displays the following information:

Clicking on any of the fields except the Record Time 
Max display opens the Project Setup dialog, where you 
can adjust the settings (see “The Project Setup dialog” on 
page 57).

• To show or hide the status line, click the “Set up Win-
dow Layout” button on the toolbar and activate or deacti-
vate the Status Line option.

The info line
The info line is displayed below the status line in the 
Project window. 

The info line shows information about the currently se-
lected event or part in the Project window. You can edit al-
most all values on the info line using regular value editing. 
Length and position values are displayed in the format cur-
rently selected for the ruler (see “The ruler” on page 47).

• To show or hide the info line, click the “Set up Window 
Layout” button on the toolbar and activate or deactivate 
the Info Line option.

Performance Meter When this is activated, meters for ASIO time usage 
and hard disk transfer load are displayed, see “About 
the VST Performance window” on page 25.

Network Controls When this is activated, buttons used when working 
in a network are displayed. For details, see the chap-
ter “Networking” on page 482.

Automation Mode When this is activated, the automation mode and a 
button to open/close the Automation panel are dis-
played on the toolbar. For details, see the chapter 
“Automation” on page 239.

Auto-Scroll When this is activated, buttons for the options “Auto-
Scroll” and “Suspend Auto-Scroll when Editing” are 
displayed, see “Auto-Scroll” on page 50.

Locators When this is activated, the left and right locator posi-
tions are displayed on the toolbar.

Transport Buttons When this is activated, the transport buttons from the 
Transport panel are also displayed on the toolbar.

Arranger Controls When this is activated, the controls used when work-
ing with the arranger track are displayed, see the 
chapter “The arranger track” on page 122.

Time Display When this is activated, the Transport panel’s time 
display is displayed on the toolbar.

Markers When this is activated, the Transport panel’s marker 
buttons are displayed on the toolbar.

Snap to Zero 
Crossing

This is described in the section “Snap to Zero 
Crossing” on page 49.

Tool Buttons When this is activated, tool buttons for editing in the 
Project window are displayed on the toolbar.

Color menu This shows/hides the color pop-up menu, see “Ap-
plying colors in the Project window” on page 577.

Nudge Palette Activate this to display the nudge buttons. These 
buttons can be used to nudge events or parts in the 
Project window or for trimming (see “Moving events” 
on page 69 and “Resizing events” on page 72).

Project Root Key Activate this to display the Project Root Key. For de-
tails, see the chapter “The transpose functions” on 
page 129.

Snap/Quantize These options are described in the sections “The 
Snap function” on page 48 and “The quantizing 
functions” on page 392.

Option Description

Option Description

Record Time Max This displays the time you have left for recording, 
depending on your project settings and the avail-
able hard disk space. Click in this field to display 
the remaining record time in a separate window.

Record Format This displays the sample rate and the bit resolution 
used for recording.

Project Frame Rate This displays the frame rate used in the project.

Project Audio Pull This displays the audio pull setting used in the 
project. For further information about audio pulls, 
see “The Project Setup dialog” on page 57.

Project Pan Law This displays the current Pan Law setting.

! Nuendo permits different sample rate settings for a 
project and the audio hardware. However, as a result 
the audio files in a project will not play back in their 
original pitch. If the “Record Format” field is high-
lighted in a different color, there is a sample rate 
mismatch and you should check the settings in the 
Project Setup dialog. The same applies to the 
Project Audio Pull field.
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The following elements can be selected for display and 
editing on the info line:

• Audio events
• Audio parts
• MIDI parts
• Video events
• Markers
• Automation curve points
• Transpose events
• Arranger events

When several elements are selected
• If you have selected several elements, the info line shows 
information about the first item in the selection. The values 
are displayed in color to indicate that several elements are 
selected.

• If you edit a value on the info line, the value change is 
applied to all selected elements, relatively to the current 
values.
If you have selected two audio events, the first being one bar long and the 
second two bars, the info line shows the length of the first event (one bar). 
If you now change this value to 3 bars in the info line, the other event will be 
resized by the same amount – and will thus be 4 bars long.

• To enter absolute values for the selected elements, 
press [Ctrl]/[Command] while modifying the value on the 
info line. In the example above, both events would be re-
sized to 3 bars. 
[Ctrl]/[Command] is the default modifier key for this – you can change 
this in the Preferences dialog (Editing–Tool Modifiers page, in the Info 
Line category).

Editing transpose and velocity for MIDI parts
When one or several MIDI parts are selected, the info line 
contains Transpose and Velocity fields.

• Adjusting the Transpose field transposes the selected 
parts in semitone steps.
Note that this transposition does not change the actual notes in the part 
– it is just a “play parameter”, affecting the notes on playback. The trans-
position you specify for a part on the info line is added to the transposi-
tion set for the whole track. For more information on transposing, see the 
chapter “The transpose functions” on page 129.

• Adjusting the Velocity field shifts the velocity for the se-
lected parts – the value you specify is added to the veloc-
ities of the notes in the parts.
Again, this velocity shift only affects the notes on playback, and again, 
the value you specify is added to the Vel.Shift. value set for the whole 
MIDI track in the Inspector.

The overview line
The overview line is displayed below the info line in the 
Project window. In the overview line, events and parts on 
all tracks are displayed as boxes.

• To show/hide the overview line, proceed as for the info 
line (see above), but activate the Overview Line option in-
stead.

You can use the overview line to zoom in or out, and for 
navigating to other sections of the project. This is done by 
moving and resizing the track view rectangle in the over-
view line:

• The track view rectangle indicates the section of the 
project currently displayed in the event display.

• You zoom in or out horizontally by resizing the rectangle.
Resize it by dragging the edges of the rectangle.

• You can drag the track view rectangle to view other 
sections of the project.
This can also be done by clicking anywhere in the upper part of the over-
view – the track view rectangle will be moved to where you clicked.
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The ruler

The ruler at the top of shows the timeline. Initially, the 
Project window ruler uses the display format specified in 
the Project Setup dialog (see “The Project Setup dialog” 
on page 57), as do all other rulers and position displays in 
the project. However, you can select an independent dis-
play format for the ruler by clicking the arrow button to the 
right of it and selecting an option from the pop-up menu 
(you can also bring up this pop-up menu by right-clicking 
anywhere in the ruler).

• The selection you make here affects the ruler, the info 
line and tooltip position values (which appear when you 
drag an event in the Project window).
You can also select independent formats for other rulers and position 
displays. 

• To set the display format globally (for all windows), use 
the primary display format pop-up on the Transport panel, 
or hold down [Ctrl]/[Command] and select a display for-
mat in any ruler.

• If you use the “Timecode” or “User” options and the 
“Show Timecode Subframes” option is activated in the 
Preferences dialog (Transport page), the frames will also 
display subframes.
There are 80 subframes per frame.

• For the “Feet+Frames” settings, there is an option in the 
Preferences dialog (Transport page) called 
“Feet’n’Frames Count from Project Start”.
When this is activated, time displays and rulers in Feet+Frames format 
will always start with 0’00 at the beginning of the project – regardless of 
any Start offset settings in the Project Setup dialog.

Using multiple rulers – ruler tracks
As described above, the Nuendo Project window contains 
a main ruler at the top of the event display, displaying the 
timeline from left to right.

If needed, you can have several rulers in the Project win-
dow, by adding ruler tracks to the project. Each ruler track 
contains an additional ruler.

• To add a ruler track, open the “Add Track” submenu 
from the Project menu and select “Ruler”.
A ruler track showing an additional ruler is added to the track list.

You can add any number of ruler tracks to a project, and 
position them as needed by dragging them up or down in 
the track list. Each of the rulers can show a separate dis-
play format.

• To select a display format for a ruler track, click on its 
name in the track list and select an option from the pop-up 
menu.

Option Positions and lengths displayed as

Bars+Beats Bars, beats, sixteenth notes and ticks. By default there 
are 120 ticks per sixteenth note but you can adjust this 
with the “MIDI Display Resolution” setting in the Prefer-
ences dialog (MIDI page).

Seconds Hours, minutes, seconds and milliseconds.

Timecode This format displays hours, minutes, seconds, and 
frames. The number of frames per second (fps) is set in 
the Project Setup dialog with the Frame Rate pop-up 
menu (see “The Project Setup dialog” on page 57).

Feet+Frames 
16 mm

Feet and frames, with 40 frames per foot.

Feet+Frames 
35 mm

Feet, frames and 1/4 frames, with 16 frames per foot.

Samples Samples.

fps (User) Hours, minutes, seconds and frames, with a user-defin-
able number of frames per second. You set the desired 
number of fps in the Preferences dialog (Transport page).

Time Linear When this is selected, the ruler will be linear relative to 
time. This means that if there are tempo changes on the 
tempo track, the distance between the bars will vary in 
Bars+Beats mode.

Bars+Beats 
Linear

When this is selected, the ruler will be linear relative to 
the meter position – bars and beats. This means that if 
there are tempo changes on the tempo track, there still 
will be the same distance between bars in Bars+Beats 
mode. If the ruler is set to a time-based mode, the dis-
tance between seconds will vary depending on the 
tempo changes.
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Note that ruler tracks are completely independent from the 
main event display ruler, as well as rulers and position dis-
plays in other windows. This means that:

• Each ruler track in a project can have its own display format.
• Ruler tracks are not affected by the display format setting in 

the Project Setup dialog (see “The Project Setup dialog” on 
page 57).

• Ruler tracks are not affected if you set the display format glo-
bally with the primary time display in the Transport panel.

Ruler tracks are affected by the “Show Timecode 
Subframes” option in the Preferences dialog (Transport 
page, see above).

The Snap function
The Snap function helps you to find exact positions when 
editing in the Project window. It does this by restricting 
horizontal movement and positioning to certain positions. 
Operations affected by Snap include moving, copying, 
drawing, sizing, splitting, range selection, etc.

• You turn Snap on or off by clicking the Snap icon on the 
toolbar.

When you are moving audio events with Snap activated, it 
is not necessarily the beginning of the event that is used 
as Snap position reference. Instead, each audio event has 
a snap point, which you can set to a relevant position in 
the audio (such as a downbeat, etc.).

The snap point is preferably set in the Sample Editor since 
it allows for a higher degree of precision (see “Adjusting 
the snap point” on page 288). You can however also set 
the snap point directly in the Project window, in the follow-
ing way:

1. Select an event.

2. Place the project cursor at the desired position within 
the selected audio event.

3. Pull down the Audio menu and select “Snap Point To 
Cursor”.
The snap point is set at the cursor position.

The snap point for an event is displayed as a blue line in the Project 
window.

The Snap Type pop-up menu
To determine how the Snap function works, open the 
Snap Type pop-up menu and select one of the available 
options.

In the Snap Type pop-up menu the following options are 
available:

Grid

If you select this Snap type, the Snap positions are set 
with the Grid Type pop-up menu. The options depend on 
the display format selected for the ruler. For example, if the 
ruler is set to show bars and beats, the grid can be set to 
bars, beats, or the quantize value set with the Quantize 
type pop-up menu. If a time or frame-based ruler format is 
selected, the Grid Type pop-up menu contains time or 
frame-based grid options, etc.

When Seconds is selected as ruler format, the Grid Type pop-up menu 
contains time-based grid options.

Snap activated.
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Grid Relative

If you select this Snap type, events and parts will not be 
“magnetic” to the grid. Rather, the grid determines the 
step size for moving the events. This means that a moved 
event will keep its original position relative to the grid.

For example, if an event starts at the position 3.04.01 (one 
beat before bar 4), Snap is set to Grid Relative and the Grid 
Type pop-up menu is set to “Bar”, you can move the event 
in steps of one bar – to the positions 4.04.01, 5.04.01 and 
so on. The event will keep its relative position to the grid, i. e. 
stay one beat before the bar lines.

• This only applies when dragging existing events or parts 
– when you create new events or parts this snap type 
works like “Grid”.

Events

This grid type makes the start and end positions of other 
events and parts become “magnetic”. This means that if 
you drag an event to a position near the start or end of an-
other event, it is automatically aligned with the start or end 
of the other event. For audio events, the position of the 
snap point is also magnetic (see “Adjusting the snap 
point” on page 288).

• Note that this includes marker events on the marker 
track.
This allows you to snap events to marker positions, and vice versa.

Shuffle

Shuffle is useful when you want to change the order of ad-
jacent events. If you have two adjacent events and drag 
the first one to the right, past the second event, the two 
events will change places.

The same principle works when changing the order of 
more than two events:

Magnetic Cursor

This grid type lets the project cursor become “magnetic”. 
Dragging an event near the cursor causes the event to be 
aligned with the cursor position.

Grid + Cursor

This is a combination of “Grid” and “Magnetic Cursor”.

Events + Cursor

This is a combination of “Events” and “Magnetic Cursor”.

Events + Grid + Cursor

This is a combination of “Events”, “Grid” and “Magnetic 
Cursor”.

Snap to Zero Crossing
When this option is activated on the toolbar or in the Pref-
erences dialog (Editing–Audio page), splitting and sizing 
of audio events is done at zero crossings (positions in the 
audio where the amplitude is zero). This helps you avoid 
pops and clicks which might otherwise be caused by sud-
den amplitude changes.

1 2 3 4 5

52431

Dragging event 2 past event 4…

…changes the order of events 2, 3 and 4.
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Auto-Scroll

“Auto-Scroll” and “Suspend Auto-Scroll when Editing” are activated

When the Auto-Scroll option is activated, the waveform 
display will scroll during playback, keeping the project cur-
sor visible in the window. You can find the Auto-Scroll but-
ton on the toolbars of the Project window and all editors.

• If the “Stationary Cursors” option is activated in the 
Preferences dialog (Transport page), the project cursor 
will be positioned in the middle of the screen (if possible).

Suspending Auto-Scroll
When editing parts or events during playback with Auto-
Scroll enabled, you may suddenly “lose sight” of the ed-
ited material as the display follows the project cursor.

If you do not want the Project window display to change 
when editing during playback, you can activate the “Sus-
pend Auto-Scroll when Editing” button. You will find this 
button right next to the Auto-Scroll button. When this op-
tion is enabled, auto-scrolling is suspended as soon as 
you click anywhere in the event display during playback.

Proceed as follows:

1. Open a project that contains audio or MIDI parts/
events.

2. Enable both the “Auto-Scroll” and the “Suspend Auto-
Scroll when Editing” buttons.

3. Start playback.

4. Edit an audio or MIDI part/event of your project (e. g. 
click and drag it to a different location on its track).
The Auto-Scroll button turns orange.

Auto-Scrolling is now suspended, i. e. when the project 
cursor moves to the right edge of the Project window, the 
display will not follow to keep the cursor visible.

As soon as playback stops or when you click the Auto-
Scroll button again, Nuendo will return to the normal Auto-
Scroll behavior.
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Creating new projects
The New Project command on the File menu allows you to 
create a new project, either as an empty project or based 
on a template:

1. Select “New Project…” from the File menu.
The templates list is displayed. By default, this list is empty. How to cre-
ate templates is described in the section “Save as Template” on page 
53.

2. Select a template (or “Empty”) and click OK.
A file dialog opens, allowing you to specify a location for the project 
folder. This will contain all files related to the project.

3. Select an existing folder or create a new folder and 
click OK.
A new, untitled project is created. If you selected a template, the new 
project will be based on this template and include the corresponding 
tracks, events, and settings.

Opening projects
The “Open…” command on the File menu is used for open-
ing saved project files. Project files created with Nuendo 
(file extension “.npr”), Cubase (file extension “.cpr”) and Se-
quel (extension “.steinberg-project”) can be opened. Note 
that program-specific settings which cannot be applied in 
Nuendo will be ignored.

1. Select “Open…” from the File menu.
A file dialog opens, allowing you to select a project.

2. Click Open to open the selected project.

• Several projects can be open at the same time.
This is useful if you want to copy parts or entire sections from one project 
to another.

3. If there is already an open project, you will be asked if 
you want to activate the new project.

• Click No to open the project inactive.
This significantly reduces load times, especially for large projects. 

• Click Activate to open and activate the new project.
The active project is indicated by the lit Activate Project button in the upper 
left corner of the Project window. To activate a different project, simply 
click its Activate Project button.

• You can also open project files by selecting an entry 
from the “Recent Projects” submenu of the File menu.
This submenu lists the projects you have recently worked with, with the 
most recent at the top of the list.

• You can also set Nuendo to automatically open a project 
when you launch the program (see “Startup Options” on 
page 56).

• You can drag projects from the MediaBay into the Nu-
endo application window (not into an existing Project win-
dow) to open them.

About the “Missing Ports” dialog
If you open a Nuendo project created on a different sys-
tem (other audio hardware), the program tries to find 
matching audio inputs and outputs for the i/o busses (this 
is one of the reasons why you should use descriptive, ge-
neric names for your input and output ports – see “Prepa-
rations” on page 29).

If the program cannot resolve all audio/MIDI inputs and 
outputs used in the project, a Missing Ports dialog will 
open. This allows you to manually re-route any ports spec-
ified in the project to ports available in your system.

Closing projects
The Close command on the File menu closes the active 
window. If a Project window is active, selecting this closes 
the corresponding project.

• If the project contains unsaved changes, you are asked 
whether you want to save it before closing.
If you select “Don’t Save” and have recorded or created new audio files 
since saving, you will be asked if you want to delete or keep these.
52
Working with projects



Saving projects

Save and Save As
The commands Save and Save As allow you to save the 
active project as a project file (file extension “.npr”). The 
Save command stores the project under its current name 
and location, while Save As allows you to rename and/or 
relocate the file. If a project has not been saved yet or if it 
has not been changed since it was last saved, only Save 
As is available.

A word about file extensions

Under Windows, file types are indicated by three letter file 
name extensions (such as *.npr for Nuendo project files). 

Under Mac OS X, it is not necessary to use file name ex-
tensions, since the file types are stored internally in the 
files. However, if you want your Nuendo projects to be 
compatible with both platforms, make sure that the “Use 
File Extension in File Dialog” option is activated in the 
Preferences dialog (General page). When this is acti-
vated, the proper file name extension is automatically 
added when you save a file.

Save New Version
This function is only available as a key command, by de-
fault [Ctrl]/[Command]-[Alt]/[Option]-[S]. When you use 
this function, an identical, new project file is being created 
and activated. 

The new file will get the same name as the original project, 
but with an incremental number attached. For example, if 
your project is called “My Project”, you will get new ver-
sions called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with 
edits and arrangements and want to be able to go back to 
a previous version at any time. The newest versions are al-
ways listed on the Recent Projects submenu of the File 
menu for instant access.

Save as Template
This function allows you to save the current project as a 
template. When you create a new project, the available 
templates are listed, allowing you to base the new project 
on a template.

Proceed as follows:

1. Set up a project.

2. Select “Save As Template…” from the File menu and 
save the project template under the desired name.

• Templates can contain clips and events just like regular 
projects.
If this is not what you want, make sure to remove all clips from the Pool 
before you save the project as a template.

Templates are always stored in the Templates folder, see 
“Where are the settings stored?” on page 579. 

Setting up a default template

If you always want the same default project to open when 
you launch Nuendo, you can save a default template. Pro-
ceed as follows:

1. Set up a project.

2. Select “Save As Template…” from the File menu and 
save the project template with the name “default”.

3. Open the Preferences dialog and select the General 
page.

4. Open the “On Startup” pop-up menu and select 
“Open ‘Default’ Template”.

The next time you launch Nuendo, the default template will 
automatically be opened. For details on the other Startup 
options, see “Startup Options” on page 56.

Reverting to the last saved version
If you select “Revert” from the File menu, you will be asked 
whether you really want to revert to the last saved version 
of the project. If you click “Revert”, all changes you have 
made since saving will be discarded.

If you have recorded or created new audio files since sav-
ing, you will be asked whether you want to delete or keep 
these.

! Generally, we recommend that you save project files 
in their project folders, to keep the projects as 
manageable as possible.
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Auto Save

If you activate the Auto Save option in the Preferences dia-
log (General page), Nuendo will automatically save backup 
copies of all open projects with unsaved changes.

These backup copies are named “<project name>-xx.bak”, 
where xx is an incremental number. Unsaved projects are 
backed up in a similar way as “UntitledX-xx.bak”, with X 
being the incremental number for unsaved projects. All 
backup files are saved in the project folder. 

• Use the “Auto Save Interval” setting to specify the time 
intervals in which a backup copy will be created.

• Use the “Maximum Backup Files” option to specify how 
many backup files will be created with the Auto Save 
function.
When the maximum number of backup files is reached, the existing files 
will be overwritten (starting with the oldest file). 

With this option only the project files themselves will 
be backed up. If you want to include the files from the Pool 
and save your project in a different location, you need to 
use the “Back up Project” function.

The Archive and Backup functions

Prepare Archive
The “Prepare Archive” function verifies that every clip ref-
erenced in the project is located in the same folder, and 
takes actions if that is not the case:

• Any files that are located outside the current project 
folder will be copied into it.
Please note that audio files residing within the project folder are not cop-
ied to the audio folder. Therefore, you have to copy them there manually 
before backing up the audio folder or save them separately during 
backup, see below.

• If any processing has been applied, you will be asked 
whether you want to Freeze Edits.
If you do this, you do not have to archive the Edits folder. Everything be-
longing to the project will be contained in the project file and the Audio 
folder.

Once you have performed a Prepare Archive operation, 
you can use the “Back Up Project” function to create a 
backup of the project file, containing copies of all neces-
sary media files (with the exception of VST Sound content, 
see below).

It is not necessary to archive the Images folder, since 
these images can be recreated by Nuendo. You may also 
find a file with the extension “.csh” in the project folder. 
This contains image information for edited clips and other 
data that can be recreated, so it can safely be deleted.

Back up Project
This function is very useful if you want to create a backup 
copy of a project for your archive. It can also be used to 
prepare projects for delivery so that they only contain the 
necessary work data (while leaving the original project un-
touched). When you back up a project, all media files (ex-
cept those coming from VST Sound archives) can be 
included as a copy.

! Video clips are always referenced and not stored in 
the project folder.

! VST Sound content provided by Steinberg is copy-
protected and will not be included in the backup 
project. If you want to use a backup copy of a project 
using such data on a different computer, make sure 
that the corresponding content is also available on 
that computer.
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1. Select “Back up Project…” from the File menu. 
A file dialog opens in which you can choose an existing empty folder or 
create a new folder to save the project.

2. Click OK.
The “Back up Project Options” dialog opens.

This dialog contains the following options:

3. Make the desired settings.

4. Click OK. 
A copy of the project is saved in the new folder. The original project is 
not affected.

Cleanup
The Cleanup function on the File menu helps you to save 
hard disk space by locating and – if you like – deleting un-
used audio files in the project folders on your disk.

1. Select “Cleanup…” from the File menu.
If there are any open projects, an alert shows. Clicking “Close” closes all 
open projects and brings up the dialog “Cleanup Nuendo Project Folders”.

2. To restrict the Cleanup function to a certain folder, 
click the “Search Folder” button and select the folder.
The default setting is that the Cleanup function is applied to all folders on 
all hard disks. Only select a specific folder if you are certain it does not 
contain audio files used in other projects (outside the folder), see below. 
You can reset the function to search all folders by opening the “Search 
Folder” dialog again and clicking “Cancel”.

3. Click the Start button.
Nuendo will now scan the selected folder (or all hard disks) for Nuendo 
project folders and check for audio and image files (in the Audio, Edits 
and Images subfolders) that are not used by any project. The found files 
are listed in the dialog.

4. When the scan is complete, you can select files by 
clicking in the list.
Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to se-
lect a range of files. You can also click the Select All button to select all 
files in the list.

In the following situations, the Cleanup function will list 
files that are not unused:

• If you have moved or renamed files or folders (without updat-
ing the project files to use the new paths), there is no way for 
Nuendo to know that these files are used in a project. 

• If you perform the Cleanup function on a folder in which there 
are audio files belonging to other projects (outside the folder), 
these files will be considered “unused”.

• Also, make sure that you do not delete any files used in 
other applications, or files that you generally want to keep!

However, you can always safely delete image files since 
these can be reconstructed by the program, if necessary.

5. Delete any files you do not want to keep by selecting 
them and clicking Delete.

6. Close the dialog by clicking the Close button.

Option Description

Project Name Enter a project name if you want to change it from the de-
fault (the current name of the project).

Keep Current 
Project Active

When this option is activated, the current project will still 
be the active project after clicking OK. If you wish to switch 
to the new backup project instead, deactivate this option.

Minimize Audio 
Files

If this is activated, only the audio file portions that are actu-
ally used in the project will be included. This can significan-
tly reduce the size of the project folder (if you are using 
small sections of large files), but it also means you cannot 
use other portions of the audio files if you continue working 
with the project in its new folder.

Freeze Edits This will perform a Freeze Edits operation, making all pro-
cessing and applied effects permanent to each clip in the 
Pool, see “Freeze Edits” on page 277.

Remove 
Unused Files

When this is activated, only files in the Pool that are actu-
ally used in the project will be stored in the new folder.

Do Not Back 
up Video

When this is activated, any video clips on the video track 
or in the Pool of the current project will not be included in 
the backup project.
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Startup Options
The “On Startup” pop-up menu in the Preferences dialog 
(General page) allows you to specify what happens when 
you launch Nuendo. 

The following options are available:

Nuendo Open Document Options dialog

The Open Document Options dialog lists your recently 
used projects. It will open in two cases:

• If you launch Nuendo with the “Show Open Options Di-
alog” option selected on the “On Startup” pop-up menu in 
the Preferences dialog (General page).

• If you hold down [Ctrl]/[Command] while launching Nu-
endo.

• To open a project, select it and click the “Open Selec-
tion” button. 

• To open another project not listed here, click the “Open 
Other…” button. 
A file dialog opens that allows you to look for the desired file on your disk. 

• To create a new project, click the “New Project” button.

Option Description

Do Nothing Nuendo launches without opening a project.

Open Last 
Project

The last saved project is opened on launch.

Open ‘Default’ 
Template

The default template is opened, see “Setting up a de-
fault template” on page 53.

Show Open 
Options Dialog

The Open dialog opens on launch, allowing you to man-
ually locate and open the desired project.

Show Template 
Dialog

The Template dialog opens on launch, allowing you to 
create a new project from one of the templates.

Show Open 
Options Dialog

The Open Document Options dialog opens on launch, 
see below. It allows you to make a different choice each 
time you launch Nuendo.
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The Project Setup dialog
General settings for the project are made in the Project 
Setup dialog. This is opened by selecting “Project 
Setup…” from the Project menu.

If the “Run Setup on Create New Project” option is ac-
tivated in the Preferences dialog (General page), the Pro-
ject Setup dialog will open automatically when you create 
a new project. 

The following settings are available in the Project Setup 
dialog:

Setting Description

Author Here you can add a name that will be written as the project 
author into the iXML chunk when exporting audio files with 
the corresponding option activated (see “AIFF files” on 
page 478). The default setting for this can be set in the 
Preferences dialog (General–Personalization page).

Company Here you can add a name that will be written as the com-
pany name into the iXML chunk when exporting audio files 
with the corresponding option activated (see “AIFF files” 
on page 478). The default setting for this can be set in the 
Preferences dialog (General–Personalization page).

Start The start time of the project. Allows you to have the project 
start at another time than zero. Also used for setting the 
sync start position when synchronizing Nuendo to external 
devices (see the chapter “Synchronization” on page 496). 
The format of this value is always in timecode. When you 
change this setting you will be asked whether you want to 
keep the project content at its timecode positions. “Yes” 
means that all events will stay at their original timecode po-
sitions – i. e. they will be moved in relation to the start of the 
project. “No” means that all events keep their position rela-
tive to the project start. See also the note on Feet+Frames 
in the section “The ruler” on page 47.

Length The length of the project. Nuendo is capable of having 
longer lengths than 24 hours because the timecode in-
cludes a “day” field. This can be handy when creating 
projects that use “time of day” timecode and cross the 24 
hour mark. The maximum project length is 10 days.

Frame Rate This setting determines both the timecode standard and 
frame rate for the project, see “Timecode standards” on 
page 498. The frame rate of a video file used in a project 
should match the frame rate set for a project. The “Get 
From Video” button allows you to set the project frame 
rate to the frame rate of an imported video file, see the 
section “Adopting the video frame rate” on page 523. 
When synchronizing Nuendo to an external device, make 
sure that this setting corresponds to the frame rate of any 
incoming timecode. However, there might be situations 
where perfect synchronization does not matter to you and 
you do not want to change the project frame rate. In this 
case, the frame rate mismatch will be indicated on the 
Transport panel in the Sync section.

Audio Pull-up/
Pull-down

When working with film transfers, this option is used to 
synchronize sound and images correctly. The pop-up 
menu is separated into two parts. In the upper part the 
pull factors available for your hardware are displayed. The 
lower part shows pull factors that are not supported by 
your audio hardware. If you select a non-supported pull 
factor, it will be highlighted in a different color. Audio pull-
up and pull-down is described in detail in the section 
“Adjusting audio playback speed” on page 531.

Display Format This is the global display format used for all rulers and po-
sition displays in the program, except ruler tracks (see 
“Ruler tracks” on page 44). However, you can make inde-
pendent display format selections for the individual rulers 
and displays if you like.
For descriptions of the different display format options, 
see “The ruler” on page 47.

Display Offset Offsets the time positions displayed in the ruler, etc., al-
lowing you to compensate for the Start position setting. 
Typically, if you synchronize Nuendo to an external source 
starting at a frame other than zero, you set the Start posi-
tion to this value. However, if you still want the display in 
Nuendo to start at zero, set the Display Offset to the 
same value.

Setting Description
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Zoom and view options
Zooming in the Project window is done according to the 
standard zoom techniques, with the following special notes:

• When you are using the Zoom tool (magnifying glass), 
the result depends on the “Zoom Tool Standard Mode: 
Horizontal Zooming Only” option in the Preferences dialog 
(Editing–Tools page).
If this is activated and you drag a selection rectangle with the Zoom tool, 
the window will only be zoomed horizontally (track height will not change). 
If the option is off, the window will be zoomed both horizontally and verti-
cally.

• When using the vertical zoom sliders, the tracks are 
scaled relatively. 
In other words, if you have made any individual track height adjustments 
(see below), the relative height differences are maintained.

You find the following options are available on the Zoom 
submenu on the Edit menu:

• If the “Zoom while Locating in Time Scale” option is ac-
tivated in the Preferences dialog (Transport page), you 
can also zoom by clicking in the ruler and dragging up or 
down with the mouse button pressed.
Drag up to zoom out; drag down to zoom in.

Bar Offset This works just like “Display Offset” described above, in 
that it offsets the time positions in the ruler by a number 
of bars, allowing you to compensate for the Start position 
setting. The difference is that Bar Offset is only used 
when the “Bars+Beats” display format is selected (see 
“The ruler” on page 47).

Sample Rate The sample rate at which Nuendo records and plays au-
dio. The order of the menu items depends on the sample 
rates available for your audio hardware. Supported set-
tings are displayed in the upper part of the menu, non-
supported settings are displayed in the lower part. Re-
garding the sample rate, there are two possible scenar-
ios: Either your audio hardware generates the audio clock 
signals itself or it is clocked externally, i. e. receives sig-
nals from an external sample clock source. 
If the sample rate is generated internally, the following ap-
plies: When you select a sample rate non-supported by 
your audio hardware (from the lower part of the menu), it 
is highlighted in a different color and the corresponding 
tooltip shows a warning. In this case you must set a dif-
ferent sample rate to make your audio files play back 
properly. When you specify a project sample rate that 
your audio hardware supports but which is different from 
the current audio hardware sample rate, and you confirm 
your settings by clicking OK, the sample rate setting of 
the audio hardware is automatically changed to the 
project sample rate. 
If your audio hardware is clocked externally, ensure that 
the project sample rate corresponds to the external sam-
ple rate. Furthermore, you should “tell” Nuendo that it re-
ceives external clock signals in the Device Setup dialog 
on the page of your audio driver by activating the “Exter-
nally Clocked” option. When you now change the project 
sample rate, it will be highlighted to inform you about a 
possible sample rate mismatch.

Bit Resolution/
Record File 
Type

When you record audio in Nuendo, the files that are cre-
ated will be of this resolution and file type, see “Selecting 
a recording file format” on page 93.

Stereo Pan 
Law

Decides whether panning uses power compensation or 
not, see “About the “Stereo Pan Law” setting” on page 
162.

! While most Project Setup settings can be changed 
at any time, you should set the sample rate directly 
after creating a new project! If you change the sam-
ple rate at a later stage, you must convert all audio 
files in the project to the new sample rate to make 
them play back properly.

Setting Description

Option Description

Zoom In Zooms in one step, centering on the project cursor.

Zoom Out Zooms out one step, centering on the project cursor.

Zoom Full Zooms out so that the whole project is visible. “The 
whole project” means the timeline from the project 
start to the length set in the Project Setup dialog (see 
above).

Zoom to 
Selection

Zooms in horizontally and vertically so that the current 
selection fills the screen.

Zoom to Selec-
tion (Horiz)

Zooms in horizontally so that the current selection fills 
the screen.

Zoom to Event This option is available only in the Sample Editor (see 
“Zooming” on page 287).

Zoom In Vertically Zooms in one step vertically.

Zoom Out 
Vertically

Zooms out one step vertically.

Zoom In Tracks Zooms in on the selected track(s) one step vertically.

Zoom Out Tracks Zooms out the selected track(s) one step vertically.

Zoom Selected 
Tracks 

This zooms in vertically on the selected track(s) and 
minimizes the height of all other tracks.

Undo/Redo 
Zoom

These options allow you to undo/redo the last zoom 
operation.
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• You can zoom the contents of parts and events verti-
cally, using the waveform zoom slider in the top right cor-
ner of the event display.
This is useful when viewing quiet audio passages.

• If you activate the option Quick Zoom in the Preferences 
dialog (Editing page), the contents of parts and events will 
not be continuously redrawn when you zoom manually.
Instead, the contents are redrawn once you have stopped changing the 
zoom – activate this if screen redraws are slow on your system.

Resizing tracks in the track list
• You can change the height of an individual track by 
clicking on its lower border in the track list and dragging 
up or down.
To change the height of all tracks simultaneously, hold down [Ctrl]/
[Command] and resize one of the tracks in this way. If “Snap Track 
Heights” is activated on the Track scale pop-up (see below), the track 
height will change in fixed increments when you resize it.

• You can also change the width of the track list area, by 
dragging the border between the track list and the event 
display.

• By default, the controls shown for tracks in the track list 
will adapt to the track size. This means that when resizing 
a track’s height or width the controls will be placed where 
they best “fit in”.
If you prefer to have the controls in fixed positions, you can deactivate the 
“Wrap Controls” option in the Track Controls settings dialog (see “Cus-
tomizing track controls” on page 573).

• You can use the Track scale pop-up (opened by clicking 
the arrow button above the vertical zoom control) to set the 
number of tracks to view in the current Project window.
The track height will be adjusted to show only the number of tracks speci-
fied on the pop-up menu. By selecting “Zoom N Tracks” from the pop-up 
you can manually set the number of tracks to fit in the current Project win-
dow.

• Tracks can also be divided vertically in lanes – see “Ed-
iting in Lane Display mode” on page 76.

The Enlarge Selected Track option
When this option is activated on the Edit menu (or in the 
Preferences dialog, Editing–Project & Mixer page), the se-
lected track is enlarged automatically. This is useful if you 
are stepping through the tracks in the track list, to check 
or edit the settings. The tracks will revert to the size they 
had before when they are deselected. You can adjust the 
size directly in the track list if the default enlargement fac-
tor does not suit you. 

While this is the program behavior you will want in most 
cases, it may be a disadvantage when changing the track 
height you started out with for one or more tracks (i. e. their 
“original” height, before “Enlarge Selected Track” was ac-
tivated). As soon as you try to resize a track, it is selected 
and automatically enlarged. Instead of turning off “Enlarge 
Selected Track”, resizing the desired track(s) and the acti-
vating “Enlarge Selected Track” again, you can resize a 
track in the track list without selecting it.

Proceed as follows:

1. Move the mouse pointer over the lower border of the 
(unselected) track you want to resize.
The mouse pointer turns into a divider symbol.

! To get an approximate reading on the level of the au-
dio events by viewing the waveforms, make sure this 
slider is all the way down. Otherwise, zoomed wave-
forms may be mistaken for clipped audio.

! This behavior is different when “Enlarge Selected 
Track” is activated on the Edit menu (see below).
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2. Hold down [Alt]/[Option] and drag the lower border of 
the track until it reaches the desired height.
Now, when you select this track, (and “Enlarge Selected Track” is acti-
vated), it will be enlarged. It will revert to the changed size, when you se-
lect a different track.

Zoom presets and cycle markers
The pop-up menu to the left of the horizontal zoom control 
allows you to select, create and organize zoom presets. 
These are useful if you want to toggle between different 
zoom settings (e. g. one where the whole project is dis-
played in the project window and another with a high 
zoom factor for detailed editing). With this pop-up menu, 
you can also zoom in on the area between cycle markers 
in the project.

The upper part of the menu lists the zoom presets:

• To store the current zoom setting as a preset, select 
Add from the pop-up menu.
A dialog opens, allowing you to type in a name for the preset.

• To select and apply a preset, select it from the pop-up 
menu.

• The “Zoom Full” preset is always available. Selecting 
this option zooms out so that the whole project is visible. 
“The whole project” means the timeline from the project 
start to the length set in the Project Setup dialog (see 
“The Project Setup dialog” on page 57).

• If you want to delete a preset, select “Organize…” from 
the pop-up menu.
In the dialog that opens, select the preset in the list and click the Delete 
button. The preset is removed from the list.

• If you want to rename a preset, select “Organize…” 
from the pop-up menu.
In the dialog that opens, select the desired preset in the list and click the 
Rename button. A second dialog opens, allowing you to type in a new 
name for the preset. Click OK to close the dialogs.

The middle part of the pop-up menu lists any cycle mark-
ers you have added to the project:

• If you select a cycle marker from this menu, the event 
display is zoomed in to encompass the marker area.

• You cannot edit the cycle markers in this pop-up menu. 
For information on editing markers, see “The Marker win-
dow” on page 138.

The Zoom history
Nuendo maintains a history of recent zoom stages, allow-
ing you to undo and redo zoom operations. This way you 
can zoom in several steps and then easily go back to the 
zoom stage at which you started.

There are two ways to invoke Undo Zoom and Redo 
Zoom:

• Use the items on the Zoom submenu on the Edit menu.
You can also assign key commands for these.

• Double-click with the Zoom tool (magnifying glass) to 
Undo Zoom.
Press [Alt]/[Option] and double-click to Redo Zoom.

Adjusting how parts and events are shown
The Preferences on the File menu (the Nuendo menu, un-
der Mac OS X) contains several settings for customizing 
the display in the Project window.

The Event Display page contains common settings for all 
track types:

Click here…

…to open the context 
menu.

! Zoom presets are global for all projects, i. e. they are 
available in all projects you open or create.

! Only the cycle markers you create in the current 
project are available on the menu.

Option Description

Colorize Event 
Background

Determines whether the backgrounds or “contents” 
(waveforms, etc.) of parts and events will be colorized, 
see “Handling tracks” on page 61.

Show Event 
Names

Determines whether the names of parts and events are 
shown in the Project window.
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The Event Display–Audio page contains settings for audio 
events:

The Event Display–MIDI page contains settings for MIDI 
parts:

Handling tracks
To add a track to the project, open the “Add Track” sub-
menu from the Project menu and select a track type. The 
new track is added below the currently selected track in 
the track list.

• The items on the “Add Track” submenu are also avail-
able on the context menu.
This is accessed by right-clicking the track list.

• If you select the Audio, MIDI, Group Channel, or Instru-
ment option from the Add Track submenu, a dialog opens, 
allowing you to insert several tracks in one go.
You just need to enter the desired number of tracks in the Count field.

• For audio and group channel tracks, the channel config-
uration – mono, stereo or surround configuration – can be 
set in the Configuration pop-up menu.

• The Choose Track Preset option in the Add Track dia-
log is described in the chapter “Working with track pre-
sets” on page 356.

• In the Preferences dialog (Editing–Project & Mixer 
page), you can find the “Auto Track Color Mode” option.
This offers you several options for automatically assigning colors to 
tracks that are added to the project.

Once you have created tracks, you can manipulate and re-
arrange them in various ways:

• To rename a track, double-click in the name field and 
type in a new name.
If you hold down any modifier key when pressing [Return] to close the 
name field, all events on the track will get the name you entered.

Transparent 
Events

When this is activated, events and parts will be transpar-
ent, showing the waveforms and MIDI events only.

Show Data on 
Small Track 
Heights

If this is activated, the contents of events and parts will be 
shown, even if the height of a track is very small.

Option Description

Interpolate 
Audio Images

If the option is deactivated, single sample values are drawn 
as “steps”. If the option is activated they are interpolated to 
form “curves”.

Outline 
Waveforms

Determines whether audio waveforms are displayed as 
solid images or with an outline. This selection affects all 
waveform images in the Project window, Sample Editor, 
and Audio Part Editor.

Show Event 
Volume Curves 
Always

If this is activated the “volume curves” created with the 
volume and fade handles are always shown – if not, the 
curves are only shown for selected events.

Thick Fade 
Lines

If this option is activated, the fade lines and volume 
curves are thicker, increasing their visibility.

Show 
Waveforms

Determines whether audio waveforms are shown at all.

Background 
Color 
Modulation

When this is activated, the backgrounds of audio wave-
forms are displayed in a different way, reflecting the 
waveform dynamics. This is especially useful to get an 
overview when working with small track heights.

Option Description

Default Edit 
Action

Determines which editor is opened when you double-
click a MIDI part, or select it and press [Ctrl]/[Com-
mand]-[E].

Part Data  
Mode

Determines if and how events in MIDI parts are shown in 
the Project window: as score notes, as drum notes (Nu-
endo Expansion Kit only) or as lines. If “No Data” is se-
lected, events will not be shown at all. Nuendo Expansion 
Kit only: Note that this setting is overridden for tracks with 
drum maps if the “Edit as Drums when Drum Map is as-
signed” option (see below) is activated.

Show 
Controllers

Governs whether non-note events (controllers, etc.) are 
shown in MIDI parts in the Project window.

Edit as Drums 
when Drum 
Map is 
assigned (Nu-
endo Expansion 
Kit only)

If this is activated, parts on MIDI tracks with drum maps 
assigned will be shown with drum note symbols in the 
Project window. Also, the parts will automatically open in 
the Drum Editor when double-clicked (overriding the De-
fault Edit Action setting above).

Note Name 
Style

Determines how MIDI note names (pitches) are dis-
played in editors, etc.

Option Description
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• To select a track, click on it in the track list.
A selected track is indicated by a light gray color in the track list.

• To select several tracks press [Ctrl]/[Command] and 
click on them. [Shift]-click to select a continuous range of 
tracks.

• To move a track, click and drag it up or down in the list.

• To duplicate a track, complete with all contents and 
channel settings, right-click the track list and select “Du-
plicate tracks” from the context menu, or select “Duplicate 
tracks” from the Project menu.
The duplicated track will appear below the original track.

• You can select a default color for a track with the Select 
Colors pop-up menu on the toolbar. The applied color will 
be used for all events on the track and will also be shown 
in the Mixer. You can override the default track color for in-
dividual events and parts by using the Color tool or the 
Select Colors pop-up menu. For more information, see 
“Applying colors in the Project window” on page 577.
The “Colorize Event Background” option in the Preferences dialog 
(Event Display page) determines whether the backgrounds or waveforms 
of events will be colorized.

• To remove a track, right-click on it in the track list and 
select “Remove Selected Tracks” from the context menu.
You can also remove multiple selected tracks, by selecting “Remove Se-
lected Tracks” either from the context menu or from the Project menu. 
Furthermore, you can remove all tracks not containing any events by se-
lecting “Remove Empty Tracks” from the Project menu.

• To change the track height of an individual track, click 
on its lower border in the track list and drag up or down, 
see “Resizing tracks in the track list” on page 59.

Note that you can also automatically enlarge the se-
lected track, see “The Enlarge Selected Track option” on 
page 59.

Disabling audio tracks
Audio tracks can be disabled by selecting “Disable Track” 
from the track list context menu. Disabling a track is similar 
to muting it (see “Muting events” on page 75), since a dis-
abled track will not be played back. However, disabling a 
track not only “zeroes” the output volume from the track, 
but actually shuts down all disk activity for it. For more in-
formation, see “About track disable/enable” on page 87.

Track folding
On the Project menu you will find the Track Folding sub-
menu, allowing you to quickly show, hide or invert what is 
displayed in the Project window event display. This en-
ables you for example to divide the project into several 
parts (by creating several folder tracks for the different 
project elements) and showing/hiding their contents by 
selecting a menu function (or using a key command). You 
can also fold in automation tracks this way. The following 
options are available:

• Toggle Selected Track
When you select this menu option, the fold state of the selected track is 
reversed, i. e. if the track was folded in (its elements (subtracks) were hid-
den), it is now unfolded (all subtracks displayed) and vice versa.

• Fold Tracks
Select this menu option to fold in all open folder tracks in the Project win-
dow. Please note that the exact behavior of this function depends on the 
“Deep Track Folding” setting in the Preferences dialog, see below.

• Unfold Tracks
Select this menu option to unfold all folder tracks in the Project window. 
Please note that the exact behavior of this function depends on the 
“Deep Track Folding” setting in the Preferences dialog, see below.

• Flip Fold States
Select this menu option to flip the fold states of the tracks in the Project 
window. This means that all tracks that were folded in will be unfolded 
and all unfolded tracks will be folded in, respectively.

You can assign key commands for these menu options 
in the Key Commands dialog (Project category).

This track is selected.
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In the Preferences dialog (Editing–Project & Mixer page), 
you can find the following option affecting the track folding 
behavior:

• Deep Track Folding
When this is activated, any folding settings you make in the Track Fold-
ing submenu of the Project menu also affect the subelements of the 
tracks, i. e. if you fold in a folder track which contains 10 audio tracks 5 of 
which have several automation tracks open, all these audio tracks within 
the folder track will be folded in as well.

Dividing the track list
It is possible to divide the track list into two parts. Both 
sections will have independent zoom and scroll controls (if 
needed), but resizing the window vertically will affect the 
lower section only (if possible). This is useful if you’re 
working with a video track along with multi-track audio for 
example. This way, you can place the video track in the 
upper track list, letting you scroll the audio tracks sepa-
rately in the lower track list, referencing them against the 
video track.

• To divide the track list, click the “Divide Track List” but-
ton in the top right corner of the Project window just be-
low the ruler.

• To revert to a single track list, click the button again.

When the track list is divided into two parts, the following 
applies:

• If you add tracks from the Add Track submenu of the 
Project menu, video tracks, marker tracks, and arranger 
tracks are automatically placed in the upper part of the 
track list.
If the track list already contains tracks any video, marker, or arranger 
tracks, these are automatically moved to the upper part when you divide 
the track list. All other types of tracks are placed in the lower part.

• If you add tracks from the context menu invoked by 
right-clicking the track list, the tracks are added to the part 
of the track list in which you click.

• You can move any type of track from the lower track list 
to the upper and vice versa by right-clicking it in the track 
list and selecting “Toggle Track List” from the context 
menu.

• You can resize the upper part by clicking and dragging 
the divider between the track list sections.

Switching between musical and linear time 
base
Tracks can be either musical (tempo) or linear (time) 
based.

• On a track using linear time base, the events will be po-
sitioned on specific time positions – changing the play-
back tempo will not affect the time position of events.

• On a track using musical time base, the positions of 
events are represented as meter values (bars, beats, 1/16th 
notes and ticks, with 120 ticks per 1/16th note). If you 
change the playback tempo, the events will play back at an 
earlier or later time.

• In the Preferences dialog (Editing page), you can find 
the “Default Track Time Type” option.
This allows you to specify the default track time type for new tracks (au-
dio, group/FX, MIDI, and marker tracks). When you change this setting, 
all new tracks will use the selected time type. You can choose between 
“Musical”, “Time Linear” and “Follow Transport Main Display”. Selecting 
“Musical” will cause all added tracks to be set to musical time type. 
When you select “Time Linear”, all new tracks will use linear time base. 
The third option uses the primary time format setting on the Transport 
panel. When this is set to “Bars+Beats”, tracks with musical time base 
will be added. When this is set to any of the other options (Seconds, 
Timecode, Samples, etc.), all new tracks will use linear time base.
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Whether to use musical or linear time base depends on the 
type of project and recording situation. You can always 
change this setting individually for each track, by clicking 
the musical/linear time base button in the Inspector or track 
list. Musical time base is indicated by a note symbol, while 
linear time base is indicated by a clock symbol.

For more information about tempo changes, see the chap-
ter “Editing tempo and signature” on page 452.

Adding events to a track
There are a number of ways to add events to a track:

• By recording (see “Basic recording methods” on page 
91).

• By dragging files and dropping them on the track at the 
desired position.

You can create events by dragging and dropping from the 
following locations:

• The desktop
• The MediaBay and its related windows (see the chapter “The 

MediaBay” on page 334)
• The Pool
• A library (a Pool file that is not attached to a project)
• The “Find media” dialog
• The Project window of another open project
• The Audio Part Editor of any open project

• The Sample Editor – press [Ctrl]/[Command] and drag to cre-
ate an event of the current selection, or click in the left column 
of the region list and drag to create an event from a region.

While you drag the clip in the Project window, its position will be 
indicated by a marker line and a numerical position box (see also “Using 
drag and drop” on page 325).

• By selecting “Audio File…” or “Video File…” from the 
Import submenu on the File menu.
This opens a file dialog, allowing you to locate the file you wish to import. 
When you import a file this way, a clip is created for the file and an event 
that plays the whole clip is inserted on the selected track, at the position 
of the project cursor. 
You can also import MIDI files by using the Import submenu, but this 
works in a slightly different way (see “Exporting and importing standard 
MIDI files” on page 560).

• By grabbing audio CD tracks and converting them to au-
dio files (see “Importing audio CD tracks” on page 553).

• By importing only the audio portion of a video file and 
converting it to an audio file (see “About thumbnail cache 
files” on page 524).

• By using Copy and Paste on the Edit menu.
This allows you to copy all kinds of events between projects. You can 
also copy events within the project, e. g. from the Sample Editor.

• By drawing.
Some types of events (markers and automation events) can be drawn di-
rectly into the Project window. For audio and MIDI tracks, you can draw 
parts (see “Creating parts” on page 65).

Audio file import options

When you are importing audio files there are a number of 
options concerning how the files are treated by Nuendo: 

• You can choose to copy the file into the audio folder of the 
project and have the project make reference to the copied file 
rather than the original file. This helps you keep your project 
“self-contained”.

• You can choose to split stereo and multi-channel files into a 
number of mono files.

• Furthermore, you may want all files in the project to have the 
same sample rate and sample size (resolution).

! Internally, events on musical time based tracks use the 
same high precision for positioning (64 bit floating 
point values) as linear time based events. However, 
switching between linear and musical time base re-
sults in a very small loss of precision (introduced by 
the mathematical operations used for scaling values in 
the two different formats). Therefore you should avoid 
switching repeatedly between the two modes.

Musical time base selected

Linear time base selected
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The Preferences dialog (Editing–Audio page) contains a 
setting that lets you decide which options to use. Select 
one of the following options on the “On Import Audio 
Files” pop-up menu:

• Open Options Dialog
An Options dialog opens when you import, allowing you to select whether 
you want to copy the files to the Audio folder and/or convert them to the 
project settings. Please note the following: 
– When importing a single file of a format other than the project settings, 
you can specify which properties (sample rate and/or resolution) are 
changed. 
– When importing multiple files at the same time, you can select to convert 
the imported files automatically if necessary, i. e. if the sample rate is differ-
ent than the project’s or the resolution is lower than the project setting.

• Use Settings
No Options dialog will appear when you import. Instead, you can choose 
to make any of the options below the pop-up menu the standard ac-
tion(s). Activate any number of the following options to have them per-
formed automatically each time you import audio files:

Creating parts

Parts are containers for MIDI or audio events. If you record 
MIDI, a MIDI part is automatically created, containing the 
recorded events. You can also create empty audio or MIDI 
parts and later add events to them. 

There are two ways to do this:

• Draw a part on a MIDI or audio track with the Pencil tool.
You can also draw parts by pressing [Alt]/[Option] and using the Arrow 
tool.

• Double-click with the Arrow tool on a MIDI or audio 
track, between the left and right locator.

To add events to a MIDI part, you use the tools and func-
tions in a MIDI editor (see “The Key Editor – Overview” on 
page 406). Adding events to audio parts is done in the 
Audio Part Editor (see “Window overview” on page 315) 
by pasting or by using drag and drop.

• You can also gather existing audio events into a part, by 
using the “Events to Part” function on the Audio menu.
This creates an audio part containing all selected audio events on the 
same track. To remove the part and make the events appear as indepen-
dent objects on the track again, select the part and use the “Dissolve 
Part” function on the Audio menu.

Folder tracks
Moving tracks into a folder is a way to structure and orga-
nize tracks in the Project window. By grouping tracks in 
folder tracks, you can solo and mute them in a quicker and 
easier way and perform editing on several tracks as one 
entity. Folder tracks can contain any type of track includ-
ing other folder tracks.

Handling folder tracks

• Creating a folder track
On the Project menu open the “Add Track” submenu and select “Folder”, 
or right-click the track list and select “Add Folder Track” from the context 
menu.

Option Description

Copy Files to 
Working 
Directory

If files are not already in the project’s audio folder they are 
copied there before being imported.

Convert and 
Copy to 
Project If 
Needed

If files are not already in the project’s audio folder they are 
copied there before being imported. Furthermore, if the 
files have a different sample rate or a lower resolution 
than the project settings, they are automatically con-
verted.

Split multi-
channel files

If you import a multi-channel audio file (including two-
channel stereo files), it will be split into a number of mono 
files – one for each channel – which are placed on sepa-
rate, automatically created mono tracks. Use the “Use 
numbers for split file names” option to give the created 
files the same name as the source file, appended by a 
number. This avoids confusion if the source file does not 
contain stereo or surround material, but poly-mono audio.

A folder track

Tracks in the folder
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• Moving tracks into a folder
In the track list, click on a track that you want to move into a folder and 
drag it onto a folder track. An arrow pointing to a folder appears when 
you drag the track onto the folder track in the list. The track is placed in 
the folder track, and all parts and events on the track will be represented 
by a corresponding folder part (see below). You can also create subfold-
ers by moving one folder track into another. For example, you could have 
a folder containing all the vocals in a project, and each vocal part could 
have a folder containing all the takes for easier handling, etc.

• Removing tracks from a folder
Drag a track out of the folder and release it in the track list to remove it 
from the folder.

• Hiding/showing tracks in a folder
Click on the “Expand/Collapse Folder” button (the folder icon) to hide or 
show the tracks located in a folder or use the corresponding options in 
the Track Folding submenu of the Project menu (see “Track folding” on 
page 62). Hidden tracks are played back as usual. 

• Muting and soloing folder tracks
Click the Mute or Solo button on the folder track to mute or solo all 
tracks in the folder as one unit. 

Working with folder parts

A folder part is a graphic representation of events and 
parts on the tracks in the folder. Folder parts indicate the 
position and length of the events and parts, as well as on 
which track they are (their vertical position). If part colors 
are used, these are also shown in the folder part.

Audio handling
When you work with audio files, it is crucial to understand 
how audio is handled in Nuendo:

When you edit or process audio in the Project window, 
you always work with an audio clip that is automatically 
created on import or during recording. This audio clip re-
fers to an audio file on the hard disk that itself remains un-
touched. This means, that audio editing and processing is 
“non-destructive”, in the sense that you can always undo 
changes or revert to the original versions.

An audio clip does not necessarily refer to just one origi-
nal audio file! If you apply some processing to a specific 
section of an audio clip, for example, this will create a new 
audio file containing only this section. The processing will 
then be applied to the new audio file only, leaving the orig-
inal audio file unchanged. Finally, the audio clip is auto-
matically adjusted, so that it refers both to the original file 
and to the new, processed file. During playback, the pro-
gram will switch between the original file and the pro-
cessed file at the correct positions. You will hear this as a 
single recording, with processing applied to one section 
only. This feature makes it possible to undo processing at 
a later stage, and to apply different processing to different 
audio clips that refer to the same original file.

An audio event is the object that you place on a time po-
sition in Nuendo. If you make copies of an audio event and 
move them to different positions in the project, they will 
still all refer to the same audio clip. Furthermore, each au-
dio event has an Offset value and a Length value. These 
determine at which positions in the clip the event will start 
and end, i. e. which section of the audio clip will be played 
back by the audio event. For example, if you resize the au-
dio event, you will just change its start and/or end position 
in the audio clip – the clip itself will not be affected.

An audio region is a section within a clip with a length 
value, a start time, and a snap point. Audio regions are 
shown in the Pool and are best created and edited in the 
Sample Editor. 

If you want to use one audio file in different contexts, 
or if you want to create several loops from one audio file, 
convert the corresponding regions of the audio clip to 
events and bounce them into separate audio files. This is 
necessary since different events that refer to the same clip 
access the same clip information.
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Auditioning audio parts and events
Audio parts and events can be auditioned in the Project 
window with the Play tool:

1. Select the Play tool.

2. Click where you want playback to start, and keep the 
mouse button pressed.
Only the track on which you click is played back, starting at the click posi-
tion. 

3. Release the mouse button to stop playback.

Scrubbing audio
The Scrub tool allows you to locate positions in the audio 
part or event by playing back, forwards or backwards, at 
any speed:

1. Select the Play tool and click a second time on the 
icon.
A pop-up menu opens.

2. Select “Scrub”.

3. Click at the desired position of your audio event or 
part and keep the mouse button pressed.
The project cursor moves to the position where you click. The mouse 
pointer is not visible anymore.

4. Drag to the left or right.
The project cursor moves correspondingly and the audio is played back. 
The speed and thus the pitch of the playback depend on how fast you 
move the mouse.

You can adjust the volume of the Scrub function in the 
Preferences dialog (Transport–Scrub page).

When scrubbing with the mouse, insert effects are al-
ways bypassed.

It is also possible to “scrub” all audio and video tracks 
of your project with the Jog wheel and Shuttle Speed con-
trol on the Transport panel, see “The shuttle speed con-
trol” on page 87.

Scrubbing can be quite a burden on your system. If play-
back problems occur, try deactivating the “Use High 
Quality Scrub Mode” option in the Preferences dialog 
(Transport–Scrub page). The resampling quality will then 
be lower, but scrubbing will be less demanding on the 
processor. This can be useful when scrubbing in large 
projects.

Editing parts and events
This section describes techniques for editing in the 
Project window. If not explicitly stated, all descriptions ap-
ply to both events and parts, even though we use the term 
“event” for convenience.

When you are using the tools for editing, you can in 
many cases get additional functions by pressing modifier 
keys (e. g. pressing [Alt]/[Option] and dragging with the 
Arrow tool creates a copy of the dragged event). 

On the following pages, the default modifier keys are de-
scribed – you can customize these in the Preferences dia-
log (Editing–Tool Modifiers page), see “Setting up tool 
modifier keys” on page 586.

Selecting events
Selecting events is done using any of the following 
methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

! When auditioning, audio will be routed directly to the 
Control Room, if the Control Room is activated. 
When the Control Room is deactivated, the audio 
will be routed to the default output bus, bypassing 
the audio channel’s settings, effects and EQs.

Option Description

All Selects all events in the Project window.

None Deselects all events.

Invert Inverts the selection – all selected events are dese-
lected and all events that were not selected are se-
lected instead.

In Loop Selects all events that are partly or wholly between 
the left and right locator.
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• Select all events on a track by right-clicking on it in the 
track list and selecting “Select All Events” from the con-
text menu.

• It is also possible to select ranges, regardless of the 
event and track boundaries.
This is done using the Range Selection tool (see “Range editing” on 
page 77).

• Use the arrow keys on the computer keyboard to select 
the closest event to the left, right, above, or below.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several events.

By default, tracks are selected with the up/down arrow keys 
on the computer keyboard. Therefore using these to select 
events, too, can be confusing. If you want to use the naviga-
tion controls for track selection only (a most vital operation 

in both editing and mixing), you can activate the “Use Up/
Down Navigation Commands for selecting Tracks only” op-
tion in the Preferences dialog (Editing page). The following 
applies:

• When this option is deactivated and no event/part is selected 
in the Project window, the up/down arrow keys on the com-
puter keyboard are used to step through the tracks in the track 
list.

• When this option is deactivated and an event/part is selected 
in the Project window, the up/down arrow keys still step 
through the tracks in the track list – but on the currently se-
lected track, the first event/part will automatically be selected 
as well.

• When this option is activated, the up/down arrow keys are 
only used to change the track selection – the current event/
part selection in the Project window will not be altered.

• If the “Auto Select Events under Cursor” option is acti-
vated in the Preferences dialog (Editing page), all events 
on the selected track(s) that are “touched” by the project 
cursor are automatically selected.
This can be helpful when rearranging your project, because it allows you 
to select whole sections (on all tracks) by selecting all tracks and moving 
the project cursor.

Using the cross hair cursor
Also in the Preferences dialog (Editing–Tools page), you 
can find the Cross Hair Cursor section. When enabled, a 
cross hair cursor is displayed when working in the Project 
window and in the editors, facilitating navigation and edit-
ing, especially when arranging large projects. You can set 
up the colors for the line and the mask of the cross hair 
cursor, and define its width. The cross hair cursor works 
as follows:

• When the Selection tool (or one of its subtools) is se-
lected, the cross hair cursor appears when you start mov-
ing/copying a part/event, or when using the event trim 
handles.

• When the Pencil tool, the Scissors tool, or any other 
tool that makes use of this function is selected, the cross 
hair cursor appears as soon as you move the mouse over 
the event display.

• The cross hair cursor is only available for tools where 
such a function is of any use. The Mute tool, for example, 
does not use a cross hair cursor, as you have to click di-
rectly on an event to mute it.

From Start to 
Cursor

Selects all events that begin to the left of the project 
cursor.

From Cursor to 
End

Selects all events that end to the right of the project 
cursor.

Equal Pitch These are available in the MIDI Editors (see “Select-
ing notes” on page 412) and the Sample Editor (see 
“Using the Select menu” on page 289).

Select Controllers 
in Note Range

This is available in the MIDI Editors (see “Selecting 
controllers within the note range” on page 412).

All on Selected 
Tracks

Selects all events on the selected track.

Events under 
Cursor

Automatically selects all events on the selected 
track(s) that are “touched” by the project cursor.

Select Event This is available in the Sample Editor (see “Window 
overview” on page 283).

Left/Right Selec-
tion Side to Cursor

These two functions are only used for range selection 
editing (see “Creating a selection range” on page 77).

! Note that these functions work differently when the 
Range Selection tool is selected (see “Creating a 
selection range” on page 77).

Option Description
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Moving events
To move events in the Project window, use the following 
methods:

• Click and drag to a new position.
All selected events are moved, maintaining their relative positions. You 
can only drag events to tracks of the same type. If Snap is activated, this 
determines to which positions you can move the events (see “The Snap 
function” on page 48). 
Note also that you can restrict movement to be either horizontal or verti-
cal only, by holding down [Ctrl]/[Command] while dragging.

• Select the event and edit the Start position in the info 
line.

• Use the “Move to” options on the Edit menu.
The following options are available:

• Use the Nudge buttons on the toolbar.
These move the selected events to the left or right. The amount of move-
ment depends on the selected display format (see “The Project Setup di-
alog” on page 57) and the value set on the Grid pop-up menu.

The Nudge buttons are not visible on the toolbar by 
default. You can decide which items are visible by right-
clicking on the toolbar and activating the corresponding 
option on the context menu (see “The setup context 
menus” on page 572).

• Use the Up/Down key commands, found in the Nudge 
category in the Key Commands dialog.
These commands allow you to nudge one or more events (except folder 
parts) up or down to the nearest track. 

Nudging up/down will not create new tracks: If there is 
no destination track that matches the track configuration 
of the nudged event, nothing happens.

There are two exceptions to this behavior: 

• If you select events in Lane Display mode, these are moved to 
the upper or lower lane. 

• If you select MIDI events in the In-Place Editor, the MIDI 
events are nudged up or down. 

Aligning events
Nuendo provides shortcuts to quickly align audio events 
and parts in the project window. You can align to selected 
parts, events or ranges or to the cursor. 

! You will note that there is a slightly delayed response 
when you move an event by dragging. This helps you 
avoid accidentally moving events when you click on 
them in the Project window. You can adjust this delay 
with the Drag Delay setting in the Preferences dialog 
(Editing page).

Option Description

Cursor Moves the selected event to the project cursor position. If 
there are several selected events on the same track, the 
first event will start at the cursor, and the following will be 
lined up end-to-start after the first one.

Origin Moves the selected events to their original positions, i. e. 
the positions at which they were originally recorded.

Front/Back This function does not actually change the position of the 
events, but moves the selected events to the front or 
back, respectively. This is useful if you have overlapping 
events and want to see one that is partially obscured. 
For audio events, this is an extra important feature, be-
cause only the visible sections of events will be played 
back. Moving an obscured audio event to front (or moving 
the obscuring event to back) will allow you to hear the 
whole event on playback (see also “Overlapping events” 
on page 316). 
Note that it is also possible to use the “To Front” function 
on the event context menu for this (although this works in 
a different way, see “Create Events mode (Preferences)” 
on page 99).

! When the Range Selection tool is used, the Nudge 
buttons move the selection range (see “Moving and 
duplicating” on page 78).

! When the snap point is set, it will be used as a refer-
ence when you align events.
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To align audio events or parts to selected parts or events, 
proceed as follows:

1. Select an event or part of any type on any track.
This will be taken as a reference for aligning.

2. Point on the audio event or part you want to move, 
press one of the modifiers listed in the table below and 
click.
The mouse pointer will change its shape and the audio event or part will 
be aligned to the selected part or event.

To align audio events or parts to selection ranges, pro-
ceed as follows:

1. Make a selection range on any track.
This will be taken as a reference for aligning.

2. Point on an audio event or part, press one of the mod-
ifiers listed in the table below and click.
The mouse pointer will change its shape and the audio event or part will 
be aligned to the selected range.

In both cases, the following modifiers are available:

You can also align audio events or parts to the project 
cursor. This is done in the following way: 

1. Set the cursor to the position where you want to move 
the audio part or event.
This will be taken as a reference for aligning.

2. Make sure that nothing is selected in your project.

3. With the arrow tool selected, point on the audio event 
or part you want to move, press one of the modifiers listed 
in the table below and click.
The mouse pointer will change its shape and the audio event or part will 
be aligned to the cursor.

For aligning audio events or parts to the cursor, the follow-
ing modifiers are available:

You can change the modifiers in the Preferences dia-
log (Editing–Tool Modifiers page).

! Note that the functions depend on where you point 
with the mouse.

Modifier Icon Description

[Ctrl]/[Command] This aligns the start of the audio event/part 
to the start of the selected event, part or 
range. This function is available when you 
move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command] 
-[Alt]/[Option]

This copies the audio event/part and aligns 
its start to the start of the selected event, 
part or range. This function is available when 
you move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command] This aligns the end of the audio event/part to 
the start of the selected event, part or range. 
This function is available when you move the 
mouse on the end of the non-selected event.

[Ctrl]/[Command] 
-[Alt]/[Option]

This copies the audio event/part and aligns 
its end to the start of the selected event, part 
or range. This function is available when you 
move the mouse on the end of the non-se-
lected event.

[Ctrl]/[Command] 
-[Shift]

This aligns the start of the audio event/part 
to the end of the selected event, part or 
range. This function is available when you 
move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command] 
-[Shift] 
-[Alt]/[Option]

This copies the audio event/part and aligns 
its start to the end of the selected event, part 
or range. This function is available when you 
move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command] 
-[Shift]

This aligns the end of the audio event/part to 
the end of the selected event, part or range. 
This function is available when you move the 
mouse on the end of the non-selected event.

[Ctrl]/[Command] 
-[Shift] 
-[Alt]/[Option]

This copies the audio event/part and aligns 
its end to the end of the selected event, part 
or range. This function is available when you 
move the mouse on the end of the non-se-
lected event.

Modifier Icon Description

[Ctrl]/[Command] This aligns the start of the audio event/part to 
the cursor. This function is available when you 
move the mouse on the beginning of the non-
selected event.

[Ctrl]/[Command] 
-[Alt]/[Option]

This copies the audio event/part and aligns its 
start to the cursor. This function is available 
when you move the mouse on the beginning of 
the non-selected event.

[Ctrl]/[Command] This aligns the end of the audio event/part to 
the cursor. This function is available when you 
move the mouse on the end of the non-se-
lected event.

[Ctrl]/[Command] 
-[Alt]/[Option]

This copies the audio event/part and aligns its 
end to the cursor. This function is available 
when you move the mouse on the end of the 
non-selected event.

Modifier Icon Description
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Duplicating events
Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new 
position.
If Snap is activated, this determines to which positions you can copy the 
events (see “The Snap function” on page 48). 

• Audio and MIDI parts can also be duplicated by clicking 
on the part, pressing [Alt]/[Option]-[Shift], and dragging.
This creates a shared copy of the part. If you edit the contents of a 
shared copy, all other shared copies of the same part are automatically 
edited in the same way.

Shared copies are indicated by an icon on the right.

Note:

• When you duplicate audio events, the copies are al-
ways shared. This means that shared copies of audio 
events always refer to the same audio clip (see “Audio 
processing” on page 264).

• You can convert a shared copy to a real copy by select-
ing “Convert to Real Copy” from the Edit menu. This cre-
ates a new version of the clip (that can be edited indepen-
dently) and adds this to the Pool. Note that no new files are 
created by this operation – for that you need to use the 
“Bounce Selection” function from the Audio menu (see “Ex-
porting regions as audio files” on page 330).

• Selecting “Duplicate” from the Edit menu creates a copy 
of the selected event and places it directly after the original.
If several events are selected, all of these are copied “as one unit”, main-
taining the relative distance between the events.

• Selecting “Repeat…” from the Edit menu opens a dia-
log, allowing you to create a number of copies (regular or 
shared) of the selected event(s).
This works just like the Duplicate function, but you can specify the num-
ber of copies.

• You can also perform the Repeat function by dragging: 
Select the event(s) to repeat, press [Alt]/[Option], click the 
handle in the lower right corner of the last selected event 
and drag to the right.
The longer to the right you drag, the more copies are created (as shown 
by the tooltip).

• Selecting “Fill Loop” from the Edit menu creates a num-
ber of copies starting at the left locator and ending at the 
right locator.
The last copy is automatically shortened to end at the right locator posi-
tion.

Using Cut, Copy and, Paste
You can cut or copy selected events, and paste them in 
again, using the functions on the Edit menu.

• When you paste an audio event, it is inserted on the se-
lected track, positioned so that its snap point is aligned 
with the cursor position.
If the selected track is of the wrong type, the event will be inserted on its 
original track. See “The Snap function” on page 48 for information about 
the snap point.

• If you use the “Paste at Origin” function, the event is 
pasted at its original position (the position from which you 
cut or copied it).

Using Cut Head and Cut Tail
You can cut everything to the left or right of the cursor or a 
selected range:

• If you use “Cut Head”, everything to the left of the cur-
sor/selection range will be deleted. No data will be kept in 
the clipboard. 

• If you use “Cut Tail”, everything to the right of the cur-
sor/selection range will be deleted. No data will be kept in 
the clipboard. 

! If you hold down [Ctrl]/[Command] as well, move-
ment direction is restricted to either horizontal or ver-
tical. That means if you drag an event vertically it 
cannot be moved horizontally at the same time.
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Renaming events
By default, audio events show the name of their clip, but 
you can enter a separate descriptive name for separate 
events if you like. This is done by selecting the event and 
typing in a new name in the “Description” field in the info 
line, or by using the Rename Object command from the 
Edit menu.

• You can also give all events on a track the same name 
as the track by changing the track name, holding down a 
modifier key and pressing [Return].
See “Handling tracks” on page 61.

• The Rename Objects command is useful when renaming 
multiple events at the same time. Select one or more 
events. Then choose “Rename…” from the Edit menu. You 
have several options for renaming events automatically us-
ing sequential numbers, timestamps and more (see “Re-
naming clips or regions in the Pool” on page 324).

Splitting events
You can split events in the Project window in the following 
ways:

• Click with the Scissors tool on the event you want to 
split.
If Snap is activated, this determines the exact split position (see “The 
Snap function” on page 48). You can also split events by pressing [Alt]/
[Option] and clicking with the Arrow tool.

• Select “Split at Cursor” from the Edit menu.
This splits the selected events at the position of the project cursor. If no 
events are selected, all events (on all tracks) that are intersected by the 
project cursor will be split.

• Select “Split Loop” from the Edit menu.
This splits events on all tracks at the left and right locator positions.

If you split a MIDI part so that the split position inter-
sects one or several MIDI notes, the result depends on the 
“Split MIDI Events” option in the Preferences dialog (Edit-
ing–MIDI page). If the option is activated, the intersected 
notes will be split (creating new notes at the beginning of 
the second part). If it is deactivated, the notes will remain 
in the first part, but “stick out” after the end of the part.

Gluing events together
You can glue events together using the Glue Tube tool. 
There are three possibilities: 

• Clicking on an event with the Glue Tube tool glues it to-
gether with the next event on the track. The events do not 
have to touch one another.
The result is a part containing the two events, with one exception: If you 
first split an event and then glue the two sections together again (without 
moving or editing them first), they become a single event again.

• You can select several events on the same track and 
click on one of them with the Glue Tube tool.
A single part is created.

• When you hold down [Alt]/[Option] while clicking on an 
event with the Glue Tube tool, this event will be glued to-
gether with all following events on this track.
You can change the default key command for this in the Preferences di-
alog (Editing–Tool Modifiers page).

Resizing events
Resizing events means to move their start or end positions 
individually. In Nuendo, there are three modes for resizing:

To select one of the resizing modes, select the Arrow tool 
and then click again on the Arrow tool icon on the toolbar. 
This opens a pop-up menu from which you can select one 
of the options.

The icon on the toolbar will change, indicating the selected resizing 
mode.

Resizing mode Description

Normal Sizing The contents of the event stay fixed, and the start or 
end point of the event is moved to “reveal” more or less 
of the contents.

Sizing Moves 
Contents

The contents follow the moved start or end of the event 
(see the figure below).

Sizing Applies 
Time Stretch

The contents will be time stretched to fit the new event 
length (see the separate section “Resizing events using 
time stretch” on page 73).
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The actual resizing is done by clicking and dragging the 
lower left or right corner of the event. If Snap is activated, 
the Snap value determines the resulting length (see “The 
Snap function” on page 48).

Normal sizing

Sizing moves contents

• If several events are selected, all will be resized in the 
same way.

• It is also possible to resize events by using the Trim but-
tons (located in the Nudge palette) on the toolbar.
This will move the start or end position of the selected event(s) by the 
amount set on the Grid Type pop-up menu. The sizing type currently se-
lected applies to this method too, with the exception of “Sizing Applies 
Time Stretch” which is not possible with this method. You can also use 
key commands for this (by default, press [Ctrl]/[Command] and use the 
left and right arrow key).

Note that the Nudge palette is not visible on the tool-
bar by default. See “The setup context menus” on page 
572 for instructions on how to show and hide items on the 
toolbar.

When resizing events, any automation data will not be 
taken into account.

Resizing events using time stretch
If you want to resize a part and make its contents “fit” the 
new size, you should use this sizing mode. Proceed as fol-
lows:

1. Click the Arrow icon on the toolbar and click again to 
select the “Sizing Applies Time Stretch” option from the 
pop-up menu.

2. Point close to the end point of the part you want to 
stretch.

3. Click and drag left or right.
When you move the mouse, a tooltip shows the current mouse position 
and length of the part. Note that the snap value applies, as with any part 
operation.

4. Release the mouse button.
The part is “stretched” or “compressed” to fit the new length.

• For MIDI parts, this means that the note events are 
stretched (moved and resized).
Controller data will be moved.

• For audio parts, this means that the events are moved, 
and that the referenced audio files are time stretched to fit 
the new length.
A dialog shows the progress of the time stretch operation.

In the Preferences dialog (Editing–Audio page), you 
can adjust which algorithm is used for the time stretch al-
gorithm.

For more information about time stretch, see “Time 
Stretch” on page 272.
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Sliding the contents of an event or part
You can move the contents of an event or part without 
changing its position in the Project window. By default, 
this is done by pressing [Alt]/[Option]-[Shift], clicking in 
the event or part and dragging to the left or right.

Grouping events
Sometimes it is useful to treat several events as one unit. 
This can be done by grouping them: Select the events (on 
the same or different Tracks) and select “Group” from the 
Edit menu.

Grouped events are indicated by a group icon on the right.

If you edit one of the grouped events in the Project window, 
all other events in the same group are affected too (if appli-
cable). 

Group editing operations include:

• Selecting events.
• Moving and duplicating events.
• Resizing events.
• Adjusting fade-in and fade-out (audio events only, see “Creat-

ing fades” on page 113).
• Splitting events (splitting one event will automatically split any 

other grouped events that are intersected by the split position).
• Locking events.
• Muting events (see below).
• Deleting events.

Locking events
If you want to make sure that you do not edit or move an 
event by accident, you can lock it. Locking can affect one 
(or any combination) of the following properties:

• To specify which of these properties are affected by the 
Lock function, use the “Lock Event Attributes” pop-up 
menu in the Preferences dialog (Editing page).

• To lock events, select them and select “Lock…” from 
the Edit menu.
The events will be locked according to the options specified in the Pref-
erences dialog.

• You can adjust the lock options for a locked event by 
selecting it and selecting “Lock…” from the Edit menu 
again.
This opens a dialog in which you can activate or deactivate the desired 
lock options.

• To unlock an event (turn off all lock options), select it 
and select “Unlock” from the Edit menu.

• It is also possible to lock a whole track, by clicking the 
padlock symbol in the track list or in the Inspector.
This disables all editing of all events on the track.

! When sliding the contents of an audio event, you 
cannot slide past the start or end of the actual audio 
clip. If the event plays the whole clip, you cannot 
slide the audio at all.

Lock Options Description

Position If this is locked, the event cannot be moved.

Size If this is locked, the event cannot be resized.

Other If this is locked, all other editing of the event is disabled. 
This includes adjusting the fades and event volume, pro-
cessing, etc.

The padlock symbol indicates that one or 
more of the lock options are activated for 
the event.
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Muting events
To mute individual events in the Project window, proceed 
as follows:

• To mute or unmute a single event, click on it with the 
Mute tool.

• To mute or unmute several events, select them – either 
by using the standard selection techniques, or by using 
one of the options on the Select submenu on the Edit 
menu – and click on one of the selected events with the 
Mute tool.
All selected events will be muted.

• You can also click in an empty area with the Mute tool 
and drag a selection rectangle around several events you 
want to mute or unmute, and then click on one of them 
with the Mute tool.

• You can mute events by selecting them and selecting 
“Mute” from the Edit menu.
Similarly, you can unmute the selected events by selecting “Unmute” 
from the Edit menu.

• You can also change the mute status of selected events 
on the info line.

Muted events can be edited as usual (with the exception 
of adjusting fades), but are not played back.

Muted events are “grayed out”.

• You can also mute whole tracks by clicking the Mute 
(“M”) button in the track list, the Inspector or the Mixer.
Clicking the Solo (“S”) button for a track mutes all other tracks. Note that 
there are two modes for the track solo function:  
If the “Enable Solo on Selected Track” option is activated in the Prefer-
ences dialog (Editing–Project & Mixer page) and you have soloed a 
track, selecting another track in the track list will automatically solo that 
track instead – the solo state “moves” with the track selection. 
If the option is not activated, the track you solo stays soloed, regardless 
of the selection.

Removing events
To remove an event from the Project window, use any of 
the following methods:

• Click on the event with the Erase tool.
Note that if you press [Alt]/[Option] while you click, all following events 
on the same track will be deleted, but not the event you clicked and all 
events before it.

• Select the event(s) and press [Backspace], or select 
“Delete” from the Edit menu.

Creating new files from events
An audio event plays a section of an audio clip, which in 
turn refers to one or more audio files on the hard disk. 
However, in some situations you may want to create a new 
file that consists only of the section played by the event. 
This is done with the function “Bounce Selection” on the 
Audio menu:

1. Select one or several audio events.

2. Set up fade in, fade out and event volume (on the info 
line or using the volume handle) as desired.
These settings will be applied to the new file. For details on fades and 
event volume, see “Creating fades” on page 113.

3. Select “Bounce Selection” from the Audio menu.
You are asked whether you want to replace the selected event or not.

• If you click “Replace”, a new file is created, containing 
only the audio in the original event. A clip for the new file is 
added to the Pool, and the original event is replaced by a 
new event playing the new clip.

• If you click “No”, a new file is created and a clip for the 
new file is added to the Pool.
The original event is not replaced.

You can also apply the Bounce Selection function to an 
audio part. In that case, the audio from all events in the 
part will be combined into a single audio file. If you choose 
“Replace” when asked, the part will be replaced with a 
single audio event playing a clip of the new file.
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Editing in Lane Display mode
When you are recording in Stacked cycle recording 
mode, each take ends up on a separate lane on the track, 
see “Recording audio in Stacked mode” on page 101 and 
“Cycle Record mode: Stacked/Stacked 2 (No Mute)” on 
page 105. However, you can also select this lane mode 
manually for individual tracks, and use it when editing in 
the Project window. This makes it easier to view and han-
dle overlapping events and parts.

Audio tracks
1. In the track list or in the Inspector for the selected 
track, click the Lane Display Type button and select 
“Lanes Fixed” from the pop-up menu.
The audio track is divided vertically into two lanes. By default, all audio 
events end up in the first (top) lane.

2. Now you can move events or parts between lanes, ei-
ther by dragging or by using the “To Front” commands on 
the Edit menu or the context menu (this will move the 
event on the lane that has playback priority).
Note that if there are overlapping audio events, the audio on the lowest 
lane has playback priority – moving events between lanes affects what 
will be heard!

If the vertical zoom factor is sufficiently high, the sections that will be 
heard on playback are indicated in green.

• Note that there will always be an extra, empty lane at the 
bottom of the track – moving an event there always will 
add another lane.
Depending on the number of lanes used, you may want to adjust the ver-
tical zoom for the track – simply drag the track edges in the track list.

3. After rearranging the overlapping events so that you 
hear what you want, you can select all events and select 
“Delete Overlaps” from the Advanced submenu on the 
Audio menu.
This puts all events in the top lane and resizes events so that overlapping 
sections are removed.

4. To turn off Lanes mode, select “Lanes Off” from the 
Lane Display Type pop-up menu.
If you do this without using the “Delete Overlaps” function, all overlap-
ping sections will be kept. However, the sections that were green will 
now be the sections visible (“on top”) and thus the sections that will be 
heard.

MIDI tracks
1. In the track list or in the Inspector for the selected 
track, click the Lane Display Type button and select 
“Lanes Auto” or “Lanes Fixed”.

• In Lanes Auto mode, extra lanes will automatically be 
added where necessary – if two MIDI parts overlap, they 
will automatically be put on separate lanes.

• In Lanes Fixed mode, you have to move MIDI parts be-
tween lanes manually (by dragging them or by using the 
“Move to Front/Back” commands on the Edit menu or 
context menu).
In this mode, there will always be an extra, empty lane at the bottom of 
the track – if you move a part there, another lane will be added and so on.

2. You can edit the overlapping parts as usual – by cut-
ting, deleting or muting sections in the Project window or 
by opening them in a MIDI editor.
In an editor, parts on different lanes will be treated just like parts on dif-
ferent tracks – you can use the part list pop-up menu to select an active 
part for editing, etc.  
Note that there is no playback priority between lanes on a MIDI track – all 
unmuted parts will be heard during playback.
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3. To merge all overlapping parts into one, make sure 
that the MIDI track is selected, position the left and right 
locators around the parts and select “Merge MIDI in Loop” 
from the MIDI menu.
In the dialog that opens, activate the Erase Destination option and click 
OK. This merges all unmuted MIDI between the locators to a single part.

4. To turn off Lanes mode, select “Lanes Off” from the 
Lane Display Type pop-up menu.

Range editing
Editing in the Project window is not necessarily restricted 
to handling whole events and parts. You can also work 
with selection ranges, which are independent from the 
event/part and track boundaries.

Creating a selection range
To make a selection range, drag with the Range Selection 
tool.

When the Range Selection tool is selected, the Select 
submenu on the Edit menu has the following items for 
making selection ranges:

• Double-clicking on an event with the Range Selection 
tool creates a selection range encompassing the event.
If you hold down [Shift] you can double-click several events in a row, and 
the selection range will expand to encompass them all. Double-clicking a 
second time on an event opens it for editing in the Sample Editor.

Making selection ranges for several non-contiguous 
tracks

You can create selection ranges that cover several tracks. 
It is also possible to exclude tracks from a selection range:

1. Create a selection range from the first to the last de-
sired track.

2. Press [Alt]/[Option] and click in the selection range on 
the tracks you want to exclude from the selection.

3. In the same manner, you can add a track to the selec-
tion range by [Alt]/[Option]-clicking in the selection range 
area on the track.

• If you press [Shift]-[Alt]/[Option] while creating a selec-
tion range, the range will encompass all tracks in the track 
list.

Option Description

All Makes a selection that covers all tracks, from the start of 
the project to the end (as defined by the Length setting 
in the Project Setup dialog).

None Removes the current selection range.

Invert Only used for event selection (see “Selecting events” on 
page 67).

In Loop Makes a selection between the left and right locator, on 
all tracks.

From Start to 
Cursor

Makes a selection on all tracks, from the start of the 
project to the project cursor.

From Cursor to 
End

Makes a selection on all tracks, from the project cursor 
to the end of the project.

All on Selected 
Tracks

Only used for event selection (see “Selecting events” on 
page 67).

Select Event This is available in the Sample Editor (see “Using the 
Select menu” on page 289).

Left Selection 
Side to Cursor

Moves the left side of the current selection range to the 
project cursor position.

Right Selection 
Side to Cursor

Moves the right side of the current selection range to the 
project cursor position.

Range to Next 
Event

Moves the selection range to the next event head or tail 
on the selected track(s) and turns it to a zero selection

Range to Previ-
ous Event

Moves the selection range to the previous event head or 
tail on the selected track(s) and turns it to a zero selec-
tion.

Enlarge Range 
to Next Event

Moves the right side of the current selection range to the 
next event head or tail on the selected track(s).

Enlarge Range 
to Previous 
Event

Moves the left side of the current selection range to the 
previous event head or tail on the selected track(s).

Option Description
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The Range Selection pop-up menu
If you want to work with different selection ranges the 
Range Selection pop-up menu comes in handy. Activating 
one of the options (Selection A or Selection B) from the 
pop-up menu will not only select the corresponding selec-
tion but also cause the event display to switch between 
the two locations. 

Proceed as follows:

1. With the Range Selection tool, define a destination 
range for your selection.
By default, the first selection you perform will be selection A. The letter 
currently displayed on the tool icon shows which selection range you 
are to define. 

2. Click on the Range Selection tool again and select 
Selection B from the pop-up menu.
This switches the selection ranges.

3. Define the destination range for selection B.

You can now select your defined ranges by opening the 
Range Selection pop-up menu and choosing the desired 
option. 

Editing selection ranges

Adjusting the size of the selection range

You can adjust the size of a selection range in the follow-
ing ways:

• By dragging its edges.
The pointer takes the shape of a double arrow when you move it over an 
edge of the selection range.

• By holding down [Shift] and clicking.
The closest selection range edge will be moved to the position at which 
you clicked.

• By adjusting the selection range start or end position on 
the info line.

• By using the Trim buttons on the toolbar.
The left Trim buttons will move the start of the selection range and the 
right buttons will move the end. The edges will be moved by the amount 
specified on the Grid pop-up menu.

• By using the Nudge buttons on the toolbar.
These will move the whole selection range to the left or the right. The 
amount of movement depends on the selected display format (see “The 
Project Setup dialog” on page 57) and the value specified on the Grid 
pop-up menu.

The Trim buttons and the Nudge buttons are located 
in the Nudge palette, which is not visible on the toolbar by 
default. 

See “The setup context menus” on page 572 for instruc-
tions on how to show and hide items on the toolbar.

Moving and duplicating

• To move a selection range, click and drag it to a new 
position.
This will move the contents of the selection range to the new position. If 
the range intersected events or parts, these will be split before moving, 
so that only the sections within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option] 
and drag.
You can also use the Duplicate, Repeat and Fill Loop functions, just as 
when duplicating events (see “Duplicating events” on page 71).

! When you are done do not forget to deactivate the 
Range Selection tool. Otherwise, you might acciden-
tally overwrite your defined selections.

! Note that the contents of the selection are not 
moved – using the Nudge buttons is the same as ad-
justing the start and end of the selection range at the 
same time, by the same amount.
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Using Cut, Copy, and Paste

When working with selection ranges, you can either use 
Cut, Copy and Paste on the Edit menu, or use the functions 
“Cut Time” and “Paste Time” on the Range submenu on the 
Edit menu. These work differently to their related functions 
on the Edit menu:

Deleting selection ranges
Again, you can either use “regular” Delete or “Delete Time”:

• If you use the Delete function on the Edit menu (or press 
[Backspace]), the data within the selection range is re-
placed by empty track space.
Events to the right of the range keep their position.

• If you use “Delete Time” on the Edit menu’s Range sub-
menu, the selection range is removed and events to the 
right are moved to the left to close up the gap.

Other functions
On the Range submenu on the Edit menu, you will find 
three more range editing functions:

Region operations
Regions are sections within a clip, with various uses. While 
regions are perhaps best created and edited in the Sample 
Editor (see “Working with regions” on page 291), the fol-
lowing region functions are available in the Advanced sub-
menu of the Audio menu:

The Edit History dialog
In the Edit History dialog you can undo and redo many edit 
actions. Actions that can be undone include all functions 
in the Project window as well as in the editors. It is also 
possible to undo audio processes or applied plug-in ef-
fects. However, these are better removed and modified 
using the Offline Process History (see “The Offline Pro-
cess History dialog” on page 275). 

In the Preferences dialog (General page) you can limit 
the Undo function by setting the number in the “Maximum 
Undo” field to the desired value. This is useful if you run 
out of hard disk space, for example. 

Function Description

Cut Cuts out the data in the selection range and moves it to 
the clipboard. The selection range is replaced by empty 
track space in the Project window, meaning that events 
to the right of the range keep their positions.

Copy Copies the data in the selection range to the clipboard.

Paste Pastes the clipboard data at the start position and track 
of the current selection. Existing events are not moved to 
make room for the pasted data.

Paste at  
Origin

Pastes the clipboard data back at its original position. Ex-
isting events are not moved to make room for the pasted 
data.

Cut Time Cuts out the selection range and moves it to the clip-
board. Events to the right of the removed range are 
moved to the left to fill out the gap.

Paste Time Pastes the clipboard data at the start position and track 
of the current selection. Existing events are moved to 
make room for the pasted data.

Paste Time at 
Origin

Pastes the clipboard data back at its original position. Ex-
isting events are moved to make room for the pasted 
data.

Function Description

Global Copy This copies everything in the selection range.

Split Splits any events or parts that are intersected by the se-
lection range, at the positions of the selection range 
edges.

Crop All events or parts that are partially within the selection 
range are cropped, that is, sections outside the selection 
range are removed. Events that are fully inside or outside 
the selection range are not affected.

Insert  
Silence

Inserts empty track space from the start of the selection 
range. The length of the silence equals the length of the 
selection range. Events to the right of the selection range 
start are moved to the right to “make room”. Events that 
are intersected by the selection range start are split, and 
the right section is moved to the right.

Function Description

Event or 
Range as 
Region

This function is available when one or several audio events 
or selection ranges are selected. It creates a region in the 
corresponding clip, with the start and end position of the 
region determined by the start and end position of the 
event or selection range within the clip.

Events from 
Regions

This function is available if you have selected an audio 
event whose clip contains regions within the boundaries 
of the event. The function will remove the original event 
and replace it with event(s) positioned and sized accord-
ing to the Region(s).

Function Description
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To undo and redo your actions, proceed as follows:

1. On the Edit menu, select “History…”.
The Edit History dialog opens.

The dialog contains a list of all your edits, with the most 
recent action at the bottom of the list. The Action column 
displays the name of the action while the Time column 
tells you when this action was performed. In the Details 
column further details are shown. Here you can enter new 
text by double-clicking in the column. 

2. Move the horizontal, colored line upwards to the de-
sired position to undo your actions. 
You can only undo your actions in reverse order, i. e. the last performed 
action is the first action to be undone.

3. Move the line down the List again to redo an action 
that was undone previously.

Working with branches
If you activate the “Use Undo Branches” option in the 
Preferences dialog (General page), actions are gathered 
in branches. This way you do not have to undo every sin-
gle action you performed, instead you can undo whole 
branches. 

A branch is created when you have undone at least one 
action. All following actions you perform will then be gath-
ered in a new branch. 

If you have two or more branches, you can choose to undo 
edits of the separate branches. Proceed as follows:

1. Select the desired branch by clicking on it in the lower 
part of the dialog.
The corresponding actions are listed in the upper part of the dialog.

2. Click the “Activate Selected” button or click a second 
time on the branch to activate it.
All actions from the subsequent branches are undone while all actions of 
the now active branch are redone.

If you undo some of the actions and then perform new edit 
operations, a new child branch is created at that position 
in the tree.

When you are happy with your edits and you do not need 
the inactive branches any longer, you can choose to re-
move them. Proceed as follows:

• Click the “Remove Inactive” button. 
All inactive branches are removed, leaving only the active actions on a 
single, linear branch.

You can now undo separate actions of the branch as 
usual in the upper part of the dialog.

! Removing inactive branches cannot be undone!
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The Preferences dialog

When you open the File menu (the Nuendo menu on a 
Mac) and select “Preferences…”, the Preferences dialog 
opens. This dialog provides a large number of options and 
settings that control the global behavior of Nuendo. 

The dialog has a number of pages, each containing op-
tions and settings belonging to a particular topic.

• In the list on the left, click on one of the entries to open 
the corresponding page.

• You can find detailed descriptions of all Preferences 
options in the dialog help, opened by clicking the Help 
button at the bottom left of the dialog.

About preference presets 
In the Preferences dialog it is possible to save complete or 
partial preference settings as presets. This lets you recall 
settings quickly and easily.

Saving a preference preset

When you have made your preferences settings, proceed 
as follows to save all settings as a preset:

1. Make sure that the “Store marked preferences only” 
option is not activated.
This is because this option is used for saving partial settings (see below), 
as opposed to complete settings.

2. Click the Store button in the lower left section of the 
Preferences dialog.

A dialog opens, allowing you to type in a name for the pre-
set.

3. Click OK to save the preset.
Your saved settings are now available from the Preference Presets 
pop-up menu.

Loading a preference preset

To load a saved preference preset, simply select a preset 
from the Preference Presets pop-up menu. The preset is 
applied immediately.

Saving partial preferences settings

It is also possible to save partial preferences settings. This 
is useful when you have made settings that only relate to a 
certain project or situation, for example. When you apply a 
saved partial preference preset, you only change the saved 
settings. All other preferences will be left unchanged.
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When you have made your specific preferences settings, 
proceed as follows to save the partial settings as a preset:

1. Activate “Store marked preferences only”.
A new “Store” column is added to the Preferences list.

2. Click in the Store column of the Preferences items you 
wish to save.
Note that if you activate a Preferences page that contains subpages, these 
will also be activated. If this is not what you want, simply deactivated the 
subpages.

3. Click the Store button in the lower left section of the 
Preferences dialog.
A dialog opens, asking you to type in a name for the preset. It is a good 
idea to choose a descriptive name for a partial preference preset, prefer-
ably relating to the saved settings (for example “Configuration” or “Edit-
ing–Controls”).

4. Click OK to save.
Your saved settings are now available from the Preference Presets 
pop-up menu.

Any Project window editing you perform to a folder part 
affects all the events and parts it contains. You can select 
several folder parts if you like – this allows you to handle 
and edit them together. The editing you can perform in-
cludes:

• Moving a folder part. This will move its contained events and 
parts (possibly resulting in other folder parts, depending on 
how the parts overlap).

• Using cut, copy and paste.
• Deleting a folder part. This will delete its contained events and 

parts.
• Splitting a folder part with the Scissors tool.

• Gluing folder parts together with the Glue tube tool. This will 
only work if the adjacent folder parts contain events or parts 
on the same track.

• Resizing a folder part resizes the contained events and parts 
according to the selected resizing method, see “Resizing 
events” on page 72.

• Muting a folder part. This will mute its contained events and 
parts.

Tracks inside a folder can be edited as one entity by per-
forming the editing directly on the folder part containing 
the tracks. You can also edit individual tracks within the 
folder by showing the contained tracks, selecting parts 
and opening editors as usual.

Double-clicking a folder part opens the editors for the cor-
responding track classes present in the folder. The follow-
ing applies:

• All MIDI parts located on the tracks within the folder are 
displayed as if they were on the same track, just like when 
opening the Key Editor with several MIDI parts selected.
To be able to easily discern the different tracks in the editor, give each 
track a different color in the Project window and use the “Part Colors” 
option in the editor (see “Coloring notes and events” on page 410).

• If the folder contains tracks with audio events and/or au-
dio parts, the Sample and/or Audio Part Editors are opened 
with each audio event and audio part in a separate window.
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7
Playback and the Transport panel



Background
This chapter describes the various methods available for 
controlling playback and transport functions in Nuendo.

The Transport panel
Below you can find a brief description of each item on the 
Transport panel.

The pictures below show the Transport panel with all con-
trols visible. The Transport panel is divided into the follow-
ing sections, from left to right.

The Output Activity and Clipping indicator as well as 
the Output Level Control refer to the Control Room chan-
nel, if the Control Room is activated. If the Control Room 
is disabled, these controls refer to the Main Mix Output 
bus as defined on the Outputs tab in the VST Connec-
tions window. For information on the Control Room, see 
the chapter “Control Room” on page 179. 

• The main Transport functions (Cycle/Stop/Play/Record) 
can also be shown on the toolbar.

In addition, various play options are available on the Trans-
port menu.

Hiding and showing the Transport panel

The Transport panel is shown automatically when you 
launch a new project. To hide or show it, select “Transport 
Panel” on the Transport menu (or use a key command – 
by default [F2]).

About Pre-roll and Post-roll

These items are described in the chapter “Recording”, 
see “About Pre-roll and Post-roll” on page 108.
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Changing the Transport panel setup

You can customize the appearance of the Transport panel 
by right-clicking anywhere on the panel and selecting/de-
selecting the corresponding options on the context menu.

This is described in detail in the section “The setup con-
text menus” on page 572.

The numeric keypad
In the default Key Command settings, various Transport 
panel operations are assigned to the numeric keypad on 
the computer keyboard. The keypads are slightly different 
on PC and Macintosh computers:

Operations

Setting the project cursor position
There are several ways to move the project cursor position:

• By using Fast Forward and Rewind.

• By using the Jog/Shuttle/Nudge control on the Trans-
port panel (see “The shuttle speed control” on page 87).

• By dragging the project cursor in the lower part of the 
ruler. 

• By clicking in the ruler.
Double-clicking in the ruler moves the cursor and starts/stops playback. 

• If the “Locate when Clicked in Empty Space” option is 
activated in the Preferences dialog (Transport page) you 
can click anywhere in an empty section of the Project win-
dow to move the cursor position.

• By changing the value in any of the position displays.

• By using the position slider above the transport buttons 
in the Transport panel.
The range of the slider relates to the Length setting in the Project Setup 
dialog. Hence, moving the slider all the way to the right will take you to 
the end of the project. 

• By using markers (see the chapter “Using markers” on 
page 136).

• By using playback options (see “Playback functions” on 
page 88).

• By using the arranger function (see “The arranger track” 
on page 122).

• By using functions on the Transport menu.

The following functions are available:

If Snap is activated when dragging the project cursor, 
the Snap value is taken into account. This is helpful for 
finding exact positions quickly.

There are also numerous key commands available for 
moving the project cursor (in the Transport category in the 
Key Commands dialog). For example, you can assign key 
commands to the “Step Bar” and “Step Back Bar” func-
tions, allowing you to move the project cursor in steps of 
one bar, backwards and forwards.

About the Transport panel display formats

Primary time display (left) and secondary time display (right)

The time unit shown in the ruler can be independent from 
the time unit shown in the main time display on the Trans-
port panel. This means that you can display timecode in 
the transport position display and bars and beats in the 
ruler, for example. In addition, there is a secondary time 
display to the right of the primary time display which is 

Numeric Key Function

[Enter] Play

[+] Fast Forward

[-] Rewind

[*] Record

[÷] (Win)/[/] (Mac) Cycle On/Off

[,] Return to Zero

[0] Stop

[1] Go to Left Locator

[2] Go to Right Locator

[3-9] Go to marker 3 to 9

Function Description

Locate Selec-
tion/Locate 
Selection End

Moves the project cursor to the beginning or end of the 
current selection. For this to be available, you must 
have selected one or more events or parts, or made a 
selection range.

Locate Next/
Previous Marker

This moves the project cursor to the closest marker to 
the right or left (see “Marker tracks” on page 44).

Locate Next/
Previous Event

This moves the project cursor forwards or backwards 
respectively, to the closest beginning or end of any 
event on the selected track(s).
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also independent, giving you three different time units 
shown at the same time (in the Project window, you can 
also create additional ruler tracks – see “Using multiple 
rulers – ruler tracks” on page 47).

The following rules apply:

• If you change the time format of the primary time display 
on the Transport panel, the time format of the ruler will be 
changed as well.
This is the same as changing the display format in the Project Setup. 
Therefore, to have different display formats in the ruler and the main time 
display you should change the format in the ruler.

• The primary time display format is set on the pop-up 
menu to the right in the main position display.

• This setting also determines the time format displayed 
for the left and right locators on the Transport panel.

• The secondary time display is completely independent, 
and the display format is set on the pop-up menu to the 
right in the secondary time display.

• You can swap time formats between the primary and 
secondary time displays by clicking the double arrow sym-
bol between them.

The left and right locators
The left and right locators are a pair of position markers 
used for specifying punch-in and punch-out positions dur-
ing recording, and as boundaries for cycle playback and 
recording. 

When cycle mode is activated on the Transport panel, 
the area between the left and right locators will be re-
peated (cycled) on playback. However, if the right locator 
is positioned before the left, this will work as a “jump” or 
“skip mode” – when the project cursor reaches the right 
locator it will immediately jump to the left locator position 
and continue playback from there.

There are several ways to set locator positions:

• To set the left locator, press [Ctrl]/[Command] and click 
at the desired position in the ruler.
Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right lo-
cator. You can also drag the locator “handles” directly in the ruler.

The locators are indicated by the “flags” in the ruler. The area between 
the locators is highlighted in the ruler and in the Project window (see 
“Appearance” on page 576). Note that if the right locator is before the 
left locator, the color of the ruler between the locators will change.

• Click and drag in the upper half of the ruler to “draw” a 
locator range.
If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on 
the numeric keypad sets the left or right locator to the 
project cursor position.
Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/
[Command]) to set the project cursor position to the left or right locator 
position. Note that these are default key commands – you can change 
these if you like.

• By creating cycle markers you can store any number of 
left and right locator positions, which can be recalled by 
simply double-clicking on the corresponding marker (see 
“Editing markers on marker tracks” on page 142).

• The “Locators to Selection” item on the Transport menu 
(default key command [P]) sets the locators to encompass 
the current selection.
This is available if you have selected one or several events or made a se-
lection range.

• You can also adjust the locators numerically on the 
Transport panel.
Clicking the L/R buttons in the locator section on the Transport panel will 
move the project cursor to the respective locator. If you press [Alt]/[Op-
tion] and click the L or R button, the corresponding locator will be set to 
the current project cursor position.
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The shuttle speed control

The shuttle speed control (the outer wheel on the Transport 
panel) allows you to play back the project at any speed 
(four times the playback speed at maximum), forwards or 
backwards. This is a quick way to locate or “cue” to any po-
sition in the project.

• Turn the shuttle speed wheel to the right to start play-
back.
The further to the right you move the wheel, the faster the playback speed. 

• If you turn the wheel to the left instead, the project will 
play backwards.
The speed depends on how far to the left you turn the wheel.

• The “Use Inserts While Scrubbing” option in the Prefer-
ences (Transport–Scrub page) allows you to activate in-
sert effects for scrubbing with the shuttle speed control.
By default, insert effects are bypassed.

You can also access the shuttle speed control via a 
remote control device.

Project scrubbing – the jog wheel

The middle wheel on the Transport panel serves as a jog 
wheel. By clicking and turning it to the right or left you will 
move the playback position manually forwards or back-
wards – much like scrubbing on a tape deck. This helps 
you pinpoint exact locations in the project.

• Note that the jog wheel is an “endless rotary encoder” – 
you can turn it as many times as needed to move to the 
desired location.
The faster you turn the wheel, the faster the playback speed. The original 
playback speed is the fastest speed possible.

• If you click the jog wheel during playback, playback au-
tomatically stops and scrubbing starts.

• The “Use Inserts While Scrubbing” option in the Prefer-
ences dialog on the Transport–Scrub page allows you to 
activate insert effects for scrubbing with the jog wheel.
By default, insert effects are bypassed.

You can also use a jog wheel on a remote controller 
for scrubbing.

The nudge position buttons
The “+” and “–” buttons in the middle of the Shuttle/Jog 
section allow you to nudge the project cursor position one 
frame at a time to the right or left.

Options and Settings

The “Return to Start Position on Stop” 
preference
This setting is found on the Transport page in the Prefer-
ences dialog (opened from the File menu under Windows, 
or the Nuendo menu under Mac OS X).

• If “Return to Start Position on Stop” is activated when 
you stop playback, the project cursor will automatically 
return to the position where recording or playback last 
started.

• If “Return to Start Position on Stop” is deactivated, the 
project cursor will remain at the position where you stop 
playback.
Pressing Stop again will return the project cursor to the position where 
recording or playback last started.

About track disable/enable
For audio tracks, the track context menu contains an item 
named “Disable Track”. This shuts down all disk activity 
for the track, as opposed to using Mute, which merely 
turns down the output volume for a track. For example, if 
you often record “alternative takes” you can easily build up 
a large number of takes on different tracks. Even though 
these tracks are muted, they are actually still “playing 
back” from the hard disk during playback. This puts an un-
necessary load on your disk system, so using “Disable 
Track” is recommended for such situations.

• Select “Disable Track” for tracks that you want to keep in 
the project for later use but do not want to play back now.
The track color changes to indicate that the track is disabled.
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• Select “Enable Track” from the track context menu to 
re-enable disabled tracks.

Playback functions
Apart from the standard transport controls on the Trans-
port panel, you can also find a number of functions on the 
Transport menu that can be used to control playback. The 
items have the following functionality:

In the Preferences dialog (Editing–Audio page) you 
will find the “Treat Muted Audio Events like Deleted” op-
tion. When you activate this option, any events overlapped 
by a muted event will become audible.

About Chase
Chase is a function that makes sure your MIDI instruments 
sound as they should when you locate to a new position 
and start playback. This is accomplished by the program 
transmitting a number of MIDI messages to your instru-
ments each time you move to a new position in the project, 
making sure all MIDI devices are set up correctly with re-
gard to program change, controller messages (such as 
MIDI Volume), etc.

For example, let’s say you have a MIDI track with a pro-
gram change event inserted at the beginning. This event 
makes a synth switch to a piano sound.

At the beginning of the first chorus you have another pro-
gram change event which makes the same synth switch to 
a string sound.

You now play back the song. It begins with the piano 
sound and then switches to the string sound. In the middle 
of the chorus you stop and rewind to some point between 
the beginning and the second program change. The synth 
will now still play the string sound although in this section 
it really should be a piano!

The Chase function takes care of that. If program change 
events are set to be chased, Nuendo will track the music 
back to the beginning, find the first program change and 
transmit it to your synth, setting it to the correct sound.

The same thing can apply to other event types as well. The 
Chase Events settings in the Preferences dialog (MIDI 
page) determine which event types will be chased when 
you locate to a new position and start playback.

Event types for which the checkbox is activated here 
will be chased.

• In this section of the Preferences dialog, you will also 
find the “Chase not limited to Part Boundaries” option.
When you activate this option, MIDI controllers are also chased outside 
the part boundaries, i. e. the Chase will be performed on the part touched 
by the cursor as well as on all the parts to the left of it. Please note that 
this option should be deactivated for very large projects, as it consider-
ably slows down operations such as positioning and soloing. When you 
deactivate this option, the MIDI controllers are only chased within the 
parts under the position cursor.

Option Description

Post-roll from 
Selection Start/End

Starts playback from the beginning or end of the 
currently selected range and stops after the time 
set in the Post-roll field on the Transport panel.

Pre-roll to Selection 
Start/End

Starts playback from a position before the start or 
end of the currently selected range and stops at 
the selection start or end, respectively. The play-
back start position is set in the Pre-roll field on the 
Transport panel.

Play from Selection 
Start/End

Activates playback from the beginning or end of the 
current selection.

Play until Selection 
Start/End

Activates playback two seconds before the start or 
end of the current selection and stops at the selec-
tion start or end, respectively.

Play until Next 
Marker

This activates playback from the project cursor and 
stops at the next marker.

Play Selection 
Range

This activates playback from the start of the current 
selection and stops at the selection end.

Loop Selection This activates playback from the start of the current 
selection and keeps starting over again when 
reaching the selection end.

! The functions listed above (except “Play until Next 
Marker”) are only available if you have selected one 
or more events or made a selection range.
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The Virtual Keyboard (Nuendo 
Expansion Kit only)
The Virtual Keyboard can be displayed in the Transport 
panel. It allows you to play and record MIDI notes by using 
your computer keyboard or mouse. This is useful if you have 
no external MIDI instrument at hand and you do not want to 
draw in notes with the Pencil tool. The Virtual Keyboard can 
perform all functions that can be controlled by external MIDI 
keyboards, e. g. playing and recording MIDI notes.

• You can choose between two different keyboard dis-
play modes: computer keyboard and piano keyboard. To 
switch between these two modes, click the “Change Vir-
tual Keyboard Display Type” button in the lower right cor-
ner of the Virtual Keyboard section or use the [Tab] key.

The Virtual Keyboard in computer keyboard display mode

The Virtual Keyboard in piano keyboard display mode

To record MIDI using the Virtual Keyboard, proceed as fol-
lows: 

1. Create or choose a MIDI or an instrument track and 
activate the “Record Enable” button for it.

2. Open the Virtual Keyboard by selecting “Virtual Key-
board” on the Devices menu, by pressing [Alt]/[Option]-
[K] or by right-clicking on the Transport panel and select-
ing “Virtual Keyboard” on the context menu.
The Virtual Keyboard is displayed in the Transport panel.

3. Activate the Record button and press a key on your 
computer keyboard to enter a note.
You can also click on the keys of the Virtual Keyboard to enter notes.

• You can also press several keys simultaneously to enter 
polyphonic parts. The maximum number of notes that can 
be played at one time varies between the different operat-
ing systems and hardware configurations.

4. Use the fader “Note velocity level” to the right of the 
virtual keyboard to adjust the volume.
You can also use the up and down arrow keys for this.

5. Enter the desired notes this way.

6. When you are done, hit the Stop button and close the 
Virtual Keyboard.
When the Virtual Keyboard is hidden, all key commands are available 
again.

Options and settings
• In piano keyboard mode, you have a wider range of keys 
at your disposal, allowing you to enter two voices simulta-
neously, for example bass and lead voice or bass drums 
and HiHats.
In computer keyboard mode, you can use the two rows of keys that are 
displayed on the Virtual Keyboard to enter notes. In piano keyboard 
mode, you can also use the two rows of keys below these.

• You have seven full octaves at your disposal. Use the 
“Octave Offset” buttons at the bottom of the virtual key-
board to offset the octave range of the keyboard. 
You can also use the left and right arrow keys to switch the keyboard 
range to a lower or higher octave, respectively.

• In piano keyboard mode, you can use the two sliders to 
the left of the keyboard to introduce pitchbend (left slider) 
or modulation (right slider).
You can also click on a key, hold the mouse button pressed until the 
mouse pointer becomes a crosshair tool and drag upwards/downward to 
introduce modulation or left/right to create pitchbend.

! When the Virtual Keyboard is displayed, the usual key 
commands are blocked because they are reserved for 
the Virtual Keyboard. The only exceptions are: [Ctrl]/
[Command]-[S] (Save), Num [*] (Start/Stop Record), 
[Space] (Start/Stop Playback), Num [1] (Jump to left 
locator), [Delete] or [Backspace] (Delete), Num [/] 
(Cycle on/off), [F2] (Show/Hide Transport panel), and 
[Alt]/[Option]-[K] (Show/Hide Virtual Keyboard).
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Background
This chapter describes the various recording methods 
that you can use in Nuendo. As it is possible to record 
both audio and MIDI tracks, both recording methods are 
covered in this chapter.

Before you start
This chapter assumes that you are reasonably familiar with 
certain basic recording concepts, and that the following 
initial preparations have been made:

• You have properly set up, connected and calibrated 
your audio hardware. 

• You have opened a project and set the project setup 
parameters to your specifications.
Project setup parameters determine the record format, sample rate, 
project length, etc. that affect the audio recordings you make during the 
course of the project, see “The Project Setup dialog” on page 57.

• If you plan to record MIDI, your MIDI equipment has to 
be set up and connected correctly.

Basic recording methods
This section describes the general methods used for re-
cording. However, there are additional preparations and 
procedures that are specific to audio and MIDI recording 
respectively. Make sure to read these sections before you 
start recording (see “Audio recording specifics” on page 
93 and “MIDI recording specifics” on page 103).

Record-enabling tracks
Nuendo can record on a single track or on several tracks 
(audio and/or MIDI) simultaneously. To make a track ready 
for recording, activate the Record Enable button for the 
track in the track list, in the Inspector, or in the Mixer.

Record Enable in the Inspector, track list, and Mixer

If the “Enable Record on Selected Track” option is ac-
tivated in the Preferences dialog (Editing–Project & Mixer 
page), tracks are automatically record-enabled when you 
select them in the track list.

You can set up key commands to record-enable all 
audio tracks simultaneously and to deactivate Record En-
able for all audio tracks (Arm/Disarm all Audio Tracks). 
You will find these commands in the Key Commands dia-
log, in the Mixer category (see “Setting up key commands” 
on page 581).

The exact number of audio tracks you can record si-
multaneously depends on your computer CPU and hard 
disk performance. In the Preferences dialog (VST page), 
you can find the “Warn on Processing Overloads” option. 
When this is activated, a warning message will be dis-
played as soon as the CPU clip indicator (on the Trans-
port panel) lights up during recording.
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Manually activating recording
You activate recording by clicking the Record button on 
the Transport panel or toolbar or by using the correspond-
ing key command (by default [*] on the numeric keypad).

Recording can be activated in Stop mode (from the current 
cursor position or from the left locator) or during playback:

• If you activate recording in Stop mode, and the “Start 
Record at Left Locator” option is activated on the Trans-
port menu, recording will start from the left locator.
The pre-roll setting or the metronome count-in will be applied (see 
“About Pre-roll and Post-roll” on page 108).

• If you activate recording in Stop mode, and “Start Record 
at Left Locator” is deactivated, recording will start from the 
current project cursor position.

• If you activate recording during playback, Nuendo will 
immediately enter Record mode and start recording from 
the current project cursor position.
This is known as “manual punch in”.

Activating recording in Sync mode

If you are synchronizing the Nuendo transport to external 
equipment (Sync is activated on the Transport panel) and 
you activate recording, the program will go into “record 
ready” mode (the record button on the Transport panel 
will light up). In this case, recording will start when a valid 
timecode signal is received (or when you click the Play 
button). See the chapter “Synchronization” on page 496 
for more information.

Automatically activating recording
Nuendo can automatically switch from playback to record-
ing at a given position. This is known as “automatic punch 
in”. A typical use for this is if you need to replace a section 
of a recording, and want to listen to what is already re-
corded, up to the recording start position.

1. Set the left locator to the position where you want re-
cording to start.

2. Activate the Punch In button on the Transport panel.

Punch In activated

3. Activate playback from some position before the left 
locator.
When the project cursor reaches the left locator, recording is automati-
cally activated.

Stopping recording
Again, this can be done automatically or manually:

• If you click the Stop button on the Transport panel (or 
use the corresponding key command, by default [0] on the 
numeric keypad), recording is deactivated and Nuendo 
goes into Stop mode.

• If you click the Record button (or use the key command 
for recording, by default [*]), recording is deactivated but 
playback continues.
This is known as “manual punch out”.

• If the Punch Out button is activated on the Transport 
panel, recording will be deactivated when the project cur-
sor reaches the right locator.
This is known as “automatic punch out”. By combining this with auto-
matic punch in, you can set up a specific section to record – again very 
useful if you want to replace a certain part of a recording (see also “Stop 
after Automatic Punch Out” on page 108).

Punch In and Out activated

Cycle recording
Nuendo can record and play back in a cycle – a loop. You 
specify where the cycle starts and ends by setting the left 
and right locators. When the cycle is active, the selected 
section is seamlessly repeated until you hit Stop or deac-
tivate cycle mode.

• To activate cycle mode, click the cycle button on the 
Transport panel.

Cycle activated
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• To record in cycle mode, you can start recording from 
the left locator, from before the locators or from within the 
cycle, in Stop mode or during playback.
As soon as the project cursor reaches the right locator, it will jump back 
to the left locator and continue recording a new lap.

• The results of cycle recording depend on the selected 
cycle record mode and are different for audio (see “Re-
cording audio in cycle mode” on page 99) and MIDI (see 
“Recording MIDI in cycle mode” on page 105).

Audio pre-record
This feature allows you to capture up to 1 minute of any in-
coming audio you play in Stop mode or during playback, 
“after the fact”. This is possible because Nuendo can cap-
ture audio input in buffer memory, even when not record-
ing. 

Proceed as follows:

1. Open the Preferences dialog (Record–Audio page).

2. Specify a time (up to 60 seconds) in the “Audio Pre-
Record Seconds” field.
This activates the buffering of audio input, making Pre-Record possible.

3. Make sure an audio track is record-enabled and re-
ceives audio from the signal source.

4. When you have played some audio material you want 
to capture (either in Stop mode or during playback), click 
the Record button.

5. After a few seconds stop the recording.
An audio event is created, starting at where the cursor position was 
when you activated recording. If you were in stop mode and the cursor 
was at the beginning of the project, you may have to move the event to 
the right in the next step. If you were playing along to a project you, leave 
the event where it is.

6. Select the Arrow tool and place the cursor on the bot-
tom left edge of the event so that a double arrow appears, 
then click and drag to the left. 
Now the event is extended and the audio you played before activating 
record is inserted – this means that if you played along during playback, 
the captured notes will end up exactly where you played them in relation 
to the project.

The position where the recording was activated is indicated by a 
colored line in the audio event.

Audio recording specifics

Selecting a recording file format
The format for recorded files is set in the Project Setup di-
alog on the Project menu. There are three settings: Sam-
ple Rate, Bit Resolution, and Record File Type. While the 
sample rate is set once and for all when you start working 
on a new project, the bit resolution and file type can be 
changed at any time.

Record File Type

The Record File Type setting determines which type of 
files will be created when you record:

• If you select Broadcast Wave File or AIFF format, you 
can specify Author, Description and Reference text strings 
that will be embedded in the recorded file.
This is done on the Record–Audio–Broadcast Wave page in the Prefer-
ences dialog.

Bit Resolution

The available options are 16 bit, 24 bit, and 32 bit float. 
Use the following guidelines:

• Normally, select the record format according to the bit 
resolution delivered by your audio hardware.
For example, if your audio hardware has 20 bit A/D converters (inputs), 
you may want to record at 24 bit resolution to capture the full bit resolu-
tion. On the other hand, if your hardware has 16 bit inputs, it is pointless 
to record with a higher bit resolution – this will only make the audio files 
larger, with no difference in audio quality. The exception is if you record 
with effects – see “Recording with effects” on page 101.

File type Description

Wave File Wave files have the extension “.wav” and are a common 
file format on the PC platform.

Wave 64 File Wave 64 is a proprietary format developed by Sonic 
Foundry Inc. Audio-wise it is identical to the Wave format, 
but the internal file structure makes much larger file sizes 
possible. This is useful for long live recordings in sur-
round format, where the audio files can become huge.

Broadcast  
Wave File

In terms of audio content, the same as regular Wave files, 
but with embedded text strings for supplying additional 
information about the file (see below).

AIFF File Audio Interchange File Format, a standard defined by Ap-
ple Inc. AIFF files have the extension “.aif” and are used 
on most computer platforms. Like Broadcast Wave files, 
AIFF files can contain embedded text strings (see below).
93
Recording



• The higher the bit resolution, the larger the files and the 
more strain is put on the disk system.
If this is an issue, you may want to lower the record format setting.

RAM requirements for recording
When recording live music performances, or during large 
postproduction projects, you will often simultaneously 
record on a large number of tracks at the same time.

Each track on which you record requires a certain amount 
of RAM, and the memory usage increases the longer the 
recording lasts. 

Please consider the RAM limitation (see “RAM” on page 
24) of your operating system when setting up your project 
for recording.

For each audio channel, 2.4 MB of RAM are required for 
mixer settings, etc. One minute of audio recording with a 
sample rate of 96 kHz on a mono track will increase mem-
ory usage by another 176 KB (Windows Task Manager, 
average).

Examples:

• Recording on a Windows 32 Bit system with 64 mono 
tracks at a sample rate of 44.1 kHz, lasting 60 minutes.
This would require a total of 403 MB of memory – not a problem on a 
modern computer.

• Recording on a Windows 32 Bit system with 128 mono 
tracks at a sample rate of 96 kHz, lasting 60 minutes.
This would require 1658 MB of memory – dangerously close to the 2 GB 
limit for RAM on a Windows 32 Bit computer.

Also note that the maximum file size for regular Wave 
files is 2 GB. If you want to record larger files, use the 
Waves 64 format (see “Record File Type” on page 93).

Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono, stereo or sur-
round tracks, with almost any combination of channels 
(LCRS, 5.1, 7.1, 10.2, etc). This allows you to record or 
import a file containing multiple channels and treat it as 
one entity, with no need to split it up into several mono 
files, etc. The signal path for an audio track maintains its 
channel configuration all the way from the input bus, via 
EQ, level and other Mixer settings to the output bus.

You specify the channel configuration for a track when you 
create it:

1. Select “Add Audio Track” from the track list context 
menu or the Project menu (or, if an audio track is already 
selected, double-click in an empty area of the track list).
A dialog opens with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
The most common formats are listed directly on the pop-up menu, with 
the remaining surround formats listed on the “More…” submenu. For a 
list of the available surround formats, see “Output bus configuration” on 
page 229.

• The Browse item in this dialog allows you to browse 
your disk(s) for created track presets, which can be used 
as a basis (or template) for tracks.
This is described in detail in the chapter “Working with track presets” on 
page 356.

3. Click the Add Track button.
A track is added, set to the specified channel configuration. In the Mixer, 
a corresponding channel strip appears. You cannot change the channel 
configuration for a track.

Selecting an input bus for a track

Here we assume that you have added and set up the re-
quired input busses (see “Setting up busses” on page 28). 
Before you record, you need to specify from which input 
bus the track will record. You can do this in the Inspector or 
in the Mixer.

! For further information on the options in the Project 
Setup dialog, see “The Project Setup dialog” on 
page 57.

! When a recording has used up all the memory made 
available by the operating system, the computer will 
crash.
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• In the Inspector, you select an input bus on the Input 
Routing pop-up menu in the top section.
As described in the section “The Inspector” on page 41, the Inspector 
shows the settings for the selected track.

• In the Mixer, you select an input bus on the Input Rout-
ing pop-up menu at the top of the track’s channel strip.
If this pop-up menu is not shown, you need to open the Mixer Routing 
View by clicking the “Show Routing” button in the extended Mixer com-
mon panel or by selecting “Show Routing View” from the Window sub-
menu of the Mixer context menu. See “Configuring the Mixer” on page 
154 for more information about the Mixer.

Recording from busses

You can also select an output bus, a group bus or an FX 
channel bus as an Input for your recording. 

Let’s assume you want to create a downmix of separate 
tracks, e. g. bass drum, hihats, snare, etc. 

Proceed as follows:

1. Set up your separate tracks as desired and add a 
group track.

2. For each of the drum tracks, open the Output Routing 
pop-up menu and select the Group track as output. 

3. Create a new audio track, open the Input Routing pop-
up menu for it and select the Group track as input for this 
audio track.

4. Record enable this audio track and start recording.

Now, the output of the group track will be recorded on the 
new track and you will get a mix of your separate tracks.

You can also select an FX channel as recording 
source. In this case, only the output of the FX channel will 
be recorded. 

For more information about the routing possibilities, see 
“Routing” on page 168.

Selecting a folder for the recorded audio files 

Each Nuendo project has a project folder containing 
(among other things) an “Audio” folder. By default, this is 
where recorded audio files are stored. However, you can 
select record folders independently for each audio track if 
needed.

Proceed as follows:

1. To select the same record folder for several audio 
tracks, select them by pressing [Shift] or [Ctrl]/[Com-
mand] and clicking on them in the track list.

2. Right-click the track list for one of the tracks to bring 
up the context menu.

3. Select “Set Record Folder”.
A file dialog opens.

4. Navigate to the desired folder (or create a new folder 
with the Create button).
Tip: if you want to have separate folders for different types of material 
(speech, ambient sounds, music, etc.), you can create subfolders within 
the project’s “Audio” folder and assign different tracks to different sub-
folders. This way, all audio files will still reside within the project folder, 
which will make managing the Project easier.

• It is possible to have different tracks record to totally dif-
ferent locations, even on different disks. However, if you 
need to move or archive the project, there is a risk of miss-
ing some files. The solution is to use the “Prepare Archive” 
function in the Pool to gather all external files into the 
project folder first, see “Prepare Archive” on page 332.

Click here to select an input bus for 
the track.

Click here to select an input 
bus for the track.

Click here to show or hide the 
input and output settings.
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Setting input levels
When recording digital sound, it is important to set the in-
put levels correctly – loud enough to ensure low noise and 
high audio quality, but not so loud that clipping (digital dis-
tortion) occurs.

Clipping typically occurs in the audio hardware when a 
too loud analog signal is converted to digital in the hard-
ware’s A/D converters. 

• It is also possible to get clipping when the signal from 
the input bus is written to a file on your hard disk.
This is because in Nuendo, you can make settings for the input bus, add-
ing EQ, effects, etc. to the signal as it is being recorded. This may raise 
the level of the signal, causing clipping in the recorded audio file.

To check the level of the “unprocessed” signal coming 
into the audio hardware, you need to switch the level 
meters to “Meter Input”. In this mode, the input channel 
level meters will show the level of the signal at the input of 
the bus, before any adjustments such as input gain, EQ, 
effects, level or pan:

1. Right-click in the Mixer window to open the context 
menu.

2. Select the Global Meter Settings submenu and make 
sure that “Meter Input” is activated.

3. Play back the audio and check the level meter for the 
input channel.
The signal should be as loud as possible without exceeding 0 dB (the 
Clipping indicator for the input bus should not light up).

The Clipping indicator

4. If necessary, adjust the input level in one of the follow-
ing ways:

• Adjust the output level of the sound source or external 
mixer.

• Use the audio hardware’s own application program to 
set the input levels (if possible).
See the documentation for the audio hardware.

• If your audio hardware supports the ASIO Control Panel 
function, it may be possible to make input level settings.
To open the ASIO control panel, open the Device Setup dialog via the De-
vices menu and, in the list to the left (below “VST Audio System”), select 
your audio card. When this is selected, you can open the Control Panel by 
clicking the Control Panel button in the settings section to the right.

The next step is to check the level of the audio being writ-
ten to a file on your hard disk. This is only necessary if you 
have made any adjustments to the input channel (level 
settings, EQ, insert effects, etc.). 

Also note the following:

• If you record in 32 bit float format, the bit resolution will 
not be reduced – which means there is no risk of clipping 
at this stage.
Also, this preserves the signal quality perfectly. Therefore, you should 
consider using 32 bit float format when you are recording with effects 
(see “Recording with effects” on page 101).

• If you record in 16 or 24 bit format, the available head-
room is lower, which means clipping can occur if the sig-
nal is too loud. To avoid this, set the signal as described 
below.

1. Bring up the Mixer context menu, open and select 
Global Meter Settings “Meter Post-Fader”.

2. Set up the input channel, by adding EQ and/or effects.
With some effects you may want to adjust the level of the signal going 
into the effect – use the Input Gain knob for this. Note that you need to 
press [Shift] or [Alt]/[Option] to adjust the Input Gain.

Adjusting the Input Gain.

3. Play back the audio and check the level meter of the 
input channel.
The signal should be reasonably loud without exceeding 0 dB (the Clip-
ping indicator for the input bus should not light up).

4. If necessary, use the input channel fader to adjust the 
signal level.
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Monitoring
In this context, “monitoring” means listening to the input 
signal during recording. There are three fundamentally dif-
ferent ways to do this: via Nuendo, externally (by listening 
to the signal before it reaches Nuendo), or by using ASIO 
Direct Monitoring (which is a combination of both other 
methods – see below).

Monitoring via Nuendo

If you monitor via Nuendo, the input signal is mixed in with 
the audio playback. The advantage of this is that you can 
adjust the monitoring level and panning in the Mixer, and 
add effects and EQ to the monitor signal just as during 
playback (using the track’s channel strip – not the input 
bus!). 

The disadvantage of monitoring via Nuendo is that the 
monitored signal will be delayed according to the latency 
value (which depends on your audio hardware and driv-
ers). Therefore, monitoring via Nuendo requires an audio 
hardware configuration with a low latency value. You can 
check the latency of your hardware in the Device Setup 
dialog (VST Audio System page).

If you are using plug-in effects with large inherent de-
lays, the automatic delay compensation function in Nuendo 
will increase the latency. If this is a problem, you can use the 
Constrain Delay Compensation function while recording, 
see “Constrain Delay Compensation” on page 225.

When monitoring via Nuendo, you can select one of four 
Auto Monitoring modes in the Preferences dialog (VST 
page):

• Manual
This option allows you to turn input monitoring on or off by clicking the 
Monitor button in the Inspector, the track list or in the Mixer.

• While Record Enabled
With this option, you will hear the audio source connected to the channel 
input whenever the track is record enabled.

• While Record Running
This option switches to input monitoring only during recording.

• Tapemachine Style
This option emulates standard tapemachine behavior: input monitoring in 
Stop mode and during recording, but not during playback.

• In the Preferences dialog (VST–Metering page) you can 
find the “Map Input Bus Metering to Audio Track (in Direct 
Monitoring)” option.
When Direct Monitoring is activated in the Device Setup dialog, this op-
tion allows you to map the input bus metering to monitor-enabled audio 
tracks. This gives you the opportunity to watch the input levels of your 
audio tracks when working in the Project window. 

When Direct Monitoring is activated in the Device Setup 
dialog, this function works as follows:

• When “Map Input Bus Metering to Audio Track (in Direct 
Monitoring)” is activated, audio tracks show the metering sig-
nal from the input bus they are routed to as soon as the track 
is record-enabled. 
Note that the tracks are mirroring the input bus signal, i. e. you 
will see the same signal in both places. When using mapped 
metering, any functions (e. g. trimming) you apply to the audio 
track are not reflected in its meters.

• When “Map Input Bus Metering to Audio Track (in Direct 
Monitoring)” is not activated, metering works as usual.

External monitoring

External monitoring (listening to the input signal before it 
goes into Nuendo) requires some sort of external mixer for 
mixing the audio playback with the input signal. This can 
be a stand-alone physical mixer or a mixer application for 
your audio hardware, if this has a mode in which the input 
audio is sent back out again (usually called “Thru”, “Direct 
Thru” or similar).

When using external monitoring, you cannot control the 
level of the monitor signal from within Nuendo or add VST 
effects or EQ to the monitor signal. The latency value of 
the audio hardware configuration does not affect the mon-
itor signal in this mode.

If you want to use external monitoring, you need to 
make sure that monitoring via Nuendo is not activated as 
well. Select the “Manual” monitoring mode in the Prefer-
ences dialog (VST page) and do not activate the Monitor 
buttons.
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ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may sup-
port ASIO Direct Monitoring (this feature may also be avail-
able for audio hardware with Mac OS X drivers). In this 
mode, the actual monitoring is done in the audio hardware, 
by sending the input signal back out again. However, moni-
toring is controlled from Nuendo. This means that the audio 
hardware’s direct monitoring feature can be turned on or off 
automatically by Nuendo, just as when using internal moni-
toring. 

• To activate ASIO Direct Monitoring, open the Device 
Setup dialog on the Devices menu and activate the Direct 
Monitoring checkbox on the page for your audio hardware.
If the checkbox is grayed out, your audio hardware (or its driver) does not 
support ASIO Direct Monitoring. Consult the audio hardware manufac-
turer for details.

• When ASIO Direct Monitoring is activated, you can se-
lect a monitoring mode in the Preferences dialog (VST 
page), as when monitoring via Nuendo (see “Monitoring 
via Nuendo” on page 97).

• Depending on the audio hardware, it may also be possi-
ble to adjust the monitoring level and panning from the 
Mixer (including the Control Room section, but excluding 
the Talkback and External Return channels) by adjusting 
the volume faders, and the input gain controls and the 
send levels for Control Room studios.
Consult the documentation of the audio hardware if in doubt.

• VST effects and EQ cannot be applied to the monitor 
signal in this mode, since the monitor signal does not pass 
through Nuendo.

• Depending on the audio hardware, there may be special 
restrictions as to which audio outputs can be used for di-
rect monitoring.
For details on the routing of the audio hardware, see its documentation.

The latency value of the audio hardware configuration 
does not affect the monitor signal when using ASIO Direct 
Monitoring.

When using Steinberg hardware (MR816 series) in com-
bination with ASIO Direct Monitoring, monitoring will be 
virtually latency-free.

If you are using RME Audio Hammerfall DSP audio 
hardware, make sure that the pan law is set to -3 dB in the 
card’s preferences.

Recording
Recording is done using any of the general recording 
methods (see “Basic recording methods” on page 91). 
When you finish recording, an audio file is created in the 
Audio folder within the project folder. In the Pool, an audio 
clip is created for the audio file, and an audio event that 
plays the whole clip appears on the recording track. Fi-
nally, a waveform image is calculated for the audio event. If 
the recording was very long, this may take a while.

If the “Create Audio Images During Record” option is 
activated in the Preferences dialog (Record–Audio page), 
the waveform image will be calculated and displayed dur-
ing the actual recording process. This realtime calculation 
uses some processing power – if your processor is slow 
or you are working on a CPU-intensive project, consider 
turning this option off.

Undoing recording

If you decide that you do not like what you just recorded, 
you can delete it by selecting Undo from the Edit menu. 
The following will happen:

• The event(s) you just created will be removed from the Project 
window.

• The audio clip(s) in the Pool will be moved to the Trash folder.
• The recorded audio file(s) will not be removed from the hard 

disk.

However, since their corresponding clips are moved to 
the Trash folder, you can delete the files by opening the 
Pool and selecting “Empty Trash” from the Media menu, 
see “Deleting from the hard disk” on page 326.

Recording overlapping events
The basic rule for audio tracks is that each track can play 
back a single audio event at a time. This means that if two 
or more events are overlapping, only one of them will be 
heard at any given time.

What happens when you record overlapping events 
(record in an area where there are already events on the 
track) depends on the Linear Record Mode setting on the 
Transport panel:
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• In “Normal” or “Merge” mode, recording where some-
thing has already been recorded creates a new audio 
event that overlaps the previous one(s).
When you record audio, there is no difference between “Normal” and 
“Merge” mode – the difference only applies to MIDI recording (see 
“About overlap and the Record Mode setting” on page 104).

• In “Replace” mode, existing events (or portions of 
events) that are overlapped by the new recording will be 
removed.
This means that if you record a section in the middle of a longer existing 
recording, the original event will be cut into two events with a gap for the 
new event.

Which event will be heard?

If two or more events are overlapping, you will only hear 
the events (or portions of events) that are actually visible. 
Overlapped (hidden) events or sections are not played 
back.

• The functions “Move to Front” and “Move to Back” on 
the Edit menu (Move submenu, see “Moving events” on 
page 69) are useful for managing overlapping events, as is 
the “To Front” function.

Recording audio in cycle mode
If you are recording audio in cycle mode, the result de-
pends on two factors:

• The “Cycle Record Mode” setting on the Transport 
panel.

• The “Audio Cycle Record Mode” setting in the Prefer-
ences dialog (Record–Audio page).

Cycle Record Modes on the Transport panel

There are five different modes on the Transport panel, but 
the first two modes only apply to MIDI recording. For au-
dio cycle recording, the following applies:

• If “Keep Last” is selected, the last complete “take” (the 
last completely recorded lap) is kept as an audio event.
In reality, all laps you recorded are saved in one audio file divided into re-
gions – one region for each take. You can easily select a previous take 
for playback – this is done as when recording in “Create Regions” mode 
(see “Create Regions mode (Preferences)” on page 100).

• If “Stacked” is selected, each take will appear as an 
event on a separate “lane” on the track.
This is useful when you want to view and edit the different takes and 
eventually combine them to one recording. In this mode, the Audio Cycle 
Record Mode preference does not matter. Stacked 2 (No Mute) is the 
same as Stacked, except that all the takes will be audible, see “Record-
ing audio in Stacked mode” on page 101. 

• If any of the other cycle recording modes is selected, 
the result depends entirely on the “Audio Cycle Record 
Mode” setting in the Preferences dialog (Record–Audio 
page).
These options are described below.

Create Events mode (Preferences)

When “Audio Cycle Record Mode” is set to “Create 
Events” in the Preferences dialog (Record–Audio page), 
the following will happen when you record audio in cycle 
mode:

• One continuous audio file is created during the entire 
recording process. 

• For each recorded lap of the cycle, one audio event is 
created.
The events will have the name of the audio file plus the text “Take *”, 
where “*” indicates the number of the take.

• The last take (the last recorded lap) will be on top (and 
will thus be the one you hear when you activate playback).
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To select another take for playback, proceed as follows:

1. Holding [Alt]/[Option], right-click the event and select 
“To Front” on the context menu.
Whether a right click opens the context menu or the toolbox is deter-
mined by the “Popup Toolbox on Right Click” option in the Preferences 
dialog (Editing–Tools page). Depending on this setting the context menu 
is opened by right-clicking or by right-clicking holding any modifier key.

The “To Front” submenu, listing all the other (obscured) events.

2. Select the desired take.
The corresponding event is brought to front.

This method allows you to quickly combine the best parts 
of each take, in the following way:

1. Use the Scissors tool to split the events in several 
sections, one for each part of the take.
For example, if you recorded four lines of vocals (in each take), you can 
split the events so that each line gets a separate event.

The events after splitting. Note that since the original take events 
overlap each other, clicking with the Scissors tool will split all takes at 
the same position.

2. For each section of the take, use the “To Front” func-
tion to bring the best take to the front.
This way, you can quickly combine the best sections of each take, using 
the first vocal line from one take, the second line from another take, and 
so on.

You can also compile a “perfect” take in the Audio Part 
Editor, see “Assembling a “perfect take”” on page 318.

Create Regions mode (Preferences)

When Audio Cycle Record Mode is set to “Create Re-
gions” in the Preferences dialog (Record–Audio page), 
the following will happen when you record audio in cycle 
mode:

• One continuous audio file is created during the entire 
recording process. 

• The audio event in the Project window shows the name 
of the audio file plus the text “Take *” (with “*” being the 
number of the last completed cycle lap).

• If you play back the recorded event, you will only hear 
what was recorded during the last lap of the cycle record-
ing. 
The previous “takes” recorded in the cycle are still available, however. 

• The audio clip is divided into regions (called takes), one 
for each lap of the cycle that was recorded.
If you locate the audio file you just recorded in the Pool, and click on the 
“+” sign beside it, you can see the regions that have been created, one 
for each lap of the cycle that was completed during recording.

“Take” regions in the Pool window

To play back the different “takes”, proceed as follows:

1. In the Project window, open the context menu for the 
event that was created during cycle recording.

2. Select the “Set To Region” menu item.
A submenu opens with the takes you recorded during cycle record.

3. Now you can select any of the takes from the submenu 
and it will replace the previous take event in the Project 
window.

Use this method to listen through the various takes. Select 
the best single take, or compile a “perfect” take by cutting 
out the best bits from each take and putting them together 
(see “Assembling a “perfect take”” on page 318).

Create Events + Regions mode (Preferences)

In this mode, both events and regions are created. If you 
work with the takes as events in this mode, you can edit 
the events freely (e. g. splitting them), see “Create Events 
mode (Preferences)” on page 99. However, in case you 
want to go back to the original takes, they are still available 
as regions (on the “Set To Region” submenu, in the Pool 
or in the Sample Editor).
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Recording audio in Stacked mode

When you record audio in cycle mode and the “Stacked” 
Cycle Record Mode is selected on the Transport panel, 
the following happens: 

• Each complete recorded cycle lap is turned into a separate 
audio event.

• The track is divided into “lanes”, one for each cycle lap.
• The events are stacked above each other, each on a different 

lane.

This makes it easy to create a “perfect take” by combining 
the best parts from the different cycle laps:

1. Zoom in so you can work comfortably with the stacked 
events.

If you play back the recorded section, only the lowest 
(last) take will be heard. 

2. To audition another take, either mute the lower take(s) 
with the Mute tool or move the takes between the lanes.
This can be done by dragging or by using the functions Move to Front/
Back on the context menu or the Edit menu.

3. Edit the takes so that only the parts you want to keep 
can be heard.
You can cut events with the Scissors tool, resize them, mute them or de-
lete them.

The sections that will be heard are indicated in green.

4. When you are satisfied with the result, select all 
events on all lanes and select “Delete Overlaps” from the 
Advanced submenu of the Audio menu.
This puts all events back on a single lane and resizes events so that over-
lapped sections are removed.

5. To turn off the lane display mode for the track, click the 
Lane Display Type button in the track list and select 
“Lanes Off”.
If the button is hidden, you can bring it to view in the Track Controls Set-
tings dialog – see “Customizing track controls” on page 573.

The Lane Display Type button

Recording with effects
Normally you record the audio signals “dry” and add ef-
fects non-destructively during playback as described in 
the chapter “Audio effects” on page 195. However, Nu-
endo also allows you to add effects (and/or EQ) directly 
while recording. This is done by adding insert effects and/
or making EQ settings for the input channel in the Mixer.

This will make the effects become part of the audio file 
itself – you cannot change the effect settings after record-
ing.

About the record format

When you record with effects, consider setting the bit res-
olution to 32 Bit Float. This is done in the Project Setup 
dialog on the Project menu. Note that this is not required 
in any way – you can also record with effects in 24 or 
16 Bit format. 

However, there are two advantages to 32 Bit Float format:

• With 32 Bit Float recording, you do not risk clipping 
(digital distortion) in the recorded files.
This can of course be avoided with 24 or 16 Bit recording as well, but re-
quires more care with the levels.
101
Recording



• Nuendo processes audio internally in 32 Bit Float for-
mat – recording in the same format means the audio qual-
ity will be kept absolutely pristine.
The reason is that the effect processing in the input channel (as well as any 
level or EQ settings you make there) is done in 32 Bit Float format. If you 
record at 16 or 24 Bit, the audio will be converted to this lower resolution 
when it is written to file – with possible signal degradation as a result.

Note also that it does not matter at which actual resolution 
your audio hardware works. Even if the signal from the au-
dio hardware is in 16 Bit resolution, the signal will be 32 
Bit Float after the effects are added in the input channel.

An example

This example shows how to apply the “SoftClipper” effect 
while recording. Note that this is only an example. The prin-
ciple is the same for all effects (or combinations of effects).

1. Set up an audio track for recording and select the de-
sired input bus.
For best results, also activate monitoring as this allows you to hear and 
try out your settings before actually recording. See “Monitoring via Nu-
endo” on page 97 for a description of monitoring via Nuendo.

2. Open the Mixer and make sure that the full extended 
view is shown.
To show the extended Mixer view, either click the arrow icon (“Show Ex-
tended Mixer”) in the Common Panel, select “Show Extended View” from 
the Window submenu of the Mixer context menu or use a key command 
(this can be set in the Key Commands dialog, see “Setting up key com-
mands” on page 581).

3. Locate the input channel (bus) from which you record.
If the input channels are hidden, click on the Show/Hide Input Channels 
button to the left.

4. Check the input level (of the signal coming into the au-
dio hardware) as described in the section “Setting input 
levels” on page 96 and adjust the level of the source audio 
if necessary.

5. Pull down the View Options pop-up menu for the input 
channel and select “Inserts”.

The View Options pop-up menu is opened by clicking the arrow button 
between the fader panel and the extended panel.

Now the extended panel for the input channel shows the 
insert slots.

6. Click on an insert slot and select an effect from the 
context menu.
As you see, the included effects are sorted into submenus – you will find 
the SoftClipper effect on the “Distortion” submenu.

The effect is loaded and activated and its control panel is 
automatically opened.

7. Adjust the effect parameters to your liking.
For detailed information on the Effect parameters, see the separate PDF 
document “Plug-in Reference”.

8. When the effect is set up as desired, you can check 
the level of the input channel by setting the Meters to 
post-fader (see “Setting input levels” on page 96). 
Use the input channel fader to adjust the level if needed.

9. Activate recording.

10. When you’re finished, you can play back the recorded 
audio track. 
As you can hear, the effect you applied is now a part of the actual audio file.

11. If you do not want to record more with the same plug-
in, deactivate it by clicking in the insert slot and selecting 
“No Effect”.
102
Recording



MIDI recording specifics

Activating MIDI Thru
Normally, when working with MIDI, you will have MIDI Thru 
activated in Nuendo, and Local Off selected in your MIDI 
instrument(s). In this mode, everything you play during re-
cording will be “echoed” back out again on the MIDI out-
put and channel selected for the recording track.

1. Make sure that the “MIDI Thru Active” option is acti-
vated in the Preferences dialog (MIDI page).

2. Record enable the track(s) on which you want to 
record.
Now, incoming MIDI is “echoed” back out again for all record-enabled 
MIDI tracks. 

If you just want to use the Thru function for a MIDI 
track without recording, activate the monitor button for the 
track instead. This is useful, for instance, if you want to try 
out different sounds or play a VST instrument in realtime 
without recording your playing.

Setting MIDI channel, input, and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the 
same time, each on a different MIDI channel. This is the 
key to playing back several sounds (bass, piano, etc.) from 
the same instrument. Some devices (such as General 
MIDI compatible sound modules) always receive on all 16 
MIDI channels. If you have such an instrument, there is no 
specific setting you need to make in the instrument. On 
other instruments, you will have to use the front panel con-
trols to set up a number of “Parts”, “Timbres” or similar so 
that they receive on one MIDI channel each. See the man-
ual that came with your instrument for more information.

Naming MIDI ports in Nuendo

MIDI inputs and outputs are often displayed with unneces-
sarily long and complicated names. However, you can re-
name your MIDI ports to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.

2. Select the MIDI Port Setup item in the Device list.
The available MIDI inputs and outputs are listed. Under Windows, which 
device to choose depends on your system.

3. To change the name of a MIDI port, click in the “Show 
As” column and type in a new name.
After closing the dialog, the new name will appear on the MIDI Input and 
Output Routing pop-up menus.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector (the area 
to the left of the track list in the Project window):

1. Select the track by clicking in the track list.
To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The 
Inspector shows the settings for the first selected track (for details, see 
“The Inspector” on page 41).

2. Click the track name in the Inspector to make sure that 
the topmost section is shown.

3. Pull down the Input Routing pop-up menu and select 
an input.
The available MIDI inputs are shown. The items on the menu depend on 
the type of MIDI interface you are using. 

• If you select the “All MIDI Inputs” option, the track will 
receive MIDI data from all available MIDI inputs.

• If you hold down [Shift]-[Alt]/[Option] and select a MIDI 
input, this will be used for all selected MIDI tracks.

Record Enable 
button

Monitor 
button
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Setting the MIDI channel and output

The MIDI channel and output settings determine where 
the recorded MIDI is routed during playback, but are also 
relevant for MIDI Thru in Nuendo. Channel and output can 
be selected in the track list or in the Inspector. The proce-
dure below describes how to make the settings in the In-
spector, but it can be done in largely the same manner in 
the track list as well.

1. To select the track(s) and show the settings in the 
Inspector, proceed as when selecting a MIDI input (see 
above).

2. Pull down the Output Routing pop-up menu and se-
lect an output.
The available MIDI outputs are shown. The items on the menu depend on 
what type of MIDI interface you are using.

• If you hold down [Shift]-[Alt]/[Option] and select a MIDI 
output, this is selected for all selected MIDI tracks.

3. Use the Channel pop-up menu to select a MIDI chan-
nel for the track.

• If you set the track to MIDI channel “Any”, each MIDI 
event on the track will be sent out on the channel stored in 
the event itself.
In other words, the MIDI material will be played back on the channel(s) 
used by the MIDI input device (the MIDI instrument you play during re-
cording).

Selecting a sound
You can select sounds from within Nuendo by instructing 
the program to send Program Change and Bank Select 
messages to your MIDI device. This is done using the 
“Patch Selector” and “Bank Selector” fields in the Inspec-
tor or track list.

Program Change messages give access to 128 different 
program locations. If your MIDI instruments have more 
than 128 programs, Bank Select messages (set in the 
“Bank Selector” field) allow you to select different banks, 
each containing 128 programs.

Bank Select messages are recognized differently by 
different MIDI instruments. The structure and numbering 
of banks and programs may also vary. Consult the docu-
mentation of your MIDI instruments for details.

Note that it is also possible to select sounds by name. 
For descriptions of how to set this up, see the separate 
PDF document “MIDI Devices”.

Recording
Recording MIDI is done according to the basic recording 
methods (see “Basic recording methods” on page 91). 
When you finish recording, a part containing MIDI events 
is created in the Project window.

About overlap and the Record Mode setting

MIDI tracks are different from audio tracks when it comes 
to overlapping parts:

All events in overlapping parts are always played back. 
If you record several parts at the same locations (or move 
parts so that they overlap), you will hear the events in all 
parts on playback, even though some of the parts are ob-
scured in the Project window.

When recording overlapping parts, the result depends on 
the Linear Record Mode setting on the Transport panel:

• If the record mode is set to “Normal”, overdub recording 
works as with audio tracks, i. e. if you record again where 
something has already been recorded, you get a new part that 
overlaps the previous one(s).

• If the record mode is set to “Merge”, the overdubbed events 
are added to the existing part.

• If the record mode is set to “Replace”, the new recording re-
places any existing events in the area on that track.
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About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch 
in/out recording for MIDI tracks is done in exactly the 
same way as for audio tracks. There is one thing to note, 
however: 

• Punching in and out on recordings with pitchbend or 
controller data (modulation wheel, sustain pedal, volume, 
etc.) may lead to strange effects (apparently hanging 
notes, constant vibrato, etc.).
If this happens, you may need to use the Reset item on the MIDI menu 
(see “The Reset function” on page 106).

About the Automatic MIDI Record Quantize function

If Auto Quantize is activated on the Transport panel (the 
“Auto Q” button), the notes you record are automatically 
quantized according to the current Quantize settings. For 
more information about quantizing, see “The quantizing 
functions” on page 392.

Recording MIDI in cycle mode
When you record MIDI in cycle mode, the result depends 
on which Cycle Record mode is selected on the Transport 
panel:

Cycle Record mode: Mix (MIDI)

For each completed lap, everything you record is added to 
what was previously recorded in the same part. This is use-
ful for building up rhythm patterns, for example. Record a hi-
hat part on the first lap, the bass drum part on the second 
lap, etc. 

Cycle Record mode: Overwrite (MIDI)

As soon as you play a MIDI note (or send any MIDI mes-
sage), all MIDI you have recorded on previous laps is over-
written from that point on in the part. An example:

1. You start recording in an eight bar cycle.

2. The first take was not good enough – you start directly 
with a new take on the next cycle lap and overwrite the 
first take.

3. After recording the second take you let the recording 
roll on and listen, without playing anything. 
You find that the take was good up until bar seven, for example.

4. On the next lap, you wait until bar seven and start 
playing.
This way you will overwrite the last two bars only.

5. Make sure that you stop playing before the next lap 
begins – otherwise you will overwrite the entire take.

Cycle Record mode: Keep Last

Each completed lap replaces the previously recorded lap. 
Note the following:

• The cycle lap must be completed – if you deactivate re-
cording or press Stop before the cursor reaches the right 
locator, the previous take will be kept.

• If you do not play or input any MIDI during a lap, nothing 
happens (the previous take will be kept).

Cycle Record mode: Stacked/Stacked 2 (No Mute)

In this mode, the following happens: 

• Each recorded cycle lap is turned into a separate MIDI part.
• The track is divided into “lanes”, one for each cycle lap.
• The parts are stacked above each other, each on a different 

lane.
• All takes but the last one are muted (Stacked). 
• If Stacked 2 is selected, no muting takes place.

This makes it easy to create a “perfect take” by combining 
the best parts from the different cycle laps. You can edit 
the parts in the Project window (by cutting, resizing and 
deleting) or you can use a MIDI editor as in the following 
example:

1. Unmute the muted takes by clicking the parts with the 
Mute tool.

2. Select all takes (parts) and open them in the Key Edi-
tor for example.

3. Use the part list pop-up menu on the toolbar to select 
which part to edit.
See “Handling several parts” on page 405.

4. Remove or edit notes as desired.
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5. When you are happy with the result, close the editor.

6. To turn it all into a single MIDI part (containing your 
“perfect take”), select all parts and select “Merge MIDI in 
Loop” from the MIDI menu.

7. In the dialog that opens, activate the Erase Destination 
option and click OK.
The remaining events in the parts are merged together into a single part.

Recording different types of MIDI messages

Notes

When you press and release a key on your synth or other 
MIDI keyboard, a Note On (key down) and a Note Off (key 
up) message are sent out. The MIDI note message also 
contains the information which MIDI channel was used. 
Normally, this information is overridden by the MIDI chan-
nel setting for the track, but if you set the track to MIDI 
channel “Any”, the notes will be played back on their orig-
inal channels.

Continuous messages

Pitchbend, aftertouch, and controllers (like modulation 
wheel, sustain pedal, volume, etc.) are considered as MIDI 
continuous events (as opposed to the momentary key 
down and key up messages). If you move the pitchbend 
wheel on your synthesizer while recording, this movement 
is recorded together with the key (Note On and Note Off 
messages), just as you’d expect. But the continuous mes-
sages can also be recorded after the notes have been re-
corded (or even before). They can also be recorded on 
their own tracks, separately from the notes to which they 
belong. 

Say, for instance, that you record one or several bass 
parts on track 2. If you now set another track, like track 55, 
to the same output and MIDI channel as track 2, you can 
make a separate recording of just pitchbends for the bass 
parts on track 55. This means that you activate recording 
as usual and only move the pitchbend wheel during the 
take. As long as the two tracks are set to the same output 
and MIDI channel, it will appear to the MIDI instrument as 
if the two recordings were made at the same time.

Program Change messages

Normally, when you switch from one program to another 
on your keyboard (or whatever you use to record), a num-
ber corresponding to that program is sent out via MIDI as 
a Program Change message. These can be recorded on 
the fly with the music, recorded afterwards on a separate 
track, or manually entered in the Key or List Editors. 

System Exclusive messages

System Exclusive (SysEx) is a special type of MIDI mes-
sage used to send data that only makes sense to a unit of 
a certain make and type. SysEx can be used to transmit a 
list of the numbers that make up the settings of one or 
more sounds in a synth. For details about viewing and ed-
iting SysEx messages, see the section “Working with 
SysEx messages” on page 427.

The Reset function
The Reset function on the MIDI menu sends out note-off 
messages and resets controllers on all MIDI channels. 
This is sometimes necessary if you experience hanging 
notes, constant vibrato, etc.

There are two other options to perform a reset:

• Nuendo can automatically perform a MIDI reset on stop.
You can turn this function on or off in the Preferences dialog (MIDI page).

• Nuendo can automatically insert a reset event at the end 
of a recorded part. 
Open the Preferences dialog (MIDI page) and activate the “Insert Reset 
Events after Record” option. The inserted Reset event will reset controller 
data such as Sustain, Aftertouch, Pitchbend, Modulation, Breath Control, 
etc. This is useful if a MIDI part is recorded and the Sustain pedal is still 
held after stopping recording. Usually, this would cause all following parts 
to be played with Sustain, as the Pedal Off command was not recorded. 
This can be prevented by activating “Insert Reset Events after Record”.

! Use MIDI Filters to decide exactly which event types 
are recorded, see “Filtering MIDI” on page 107.
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Retrospective Record
This feature allows you to capture any MIDI notes you play 
in Stop mode or during playback and turn them into a MIDI 
part “after the fact”. This is possible due to the fact that 
Nuendo can capture MIDI input in buffer memory, even 
when not recording.

Proceed as follows:

1. Enable the Retrospective Record option in the Prefer-
ences dialog (Record–MIDI page).
This activates the buffering of MIDI input, making Retrospective Record 
possible.

2. Make sure a MIDI track is record-enabled.

3. When you have played some MIDI material you want 
to capture (either in Stop mode or during playback), select 
Retrospective Record from the Transport menu (or use 
the key command, by default [Shift]-Num[*]).

The content of the MIDI buffer (i. e. what you just played) is 
turned into a MIDI part on the record enabled track. The 
part will appear where the project cursor was when you 
started playing – this means that if you played along dur-
ing playback, the captured notes will end up exactly where 
you played them in relation to the project.

• The Retrospective Record Buffer Size setting in the 
Preferences dialog (Record–MIDI page) determines how 
much data can be captured.

MIDI Preferences
There are several other options and settings in the Prefer-
ences that affect MIDI recording and playback:

MIDI page

• Length Adjustment
Adjusts the length of notes so that there is always a short time between 
the end of one note and the start of another (of the same pitch and on the 
same MIDI channel). The time is set in ticks. By default there are 120 
ticks per 1/16 note, but you can adjust this with the MIDI Display Reso-
lution setting on the same page.

Record–MIDI page

• Snap MIDI Parts to Bars
When this is activated, recorded MIDI parts will automatically be length-
ened to start and end at whole bar positions. If you are working in a 
Bars+Beats-based context, this can make editing (moving, duplicating, 
repeating, etc.) easier.

• Solo Record in MIDI Editors
If this is activated and you open a part for editing in a MIDI editor, its track 
is automatically record-enabled. Furthermore, Record Enable is deacti-
vated for all other MIDI tracks until you close the editor again. 
This makes it easier to record MIDI data when you’re editing a part – you 
will always be sure the recorded data ends up in the edited part and not on 
any other track.

• MIDI Record Catch Range in ms
When you record starting at the left locator, this setting helps you make 
sure that the very start of the recording is included. A very annoying 
scenario is when you have recorded a perfect MIDI take, only to find out 
that the very first note was not included – because you started playing a 
little bit too early! If you raise the Record Catch Range, Nuendo will 
catch the events played just before the recording start point, eliminating 
this problem. 

For a description of the other options, click the Help but-
ton in the Preferences dialog.

Filtering MIDI

The MIDI–MIDI Filter page in the Preferences dialog allows 
you to prevent certain MIDI messages from being recorded 
and/or “thruput” (echoed by the MIDI Thru function).

The dialog is divided into four sections:

Section Description

Record Activating any of these options prevents that type of MIDI 
message from being recorded. It can, however, be thru-
put, and if already recorded, it will play back normally.

Thru Activating any of these options prevents that type of MIDI 
message from being thruput. It can, however, be recorded 
and played back normally.
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Options and Settings

Recording-related Transport Preferences
A couple of settings in the Preferences dialog (Transport 
page) are relevant for recording. Set these according to 
your preferred method of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is auto-
matically deactivated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after 
automatic punch out (when the project cursor reaches the 
right locator and punch out is activated on the Transport 
panel). If the post-roll value on the Transport panel is set 
to a value other than zero, playback will continue for the 
set time before stopping (see below).

About Pre-roll and Post-roll

The pre-roll and post-roll value fields (below the left/right 
locator fields) on the Transport panel have the following 
functionality:

• By setting a pre-roll value, you instruct Nuendo to “roll 
back” a short section whenever playback is activated.
This applies whenever you start playback, but is perhaps most relevant 
when recording from the left locator (punch in activated on the Transport 
panel) as described below.

• By setting a post-roll value, you instruct Nuendo to play 
back a short section after automatic punch out before 
stopping.
This is only relevant when punch out is activated on the Transport panel 
and “Stop after Automatic Punch Out” is activated in the Preferences di-
alog (Transport page).

• To turn pre-roll or post-roll on or off, click the corre-
sponding button on the Transport panel (next to the pre/
post-roll value) or use the “Use Pre-roll” and “Use Post-
roll” options on the Transport menu.

An example:

1. Set the locators to where you want to start and end re-
cording.

2. Activate Punch in and Punch out on the Transport 
panel.

3. Activate the “Stop after Automatic Punch Out” option 
in the Preferences dialog (Transport page).

4. Set suitable pre-roll and post-roll times by clicking in 
the corresponding fields on the Transport panel and typ-
ing in time values.

5. Activate pre-roll and post-roll by clicking the buttons 
next to the pre-roll and post-roll times so that they light up.

6. Activate recording.
The project cursor “rolls back” by the time specified in the pre-roll field 
and playback starts. When the cursor reaches the left locator, recording 
is automatically activated. When the cursor reaches the right locator, re-
cording is deactivated, but playback continues for the time set in the 
post-roll field before stopping.

Using the metronome
The metronome can output a click that can be used as a 
timing reference. The two parameters that govern the tim-
ing of the metronome are tempo and time signature, as set 
on the tempo track and signature track, or in the Tempo 
Track Editor (see “Editing the tempo curve” on page 455). 
The metronome can use a either an audio click played 
back via the audio hardware, send MIDI data to a con-
nected device which will play back the click or both.

You can also set up a precount (count-in) that will be 
heard when you start recording from Stop mode. This can 
be musical or time based (see “Setting up a time-based 
count-in” on page 110). 

Channels If you activate a channel button, no MIDI messages on 
that MIDI channel will be recorded or thruput. Already re-
corded messages will, however, be played back normally.

Controller Allows you to prevent certain MIDI controller types from 
being recorded or thruput.
To filter out a controller type, select it from the list at the 
top of the Controller section and click “Add”. It will ap-
pear on the list below.
To remove a controller type from the list (allow it to be re-
corded and thruput), select it in the lower list and click 
“Remove”.

Section Description

Post-roll value field and on/off switch

Pre-roll value field and on/off switch
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• To activate the metronome click, activate the Click but-
ton on the Transport panel. 
You can also select the “Metronome On” option on the Transport menu 
or use the corresponding key command (by default [C]). 

• To activate the precount, click the Precount button on 
the Transport panel.
You can also select the “Precount On” option on the Transport menu or 
set up a key command for this.

Metronome settings

You make settings for the metronome in the Metronome 
Setup dialog, opened from the Transport menu.

In the Metronome Options section, the following options 
are available:

If “Use Musical Precount” is selected, the following pre-
count options are available:

If “Use Time-Linear Count-In” is selected, the following 
count-in options are available (see “Setting up a time-
based count-in” on page 110 for details):

Further configuration options for MIDI and audio clicks are 
available in the Click Outputs section:

Option Description

Metronome in 
Record/Play

Allows you to specify whether the metronome is heard 
during playback, recording or both (when Click is acti-
vated on the Transport panel).

Use Musical 
Precount

Activates a musical count-in that is heard when you start 
recording from Stop mode.

Use Time-
Linear Count-In

Activates a time-based count-in that is heard when you 
start recording from Stop mode.

Click on/off Precount on/off

Option Description

Precount Bars Sets the number of bars the metronome counts in before 
recording starts.

Use Project 
Count Base

If this option is activated, the metronome plays one click 
per beat according to the project count base. 

Use Count 
Base

If this option is activated, a field appears to the right where 
you specify the “rhythm” of the metronome. For example, 
setting this to “1/8”, gives you eighth notes (two clicks per 
beat). It is also possible to create unusual metronome 
rhythms such as triplets.

Use Time Sign. 
at Rec. Start 
Time

When this is activated, the precount automatically uses 
the time signature and tempo set at the position where 
recording starts.

Use Time Sign. 
at Project Time

When this is activated, the precount uses the time signa-
ture set on the tempo track. Furthermore, any tempo 
changes on the tempo track during the precount are ap-
plied.

Use Signature This lets you set a time signature for the precount. In this 
mode, tempo changes on the tempo track do not affect 
the precount.

Option Description

Count-In Clicks In this field you can set the number of clicks you hear be-
fore playback or recording starts. You can set values 
from 1 to 20.

Interval in 
seconds

Use this field to define a time interval for the clicks (from 
0.1 to 1.0 seconds). 
You can calculate the position of the first click by multi-
plying the Count-In Click value with the specified interval 
and subtracting this value from the position of the left lo-
cator.

Emphasis Use this pop-up menu to select an emphasized click. 
This is useful if you want to have an audible difference 
between the first and/or last click and the other clicks.

Option Description

Activate MIDI 
Click

Selects whether or not the metronome sounds via MIDI.

MIDI Port/
Channel

This is where you select a MIDI output and channel for the 
metronome click. 
For the metronome click you can also select a VST instru-
ment previously set up in the VST Instruments window.

Hi Note/
Velocity

Sets the MIDI note number and velocity value for the 
“high note” (the first beat in a bar). 
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Setting up a time-based count-in

In postproduction scenarios projects are rather time 
based than referencing to bars and beats. In these cases 
it is useful to set up a time-linear count-in as a timing ref-
erence for your recordings.

A typical use case would be the synchronization of voice-
overs or dubbing versions. In these scenarios you find 
yourself frequently jumping to positions from which you 
want the recording to start. By setting the locators to the 
sections you want to record and defining a time-linear 
count-in, you can quickly assign, locate and hear the de-
sired record start position in your project. 

Proceed as follows:

1. On the Transport panel, activate the metronome click, 
set up a suitable pre-roll value and activate Pre-roll.

2. Open the Transport menu and make sure that the 
“Start Record at Left Locator” option is activated.

3. On the Transport menu, select “Metronome Setup…”.
The Metronome Setup dialog opens.

4. In the Metronome Options section, make sure that the 
“Metronome in Record” option is activated.

5. Activate the “Use Time-Linear Count-In” option.
Options for the time-linear count-in are displayed in the “Count-In Op-
tions” section.

6. Set up the Count-In Options according to your needs.

7. Click OK to save your settings and close the Metro-
nome dialog.

8. Set the locators to the section you want to record.
If you want to record several sections, it is useful to set up cycle markers 
for all sections that you want to record (see “Cycle markers” on page 137).

9. Activate recording.
Your project is played back from the current project cursor position. When 
the project cursor reaches the position specified with the “Count-In 
Clicks” and “Interval in seconds” parameters, the Count-In is triggered. It 
stops when the cursor reaches the left locator and recording starts.

• You can also set the left locator to the position where 
you want recording to start, set the project cursor to a po-
sition before the left locator, activate the Punch In button on 
the Transport panel and start playback. 
The defined time-linear count-in is triggered as the project cursor moves 
towards the left locator. When it reaches the left locator, recording is au-
tomatically activated.

Lo Note/
Velocity

Sets the MIDI note number and velocity for the “low 
notes” (the other beats). 

Activate  
Audio Click

Selects whether or not the metronome sounds via the 
audio hardware.

Beeps When this is selected, the audio clicks will be beeps 
generated by the program. Adjust the pitch and level of 
the beeps for the “Hi” (first) beat and “Lo” (other) beats 
using the sliders below.

Sounds When this is selected, you can click in the “Sound” fields 
below to load any audio files for the “Hi” and “Lo” metro-
nome sounds. The sliders set the level of the click.

Option Description
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Lock and Unlock Record
During recording it can happen that you accidentally de-
activate the record mode, e. g. by pressing [Space]. In or-
der to prevent this, you can set up a key command for this 
in the Key Commands dialog. If you use the Lock Record 
key command, the Record button will turn gray and the 
record mode is locked until you use the Unlock Record 
key command or enter Stop mode.

• If Lock Record is activated and you want to enter Stop 
mode (by clicking Stop or pressing [Space]), you will see 
a dialog in which you need to confirm that you want to 
stop recording. You can also use the Unlock Record key 
command first and then enter Stop mode as usual.

• By default, no key commands are assigned to these 
functions. In the Key Commands dialog, you will find the 
corresponding key command entries in the Transport cat-
egory (see the chapter “Key commands” on page 580 for 
more information on how to set up key commands).

These key commands are especially useful when com-
bined with other commands (e. g. with Record/Stop) using 
the macro functions. That way you will receive powerful 
macros that can greatly enhance your workflow.

Note that an automatic punch-out at the right locator 
position that you may have set on the transport panel, will 
be ignored in Lock Record mode.

Record Time Max display
The Record Time Max display lets you see how much time 
you have left for recording. The available time depends on 
the current setup, for example, on the amount of tracks 
that are record-enabled, your project setup (e. g. the sam-
ple rate), and the amount of hard disk space available.

You can show and hide the display using the “Record 
Time Max” option on the Devices menu.

The remaining record time is also shown in the status 
line above the track list.

Recovery of audio recordings after 
system failure
Normally, when a computer crashes, all changes made to 
your current project since you last saved it will be lost. 
Usually, there is no quick and easy way to recover your 
work.

With Nuendo, when your system crashes while you are re-
cording (because of a power cut or other mishap), you will 
find that your recording is still available, from the moment 
when you started recording to the time when your com-
puter crashed.

When you experience a computer crash during a record-
ing, simply relaunch the system and check the project 
record folder (by default this is the Audio subfolder inside 
the project folder). It should contain the audio file you 
were recording at the time of the crash.

! If you are storing your tracks on different drives (by 
using individual record folders), the time display re-
fers to the medium with the least storage space 
available.

! This feature does not constitute an “overall” guaran-
tee by Steinberg. While the program itself was im-
proved in such a way that audio recordings can be 
recovered after a system failure, it is always possible 
that a computer crash, power cut, etc. might have 
damaged another component of the computer, mak-
ing it impossible to save or recover any of the data.

! Please do not try to actively bring about this kind of 
situation to test this feature. Although the internal 
program processes have been improved to cope 
with such situations, Steinberg cannot guarantee 
that other parts of the computer are not damaged as 
a consequence.
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Creating fades
There are two types of fade ins and fade outs in audio 
events in Nuendo: event-based fades that you create by us-
ing the fade handles (see below) and clip-based fades cre-
ated by processing (see “Clip-based fades” on page 114).

Event-based fades
Selected audio events have triangular handles in the up-
per left and right corners. These can be dragged to create 
a fade in or fade out, respectively.

Creating a fade in. The fade is automatically reflected in the shape of 
the event’s waveform, giving you a visual feedback of the result when 
dragging the fade handle. 

Fades created with the handles are not applied to the audio 
clip as such but calculated in realtime during playback. This 
means that several events referring to the same audio clip 
can have different fade curves. It also means that having a 
large number of fades may require more processing power.

• If you select multiple events and drag the fade handles 
of one of them, the same fade is applied to all selected 
events.

• A fade can be edited in the Fade dialog, as described 
on the following pages. 
You open the dialog by double-clicking in the area above the fade curve, 
or by selecting the event and selecting “Open Fade Editor(s)” from the 
Audio menu (note that this will open two dialogs if the event has both 
fade in and fade out curves). 
If you adjust the shape of the fade curve in the Fade dialog, this shape 
will be maintained when you later adjust the length of the fade.

• You can make the fade longer or shorter at any time, by 
dragging the handle.
You can do this without selecting the event first, i. e. without visible han-
dles. Just move the mouse pointer along the fade curve until the cursor 
turns into a bidirectional arrow, then click and drag.

• If the “Show Event Volume Curves Always” option is ac-
tivated in the Preferences dialog (Event Display–Audio 
page), fade curves are shown in all events, regardless of 
whether they are selected or not.
If the option is deactivated, the fade curves are shown in selected events 
only.

• If the “Thick Fade Lines” option is activated in the Pref-
erences dialog (Event Display–Audio page), the fade lines 
and volume curve are thicker, increasing their visibility.

• If the “Use Mouse Wheel for Event volume and Fades” 
option is activated in the Preferences dialog (Editing–Au-
dio page), pressing [Shift] while moving the mouse wheel 
moves the volume curve up or down. 
When you position the mouse pointer somewhere in the left half of the 
event, the fade in end point is moved. When the mouse pointer is in the 
right half of the event, the fade out start point is moved.

In the Key Commands dialog (Audio category) you can 
set up key commands for changing the event volume curve 
and any fade curves, see “Key commands” on page 580.

As an alternative to dragging the fade handles, you 
can use the “Fade In to Cursor” and “Fade Out to Cursor” 
options on the Audio menu to create fades. Position the 
project cursor on an audio event where you want a fade in 
to end or a fade out to begin, and select the appropriate 
option from the Audio menu. A fade will then be created, 
ranging from the event’s start or end to the position of the 
cursor.

Creating and adjusting fades with the Range Selection 
tool

Event-based fades can also be created and adjusted with 
the Range Selection tool:

1. Select a section of the audio event with the Range Se-
lection tool.

2. Pull down the Audio menu and select “Adjust Fades to 
Range”.
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The result depends on your selection:

• If you select a range from the beginning of the event, a fade in 
is created within the range. 

• If you select a range that reaches the end of an event, a fade 
out is created in the range. 

• If you select a range encompassing a middle section of the 
event, but not reaching neither the start nor the end, a fade in 
is created from the beginning of the event to the beginning of 
the selected range, and a fade out is created from the end of 
the selected range to the end of the event.

Applying default fades

You can also create fades by using the “Apply Standard 
Fade In” and “Apply Standard Fade Out” commands from 
the Audio menu.

1. Select one or more audio events in the Project window.

2. On the Audio menu, select “Apply Standard Fade In” 
or “Apply Standard Fade Out”.
A fade of the same length and shape as the default fade is created (see 
“As Default button” on page 115).

About the volume handle

A selected audio event also has a square handle in the top 
middle: the volume handle. It provides a quick way of 
changing the volume of an event in the Project window. 
Note that dragging the volume handle also changes the 
value on the info line.

Removing fades

To remove the fades for an event, select the event and se-
lect “Remove Fades” from the Audio menu.

If you want to remove the fades in a specific range only, 
select the fade area with the Range Selection tool and se-
lect “Remove Fades” from the Audio menu.

Clip-based fades
If you have selected an audio event or a section of an au-
dio event (using the Range Selection tool), you can apply 
a fade in or fade out to the selection by using the “Fade In” 
or “Fade Out” function on the Process submenu of the 
Audio menu. These functions open the corresponding 
Fade dialog, allowing you to specify a fade curve. Fades 
created this way are applied to the audio clip rather than 
to the event. 

Please note the following:

• If you later create new events that refer to the same clip, these 
will have the same fades.

• You can remove or modify the fades at any time using the Of-
fline Process History (see “The Offline Process History dialog” 
on page 275).

If other events refer to the same audio clip, you will be 
asked whether you want the processing to be applied to 
these events or not.

• Continue will apply the processing to all events that refer to 
the audio clip.

• New Version will create a separate, new version of the audio 
clip for the selected event.

• You can also activate the “Please, don’t ask again” op-
tion. Regardless of whether you then choose “Continue” 
or “New Version”, any further processing will conform to 
the option you select.
You can change this setting at any time in the Preferences dialog (Edit-
ing–Audio page), under “On Processing Shared Clips”.

! You can select multiple audio events on separate 
tracks with the Range Selection tool, and apply the 
fade to all of them simultaneously.

Drag the Volume handle up 
or down to change the 
volume of the event.

The volume change is displayed 
numerically in the info line.

The event waveform reflects the volume change.

! The length of the fade area is determined by your se-
lection. In other words, you specify the length of the 
fade before you open the Fade dialog. You can select 
multiple events and apply the same processing to all 
of them simultaneously.
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The Fade dialogs
The Fade dialogs appear when you edit an existing fade or 
use the Fade In/Fade Out functions on the Process sub-
menu of the Audio menu. The picture below shows the 
Fade In dialog; the Fade Out dialog has identical settings 
and features.

If you open the Fade dialog(s) with several events se-
lected, you can adjust the fade curves for all these events 
at the same time. This is useful if you want to apply the 
same type of fade in to more than one event, etc.

The available options are:

Applying a fade

Depending on whether you are editing a fade made with the 
fade handles or applying a fade using processing, different 
buttons are shown in the bottom row of the Fade dialog.

The Edit Fade dialogs have the following buttons:

The Process Fade dialogs have the following buttons:

Option Description

Curve Kind These buttons determine whether the fade curve con-
sists of spline curve segments (left button), damped 
spline segments (middle button), or linear segments 
(right button).

Fade display This shows the shape of the fade curve. The resulting 
waveform shape is shown in dark gray, with the cur-
rent waveform shape in light gray. 
Click on the curve to add points, and click and drag 
existing points to change the shape. To remove a 
point from the curve, drag it outside the display.

Curve shape 
buttons

These buttons give you quick access to some com-
mon curve shapes.

Restore button This button is only available when editing fades made 
by dragging the fade handles. Click this to cancel any 
changes you have made since opening the dialog.

Fade Length Value This parameter is only available when editing fades 
made by dragging the fade handles. It can be used to 
enter fade lengths numerically. The format of values 
displayed here is determined by the Primary Time Dis-
play in the Transport panel. 
When you activate the Apply Length option, the value 
entered in the Fade Length value field is used when 
clicking Apply or OK.  
When you set the current fade as the default fade, the 
length value is included as part of the default settings.

Presets In this section you can set up presets for fade in or 
fade out curves that you want to apply to other 
events or clips. 
To apply a stored preset, select it from the pop-up 
menu.  
To rename the selected preset, double-click on the 
name and type in a new one.  
To remove a stored preset, select it from the pop-up 
menu and click Remove.

As Default button This button is only available when editing fades made 
by dragging the fade handles. Click this to store the 
current settings as the default fade, to be used 
whenever you create new fades by dragging event 
handles. Both the shape and length will be used 
when you create fades using the “Apply Standard 
Fade…” command from the Audio menu.

Button Function

OK Applies the set fade curve to the event, and closes the 
dialog.

Cancel Closes the dialog without applying any fade.

Apply Applies the set fade curve to the event, without closing 
the dialog.

Button Function

Preview Plays back the fade area. Playback will repeat until you 
click the button again (the button is labeled “Stop” during 
playback).

Process Applies the set fade curve to the clip, and closes the 
dialog.

Cancel Closes the dialog without applying any fade.

Option Description
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Creating crossfades
Overlapping audio material on the same track can be cross-
faded, for smooth transitions or special effects. You create 
a crossfade by selecting two consecutive audio events and 
selecting the Crossfade command on the Audio menu (or 
by using the corresponding key command, by default [X]). 
The result depends on whether the two events overlap or 
not:

• If the events overlap, a crossfade is created in the over-
lapping area.
The crossfade will be of the default shape (linear, symmetric), but you 
can change this as described below.

The default crossfade length and shape are set in the 
Crossfade dialog (see “As Default button” on page 115).

• If the events do not overlap but are directly consecutive 
(lined up end-to-start, with no gap) it is still possible to 
crossfade them – provided that their respective audio 
clips overlap! In this case, the two events are resized so 
that they overlap, and a crossfade of the default length 
and shape is applied.

An example:

The events themselves do not overlap, but their clips do. Therefore, the 
events can be resized so that they overlap, which is required for a 
crossfade.

When you apply the Crossfade function, the two events are resized so 
that they overlap, and a default crossfade is created in the crossfade 
area.

• If the events do not overlap and cannot be resized 
enough to overlap, a crossfade cannot be created.

• You can specify the length of the crossfade using the 
Range Selection tool: make a selection range covering the 
desired crossfade area and use the Crossfade command 
on the Audio menu.
The crossfade is applied to the selected range (provided that the events 
or their clips overlap, as described above). 

You can also make a selection range after creating the 
crossfade and use the function “Adjust fades to Range” 
on the Audio menu.

• Once you have created a crossfade, you can edit it by 
selecting one or both crossfaded events, and selecting 
“Crossfade” from the Audio menu again (or by double-
clicking in the crossfade zone). 
This opens the Crossfade dialog, see below.

Removing crossfades
To remove a crossfade, proceed as follows:

• Select the corresponding events and select “Remove 
Fades” from the Audio menu.

• Use the Range Selection tool to select all fades and 
crossfades you wish to remove, and select “Remove 
Fades” from the Audio menu.

• Select a crossfade by clicking and drag it outside the 
track.

Crossfade area

Audio clips

Audio events
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The Crossfade dialog

This section describes the default Crossfade dialog. 
However, if you activate the “Simple Crossfade Editor” op-
tion in the Preferences dialog (Editing–Audio page), a sim-
plified dialog is used instead (similar to the regular Fade 
dialogs).

Options and settings
The Crossfade dialog consists of two sections: The wave-
forms of the audio to be crossfaded and the fade curves are 
displayed at the top. The lower half of the Crossfade dialog 
contains a number of common settings and controls, as 
well as separate (but identical) settings for the fade out 
(top) and the fade in curve (bottom) of the crossfade. The 
following options are available (from left to right):

Option Description

Nudge Range This pop-up menu lets you specify the range that 
is moved when using the Nudge buttons, see “Us-
ing the Nudge buttons” on page 119.

Nudge Mode Here, you can specify whether you want the fade 
or the audio to move when you use the Nudge but-
tons, see “Using the Nudge buttons” on page 119.

Chaining Mode This setting determines how the audio to the right 
of the crossfade on the track behaves when you 
move the crossfade for an event. Note that the be-
havior is different depending on whether the next 
audio event on the track follows seamlessly or with 
a gap:
Until End – all following events on the track are 
moved.
Until Gap – all following events on the track up to 
the next gap are moved.
None – none of the following events on the track 
are moved.

Splice Point Offset In the fade in and fade out curves you can see a 
dotted vertical line that marks the splice point. If 
you work with asymmetric crossfades, you can set 
different splice points for the fade in and the fade 
out events, i. e. a splice point offset. For further in-
formation about the splice point, see “Changing 
the overlap” on page 118.

Symmetric Fades If this is activated, the editing controls of the fade 
out and fade in curves become “linked”, so that 
both fade curves are affected by the same amount, 
regardless of whether you use the fade out or fade 
in controls. 

Length This specifies the length of the crossfade area, see 
“Resizing the crossfade area” on page 119.

Overlap This defines the position of the splice point in the 
crossfade area, see “Changing the overlap” on 
page 118.

Option Description
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Moving the crossfade area
You can move the crossfade area in the crossfade display 
by changing the overlap or the nudge parameters. This is 
described in the following sections.

Changing the overlap

The overlap value is the relation between the splice point 
(i. e. the intersection point of the two events, see the pic-
ture below) and the crossfade area. If you use the Overlap 
controls, the crossfade will be moved around the splice 
point. By default, the splice point is situated in the center 
of the crossfade area. 

A centered symmetric crossfade

Volume This changes the volume of the crossfaded events. 
This is the same as using the volume handles in 
the event display, see “About the volume handle” 
on page 114.

Nudge buttons Use the Nudge buttons to nudge the fade area or 
the audio in the desired direction, see “Using the 
Nudge buttons” on page 119.

Fade curve  
displays

These displays show the shape of the fade out and 
fade in curve, respectively. Click on a curve to add 
points, click and drag existing points to change 
their shape, or drag a point outside the display to 
remove it.

Curve buttons The curve kind buttons determine whether the cor-
responding fade curve consists of spline curve 
segments (left button), damped spline segments 
(middle button) or linear segments (right button).

The curve shape buttons give you quick access to 
some common curve shapes.

Equal Gain Activate this parameter to adjust the fade curves 
so that the summed fade in and fade out ampli-
tudes will be the same all along the crossfade 
region. This is often suitable for short crossfades.

Equal Power Activate this parameter to adjust the fade curves 
so that the energy (power) of the crossfade will be 
constant all along the crossfade region.

Play buttons These buttons allow you to audition the whole 
crossfade, or the fade out part, or the fade in part. 
You can set up key commands for this in the fol-
lowing categories of the Key Commands dialog:
Crossfade Editor category – Play Fade Out, Play 
Crossfade, Play Fade In.
Media category – Preview Start (triggers cross-
fade playback), Preview Stop (stops crossfade 
playback).
Transport category – StartStop (triggers global 
playback), Stop (stops global playback) and Start-
Stop Preview (triggers crossfade playback).
For further information, see “Key commands” on 
page 580.

Pre-roll and Post-roll Activate pre-roll to start playback before the fade 
area. Activate post-roll to stop playback after the 
fade area.  
In the time fields you can enter the desired time (in 
seconds and milliseconds) for the pre-roll and 
post-roll length.

Auto-Scroll button Activate this to scroll the crossfade display during 
playback, so that the position cursor is always visi-
ble. This only applies when using the Transport 
play controls and works like the corresponding 
function in the Project window (see “Auto-Scroll” 
on page 50).

Zoom to Fade button Click on this button to zoom and center the display 
on the currently selected crossfade area.

Option Description

Auto Zoom Activate this to zoom and center the display auto-
matically on the current crossfade when you resize 
it. This also works when you select the next cross-
fade with the “Select Crossfade” buttons (see be-
low).

Presets section Click the Store button to the right of the Presets 
pop-up menu to store the settings of your cross-
fade so that you can apply them to other events 
later. 
To rename a preset, double-click on the name and 
type in a new one.  
To remove a preset, select it on the pop-up menu 
and click the Delete button.

Default buttons Click the As Default button to store the current set-
tings as default. These settings will then be used 
whenever you create new crossfades. 
Click the Recall Default button to apply the curves 
and settings of the default crossfade to the Cross-
fade dialog.

Select Crossfade 
buttons

These buttons allow you to select the previous/
next crossfade area, provided that the current 
track contains more than one crossfade. 
If “Project selection follows” is activated, selecting 
another crossfade will automatically change the 
event selection in the Project window.

Option Description

Splice 
point
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For symmetric crossfades, the splice point for the fade out 
and the fade in is initially situated in the center of the 
crossfade. By moving the overlap sliders, you can move 
the crossfade around the splice point to determine how 
much of the fade out and how much of the fade in event 
are included. 

For asymmetric crossfades you can move the overlap slid-
ers separately to set up different overlap values for the fade 
in and fade out curves. This results in a Splice Point Offset.

Using the Nudge buttons

When you use the Nudge buttons, you can decide 
whether they move the fade area or the audio clip. To do 
this, activate either “Move Audio” or “Move Fade” in the 
Nudge Mode section. Each time you click a Nudge button 
or change the value in the nudge field, the fade area or au-
dio clip is moved in the corresponding direction by the 
amount specified on the Nudge Range pop-up menu.

• If “Symmetric Fades” is activated and the Nudge Mode is 
set to “Move Fade”, both the fade out area and the fade in 
area will be moved by the same amount. You can also move 
the fade by using the middle handle of the fade out or the 
fade in curve. 

Moving the Fade

• If “Symmetric Fades” is activated and the Nudge Mode 
is set to “Move Audio”, the Nudge buttons in the fade in 
display will move the audio event. 
You can also move the audio by clicking on the fade in event and dragging 
with the hand symbol that appears.

Moving the audio

It is not possible to move the audio of the fade out 
event.

Resizing the crossfade area

Changing the crossfade length without moving the splice 
points

You can adjust the length of the crossfade area by using 
the Length sliders, by clicking in the “Length” fields, by 
changing the value numerically and pressing [Return], or 
by moving the corresponding handles in the crossfade 
display:

Click and drag these points to change the length of the fade out or the 
fade in curve. 

• If “Symmetric Fades” is activated when you change the 
length, both the fade out and the fade in length are 
changed by the same amount.
The length change will be applied equally to both sides, without moving 
the splice points. 

! Do not mistake the Overlap parameter for the length 
of the crossfade area of the events.

! To be able to resize a crossfade, it must be possible to 
resize the corresponding event. For example, if the 
fade out event already plays its audio clip to the end, 
its end point cannot be moved any further to the right.
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• If “Symmetric Fades” is deactivated, the upper Length 
controls change the length of the fade out curve, and the 
lower controls change the length of the fade in curve.

Changing the crossfade length and moving the splice 
points

You can also adjust the length of the crossfade area by 
using the right handle of the fade out or the left handle of 
the fade in curve. This will change the length together with 
the splice points:

Click and drag these handles to change the length of the fade out or the 
fade in curve together with the splice points.

• If “Symmetric Fades” is activated, the length and splice 
points of both the fade out curve and the fade in curve are 
changed.

• If “Symmetric Fades” is deactivated, the right handle of 
the fade out curve changes the length and splice point of 
the fade out curve, and the left handle of the fade in curve 
changes the length and splice point of the fade in curve.

Auto fades and crossfades
Nuendo features an Auto Fade function that can be set 
both globally, and separately for each audio track. The 
idea behind the Auto Fade function is to create smoother 
transitions between events by applying short (1–500 ms) 
fade ins and fade outs.

Auto fades are not indicated by fade lines!

Making global Auto Fade settings
1. To make Auto Fades settings globally for a project, se-
lect “Auto Fades Settings…” from the Project menu.
This opens the Auto Fades dialog for the project.

2. Use the Length value field to specify the length of the 
Auto Fades or Crossfades (1–500 ms).

3. Use the checkboxes in the upper right corner to acti-
vate or deactivate Auto Fade In, Auto Fade Out, and Auto 
Crossfades.

4. To adjust the shapes of Auto Fade In and Auto Fade 
Out, select the Fades tab and make settings as in the reg-
ular Fade dialogs (see “The Fade dialogs” on page 115).

5. To adjust the shape of the Auto Crossfade, select the 
“Crossfades” tab and make settings as in the regular 
Crossfade dialog (see “The Crossfade dialog” on page 
117).

6. If you want to use your settings in future projects, click 
the “As Default” button.

7. Click OK to close the dialog.

! As mentioned earlier, event-based fades are calcu-
lated in realtime during playback. Therefore, the more 
audio events there are in a project, the higher the de-
mand on the processor when Auto Fades is activated. 
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Making Auto Fade settings for individual tracks
By default, all audio tracks will use the settings you have 
made in the project’s Auto Fades dialog. However, since 
Auto Fades use computing power, a better approach may 
be to turn Auto Fades off globally and activate them for in-
dividual tracks, as needed:

1. Right-click the track in the track list and select “Auto 
Fades Settings…” from the context menu (or select the 
track and click the “Auto Fades Settings” button in the In-
spector).
The Auto Fades dialog for the track opens. This is identical to the project’s 
Auto Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.
Any settings you now make are applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to project settings

If you want a track with individual Auto Fade settings to 
use the global Auto Fade settings, open the Auto Fades 
dialog for the track and activate the “Use Project Settings” 
checkbox. 

Event envelopes
An envelope is a volume curve for an audio event. It is sim-
ilar to the realtime fades, but allows you to create volume 
changes within the event, not only at the start or end. 

To create an envelope for an audio event, proceed as fol-
lows:

1. Zoom in on the event so that you can view its wave-
form properly.

2. Select the Pencil tool.
When you move the Pencil tool over an audio event, a small volume curve 
symbol is shown next to the tool.

3. To add an envelope point, click in the event with the 
Pencil tool.
An envelope curve and a curve point appear.

4. Drag the curve point to adjust the envelope shape.
The waveform image reflects the volume curve.

• You can add as many curve points as you like.

• To remove a curve point from the envelope, click on it 
and drag it outside the event.

• The envelope curve is a part of the audio event – it will 
follow when you move or copy the event.
After copying an event with an envelope, you can make independent ad-
justments to the envelopes in the original event and the copy.

It is also possible to apply an envelope to the audio 
clip using the Envelope function on the Process submenu 
of the Audio menu (see “Envelope” on page 266).

• To remove an event envelope curve from a selected 
event, open the Audio menu and select the Remove 
Volume Curve option.
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Introduction
The arranger track allows you to work with sections of 
your project in a non-linear fashion, to simplify arranging to 
the maximum extent. Instead of moving, copying and past-
ing events in the Project window to create a linear project, 
you can define how different sections are to be played 
back, like a playlist.

For this, you can define arranger events, order them in a list, 
and add repeats as desired. This offers a different and more 
pattern-oriented way of working, which complements the 
usual linear editing methods in the Project window. 

You can create several arranger chains, making it possible 
to store different versions of a song within the project 
without sacrificing the original version. When you have 
created an arranger chain that you like, you have the op-
tion of “flattening” the list, which creates a normal linear 
project based on the arranger chain.

You can also use the arranger track for live performances 
on the stage, in clubs or at parties.

Setting up the arranger track
Let’s say you have prepared a number of audio files that 
form the base of a typical pop song, with introduction, 
verse, chorus and bridge. Now you want to arrange these 
files.

The first step is to create an arranger track. On the ar-
ranger track, you define specific sections of the project by 
creating arranger events. These can be of any length, may 
overlap and are not bound to the start or end of existing 
events and parts. Proceed as follows:

1. Open the project for which you want to create ar-
ranger events.

2. Open the Project menu and select Arranger from the 
Add Track submenu (or right-click the track list and select 
the corresponding option from the context menu).
An arranger track is added. There can be only one arranger track in a 
project, but you can set up more than one arranger chain for this track, 
see “Managing arranger chains” on page 125.

3. On the Project window toolbar, make sure that Snap 
is activated and that the Snap Type is set to a mode that 
allows your arranger events to snap to appropriate posi-
tions in the project.

Snap to events is activated, i. e. when drawing in the Project window, 
new events will snap to existing events.

4. On the arranger track, use the Pencil tool to draw an 
event of the desired length.
An arranger event is added, called “A” by default. Any following events 
will be named in alphabetical order. 

• You can rename an arranger event by selecting it and 
changing its name in the Project window info line or by 
holding down [Alt]/[Option], double-clicking on the name 
in the arranger chain (see below) and entering a new 
name.
You may want to name your arranger events according to the structure of 
your project, e. g. Verse, Chorus, etc.

5. Create as many events as you need for your project.

When arranger events have been created, the music sequence is 
determined by the arranger events.

Events can be moved, resized and deleted using the stan-
dard techniques. Please note:

• If you want to change the length of an event, select the 
Arrow tool and click and drag the lower corners of the 
event in the desired direction.

• If you copy an arranger event (by [Alt]/[Option]-drag-
ging or by using copy/paste), a new event will be created 
with the same name as the original.
However, this new event will be totally independent from the original 
event.

• Double-clicking on an arranger event adds it to the cur-
rent arranger chain.
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Working with arranger events
You now have a number of arranger events that form the 
basic building blocks for your arrangement. The next step 
is to arrange these events using the functions of the Ar-
ranger Editor.

Creating an arranger chain
You can set up an arranger chain in the Arranger Editor or 
in the Inspector for the arranger track. The Arranger Editor 
is opened by clicking the “e” button in the Inspector or in 
the track list. 

On the right in the Arranger Editor, the available arranger 
events are listed, in the order they appear on the time line. 
To the left you find the actual arranger chain, which shows 
in which order the events will be played back, from top to 
bottom, and how many times they are repeated.

Initially the arranger chain is empty – you set it up by add-
ing events from the list to the chain. There are several 
ways to add events to the arranger chain:

• By double-clicking on the name of an event in the win-
dow section on the right (or in the Project window).
When an event is selected in the arranger chain on the left, this will add 
the event above the selected event. When no events are selected in the 
arranger chain, the event will be added at the end of the list.

• By selecting one or more events in the list, right-clicking 
and selecting “Append Selected In Arranger Chain”.
This will add the selected events at the end of the list.

• By dragging and dropping arranger events from the list 
on the right to the arranger chain on the left.
A blue insertion line shows you where the dragged event will end up.

An event is dragged into the arranger chain.

• By dragging arranger events from the Project window 
into the arranger chain.

If you followed our example, you should now have arranger 
events arranged in a very basic pop song pattern. How-
ever, we have used audio files that are only a few bars 
long – to turn our pattern into a “song” (or at least into a 
basic sketch of the song structure), these files must be 
looped. This is where the Repeats function comes in.

If you want an event to repeat several times, proceed as 
follows:

• Click in the Repeats field for an event, type in the de-
sired number of repeats and press [Enter].
When playing back the arranger chain, the Counter column indicates 
which repeat of this event is currently playing.

• Click in the Mode field for an event and select the de-
sired repeat mode.

Click the “e” 
button…

…to open the Arranger Editor.

Option Button Description

Normal In this mode, the arranger chain will be played back 
as you set it up.

Repeat 
forever

In this mode, the current arranger event will be re-
peated in a loop until you either click on another 
event in the Arranger Editor or press play once 
again.

Pause af-
ter Re-
peats

In this mode, the playback of the arranger chain will 
be stopped after having played back all repeats of 
the current arranger event.
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When you now play back the arranger chain, you will hear 
the complete arrangement. Proceed as follows:

1. Make sure that Arranger mode is activated.
In Arranger mode the project will be played back using the arranger set-
tings.

2. Position the Arranger Editor window so that you can 
see the arranger track in the Project window, and click in 
the arrow column for the event at the top of the list.
You will see the project cursor jump to the beginning of the first event 
specified in the arranger chain.

3. Activate playback, either from the Arranger Editor or 
on the Transport panel.
The events are played back in the specified order.

Editing the arranger chain
In the arranger chain on the left, you can do the following:

• Select multiple events by [Ctrl]/[Command]-clicking or 
[Shift]-clicking as usual.

• Drag events to move them in the list.

• Drag events holding [Alt]/[Option] to create copies of 
the selected items.
The insert location for both move and copy operations is indicated by a 
colored insertion line. A blue line indicates that the move or copy is pos-
sible; a red line indicates that moving or copying events to the current 
position is not allowed.

• Use the Repeats column to specify how many times 
each event is to be repeated.

• Click the arrow to the left of an event in the arranger 
chain to move the playback position to the start of that 
event.

• To remove an event from the list, right-click on it and se-
lect “Remove Touched” from the context menu. To remove 
several events, select them, right-click and select “Remove 
Selected”.

Navigating
To navigate between arranger events, you use the ar-
ranger transport buttons:

These controls are available in the Arranger Editor, on the 
Project window toolbar, and on the Transport panel.

In the Arranger Editor, the event that is currently played 
back is indicated by an arrow in the leftmost column, and 
the indicators in the Counter column.

Managing arranger chains
You can create several arranger chains. This way, you can 
create alternative versions for playback. In the Arranger 
Editor, the toolbar buttons on the right are used for this:

• In the Inspector, these functions are accessed from the 
Arranger pop-up menu (opened by clicking on the Ar-
ranger name field).

The arranger chains you create will be listed on the Name 
pop-up menu, found in the Arranger Editor to the left of 
the buttons, at the top of the arranger track Inspector, and 
in the track list. Please note that to be able to select an-
other arranger chain from the pop-up menu, the Arranger 
mode must be activated.

Button Description

Click this to rename the current arranger chain.

Creates a new, empty arranger chain.

Creates a duplicate of the current arranger chain, containing 
the same events.

Removes the currently selected arranger chain. Only avail-
able if you have created more than one arranger chain.

First repeat of current chain stepPrevious chain step

Next chain step Last repeat of current chain step
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Flattening the arranger chain
When you have found an arranger chain that suits your 
purposes, you can “flatten” it, i. e. convert the list into a lin-
ear project. Proceed as follows:

1. Click the Flatten button (or select Flatten Chain from 
the pop-up menu in the Inspector for the arranger track).
The events and parts in the project are reordered, repeated, resized, 
moved and/or deleted (if these are not within the boundaries of any used 
arranger event), so that they correspond exactly to the arranger chain.

The Flatten button

2. Activate Playback.
The project will now play back exactly as in Arranger mode, but you can 
view it and work with it as usual.

Flattening options
Sometimes it might be useful to keep the original arranger 
events even after flattening the arranger track. By using 
flattening options you can define which chain is flattened, 
where it is stored and how it is named together with other 
options.

1. Click the Flattening options button.

2. In the window that opens, select the desired options.

In the Source section you can specify which arranger 
chains are flattened. The available options are:

The Destination section allows you to choose where the 
result of the flattening is saved. The available options are:

In the Options section you can make further settings. The 
available options are:

! Flattening the arranger chain may remove events and 
parts from the project. Only use the Flatten function 
when you know you do not want to edit the arranger 
track/chain any more. If in doubt, save a copy of the 
project before flattening the arranger chain.

Option Description

Current Chain If you activate this option, only the current chain will be 
flattened.

Checked 
Chains…

If you activate this option, you can select the arranger 
chains you want to flatten in the list to the left.

All Chains If you activate this option, all arranger chains of the 
current project will be flattened.

Option Description

Current 
Project

This is only available if you have selected “Current Chain” as 
Source. If you activate this option, the result of the flattening 
of the current chain will be saved in the current project.

New  
Project

If you activate this option, you can flatten one or several 
chains in a new project. In this case it might be useful to use 
naming options. If you activate “Append Chain Name”, the 
Chain Names will be appended in brackets to the project 
name. If you activate “Use Chain Name”, the new projects 
will have the name of the current arranger chains. If you acti-
vate “Add Number”, the new projects will be named like the 
old ones and a number will be appended in brackets.

Option Description

Keep Arranger 
Track

If you activate this option, the arranger track will be kept 
when flattening the arranger chain. Activate “Rename 
Arranger Events” to append a number to the events, ac-
cording to their use. For example, if you use arranger 
event “A” two times, the first occurrence will be renamed 
“A 1” and the second “A 2”.

Make Real 
Event Copies

Normally, you will get shared copies when flattening the 
arranger track. If you activate this option, real copies will 
be created instead.

Don’t Split 
Events

If this option is activated, MIDI notes that start before or 
are longer than the arranger event will not be included. 
Only MIDI notes that begin and end inside the arranger 
event boundaries will be taken into account.

Open New 
Projects

If you activate this option, a new project will be created 
for every flattened arranger chain. If you activate the 
“Cascade New Projects” option the opened projects will 
be cascaded.
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3. You can now flatten the arranger track by clicking the 
Flatten button.
If you realize that you want to do further arrangements, you can click the 
“Go Back” button and make your adjustments. Your Flattening settings 
will be kept.

4. Click the “Go Back” button to go back to the Arranger 
Editor or close the window by clicking its Close button.

Live mode
If you have set up an arranger track and play it back, you 
have also the possibility to influence the playback order 
“live”. Note that the Arranger mode has to be activated to 
be able to use the Live mode. 

1. Set up an arranger chain in the Inspector or in the Ar-
ranger Editor for an arranger track, activate the Arranger 
mode and play back your project.
Now you can use your arranger events listed in the lower section of the 
Inspector to play back your project in Live mode.

2. Switch into Live mode by clicking on the little arrow in 
the lower list of the Inspector to the left of the arranger 
event you want to trigger.
The arranger event will be looped endlessly, until you click on another ar-
ranger event. This might be useful, for example, if you want to loop a gui-
tar solo with a flexible length.

In the Jump Mode pop-up menu, you can define how long 
the active arranger event will be played, before jumping to 
the next one. The following options are available:

• You can stop Live mode by clicking the Stop button or 
go back to “normal” playback in Arranger mode by clicking 
on any arranger event in the upper list.
In the latter case, playback will be continued from the arranger event 
where you clicked. 

Arranging your music to video
The relative time of your arranger track can be taken as a 
reference instead of the project time. This is useful, if you 
want to use the arranger track to compose music for video 
and fill a specific video section with music, by repeating 
the corresponding number of arranger events. 

If you position your external sync master device to a posi-
tion that does not match the Project Start time, Nuendo 
will jump automatically to the right position in the arranger 
track and will start playback from there, i. e. the correct rel-
ative position and not the absolute project time will be 
found. The reference for the external timecode can be 
MIDI or any other timecode that can be interpreted/read 
by Nuendo. 

Option Description

None Jumps to the next section immediately.

4 bars, 
2 bars

When one of these modes is selected, a grid of 4 or 2 bars (de-
pending on the setting) will be placed on the active arranger 
event. Whenever the respective grid line is reached, playback 
will jump to the next arranger event. An example:
Let’s say you have an arranger event which is 8 bars long and 
the grid is set to 4 bars. When the cursor is anywhere within the 
first 4 bars of the arranger event when you hit the next arranger 
event, playback will jump to the next event when the end of the 
fourth bar of the arranger event is reached. When the cursor is 
anywhere within the last 4 bars of the arranger event, playback 
will jump to the next event at the end of the event.
When an event is shorter than 4 (or 2) bars and this mode is se-
lected, playback will jump to the next section at the event end.

1 bar Jumps to the next section at the next bar line.

1 beat Jumps to the next section at the next beat.

End Plays the current section to the end, then jumps to the next sec-
tion.
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An example:

1. Set up a project with a MIDI track and three MIDI 
parts. The first part should start at position 00:00:00:00 
and end at position 00:01:00:00, the second should start 
at position 00:01:00:00 and end at position 00:02:00:00 
and the third should start at position 00:02:00:00 and end 
at position 00:03:00:00.

2. Activate the Sync button on the Transport panel.

3. Add an arranger track and create arranger events that 
match the MIDI parts.

4. Set up the arranger chain “A-A-B-B-C-C”, activate 
the Arranger mode and play back your project.

5. Start external timecode at position 00:00:10:00 
(within the range of “A”).
In your project, the position 00:00:10:00 will be located and you will hear 
“A” playing. Nothing special!

Now, let’s see what happens if your external sync master 
device starts at a position that does not match the Project 
Start time:

6. Start at 00:01:10:00 (within the range of what origi-
nally was “B”).
In your project, the position 00:01:10:00 will be located and you will hear 
“A” playing, because it plays twice in the arranger track.

7. Start external timecode at position 00:02:10:00 
(within the range of what originally was “C”).
In your project, the position 00:02:10:00 will be located and you will hear 
“B” playing, because it plays “later” in the arranger track.

If the Arranger mode is not activated or no arranger 
track exists, Nuendo will work as usual. 
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Introduction
Nuendo offers transpose functions for audio, MIDI and in-
strument parts and for audio events. These allow you to 
create variations of your music or change the harmonics of 
an entire project or separate sections. 

Transpose can be applied on three levels:

• To the entire project
By changing the project Root Key in the Project window toolbar, the 
whole project will be transposed (see “Transposing an entire project with 
the root key” on page 130). 

• To sections of the project
By creating transpose events on the transpose track, you can set trans-
pose values for separate sections of your project (see “Transposing sep-
arate sections of a project using transpose events” on page 132).

• To individual parts or events
By selecting individual parts or events and changing their transpose value 
in the info line, you can transpose individual parts or events (see “Trans-
posing individual parts or events using the info line” on page 133).

Apart from the transpose features described in this chapter, 
you can also transpose all MIDI notes on the selected track 
using the MIDI modifiers (see “Transpose” on page 374), 
selected notes using the Transpose dialog (see “Trans-
pose” on page 396), and MIDI tracks using MIDI effects 
(see the separate PDF document “Plug-in Reference”).

Transposing your music
In the following sections we will describe the different 
possibilities of transposing your music. Note that these 
can also be combined. However, we recommend you to 
set the root key first, before recording or changing trans-
pose values on the transpose track. 

Transposing an entire project with the root key
The root key you specify for a project will be the reference 
that audio or MIDI events in your project will follow. You 
can however exclude separate parts or events from being 
transposed, e. g. drums or percussion (see “The Global 
Transpose setting” on page 133). 

Depending on whether you are using events which already 
contain root key information or not, the procedures differ 
slightly.

If the events already contain root key information

Let’s say you want to create a project based on loops. 
Proceed as follows:

1. Open the MediaBay and drag some loops into an 
empty project, see “Inserting the files into the project” on 
page 341.
For this example, import audio loops with different root keys.

2. Open the Root Key pop-up menu in the Project win-
dow toolbar and set the project root key.
If the Root Key pop-up menu is not visible, right-click the toolbar and se-
lect the “Project Root Key” option from the context menu. By default, no 
project root key is specified (“-”).

! The transpose functions do not change the actual 
MIDI notes or the audio, but only affect the playback. 

! As a general rule, always set the root key first when 
you work with content with a defined root key.
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The entire project will be played back with this root key. To 
do so, the separate loops are transposed to match the 
project root key. For example, if you have imported a bass 
loop in C and the project root key is set to E, the bass loop 
will be transposed up by 4 semitones.

3. With the root key set, record some audio or MIDI.
The recorded events will get the project root key.

4. When you are done, you can change the project root 
key and your events will follow.

If the events do not contain root key information

Let’s say you have created a project by recording audio 
and importing some MIDI loops, and you want to match 
the root key of the whole project to the register of a certain 
singer.

Proceed as follows:

1. Open the Project menu and select “Transpose” from 
the Add Track submenu (or right-click the track list select 
the corresponding option from the context menu). 
A transpose track is created. You can only have one transpose track in a 
project.

2. Set the project to the desired root key by selecting the 
corresponding option from the Root Key pop-up menu in 
the Project window toolbar.

3. Right-click the transpose track in the track list and se-
lect “Set root key for unassigned events” from the context 
menu.
This sets the project root key for all parts or events not containing any 
root key information. This option is only available, if a project root key has 
been set.

Recording with a project root key

Let’s say that you want to record a guitar line for a project 
that is in D# minor, but your guitar player prefers to play in 
A minor. In this case, change the project root key to A, so 
that you can record your guitar. Proceed as follows:

1. Open your project and set the project root key to A.
All parts and events will be transposed in order to match the root key.

2. Listen to your project and verify that no drums and 
percussions have been transposed. 
If drums have been transposed, select them and set their Global Trans-
pose setting to “Independent”.

3. Record your guitar line as desired.

4. When you are done and satisfied with the result, you 
can change the project root key back to D# minor and 
your events will follow.

! If you work with drums or percussion, exclude these 
from being transposed by setting the “Global Trans-
pose” setting on the info line to “Independent” (see 
“The Global Transpose setting” on page 133).

! If you work with drums or percussion, exclude these 
from being transposed by setting the “Global Trans-
pose” setting on the info line to “Independent” (see 
“The Global Transpose setting” on page 133).

! For recorded audio events and MIDI parts, the “Glo-
bal Transpose” setting on the info line is automati-
cally set to “Follow”, i. e. the events or parts will get 
the project root key.
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Changing the root key of single events or parts

If you want to check if an audio event or part has root key 
information or if you want to change it, proceed as follows:

1. Open the Pool and display the Key column by activat-
ing the Root Key option on the View/Attributes pop-up 
menu.

2. Click in the Key column for the desired audio event 
and set the root key according to your needs.
You can also check and assign root keys in the MediaBay.

If you change the root key of an audio part or event, 
the corresponding audio file will not change. To save the 
root key in the audio file, you have to use the “Bounce Se-
lection” function on the Audio menu. 

To check or change the root key setting of a MIDI part, 
proceed as follows:

1. Select your MIDI part in the Project window and check 
the Project window info line.

A MIDI part with the root key set to “D”

2. Click on the root key value in the info line to open the 
corresponding pop-up menu and select the desired root 
key.

Transposing separate sections of a project 
using transpose events
Sometimes you may want to transpose only certain sec-
tions of your project, e. g. to create harmonic variations. 
This can be done by creating transpose events. Trans-
pose events allow you to add a relative transpose offset by 
specifying transpose values in semitones. For example, 

you can brighten up your loops in C major by transposing 
them by 5 semitones, so that the subdominant on F major 
is played back, or you can turn your hit more interesting by 
transposing the last chorus one semitone upwards.

1. Open the Project menu and select “Transpose” from 
the Add Track submenu (or right-click the track list select 
the corresponding option from the context menu). 
A transpose track is created. You can only have one transpose track in a 
project.

2. Select the Pencil tool and click in the transpose track 
to create a transpose event. 
A transpose event will be created from the point where you clicked until 
the end of the project.

3. To create another transpose event, click with the Pen-
cil tool on the first transpose event.
By default, the transpose value of new transpose events is set to 0.

You can add more transpose events by clicking with the pencil tool. 

4. Click in the transpose value field and enter the trans-
pose value for the transpose event.
You can enter the desired value with the computer keyboard, use the 
mouse wheel or [Alt]/[Option]-click on the transpose value to open a 
value fader. You can specify values between -24 and 24 semitones. 

5. Play back your project.
The parts of your project on the same position as the transpose events 
will be transposed according to the specified transpose values.

You can also transpose the whole project using the 
transpose track. This is useful if your singer does not 
reach a certain pitch, for example. You could then trans-
pose the whole project by approx. -2 semitones. Always 
remember to verify that the “Global Transpose” setting for 
drums and percussion is set to “Independent” on the info 
line (see “The Global Transpose setting” on page 133).

You can erase and move transpose events, but you can-
not mute, cut or glue them. The “Locators to Selection” 
option does not apply on transpose events. 

! If you change the project root key after setting the 
event root key, the events will keep their own root key 
settings, and will be transposed to match the project 
root key. If you record an audio or a MIDI part and the 
project root key is specified, this root key is automat-
ically set.
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Transposing individual parts or events using 
the info line
You can also transpose individual audio and MIDI parts 
and events via the info line (or the Inspector). This trans-
position will be added to the global transposition (i. e. the 
root key or the transpose events). Proceed as follows:

1. Select the event that you want to transpose.

2. In the Project window info line, adjust the Transpose 
value as desired.

A global transpose change will not overwrite individual 
part or event transpose, but will be added to the trans-
pose value for the part or event. In this case, it might be 
useful to keep the transposition within the octave range 
(see “Keep Transpose in Octave Range” on page 134).

Other functions

Indicate Transpositions
When you transpose your music, you may sometimes 
want to visually compare the original sounds and the 
transposed music. For MIDI parts, you can check this by 
opening the Key Editor and clicking the “Indicate Transpo-
sitions” button. This will help you see how your MIDI notes 
will be transposed. If the button is activated, the Key Edi-
tor will show the note pitch you will hear, if it is deacti-
vated, the Key Editor shows the original pitch of the notes 
in your MIDI part. By default, the “Indicate Transpositions” 
button is deactivated.

A MIDI part as originally recorded

When you activate “Indicate Transpositions” you will see how your MIDI 
part will be transposed. 

The Global Transpose setting
If you are working with drum and percussion loops or spe-
cial effects (FX) loops, you will want to exclude these from 
being transposed. This can be achieved by locking them 
using the Global Transpose setting. Proceed as follows:

1. Open your project.

2. Select the desired event or part and set the “Global 
Transpose” setting on the info line to “Independent”.
A symbol will be displayed in the lower right corner of the selected part 
or event, indicating that it will not be transposed neither by changing the 
root key nor by specifying transpose events. 

If Global Transpose is set to Independent, the selected part will not be 
transposed.

3. You can now change the project root key.
The “Independent” parts or events will not be affected by the root key 
changes.

If you import ready-made parts or events that are 
tagged drums or FX, Global Transpose will be automati-
cally set to Independent.
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If you record audio or MIDI, Global Transpose will be set to 
“Independent”, provided that the transpose track exists and 
you have specified at least one transpose event (even when 
the transpose value is not defined). In this case, your re-
cording will sound exactly the way you played it. The trans-
pose events will not be taken into account during recording 
and the recorded event will not get the project root key. 

Have a look at the following example:

1. Set up a project with the root key in C.

2. Add a transpose track and enter transpose events 
with the values 0, 5, 7 and 0.

3. Record some chords with your MIDI keyboard. For our 
example, record C, F, G and C.

The transpose events are not taken into account and the 
result of your recording will be C, F, G and C. No root key 
will be set.

Recorded events are independent from Global Trans-
pose.

If no transpose track exists or if no transpose event has 
been added, Global Transpose will be set to Follow.

If Global Transpose is set to Follow, the selected part will 
follow all global transpositions.

Locking the transpose track
If you want to prevent your transpose events from being 
changed by mistake, activate the Lock button on the 
transpose track. This way, you will not be able to move 
your transpose events or change their transpose values.

Muting transpose events
Sometimes it might be useful to disable the transpose 
track, e. g. to hear the original sound of individual tracks. If 
you activate the mute button on the transpose track, your 
transpose events will not be taken into account during 
playback.

Keep Transpose in Octave Range
The “Keep Transpose in Octave Range” button on the 
transpose track (the button with an up and down arrow in 
brackets) keeps the transposition in the octave range. This 
option is activated by default. This way, nothing will be 
transposed by more than seven semitones. This ensures 
that your music never sounds unnatural because the pitch 
was raised too high or too low. 

To understand the principle behind this, follow the exam-
ple below:

1. Create a MIDI part, enter a C major chord, open the 
Key Editor and activate “Indicate Transpositions”.
This way you can observe and understand what happens when you 
change the transposition.

2. Add a transpose track and create a transpose event.
By default, the transpose value is set to 0.
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3. Make sure that the “Keep Transpose in Octave 
Range” button is activated on the transpose track and 
change the transpose value of the transpose event to 7.
Your chord will be transposed accordingly.

If you enter a transpose value of 7, your chord will be transposed by 
seven semitones upwards. In this example, this would be G3/B3/D4.

4. Set the transpose value to 8 semitones.
As “Keep Transpose in Octave Range” is activated, your chord will now 
be transposed to the nearest interval or pitch. 

Your chord has been transposed to the nearest pitch, this results in 
G#2/C3/D#3.

! If you mainly work with audio loops, we recommend 
activating “Keep Transpose in Octave Range”. 
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Introduction
Markers are used to locate certain positions quickly. If you 
often find yourself jumping to a specific position within a 
project, you should insert a marker at this position. You can 
also use markers to make range selections (see “Using 
markers to make range selections in the Project window” 
on page 143) or for zooming (see “Zooming to cycle mark-
ers” on page 137).

Markers are located on marker tracks. For postproduction 
purposes, you can set up multiple marker tracks. This is 
useful for viewing and working with Edit Decision Lists 
(see “Importing EDL CMX3600 files (Edit Decision Lists)” 
on page 146) and CSV files (see “Exporting markers as 
CSV files” on page 148). 

There are two types of markers: position markers and cy-
cle markers.

Position markers
As the name implies, position markers allow you to store a 
specific position. Position markers on the marker track are 
shown as marker events: vertical lines with the marker de-
scription (if assigned) and number beside it. If you select a 
marker track, all its markers are shown in the Inspector. 

Cycle markers
By creating cycle markers you can store any number of left 
and right locator positions as start and end positions of a 
range and recall them by double-clicking on the corre-
sponding marker. Cycle markers are shown on marker 
tracks as two markers bridged by a horizontal line. Cycle 
markers are ideal for storing sections of a project. By de-
fining cycle markers for sections of a song, e. g. “Intro”, 
“Verse”, and “Chorus”, you can quickly navigate to the 
song sections and repeat the section by activating the Cy-
cle button on the Transport panel. 

Using cycle markers

Cycle markers represent ranges in your project. Therefore 
you can use them for moving the left and right locators:

• If you double-click on a cycle marker or select it from 
the Cycle pop-up menu in the track list, the left and right 
locators are moved to encompass the cycle marker.
Now you can move the project cursor position to the start or the end of 
the cycle marker by moving it to the corresponding locator (e.g. by using 
the keys [1] and [2] on the numeric pad).

You can also use cycle markers to export specific 
ranges of your project with the Export Audio Mixdown 
dialog (see “Mixing down to audio files” on page 474). 

Editing cycle markers using tools

Cycle markers can be edited on marker tracks using the 
following tools (Snap is taken into account):

Zooming to cycle markers

• When you select a cycle marker on the Zoom pop-up 
menu, the event display is zoomed in to show the selected 
range only (see the section “Zoom presets and cycle 
markers” on page 60).
Note that only the cycle markers of the active marker track are shown on 
the Zoom pop-up menu.

• You can also zoom in by pressing [Alt]/[Option] and 
double-clicking on the cycle marker in the event display.

Tool Use

Arrow tool Drag the start or end handle of a cycle marker with the 
Arrow tool to change its start or end position, or drag the 
upper border to move the whole cycle marker. 
Double-click on a cycle marker to set the left and right lo-
cators.

Selection  
Range

Double-click on a cycle marker – this creates a selection 
range spanning all tracks in the project. You can also se-
lect a range inside the cycle marker and press [Ctrl]/
[Command]-[X] to trim or to divide a cycle marker.

Pencil Press [Ctrl]/[Command] and use the Pencil tool to create 
new cycle markers.

Eraser Click with the Eraser tool to delete a cycle marker. If you 
hold down [Alt]/[Option] when you click, all consecutive 
markers are also be deleted.
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The Marker window

In the Marker window you can view and edit markers. The 
markers on the active marker track are displayed in the 
marker list in the order in which they occur in the project. 

To open the Marker window, you have the following possi-
bilities:

• Open the Project menu and select “Markers”.
• Click the Show button in the marker section on the Transport 

panel.
• Use the key command (by default [Ctrl]/[Command]-[M]).

The Track and Type pop-up menus

• By selecting an entry from the Track pop-up menu, you 
select which of the marker tracks is activated. (For further 
information about the active marker track, see “The active 
marker track” on page 143.) 
You can also activate a marker track by clicking on the corresponding 
button in the track list. The marker list in the Marker window will be up-
dated automatically.

• By selecting an entry from the Type pop-up menu, you 
select which markers (position markers, cycle markers, or 
all) are shown in the marker list.

Adding, moving, and removing markers 

• To select a marker, click on it in the Marker window. 

• To edit a selected marker, click on it. 
Select multiple markers by [Shift]-clicking or [Ctrl]/[Command]-clicking 
them.

• To add a position marker, open the Functions pop-up 
menu and select the “Insert Marker” option. 
A position marker is added at the current project cursor position on the ac-
tive marker track. You can also use key commands for this, see “Marker key 
commands” on page 145. 

• To add a cycle marker, open the Functions pop-up 
menu and select the “Insert Cycle Marker” option.
This adds a cycle marker between the left and right locators on the active 
marker track. 

• To move one or more markers to a specific position, set 
the project cursor to the desired position, select the mark-
ers, and select the “Move Markers to Cursor” option from 
the Functions pop-up menu.
You can also move markers by entering the new position numerically in 
the Position column. If a cycle marker is selected, the Move operation af-
fects the cycle marker start position. 

• To move one or several markers to another marker track, 
select them in the current Marker window, open the Func-
tions pop-up menu and from the “Move Markers to Track” 
submenu select the desired track.
The markers are no longer listed in the Marker window of the first marker 
track. 

• To remove a marker, select it and select the “Remove 
Marker” option from the Functions pop-up menu.

Auto-Scroll with Project Cursor

This option helps you to keep track of the locate arrow, 
even if your project contains a large number of markers. 
When this option is activated, the window is automatically 
scrolled to keep the Locate arrow visible.

Set up Attribute Columns
Locate 
arrow Reset Filters

Auto-Scroll with 
Project Cursor

Set up Attribute Columns for Details
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Navigating in the marker list

You can navigate in the marker list using your computer 
keyboard and select entries by pressing [Enter]. This is a 
quick and easy way to jump to markers during playback or 
recording:

• To move to the previous/next marker in the list, press 
[Up Arrow]/[Down Arrow]. 

• To jump to the first/last marker, press [PageUp]/[Page-
Down]. 

• To step through the attributes of a marker, select a 
marker, then click again and press [Tab].
You can step back by pressing [Shift]-[Tab]. 

When working with video, you can use the Marker win-
dow as a spotting list (a list of timecode values) to position 
your audio events according to the video events, see “Us-
ing the Marker window as a spotting list” on page 543.

Marker attributes
The following sections describe how to set up and edit 
standard attributes and user attributes for markers in the 
Marker window and how to display them in the Details 
section.

Displaying attributes 

By default, the following standard marker attributes are 
shown in the marker list of the Marker window: 

You can show other attributes by clicking the “Set up At-
tribute Columns” button and selecting the desired at-
tributes from the pop-up menu. In this menu the most 
common attributes for postproduction are listed in cate-
gories according to their usage: General, ADR, Dialog 
Spotting, Foley, SFX, Background, and User Defined (if 
available). The standard attributes are found in the Stan-
dard Attributes category. 

The number in brackets following the category name 
helps to get a quick overview of how many attributes of a 
certain category are displayed as columns in the Marker 
window.

To configure which attributes and columns are shown, you 
can also use the following functions of the “Set up At-
tribute Columns” pop-up menu: 

• To show all attributes in the Marker window, activate the 
“Show all” option. 
Selecting “Hide all” will hide all attributes except for the Locate and Po-
sition columns.

• To show only the columns that are used for at least one 
marker, activate the “Show only used Attributes” option.

• If you activate the Row Count option on the “Set up At-
tribute Columns” pop-up menu, the rows of the marker list 
are numbered consecutively. 
This can be useful when using filters for certain attributes, see “Filtering 
attributes” on page 140.

Editing attributes

There are three different types of attributes: Text, Number, 
and Yes/No switch. Depending on the type, you can enter 
text or numerical values, or activate/deactivate the corre-
sponding checkbox.

• To edit a marker attribute, select the corresponding 
marker, click in the desired attribute column, and make 
your settings.

• To change the attributes of several markers, select the 
markers and click the checkbox for the desired attribute. 
All selected markers will change their attributes accordingly. Note that 
this does not work when clicking on a timecode value or a text field.

To navigate in the list of marker attributes, you can also 
use the [Tab] key and the arrow keys.

Column Description

Locate (left-
most column)

An arrow indicates which marker is at the project cursor 
position (or closest to the project cursor). If you click in 
this column, the project cursor is moved to the corre-
sponding marker position. This column cannot be hidden.

ID This column shows the marker ID numbers, see “About 
marker IDs” on page 141.

Position In this column you can view and edit the markers’ time 
positions (or start positions for cycle markers). This col-
umn cannot be hidden.

End In this column you can view and edit the end positions of 
cycle markers, see “Cycle markers” on page 137.

Length In this column you can view and edit the length of cycle 
markers, see “Cycle markers” on page 137.

Description Here you can enter names or descriptions for markers.
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Setting up user attributes

To set up your own attributes, proceed as follows: 

1. Click the “Set up Attribute Columns” button and se-
lect “Define User Attributes…”.

2. In the User Attributes dialog, click the Add User At-
tribute (+) button.
A new attribute is added to the attributes list.

3. Enter a name for the new attribute and define its type.
Attributes can be of the types “Text”, “Number”, or “Yes/No” switch.

• Click the “Store as Defaults” button in the dialog to 
save your user attributes as default. 
New projects will contain these attributes in the User Defined category 
of the “Set up Attribute Columns” pop-up menu. 

4. Click OK.
The new attribute is added to the list of available attributes and can be 
displayed in the Marker window.

• To remove a user attribute, select it in the list and click 
the Remove User Attribute (-) button.
The attribute is removed from the list and the pop-up menu.

• To restore your previously saved user attributes, click 
the “Restore Defaults” button.
Note that this will remove any attributes not saved as defaults. 

Sorting and reordering columns

You can customize the display of the marker attributes in 
the marker list by sorting or reordering the columns. Pro-
ceed as follows:

• To sort the marker list by a specific attribute (except 
Row Count), click on the corresponding column header.

• To reorder the marker attributes, drag and drop the cor-
responding column headers.

• To adjust the width of a column, place the mouse pointer 
between two column headers and drag left or right.
The pointer changes to a divider when you place it between two column 
headers.

No matter by which attribute you sort, the second sort 
criterion will always be the position attribute.

Filtering attributes

When you are working with many markers so that the list 
is very long, you may want to filter the list to show only 
markers with a certain attribute value, such as the name of 
a character. Proceed as follows:

1. Right-click on the column header of the attribute that 
you want to use for the filter.
A context menu appears.

2. From the “Filter <Attribute Title>” submenu, select the 
desired attribute value.
The marker list is filtered according to your settings, and the column 
header changes color to indicate that a filter is applied.

• To remove the filter, right-click the column header and 
select the “Reset <Attribute Title> Filter” option from the 
context menu.

• To remove all filters for all columns, click the “Reset Fil-
ters” button.
The filters are also reset if you change the displayed marker track or hide 
a filtered attribute. Filter settings are not saved in the project or defaults.
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Using the Details view

The Details view is displayed below the regular marker list. 
It shows the details for the marker that is selected in the 
marker list. If more than one marker is selected, only the 
details for the first marker of the selection are shown.

1. To open the Details view, click the “Show Details 
View” button.
The “Set up Attribute Columns for Details” button appears next to the 
“Set up Attribute Columns button”. 

2. Click the “Set up Attributes Columns for Details” button 
and select the desired options from the pop-up menu to 
determine which attributes are shown in the Details view.

You can edit the marker details in the same way as in the 
marker list. The changes are reflected in the main marker 
list.

• To hide the Details view, click the “Show Details View” 
button again.

The details view supports line breaks which is useful 
for attributes with long texts. 

Marker preferences

You can access the marker preferences by clicking the 
corresponding button in the bottom left corner of the 
Marker window.

The following marker preferences are available:

About marker IDs
Each time you add a marker, it is automatically and sequen-
tially assigned an ID number, starting from 1. IDs for cycle 
markers are shown in brackets and start from [1]. ID num-
bers can be changed at any time – this allows you to assign 
specific markers to key commands.

If you move a marker from one marker track to another 
by drag & drop in the Project window and the marker ID is 
already used on this track, the inserted marker automati-
cally gets a new ID. 

Assigning marker IDs to key commands

You can move the project cursor to the markers 1 to 9 by 
pressing [Shift]-[1] to [9] on the numeric keypad. If you 
wish to locate other markers in this way, simply reassign 
the marker IDs:

1. Select the marker to which you wish to assign a new 
marker ID in the Marker window.

2. Click in the ID column of the selected marker and en-
ter a new ID.
If the number you enter was previously used for another marker, these 
markers will swap IDs.

3. Repeat this procedure as necessary for other markers.

• You can also remove a marker with an ID number be-
tween 1 to 9 to free up a key.

• For more information about marker key commands, see 
“Marker key commands” on page 145.

Column Description

Cycle follows 
when locating 
to Markers

This sets the left and right locators automatically to a po-
sition or cycle marker, when locating to this marker. This 
is useful if you need to set the locators on the fly, e. g. dur-
ing recording for Punch In/Punch Out. 

Show marker 
IDs on marker 
track

When this option is activated, the marker IDs are shown 
on the marker track.

Sync Selection When this option is activated, the Marker window selec-
tion is linked to the selection in the Project window. 
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Reassigning marker IDs

Sometimes, especially when setting markers on the fly, 
you may forget or miss to set a marker. When added later, 
this marker’s ID will not correspond to its position on the 
marker track. Therefore, it is possible to reassign the IDs 
for all markers on a track.

Proceed as follows:

1. Open the Marker window and select the marker track 
whose ID numbers you want to reassign.

2. Open the Functions pop-up menu and select either 
“Reassign Position Marker IDs” or “Reassign Cycle 
Marker IDs”.
The marker IDs of the selected type are reassigned to match the order of 
markers on the marker track.

Marker tracks
Marker tracks are used for adding and editing markers.

In the track list area for the marker track you can find three 
pop-up menus, which help you to select or zoom to the 
markers that you select:

Markers shown on marker tracks are exactly the same 
as shown in the Marker window, and any changes made 
on a marker track is reflected in the Marker window and 
vice versa. 

Adding, moving, and removing marker tracks
• To add a marker track to the project, select Marker from 
the Add Track submenu of the Project menu. 

• To move a marker track to another position in the track 
list, click and drag it up or down. 

• To remove one or more marker tracks, right-click them 
in the track list and select “Remove Selected Tracks” from 
the context menu.

• Empty marker tracks can also be removed by selecting 
“Remove Empty Tracks” from the Project menu. 
Note that Remove Empty Tracks also removes any other tracks that are 
empty.

When you remove all marker tracks, the marker track 
that you removed last (including all its markers) is moved 
to the clipboard. If you later insert a new marker track, this 
track is pasted from the clipboard into the track list.

Editing markers on marker tracks
The following editing functions can be performed directly 
on a marker track:

• Adding position markers “on the fly”.
Use the [Insert] key (Win) or the “Add Marker” button in the track list for 
the marker track to add position markers at the current cursor position 
during playback. 

• Adding a cycle marker.
Clicking the “Add Cycle Marker” button in the track list for the marker 
track adds a cycle marker spanning the area between the left and right 
locator. 

• Selecting markers.
You can use standard selection techniques like a selection rectangle, or 
use [Shift]-clicking to select separate markers. When selecting markers 
on the marker track, they are also selected in the Marker window.

• Drawing in position markers.
By using the Pencil tool (or pressing [Alt]/[Option] and using the Arrow 
tool), you can create position marker events at any position on the track. 
If Snap is activated on the toolbar, this determines at which positions you 
can draw markers.

Option Description

Locate pop-up 
menu

If you select a position or a cycle marker in this pop-up 
menu, the corresponding marker in the event display or in 
the Marker window is selected.

Cycle pop-up 
menu

If you select a cycle marker in this pop-up menu, the left 
and right locators are set to the corresponding cycle 
marker.

Zoom pop-up 
menu

If you select a cycle marker in this pop-up menu, the view 
zooms to the corresponding cycle marker.

Position markerCycle 
marker

LocatorsLocate pop-up menu

Zoom pop-up 
menu

Cycle pop-up 
menu

Add Marker/Add Cycle Marker buttons
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• Drawing in cycle markers.
To draw a cycle marker range, press [Ctrl]/[Command] and use the Pen-
cil tool or the Arrow tool. If Snap is activated on the toolbar, this deter-
mines at which positions you can draw markers. 

• Resizing cycle markers.
Select a cycle marker by clicking on it. Two handles appear at the bottom 
of the start and end events. If you click and hold one of the handles you 
can drag the event left or right to resize the cycle marker. This can also 
be done numerically on the info line.

• Moving markers.
Click and drag to move the selected markers. You can also edit marker 
positions on the info line. As usual, Snap is taken into account. If you 
move markers from one track to another, the marker gets the numbering 
of the first free marker ID on the track where it is dropped (see “About 
marker IDs” on page 141). 

• Removing markers.
This is done exactly the same way as for other events, i.e. by selecting 
them and pressing [Delete], using the Erase tool, etc.

Using markers to make range selections in the 
Project window
Besides enabling you to quickly move the project cursor 
and the locators, markers can be used in conjunction with 
the Range Selection tool to make range selections in the 
Project window. This is useful if you quickly want to make 
a selection that spans all tracks in the project. 

Moving and copying sections

To quickly move or copy complete sections of the project 
(on all tracks), proceed as follows:

1. Set markers at the start and end of the section that 
you want to move or copy.

2. Select the Range Selection tool and double-click on 
the marker track between the markers.
Everything in the project within the marker boundaries is selected. Any 
functions or processing you perform now affect the selection only.

3. Click on a marker track in the selected range and drag 
the range to a new position.

• If you hold down [Alt]/[Option] while you drag the range, 
the selection in the Project window is copied instead.

Multiple marker tracks
You can create up to 32 marker tracks. Multiple marker 
tracks are useful when working in a postproduction con-
text. For example, they can be used to import Edit Deci-
sion Lists (EDLs) or import/export CSV files for Automatic 
Dialog Replacement (ADR). 

A possible scenario would be to create a marker track 
with cycle markers for sections of the audio, and another 
marker track with important sync points in the video. You 
can also use multiple marker tracks to insert markers for 
different users in a network or different narrators in a 
movie (see “Working with multiple marker tracks – an ex-
ample” on page 144). 

Naming marker tracks

By default, the first marker track you create is called 
“Marker”, the second “Marker 02”, and so on. If you work 
with multiple marker tracks, it is recommended to name 
marker tracks according to their purposes, e. g. audio, 
video, or scene. 

You can name marker tracks by double-clicking on the 
marker track name in the track list or the Inspector and 
entering a new name.

The active marker track

When you are working with multiple marker tracks, only 
one track is active. All editing functions affect the markers 
on the active track only. You activate a track by clicking 
the “Activate this track” button in the track list.

The following rules apply:

• When you add a new marker track, this track is auto-
matically active.

• When you remove an active track, the topmost marker 
track in the track list is activated. 

• When using cycle markers for zooming (see “Zooming 
to cycle markers” on page 137), only the cycle markers of 
the active track are displayed on the Zoom pop-up menu. 
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• When exporting an audio mixdown of the audio between 
the cycle markers (see “Exporting and importing markers” 
on page 145), only the cycle markers of the active track are 
displayed in the Export Audio Mixdown dialog. 

• Most marker key commands affect the active track, see 
“Marker key commands” on page 145.

Locking marker tracks

You can lock one or more marker tracks by clicking the 
corresponding lock button of the track. When a marker 
track is locked, you cannot edit the track and its markers. 
However, you can still rename the track or change its sta-
tus (active/inactive). In the Marker window and the Project 
Browser, the unavailable features of a locked track are 
grayed out.

Working with multiple marker tracks – an example

Let’s say you have a video project where the dialog of two 
narrators is to be replaced. All you have to do is create dif-
ferent marker tracks for the individual narrators and set up 
the markers according to the video sections that need to 
be dubbed. 

Proceed as follows:

1. Add two marker tracks to the project that you want to 
edit and name them according to the narrators. 

2. Open the File menu and select “Key Commands…”.
The Key Commands dialog opens.

3. In the Marker category, set up a key command for the 
“Insert and name Marker” command.
This command adds a position marker, opens the marker window and 
activates the Description column, so that you can insert a name for the 
new marker. This makes it easier for you to insert markers on the fly and 
name them instantly. 

4. Set up key commands for the “Activate next Marker 
Track” and “Activate previous Marker Track” commands.
This helps you to activate the marker track where you want to insert the 
markers.

5. Activate the marker track for the first narrator, play 
back the video file, and at the position where the first dia-
log section should be replaced, trigger the “Insert and 
name Marker” command.
The Marker window opens; the Description column is active.

6. Enter a name or description for the corresponding 
section and press [Return] to confirm.
On the active track in the Project window a new marker is created. It might 
be useful to name the markers according to the first words of the dialog.

7. Trigger the “Activate next Marker Track” or “Activate 
previous Marker Track” key command, depending on 
which track you want to insert the following marker.
A message informs you that a different marker track is now active.

8. Trigger the “Insert and name Marker” key command at 
the position where the next dialog section should be re-
placed.

Repeat this procedure for all markers that you want to 
insert.
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Marker key commands
You can check or change any key command assignments 
for the marker commands in the Transport and Marker cat-
egories of the Key Commands dialog. In the following sec-
tion, the available key commands for markers are listed. If 
not stated otherwise, the key commands only affect the 
active marker track.

Key commands in the Transport Category:

Key commands in the Marker category:

Where no default key command is specified, you need 
to define your own stroke sequence in the Key Com-
mands dialog, see “Key commands” on page 580.

Exporting and importing markers
In Nuendo, markers and marker tracks can be imported 
and exported in different ways. You have the following 
possibilities: 

• You can import EDL CMX3600 files. 
• You can import/export CSV files. 
• You can import/export markers contained in MIDI files. 
• You can import/export track archives that contain marker 

tracks. 

Operation Description Default key 
command

Insert Cycle 
Marker

Creates a new cycle marker between 
the left and the right locator.

-

Insert Marker Creates a new marker at the current 
project cursor position.

[Insert]  
(Windows 
only)

Locate Next 
Marker

Moves the project cursor to the right to 
the next marker position (if any).

[Shift]-[N]

Locate next 
marker in 
marker window

Moves the project cursor to the next 
marker position, or to the start of the 
next cycle marker position (if any).

-

Locate Previ-
ous Marker

Moves the project cursor to the left to 
the previous marker position (if any).

[Shift]-[B]

Locate previ-
ous marker in 
marker window

Moves the project cursor to the previ-
ous marker position, or to the beginning 
of the next cycle marker position in the 
Marker window (if any).

-

Play until next 
marker

Plays back your project from the current 
project cursor position to the next 
marker position.

-

Recall Cycle 
Marker 1-9

Moves the left and right locators to 
encompass the specified cycle marker 
(1 to 9).

[Shift]- 
[Pad1] to 
[Pad9]

Set Marker  
1-9

Moves the specified marker (1 to 9) to 
the current project cursor position.

[Ctrl]-[1] to [9]

To Cycle 
Marker 1-9

Moves the project cursor to the start 
position of the specified cycle marker 
(1 to 9).

-

To Cycle 
Marker X

Moves the project cursor to the start 
position of a marker. Use this key com-
mand, let go of it and enter the desired 
marker ID.

-

To Marker 1-9 Moves the project cursor to the speci-
fied marker (ID 1 to 9).

[Shift]-[1] to 
[9]

To Marker X Moves the project cursor to the position 
of the specified marker. Use this key 
command, let go of it and enter the de-
sired marker ID.

-

Toggle: Cycle 
follows when 
locating to 
markers

Toggles the marker preference “Cycle 
follows when locating to markers” (see 
“Marker preferences” on page 141).

-

Operation Description Default key 
command

Activate Marker 
Track

Activates the selected marker track. If 
more than one marker track is se-
lected, the topmost track is activated.

-

Activate next 
Marker Track

Activates the next marker track in the 
track list.  
When you use this key command, a 
message informs you that the next 
marker track is activated.

-

Activate 
previous 
Marker Track

Activates the previous marker track in 
the track list. 
When you use this key command, a 
warning appears informing you that the 
previous marker track is activated.

-

Insert and 
name Cycle 
Marker

Adds a cycle marker between the left 
and the right locator, opens the marker 
window and activates the Name col-
umn, so that you can insert a name for 
the new cycle marker. 

-

Insert and 
name Marker

Adds a marker, opens the marker win-
dow and activates the Name column, 
so that you can insert a name for the 
new marker. 

-

Show only 
used attributes

Shows only the used attributes in the 
Marker window. 

-

Operation Description Default key 
command
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Importing EDL CMX3600 files (Edit Decision 
Lists)
In Nuendo, you can import Edit Decision Lists (EDLs) in 
CMX3600 format. EDLs are cut lists, i. e. representations 
of video edits that can be used to align audio events to a 
reference video file in Nuendo. They contain reel and time-
code data that help you to detect the exact position of 
each video clip. Most EDLs are simple ASCII files created 
by offline editing systems, but you can also create, open, 
and edit them manually with a text editor. 

The information contained in an EDL can be used in Nu-
endo to place audio events in the Project window at the 
specific timecode positions that correspond to the edits 
made in the video editing suite. 

Importing EDL CMX3600 files 

EDLs allow you to edit your audio according to the cuts of 
a video. When you import an EDL in Nuendo together with 
the cut video file, each cut described in the EDL is indi-
cated by a marker.

Every track in the EDL results in a new marker track in 
Nuendo. One video track and up to four audio tracks of 
the EDL can be imported.

To import an EDL CMX3600 file, proceed as follows:

1. Create a new project.
This is not strictly necessary, but helps you keep track of things.

2. Set up the project frame rate according to the frame 
rate of the EDL that you want to import.
For EDL import, Nuendo supports the frame rates 24 fps, 25 fps, 
29.97 fps, 29.97 dfps, 30 fps, and 30 dfps.

3. Open the File menu and select “EDL CMX3600…” 
from the Import submenu. 

4. In the file dialog that opens, select the file that you 
want to import and click Open.
The Import Options dialog opens.

5. In the Import column on the left, activate the marker 
tracks that you want to import.
You can also select all tracks by clicking the Select All Tracks button.

6. In the “Marker Options - Video” and “Marker Options - 
Audio” sections, select whether you want to import posi-
tion or cycle markers.

7. Click OK to import the EDL file.
If there are EDL edits outside the current project range, you are asked if 
you want the range to be automatically adjusted.

About scene detection

EDL CMX3600 files can also be used for scene detec-
tion. Scene detection can be useful if you want to fill spe-
cific sections of your project with a certain background 
atmosphere (by setting the locators to the cycle marker 
and using the Fill Loop option from the Edit menu). On im-
port, each scene is indicated by a colored cycle marker.
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Nuendo supports the following ways of scene naming:

• Three number scene naming, e. g. 25-3-5
The first is the scene number, the second is the setting or shooting angle 
and the third is the take number. As separators, the following characters 
can be used: comma (,), semicolon (;), full stop (.), hyphen (-), under-
score (_), slash (/), backslash (\). 

• Clip names
Scenes can also be identified by their clip names.

Recommendations 

When exporting EDLs from your offline editing system, 
keep the following rules in mind in order to achieve the 
best import results in Nuendo:

• Export your EDL in CMX3600 format.
Nuendo only supports the CMX3600 format.

• Add clip names as comments to the EDL and use a 
consistent naming scheme.
These names are used for naming markers and detecting scenes. 

Make sure that you set the correct export options in 
your video editing application (e. g. Final Cut Pro, Avid 
Xpress Pro) when creating the EDL.

Importing a CSV file
In Nuendo, you can import CSV (Comma Separated Val-
ues) files that were created with an additional program 
(taker program, etc.) or manually (text editor, Excel, Open 
Office, etc.). The values in the file should be separated by 
comma, semicolon, or tab and must contain at least time-
code in information. Make sure that the CSV file uses the 
file extension “*.csv”.

On import, the data in the CSV file will be interpreted as 
markers. For example, these help you to detect the exact 
timecode position of each audio or video clip. This is ex-
tremely useful if you want to create dubbed or synchro-
nized audio versions of your video.

To import a CSV file, proceed as follows:

1. Create a new project.
This is not strictly necessary, but helps you keep track of things. 

2. Set up the project frame rate corresponding to the 
frame rate of the CSV file that you want to import.
For CSV import, Nuendo supports the frame rates 24 fps, 25 fps, 
29.97 fps, 29.97 dfps, 30 fps, and 30 dfps.

3. Open the File menu and select “CSV Marker…” on the 
Import submenu.

4. In the file dialog that opens, select the file that you 
want to import and click Open.
The “CSV Import - Encoding” dialog opens.

5. In the “CSV Import - Encoding” dialog, open the En-
coding pop-up menu to select the encoding method of 
the file that you want to import.
If you are not sure which encoding method was used, select the Autode-
tect option.

The Preview section gives you visual feedback of how 
Nuendo interprets the data contained in the CSV file. If 
the data is not displayed correctly, try another encoding 
method.

6. Activate one of the Separator options.
The available options are: Comma (default setting), Semicolon, and Tab. 
Which option to choose depends on the separators used in the CSV file 
that you want to import.
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7. Click OK to apply your settings.
The CSV Import - Attribute Selection dialog opens. Here, you can assign 
the columns of the CSV to several marker attributes (e. g. timecode in, 
timecode out, name).

8. Use the column pop-up menus to assign marker at-
tributes. 

Note that at least the attribute for timecode in has to 
be assigned.

9. In the “Ignore first rows” field, specify how many lines 
you want to exclude from import. 
This is useful if your CSV file contains column headers that you want to 
exclude from import.

10. You can use the “Append numbers to a marker at-
tribute” pop-up menu to add a counter, e. g. to the charac-
ter attribute.
If you later sort the marker list by this attribute in the Marker window, you 
can quickly discern for how many takes/scenes this character is needed. 
Do not use this attribute to split your CSV file (see below).

11. Activate the “Generate multiple marker tracks” option 
if you want the markers to be placed on different tracks.

12. Use the “Split using Column” option to specify by 
what column the markers are sorted.
This specifies that all lines with the same value in the “split” column are 
imported into the same marker track in Nuendo.

• Click OK to continue.
The Import Options dialog opens.

13. In the Import Options dialog, select the tracks that you 
want to import by activating the corresponding tracks in 
the Import column to the left, or select all tracks by clicking 
the Select All Tracks button.

14. Click OK to import the CSV file and close the dialog.
The data contained in the CSV file is imported into marker tracks in Nu-
endo.

Exporting markers as CSV files
You can export the markers you set up in Nuendo as CSV 
(Comma Separated Values) files to use them as disposi-
tions. Dispositions are useful in recording studios, as they 
allow you to determine for how long a specific narrator is 
needed, etc. This makes it easier to calculate time and 
costs of a synchronization project.
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To export a CSV file containing markers from Nuendo, 
proceed as follows:

1. Set up the markers for your project.

2. On the File menu, open the Export submenu and se-
lect “CSV Marker…”.
The Export Options dialog opens.

3. In the Export column, activate the marker tracks that 
you want to export.
To select all marker tracks, click the Select All button.

4. Select “From Left to Right Locator”, if you want to ex-
port only markers within the locator range.

5. Choose the desired settings in the Options section. 
The following options are available:

6. Click the “Select Attributes” button to open the “CSV 
Export - Attribute Selection” dialog where you can specify 
which marker attributes you want to export. 
By default, all used attributes (i.e. attributes where at least one marker 
has a value) are exported, but you can also choose to export specific at-
tribute categories only (see “Marker attributes” on page 139). 

7. Click OK to confirm your attribute selection and close 
the Select Attributes dialog.

8. Click OK to export your markers as a CSV file.

Importing markers via MIDI import
You can import position markers by importing MIDI files 
containing markers. This is useful if you want to use your 
marker tracks in other projects or if you want to share them 
with other Nuendo users. Any markers you have added are 
included in the MIDI file as standard MIDI file marker events. 
Make sure that the “Import Markers” option is activated in 
the Preferences dialog (MIDI–MIDI File page).

The following settings are imported:

• The start position of position markers and cycle markers
• The track assignment of markers
• All marker tracks

If you import a standard MIDI file created in other ap-
plications, all markers are merged on one “shared” marker 
track.

For a description of how to import MIDI files, see “Import-
ing MIDI files” on page 561.

Exporting markers via MIDI
You can export your markers as part of a MIDI file. If you 
activate “Export Markers” in the Export Options dialog, any 
markers are included in the MIDI file. 

The following settings are exported:

• The start position of position markers and cycle markers
• The track assignment of markers
• All marker tracks

Option Description

Encoding Here you can select an encoding format for your 
CSV file. The available formats are: UTF8, UTF16, 
Win-1252/Win Latin1, MacRoman, Mac Central Eu-
ropean, and Shift JIS.

Separator Activate one of the options to specify the kind of 
separator used in your file. The available options are: 
Comma (default setting), Semicolon, and Tab.

Sort rows 
chronologically

Activate this option if you want to sort the markers 
according to their position on the timeline.

Sort track after track Activate this option if you want to sort the markers by 
their track name.

Generate Column 
Headings

Activate this option if you want to generate column 
headings.

Option Description
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To be able to export markers via MIDI export, your 
project must contain at least one marker track.

For a description of how to export MIDI files, see “Export-
ing MIDI files” on page 560.

Importing markers as part of a track archive
You can import position markers and cycle markers by im-
porting track archives containing marker tracks. Select the 
tracks that you want to import in the Import Options dialog.

The following settings are imported:

• The start and end positions of cycle markers
• The track assignment of markers
• The marker IDs
• The attributes
• All marker tracks

For a description of how to import track archives, see “Im-
porting tracks from a track archive” on page 563.

Exporting markers as part of a track archive
If you want to use your marker tracks in other projects, for 
example to share them with other users, you can export 
them as part of a track archive. Select the marker tracks 
that you want to export and select “Selected Tracks…” 
from the Export submenu of the File menu.

The following settings are exported:

• The start and end positions of cycle markers
• The track assignment of markers
• The marker IDs
• The attributes
• All marker tracks

For a description of how to export tracks archives, see 
“Exporting tracks as track archives” on page 562.
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Overview

The Mixer offers a common environment for controlling lev-
els, pan, solo/mute status, etc. for both audio and MIDI 
channels. Furthermore it is a convenient environment for 
setting up the input/output routing for multiple tracks or 
channels at the same time.

This chapter contains detailed information about the ele-
ments used when mixing audio and MIDI, or routing audio. 
You will also learn about the various ways you can config-
ure the Mixer.

Some mixer-related features are not described in this 
chapter. These are the following:

• Setting up and using audio effects.
See the chapter “Audio effects” on page 195.

• Setting up and using MIDI effects.
See the chapter “MIDI realtime parameters and effects” on page 372.

• Surround Sound.
See the chapter “Surround sound” on page 226.

• Automation of all Mixer parameters.
See the chapter “Automation” on page 239.

• Mixing down several audio tracks (complete with auto-
mation and effects if you wish) to a single audio file.
See the chapter “Export Audio Mixdown” on page 473.

Opening the Mixer
The Mixer can be opened in several ways:

• By selecting Mixer from the Devices menu.

• By clicking the Mixer icon on the toolbar.
If this icon is not visible, you need to activate the “Media & Mixer Windows” 
option on the toolbar context menu first.

• By using a key command (by default [F3]).

• By clicking the Mixer button in the Devices panel.
You open the Devices panel by selecting Show Panel from the Devices 
menu.

Opening multiple Mixer windows
Several separate Mixer items are available on the Devices 
menu. These are not separate Mixers, but rather separate 
views of the same Mixer. 

• Each of the Mixer windows can be configured to show 
any combination of channels, channel types, narrow and 
wide channel strips, etc.
For example, you can configure one Mixer window to show MIDI channel 
strips, another to show input and output channels, and another to show 
all audio-related channels.

• You can also save channel configurations as view sets 
(see “Channel view sets” on page 156), which are then 
accessible from all Mixer windows.
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All options for configuring the Mixer described in this 
chapter are identical for all Mixer windows.

The use of multiple Mixer windows combined with the abil-
ity to recall different Mixer configurations enables you to 
focus on the task at hand and keep window scrolling 
down to a minimum.

What channel types can be shown in the 
Mixer?
The following track-based channel types are shown in the 
Mixer:

• Audio
• MIDI
• Effect return channels (referred to as FX channels in the 

Project window)
• Group channels
• Instrument track channels

The order of audio, MIDI, instrument, group, and effect 
return channel strips (from left to right) in the Mixer corre-
sponds to the track list in the Project window (from top to 
bottom). If you reorder tracks of these types in the track 
list, this will be mirrored in the Mixer.

In addition to the above, the following channel types are 
also shown in the Mixer:

• Activated ReWire channels (see the chapter “ReWire” on 
page 548).

• VST instrument channels (see the chapter “VST instruments 
and instrument tracks” on page 215).

ReWire channels cannot be reordered and always appear 
to the right of other channels in the main Mixer pane. VST 
instrument (VSTi) channels can be reordered in the track 
list which will in turn be mirrored in the Mixer.

Input and output busses in the Mixer
The busses you set up in the VST Connections window 
are represented by input and output channels in the Mixer. 
They are shown in separate panes (to the left and right of 
the regular channel strips), with their own dividers and 
horizontal scrollbars. Input and output channel strips are 
very similar. The only difference between the two is that in-
put channels have no Solo buttons and no sends.

• You can hide and show these panes by activating or 
deactivating the “Hide Input Channels” or “Hide Output 
Channels” button on the common panel (see “The com-
mon panel” on page 154).

For input and output channel strips the following controls 
are available:

• You can check and adjust the input level using the Input 
Gain knobs and/or the level fader.
See “Setting input levels” on page 96.

• You can change the phase of the input signal.
This is done by clicking the Input Phase button next to the Input Gain 
control.

• You can add effects or EQ to the busses.
See “Recording with effects” on page 101 for an example of how to add 
effects to your recording at the input bus stage.

• You can open the Channel Settings window to add ef-
fects or EQ.
These will affect the whole bus. Examples of effects you may want to add 
here include compressors, limiters and dithering, see the chapter “Audio 
effects” on page 195.

For information on how to set up input and output busses, 
see the chapter “VST Connections” on page 27.

! The settings you make for the input channel will be a 
permanent part of the recorded audio file!

Input Gain

Bus level meter

Automation controls

Clipping indicator, see 
“Setting input levels” 
on page 96.

Speaker configuration

Inserts, EQ, and Sends
indicators and bypass 

buttons

Input Phase button

Mute, Solo, and Listen 
buttons (only the Output 

bus features a Solo 
button)

Bus volume fader

Edit button

Pan control
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How to route audio channels to busses is described in the 
section “Routing audio to output busses in the Mixer” on 
page 169.

If the Control Room is disabled (see the chapter “Con-
trol Room” on page 179), the Main Mix (the default output) 
bus is used for monitoring. For information about Monitor-
ing, see “About monitoring” on page 32.

Configuring the Mixer
The Mixer window can be configured in various ways to 
suit your needs and to save screen space. You can decide 
which types of channels are displayed (see “Showing/hid-
ing channel types” on page 155), and expand the view to 
open additional sections above the fader display (see be-
low). On the left is the common panel which allows for 
global settings affecting all channels (see “The common 
panel” on page 154).

Normal vs. extended channel strips
While the fader panel in the Mixer is always visible, you 
can show/hide extended channel strips and the routing 
section at the top of the channel strips. The correspond-
ing buttons can be found on the common panel on the left 
of the Mixer window. For details about the common panel, 
see “The common panel” on page 154.

The fader panel shows the basic controls – faders, pan 
controls and an associated vertical row of buttons. The ex-
tended panel can be set to show EQs, send effects, insert 
effects, etc. The routing panel contains input and output 
routing pop-up menus (where applicable), along with In-
put Phase and Input Gain controls for audio-related chan-
nel strips or an Input Transformer control for MIDI channel 
strips.

The extended panel and the routing panel can be shown 
and hidden as follows:

• On the common panel, click the “Show Extended Mixer” 
button or the “Show Routing View” button (respectively).
These options are also available on the Window submenu of the Mixer 
context menu.

Showing the extended Mixer panel

• On the common panel, click the “Hide Extended Mixer” 
button or the “Hide Routing View” button (respectively). 
These buttons (down arrows) are only visible when the 
corresponding section is open.
These options are also available on the Window submenu of the Mixer 
context menu.

Hiding the routing panel

The common panel
The common panel can be found on the left of the Mixer 
window. It contains settings for changing the look and 
behavior of the Mixer, as well as global settings for all 
channels.

In standard mode (extended view is hidden), the common 
panel contains the following controls:

Global automation 
Read/Write buttons

View set buttons, see 
“Channel view sets” on 
page 156.

Channel type buttons, 
see below.

Global channel width 
controls, see “Setting the 
width of channel strips” 
on page 157.

Opens the VST 
Connections window, 

see “The VST 
Connections window”

on page 28.

Reset Mixer/Reset 
Channels

Channel settings copy/
paste, see “Copying 

settings between audio 
channels” on page 166.

Global Mute, Solo and 
Listen buttons

“Command Target” 
options, see “About the 
Command Target” on 
page 156.
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Showing/hiding channel types

In the lower part of the common panel you will find a vertical 
strip with icons representing the different channel types:

• To hide or show a channel type, click the corresponding 
icon.
If an icon is lit (orange), the corresponding channel type is not visible in 
the Mixer.

• To show all hidden channel types again, click the “Re-
veal All Channels” button.

Configuring the extended channel strips

Using the icons in the extended area of the common panel 
you can determine globally what is displayed in the ex-
tended Mixer panel for all channel strips. Depending on 
the channel type, the following options are available:

• For a description of the options available for audio-re-
lated channels, see “Options for extended audio channel 
strips” on page 160. The options for MIDI channels are 
described in the section “Options for extended MIDI 
channel strips” on page 174.

• To apply the global view settings also to the input and 
output channels, press [Alt]/[Option] while clicking on an 
icon.

• To set up the extended channel strip individually for a 
channel, you can use the View Options pop-up menu, see 
below. 

The View Options pop-up menu
Each channel strip in the Mixer features a View Options 
pop-up menu, which is used for two things:

• To determine what is shown in the extended panel for 
individual channels in the Mixer.
The corresponding options are only available when the extended Mixer 
view is open.

• To set the “Can Hide” status for individual channels in 
the Mixer, see below.

The View Options pop-up menu is opened by clicking the 
down arrow located just above the fader panel of a chan-
nel strip.

Input Channels
Audio Channels

Group Channels

ReWire Channels

MIDI Channels

VST Instrument Channels
FX Channels

Output Channels

“Can Hide” options, see 
“Showing/hiding individual 

channels” on page 156

Reveal All Channels

Clear all views  
(blank panels)

Show all Inserts

Show all Equalizers Show all Equalizers with 
Curve

Show all Sends
Show Sends 1–4 or 5–8

Show SurroundPanners 
(where applicable)

Show all Meters
Show Channel 
Overview

Show Studio Sends

Show Direct Routing

Show Wave Meters
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Showing/hiding individual channels
Additionally to hiding or showing channel types via the 
common panel, you can show or hide individual channel 
strips. Proceed as follows:

1. Pull down the View Options pop-up menu for a chan-
nel that you want to hide and activate the “Can Hide” op-
tion (or [Alt]/[Option]-click in the top middle section of the 
channel strip).
The “/” icon is shown if “Can Hide” is activated for a channel strip.

2. Repeat this for all the channels that you want to hide.

3. On the common panel, click the “Hide Channels set to 
‘Can Hide’” button.
This hides all channels set to “Can Hide”. To show them again, click the 
button again, or click the “Reveal All Channels” button at the bottom of 
the common panel.

Below the “Hide Channels set to ‘Can Hide’” button, there 
are three additional buttons. These have the following 
functionality:

About the Command Target
Command targets let you specify which channels are af-
fected by Mixer “commands” (all the functions that key 
commands can be assigned to), e. g. what to display in the 
extended Mixer, or the width setting of the channel strips. 
You can set command targets using the common panel or 
the context menu.

The Command Target Controls on the common panel

The following options are available:

• All Channels – Select this if you want your commands to af-
fect all channels.

• Selected Only – Select this if you want your commands to 
affect the selected channels only.

• Exclude Inputs – Select this if you do not want your com-
mands to affect the input channels.

• Exclude Outputs – Select this if you do not want your com-
mands to affect the output channels.

Channel view sets
Channel view sets are saved configurations of the Mixer 
window, allowing you to quickly switch between different 
layouts for the Mixer. The following settings are stored in 
view sets:

• Settings for individual channel strips (e. g. narrow or wide 
mode and whether the channel strip is hidden or set to “Can 
Hide”).

• The global hide/show status for channel types.
• The panel hide/show status (fader panel, extended panel, 

routing panel).
• Configuration of the extended view.

To create a view set, proceed as follows:

1. Set up the Mixer configuration that you want to save.

2. At the bottom of the common panel, click the “Store 
View Set” button (the “+” sign).

3. A dialog opens, allowing you to enter a name for the 
view set.

4. Click OK to store the current Mixer view set.

Option Description

Set Target Channels 
to ‘Can Hide’

This activates “Can Hide” for all channels that you 
specified as “Command Targets”, see below.

Remove ‘Can Hide’ 
from Target Channels

This deactivates “Can Hide” for all channels that 
you specified as “Command Targets”, see below.

Remove ‘Can Hide’ 
from All Channels

This deactivates “Can Hide” for all channels in the 
Mixer.

The orange color of this control on the common panel 
indicates that all channels set to ‘Can Hide’ are hidden from 
view.
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• You can now return to this stored configuration at any 
time by clicking the “Select Channel View Set” button (the 
down arrow to the left of the “Store View Set” button) and 
selecting it from the pop-up menu.

• To remove a stored channel view set, select it and click 
the “Remove View Set” button (the “-” sign).

Setting the width of channel strips
Each channel strip can be set to either “Wide” or “Narrow” 
mode by using the “Channel Narrow/Wide” button on the 
left above the fader strip.

• Narrow channel strips contain a narrow fader, miniature 
buttons, and the View Options pop-up menu.
In the extended panel, only the Channel Overview, the Meter and the Di-
rect Routing outputs are shown in narrow mode. (All other parameters 
are shown again when you return to wide mode.)

A wide and a narrow channel strip

• If you select “All targets narrow” or “All targets wide” on 
the common panel, all channel strips selected as command 
targets (see “About the Command Target” on page 156) 
are affected.

The Window submenu
The Mixer context menu, opened by right-clicking any-
where on the Mixer window background, contains a Win-
dow submenu. Its options are handy for quickly switching 
to another open Mixer window, showing/hiding the differ-
ent Mixer panes, etc. It contains the following options:

• Show Routing View
Allows you to show/hide the topmost section of the Mixer which contains 
the input/output routing settings.

• Show Extended View
Allows you to show/hide the middle section of the Mixer, where you can 
display different settings for the channels (EQs, Send effects, etc.).

• Next Mixer
This displays the next Mixer window (if you have several Mixer windows 
open).

Basic mixing procedures

Setting volume in the Mixer
In the Mixer, each channel strip has a volume fader. 

• For audio channels, the faders control the volume of the 
channels before they are routed (directly or via a group 
channel) to an output bus.
Each channel can in turn handle up to 12 speaker channels – see the 
chapter “Surround sound” on page 226.

• An output channel fader determines the master output 
level of all audio channels routed to that output bus.

• MIDI channels handle fader volume changes in the 
Mixer by sending out MIDI volume messages to the con-
nected instrument(s).
Connected instruments must be set to respond to MIDI messages (such 
as MIDI volume in this case) for this to function properly.

• The fader settings are displayed numerically below the 
faders, in dB for audio-related channels and as MIDI vol-
ume (0 to 127) for MIDI channels.
You can click in the fader value fields and type in a new volume value.

• To make fine volume adjustments, hold down [Shift] 
when you move the faders.

• If you hold down [Ctrl]/[Command] and click on a fader, 
it is reset to its default value, i. e. to 0.0 dB for audio-re-
lated channels, or to 100 for MIDI channels.
Most Mixer parameters can be reset to their default values like this.

! Some remote control devices support this function, 
which means that you can use the remote device to 
switch between the channel view sets.
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You can use the faders to set up a volume balance be-
tween the audio and MIDI channels, and perform a manual 
mix by moving the faders and other controls while playing 
back. Using the Write function (see “Enabling and dis-
abling the writing of automation data” on page 240), you 
can automate the levels and most Mixer actions.

About the level meters for audio channels

When playing back audio in Nuendo, the level meters in 
the Mixer show the level of each audio channel.

• Directly below the level meter is a small level readout – 
this shows the highest registered level in the signal.
Click this to reset the peak levels.

• Peak levels can also be shown as static horizontal lines 
in the meter, see “Changing the meter characteristics” on 
page 167.

Nuendo uses 32 bit floating point processing internally, 
so there is virtually limitless headroom – signals can go way 
beyond 0 dB without clipping. Having higher levels than 
0 dB for individual audio channels is therefore not a problem 
in itself. The audio quality will not be degraded by this.

However, when many high level signals are mixed in an 
output bus, this may require that you lower the output 
channel level a lot (see below). Therefore it is good prac-
tice to keep the maximum levels for individual audio chan-
nels roughly around 0 dB.

About the level meters for input and output channels

Input and output channels have clipping indicators.

• When you are recording, clipping can occur when the 
analog signal is converted to digital in the audio hardware. 
It is also possible to get clipping in the signal being recorded to disk 
(when 16 or 24 bit record format is used and you have adjusted the 
Mixer settings for the input channel). For more information, see “Setting 
input levels” on page 96.

• In the output busses, the floating point audio is converted 
to the resolution of the audio hardware. In the integer audio 
domain, the maximum level is 0 dB – higher levels cause the 
clipping indicator for each bus to light up.
If the clipping indicators light up for a bus, this indicates actual clipping – 
digital distortion which is to be avoided.

About the Input Gain control

Each audio-related channel and input/output channel fea-
tures an Input Gain knob. It controls the gain for the in-
coming signal, before EQ and effects.

The Input Gain knob is not meant to be used as a volume 
control in the Mixer, as it is not suited for continuous level 
adjustments during playback. However, it can be used to 
cut or boost the gain. This is useful in the following cir-
cumstances:

• To change the level of a signal before the effects sec-
tion.
The level going into certain effects can change the way the signal is af-
fected. A compressor, for example, can be “driven” harder by raising the 
input gain.

• To boost the level of poorly recorded signals.

To change the input gain value, you need to press [Shift] 
before you can adjust the control (that way accidental gain 
changes are avoided). If you press [Alt]/[Option], you can 
adjust the Input Gain using a fader. Alternatively, you can 
directly enter a new value in the value field.

! It is also possible to create volume envelopes for 
separate events in the Project window or Audio Part 
Editor (see “Event envelopes” on page 121), or to 
make static volume settings for an event on the info 
line or with the volume handle (see “About the vol-
ume handle” on page 114).

! When Direct Monitoring is used and the “Map input 
bus metering to Audio track (in Direct Monitoring)” 
option is activated in the Preferences dialog (VST–
Metering page), the level meters in the Mixer show 
the level of the input bus instead. 

! If the clipping indicator lights up for an output chan-
nel, lower the level until the indicator is no longer lit.
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About the Input Phase control

Each audio-related channel and input/output channel has 
an Input Phase button (to the left of the Input Gain con-
trol). When this button is activated, the phase polarity is 
inverted for the signal. Use this to correct for balanced 
lines and mics that are wired backwards, or mics that are 
“out of phase” due to their positioning.

• Phase polarity is important when mixing together two 
similar signals. 
If the signals are “out of phase” with respect to one another, there will be 
some cancellation in the resulting audio, producing a hollow sound with 
less low-frequency content.

Level meters for MIDI channels

The level meters for MIDI channels do not show actual vol-
ume levels. Instead, they indicate the velocity values of the 
notes played back on MIDI tracks.

MIDI tracks set to the same MIDI channel and output

If you have several MIDI tracks set to the same MIDI chan-
nel (and routed to the same MIDI output), making volume 
and pan settings for one of these MIDI tracks/Mixer chan-
nels also affects all other Mixer channels set to the same 
MIDI channel/output combination.

Using Solo and Mute
You can use the Mute and Solo buttons to silence one or 
several channels. 

The following applies:

• The Mute button silences the selected channel.
Clicking the Mute button again unmutes the channel. Several channels 
can be muted simultaneously. Muting group channels can have two dif-
ferent results depending on how the Preferences are set (see “Settings 
for group channels” on page 170).

• Clicking the Solo button for a channel mutes all other 
channels.
A soloed channel is indicated by a lit Solo button, and also by the lit Glo-
bal Solo icon on the common panel. Click the Solo button again to turn 
off Solo.

• Several channels can be soloed at the same time.
However, if you press [Ctrl]/[Command] and click the Solo button for a 
channel, any other soloed channels are automatically un-soloed (i. e. this 
Solo mode is exclusive).

• [Alt]/[Option]-clicking a Solo button activates “Solo De-
feat” for that channel.
In this mode the channel will not be muted if you solo another channel. To 
turn off Solo Defeat, [Alt]/[Option]-click the Solo button again. 

• You can un-mute or un-solo all channels simultaneously 
by clicking the Global Mute or Global Solo icon on the 
common panel.

A muted channel 
in the Mixer.

A lit Global Mute icon on the 
common panel shows that one or 
more channels are muted.

Solo Defeat is activated for this channel.
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Audio-specific procedures
This section describes the options and basic procedures regarding audio channels in the Mixer. The following graphic 
shows different types of (non-extended) audio-related channels (from left to right): an audio track, a group channel, an 
instrument track, an FX channel, and a VST instrument channel:

All audio-related channel types (audio, instrument track, 
group, effect return, VST instrument, and ReWire) have 
the same channel strip layout, with the following excep-
tions:

• Only audio track channels have an Input Routing pop-up 
menu.

• Only audio and instrument track channels have Monitor and 
Record Enable buttons.

• Instrument track and VST instrument channels have an addi-
tional button for opening the instrument’s control panel.

About the Insert/EQ/Send indicators and 
bypass buttons
The three buttons in each audio channel strip have the fol-
lowing functionality:

• If an insert or send effect, or an EQ module is activated 
for a channel, the corresponding button is lit. 
The effect indicator buttons are blue, and the EQ indicator buttons are 
green.

• If you click any of these buttons when lit, the corre-
sponding EQ or effects section is bypassed.
Bypass is indicated by the color yellow. Clicking the button again deac-
tivates bypass.

Options for extended audio channel strips
When using the extended view (see “Normal vs. extended 
channel strips” on page 154), the upper panel can be set 
to show different views for each audio-related channel 
strip. You can select what to display in the extended panel 
individually for each channel or globally for all channels.

The following views are available:

• A blank panel (“Empty”).

• The Inserts section, with 8 effect pop-up menus, a by-
pass and an edit button.
The inserts can also be found in the Inspector and the Channel Settings 
window, see “Using Channel Settings” on page 163.

Automation controls

Monitor and Record 
Enable buttons

Input/Output Routing

Opens the control panel for the VST instrument.

Level fader and meter

Edit button (opens the 
Channel Settings window)

Insert/EQ/Send indicators and bypass buttons (see below)

Channel name

Input Gain control

Speaker configuration Input Phase switch

Listen button (see the section 
“Listen mode” on page 161)

Pan control
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• The EQ section, either with value sliders (“EQs”) or as 
numerical settings with a curve display (“EQs curve”).
These two views have exactly the same controls but different graphic lay-
outs. The EQ section is also available in the Channel Settings window. 
For EQ parameter descriptions, see “Making EQ settings” on page 164.

• The Sends section, with 8 effect pop-up menus and 
send level value sliders.
The sends can also be found in the Inspector and the Channel Settings 
window, see “Using Channel Settings” on page 163.

• You also have the option of displaying four sends at a 
time (the Sends 1–4 and 5–8 menu items). 
These modes offer the additional benefit of displaying send levels as dB 
values.

• The Panner section (where applicable).
If the channel is routed to a surround bus, you can view a compact ver-
sion of the SurroundPanner in the extended panel. Double-click on it to 
open the full SurroundPanner panel. If the Mixconvert plug-in is inserted 
and active, its controls are displayed in this section instead.

• The Meter section.
Select the Meter option to view large level meters in the extended panel. 
These operate exactly like the regular meters.

• The Overview section.
Select the Overview option if you want to know which insert effects, EQ 
modules, and send effects are activated for the channel. You can click 
the On/Off buttons to activate and deactivate the corresponding insert 
effect, EQ module, or send effect.

• The User Panel section.
Select the User Panel option to view the available device panels for the 
audio track, including panels for inserted VST effects, see “Audio tracks” 
on page 43. You can access the available panels via the User pop-up 
menu in the extended Mixer panel.
For information on device panels, see the separate PDF document “MIDI 
Devices”.

• The Studio Sends section.
Select the Studio Sends option if you want to view the available studio 
sends. This section is only available if the Control Room is enabled, see 
the chapter “Control Room” on page 179.

• The Direct Routing section.
Select the Direct Routing option to view 7 additional output destination 
slots. For more information, see “Direct Routing” on page 171.

• The Wave Meters display.
Select the Wave Meters option to display a vertically scrolling waveform 
in the extended Mixer panel. The scrolling speed depends on the disk 
preload time set in the Device Setup dialog (VST Audio System page). 
With preload times under 4 seconds, the scrolling speed increases.

In narrow mode, only the Channel Overview, the Meter, 
and the Direct Routing sections can be shown in the ex-
tended channel strip. If you have selected any of the other 
options, the Channel Overview is displayed in narrow 
mode. When you switch back to wide mode, the corre-
sponding settings become available again.

Listen mode
Additionally to the Solo/Mute functions, which affect the 
actual mix, Nuendo features a Listen function. It allows you 
to quickly check the signal coming from selected channels 
without interrupting and interfering with the actual mix.

For example, during a recording session this allows the 
sound engineer in the control room to attenuate the signal 
coming from one of the musicians while the recording 
continues undisturbed.

In the Control Room Mixer you can enable/disable the Lis-
ten function for the Phones and Control Room channels, 
decide whether the signal is read pre-fader or post-fader, 
and hear the signals from the listen-enabled channels in 
context by adding a dimmed version of the mix signal. For 
more information about the functions available in the Con-
trol Room Mixer, see “The Control Room Mixer” on page 
184.

In the Mixer you can listen-enable any track by activating 
the corresponding Listen button:

• Clicking the Listen button for a channel routes that 
channel to the Control Room without interrupting the nor-
mal signal flow. 
A listen-enabled channel is indicated by a lit Listen button, and also by 
the lit global Listen button on the common panel. 

The Listen button for a channel strip and the global Listen button on the 
common panel

• Click the Listen button again to turn off Listen mode.
You can also turn off Listen mode for all listen-enabled tracks at the 
same time by clicking the global Listen button on the common panel.

In the Key Commands dialog (Mixer category) you can 
also set up a key command to enable/disable Listen for a 
channel (see “Key commands” on page 580).
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Setting pan in the Mixer
For each audio-related channel with at least a stereo out-
put configuration you will find a miniature pan control at 
the top of the channel strip. This control is different for 
stereo and surround configurations.

Panning channels with a stereo output configuration

The pan control at the top of stereo audio channel strips is 
used to position a channel in the stereo spectrum.

The stereo pan control

The following applies when using the pan control: 

• To make fine pan adjustments, hold down [Shift] when 
you move the pan control.

• To select the (default) center pan position, hold down 
[Ctrl]/[Command] and click on the pan control.

• To view the pan settings in a separate window, where 
you can change the settings using sliders, double-click on 
the pan control.

About the three stereo pan modes

By default, stereo pan controls the balance between the 
left and right channels. However, if you want to set pan in-
dependently for the left and right channel, you can select a 
different pan mode.

If you right-click in the pan control field for a stereo audio 
channel, you can select one of three pan modes:

• Stereo Balance Panner controls the balance between 
the left and right channels.
This is the default mode.

• If Stereo Dual Panner is selected, there will be two pan 
controls with the upper controlling pan for the left channel, 
and the lower controlling pan for the right channel.
This allows you to set pan independently for the left and right channels. 
Note that it is possible to reverse the left and right channels, i. e. the left 
channel can be panned to the right and vice versa. You can also “sum” 
two channels by setting them to the same pan position (i. e. mono). How-
ever, this will increase the volume of the signal.

• If Stereo Combined Panner is selected, the left and 
right pan positions are shown as two lines with a blue/gray 
area between them.
In this mode, the left and right pan controls are linked, and can be moved 
left and right like a single pan control (keeping their relative distance).

In Stereo Combined mode you can also set the pan inde-
pendently for the left and right channels. This is done by 
holding down [Alt]/[Option] and dragging the correspond-
ing pan control.

If you reverse the left and right channels, the area be-
tween the pan controls is red instead of blue/gray.

When moving combined pan controls so that the left or 
right pan control reaches its maximum pan value, it natu-
rally cannot go any further. If you continue to move further 
in the same direction, only the other pan control will move, 
thus altering the set relative pan range until both channels 
are panned fully to one side. If you move the pan controls 
in the opposite direction without releasing the mouse, the 
previously set pan range will be restored.

The pan settings made with the Dual Panner are re-
flected in the Combined Panner and vice versa.

You can specify the default pan mode for inserted au-
dio tracks in the Preferences dialog (VST page).
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About the “Stereo Pan Law” setting

In the Project Setup dialog you will find a pop-up menu 
named “Stereo Pan Law”, which allows you to select one 
of several pan modes. These modes are required for power 
compensation. Without power compensation, the power of 
the sum of the left and right side is higher (louder) if a 
channel is panned center than if it is panned left or right. 

To remedy this, the Stereo Pan Law setting allows you to 
attenuate signals panned center, by -6, -4.5 or -3 dB (de-
fault). Selecting the 0 dB option effectively turns off con-
stant-power panning. Experiment with the modes to see 
which fits best in a given situation. You can also select 
“Equal Power” on this pop-up menu, which means that the 
power of the signal will remain the same regardless of the 
pan setting.

Panning multi-channel audio

Channels with a multi-channel output configuration fea-
ture a miniature SurroundPanner control at the top of the 
channel strip. For further information on multi-channel au-
dio and the SurroundPanner V5, see the chapter “Sur-
round sound” on page 226.

Panning Bypass

You can bypass the panning for all audio-related track 
types. To do this, press [Shift]–[Alt]/[Option] and click on 
the pan setting for the respective channel (on the fader 
panel or in the extended Mixer view). The Panning Bypass 
state is reflected in all the different pan setting sections, 
e. g. if you bypass a channel in the Mixer, this is automati-
cally reflected in the Inspector for the respective track.

When panning is bypassed for a channel, the following 
happens:

• Mono channels are panned center.
• Stereo channels are panned left and right.
• Surround channels are panned center.

To deactivate Panning Bypass, simply press [Shift]-
[Alt]/[Option] and click again.

Using Channel Settings 
For each audio channel strip in the Mixer and in the In-
spector and track list for each audio track, there is an Edit 
button (“e”).

Clicking this opens the VST Audio Channel Settings win-
dow. By default, this window contains:

• A section with eight insert effect slots (see “Audio effects” on 
page 195).

• Four EQ modules and an associated EQ curve display (see 
“Making EQ settings” on page 164).

• A section with eight sends (see “Audio effects” on page 195).
• A duplicate of the Mixer channel strip (without the extended 

panel but with the input and output settings panel).

You can customize the Channel Settings window, by 
showing/hiding the different panels and/or by changing 
their order:

• To specify which panels are shown or hidden, right-click in the 
Channel Settings window, and activate/deactivate the corre-
sponding options on the Customize View submenu of the 
context menu.

• To change the order of the panels, select “Setup…” on the 
Customize View pop-up menu and use the “Move up” and 
“Move Down” buttons.

For further information, see the chapter “Customizing” 
on page 570.

Every channel has its own Channel Settings window (al-
though you can view each in the same window if you like – 
see below).

Click the Edit button to open the Channel Settings 
window.
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The Channel Settings window in its default configuration 
is used for the following operations:

• Apply equalization, see “Making EQ settings” on page 164.
• Apply send effects, see “Audio effects” on page 195.
• Apply insert effects, see “Audio effects” on page 195.
• Copy channel settings and apply them to another channel, see 

“Copying settings between audio channels” on page 166.

Changing channels in the Channel Settings window

You can view any channel’s settings from a single win-
dow. 

If the “Sync Project and Mixer Selection” option is acti-
vated in the Preferences dialog (Editing–Project & Mixer 
page), this can be done “automatically”:

• Open the Channel Settings window for a track and po-
sition it so that you can see both the Project window and 
the Channel Settings window.

Selecting a track in the Project window automatically 
selects the corresponding channel in the Mixer (and vice 
versa). If a Channel Settings window is open, this will im-
mediately switch to show the settings for the selected 
channel. This allows you to have a single Channel Settings 
window open in a convenient position on the screen, and 
use it for all your EQ and channel effect settings.

You can also select a channel manually (thereby changing 
what is shown in the open Channel Settings window). 
Proceed as follows:

1. Open the Channel Settings window for any channel.

2. Open the “Choose Edit Channel” pop-up menu by 
clicking the arrow button to the left of the channel number 
at the top of the Fader view.

3. Select a channel from the pop-up menu to show the 
settings for that channel in the open Channel Settings 
window.

• Alternatively, you can select a channel in the Mixer by 
clicking its channel strip (make sure not to click on a con-
trol as this will change the respective parameter setting 
instead).
This selects the channel, and the Channel Settings window is updated.

• To open several Channel Settings windows at the same 
time, press [Alt]/[Option] and click the Edit buttons for the 
respective channels.

Making EQ settings
Each audio channel in Nuendo has a built-in parametric 
equalizer with up to four bands. There are several ways to 
view and adjust the EQs:

• By selecting one of the EQ display modes (“Show All 
Equalizers” or “Show All Equalizers with Curve”) for the 
extended channel strip in the Mixer. These modes contain 
the same settings but present them in different ways:

• By selecting the Equalizers or Equalizer Curve tab in the 
Inspector.
The Equalizers section is similar to the EQs mode in the extended Mixer or 
the Equalizers section in the Channel Settings window, while the Equalizer 
Curve section shows a display in which you can “draw” an EQ curve. Set-
ting EQ in the Inspector is only possible for track-based audio channels.

By default, only the Equalizers tab is shown. To display 
the Equalizer Curve tab, right-click on an Inspector tab 
(not in the empty area below the Inspector) and activate 
the Equalizer Curve option.

• By using the Channel Settings window.
This offers both parameter sliders and a clickable curve display (the 
Equalizer + Curve pane) and also lets you store and recall EQ presets.

! All channel settings are applied to both sides of a 
stereo channel.

In “Show All Equalizers” mode, the top value slider 
controls the gain, the middle controls frequency and 
the lower sets the filter type and the Q parameter for 

each EQ band.

In “Show All Equalizers with Curve” mode, EQ 
settings are shown as a curve. Parameters are set 
by clicking on the value and adjusting with the 
fader that appears.
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Below we describe how to set up EQ in the Channel Set-
tings window, but the parameters are the same in the Mixer 
and Inspector (apart from the presets and reset function, 
which are not available in the Mixer).

The Equalizers + Curve pane in the Channel Settings win-
dow consists of four EQ modules with parameter sliders, 
an EQ curve display and some additional functions at the 
top.

Using the parameter controls

1. Activate an EQ module by clicking its On/Off button.
Although the modules have different default frequency values and differ-
ent Q names, they all have the same frequency range (20 Hz to 20 kHz). 
The only difference between the modules is that you can specify different 
filter types for each individual module (see below).

2. Set the amount of cut or boost with the gain control – 
the upper slider.
The range is ± 24 dB.

3. Set the desired frequency with the frequency slider.
This is the center frequency of the frequency range (20 Hz to 20 kHz) to 
be cut or boosted.

4. Click on the filter name above the bottom slider and 
select a filter type from the pop-up menu.
The “eq1” and “eq4” bands can act as parametric, shelving, or high/low-
pass filters, while “eq2” and “eq3” will always be parametric filters.

5. Set the Q value with the bottom slider.
This determines the width of the affected frequency range. Higher values 
give narrower frequency ranges.

6. To invert an EQ band (i. e. reflect the curve along the x 
axis), click the Inverse button to the right of its On/Off but-
ton. This button is hidden when the EQ module is deacti-
vated.
This is very useful if you want to filter out unwanted noise. While looking 
for the frequency to omit, it sometimes helps to boost it in the first place 
(set the filter to positive gain). After you have found it, you can use the In-
verse button to cancel it out.

7. If needed, you can activate and make settings for up to 
four modules.

• Note that you can edit the values numerically as well, by 
clicking in a value field and entering the desired gain, fre-
quency, or Q value.

Using the curve display

When you activate EQ modules and make settings, you 
will see that your settings are automatically reflected in the 
curve display above. You can also make settings directly 
in the curve (or combine the two methods any way you 
like):

1. To activate an EQ module, click in the curve display.
This adds a curve point and one of the modules below is activated.

2. Make EQ settings by dragging the curve point in the 
display.
This allows you to adjust gain (drag up or down) and frequency (drag left 
or right).

3. To set the Q parameter, press [Shift] and drag the 
mouse up or down.
You will see the EQ curve become wider or narrower as you drag.

• You can also restrict the editing by pressing [Ctrl]/
[Command] (sets gain only) or [Alt]/[Option] (sets fre-
quency only) while you drag the curve point.

4. To activate another EQ module, click somewhere else 
in the display and proceed as above.

5. To turn off an EQ module, double-click its curve point 
or drag it outside the display.

6. To invert the EQ curve (i. e. reflect it along the x axis), 
click the Inverse Equalizers button to the right of the curve 
display.
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EQ bypass

Whenever one or several EQ modules are activated for a 
channel, the EQ button lights up in green in the Mixer 
channel strip, Inspector (Equalizer and Channel sections), 
track list, and Channel Settings window (top right corner 
of the EQ section).

You can also bypass all EQ modules. This is useful, as it 
allows you to compare the sound with and without EQ. 
Proceed as follows:

• In the Mixer, the track list and in the Channel section in 
the Inspector, click the EQs state button so that it turns 
yellow.
To deactivate EQ bypass, click the button again, so that it turns green 
again.

• In the Inspector (Equalizers tab) and in the Channel 
Settings window, click the Bypass button (next to the EQ 
button) so that it turns yellow.
Click again to deactivate EQ bypass mode.

Left: EQ bypass in the Mixer; Right: EQ bypass in the Channel Settings 
window or the Inspector

EQ reset

On the Presets pop-up menu in the Channel Settings win-
dow and in the Inspector, you will find the Reset command. 
Select this to turn off all EQ modules and reset all EQ pa-
rameters to their default values.

Using EQ presets

Some useful basic presets are included with the program. 
You can use them as they are, or as a starting point for fur-
ther “tweaking”. 

• To call up a preset, pull down the presets pop-up menu 
in the Channel Settings window or in the Inspector and 
select one of the available presets.

• To store the current EQ settings as a preset, select 
“Save Preset…” from the Presets pop-up menu and enter 
the desired name for the preset in the dialog that opens.

• To rename the selected preset, select “Rename Preset” 
on the pop-up menu and enter a new name.

• To delete the selected preset, select “Remove Preset” 
on the pop-up menu.

You can also apply EQ (and Inserts) settings from 
track presets, see “Applying inserts and EQ settings from 
track presets” on page 359.

EQ in the channel overview

If the Channel section is selected in the Inspector or if the 
Overview section is displayed in the extended Mixer view, 
you will get an overview of which EQ modules, insert ef-
fects and sends are activated for the channel.

By clicking on any of the module numbers (1 to 4), you 
can turn the corresponding EQ module on or off.

The channel overview in the extended Mixer view

Copying settings between audio channels
It is possible to copy all channel settings for an audio 
channel and paste them to one or several other channels. 
This applies to all audio-based channel types. For exam-
ple, you can copy EQ settings from an audio track and ap-
ply these to a group or VST instrument channel, if you 
want them to have the same sound. 
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Proceed as follows:

1. In the Mixer, select the channel you want to copy set-
tings from.

2. On the common panel, click the “Copy First Selected 
Channel’s Settings” button.

3. Select the channel(s) you want to copy the settings to 
and click the “Paste Settings to Selected Channels” but-
ton (below the “Copy First Selected Channel Settings” 
button).
The settings are applied to the selected channel(s).

You can copy channel settings between different types of 
channels, but only those channels will be used for which 
corresponding settings are available in the target channel:

• For example, since input/output channels do not have send ef-
fects, copying from them will leave the sends settings in the 
target channel unaffected.

• Also, in case of surround sound, any insert effects routed to 
surround speaker channels become muted when the settings 
are pasted to a mono or stereo channel.

Initialize Channel and Reset Mixer
The Initialize Channel button can be found in the lower 
part of the Control Strip section in the Channel Settings 
window. (If this section is not shown in the Channel Set-
tings window, open the context menu and select “Control 
Strip” on the Customize View submenu.) Initialize Channel 
resets the selected channel to the default settings. 

Similarly, the Mixer common panel holds a Reset Mixer/
Reset Channels button. When you click this, you will be 
asked whether you want to reset all channels or just the 
selected channels.

The default settings are:

• All EQ, insert and send effect settings are deactivated and 
reset.

• Solo/Mute is deactivated.
• The fader is set to 0 dB.
• Pan is set to center position.

Changing the meter characteristics 
On the Mixer context menu, there is a submenu named 
“Global Meter Settings”. Here you can make settings for 
the preferred meter characteristics, with the following op-
tions:

• If Hold Peaks is activated, the highest registered levels 
are “held” and are shown as static horizontal lines in the 
meter.
Note that you can turn this on or off by clicking in any audio level meter in 
the Mixer.

• If Hold Forever is activated, the peak levels are shown 
until meters are reset (by clicking the numerical peak dis-
play below the meter).
If Hold Forever is off, you can use the parameter “Meters’ Peak Hold 
Time” in the Preferences dialog (VST–Metering page) to specify for how 
long the peak levels will be held. The peak hold time can be between 
500 and 30000 ms.

• If Meter Input is activated, meters show input levels for 
all audio channels and input/output channels. 
Note that the input meters are post input gain.

• If “Meter Post-Fader” is activated, meters show post-
fader levels.
This is the default setting for channels in the Mixer.

• There is also a “Meter Post-Panner” mode.
This is similar to “Meter Post-Fader”, but the meters will reflect pan set-
tings as well.

• If Fast Release is activated, the meters respond very 
quickly to level peaks. If Fast Release is deactivated, the 
meters respond more like standard meters.
You can set the time it takes for the meters to “fall back” in the Prefer-
ences dialog (VST–Metering page).

Hold Peaks is activated. The 
highest registered level is 
displayed in the meter.
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Saving and loading Mixer settings
It is possible to save complete Mixer settings for all or all se-
lected audio-related channels in the Mixer. These can later 
be loaded into any project. Channel settings are saved as 
Mixer settings files. These have the file extension “.vmx”. 

Saving selected channels or all Mixer settings

Right-clicking somewhere in the Mixer panel or in the 
Channel Settings window brings up the context menu 
where the following Save options can be found:

• “Save Selected Channels” will save all channel settings 
for the selected channels.
Input/output routing is not saved.

• “Save All Mixer Settings” saves all channel settings for 
all channels.

When you select any of the above options, a standard file 
dialog opens where you can select a name and storage lo-
cation on your disk for the file.

Loading selected channels

To load Mixer settings saved for selected channels, pro-
ceed as follows:

1. Select the same number of channels as when you 
saved your Mixer settings.

• The Mixer settings are applied in the same order as they 
were saved.
For example, if you save the settings for channels 4, 6 and 8, and apply 
these settings to channels 1, 2 and 3, the settings saved for channel 4 
are applied to channel 1, the settings saved for channel 6 to channel 2, 
and so on.

2. Open the Mixer context menu and select “Load Se-
lected Channels”.
A standard file dialog opens, allowing you to locate the saved file.

3. Select the file and click Open.
The channel settings are applied to the selected channels.

Loading all Mixer settings

Selecting “Load All Mixer Settings” from the context menu 
allows you to open a saved Mixer settings file, and have 
the stored settings applied to all channels for which infor-
mation is included in the file. All channels, output settings, 
VST instruments, sends and “master” effects will be af-
fected.

Routing
When you play back an audio track (or any other audio-re-
lated channel), you route it to an output bus. In the same 
way, when you record on an audio track you select from 
which input bus the audio is received.

The input and output routing for a channel can be set up 
via the Inspector or the Mixer. For large projects, it is con-
venient to use the Mixer for this, since it allows you to set 
inputs and outputs for multiple channels at the same time. 
In postproduction projects it might even be necessary to 
send signals to several outputs at once. This can easily be 
achieved using the Direct Routing features, see “Direct 
Routing” on page 171.

! When applying Mixer settings to fewer channels than 
Mixer settings available in the saved file, some of the 
saved settings are not needed and will be “left over”. 
Since the saved settings are applied from “left to 
right” (as shown in the Mixer), the settings for the 
channels furthest to the right are the ones that are 
not applied to any channels.

! This function does not automatically add channels! 
For example, if the saved Mixer settings are for 24 
channels, and the Mixer you apply it to contains 16 
channels, only the settings for channels 1 to 16 are 
applied.
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• In the Inspector, you can select input and output busses 
using the Input and Output Routing pop-up menus.

• In the Mixer, you can select busses in the routing panel 
at the top of each channel strip.
For more information about the routing panel, see “Normal vs. extended 
channel strips” on page 154.

• If you press [Shift]-[Alt]/[Option] and select an input or 
output bus in the track list or the routing panel in the Mixer, 
it will be chosen for all selected channels.
This makes it easy to quickly set several channels to use the same input 
or output. Similarly, if you press [Shift] and select a bus, the following se-
lected channels will be set to use incrementing busses – the second se-
lected channel will use the second bus, the third will use the third bus 
and so on.

For audio-related channel types other than audio track 
channels (i. e. VST instrument channels, ReWire channels, 
group channels, and FX channels), only the Output Rout-
ing pop-up menu is available.

When selecting an input bus for a track you can only se-
lect busses that correspond to the track’s channel config-
uration. Here are the details for input busses:

• Mono tracks can be routed to mono input busses or individual 
channels within a stereo or surround input bus.

• Mono tracks can be routed to External Inputs configured on 
the Studio tab of the VST Connections window. These can be 
mono or individual channels within a stereo or surround bus. 
They can also be routed to the Talkback input.

• Mono tracks can also be routed to mono output busses, mono 
group output busses or mono FX channel output busses, pro-
vided that these will not lead to feedback.

• Stereo tracks can be routed to mono input busses, stereo in-
put busses or stereo child busses within a surround bus.

• Stereo tracks can be routed to External Inputs that are config-
ured in the Studio tab of the VST Connections window. These 
can be mono input busses or stereo input busses. They can 
also be routed to the Talkback input.

• Stereo tracks can also be routed to mono or stereo output 
busses, mono or stereo group output busses and mono or 
stereo FX channel output busses, provided that these will not 
lead to feedback.

• Surround tracks can be routed to surround input busses.
• Surround tracks can be routed to External Inputs that are con-

figured in the Studio tab of the VST Connections window, 
provided that these have the same input configuration. 

• Surround tracks can also be routed to output busses, pro-
vided that these have the same input configuration or will not 
lead to feedback.

For output busses any assignment is possible.

To disconnect input or output bus assignments, select 
“No Bus” from the corresponding pop-up menu.

Routing audio to output busses in the Mixer
Output busses let you route audio from the program to the 
outputs on your audio hardware. To route the output of an 
audio channel to one of the active busses, proceed as fol-
lows:

1. Make sure that the routing panel is visible (see “Nor-
mal vs. extended channel strips” on page 154).

2. Pull down the Output Routing pop-up menu at the top 
of the channel strip and select one of the busses.
This pop-up menu contains the output busses configured in the VST 
Connections window, as well as available group channels (provided that 
the busses and groups are compatible with the speaker configuration for 
the channel – see “Routing” on page 168).

For details on routing surround channels, see “Routing” 
on page 229.

! Assignments that will lead to feedback are not avail-
able in the pop-up menu. This is also indicated by a 
one-way symbol.
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You can also create sends that can be routed to other 
output channels. This can be useful when creating quick 
headphone mixes from the current monitor mix or to create 
a downmix of a surround mix. This is done by creating a 
send from the current monitor output bus, assigned to an-
other output bus connected to a headphone amplifier.

Using group channels
You can route the outputs from multiple audio channels to 
a group. This enables you to control the channel levels us-
ing one fader, apply the same effects and equalization to 
all the channels, etc.

For example, group channels can be used as “effect 
racks” (see the chapter “Audio effects” on page 195) or 
for pre-mixing purposes (i. e. stems) in a postproduction 
scenario (see “Direct Routing” on page 171).

To set up a group channel, proceed as follows:

1. Pull down the Project menu, open the Add Track sub-
menu and select the “Group Channel…” option.

2. Select the desired channel configuration and click the 
Add Track button.
A group channel track is added to the track list and a corresponding 
group channel strip is added to the Mixer. By default, the first group 
channel strip is labeled “Group 1”, but you can rename it just like any 
channel in the Mixer.

3. Pull down the Output Routing pop-up menu for a 
channel you want to route to the group channel, and se-
lect the group channel.
The output of the audio channel is now redirected to the selected group.

4. Do the same for the other channels you wish to route 
to the group.

Settings for group channels

The group channel strips are almost identical to audio 
channel strips in the Mixer. The descriptions of the Mixer 
features earlier in this chapter apply to group channels as 
well. Some things to note:

• You can route the output of a group to an audio channel 
(see “Recording from busses” on page 95), to an output 
bus or to another group.
You cannot route a group to itself.

• There are no Input Routing pop-up menus, Monitor but-
tons or Record Enable buttons for group channels.

• Solo functionality is automatically linked for channels 
routed to a group and the group channel itself.
This means that if you solo a group channel, all channels routed to the 
group are automatically soloed as well. Similarly, soloing a channel 
routed to a group will automatically solo the group channel.

• Mute functionality depends on the “Group Channels: 
Mute Sources as well” setting in the Preferences dialog 
(VST page).

By default, when you mute a group channel, no audio will 
pass through the group. However, other channels that are 
routed directly to that group channel will remain unmuted. 
If any of those channels have aux sends routed to other 
group channels, FX channels or output busses, those will 
still be heard.

If the “Group Channels: Mute Sources as well” option is 
activated in the Preferences dialog (VST page), muting a 
group channel will cause all other channels directly routed 
to it to be muted as well. Clicking the Mute button again 
will unmute the group channel and all other channels di-
rectly routed to it. Channels that were muted prior to the 
group channel being muted will not remember their mute 
state and become unmuted with the group channel.! You can select a group channel as input for an audio 

track, e. g. to record a downmix of separate tracks 
(see “Recording from busses” on page 95). ! The “Group Channels: Mute Sources as well” option 

does not affect how mute automation is written. Writ-
ing mute automation for a group channel only affects 
the group channel and not the channels routed to it. 
When writing automation, you will see the other 
channels being muted as well upon muting a group 
channel. However, during playback, only the group 
channel will respond to the automation.
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Direct Routing
In large postproduction projects, a lot of time and effort 
has to go into the routing of individual tracks, group chan-
nels, etc. The Direct Routing features of Nuendo help you 
to set up your routing easily and quickly. They allow you to 
switch the destination of channels “on the fly” (for exam-
ple, if a track containing sound effects is temporarily to be 
routed to the dialogue stem), and to create different mix 
versions (such as full and M+E) in one go, thus saving you 
the time to start the mixdown process twice.

Rather than having to adjust the routing destinations indi-
vidually for each channel, you can use the Direct Routing 
panel in the Mixer to set and activate outputs for all se-
lected channels at once. The Direct Routing features are 
available for audio-related tracks (audio, instrument, and 
FX channel tracks), groups, and output busses.

Direct Routing offers the following advantages:

• Routing destinations can be set for multiple channels at the 
same time.

• The switching of routing destinations can be automated.
• The extended Mixer panel offers eight easy-to-use destination 

slots for each channel. 
• Multiple Direct Routing destinations can be assigned and ac-

tivated at the same time.
• Upmixing or downmixing happens automatically, if necessary.

Direct Routing destinations in the Mixer
The Direct Routing panel is shown in the extended Mixer 
view by clicking the “Show Direct Routing” button on the 
common panel (see “Configuring the extended channel 
strips” on page 155). Here, you can make all necessary 
settings for setting up multiple routing destinations.

Additionally to the main output you can set up seven rout-
ing destinations that are positioned post-fader and post-
panner in the signal path and share the configuration of 
the main output. If you want to set up outputs with a differ-
ent channel width, upmixing or downmixing becomes nec-
essary. For more information, see “Automatic upmixing 
and downmixing” on page 173.

Setting up the routing panel
Once you have set up your project, created your output 
busses, and defined the groups (stems) that you want to 
work with, you can set up the Direct Routing panel. Includ-
ing the main output, up to eight routing destinations can 
be assigned to each channel strip. It is recommended to 
choose the same set of destinations for all channels that 
belong together (for example, all audio tracks containing 
dialogue). By setting up multiple outputs, you can later 
switch the routing destination for the channels very quickly 
(see “Automating destination switches” on page 172), or 
activate multiple destinations (see “Feeding signals to 
multiple destinations” on page 172).

To set up the routing panel, proceed as follows:

1. In the Mixer, make sure that the extended Mixer view is 
visible.

2. On the common panel, click the “Show Direct Rout-
ing” button.
Eight routing destination slots appear above each channel strip.

Audio tracks routed to group channels (on the left) and group channels 
routed to different output busses (on the right)
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3. Select all the channels for which you want to set up 
the same destinations (e. g. all audio tracks, or all groups).

• The Direct Routing settings can be applied to all se-
lected channels at once. To do this, keep [Shift]-[Alt]/[Op-
tion] pressed when making a selection or activating a 
button.

4. Open the Output Routing pop-up menu for the first 
(topmost) destination slot and choose the main output for 
the selected channels.
The main output should have the widest channel configuration since it is 
used as a reference for all additional output destinations. For more infor-
mation, see “Automatic upmixing and downmixing” on page 173.

5. Open the Output Routing pop-up menu for the next 
destination slot, and select another output. Do this for as 
many destination slots as you need (up to eight).
For example, you can route all your audio tracks to the corresponding 
groups (stems).

6. Repeat this procedure for channels of a different type.
For example, after routing your audio tracks to groups, you can route the 
groups to output busses.

7. For each channel, you can now activate the appropri-
ate routing destination by clicking on the corresponding 
slot.

Narrow vs. wide channel strips

The Mixer panel can be set to show “narrow” or “wide” 
channel strips (see “Setting the width of channel strips” 
on page 157). Switching to the narrow view can be useful 
after setting up the Direct Routing destinations so that 
more channel strips fit on the screen. However, not all 
controls for the routing destinations are available in this 
mode.

Automating destination switches
Especially in larger postproduction scenarios it is neces-
sary to switch the output destinations for audio-related 
tracks and to automate these switches. This is especially 
useful for FX channel tracks carrying insert effects that 
you want to apply to different stems (e. g. reverb). Another 
scenario could be if a certain type of sound is sometimes 
part of the ambience stem and at other times needs to be 
fed to the SFX stem. By using the Direct Routing features, 
you can achieve the switches “on the fly” with a simple 
mouse click.

To automate the switching of routing destinations, pro-
ceed as follows:

1. Play back your project, taking note of the positions 
where routing changes are necessary.

2. Write-enable the corresponding track, and at the right 
moment, click on the routing destination that you want to 
switch to.
The new destination is now active, and the switch has been recorded as 
automation data.

3. Continue to record destination changes for your 
project.

To switch destinations for multiple channels simulta-
neously, select these channels and keep [Shift]-[Alt]/[Op-
tion] pressed when activating a different destination.

Feeding signals to multiple destinations
Generally, routing destinations are assigned exclusively. 
For each channel, only one output can be active at a time. 
However, Direct Routing offers a summing mode, allowing 
you to feed your signals to several outputs at the same 
time.

In film mixing projects it is likely that you need to create 
different mixes. For example, you might need a final 5.1 
mix for cinema and a stereo mix for home screening, as 
well as an M&E mix (needed to create a dubbed version, 
for example, for the German audience). Recording these 
mixes one after the other will take considerable time. To 
get an impression of how these different mixes will sound 
in the end, Nuendo allows you to activate multiple outputs 
at the same time so that you can quickly create different 
mix versions for previewing. However, since no individual 
settings can be made for these mixes, this will not replace 
the final mixing process.

Feeding a signal to multiple outputs can also be used to 
apply an effect to several stems at the same time. For ex-
ample, you may want to add reverb to the dialogue and fo-
ley stems simultaneously to create a realistic sound 
experience.

Proceed as follows:

1. In the Mixer, set up your output busses as routing desti-
nations (see “Setting up the routing panel” on page 171).

2. Select all the channels that you want to route to the 
same destinations.
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In order to apply the following settings to all selected 
channels at once, keep [Shift]-[Alt]/[Option] pressed 
when making a selection or activating a button.

3. Activate the “Summing Mode On/Off” buttons for the 
selected channels.

In the Key Commands dialog (Mixer category), you can 
also set up a key command for the summing mode (see 
the chapter “Key commands” on page 580).

4. Activate all the outputs that you want to route the se-
lected channels to.

Automatic upmixing and downmixing
The output in the first (topmost) Direct Routing slot de-
fines the channel width. Since the other destinations are 
positioned post-panner in the signal path (see graphic) 
they have the same channel width to start with. Therefore, 
if you set up outputs with a different channel configuration, 
the signal needs to be converted accordingly (by upmixing 
or downmixing). This is done automatically by Nuendo, no 
configuration is necessary.

When using multiple routing destinations, the following 
scenarios are possible:

• The Direct Routing destination has the same number of 
channels as the main output, but a different format: The 
levels of the speaker channels are adjusted accordingly.
If both destinations have the same format, no upmixing or downmixing is 
required.

• The main output configuration is wider than the Direct 
Routing destination: A downmix is performed before send-
ing the signal to that destination (e. g. from 5.1 to stereo).

• The main output has less channels than the Direct Rout-
ing destination: An upmix is performed before the signal is 
sent to that destination (e. g. from stereo to 5.1).
It is not recommended to use such a setup (even though it is technically 
possible). Upmixing might lead to unexpected side effects. For example, 
if the main output is stereo and you have an additional 5.1 output, this 
second output gets an upmixed stereo signal feeding only the left and 
right channels.

Based on two common examples, the following tables il-
lustrate how the levels are adjusted when performing an 
automatic downmix. The channel configuration as defined 
by the main output is shown from left to right, and the 
channel configuration of the downmix from top to bottom.

Automatic downmixing from 5.1 to stereo:

Center and Lfe signals are split to L and R channels, Ls and Rs are sent 
to L and R (respectively), but reduced in volume.

Automatic downmixing from 7.1 to 5.1:

Lc and Rc signals are split to L/R (respectively) and the center channel.

Channel 
(e. g. stereo)

Panner 
(e. g. stereo to 5.1)

Main output 
(e. g. 5.1)

Additional output destinations 
(e. g. a stereo mix)Upmixing or Downmixing

! It is recommended to always select the output with 
the widest channel configuration in the “Main” slot.

L R C Lfe Ls Rs

L 0.0 -3.01 -3.01 -6.02

R 0.0 -3.01 -3.01 -6.02

L R C Lfe Ls Rs Lc Rc

L 0.0 -3.01

R 0.0 -3.01

C 0.0 -3.01 -3.01

Lfe 0.0

Ls 0.0

Rs 0.0
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MIDI-specific procedures
This section describes basic procedures for MIDI chan-
nels in the Mixer.

MIDI channel strips

The MIDI channel strips allow you to control volume and 
pan in your MIDI instrument (provided that the instrument 
is set up to receive the corresponding MIDI messages). 
The settings here are also available in the Inspector for 
MIDI tracks.

Options for extended MIDI channel strips
When using the extended view (see “Normal vs. extended 
channel strips” on page 154), the upper panel can be set 
to show different views for each MIDI channel strip. You 
can select what to display in the extended panel individu-
ally for each channel or globally for all channels (see 
“Configuring the extended channel strips” on page 155). 
The following views are available:

• A blank panel (“Empty”).

• The Inserts section, with 4 insert effect slots for the 
channel.
MIDI inserts can also be found in the Inspector and the Channel Settings 
window for MIDI channels. How to use MIDI insert effects is described in 
the chapter “MIDI realtime parameters and effects” on page 372.

• The Sends section, with 4 send effect slots for the 
channel.
The sends can also be found in the Inspector and the Channel Settings 
window for MIDI channels. How to use MIDI send effects is described in 
the chapter “MIDI realtime parameters and effects” on page 372.

• The Meter section.
Select the Meter option to view large level (velocity) meters in the ex-
tended panel.

• The Overview section. 
Select the Overview option if you want to know which insert effects and 
effect sends are activated for the channel.
You can click the indicators to turn the corresponding slot/send on or off.

• The User Panel section.
Select the User Panel option if you want to import MIDI device panels. 
This is described in the separate PDF document “MIDI Devices”.

If you select the EQ, the Studio Sends, the Surround-
Panners, or the Direct Routing option on the common 
panel, the view for MIDI channels does not change. These 
apply to audio-related channels only.

Panning MIDI channels
For MIDI channels, the pan control sends out MIDI pan 
messages. The result depends on how your MIDI instru-
ment is set to respond to pan – check your documentation 
for details.

Using Channel Settings
For each MIDI channel strip in the Mixer (and MIDI track in 
the track list or the Inspector), there is an Edit (“e”) button. 

Clicking this opens the MIDI Channel Settings window. 
By default, this window contains a duplicate of the Mixer 
channel strip, a section with four MIDI inserts and a sec-
tion with four MIDI send effects.

You can customize the Channel Settings window by 
showing/hiding the different panels and/or by changing 
their order:

• To specify which panels are shown or hidden, right-
click in the Channel Settings window and activate/deacti-
vate the corresponding options on the Customize View 
submenu of the context menu.

• To change the order of the panels, select Setup on the 
Customize View pop-up menu and use the “Move up” and 
“Move Down” buttons in the dialog that opens.

Level fader  
(MIDI volume)

Level (velocity) meterAutomation controls

Pan control

Monitor and Record 
Enable buttons

MIDI input and 
output

Edit button

Mute and Solo

Insert/Send indicators 
and bypass buttons

Input Transformer button
MIDI channel

Opens the control panel 
for a connected VST 

instrument
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Every MIDI channel has its own Channel Settings window.

Utilities

Link/Unlink channels
This function is used to “link” selected channels in the 
Mixer so that any change applied to one channel will be 
mirrored by all channels in that group. Only channels of 
the same type (audio-related or MIDI) can be linked with 
each other. You can link as many channels as you like, and 
you can also create as many groups of linked channels as 
you like. To link channels in the Mixer, proceed as follows:

1. Press [Ctrl]/[Command] and click on all the channels 
you want to link.
[Shift]-clicking allows you to select a continuous range of channels.

2. On the Mixer context menu, select the Link Channels 
option.

• To unlink channels, select one of the linked channels and 
select “Unlink Channels” from the Mixer context menu.
The channels are unlinked. Note that you do not have to select all the 
channels that are linked, only one of them.

It is not possible to remove individual channels from 
the link.

What will be linked?

The following rules apply to linked channels:

• Only level, mute, solo, select, monitor and record enable 
will be linked between channels.
Effect/EQ/pan/input and output routing settings are not linked.

• Any individual channel settings you have made before 
linking will remain until you alter the same setting for any of 
the linked channels.
For example, if you link three channels and one of them was muted at the 
time you applied the Link Channel function, this channel will remain muted 
after linking. However, if you mute another channel, all linked channels will 
be muted.

• Fader levels will be “ganged”.
The relative level offset between channels will be kept if you move a 
linked channel fader.

The three channels shown are linked. Moving one fader changes the 
levels for all three channels, but keeps the relative level mix.

• By pressing [Alt]/[Option], you can make individual set-
tings and changes for channels that are linked.

Linked channels have individual automation tracks. 
These are completely independent, and are not affected 
by the Link function.
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VST Mixer Diagrams

Channel Objects
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Control Room Objects
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Virtual Control Room – The concept
The concept behind the Control Room features in Nuendo 
is to divide the studio environment into the performing area 
(studio) and the engineer/producer area (control room) 
common to traditional studios. Previously, an analog con-
sole or some method of speaker control and monitor rout-
ing was necessary to provide this functionality to the DAW 
environment.

With its Control Room Mixer and Control Room Overview 
features, Nuendo provides all the functionality of the ana-
log console’s monitoring section, along with many more 
features, in a virtual, VST-based audio environment where 
flexibility and instant recall are expected.

Control Room features
The following features are available for the Control Room 
Mixer:

• Support for up to four sets of monitors with various speaker 
configurations from mono up to 7.1 or 8.0 cinema speaker 
systems.

• Configurable monitor sources that allow you to route different 
inputs, outputs, and groups to the Control Room.

• Dedicated Headphone output.
• Support for up to four discrete cue mix outputs called “Studios”.
• Dedicated Talkback channel with flexible routing and auto-

matic record defeat.
• Support for up to six external inputs with configurations up to 

7.1 or 8.0 surround.
• Click track routing and level control to all Control Room out-

puts.
• Flexible Listen bus options with the Listen Dim setting that 

allows listen-enabled tracks to be heard in context with the 
whole mix.

• Listen bus enabling on both Control Room and Headphone 
outputs.

• User-definable downmix settings using the MixConvert plug-in 
for all speaker configurations.

• Individual speaker soloing for all speaker configurations.
• Multiple inserts on each Control Room channel for metering 

and surround decoding among other possibilities.
• Monitor Dim function with adjustable level.
• User-defined Calibrated Monitor level for postproduction mix-

ing in a calibrated environment.
• Adjustable Input Gain and Input Phase on all external inputs 

and Speaker outputs.

• Full-sized meters on every Control Room channel.
• Support for up to four aux sends (Studio Sends) for creation 

of discrete cue mixes for performers. Each Studio output has 
its own cue mix.

• The ability to disable the Control Room Section when working 
with an external monitoring solution or console.

Control Room operations
In traditional analog studios, the control room section of 
the console contained the most used set of controls in the 
whole studio.

The need to constantly be able to switch monitoring 
sources, adjust the volume of monitors and route various 
cue mixes and other sources to headphone systems is the 
norm in most sessions. Meeting the needs of several per-
formers in the studio plus a producer and the engineer be-
comes a constant task that requires flexibility and ease of 
operation. Communication between everyone must be 
flawlessly clear without intruding on the creativity of 
performers.

The Nuendo Control Room Mixer is designed to fill those 
needs with a simple yet highly flexible solution. The virtual 
mixing environment of VST is the ideal solution to the var-
ied needs of a control room matrix. With a virtual mixer, a 
high degree of customization and precise settings are 
possible with the ability to completely recall these settings 
at any time.

Configuring the Control Room
The Control Room features are configured in several loca-
tions within Nuendo. 

• The hardware inputs and outputs for the Control Room chan-
nels are defined in the VST Connections window on the Stu-
dio tab. Here you can also enable and disable the Control 
Room.

• The Control Room Overview gives you a visual overview of the 
Control Room channels and signal flow. It is opened via the 
Devices menu.

• The Control Room Mixer allows operation of the Control 
Room features. It can be opened from the Project window 
toolbar (Media & Mixer Windows section), the Devices menu, 
or the Studio tab in the VST Connections window.

• Some general Control Room settings can be found in the 
Preferences dialog (VST–Control Room page).
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VST Connections – Studio tab
The Studio tab of the VST Connections window is where 
you configure the inputs and outputs for the Control Room 
Mixer. You can also enable or disable the Control Room 
and open the Control Room Mixer. The channel width of 
the Control Room channel is shown in the Configuration 
field on the top right of the tab. For more information about 
the VST Connections window, see the chapter “VST Con-
nections” on page 27. 

The Studio tab of the VST Connections window showing several 
Control Room channels

When the Control Room is enabled, the Main Mix bus 
is automatically shown on the Studio tab. The reason is 
that the Main Mix is always available as a monitor source in 
the Control Room Mixer (see “Selecting a monitor source” 
on page 188). However, editing the Main Mix bus can only 
be done on the Outputs tab.

By default, one stereo Monitor channel is created after 
installing Nuendo.

About the Control Room channels
There are different types of channels that you can create, 
each defining either an input or output of the Control 
Room Mixer. As more channels are created, the Control 
Room Mixer expands to display controls for each channel.

Of all Control Room channels only Monitor channels can 
share hardware inputs or outputs with another bus or chan-
nel, as defined in the VST Connections window (see “Add-
ing input and output busses” on page 30). As you create 
connections for each Monitor channel, those device ports 
that have already been used for other busses or channels 
are shown in red on the Device Port pop-up menu. If you 
select a port marked in red, the previous connection of this 
port is lost.

In order to avoid confusion due to suddenly missing 
port connections on other tabs, you may want to set all the 
outputs to “Not Assigned” while the Control Room is be-
ing set up.

Monitors

Each Monitor channel is a set of outputs that are con-
nected to monitor speakers in the Control Room. Up to 
four Monitor channels can be created for the different sets 
of speakers in a studio. Monitor channels can be config-
ured for a mono, stereo or up to 7.1 or 8.0 surround 
speaker configuration. A typical postproduction studio 
could have one set of 5.1 surround speakers, another ste-
reo set of speakers, and even a single mono speaker for 
checking balances for mono broadcast.

The Control Room Mixer allows you to switch speakers 
easily. Each set of Monitors can have its own custom 
downmix settings, input gain and input phase adjust-
ments.

Monitor sources

Postproduction setups usually require more than one mix 
bus (e. g. for dialogue, sound effects, and music). Every 
bus is recorded separately, but the re-recording mixer has 
to listen individually to the different busses as well as to 
the sum of all mix busses. For this purpose you can set up 
different monitor sources in the VST Connections window 
and then use the Control Room Mixer to dynamically se-
lect the mix source(s) that you want to listen to.

As a monitor source you can select any available input or 
output bus, or group channel. 

Click here to open the 
Control Room Mixer.

The width of the 
Control Room channel

! Note that the channel width of the Control Room is 
determined by the Main Mix bus. If you choose a 
monitor source with a wider configuration, automatic 
downmixing occurs. It is strongly recommended to 
always select the bus with the widest channel con-
figuration as the Main Mix bus.
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Phones

The Phones channel is used by the engineer in the control 
room for checking cue mixes and as another option for lis-
tening to the mix or external inputs on a pair of headphones. 
Furthermore, the Phones channel can be used for preview-
ing, see “Control Room preferences” on page 190. It is not 
intended for cue mixes that performers use while recording.

Studios

Studio channels are intended for sending cue mixes to 
performers in the studio during recording. They have talk-
back and click functions and can monitor the main mix, ex-
ternal inputs or a dedicated cue mix. Up to four Studios 
can be created allowing four discrete cue mixes for per-
formers.

For example, if you have two available headphone amplifi-
ers for performers to use, create two Studio channels, one 
for each headphone mix.

External inputs

External inputs are used for monitoring external devices 
such as CD players, multi-channel recorders or any other 
audio source. Up to six external inputs can be created with 
various configurations from mono up to 7.1 surround.

If you select external inputs as input source of an audio 
channel, you can record them. In this case, you will not 
need to assign the device ports to the input channel (see 
“Routing” on page 168).

Talkback

The Talkback is a mono input used for a communications 
system between the control room and performers in the 
studio. Only one mono Talkback channel is available.

The Talkback channel can be routed to each Studio chan-
nel with variable levels in order to optimize communication 
between the control room and performers.

Additionally, the Talkback is available as a possible in-
put source for audio tracks. You can record from the Talk-
back just like any other input.

Creating a Control Room channel
To create a new channel for the Control Room, proceed 
as follows:

1. Open the Studio tab of the VST Connections window 
and click the Add Channel button.
A pop-up menu lists all available channel types along with how many of 
each type are available. Available Monitor Sources are listed on the cor-
responding submenu.

Instead of clicking the Add Channel button you can also 
select a channel type on the context menu of the Studio 
tab.

2. Select the type of channel you wish to create. 
For most channel types a dialog opens, allowing you to choose the con-
figuration of the channel (stereo, 5.1, etc.).

The new channel is displayed in the VST Connections win-
dow. For each audio path except the monitoring sources 
(see below) an audio device must be selected. You can as-
sign device ports to channels in the same fashion as as-
signing any VST connection.

Exclusive assignment of Monitor channels

Even though the port assignment to the Control Room 
channels is generally exclusive, it might be useful to create 
Monitor channels that share device ports with each other 
as well as inputs and outputs. This can be helpful if you 
use the same speakers as a stereo pair and also as the left 
and right channels of a surround speaker configuration. 

! The Phones channel is stereo only.

! Studio channels can either be mono or stereo.

! Inserts are available on the Talkback and all other 
Control Room channels. A compressor/limiter can 
be inserted on the Talkback channel to ensure that 
erratic levels do not bother performers and clear 
communication with everyone is possible.

! Note that the port assignments for all Control Room 
channels except Monitor channels are exclusive, 
meaning that you cannot assign the same device 
port to any bus or channel and a Control Room chan-
nel at the same time. 
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Switching between monitors that share device ports will 
be seamless, providing any downmix of multi-channel au-
dio to stereo if needed. Only one monitor set can be active 
at a time.

If your scenario does not require you to assign ports to 
several Monitor channels, it is recommended to activate 
the “Exclusive Device Ports for Monitor Channels” option 
in the Preferences dialog (VST–Control Room page). This 
way you can make sure that you do not accidentally assign 
ports to inputs/outputs and Monitor channels at the same 
time.

The state of the “Exclusive Device Ports for Monitor 
Channels” preference is saved together with the Control 
Room presets. Therefore, if you recall a preset, your current 
setting in the Preferences dialog might be overwritten.

Outputs – Main Mix
For the Control Room to function correctly, the Main Mix 
on the Outputs tab should have the widest bus configura-
tion in your project. This is due to the fact that the config-
uration of the Main Mix defines the channel width of the 
Control Room (see also “The Main Mix and the Control 
Room channel” on page 188).

If you have more than one output bus defined, you can 
choose another bus as Main Mix by right-clicking on the 
name of the output and selecting “Set ‘Out’ as Main Mix”. 
The Main Mix is marked by a small speaker icon to the left 
of its name.

Selecting an output bus as Main Mix in the VST Connections window.

Outputs other than the Main Mix are not routed automati-
cally through the Control Room Mixer. However, they can 
be added as additional monitor sources in the VST Con-
nections window (see “Selecting a monitor source” on 
page 188).

Output click enabling

There may be a situation when you want the click to be 
routed always to a specific output bus, regardless of the 
actual Control Room settings, or indeed when the Control 
Room is disabled. In these cases, enable the click on spe-
cific outputs using the Click column on the Outputs tab in 
the VST Connections window.

The Outputs tab showing the Main Mix and a second stereo output that 
is click enabled. 

Disabling the Control Room
Once you have created all the channels for your studio 
configuration, the Control Room functions are available for 
use. If you need to use Nuendo without the Control Room 
functions, you can simply disable the Control Room using 
the On/Off button on the Studio tab of the VST Connec-
tions window. Any channels you have created are saved, 
and when you enable the Control Room again, that config-
uration is reloaded.

You can also create presets for the Control Room config-
uration in the same manner as for inputs and outputs, see 
“Presets” on page 31.

! The click will only be heard in outputs that are as-
signed to device ports. Note that the click can also 
be routed to device ports using the Control Room 
features.

! Be aware that some audio interfaces allow very flexi-
ble routing within the hardware itself. Certain routing 
configurations can cause overloads and possible 
damage to speaker equipment. Consult the hard-
ware documentation for further information.

Click here to disable the Control Room.
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The Control Room Mixer

The Control Room Mixer is where you can access all the features of the Control Room. It is designed to display informa-
tion and controls only for the channels you have defined in the VST Connections window. For example, if you have not 
defined any Studio channels, they will not appear in the Control Room Mixer. If you want to see all possible channels, use 
the Control Room Overview instead (see “The Control Room Overview” on page 193).
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The Control Room Mixer has a variety of controls, some 
that are similar to the Project Mixer and some that are 
unique to Control Room operations. In the following each 
control is briefly described:

1. Input Phase
Each external input and Monitor speaker output has an Input Phase re-
versal switch. When lit, all audio paths within the channel have their 
phase reversed.

2. Input Gain
Each external input, Monitor speaker output and the Talkback input has 
an Input Gain control. When an external input or Monitor becomes ac-
tive, the Gain settings are recalled.

3. Channel inserts
Each channel in the Control Room Mixer has inserts available. For de-
tailed information about inserts in the Control Room Mixer, see “Config-
uring the Control Room Mixer” on page 187.

4. Channel configuration
This displays the current configuration of audio paths in the channel, e. g. 
Stereo or 5.1.

5. Channel labels
This displays the name of the channel as defined in the VST Connections 
window.

6. Expansion controls
There are several arrow buttons that open and close additional panels of 
the Control Room Mixer. By default, the extended panels are hidden. For 
more information, see “Configuring the Control Room Mixer” on page 
187.

7. Control Room and Headphone input selectors
These buttons allow you to select input sources for the Control Room 
and Headphone channels. The choices are External Input, Monitor Mix, or 
any one of the four Studio channels.

8. Use Reference Level
When you click this button, the Control Room level is set to the reference 
level set in the Preferences dialog, e. g. a level for calibrated mixing envi-
ronments such as film dubbing stages. Press [Alt]/[Option] and click this 
button to set the Reference Level setting in the Preferences dialog to the 
current Control Room level.

9. Show Meters/Inserts button
This allows you to switch between the display of meters and inserts for 
the extended Mixer view.

10. Listen Bus AFL/PFL
This button determines whether the signal of a listen-enabled channel is 
routed to the Control Room channel after applying the fader and pan set-
tings (AFL) or before (PFL) (see “Listen mode” on page 161).

11. Listen Activate/Deactivate All Listen
When lit, this indicates that one or more channels in the Project Mixer are 
listen-enabled. Clicking this button deactivates Listen for all channels.

12. Listen DIM Level
This gain control adjusts the volume of the Main Mix (or monitor source) 
when channels have been put in Listen mode. This allows you to keep lis-
ten-enabled channels in context with the Main Mix. If the Listen DIM level 
is set to minus infinity, you will only hear the listen-enabled channels. Any 
other setting leaves the Main Mix at a lower level.

13. DIM Signal
This turns the Control Room level down by a preset amount (the default 
setting is -30 dB). This allows a quick reduction in monitor volume with-
out disturbing the current monitor level. Clicking on the DIM button again 
returns the monitor level to the previous setting. 
The default value can be changed by adjusting the “Main Dim Volume” 
setting in the Preferences dialog (VST–Control Room page).

14. Activate Talkback
Click the TALK button to turn on the Talkback system, allowing commu-
nication between the control room and performers in the studio. There 
are two modes of operation: momentary mode used by clicking and hold-
ing the Talk button, and latch mode where clicking once turns the Talk-
back on until you click it again to turn it off. 

15. Talkback DIM Level
When the Talkback is enabled, this control allows you to determine how 
much the output of all the channels in the Control Room Mixer is reduced. 
This prevents unwanted feedback. If the Talkback DIM level is set to 0 dB, 
no change occurs in the Control Room channels.

16. Cycle Downmix Preset Selection
The Control Room allows four different speaker downmix settings for au-
ditioning with various speaker configurations. Clicking this button cycles 
through the four downmix presets. Various icons appear to show which 
preset is active.

17. Cycle Monitor Selection
Pressing this button changes the Monitor selection to the next available 
set. As Monitors are changed, so are the downmix presets, Monitor inserts, 
Input Gain, and Input Phase controls associated with that Monitor set.

18. Listen Enable for Output
This activates the Listen bus function for either the Control Room or 
Headphone output. If this is not enabled, the Listen bus will not be 
routed to that channel.

19. Listen Level for Output
This level adjustment determines how loud Listen bus signals are when 
routed to the Control Room or Headphone output. Clicking on the num-
ber pops up a fader control for adjustment.

20. Activate channel buttons
These buttons turn each channel’s output on or off. When lit, the channel 
is on.
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21. Channel labels
These labels reflect the names entered in the VST Connections window.

22. Talkback Enable to Studio and talkback amount
In order for Talkback signals to be routed to a Studio, the Talkback En-
able to Studio button must be lit. Clicking on it turns it on or off. When 
Talkback Enable is deactivated, the Talkback DIM setting has no effect 
on this output. 
The value below the button controls the amount of Talkback signal fed to 
the output of each Studio.

23. Metronome Level and Pan
The Level and Pan controls determine how the Metronome will be heard 
in each channel. These controls are independent for each channel.

24. Activate Metronome Click
This determines whether click signals are sent to each channel. When lit, 
click signals will be heard in that output.

25. Channel Level control
This is the main volume for each Control Room output. These faders do 
not affect recording input levels or the Main Mix level for exporting mix-
downs.

26. Studio input selectors
For Studio channels, the input choices are External Input, Aux (from Stu-
dio Sends), or Monitor Mix.

27. Signal Presence Indicators
In the Preferences dialog, there is an option to display these Signal Pres-
ence Indicators as a substitute for the full size meters.

28. External input selectors
Up to six external inputs are available. These buttons determine which ex-
ternal input is currently being used. The names for the external inputs are 
displayed here as they were entered in the VST Connections window.

29. Multiple Monitor Sources button
When this button is activated, you can select multiple monitor sources to 
listen to the sum of several mix busses at the same time.

30. Monitor Source selectors
Using these buttons you can activate/deactivate the available monitor 
sources that were set up in the VST Connections window. For more infor-
mation about selecting a monitor source, see “Selecting a monitor source” 
on page 188.

The Monitor controls in the Control Room Mixer

31. Individual Speaker Solos
Each speaker icon is a solo button for that channel. [Shift]-clicking a 
speaker will solo all the speakers in that row (front or rear). [Ctrl]/[Com-
mand]-clicking on a speaker that is already soloed will mute that speaker 
and solo all other channels. 
Use the speaker solos to test your multi-channel speaker system and en-
sure that the proper channels are routed to each speaker.

32. LFE Solo
The “+” icon solos the LFE channel.

33. Solo Left and Right/Front/Rear Channels
These buttons solo the left and right channels, the front channels, or the 
rear channels (from left to right).

34. Cancel Speaker Solo
This button defeats all speaker solos, resetting them to normal playback.

35. Listen to Rear Channels on Front Monitors
This button solos the rear channels and routes them to the front speakers.

36. Listen to Solo Channels on Center Monitor
When this button is enabled, all speakers that are soloed will be heard in 
the center channel if there is one in the configuration. If not (as with stereo) 
the soloed channel will be heard equally in both left and right speakers.

28.

30.
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33.
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37. Open MixConvert Settings
Clicking on this tab opens the MixConvert plug-in used to downmix 
multi-channel signals for monitoring. With this plug-in you can modify the 
settings for each downmix preset. For more information about the Mix-
Convert plug-in see the chapter “Surround sound” on page 226 and the 
separate PDF document “Plug-In Reference”. 
Note that you can also double-click in the center of the speaker solo area 
to open the MixConvert plug-in.

38. Downmix Preset Selection
With these buttons you can select the downmix preset for the current 
Monitor. Automatic configuration of the downmix settings follows a logi-
cal path. For example, if you have defined one set of 5.1 monitors and an-
other set of stereo monitors, Nuendo will create a 5.1 to stereo downmix 
preset and another downmix to mono. 

39. Downmix labels
This area displays the names of the four downmix presets. You can click 
on a name to change it. A “?” appears when there is no preset defined 
for that downmix.

40. Monitor selection
With these buttons you can select the current Monitor set. Each Monitor 
has its own settings including downmix preset, solo enables, inserts, in-
put gain and input phase. These settings are automatically recalled when 
a Monitor is selected.

41. Monitor labels
This area displays up to four Monitors. The names are entered in the VST 
Connections window when you define a Monitor channel.

Configuring the Control Room Mixer
In order to display more controls in the Control Room 
Mixer, the small arrows in the lower left and right corners 
can be clicked to open or close the extended speaker 
controls on the right (“Show Right Strip”) and the External 
Input and Talkback controls on the left (“Show Left Strip”).

The arrow in the upper right corner of the Control Room 
Mixer (“Show Extended View”) extends the Mixer vertically 
to display meters and inserts. A second arrow appears 
above the inserts and meter display. Extending the Mixer 
using this arrow (“Show Routing View”) exposes the Input 
Gain and Input Phase controls, the channel configuration 
and the name of each channel. Each panel can be closed 
by clicking the corresponding down arrow.

The different Control Room Mixer panels are handled in 
the same way as the Project Mixer panels, see “Configur-
ing the Mixer” on page 154.

Control Room inserts and meters

In the extended view of the Control Room Mixer the 
meters are visible. They function the same way as the 
ones in the Project Mixer.

When you click the Show Meters/Inserts button to the right 
of the meters display, the view changes to show inserts in-
stead of meters. Alternatively, these can also be displayed 
by deactivating the Show Meters option on the Window 
submenu of the Control Room Mixer context menu.

Each Control Room channel has a set of inserts configured 
as six pre-fader and two post-fader inserts. External input 
channels only have the six pre-fader inserts and Monitor 
channels have eight inserts (post Control Room fader).

! You can also use the Window submenu of the Con-
trol Room Mixer context menu to show/hide the dif-
ferent panels, just as in the Project Mixer.
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If you do not wish to see full sized meters but still want 
some indication of signal activity, activate the “Signal 
Presence Indicators” option in the Preferences dialog 
(VST–Control Room page). They will be displayed next to 
the input selection buttons and indicate signal presence 
for all inputs.

Control Room Mixer channels with active Signal Presence indicators

Inserts for external inputs

Each external input has its own set of six inserts. By click-
ing the button next to the name of an external input on the 
left of the Mixer window, the inserts associated with that 
channel are displayed in the extended view.

Inserts for the Talkback channel

The Talkback channel has a separate set of eight inserts. 
In order to view and adjust them, the Talkback must be en-
abled via the TALK button located in the bottom right sec-
tion of the Control Room Mixer. Click once on the TALK 
button to activate the Talkback system. The inserts for ex-
ternal inputs are now replaced with the Talkback inserts. 
Once the Talkback is disabled, the view reverts to external 
input inserts.

Monitor inserts

Each Monitor channel has a set of eight inserts, all of 
which are post Control Room fader. The Monitor inserts 
are most useful for surround decoding or brickwall limiting 
to protect sensitive monitor speakers.

The Main Mix and the Control Room channel
The channel configuration of the Main Mix determines the 
channel configuration of the Control Room channel. 
Switching between a project that has a stereo Main Mix to 
a project that has a 5.1 Main Mix will cause the Control 
Room channel in the Control Room Mixer to change from 
a stereo to a 5.1 configuration.

The Control Room configuration also determines the lay-
out of the Speaker Solo panel. If the channel is stereo, the 
solo panel only contains a left and a right speaker.

Any external input that has more channels than the Main 
Mix will not be heard correctly when routed to the Control 
Room channel. Only the channels available will be heard.

If a 5.1 external input is routed to a stereo Control 
Room channel, only the left and right channels are heard 
even if a 5.1 Monitor is selected. Only two channels can be 
routed through a stereo Control Room channel. You can 
use an instance of MixConvert on the external input’s in-
serts to downmix the material to stereo in order to hear it.

Selecting a monitor source
In the section on the bottom left of the Control Room 
Mixer you can select which monitor source(s) are routed 
to the Control Room.

Initially, only the Main Mix appears in this section. If you 
want to add further sources (e. g. separate submixes or 
stems) you need to set up monitor sources in the VST Con-
nections window, see “Monitor sources” on page 181.

Depending on whether you want to listen to several sub-
mixes at the same time or to an individual submix alone, 
you can activate several monitor sources at the same time 
(summing mode) or switch between different monitor 
sources (exclusive mode).

! You can easily identify the inserts for the Talkback 
since they have six pre-fader and two post-fader in-
serts while the external inputs only have six pre-fader 
inserts. If the Control Room Mixer is fully expanded, 
the name displayed at the very top of the Mixer re-
flects which channel is currently visible in the ex-
tended panel.

“Multiple Monitor Sources” button

Available Monitor Sources
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Activating several monitor sources at the same time

By activating several monitor sources, you will hear the 
sum of the selected busses or group channels. For exam-
ple, this is useful to listen to the final mix without having to 
route the individual submixes to the Main Mix first. There 
are two ways to achieve this:

• Activate the “Multiple Monitor Sources” button and suc-
cessively click on the monitor sources that you want to in-
clude. 

• Hold down [Shift] and click on the monitor sources that 
you want to include.
This modifier also works if the “Multiple Monitor Sources” button is deac-
tivated.

Switching between individual monitor sources

If you want to listen to only one monitor source at the 
same time, you can switch between exclusive sources:

• Deactivate the “Multiple Monitor Sources” button and 
click on the monitor source that you want to listen to.
With each click on another source you hear the new source only. 

• Hold down [Alt]/[Option] and click on the monitor 
source that you want to listen to.
This modifier also works if the “Multiple Monitor Sources” button is acti-
vated.

To toggle between summing mode and exclusive 
mode or to switch to another monitor source, you can also 
define additional key commands in the Key Commands di-
alog (Control Room category). For more information about 
defining key commands, see the chapter “Key commands” 
on page 580.

Suggested settings
With all the versatility that the Control Room provides 
there are also opportunities for confusion when first set-
ting up the Control Room. The following list contains sug-
gestions that can help to quickly set up the Control Room 
and get started for recording and mixing.

• If you do not have a master recording device and only use the 
Export Mixdown function to create final mix files, set your Main 
Mix output to “Not Assigned”. This eliminates many confusing 
errors and unpredictable behavior since outputs and Control 
Room Monitors can share hardware outputs. The Main Mix is 
automatically routed to the Control Room channel and will not 
be affected.

• Create one stereo Monitor to familiarize yourself with the Con-
trol Room level controls, DIM settings, the Listen bus, and 
other monitoring features. Once you have become acquainted 
with some of these functions, create additional Monitors for 
every set of speakers you intend to use.

• Use the inserts on Monitor channels for surround decoding 
and bass management plug-ins among other things.

• Use the inserts on the Control Room channel for metering and 
spectral analysis plug-ins. All solos including the Listen bus 
will come through the Control Room channel allowing analysis 
of individual sounds.

• A brickwall limiter in the last insert of the Control Room chan-
nel can prevent accidental overloads and damage to speaker 
systems.

• Use the inserts for the Talkback channel to control the dynam-
ics of the talkback microphone. This will help protect perform-
ers’ hearing and ensure that everyone can be heard over the 
talkback microphone.

• Use the Gain settings on the external inputs to level balance 
CD players and other sources to the Main Mix level for A/B 
comparisons.

• Use the Gain settings on each Monitor to level balance all your 
monitor systems. Switching between sets of speakers will re-
sult in the same playback volume.

• Use the calibrated Control Room level for film or DVD mixing. 
Set this level to the proper speaker volume as determined by 
the mixing standard you choose to follow.
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Control Room preferences
There are several preferences for the Control Room Mixer. 
These are found in the Preferences dialog (VST–Control 
Room page).

Most of these preferences deal with what options are visi-
ble in the Control Room Mixer. This allows you to custom-
ize the layout of the Mixer and only have the controls 
visible that you use the most.

The other preferences have the following functionality:

• Show Control Room Volume in Transport Panel
This option makes the small fader at the right-hand side of the Transport 
panel control the Control Room level. When this option is not activated 
(or the Control Room is disabled), that fader controls the level of the 
Main Mix bus.

• Disable Talkback during Recording
This option deactivates the Talkback channel when the transport enters 
record mode. It is advisable to set the Talkback DIM level to 0 dB when 
using this feature so as not to radically change the mix level when punch-
ing in and out of record mode.

• Use Phones Channel as Preview Channel
When activated, the Headphone output is used for Preview options such 
as import preview, scrubbing, offline process preview and certain Sam-
ple Editor operations. Note that when using the Headphones output for 
preview, the Control Room channel will no longer output preview audio.

• Dim Studio during Talkback
When this option is enabled, the cue mix heard in a Studio will be 
dimmed (by the amount set in the Talkback Dim Level field (below the 
TALK button) for as long as the Talkback channel is used. When dis-
abled, the cue mix level remains the same during Talkback.

• Exclusive Device Ports for Monitor Channels
When activated, the port assignment for Monitor channels is exclusive 
(see “Exclusive assignment of Monitor channels” on page 182).

• Reference Level 
This setting determines the Control Room level used when the Refer-
ence Level button is activated.

• Main Dim Volume 
This is the amount of gain reduction applied to the Control Room chan-
nel when the DIM button is activated.

Studios and Studio Sends
Studio Sends are displayed in the Nuendo Project Mixer 
and the Inspector. Each Studio Send is intended for the 
creation of a discrete cue mix for performers to listen to 
during recording. Studio Sends are essentially stereo aux 
sends that are routed to Studio outputs in the Control 
Room Mixer. There are up to four Studios and Studio 
Sends available.

Configuring Studio Sends
Studio Sends only become available when a Studio chan-
nel has been created in the VST Connections window. 
Otherwise they remain grayed out. For every Studio de-
fined in the VST Connections, each channel in the Project 
Mixer has an additional aux send with level, pan and pre/
post-fader selection. This aux send is used to create a mix 
for a performer to listen to while recording.
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• In the Project Mixer, the Studio Sends are accessed by 
choosing the Studio Sends option from the View options 
pop-up menu in each channel or by clicking the star icon 
(“Show Studio Sends”) on the common panel of the ex-
tended Project Mixer.

The Studio Sends view in the Project Mixer

• In the Inspector, a Studio Sends tab can be found. This 
displays all Studio Sends for the selected track.
Please note that not all Inspector sections are available by default. To 
show/hide a section, right-click on an Inspector section and select/dese-
lect the corresponding option on the context menu.

The Studio Sends tab in the Inspector

Each Studio can have a unique name in order to help 
identify what it is being used for. For example, the four 
Studios could be named as follows:

• Vocalist Mix
• Guitarist Mix
• Bassist Mix
• Drummer’s Mix

The name of each Studio is displayed in the Control Room 
Mixer. To hear the Studio Sends mix in the Studio output, 
the input selector for each Studio must be set to “Aux”.

Setting up a Studio cue mix
The Studio Sends are very flexible. There are several ways 
to create a cue mix for each Studio in a very fast and effi-
cient manner. Simple “more me” mixes and more complex 
discrete mixes are easily accommodated by the Studio 
Sends.

Using fader and pan settings from the Project Mixer

You can create a cue mix from the fader and pan levels al-
ready used in the Project Mixer and then alter them to 
meet the needs of an individual performer. You can do this 
with any single channel or group of channels at any time. 

A Studio channel in 
the Control Room 
Mixer with its input 
set to Aux.
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To copy fader and pan information from the main mix, pro-
ceed as follows:

1. In the Project Mixer, select all the channels that you 
wish to copy settings from.
The following operations affect only selected channels.

2. In the Control Room Mixer, right-click anywhere on a 
Studio channel strip to open the context menu that has the 
Studio’s name as a submenu.
This submenu contains all the Studio Send functions for that Studio. If 
you open the context menu outside of a Studio channel strip, the sub-
menu will be for All Studios. 

The Control Room Mixer’s context menu

3. Choose the “Use Current Mix Levels” option to copy 
the fader levels on the selected tracks to the Studio 
Sends.
This option sets all Studio Send levels for the selected tracks to the 
same level as the main channel fader. It also changes the Studio Send 
status to pre-fader so that changes in the main mix do not affect the Stu-
dio Sends.

4. Choose the “Use Current Pan Settings” option to 
copy pan information from the main mix to the Studio 
Sends on selected tracks.
Studio Sends are either mono or stereo. If the Send is mono, the pan 
setting will still be copied. However, the output of the Studio Send will 
be a sum of the left and right channels.

5. Choose the “Enable Studio Sends” option to activate 
the Sends on selected channels.
By default, Studio Sends are not enabled even when level and pan infor-
mation is copied to them. You must enable them in order to hear the Stu-
dio cue mix.

By copying the level and pan information from the main 
mix to the Studio Sends, a rough balance can be created 
in a matter of moments. Next, you may alter the level and 
pan settings on any channel’s Studio Sends to change the 
mix to meet the performer’s needs. This may require in-
creasing the volume of the performer herself. This is often 
referred to as a “more me” mix.

Adjusting the overall Studio Send level

Levels in the main mix are often optimized for the loudest 
signal level possible without clipping. However, when you 
are creating a “more me” mix, you may find that there is not 
enough headroom available in the Studio Send to turn up 
channels without clipping becoming a possibility.

Fortunately, the Studio Sends have an option to adjust 
multiple send levels at the same time, allowing you to keep 
the blend intact while lowering the overall volume to make 
room for “more me” signals.

Once you have created a Studio Send mix, proceed as 
follows to adjust their relative levels:

1. Select all the channels you wish to modify.
Only selected channels are affected by the context menu commands.

2. Right-click anywhere on the Studio channel strip in the 
Control Room Mixer to open the context menu for that 
Studio channel. 
You may also use the context menu outside of the Studio channel strip to 
adjust all four Studio Sends on the selected channels at the same time.

3. Choose the “Change Studio Sends Level” option from 
the Studio submenu.
This will bring up a gain window with a checkbox that reads “Relative 
Mode”. Make sure this is activated if you want to adjust already existing 
levels.

4. Either use the up and down arrow buttons or click on 
the numeric readout to open a pop-up fader and adjust 
the gain as necessary.
The level of all selected Studio Sends will be adjusted by the amount 
shown here. For example, if the amount reads -3 dB, each Studio Send 
level is reduced by 3 dB.

5. Click OK to change the level.
It is possible to view these changes as they occur if you have the Project 
Mixer open and the extended view set to show the Studio Sends.
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Using Studio Sends from outputs

Each output also has Studio Sends. Studio Sends from 
the Main Mix output can be used to route the main mix in-
stantly to the Studio output. 

Any level changes made to the main mix are reflected in 
the signal sent by the Studio Send. Setting the level lower 
than 0 dB can leave headroom for “more me” signals in the 
Studio channel output.

Post-Fader Studio Sends

It is also possible to use the Studio Sends as post-fader 
aux sends. This is another way for the cue mix to follow 
changes made to the Main Mix. The Reset function is very 
helpful in this regard.

To reset the Studio Sends to the post-fader default level 
of -6 dB, proceed as follows:

1. Select all the channels you wish to reset.
Studio Send commands only work on selected channels.

2. On the Studio channel strip right-click to open the 
context menu. In the Studio submenu, select the “Reset 
Studio Sends” command.
If you open the context menu in other areas of the Control Room Mixer 
besides the Studio channel strips, the context menu commands will af-
fect all Studios at the same time.

3. Selecting the “Reset Studio Sends” option changes 
the Send level of all selected channels to -6 dB and sets 
the signal source to post-fader.
The -6 dB level is designed to allow for headroom for “more me” signals 
in the Studio outputs.

Once all Studio Sends have been set to -6 dB, post-fader, 
any changes to the main mix will also change the Studio 
mix. For “more me” channels, simply turn up the level on 
that channel or even set the signal to pre-fader for abso-
lute control.

Studio Send cue mix summary

Using various combinations of the above techniques al-
lows you to create complex discrete cue mixes for per-
formers in very little time. Modifications to these mixes can 
occur in the Project Mixer or the Inspector, giving you the 
most accessibility for quick changes.

To familiarize yourself with how the Studio Sends work, 
open the extended Project Mixer and set the view to the 
Studio Sends. Follow the above examples and watch how 
the Studio Sends react to various commands. This should 
help you get a feel for how they function and increase the 
workflow productivity of recording sessions.

The Control Room Overview
You can access the Control Room Overview from the De-
vices menu. The Control Room Overview is designed to 
display the current configuration of the Control Room. The 
window shows all possible channels, with active channels 
highlighted once they have been created in the VST Con-
nections window. Channels that are grayed out have not 
been defined in the VST Connections window.

! If you deactivate the Relative Mode option, all Studio 
Sends are set to the same absolute level. While the 
dialog window is still open, you may activate the Rel-
ative Mode checkbox again and reload the previous 
relative levels. Only when you click OK, the level set-
tings are made permanent. Clicking Cancel returns 
all send levels to their previous settings.
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The Control Room Overview allows you to see the signal 
flow through the Control Room Mixer. All the routing func-
tions of the Control Room Mixer are duplicated in the 
Overview.

Open the Control Room Mixer and the Control Room Over-
view windows side by side. As you operate the controls in 
the Mixer you will see the various pale squares light up in 
the Overview, indicating changes in signal flow. You can 
also click the squares in the Overview and watch the con-
trols in the Mixer reflect the changes in signal flow.

Direct Monitoring and latency
The Control Room and Studio Sends functions use the in-
ternal processing power of the host computer system for 
all routing and processing, which means they are subject 
to the computer’s latency.

When recording with several performers at once, a system 
capable of running at very low ASIO buffer settings will be 
necessary to take full advantage of all the Studio Send 
features. 

Studio Sends are not capable of controlling the Direct 
Monitoring features of various audio hardware interfaces. 
This means that unless the internal latency of the system is 
very low (128 samples or less), monitoring of record-en-
abled tracks through the Studio Sends will have some de-
lay that can affect performers during recording.

In the situation where internal latency is too much for 
record monitoring, it is advisable to use the Studio Sends 
for monitoring of tracks that have already been recorded 
and use normal Direct Monitoring for tracks currently be-
ing recorded.
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About this chapter
Nuendo comes with a number of effect plug-ins included. 
This chapter contains general details about how to assign, 
use and organize effect plug-ins. The effects and their pa-
rameters are described in the separate PDF document 
“Plug-in Reference”.

Overview
There are three ways to use audio effects in Nuendo:

• As insert effects.
An insert effect is inserted into the signal chain of an audio channel, which 
means that the whole channel signal passes through the effect. This makes 
inserts suitable for effects for which you do not need to mix dry and wet 
sound, e. g. distortion, filters or other effects that change the tonal or dy-
namic characteristics of the sound. You can have up to eight different in-
sert effects per channel (and the same is true for input and output busses 
– for recording with effects and “master effects”, respectively).

• As send effects.
Each audio channel has eight sends, each of which can be freely routed 
to an effect (or to a chain of effects). Send effects are practical for two 
reasons: you can control the balance between the dry (direct) and wet 
(processed) sound individually for each channel using the sends, and 
several different audio channels can use the same send effect. In Nu-
endo, send effects are handled by means of FX channel tracks. 

• By using offline processing.
You can apply effects directly to individual audio events – this is de-
scribed in the chapter “Audio processing and functions” on page 263.

About VST 3 
The new VST 3 plug-in standard offers many improve-
ments over the previous VST 2 standard, yet retains full 
backwards compatibility, i. e. you will still be able to use 
your previous VST effects and presets.

In the program, effects compatible with previous VST ver-
sions will be easily recognized:

Nuendo is able to run plug-ins originally developed for dif-
ferent platforms: you can use a 32-bit plug-in under Win-
dows Vista/Windows 7 64 bit, and you can use plug-ins 
developed for Mac PPC on Mac Intel systems.

As the use of 32-bit plug-ins on 64-bit computers affects 
the computer performance, these will be marked by an 
icon in the plug-in menus.

Please note that this functionality is provided to allow 
you to load older projects including their original plug-ins 
on current computers. However, the plug-ins will require 
higher CPU performance when compared to their native 
platform. Therefore, it is recommended to use 64 bit ver-
sions or Mac Intel (Universal Binary) versions of such 
plug-ins or instruments once available.

VST preset management

From a user perspective, the main difference between 
VST 2 and VST 3 is in the effect preset management. The 
FXP/FXB files used in VST 2 have been replaced by 
VST 3 Presets (extension “.vstpreset”). Using the preset 
management features, you can assign various attributes to 
your effect presets to help you quickly find the right patch. 
You can also preview effect presets before you load them. 
A large number of presets for effects are included with the 
program. If you have any previous VST plug-ins installed 
on your computer, you can still use them, and you can also 
convert their programs to VST 3 presets, see “Effect pre-
sets” on page 209.

Smart plug-in processing

Another feature of the VST3 standard is “smart” plug-in 
processing. Previously, any loaded plug-in was processing 
continuously, regardless of whether a signal was present 
or not. In VST3, processing by a plug-in can be disen-
gaged if there is no signal present. This can greatly reduce 
the CPU load, thus allowing for more effects to be used. 

This is achieved by activating the “Suspend VST3 plug-in 
processing when no audio signals are received” option in 
the Preferences dialog (VST–Plug-ins page).

When this is activated, VST 3 plug-ins will not consume 
CPU power on silent passages, i. e. when no audio data 
runs through them.

! This chapter describes audio effects, i. e. effects that 
are used to process audio, group, VST instrument 
and ReWire channels. 

An effect compatible 
with a previous VST 

version

A VST 3 effect
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However, be aware that this can lead to a situation where 
you added more plug-ins on “transport stop” than the sys-
tem can handle on playback. Therefore, you should always 
find the passage with the largest number of events playing 
simultaneously to make sure that your system offers the 
required performance.

Activating this option can increase your system perfor-
mance a lot in certain projects, but it also makes it more 
unpredictable whether the project can play back fine on 
any timecode position of the project. 

About side-chain inputs

Several VST3 effects feature side-chain inputs. This means 
that the operation of the effect can be controlled via exter-
nal signals routed to the side-chain input. The effect pro-
cessing is still applied to the main audio signal, see “Using 
the side-chain input” on page 207.

About plug-in delay compensation
A plug-in effect may have some inherent delay or latency. 
This means that it takes a brief time for the plug-in to pro-
cess the audio fed into it – as a result, the output audio 
will be slightly delayed. This especially applies to dynam-
ics processors featuring “look-ahead” functionality. 

Nuendo provides full plug-in delay compensation through-
out the entire audio path. All plug-in delays are compen-
sated for, maintaining the sync and timing of all audio 
channels.

Normally, you do not have to make any settings for this. 
However, VST3 dynamics plug-ins with look-ahead func-
tionality have a “Live” button, allowing you to disengage 
the look-ahead to minimize latency, if they are to be used 
during realtime recording (see the separate PDF docu-
ment “Plug-in Reference”).

You can also constrain the delay compensation, which is 
useful to avoid latency when recording audio or playing a 
VST instrument in real time, see “Constrain Delay Com-
pensation” on page 225.

About tempo sync
Plug-ins can receive timing and tempo information from 
the host application (in this case, Nuendo). Typically, this 
is used to synchronize certain plug-in parameters (such as 
modulation rates or delay times) to the project tempo.

• This information is automatically provided to any VST 
plug-in (2.0 or later) that “requests it”.
You do not have to make any special settings for this.

• You set up tempo sync by specifying a base note value. 
You can use straight, triplet or dotted note values (1/1 to 1/32).

Please refer to the separate PDF document “Plug-in Ref-
erence” for details about the included effects.

Insert effects

Background
As the name implies, insert effects are inserted into the 
audio signal path – this means that the audio channel data 
will be routed through the effect. You can add up to eight 
different insert effects independently for each audio-re-
lated channel (audio track, group channel track, FX chan-
nel track, VST instrument channel or ReWire channel) or 
bus. The signal passes through the effects in series from 
the top downwards, with the signal path shown below:

Input gain

Insert effect 1

Insert effect 2

Insert effect 3

Insert effect 6

EQ

Volume (fader)

Insert effect 7

Insert effect 8

Insert effect 4

Insert effect 5
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As you can see, the last two insert slots (for any channel) 
are post-EQ and post-fader. Post-fader slots are best 
suited for insert effects where you do not want the level to 
be changed after the effect, such as dithering (see “Dith-
ering” on page 201) and maximizers – both typically used 
as insert effects for output busses.

Applying several effects on several channels may be 
too much for your CPU to handle! If you want to use the 
same effect with the same settings on several channels, it 
may be more efficient to set up a group channel and to ap-
ply your effect only once, as a single insert for this group. 
You can use the VST Performance window to keep an eye 
on the CPU load.

Routing an audio channel or bus through 
insert effects
Insert effect settings are available in the Mixer (in extended 
mode), the Channel Settings window and the Inspector. 
The examples below show the Channel Settings window, 
but the procedures are the same for all the inserts sections:

1. Bring up the Channel Settings window.
By default, the inserts are located to the far left.

2. Pull down the effect type pop-up menu for one of the 
insert slots, and select an effect.

The effect is loaded and automatically activated and its 
control panel opens. You can open or close the control 
panel for an effect by clicking the “e” button for the insert 
slot.

• If the effect has a dry/wet Mix parameter, you can use 
this to adjust the balance between the dry signal and the 
effect signal.
See “Editing effects” on page 208 for details about editing effects.

• To remove an effect, pull down the effect type pop-up 
menu and select “No Effect”.
To reduce the CPU load, do this for all effects that you do not intend to 
use.

• You can add up to 8 insert effects per channel this way.

• You can reorder the effects by clicking in the area above 
the name field and dragging the effect onto another slot.

• You can copy an effect into another effect slot (for the 
same channel or between channels) by holding down [Ctrl]/
[Command] and dragging it onto another effect slot.

• You can apply or remove an effect to or from all the se-
lected channels at once by holding down [Shift]-[Alt]/[Op-
tion] and selecting the desired effect from any of the effect 
slots.

Deactivating vs. bypassing
If you want to listen to the track without having it pro-
cessed by a particular effect, but do not want to remove 
this effect completely from the insert slot, you can either 
deactivate or bypass it.

Deactivating means to terminate all processing, whereas 
bypassing means to play back only the unprocessed origi-
nal signal – a bypassed effect is still processing in the 
background. Bypassing allows for crackle-free comparison 
of the original (“dry”) and the processed (“wet”) signal.

• To deactivate an effect, click the blue button on the left 
above the insert slot.
If you hold down [Shift]-[Alt]/[Option] when clicking the button, you acti-
vate or deactivate this effect slot for all selected channels.

• To bypass an effect, click its Bypass button (the middle 
button above the insert slot).
When an effect is bypassed, this button is yellow.

This effect is activated, and its control 
panel is open.

This insert effect is bypassed.
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• To bypass all inserts for a track, click the global bypass 
button. 
This button can be found at the top of the Inserts section in the Inspector 
or the Channel Settings window. It lights up in yellow to indicate that the 
inserts of this track are bypassed. In the track list and the channel strip in 
the Mixer, the Inserts State button will also light up in yellow.

Insert effects in the channel overview
If the “Channel” section is selected in the Inspector or the 
“Channel Overview” view mode is selected in the extended 
Mixer, you will get an overview of which insert effects, EQ 
modules and effect sends are activated for the channel.

You can activate or deactivate individual insert effect slots 
by clicking the corresponding number (in the top part of 
the overview).

The channel overview in the Inspector

Using effects in multi-channel configurations
Whether an effect plug-in supports mono, stereo, or multi-
channel processing depends on the capabilities of the cor-
responding plug-in. Regardless of this, all VST2 and VST3 
plug-ins can be inserted on tracks with a multi-channel 
configuration. Surround-capable plug-ins are applied to all 
speaker channels (or a subset of these), while mono or ste-
reo effects can only process one or two channels.

For example, if you insert a plug-in on a 5.1 track, Nuendo 
tries to apply a 5.1 configuration to this plug-in. If the plug-
in is surround capable, this is accepted. However, if you in-
sert a stereo insert effect, the first speaker channels of the 
track (L and R) are routed through the effect’s available 
channels, and the other channels of the track are left un-
processed.

Setting up the channel configuration for the plug-in

Even though many plug-ins can be applied to several or all 
speaker channels in a surround configuration, this may not 
always be what you want. For example, you might want to 
apply a compression plug-in only to the Center channel in 
a 5.1 mix or apply reverb to everything except the LFE 
channel.

Nuendo offers you all the flexibility you need. From a pop-
up menu in the plug-in panel you can choose a setup with 
less channels, and you can also modify the effect routing 
manually in the Routing Editor.

On the Effect Routing pop-up menu you can change the channel 
configuration of the plug-in.

The first entry (default) is always identical with the channel 
configuration of the track. Below this you will find all pos-
sible channel subsets of the default configuration that are 
supported by Nuendo. 

Not all plug-ins support all the channel configurations 
offered by Nuendo. If you select a configuration that is not 
supported by a plug-in, it will automatically chooses a dif-
ferent configuration.

The blue color of inserts 1 and 2 and the 
blue Inserts State button in the channel strip 
indicate that this track has active inserts.
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Using the Routing Editor

If the Effect Routing pop-up menu does not contain the 
configuration that you need, you can use the Routing Editor. 
It allows you to freely set up the routing for the individual 
channels. For example, if you want to apply an effect only to 
the right speaker, you can choose the Mono configuration 
from the pop-up menu and use the Routing Editor to move 
the connection from the left speaker (L) to the right (R).

• To open the Routing Editor, select “Open Routing Edi-
tor…” on the Effect Routing pop-up menu for the plug-in 
in question.

The columns in the diagram represent the channels in the 
current configuration, with signals passing from top to 
bottom. The gray field in the middle represents the actual 
effect plug-in.

• The squares above the effect represent inputs to the effect 
plug-in.

• The squares below the effect represent outputs from the ef-
fect plug-in.

• A line that passes through the effect (with no square input/
output indicators) represent a bypass connection – the audio 
on that speaker channel passes the effect without being pro-
cessed.

• A “broken” line indicates a broken connection – the audio on 
that speaker channel will not be sent to the output at all.

Here, the effect will process the L and R channels. The Ls, Rs, and C 
channels are not processed, while the Lfe connection is broken.

Operations

You can change the input/output assignment of the chan-
nels by moving connections to the left or right. To do this, 
use the arrow buttons to the right.

• The upper arrow buttons move the input connections, 
and the lower arrow buttons move the output connections.
If the Link checkbox is activated, the input and output connections are al-
ways moved together. This is the mode to use when you simply want to 
process other channels than the default.

• If you move inputs or outputs independently, you create 
a “cross-connection”.

The audio on the Ls-Rs channels is processed in the plug-in and output 
on the L-R channels. Since the L-R channels are bypassed, this means 
the final L-R output will contain both the original L-R signals and the 
processed Ls-Rs signals.

• If a channel is bypassed (a straight line is shown through 
the plug-in), you can click on the line to break the connec-
tion.
Click again to replace the broken connection with a bypass.

• Clicking Reset takes you back to the original setup.

Changes you make in this window are audible immedi-
ately.

Insert Routing in the Channel Settings window

You can also open the Routing Editor via the Channel 
Settings window of the audio track on which the plug-in is 
inserted. To do so, make sure that the Insert Routing sec-
tion is shown (via the Customize View submenu of the 
window’s context menu). You can then double-click on 
the signal diagram to open the Routing Editor.
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Adding insert effects to busses
All input and output busses have eight insert slots, just like 
regular audio channels. The procedures for adding insert 
effects are the same.

• Adding insert effects to an input bus allows you to 
record with effects.
The effects will become a permanent part of the recorded audio file (see 
the chapter “Recording” on page 90).

• Insert effects added to an output bus will affect all audio 
routed to that bus, like a “master insert effect”.
Typically you would add compressors, limiters, EQ or other plug-ins to 
tailor the dynamics and sound of the final mix. Dithering is a special case, 
as described below.

Input and output busses only appear as tracks in the track 
list after their automation Write buttons have been activated 
at least once. Only then will you be able to make Inserts set-
tings for the corresponding busses in the Inspector section. 
However, you can always make Inserts settings in the 
Channel Settings window and the extended Mixer panel.

Dithering
Dithering is a method for controlling the noise produced 
by quantization errors in digital recordings. The theory be-
hind this is that during low level passages, only a few bits 
are used to represent the signal, which leads to quantiza-
tion errors and hence distortion. 

For example, when “truncating bits”, as a result of moving 
from 24 to 16 bit resolution, quantization errors are added 
to an otherwise immaculate recording. By adding a spe-
cial kind of noise at an extremely low level, the effect of 
these errors is minimized. The added noise could be per-
ceived as a very low-level hiss under exacting listening 
conditions. However, this is hardly noticeable and much 
preferred to the distortion that otherwise occurs.

When should I use dithering?

• Consider dithering when you mix down to a lower reso-
lution, either in realtime (during playback) or with the Ex-
port Audio Mixdown function. 
A typical example is when you mix down a project to a 16-bit stereo au-
dio file for audio CD burning.

What is a “lower resolution” then? Well, Nuendo uses 32-
bit float resolution internally, which means that all integer 
resolutions (16 bit, 24 bit, etc.) are lower. The negative ef-
fects of truncation (no dithering) are most noticeable when 
mixing down to 8 bit, 16 bit and 20 bit format; whether to 
dither when mixing down to 24 bits is a matter of taste.

Applying dithering

1. Open the VST Output Channel Settings window by 
clicking the “e” button for the Output channel in the Mixer.
You can also display the Inserts section in the extended Mixer pane.

2. Open the Inserts pop-up menu for slot 7 or 8.
The two last Insert effect slots (for all channels) are post-fader, which is 
crucial for a dithering plug-in. The reason is that any master gain change 
applied after dithering would bring the signal back to the internal 32 bit 
float domain, rendering the dithering settings useless.

3. Select the included UV22HR dithering plug-in from 
the pop-up menu.

The included dithering plug-ins and their parameters are 
described in the separate PDF document “Plug-in Refer-
ence”. If you have installed another dithering plug-in that 
you prefer, you can of course select this instead.

4. Make sure that the plug-in is set to dither to the cor-
rect resolution.
This would be the resolution of your audio hardware (on playback) or the 
desired resolution for the mixdown file you want to create (as set in the 
Export Audio Mixdown dialog, see the chapter “Export Audio Mixdown” 
on page 473).

5. Use the other parameters in the control panel to set up 
the dithering to your liking.

Using group channels for insert effects
Like all other channels, group channels can have up to 
eight insert effects. This is useful if you have several audio 
tracks that you want to process through the same effect 
(e. g. different vocal tracks that you want to be processed 
by the same compressor). 
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Another special use for group channels and effects is the 
following:

If you have a mono audio track and want to process this 
through a stereo insert effect (e. g. a stereo chorus or an 
auto panner device), you cannot just insert the effect as 
usual. This is because the audio track is in mono – the 
output of the insert effect will be in mono as well, and the 
stereo information from the effect will be lost.

One solution is to route a send from the mono track to a 
stereo FX channel track, set the send to pre-fader mode 
and lower the fader completely for the mono audio track. 
However, this makes mixing the track cumbersome, since 
you cannot use the fader.

Here is another solution:

1. Create a group channel track in stereo and route it to 
the desired output bus.

2. Add the desired effect to the group channel as an in-
sert effect.

3. Route the mono audio track to the group channel.

Now the signal from the mono audio track is sent directly 
to the group, where it passes through the insert effect, in 
stereo.

Freezing (rendering) insert effects for a track
Effect plug-ins can sometimes require a lot of processor 
power. If you are using a large number of insert effects for 
a track, you may reach a point where the computer cannot 
play back the track properly (the CPU overload indicator 
in the VST Performance window lights up, you get crack-
ling sounds, etc.).

To remedy this, you can freeze the track, by clicking the 
Freeze button in the Inspector.

• The Freeze Channel Options dialog opens, allowing you 
to set a “Tail” time in seconds.
This adds time at the end of the rendered file to allow reverb and delay 
tails to fully fade out.

• The program now renders the output of the track, in-
cluding all pre-fader insert effects, to an audio file.
This file is placed in the “Freeze” folder within the Project folder (Win-
dows). On the Mac, the Freeze folder is stored under “User/Documents”.

• The frozen audio track is locked for editing in the Project 
window.
The frozen insert effects cannot be edited or removed and you cannot 
add new insert effects for the track (except post-fader effects).

• On playback, the rendered audio file is played back. 
You can still adjust the level and panning in the Mixer, 
make EQ settings and adjust the effect sends.
In the Mixer, the channel strip for a frozen track is indicated by a “snow 
flake” symbol on the volume fader handle.

After freezing the Inserts for a track, you hear the track 
play back as before but the insert effects do not have to 
be calculated in real time, easing the load on the computer 
processor. Typically, you would freeze a track when it is 
finished and you do not need to edit it anymore.

• You can only freeze audio tracks this way, not group 
channel tracks or FX channel tracks.

• The last two insert effects will not be frozen. This is 
because these are post-fader insert slots.

• You can also freeze VST instruments and their insert 
effects – see the chapter “VST instruments and instru-
ment tracks” on page 215.

Unfreezing

If you need to edit the events on a frozen track or make 
settings for the insert effects, you can unfreeze the track:

1. Click the Freeze button in the Inspector for the track.
You will be asked whether you really want to unfreeze the channel and if 
you wish to keep or delete the freeze files.

2. Click “Unfreeze” or “Keep Freeze files”.
This reactivates the frozen insert effects. Clicking “Keep Freeze Files” 
will unfreeze the channel but not delete the freeze files. After editing, you 
can freeze the track again.
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Send effects

Background
As their name implies, send effects are outside of an audio 
channel’s signal path, i. e. the audio data to be processed 
must be sent to the effect (as opposed to insert effects, 
which are inserted into the channel’s signal path).

To this end, Nuendo provides FX channel tracks. When 
you have created such a track, it is added to the track list 
and can be selected as a routing target in the Send slots 
of audio channels.

• When selecting an FX channel track in one of the send 
slots of an audio channel, the audio is sent to the FX chan-
nel and through any insert effects set up for it.
Each audio channel has eight sends, which can be routed to different FX 
channels, and thus different FX channel insert effect configurations. You 
control the amount of signal sent to the FX channel by adjusting the ef-
fect send level.

• If you have added several effects to the FX channel, the 
signal passes through the effects in series, from the top 
(the first slot) downward.
This allows for “custom” send effect configurations – e. g. a chorus fol-
lowed by a reverb followed by an EQ and so on.

• The FX channel track has its own channel strip in the 
Mixer, the effect return channel.
Here you can adjust the effect return level and balance, add EQ and 
route the effect return to any output bus.

• Each FX channel track can have any number of automa-
tion tracks, for automating various effect parameters. 
See the chapter “Automation” on page 239 for more information.

Setting up send effects

Adding an FX channel track

1. Pull down the Project menu, open the “Add Track” 
submenu and select “FX Channel”.
A dialog opens.

2. Select a channel configuration for the FX channel 
track.
Normally, stereo is a good choice since most effect plug-ins have stereo 
outputs.

3. Select an effect for the FX channel track.
This is not strictly necessary at this point – you can also leave the plug-in 
pop-up menu set to “No Effect” and add effects to the FX channel later.

4. Click the Add Track button.
An FX channel track is added to the track list, and the selected effect, if 
any, is loaded into the first insert effect slot for the FX channel (in that 
case, the lit Inserts tab for the FX channel track in the Inspector indicates 
that an effect has been assigned and automatically activated).

• All FX channel tracks you create will appear in a dedi-
cated “folder” track in the track list.
This makes it easy to manage and keep track of all your FX channel 
tracks, and also allows you to save screen space by folding in the FX 
Channel folder.

FX channel tracks are automatically named “FX 1”, “FX 2” etc., but you 
can rename them if you wish. Just double-click the name of an FX 
channel track in either the track list or the Inspector and type in a new 
name.

Adding and setting up effects

As mentioned above, you can add a single insert effect 
when you create the FX channel track. To add and set up 
effects after the FX channel track is created, you can ei-
ther use the Inspector for the track (click the Inserts tab) 
or the VST FX Channel Settings window:

1. Click the Edit (“e”) button for the FX channel track (in 
the track list, Mixer or Inspector).
The VST FX Channel Settings window appears, similar to a regular 
Channel Settings window.

On the left in the window you can find the Inserts section with eight 
effect slots.
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2. Make sure that the FX channel is routed to the correct 
output bus.
This is done with the Output Routing pop-up menu at the top of the fader 
section (also available in the Mixer and Inspector).

3. To add an insert effect in an empty slot (or to replace 
the current effect in a slot), click in the slot and select an 
effect from the pop-up menu.
This works just like when selecting insert effects for a regular audio chan-
nel.

4. When you add an effect, its control panel will automat-
ically appear. When you set up send effects, you normally 
set the wet/dry Mix control to all “wet”.
This is because you control the balance between the wet and the dry sig-
nal with the effect sends. For more information, see “Editing effects” on 
page 208.

• You can add up to eight effects for an FX channel.
The signal will pass through all the effects in series. It is not possible to 
adjust the send and return levels separately for the effects – this is done 
for the FX channel as a whole. If you want several separate send effects 
(where you can control the send and return levels independently), add 
more FX channel tracks instead – one for each effect.

• You can reorder the effects by clicking in the area above 
the name field and dragging the effect onto another slot.

• You can copy an effect into another effect slot (for the 
same channel or between channels) by holding down [Ctrl]/
[Command] and dragging it onto another effect slot.

• To remove an insert effect from a slot, click in the slot 
and select “No Effect” from the pop-up menu.
To reduce the CPU load, do this for all effects that you do not intend to 
use.

• You can bypass individual effects (or all effects) by 
clicking the corresponding Bypass button(s) for the FX 
channel track.
See “Routing an audio channel or bus through insert effects” on page 
198.

• You can also adjust level, pan and EQ for the effect re-
turn in the FX Channel Settings window.
This can also be done in the Mixer or in the Inspector.

Remember that the more effect units you use, the 
higher the CPU load.

Making settings for the sends

The next step is to set up a send for an audio channel and 
route it to the FX channel. This can be done in the Mixer (in 
the extended panel), in the Channel Settings window or in 
the Inspector for the audio track. The example below 
shows the Channel Settings window, but the procedure is 
similar for all the sections:

1. Click the “e” button for an audio channel to bring up 
its Channel Settings window.

By default, the send section is located to the left of the 
channel strip. Each of the eight sends has the following 
controls:

• An On/Off button for activating/deactivating the effect
• A send level slider
• A pre/post-fader switch
• An “e” (edit) button

Note that the last three items are not shown until the send 
is activated and an effect has been loaded.

2. Pull down the Routing pop-up menu for a send by 
clicking in the empty slot, and select the desired routing 
destination.

• If the first item on this menu (“No Bus”) is selected, the send is 
not routed anywhere.

• Items called “FX 1”, “FX 2” etc. correspond to existing FX 
tracks. If you renamed an FX track (see “Adding an FX channel 
track” on page 203), that name will appear on this menu in-
stead of the default.

• The menu also allows for routing a send directly to output bus-
ses, separate output bus channels or Group channels.

• You can apply or remove a send to or from all the se-
lected channels at once by holding down [Shift]-[Alt]/[Op-
tion] and selecting the desired effect from any of the effect 
slots.
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3. Select an FX channel track from the pop-up menu.
Now the send is routed to the FX channel.

4. Activate the On/Off button for the effect send.
If you hold down [Shift]-[Alt]/[Option] when clicking the button, you acti-
vate or deactivate this effect slot for all selected channels.

5. Click and drag the send level slider to a moderate 
value.
The send level determines how much of the signal from the audio chan-
nel is routed to the FX channel via the send.

Setting the Send level.

• In the Fader section of the Channel Settings window, 
select the FX channel from the pop-up menu and adjust 
its effect return level.
By adjusting the return level, you control the amount of the signal sent 
from the FX channel to the output bus.

Setting the effect return level.

6. If you want the signal to be sent to the FX channel be-
fore the audio channel’s volume fader in the Mixer, click on 
the Pre-Fader button for the send so that it lights up.

A send set to pre-fader mode.

Normally you want the effect send to be proportional to 
the channel volume (post-fader send). The picture below 
shows where the sends are “tapped” from the signal in 
pre and post-fader mode:

Use the channel’s Mute button to determine whether a 
send in pre-fader mode is affected. This is done with the 
“Mute Pre-Send when Mute” option in the Preferences di-
alog (VST page).

• When one or several sends are activated for a channel, 
the Send Effects buttons light up in blue.

The FX channels themselves have sends, too.

Insert effects 1–6

EQ

Volume (fader)

Pre-fader sends

Post-fader sends

Insert effects 7–8

Input gain
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Bypassing the sends

• In the Mixer, you can click on the lit (blue) Sends State 
button for a channel to bypass (disable) all its sends.
When the sends are bypassed, the button is yellow. Click the button 
again to enable the sends.

• In the Inspector and the Channel Settings window, click 
the button to the left of the Sends button (so that it lights 
up yellow) to bypass the sends.

• You can also bypass individual sends in the channel 
overview.
See “Insert effects in the channel overview” on page 199.

• You can also bypass the send effects by clicking the 
“Bypass Inserts” button for the FX channel.
This bypasses the actual effects which may be used by several different 
channels. Bypassing a send affects that send and that channel only. If 
you bypass the insert effects, the original sound will be passed through. 
This may lead to unwanted side effects (higher volume). To deactivate all 
effects, use the mute button in the FX channel.

Setting pan for the sends

There are several possibilities to set up pan for the sends:

• To position the send signal at center pan in the stereo 
FX channel (or anywhere you like), route a send from a 
mono channel to a stereo FX channel track.

• To use the pan control as a crossfader, determining the 
balance between the stereo sides when the stereo send 
signal is mixed to mono, route a send from a stereo chan-
nel to a mono FX channel track.

• To use the surround panner to position the send signal 
in the surround image, route a send from a mono or stereo 
channel to an FX channel track in surround format.

• To set the panning with the Mixconvert plug-in, route a 
send from a surround channel to an FX channel in a format 
with less channels.

You set up send panning in the following way:

1. Open the Channel Settings window for the audio 
channel.

2. Right-click somewhere in the Channel Settings win-
dow (not the EQ display), to open the context menu and 
open the Customize View submenu.

3. From the submenu, select “Send Routing” and “Con-
trol Strip”.
In the Send Routing section of the Channel Settings window, each send 
is shown as a small routing diagram showing a pre/post selector to the 
right and a pan fader (where applicable). In the Control Strip section, you 
can activate the “Send Routing Panners follow Channel Panner” option. 
The send panners will then follow the pan for the channel, making the 
stereo imaging as clear and true as possible. This behavior can also be 
set as default for all channels. The corresponding setting is available in 
the Preferences dialog (VST page). 

The Sends, Send Routing, and Control Strip sections in the Channel 
Settings window

4. Click and drag the pan control for the desired send(s) 
in the display.
You can reset the pan control to the center position by [Ctrl]/[Com-
mand]-clicking on the pan control.

Send Routing Panners 
follow Channel Panner
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• If the FX channel is configured in a surround format, the 
pan control will be a miniature surround panner, similar to 
the one found in the Mixer.
You can click and drag the “ball” in the miniature panner display to posi-
tion the send in the surround field, or double-click in the display to bring 
up the surround panner. See the chapter “Surround sound” on page 226 
for details.

If both the send (the audio channel) and the FX chan-
nel are in mono, the pan control is not available.

Using the side-chain input
Many VST 3.0 effects feature a side-chain input. Side-
chaining allows you, for example, to lower the music vol-
ume when someone is speaking (“ducking”) or to use 
compression (e. g. on a bass sound) when the drums are 
hit, thereby “harmonizing” the intensity of the two instru-
ments. Another possibility is to use the side-chain signal 
as a source for modulation.

The effect types which feature side-chain functionality are 
Delay, Dynamics, Modulation, and Filter.

Certain combinations of tracks and side-chain inputs 
may lead to feedback loops and added latency. If this is 
the case, the side-chain options will not be available.

Creating a Ducking delay
The delay repeats can be silenced by side-chain signals 
exceeding a certain threshold.

You can use this feature to create a so-called “ducking 
delay” for your vocals. Let’s say you want to add a delay 
effect that is audible only when no signal is present on the 
vocal track. For this, you need to set up a delay effect 
which is deactivated every time the vocals start again.

Proceed as follows:

1. Select the vocal track. 

2. On the Project menu, select “Duplicate Tracks”.
Now you can use the vocal events on the second track to silence the de-
lay effect.

3. Open the Inserts tab for the first Vocal track in the In-
spector and select “PingPongDelay” from the Effects 
pop-up menu.
The control panel for the effect opens.

4. On the control panel for the effect, make the desired 
effect settings and activate the Side-Chain button.
Try out the effect settings to find out which settings will work best with 
your project. For detailed descriptions of the parameters, see the sepa-
rate PDF document “Plug-in Reference”.

5. In the track list, select the second vocal track.

6. Pull down the Output Routing pop-up menu and on 
the Side-Chain submenu, select the PingPongDelay ef-
fect you set up for the vocal track.
This way, the signals from the second (duplicate) track are routed to the 
effect (and do not end up in the mix).

Now every time the signals on the vocal track exceed the 
threshold, the delay will be deactivated. Since the thres-
hold for the delay effect is fixed, you may have to adjust 
the volume of track 2, in this example, to ensure that vocal 
parts of low or middle volume will also silence the delay 
effect.

! For detailed descriptions of the plug-ins that feature 
side-chaining, see the separate PDF document 
“Plug-in Reference”.
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Triggering a compressor using side-chain 
signals
Compression, expansion or gating can be triggered by 
side-chain signals exceeding a specified threshold.

You may run into a situation where you want to lower the 
volume of one instrument every time another instrument is 
played. For example, you may want to lower the volume of 
the bass guitar during the bass drum hits. This can be 
achieved by applying compression to the bass guitar sig-
nal every time the drum signals are present on the respec-
tive track.

Proceed as follows:

1. Select the bass guitar track.

2. Open the Inserts tab in the Inspector, click in an insert 
slot to open the effect selection pop-up menu and, on the 
Dynamics submenu, select “Compressor”.
The effect is loaded into the effect slot and the effect control panel opens. 

3. Make the desired effect settings (you will most likely 
have to adjust them later to get the right compression 
level) and activate the Side-Chain button.

4. Select the bass drum track. 

5. Open the Sends Inspector section, click in a send slot 
and from the Side-Chain submenu, select the Compres-
sor effect you created for the bass guitar track. Adjust the 
Send level.
This way, the bass drum signal triggers the compressor on the bass gui-
tar track.

When you now play back the project, the bass guitar will 
be compressed whenever the signals on the bass drum 
track exceed the threshold.

Side-chain and Modulation
Side-chain signals bypass the built-in LFO modulation 
and instead apply modulation according to the envelope 
of the side-chain signal. Since each channel will be ana-
lyzed and modulated separately, this allows for creating 
astonishing spatial stereo or surround modulation effects. 
Feel free to experiment with the functions to see what they 
have to offer!

About drag & drop
When you drag effects from one insert slot to another (on 
the same channel or between different channels), the fol-
lowing applies:

• When you move an effect within a channel (e. g. from slot 4 to 
slot 6), the side-chain connections will be kept.

• When you drag and drop an effect between two channels, the 
side-chain connections will not be kept.

• When copying an effect into another effect slot (for the same 
or a different channel), the side-chain connections will not be 
copied, i. e. they will be lost.

Using external effects
Although this program comes with a top selection of VST 
effect plug-ins, and although there is a huge range of ad-
ditional plug-ins available on the market, you may still have 
some hardware effect units that you want to use – valve 
compressors, reverb units, vintage tape echo machines, 
etc. By setting up external FX busses you can make your 
outboard equipment part of the Nuendo virtual studio!

An external FX bus is a combination of outputs (sends) 
and inputs (returns) on your audio hardware, along with a 
few additional settings. All external FX busses you have 
created will appear on the effect pop-up menus and can 
be selected like the internal effect plug-ins. The difference 
is that if you select an external effect as an insert effect for 
an audio track, the audio will be sent to the corresponding 
audio output, processed in your hardware effect (provided 
that you have connected it properly) and returned via the 
specified audio input.

Creating and handling of external effects is described 
in detail in the chapter “VST Connections” on page 27.

Editing effects
All inserts and sends have an Edit (“e”) button. Clicking 
this opens the control panel for the effect, in which you 
can make parameter settings.

The contents, design and layout of the control panel de-
pends on the selected effect. However, all effect control 
panels have an On/Off button, a Bypass button, Read/
Write automation buttons (for automating effect parame-
ter changes, see the chapter “Automation” on page 239), 
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a preset pop-up menu and a Preset Management pop-up 
menu for saving and loading effect presets. Some plug-ins 
also feature a side-chain button, see “Using the side-
chain input” on page 207.

The Rotary effect control panel

• Please note that all effects can be edited using a simpli-
fied control panel (horizontal sliders only, no graphics). 
This panel is opened by pressing [Ctrl]/[Command]-[Alt]/
[Option]-[Shift] and clicking on the Edit button for the ef-
fect send or slot.

Effect control panels may have any combination of knobs, 
sliders, buttons and graphic curves. 

The included effects and their parameters are de-
scribed in detail in the separate PDF document “Plug-in 
Reference”.

• If you edit the parameters for an effect, these settings 
are saved automatically with the project.

• You can also save the current settings as a preset, see 
below.

• Effects parameters can be automated – see the chapter 
“Automation” on page 239.

Effect presets
Effect preset management in Nuendo is very versatile. In 
the MediaBay – or with certain limits in the Save Preset di-
alog – you can assign attributes to presets which allow 
you to organize and browse them according to various cri-
teria. Nuendo comes with a huge array of categorized 
track and VST presets that you can use straight out of the 
box. You can also preview effect presets before loading 
them which considerably speeds up the process of find-
ing the right effect preset.

Effect presets can be divided into the following main 
categories:

• VST presets for a plug-in
These are stored parameter settings for a specific effect.

• Inserts presets that contain insert effect combinations
These can contain the whole insert effects rack, complete with settings 
for each effect, see “Saving insert effect combinations” on page 211.

Selecting effect presets
Most VST effect plug-ins come with a number of useful 
presets for instant selection.

To select an effect preset in the Presets browser, proceed 
as follows:

1. Load an effect, either as a channel insert or into an FX 
channel.
The control panel for the effect is displayed.

2. Click in the preset field at the top of the control panel.
This opens the Presets browser.

• You can also open the Presets browser from the In-
spector (Inserts tab) or the Channel Settings window.

3. In the Results section, select a preset from the list.

4. Activate playback to audition the selected preset.
Simply step through the presets until you find the right sound. It may be 
helpful to set up cycle playback of a section to make comparisons be-
tween different preset settings easier.
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5. When you have found the preset that you want, dou-
ble-click on it (or click outside the Presets browser).
The preset is applied.

• To return to the preset that was selected when you 
opened the Presets browser, click the “Revert to Last Set-
ting” button.

• You can also open the Presets browser by clicking the 
button to the right of the preset field an selecting “Load 
Preset” from the pop-up menu.

The preset handling for VST 2 plug-ins is slightly differ-
ent, see “About earlier VST effect presets” on page 211.

The Browser sections

The Presets browser contains the following sections:

• The “Results” section lists the available presets for the 
selected effect.

• The Filters section shows the available preset attributes 
for the selected effect. 
This section is similar to the Filters section in the MediaBay, see “The Fil-
ters section” on page 335. To show the Filters section, click the “Set Up 
Window Layout” button and activate the Filters option.

• The Location Tree section allows you to specify the 
folder that is searched for preset files.
To show the Location Tree section, click the “Set Up Window Layout” 
button and activate the Location Tree option. Note that this is only avail-
able if the Filters section is also active.

Saving effect presets
You can save your edited effect settings as presets for 
further use (e. g. in other projects):

1. Open the Preset Management pop-up menu.

2. Select “Save Preset…” from the pop-up menu.
The Save Preset dialog opens.

3. In the New Preset section, enter a name for the new 
preset.

• If you want to save attributes for the preset, click the 
button below the “New Preset” section at the bottom left.
The Attribute Inspector section opens, allowing you to define attributes 
for the preset. For further information about attributes, see “The Attribute 
Inspector” on page 347.

4. Click OK to store the preset and exit the dialog.

User-defined presets are saved in the following location:

• Windows XP: \Documents and Settings\<user name>\Appli-
cation data\VST3 presets\<company>\<plug-in name>

• Windows Vista\Windows 7: \Users\<user name>\App-
Data\Roaming\VST3 presets\<company>\<plug-in name>

• Mac: /Users/<user name>/Library/Audio/Presets/<com-
pany>/<plug-in name>

You cannot change the default folders, but you can 
add further subfolders inside the individual effect preset 
folders (by clicking the New Folder button).
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About earlier VST effect presets
As stated previously, you can use any VST 2.x plug-ins in 
Nuendo. For a description of how to add VST plug-ins, see 
“Installing and managing effect plug-ins” on page 212.

When you add a VST 2 plug-in, any previously stored pre-
sets for it will be in the old FX program/bank format (.fxp/
.fxb). You can import such files, but the preset handling will 
be slightly different. You will not be able to use the new fea-
tures like the Attribute Inspector until you have converted 
the old “.fxp/.fxb” presets to VST 3 presets. If you save new 
presets for the included VST 2 plug-ins, these will automat-
ically be saved in the new “.vstpreset” format.

Importing and converting FXB/FXP files

To import FXB/FXP files, proceed as follows:

1. Load any VST 2 effect you may have installed, and 
open the Preset Management pop-up menu.

2. Select “Import FXB/FXP…” from the pop-up menu.
This menu item is only available for VST 2 plug-ins.

3. In the file dialog that opens, locate the FXP file and 
click Open.
If you load a bank (.fxb), it will replace the current set of all effect pro-
grams. If you load a single program, it will replace the currently selected 
effect program only. Note that such files exist only if you created your 
own .fxp/.fxb presets with a previous version of Nuendo (or any other 
VST 2 application).

4. After importing, you can convert the current program 
list to VST presets by selecting “Convert Program List to 
VST Presets” from the Preset Management pop-up menu.
After converting, the presets will be available in the Presets browser, and 
you can use the Attribute Inspector to add attributes and audition the 
presets. The converted presets will be stored in the VST3 Preset folder.

Saving insert effect combinations
You can save the complete insert effect rack for a channel 
together with all parameter settings as an inserts preset. 
Inserts presets can be applied to audio, instruments, FX 
channel, or group tracks.

Proceed as follows:

1. Select the desired track in the track list and open the 
Inserts Inspector section.

2. Load a combination of insert effects and adjust the pa-
rameters (or select effect presets) for each effect.

3. At the top of the Inserts tab, click the VST Sound but-
ton to open the Preset Management pop-up menu for the 
inserts and select “Save Preset…”.
This can also be done from the Channel Settings window using the VST 
Sound button at the top of the Inserts section.

4. In the dialog that opens, type in a name for the preset.

5. Select the track (audio/group/instrument/FX channel) 
you wish to apply the new preset to, and open the Preset 
Management pop-up menu.
As you can see, the new preset is available at the top of the pop-up menu.

6. Select the preset you created from the pop-up menu.
The effects are loaded into the Insert slots of the new track, and the con-
trol panels for all effects are opened.

• Note that when loading insert combination presets, any 
plug-ins that were previously loaded for the track will be 
removed, regardless of whether these slots are used in 
the preset.
In other words, saving an inserts preset means saving the states of all in-
sert slots.

! All VST 2 presets can be converted to VST 3 presets.
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• You can use the Preset Management pop-up menu to 
save your settings as preset, or to rename or remove the 
current preset.

Extracting insert effect settings from track presets

You can extract the effects used in a track preset and load 
them into your inserts “rack”: 

• On the Preset Management pop-up menu, select “From 
Track Preset…” to open a dialog where all track presets 
are shown.

• Select an item in the list to load the effects used in the 
track preset.

Track presets are described in the chapter “Working with 
track presets” on page 356.

Installing and managing effect 
plug-ins
Nuendo supports two plug-in formats; the VST 2 format 
(with the file name extensions “.dll” on the PC and “.VST” 
on the Mac) and the VST 3 format (extension “.vst3” on 
both platforms). The formats are handled differently when 
it comes to installation and organizing.

Installing additional VST plug-ins

Installing VST 3 plug-ins under Mac OS X

To install a VST 3.x plug-in under Mac OS X, quit Nuendo 
and drag the plug-in file into one of the following folders:

• /Library/Audio/Plug-Ins/VST3/
This is only possible if you are the system administrator. Plug-ins in-
stalled in this folder will be available to all users, for all programs that 
support them.

• /Users/<user name>/Library/Audio/Plug-Ins/VST3/
“<user name>” is the name you use to log on to the computer (the easi-
est way to open this folder is to go to your “Home” folder and use the 
path /Library/Audio/Plug-Ins/VST3/ from there). Plug-ins installed in this 
folder are only available to you.

When you launch Nuendo again, the new effects will ap-
pear on the effect pop-up menus. In the VST 3 protocol, 
the effect category, subfolder structure, etc. are built-in 
and cannot be changed. Therefore you will find the ef-
fect(s) in the assigned category folder(s) on the Effect 
pop-up menu.

Installing VST 2.x plug-ins under Mac OS X

To install a VST 2.x plug-in under Mac OS X, quit Nuendo 
and drag the plug-in file to one of the following folders:

• /Library/Audio/Plug-Ins/VST/
This is only possible if you are the system administrator. Plug-ins in-
stalled in this folder will be available to all users, for all programs that 
support them.

• <user name>/Library/Audio/Plug-Ins/VST/
“<user name>” is the name you use to log on to the computer (the easi-
est way to open this folder is to go to your “Home” folder and use the 
path /Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this 
folder are only available to you.

When you launch Nuendo again, the new effects will ap-
pear on the effect pop-up menus.

If an effect plug-in comes with its own installation ap-
plication, you should use this. As a general rule, always 
read the documentation or readme files before installing 
new plug-ins.

Installing VST 3 plug-ins under Windows

Under Windows, VST 3 plug-ins are installed by dragging 
the files (with the extension “.vst3”) into the VST3 folder in 
the Nuendo application folder. When you launch Nuendo 
again, the new effects will appear on the Effect pop-up 
menus. In the VST 3 protocol, the effect category, sub-
folder structure, etc. are built-in and cannot be changed. 
Therefore you will find the new effect(s) in the assigned 
category folder(s) on the effect pop-up menu.

Installing VST 2 plug-ins under Windows

Under Windows, VST 2.x plug-ins are installed by drag-
ging the files (with the extension “.dll”) into the Vstplugins 
folder in the Nuendo application folder, or into the Shared 
VST Plug-in folder – see below. When you launch 
Nuendo again, the new effects will appear on the effect 
pop-up menus.

If an effect plug-in comes with its own installation ap-
plication, you should use this. As a general rule, always 
read the documentation before installing new plug-ins.
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Organizing VST 2 plug-ins

If you have a large number of VST 2 plug-ins, having them 
all on a single pop-up menu in the program may become 
unmanageable. For this reason, the VST 2 plug-ins in-
stalled with Nuendo are placed in appropriate subfolders 
according to the effect type.

• Under Windows, you can organize VST plug-ins by 
moving, adding or renaming subfolders within the Vstplu-
gins folder. 
When you launch the program and pull down an effects pop-up menu, 
the subfolders will be represented by hierarchical submenus, each listing 
the plug-ins in the corresponding subfolder.

• Under Mac OS X, you cannot change the hierarchic ar-
rangement of the “built-in” VST plug-ins.
However, you can arrange any additional plug-ins you have installed (in the 
/Library/Audio/Plug-Ins/VST/ folders, see above) by placing them in sub-
folders. In the program, the subfolders will be represented by hierarchical 
submenus, each listing the plug-ins in the corresponding subfolder.

About the effects from previous Nuendo versions

Effect plug-ins from previous versions of Nuendo are avail-
able through the Steinberg web site. Go to http://know-
ledgebase.steinberg.net, search for “legacy plug-ins” and 
follow the link to the download page you require.

Installing older plug-ins will allow you to import projects 
created with previous versions of Nuendo, without loosing 
effect settings.

The Plug-in Information window
On the Devices menu, you will find an item called “Plug-in 
Information”. Selecting this opens a dialog listing all the 
available VST compatible plug-ins in your system (includ-
ing VST instruments), along with all MIDI plug-ins.

Managing and selecting VST plug-ins

To display all available VST plug-ins, open the “VST 
PlugIns” tab.

• To enable a plug-in (make it available for selection), put 
a checkmark in the left column.
Only the enabled plug-ins will appear on the effect menus.

• The Instances column indicates how many instances of 
the plug-in are currently used in Nuendo.
Clicking in this column for a plug-in which is already in use produces a 
pop-up showing exactly where each use occurs.

A plug-in may be in use even if it is not enabled in the 
left column. 

You might for example have opened a project containing effects that are 
currently disabled on the menu. The left column only determines whether 
or not the plug-in will be visible on the effect menus.

• All columns can be resized by dragging the divider in 
the column header.

The other columns show the following information about 
each plug-in:

Update button

Clicking this button will make Nuendo re-scan the desig-
nated VST folders for updated plug-in information.

Column Description

Name The name of the plug-in.

Vendor The manufacturer of the plug-in.

File This shows the complete name of the plug-in (with extension).

Category This indicates the category of each plug-in (such as VST in-
struments, surround effects, etc.).

Version Shows the version of the plug-in.

SDK Shows with which version of the VST protocol a plug-in is 
compatible.

Latency This shows the delay (in samples) that will be introduced if the 
effect is used as an Insert. This is automatically compensated 
for by Nuendo.

Side-
Chain 
Inputs

Shows the number of side-chain inputs for a plug-in.

I/O This column shows the number of inputs and outputs for each 
plug-in.

Path The path and name of the folder in which the plug-in file is 
located.
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VST 2.x Plug-in Paths button

This opens a dialog where you can see the current paths 
to where VST 2.x plug-ins are located. You can add/re-
move folder locations by using the corresponding buttons. 
If you click “Add”, a file dialog opens, where you can se-
lect a folder location.

About the “shared” plug-ins folder (Windows and VST 
2.x only)

You can designate a “shared” VST 2.x plug-ins folder. 
This will allow VST 2.x plug-ins to be used by other pro-
grams that support this standard.

You designate a shared folder by selecting a folder in the 
list and clicking the “Set As Shared Folder” button in the 
VST 2.x Plug-in Paths dialog.

Exporting plug-in information files

You can also save plug-in information as an XML file, e. g. 
for archiving purposes or troubleshooting. The Export 
function is available for VST, MIDI and Audio Codec plug-
ins. Proceed as follows:

1. Right-click on the desired tab in the Plug-in Information 
window to open the context menu and select “Export”.
A file dialog opens.

2. In the dialog, specify a name and location for the Plug-
in Information export file and click OK to export the file.

• The Plug-in Information file contains information on the 
installed/available plug-ins, their version, vendor, etc.

• The XML file can then be opened in any editor applica-
tion supporting the XML format.
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Introduction
VST instruments are software synthesizers (or other sound 
sources) that are contained within Nuendo. They are played 
internally via MIDI. You can add effects or EQ to VST instru-
ments, just as with audio tracks.

This chapter describes the general procedures for 
setting up and using VST instruments.

Depending on the VST version the instrument is com-
patible with, an icon may be displayed in front of the in-
strument name, see “About VST 3” on page 196.

Note that VST instruments are only supplied as part of 
the Nuendo Expansion Kit. You can, however, use your 
own VST instruments in Nuendo. The VST instrument in-
cluded in the Nuendo Expansion Kit are described in de-
tail in the separate manual “Nuendo Expansion Kit – 
Cubase Music Tools for Nuendo”.

VST instrument channels vs. 
instrument tracks
Nuendo allows you to make use of VST instruments in two 
different ways:

• By activating instruments in the VST Instruments window.
This creates a VST instrument channel, which can be played by one (or se-
veral) MIDI track(s) routed to it.

• By creating instrument tracks.
Instrument tracks are a combination of a VST instrument, an instrument 
channel, and a MIDI track. You play and record MIDI note data directly for 
this track.

Both methods have their advantages and should be se-
lected according to what best suits your needs. The fol-
lowing sections describe the two approaches.

VST instrument channels
You can access a VST instrument from within Nuendo by 
creating a VST instrument channel and associating this 
channel with a MIDI track. Proceed as follows:

1. On the Devices menu, select “VST Instruments”.
The VST Instruments window opens.

2. Click in one of the empty slots to open the instrument 
pop-up menu and select the desired instrument.

3. You will be asked if you want to create an associated 
MIDI track connected to the VST instrument. Click Create.
The instrument is loaded and activated, and its control panel opens. A 
MIDI track with the name of the instrument is added to the track list. The 
output of this track is routed to the instrument.

In the Preferences dialog (VST–Plug-ins page), you can 
specify what happens when loading a VST instrument in 
an instrument slot. Open the pop-up menu “Create MIDI 
track when loading VSTi” and select one of the available 
options:

• When you select “Always”, a corresponding MIDI track will al-
ways be created.

• When you select “Do not”, no track will be created and only 
the instrument will be loaded.

• Select “Always ask to” if you want to decide whether a MIDI 
track is created whenever you load an instrument.

You can also use modifiers to specify what happens when 
you load a VST instrument (overriding the Preference set-
ting):

• When you hold down [Ctrl]/[Command] while selecting a VST 
instrument for an instrument slot, a corresponding MIDI track 
with the name of the instrument is automatically created.

• When you hold down [Alt]/[Option] while selecting a VST in-
strument for an instrument slot, no MIDI track will be created 
for the instrument.
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• If you do not want the plug-in control panels to open ev-
ery time you load a plug-in, open the Preferences dialog 
(VST–Plug-ins page) and deactivate “Open Effect Editor 
After Loading it”.
You can open a plug-in panel at any time by clicking the “e” button of the 
corresponding plug-in slot.

4. If you now look in the Project window track list, you will 
find that a dedicated folder for the chosen instrument has 
been added, within a “VST Instruments” folder (where all 
your VST instrument channels will be listed).
The separate folder for the added VST instrument contains two types of 
automation tracks: one for automating the plug-in parameters and one 
for each Mixer channel used by the VST instrument. For example, if you 
add a VST instrument with four separate outputs (four separate Mixer 
channels), the folder will contain five automation tracks. To keep the 
screen less cluttered, you may want to close the folder for the VST in-
strument until you need to view or edit any of the automation tracks. For 
details about automation, see the chapter “Automation” on page 239.

• When you select the MIDI track routed to the VST in-
strument, you will see that the Inspector contains a sepa-
rate section for the instrument.
This section contains the audio channel settings for the VST instrument 
(inserts, EQs, Sends, and fader settings). The tab has two buttons for 
opening the Channel Settings window (for the VST instrument channel) 
and the Edit Instrument button which opens the control panel for the VST 
instrument.

5. Depending on the selected VST instrument, you may 
also need to select a MIDI channel for the track.
For example, a multitimbral VST instrument can play back different 
sounds on different MIDI channels – check the documentation for the 
VST instrument for MIDI implementation details.

6. Make sure that the “MIDI Thru Active” option is acti-
vated in the Preferences dialog (MIDI page).

7. Activate the Monitor button for the MIDI track (in the 
track list, Inspector, or Mixer). 
When this is activated (or when the track is record enabled), incoming 
MIDI is passed on to the selected MIDI output (in this case the VST in-
strument), see the chapter “Recording” on page 90.

8. Open the Mixer.
You will find one or more channel strips for the audio outputs of the VST 
instrument. VST instrument channel strips have the same features and 
functionality as group channel strips, with the addition of an Edit button 
at the bottom of the strip for opening the VST instrument control panel. 
You will also find Output Routing pop-up menus at the top of the channel 
strips, e. g. for routing the VST instrument channels to output channels or 
groups. Routing is described in detail in the chapter “VST Connections” 
on page 27.

9. Play the VST instrument from your MIDI keyboard.
You can use the Mixer settings to adjust the sound, add EQ or effects, etc., 
just as with regular audio channels. Of course, you can also record or man-
ually create MIDI parts that play back sounds from the VST instrument.

• VST instrument channels give you full access to multi-
timbral instruments.
You can have several MIDI tracks routed to the VST instrument, each 
playing a different part.

• Similarly, you can route channels to any available output 
provided by the VST instrument.

The VST Instruments window
When a VST instrument is loaded, six controls are dis-
played for this slot in the VST Instruments window.

• The button on the far left is used for the Freeze function, 
see “Instrument Freeze” on page 220.

• The On/Off button is used to activate or deactivate the 
VST instrument.
When an instrument is selected from the instrument pop-up menu, it is 
activated automatically, i. e. the On/Off button is lit.
For some instruments you may also bypass the instrument by clicking the 
Bypass button to the right of the On/Off button.

Opens the Channel Settings 
window.

Opens the control panel for 
the VST instrument.

! You can have up to 64 VST instruments activated at 
the same time, either different instruments or multiple 
instances of the same instrument. However, software 
instruments can consume a lot of CPU power – keep 
an eye on the VST Performance window to avoid run-
ning out of processor power (see also “Instrument 
Freeze” on page 220).

Instrument 
on/off

Instrument 
Freeze

Activate outputs
Bypass 
instrument

Open instrument panelEvent received
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• Click the Edit (“e”) button to open the control panel for 
the VST instrument. 

• Below the Edit button is a small LED that will light up 
when MIDI data is received by the instrument.

• The rightmost button allows you to activate the desired 
output for the instrument.
This is useful when you are using VST instruments that have a large num-
ber of audio busses, which may be confusing. Click one of the entries in 
the pop-up list to activate/deactivate output busses for this instrument.

Instrument tracks
An instrument track is a combination of a VST instrument, a 
MIDI track, and a VST instrument channel, in other words: it 
is a track coupled with a sound – it allows you to think in 
terms of sounds rather than in terms of track and instrument 
settings.

Adding instrument tracks
To open and use an instrument track, proceed as follows:

1. Pull down the Project menu, open the Add Track sub-
menu and select “Instrument”.
You can also right-click the track list and select “Add Instrument Track” 
on the context menu.

2. The Add Instrument Track dialog opens.
You can select an instrument for the track from the pop-up menu (but you 
can also leave this until later if you wish). Specify the number of instrument 
tracks you wish to create in the “Count” field. If you click the Browse but-
ton, the dialog expands to show the Presets browser, where you can 
browse for sounds, see “Using the Presets browser” on page 222.

3. Click the Add Track button.
If you have selected an instrument in the Add Track dialog, the new track 
gets the name of the instrument. Otherwise, the track is named “Instru-
ment track”.

Properties
Each instrument track has a corresponding channel strip 
in the Mixer.

• In the Inspector, you can select a VST instrument from 
the Instrument pop-up menu.
When you select an instrument from this pop-up menu, its control panel 
will open automatically.

• You can also exchange the “sound” of an instrument 
track (i. e. the VST instrument and its settings) by extract-
ing these data from another instrument track or a VST pre-
set, see “Extracting sound from an instrument track or VST 
preset” on page 360.

• On the Input Routing pop-up menu, you can select a 
MIDI input.
Instrument tracks have only one MIDI input.

• To open the control panel for the VST instrument, click 
the “Edit Instrument” button in the Inspector.

• As with MIDI tracks, you can perform the usual MIDI edit-
ing procedures on the instrument track, like duplicate, split, 
repeat or lock the track, use the In-Place Editor, drag and 
drop the MIDI parts of an instrument track, etc. For more in-
formation, see the chapter “MIDI realtime parameters and 
effects” on page 372.

• As with the MIDI track inspector and track controls, you 
can adjust track delay, choose MIDI input, work with VST 
instrument panels, etc. For more information, see the chap-
ter “MIDI realtime parameters and effects” on page 372.

• Instrument tracks have all options that VST instrument 
channels have, i. e. inserts, sends, EQ, etc.

VST instruments used in instrument tracks do not ap-
pear in the VST Instruments window. For an overview of all 
used VST instruments, open the Plug-in Information win-
dow via the Devices menu. For further information, see the 
section “The Plug-in Information window” on page 213.
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Restrictions
• Instrument tracks have no MIDI sends.

• MIDI volume and pan cannot be controlled (there is no 
“MIDI fader” tab in the Inspector); instead, the VST instru-
ment volume and pan are used (via the “Channel” tab in 
the Inspector). This applies also to the respective automa-
tion parameters.

Due to there being only one volume and pan control for 
the instrument track, the Mute button will mute the com-
plete track including the VST instrument. (As opposed to a 
MIDI track with an assigned VST instrument, for which mut-
ing the MIDI track still allows you to monitor and record the 
VST instrument.)

• Instrument tracks always have one stereo output chan-
nel only. This means that VST instruments that do not pro-
vide a stereo output as their first output channel cannot be 
used with instrument tracks, and must be loaded via the 
VST Instruments window.

• Due to the limitation to one output channel, instrument 
tracks play only the first voice of a multi-timbral VST in-
strument. If you want to use all voices, you have to load the 
instrument via the VST Instruments window and set up a 
MIDI channel to play it.

Import and export options

Importing MIDI loops

You can import “MIDI loops” (file extension “*.midiloop”) in 
Nuendo. These files contain MIDI part information (MIDI 
notes, controllers, etc.) as well as all the settings that are 
saved in instrument track presets (see “About track pre-
sets and VST presets” on page 221). This way, you can 
easily reuse instrument patterns you really like in other 
projects or applications, for example.

Proceed as follows:

1. Open the MediaBay window via the Media menu.

2. In the Results section, open the “Show Media Types” 
dialog and select “MIDI Loops & Plug-in Presets” (see 
“Filtering according to media type” on page 339).
This is not necessary, but will help you locate your MIDI loops more quickly.

3. In the Results list, select a MIDI loop and drag it to an 
empty section in the Project window.
An instrument track is created and the instrument part is inserted at the 
position where you dragged the file. The Inspector will reflect all settings 
saved in the MIDI loop, e. g. the VST instrument that was used, applied 
insert effects, track parameters, etc.

You can also drag MIDI loops onto existing instrument 
or MIDI tracks. However, this will only import the part infor-
mation. This means this part will only contain the MIDI data 
(notes, controllers) saved in the MIDI loop, but no inspec-
tor settings or instrument parameters.

Exporting MIDI loops

Exporting MIDI loops is a great way of saving a MIDI part 
together with its instrument and effect settings. This al-
lows you to easily reproduce patterns you created without 
having to search for the correct sound, style, or effect.

Proceed as follows:

1. Select the desired instrument part.

2. Pull down the File menu, open the Export submenu, 
and select “MIDI Loop…”.
A file dialog opens.

3. In the “New MIDI Loop” section, enter a name for the 
MIDI loop.

• If you want to save attributes for the MIDI loop, click the 
button below the “New MIDI Loop” section at the bottom 
left.
The Attribute Inspector section opens, allowing you to define attributes 
for your MIDI loop.

4. Click OK to close the dialog and save the MIDI loop.

MIDI Loop files are saved in the following folder:

• Windows XP: \Documents and Settings\<user name> 
\Application Data\Steinberg\MIDI Loops

• Windows Vista and Windows 7: \Users\<user name>\ 
AppData\Roaming\Steinberg\MIDI Loops

• Mac: /Users/<user name>/Library/Application Support/
Steinberg/MIDI Loops/

This default folder cannot be changed, but you can create 
subfolders within this folder to organize your MIDI loops. 
Simply click the “New Folder” button in the Save MIDI 
Loop dialog.
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Exporting instrument tracks as MIDI file

You can also export instrument tracks as standard MIDI 
files, see “Exporting MIDI files” on page 560.

Please note: 

• As there is no MIDI patch information in an instrument 
track, this information is missing in the resulting MIDI file.

• If you activate “Export Inspector Volume/Pan”, volume 
and pan information of the VST instrument will be con-
verted and written into the MIDI file as controller data.

What do I need? Instrument channel 
or instrument track?
• If you need a particular sound without knowing which 
VST instrument to use, create an instrument track and use 
the preview features of the Presets browser to find the 
sound you want.

• Do likewise if the instrument track restrictions described 
above do not matter.

• If you are planning to create an instrument track preset, 
complete with inserts and EQ settings, you have to use an 
instrument track.

• If you need to use multitimbral parts and/or multiple out-
puts, set up a VST instrument channel. 

Instrument Freeze
Like all plug-ins, VST instruments may require a lot of pro-
cessor power. If you are using a moderately powerful com-
puter or if you are using a large number of VST instruments, 
you may come to a point where your computer cannot han-
dle all VST instruments playing back in realtime (the CPU 
overload indicator in the VST Performance window lights 
up, you get crackling sounds, etc.).

Enter the Instrument Freeze function! This is how it works:

• When you freeze a VST instrument, the program renders 
an audio file of the instrument output (taking into account all 
unmuted MIDI parts routed to that VST instrument). This file 
is placed in the “Freeze” folder within the Project folder.

• All MIDI tracks routed to the VST instrument, or the in-
strument track associated with the VST instrument, are 
muted and locked (the controls for these tracks will ap-
pear “grayed-out” in the track list and Inspector).

• When you start playback, the rendered audio file is 
played back from an “invisible” audio track, routed to the 
VST instrument’s Mixer channel. Thus, any effects, EQ, or 
mixing automation will still be applied.

• You can also freeze the Mixer channel of the VST instru-
ment. This freezes any pre-fader insert effects for the 
channels, just as when freezing audio tracks (see “Freez-
ing (rendering) insert effects for a track” on page 202).

The result of the Freeze is that you get exactly the same 
sound as before, but the computer processor does not 
have to calculate the sound of the VST instrument in real-
time.

Performing the freeze
The instrument freeze function is available in the VST In-
struments window, the track list, and the Inspector for in-
strument tracks.

1. Set up the project so that the VST instrument plays 
back the way you want it to.
This includes editing the MIDI tracks routed to the VST instrument, or ed-
iting the instrument track, and making parameter settings for the VST in-
strument itself. If you have automated parameter changes for the VST 
instrument, make sure that the Read (R) button is activated.

2. Open the VST Instruments window from the Devices 
menu, or, if you are using an instrument track, select the 
track and open the top Inspector tab.

3. Click the Freeze button for the VST instrument (the 
button to the left of the VST instrument slot), or the Freeze 
button in the Inspector for the instrument track.

The Freeze button in the 
VST Instruments window…

…and in the Inspector.
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The Freeze Instrument Options dialog opens with the fol-
lowing options for the Freeze operation:

• Select “Freeze Instrument Only” if you do not want to 
freeze any insert effects for the VST instrument channels.
Use this if you are using insert effects on the VST instrument channel(s) 
and want to be able to edit, replace, or remove these after freezing the 
VST instrument.

• Select “Freeze Instrument and Channels” if you want to 
freeze all pre-fader insert effects for the VST instrument 
channels.
If your VST instrument channels are set up with the desired insert effects 
and you do not need to edit these, select this option.

• You can set a Tail Size time to let sounds complete their 
normal release cycle.
Otherwise, the sound might be cut off at the very end of the freeze file.

• When you activate “Unload Instrument when Frozen”, 
the frozen VST instrument will be removed.
This is useful if you are freezing an instrument that uses a lot of RAM, e. g. 
for pre-loading samples. By unloading the instrument, the RAM becomes 
available for other plug-ins, etc.

4. Click OK.
A progress dialog is shown while the program renders the VST instru-
ment audio to a file on your hard disk.

The Freeze button lights up. If you check the Project win-
dow at this point, you will find that the relevant MIDI/in-
strument tracks have grayed out controls in the track list 
and Inspector. Furthermore, the MIDI parts are locked and 
cannot be moved.

5. Play back the project.
You will hear exactly the same sound as before freezing the VST instru-
ment – but the CPU load will be considerably less! 

• If you selected “Freeze Instrument and Channels”, any 
insert effects used by the VST instrument are also frozen 
(except for the post-fader inserts). However, you can al-
ways adjust level, pan, sends, and EQ for frozen VST in-
struments.

Unfreezing
If you need to make adjustments (either to the MIDI tracks, 
to the VST instrument parameters or to the VST instru-
ment channels if these were frozen) you need to unfreeze 
the VST instrument:

1. Click the Freeze button for the VST instrument again 
(either in the VST Instruments window or in the Inspector).
You will be asked to confirm this operation.

2. Click “Unfreeze”.
The tracks and VST instrument are restored and the rendered “freeze 
file” is deleted.

VST instruments and processor load
If you are working with VST 3 instruments, another way to 
relieve processor load is the “Suspend VST3 plug-in pro-
cessing when no audio signals are received” option in the 
Preferences dialog (VST–Plug-ins page). This is described 
in the section “Smart plug-in processing” on page 196. 

Using presets for VSTi configuration

About track presets and VST presets
Track presets and VST presets allow you to quickly set up 
tracks or instruments with all the settings required for the 
sound you want. Nuendo provides various types of pre-
sets for various purposes. Two of these are of relevance 
for VST instruments:

• Track presets for instrument tracks store the parameter 
settings of a VST instrument together with all track/chan-
nel settings (applied audio and MIDI insert effects, etc.).
Instrument track presets can only be applied to instrument tracks, not to 
instrument channels activated in the VST Instruments window.

• VST presets store all panel settings for a plug-in (VST 
instruments and VST effects), but no track/channel set-
tings.
Note that you can create instrument tracks from VST 3 presets, i. e. se-
lecting a VST 3 preset will create an instrument track with all settings 
stored in the VST preset plus an “empty” track.
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As described in the chapter “Audio effects” on page 195, 
there are two types of VST presets that can be used: the 
VST 2 standard FXB/FXP files and the VST 3 preset stan-
dard with the extension “.vstpreset”. Some of the included 
VST instruments use the VST 2 preset standard, and oth-
ers use the VST 3 standard. 

All VST 2 instruments can import FXB/FXP files and also 
convert them to the VST 3 standard. Once converted, you 
can use all VST 3 features, see “About earlier VST instru-
ment presets” on page 224.

For further information on track presets and VST 
presets, see the chapter “Working with track presets” on 
page 356.

Browsing for sounds
One important and often time-consuming aspect of music 
creation is the search for the right sounds. You might spend 
a huge amount of time trying out the presets for a particular 
instrument only to find out later that the preset for another 
instrument contains the sound you were looking for.

This is why Nuendo features extensive browsing possibili-
ties, allowing you to preview all available presets without 
having to load them first!

In addition, you can filter your search by specifying cate-
gory, style, etc. For example, if you are looking for a bass 
sound, simply select the Bass category to browse and 
preview all bass sounds for all instruments. If you know 
you want a synth bass sound, select Synth Bass as sub-
category to filter out all other sounds, etc.

You can also browse and preview track presets for instru-
ment tracks, i. e. instrument sounds plus all track settings 
and all channel insert effect settings for this track.

These features combined speed up the process of finding 
the right sound immensely. 

• When creating your own presets, it is always a good 
idea to set up attributes for them, as it allows you to fully 
use the browsing features for your files, too.
This is described in the section “Editing attributes (tagging)” on page 348.

Using the Presets browser

You can open the Presets browser for an existing track or 
when creating a new track. Proceed as follows:

• In the Add Instrument Track dialog, click the Browse 
button.
The dialog expands to show the Presets browser.

• Click in the “Load Track Preset” field at the top of the 
Inspector (above the track name) or right-click the track in 
the track list and select “Load Track Preset…”.
The Presets browser opens (see also “Loading track or VST presets in 
the Inspector or the context menu of the track” on page 359).

To find an appropriate preset, proceed as follows:

1. Select a preset from the Results list.
If needed, filter the list by activating the attributes you are looking for in 
the Filters section. This section is similar to the Filters section in the Me-
diaBay, see “The Filters section” on page 335.

2. Play a few notes on your MIDI keyboard to hear the 
preset sound. You can switch between presets and hear 
the sound while you play. Alternatively, you can play back/
loop a MIDI part on a track.
Each time you select a preset, all associated track and/or instrument set-
tings are automatically loaded.

3. When you have found the preset that you want, dou-
ble-click on it (or click outside the Presets browser).
The preset is applied.

• To return to the preset that was selected when you 
opened the Presets browser, click the “Revert to Last 
Setting” button.
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Using the “Choose Track Preset” dialog

1. Right-click the track list to open the context menu and 
on the Add Track submenu select “Add Track Using Track 
Preset…”.
The Choose Track Preset dialog opens. It contains the same sections as 
the Presets browser.

2. Select a preset from the Results list.
The Results section of the Choose Track Preset dialog displays all pre-
set sounds for all track types and VST instruments.

3. To preview the presets, you have to play MIDI notes on 
a MIDI keyboard or load a MIDI file because there is no 
track connected.
The previewing options are described in detail in the section “Previewing 
VST presets and track presets for MIDI and instrument tracks” on page 
343.

4. When you have found the right sound, click the Add 
Track button to close the dialog.
An instrument track is created with all track and/or instrument settings 
that were saved in the preset.

Selecting VST instrument presets
The previous sections focussed on selecting presets for 
the creation of new instrument tracks, or for changing the 
setup of an existing track. However, you can also use pre-
sets to change the settings of the VST instrument itself.

To select a VST instrument preset, proceed as follows:

1. Load a VST instrument (either in the VST Instruments 
window or via an instrument track).

2. If you use the VST Instruments window, select a MIDI 
track routed to the instrument. If you use an instrument 
track, select this track. 

3. Make sure that the Inspector section with the basic 
track settings is visible.
If this is not the case, click on the track name at the top of the Inspector.

4. In the Inspector, click in the Programs field.
The Presets browser opens.

5. In the Results section, select a preset from the list.

6. Activate playback to audition the selected preset.
Simply step through the presets until you find the right sound. It may be 
helpful to set up cycle playback of a section to make comparisons be-
tween different preset settings easier.

! The Preview functions work in the same way in the 
MediaBay and its related dialogs. Note however that 
not all Preview functions available in the MediaBay 
are also available in the dialogs.

! Note that the following refers to the selection of 
VST 3 presets (.vstpreset). If you want to apply .FXP/
.FXB presets to your VST 2 instruments in this way, 
see “About earlier VST instrument presets” on page 
224.
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7. When you have found the preset that you want, dou-
ble-click on it (or click outside the Presets browser).
The preset is applied.

• To return to the preset that was selected when you 
opened the Presets browser, click the “Revert to Last Set-
ting” button.

You can also open the Presets browser via the Pre-
sets pop-up menu in the control panel of the VST instru-
ment.

Saving VST instrument presets
You can save your settings as presets for further use (e. g. 
in other projects):

1. In the VST instrument panel, click the button to the 
right of the preset name and select “Save Preset…”.
This opens a dialog where you can save the current settings as a preset.

2. In the New Preset section, enter a name for the preset.

• If you want to save attributes for the preset, click the 
button below the “New Preset” section at the bottom left.
The Attribute Inspector section opens, allowing you to define attributes 
for the preset. For further information about attributes, see “The Attribute 
Inspector” on page 347.

3. Click OK to save the preset and exit the dialog.

Presets are saved into a default folder named VST3 Pre-
sets. Within this folder, there is a folder called “Steinberg 
Media Technologies” where the included presets are ar-
ranged in subfolders named after each instrument.

You cannot change the default folder, but you can add fur-
ther subfolders inside the instrument’s preset folder.

• Under Windows XP, the default preset folder is in the follow-
ing location: \Documents and Settings\<user name>\ 
Application data\VST3 Presets.

• Under Windows Vista and Windows 7, the default preset 
folder is in the following location: \Users\<user name>\ 
AppData\Roaming\VST3 Presets.

• Under Mac OS, the default preset folder is in the following lo-
cation: /Users/<user name>/Library/Audio/Presets/ 
<company>/<plug-in name>.

About earlier VST instrument presets
You can use any VST 2.x instrument plug-ins in Nuendo. 
Installing VST instrument plug-ins works the same way as 
for audio effects – see “Installing additional VST plug-ins” 
on page 212.

When you install a VST 2 instrument, any previously 
stored presets for it will be of the old FX program/bank 
(.fxp/.fxb) standard. You can import such files, but the pre-
set handling will be slightly different. You will not be able 
to use the new features like the Preview function or the At-
tribute Inspector until you have converted the old “.FXP/
.FXB” presets to VST 3 presets. If you save new presets 
for a VST 2 plug-in these will automatically be saved in the 
new “.vstpreset” format in the default location.

Importing and converting FXB/FXP files

To import FXP/FXB files, proceed as follows:

1. Load any VST 2 instrument you may have installed, 
and click the VST Sound button to open the Preset Ma-
nagement pop-up menu.

2. Select the “Import FXB/FXP” option.
This menu item is only available for VST 2 instrument plug-ins.

3. In the file dialog that opens, locate the FXP file and 
click “Open”.
If you load a bank (.fxb), it will replace the current set of all effect programs. 
If you load a single program, it will replace the currently selected effect pro-
gram only. Note that such files exist only if you created your own .fxp/fxb 
presets with a previous program version (or any other VST 2 application).

• After importing, you can convert the current program list 
to VST presets by selecting “Convert Program List to VST 
Presets” from the Preset Management pop-up menu.
When the presets are converted, they are available in the Presets browser, 
and you can use the Attribute Inspector to add attributes and audition the 
presets. The presets will be stored in the VST3 Preset folder.
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About latency
Depending on your audio hardware and its ASIO driver, 
the latency (the time it takes for the instrument to produce 
a sound when you press a key on your MIDI controller) 
may simply be too high to allow comfortable realtime VST 
instrument playback from a keyboard. 

If this is the case, a workaround is to play and record your 
parts with another MIDI sound source selected, and then 
switch to the VST instrument for playback.

You can check the latency for your audio hardware in 
the Device Setup dialog (VST Audio System page).

The input and output latency values are shown below the ASIO Driver 
pop-up menu. For live VST instrument playing, these values should ide-
ally be a few milliseconds (although the limit for “comfortable” live playing 
is a matter of personal taste).

Constrain Delay Compensation
Nuendo features full delay compensation throughout the 
entire audio path. This means that any delay inherent in the 
VST plug-ins you use will automatically be compensated 
for during playback, so that all channels are kept in perfect 
sync (see “About plug-in delay compensation” on page 
197).

However, when you play a VST instrument in realtime or 
record live audio (with monitoring through Nuendo acti-
vated), this delay compensation may sometimes result in 
added latency. To avoid this, you can activate the Con-
strain Delay Compensation button on the Project window 
toolbar. This function tries to minimize the latency effects 
of the delay compensation, while maintaining the sound of 
the mix as far as possible.

• In the Preferences dialog (VST page) you will find a set-
ting called Delay Compensation Threshold. Only plug-ins 
with a delay higher than this setting will be affected by the 
Constrain Delay Compensation function.

• VST plug-ins (with higher delay than the threshold 
value) which are activated for VST instrument channels, 
audio track channels that are record enabled, group chan-
nels and output channels will be turned off when you acti-
vate Constrain Delay Compensation.

• VST plug-ins activated for FX channels are not turned 
off but their delay is disregarded by the program (delay 
compensation is turned off).

After recording or using a VST instrument with Constrain 
Delay Compensation, turn off the function in order to re-
store full delay compensation.

External instruments
An external instrument bus is an input (return) to your audio 
hardware, along with a MIDI connection via Nuendo and 
few additional settings. External instrument busses are cre-
ated in the VST Connections window. All external instru-
ment busses you have created will appear on the VST 
Instrument pop-up menus and can be selected in the same 
way as any VST instrument plug-in. If you select an external 
instrument, you play it via MIDI as usual (you have to create 
a MIDI device to play it) and the sound (synth audio output) 
will come in to the VST environment where you can apply 
processing, etc. For more information on external instru-
ments, see “Setting up external instruments” on page 34. 
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Introduction
Nuendo has integrated surround sound features with sup-
port for several formats. This support goes all the way 
through the audio path: all audio-related channels (i. e. au-
dio and instrument tracks as well as group channels) and 
busses can handle multi-channel speaker configurations 
(up to 12 channels). A channel in the Mixer can either carry 
complete surround mixes, or an individual speaker channel 
which is part of a surround setup.

Nuendo offers the following surround-related features:

• Audio-related tracks can be routed freely to surround channels.
• The SurroundPanner V5 plug-in is automatically applied to au-

dio-related tracks with a supported surround configuration 
and to output channels with a multi-channel configuration 
(other than stereo). It is available in the Inspector and Mixer 
and can be used to graphically position channels in the sur-
round field. The plug-in is described in detail in the section 
“Using the SurroundPanner V5” on page 230.

• The MixConvert plug-in allows conversion of one surround 
channel into another with a different speaker configuration. 
Nuendo places MixConvert automatically where needed. For 
more information about MixConvert, see “Using the MixCon-
vert plug-in” on page 237.

• Nuendo supports surround-specific plug-ins, that is plug-ins 
with multi-channel support specifically designed for surround 
sound mixing tasks (the included “Mix8to2” plug-in is an ex-
ample of this). Furthermore, any VST3 plug-in features multi-
channel support and can therefore be used in a surround con-
figuration, even if it was not specifically designed for surround. 
This is described in detail in the section “Using effects in 
multi-channel configurations” on page 199. All plug-ins are 
described in the separate PDF document “Plug-in Reference”.

• You configure Nuendo for surround sound by defining input 
and output busses in the desired surround format and specify-
ing which audio inputs and outputs are used for the different 
channels in the busses, see “Preparations” on page 229.

Deliverables
The result of a surround mix in Nuendo is either the multi-
channel audio sent from the surround output bus to your 
dubber, or (if you use the Export Audio Mixdown feature) 
audio file(s) on your hard disk. Exported surround mixes can 
either be split (one mono file per speaker channel) or inter-
leaved (a single file containing all the surround channels).

Available surround configurations
The following surround configurations are supported in 
Nuendo:

Format Description

LRCS  
LRCS refers to Left Right Center Surround, where the sur-
round speaker is center-rear positioned. This is the original 
surround format that first appeared as Dolby Stereo in cin-
ema and later as the home cinema format Dolby ProLogic.

5.0  
This is the same as 5.1 (see below) but without the LFE 
channel. The LFE channel is optional in 5.1 and if you do 
not plan to use it, you might find this option more conve-
nient.

5.1  
This is the most popular surround format in cinema and 
DVD. In its various encoding implementations (estab-
lished by different manufacturers), it is referred to as 
Dolby Digital, AC-3, DTS, and MPEG-2 Multichannel. 
5.1 has one center speaker (mainly used for dialogue), 
main left and right speakers, and two surround speakers 
(mostly for sound effects). Additionally an LFE (Low Fre-
quency Effects) subchannel with lower bandwidth is 
used for special low frequency effects.

LRC  
Same as LRCS, but without the surround speaker channel.

LRS  
Left-Right-Surround, with the surround speaker posi-
tioned at center-rear.

LRC+Lfe  
Same as LRC, but including an LFE subchannel.

LRS+Lfe  
Same as LRS, but including an LFE subchannel.
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Quadro  
The original Quadraphonic format for music, with one 
speaker in each corner. This format was intended for vinyl 
record players.

LRCS+Lfe  
Same as LRCS, but including an LFE subchannel.

Quadro+Lfe  
Same as Quadro, but including an LFE subchannel.

6.0 Cine  
A Left-Right-Center front speaker arrangement with three 
surround channels (Left-Right-Center).

6.0 Music  
This uses two front channels (Left/Right) with Left and 
Right surround channels and Left and Right Side channels.

6.1 Cine  
Same as 6.0 Cine but with an LFE subchannel added. 
This speaker arrangement is used in the Dolby Digital EX 
and DTS-ES formats.

6.1 Music  
Same as 6.0 Music, but including an LFE subchannel.

Format Description

7.0 Cine  
A Left, Mid-left, Center, Mid-right, Right front speaker ar-
rangement with Left and Right surround channels.

7.0 Music  
Same as 6.0 Music, but including a Center front channel.

7.1 Cine  
Same as 7.0 Cine but with an LFE subchannel added. 
This arrangement is used in the Sony Dynamic Digital 
Sound (SDDS) format.

7.1 Music  
Same as 7.0 Music, but including an LFE subchannel.

8.0 Cine  
Same as 7.0 Cine, but including a Center Surround 
channel.

8.0 Music  
Same as 7.0 Music, but including a Center Surround 
channel.

8.1 Cine  
Same as 8.0 Cine, but including an LFE subchannel.

Format Description
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Preparations

Output bus configuration
Before you can start working with surround sound, you 
have to configure a surround output bus, through which all 
the speaker channels of the selected surround format are 
routed. How to add and set up busses in the VST Con-
nections window is described in detail in the section “Set-
ting up busses” on page 28. 

Child busses

A child bus is a bus within a (wider) bus. The most obvious 
application of a child bus is to create stereo busses within 
your surround bus – this allows you to route stereo tracks 
directly to a stereo speaker pair within the surround bus. 
You may also want to add child busses in other surround 
formats (with fewer channels than the “parent bus”).

Once you have created a surround bus, you can add one or 
several child busses to it by right-clicking the bus and se-
lecting “Add Child Bus”. This is described in detail in the 
section “Adding child busses” on page 31.

Routing
In the Routing panel of the Mixer, you can use the Output 
Routing pop-up menu to route audio-related tracks to 
output busses or group channels with a surround configu-
ration. For details on routing, see “Routing” on page 168.

Routing channels to individual surround channels

If you want to place an audio source in one separate 
speaker channel, you can route it directly to that speaker 
channel. This is useful for premixed material or multi-chan-
nel recordings that do not require panning.

• To do this, simply select an individual speaker channel 
in the Output Routing pop-up menu.

• If a stereo audio channel is routed directly to a speaker 
channel, the left/right channels are mixed to mono.
The pan control for the audio channel governs the balance between the 
left and right channel in the resulting mono mix. Center pan will produce 
a mix of equal proportion.

Routing channels to child busses

If you have added a child bus within a surround bus (see 
above), it appears as a subentry of the surround bus on the 
Output Routing pop-up menu. Select this option to route a 
stereo audio channel directly to that stereo speaker pair of 
the surround bus (e. g. to route a music track directly to the 
left and right front speakers in a surround channel).

Input bus configuration
To work with surround sound in Nuendo, it is often not nec-
essary to configure a surround format input bus. You can 
record audio files via standard inputs, and easily route the 
resulting audio channels to surround outputs at any stage. 
You can also directly import multi-channel files of a specific 
surround format onto audio tracks of the same format.

You should add a surround input bus in the following cir-
cumstances:

• You have existing audio material in a specific surround 
format, and you wish to transfer this material into Nuendo 
as a single, multi-channel file.

8.1 Music  
Same as 8.0 Music, but including an LFE subchannel.

10.2  
This is an experimental format with ten surrounding speak-
ers and two LFE channels (a combination of two 5.1 set-
ups, one at the top and one at the bottom of the room).

Format Description
229
Surround sound



• You wish to record a surround setup “live”.

• You have prepared surround premixes (e. g. stems) that 
you want to record on a new audio track with a surround 
configuration.

Using the SurroundPanner V5
Nuendo has a special feature for graphically positioning a 
sound source in the surround field or modifying existing 
premixes: the SurroundPanner V5. This plug-in distributes 
the audio from the input channels in various proportions to 
the output surround channels.

Whether the SurroundPanner V5 can be used for a spe-
cific input/output configuration, depends on whether this 
configuration can be mapped by the panner. The plug-in 
supports mapping of mono or stereo inputs to any sur-
round configuration, as well as setups where the input and 
output channels have the same configuration. In all other 
cases (e. g. 5.1 to stereo), the MixConvert plug-in is used 
to map the channel configuration (see “Using the MixCon-
vert plug-in” on page 237).

While you need to open the plug-in panel to access all of 
the panner features, you can perform basic panning oper-
ations also in the following places:

• In the Mixer, a miniature view of the surround plug-in ap-
pears at the top of the fader section in the channel strip.
You can click and drag directly in the miniature image to move the signal 
source in the surround field.
The volume slider to the right controls the LFE level (if available for the 
selected surround format).

• To view a slightly larger version of the miniature surround 
control in the extended Mixer panel, select the Panner op-
tion on the View Options pop-up menu.
This panner view offers click and drag panning, speaker channel icons 
reflecting the solo/mute and deactivation states, as well as numerical val-
ues for left/right balance, front/rear balance, and LFE amount. You can 
enter values directly or using the mouse wheel.

• In the Inspector, a miniature surround pan control can 
be displayed on the Surround Pan tab.
This panner view offers click and drag panning as well as speaker chan-
nel icons reflecting the solo/mute and deactivation states.

In all miniature panner views you can scale down your 
movements by holding the [Shift] key while moving the 
sound source. This allows you to make fine adjustments.
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The plug-in panel
Double-click on any of the miniature panner controls to 
open the plug-in panel in a separate window.

The SurroundPanner V5 plug-in offers numerous possibili-
ties to position any supported type of sound source, 
whether mono, stereo, or multi-channel. If you work visually 
oriented, you can simply drag the sound source around in 
the pan area. To help you execute very exact movements 
you can use modifier keys to limit the movement direction 
(e. g. for straight front/rear panning). 

To perform rotating movements that you cannot achieve 
by dragging the mouse, you can use the powerful rotation 
and orbit controls below the pan area. Here you will also 
find parameters for controlling the signal distribution to the 
different speaker channels and the advanced scaling con-
trols with which you can influence the size of the sound 
source itself.

To the left and right of the surround field there are volume 
meters, showing the input and output levels of all speaker 
channels. For a detailed description of all the panning op-
tions available in the SurroundPanner V5, see below.

Positioning signals in the pan area
In the pan area, you see a graphical representation of the 
sound source, with the different input channels shown as 
gray balls – except for the left and right front channels that 
are shown in yellow and red. Here, you can position the 
sound source using the mouse:

• By clicking at the desired position in the pan area.
When you release the mouse button, the sound source jumps to that po-
sition (with the positioning handle, i. e. the circle located in the center of 
the sound source, ending up where you clicked).

• By clicking and dragging the positioning handle.
Note that you do not have to click exactly on the handle in order to move 
it. You can click anywhere in the pan area and start moving the mouse, 
the handle then moves in the same direction as the mouse.

The pan area showing a 5.1 sound source

The positioning handle can be positioned freely in the pan 
area and even be moved out of the pan area. The panning 
balls, though, will never move further out than the edge of 
the surround field (which is indicated by a gray line). Mov-
ing the positioning handle out of the pan area can be use-
ful for extreme panning positions, such as panning all 
channels hard right.

For mono channels there is no positioning handle. 
Click and drag the input channel to position it.

Left and right front channels

Positioning 
handle
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Speaker channels – Solo and Mute vs. Disabling

The speakers that are distributed around the surround 
field represent the output configuration. You can disable 
speakers or solo/mute them.

• [Alt]/[Option]-click on a speaker symbol to disable that 
speaker (the speaker symbol is grayed out) so that no au-
dio will be routed to this surround channel. The signal that 
would otherwise be sent to this speaker is distributed to 
the other speakers instead. For example, you can disable 
the center speaker for all stems of a film mix except the di-
alogue to make sure that only dialogue is sent to that 
speaker.
Note that the signal is distributed in such a way that the power level stays 
constant all the time (see “Constant power” on page 237).

• Click on a speaker symbol to solo that speaker (the 
speaker symbol turns red). That way you will only hear the 
signal sent to this speaker. All other speakers are muted 
(yellow speaker symbol). This can be used for testing pur-
poses, e. g. to make sure that a signal is sent to a specific 
speaker as intended.
Note that you can solo several speakers at the same time by clicking on 
them one after the other. By [Ctrl]/[Command]-clicking on a speaker sym-
bol, this speaker is soloed exclusively, and all other speakers are muted.

Solo and Mute cannot be automated!

Restricting movement

By default, you can click anywhere in the pan area and 
drag the mouse to move the sound source. If you want the 
positioning handle to jump to a specific position, you can 
click once at that position.

However, you can also limit movement to a specific direc-
tion, using the corresponding modifier keys (or the arrow 
icons above the pan area). That way you can scale down 
your movements, or have the sound source move along a 
certain axis (e. g. from bottom left to top right).

• When you press a modifier key (e. g. [Ctrl]/[Command]), 
the corresponding icon above the pan area is highlighted 
with a lighter border, indicating that this mode is active.
As soon as you release the modifier key, you return to standard mode.

• By clicking on one of the icons above the pan area, the 
corresponding positioning mode is activated persistently. 
That way you do not have to keep the corresponding mod-
ifier key pressed all the time.
To deactivate the selected positioning mode, switch back to standard 
mode.

The following modes are available:

Panning the left and right channels independently with 
the mouse

At the top right of the plug-in window you will find the but-
ton for the independent positioning mode. If this is acti-
vated, you can adjust the front left and right input channels 
(yellow and red balls) independently by clicking and drag-
ging. This is similar to using the two surround pan joysticks 
found on some hardware consoles.

This speaker 
is muted.

This speaker 
is soloed.

This speaker 
is disabled.

Icon Modifier key(s) Description

- Standard mode, no restrictions apply.

[Shift] Mouse movements are scaled to allow 
very fine movements. This is useful when 
panning in the miniature display in the 
channel strip, for example.

[Ctrl]/[Command] Horizontal movements only.

[Ctrl]/[Command]-
[Shift]

Vertical movements only.

[Alt]/[Option] Diagonal movements only (bottom left to 
top right).

[Alt]/[Option]- 
[Shift]

Diagonal movements only (bottom right to 
top left).

[Shift]- 
[Ctrl]/[Command]- 
[Alt]/[Option]

In this mode the mouse pointer immedi-
ately jumps to the positioning handle even 
if it is located outside the pan area (only 
visible in Overview Mode).

The independent 
positioning mode 
is activated.

The right front channel is panned independently with the mouse.
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To move one of the panning balls in this mode, you do 
not have to click directly on them. You will always move the 
panning ball that is nearer to the position of the mouse 
pointer.

Overview Mode

When moving the sound source in the pan area, you will 
notice that the positioning handle can leave the visible pan 
area (although the channel panning balls cannot). It can 
be moved so far outside that all channels end up on the 
perimeter where the positioning handle left the area. If you 
now use one of the rotation controls, for example, it can be 
quite hard to understand what is happening, i. e. why the 
panning balls are moving the way they are.

To get a better understanding of this behavior, you can 
switch to Overview Mode. Here you can see where the po-
sitioning handle is actually located and where the panning 
balls would be (if they could leave the pan area). These vir-
tual or “ghost” positions are connected to the actual pan-
ning balls inside the surround field by a thin line to help you 
understand complex movements.

• To switch to Overview Mode, click on the eye icon 
above and to the left of the pan area.

The Overview Mode is only used for visualizing the 
complex scenarios that you can create with the Surround-
Panner V5. The actual panning is done in the standard 
view. Therefore, the speakers are visible in this mode, but 
cannot be soloed/muted or disabled.

Left-right and front-rear panning

These two controls are used to pan the sound source 
from left to right and front to rear, and vice versa. This can 
be useful when an object moves through the scene, e. g. a 
car driving through from the left to the right or a spaceship 
passing overhead.

This is the same as restricting the movement direction 
using the [Ctrl]/[Command] and [Ctrl]/[Command]-[Shift] 
modifiers.

Rotating signals

The Rotate Signal control is used to rotate the source 
channels around the positioning handle. All input channels 
circle around the handle (but they cannot move beyond 
the borders of the surround field).

Usually, you would use this control on a premixed stem, 
i. e. a group channel that already has surround qualities. 
For example, if you are working on a scene where the 
camera turns around, you can rotate the surround sound 
source within the surround field of the output bus to imi-
tate this behavior.

! When panning in independent positioning mode, au-
tomation data is written for several parameters. Due 
to this, special automation rules apply, see “Automa-
tion” on page 236.

! Automation data for the independent positioning 
mode is always written for the complete sound 
source, not for individual channels. This means it is not 
possible to record automation for one stereo channel 
and then add automation for the other stereo channel 
in a second go, for example. 

The left and right channels cannot leave the pan area.

The positioning handle is 
located outside the pan 
area.

“Ghost” images of the 
panning balls. These are the 
theoretical positions outside 
the visible pan area.
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Orbit controls

The Orbit controls are used to rotate the sound source 
(including all input channels and the positioning handle) 
around the center of the surround field.

Orbit Center

This is the main control that allows you to perform the ro-
tation. For example, you can use this if a person walks 
around in a scene and can still be heard when walking 
“behind the audience”.

Counter Shot

The Counter Shot control is used to rotate the sound 
source by exactly 180°, thereby “flipping” the surround im-
age to the opposite side. 

For example, this can be used when working on a close-
up scene of two people sitting face to face with a lot of re-
verse shots. With the Counter Shot button you can then 
flip the surround field each time that the camera switches 
from perspective A to perspective B or back. 

This control is best applied to premixes (e. g. the ambi-
ence stem) so that you only have to press the button once 
for each cut.

Tip: When panning a scene with reverse shots with less 
than 180° (so that you cannot use the Counter Shot but-
ton) you can make the necessary adjustments for the first 
perspective of the reverse shot manually, write this as au-
tomation and use the punch log function to save this 
setup. Repeat this for the second perspective, and after-
wards use the punch log entries to switch between the 
two perspectives with just a click. For more information 
about this, see “The Punch Log section” on page 259.

Radius

When using the Orbit Center control, the Radius encoder 
allows you to control the distance of the sound source 
from the center of the surround field (without changing the 
angle).

An example:

The gray circle shows the theoretical path of the sound 
source when orbiting the center. Since the sound source 
cannot leave the pan area, it moves along the perimeter in-
stead. At the maximum radius setting (a) the theoretical 
path lies outside the pan area so that the sound source 
stays on the perimeter all the time; at a smaller setting (b) 
the circle is smaller and the sound source moves inside 
the pan area in the corners.

The Rotate Signal, Orbit Center, and Radius controls 
are endless rotary encoders so that there is no limit as to 
how far left or right you can rotate the sound source.

The LFE encoder

Use the LFE encoder in the plug-in panel to set the signal 
amount sent to the LFE (Low Frequency Effects) channel. 
You can also set this using the LFE level slider to the right 
of the panner in the Mixer channel strip, or by typing in a 
number in the LFE value field in the panner shown in the 
extended Mixer view.

Orbit Center

Counter Shot

Radius

! In terms of automation, the Orbit Center, Counter 
Shot, and Radius controls are not independent pa-
rameters as such. Instead, a combination of different 
automation parameters is used. For more informa-
tion, see “Automation” on page 236.

a) Radius = 141.4 b) Radius = 116.5
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• If the selected input already contains an LFE channel 
(x.1 configuration), it is routed through the SurroundPan-
ner V5 and the LFE encoder is used to control the volume 
of this channel.

• If the selected input does not contain an LFE channel 
(x.0 configuration), all input channels are distributed 
evenly to the output LFE channel. In this case, it might be 
useful to raise the volume of this “downmix” using the LFE 
encoder.

The LFE channel is used as a full range channel, no 
low-pass filtering is applied.

Center Distribution

The Center Distribution control is used to distribute part or 
all of the center signal to the left and right front speakers.

For example, this can be useful in the following situation: 
The center signal is panned directly to the center speaker 
and the Center Distribution is set to 0 %. However, the 
signal is too discrete for your liking, and you want to add 
part of the signal to the left and right front speakers to 
widen it. You can do this by raising the Center Distribution 
value. At 100 %, the center source is provided entirely by 
the phantom image created by the left and right speakers 
and using a value in between you can distribute the signal 
to the three speakers.

A blue line at the top of the surround field indicates the 
distance up to which a phantom signal is added. If you po-
sition the source signal inside this range, the signal is sent 
to all three channels.

Divergence controls

The three divergence controls (Front, F/R, and Rear) deter-
mine the attenuation curves used when positioning sound 
sources for X-axis front, Y-axis (front/rear), and X-axis back. 
If all three controls are set to 0 %, positioning a sound 
source on a speaker sets all other speakers to zero level. 
With higher values, the other speakers receive a percent-
age of the sound source.

Blue horizontal and vertical lines visualize the effects when 
changing the divergence settings.

For example, by using the front divergence, you can 
acoustically intensify the distance from the action on 
screen as perceived by the viewer.

• At 0 % the perception is very focussed (concentrated in one 
spot). This can be used for movements close to the camera to 
intensify the feeling that something is taking place right in front 
of the viewer.

• At 100 % the perception is very diffuse (hard to locate). This 
can be used for actions that are taking place at the far back of 
the scene, giving the audience the feeling that it is far away 
from the action.

The Center Distribution value and the front divergence 
are combined. If the front divergence is set to 100 %, the 
Center Distribution has no effect.

Scaling

The Scale controls allow you to control the horizontal 
(Width) and vertical (Depth) expansion of the sound 
source. 100 % corresponds to the complete width or 
depth of the surround field. If you reduce both values to 
0 %, the distance is reduced to zero and all source chan-
nels are centered in one spot.

! Note that for this to work, the front speaker configu-
ration needs to be symmetrical and there can never 
be more than 3 speakers involved.
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These controls influence the perception of spatiality and 
ambience, as well as the traceability of signals.

• At 100 % you get a very transparent, clear sound that conveys 
much spatiality.

• At 0 % the signal is less transparent and movements cannot 
be traced easily.

The Depth parameter is only available for configura-
tions with front and rear channels.

Input and output level meters
The meters to the left and right of the pan area show the 
volume of all input and output speaker channels, respec-
tively. The numeric values below the meters indicate the 
peak level that has been measured for any of the channels.

General plug-in controls

The Bypass Effect button

At the top left of the plug-in panel you will find a button to 
bypass the SurroundPanner V5. If this is activated, the in-
put signals are directly routed to the output channels (in 
case of an identical input and output configuration). If the 
output configuration is different from the input configura-
tion, the panner attempts to route the input signals to the 
appropriate output channels (e. g. the left and right front 
speakers if panning a stereo signal to a 5.1 configuration).

When using the SurroundPanner V5 as an insert ef-
fect, this button has the same function as the Bypass Ef-
fect button available for all audio plug-ins (see 
“Deactivating vs. bypassing” on page 198).

Mute/Solo buttons

At the top of the plug-in panel you will find a Mute and a 
Solo button that are identical with the channel’s Mute/
Solo controls (see “Using Solo and Mute” on page 159). 

These buttons are not present when the Surround-
Panner V5 is used as an insert effect.

Read/Write buttons

Like any other effect plug-in, the SurroundPanner V5 has 
Read and Write buttons at the top of the window to apply 
and record automation data (see below). When the pan-
ner is used on an output channel, these buttons are iden-
tical with the channel’s Read and Write buttons. When 
used as an insert effect, automation data for this insert is 
written separately.

Automation
Most of the parameters in the SurroundPanner V5 plug-in 
can be automated just like any other channel or insert pa-
rameter (see “Enabling and disabling the writing of auto-
mation data” on page 240).

Recording automation for the Orbit controls and the inde-
pendent positioning mode is handled differently, however. 
Automation data for these parameters is written as a com-
bination of the front-rear panning, left-right panning and 
the Rotate Signal parameters. For the independent posi-
tioning mode, Scaling is added. Due to this you cannot 
easily modify existing automation data since this would in-
volve too many different parameters. If an automation pass 
did not yield the desired result, simply try again.

Resetting all parameters

[Alt]/[Option]-click the Reset button in the lower right cor-
ner of the plug-in panel to reset all controls to their default 
values.

Bypass Effect button
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Pinning the SurroundPanner V5 window
When working with multiple channels in a surround con-
figuration, the screen might become overcrowded with 
plug-in windows and you can easily lose track of where 
each panner window belongs.

If you want to work with only one panner window at a time, 
you can open the SurroundPanner V5 for one of your chan-
nels and activate the “Pinned window follows VST channel 
selection” button at the top of the plug-in panel. When you 
now select a different channel or bus, the settings for the 
new channel are displayed in the same window.

“Pinned window follows VST channel selection” is activated

Standard panners and the MixConvert plug-in are also 
shown in the pinned window. However, if you select a 
channel for which no panner view is available, the pinned 
window continues to show the last available panner view. 
In this case the panner view will not be consistent with the 
selected channel.

• If necessary, you can still open additional SurroundPan-
ner windows by double-clicking the corresponding minia-
ture panner view in the Mixer channel strip (or the extended 
Mixer view).
These “auxiliary” panner views will have no “Pinned window follows 
channel selection” indicator.

Constant power
“What goes in, must come out again.” This principle can 
be taken literally with regard to the SurroundPanner V5. It 
means that the power of a source channel is identical to 
the power of the corresponding output signal.

The advantage of this is that the overall volume as per-
ceived by the listener (= the power) is always the same, 
regardless of the signal panning, e. g. when you move the 
sound source in the pan area, disable specific speaker 
channels, or use the divergence controls.

Using older projects with the 
SurroundPanner V5
If you load a project that was created with a previous ver-
sion of Nuendo and still uses the old SurroundPan plug-in, 
you can either continue using the old panner plug-in or 
switch to the SurroundPanner V5 plug-in. To do this, right-
click the miniature panner view of the corresponding track 
in the Mixer and select the “SurroundPanner V5” option 
from the context menu.

Switching to the SurroundPanner V5.

Using the MixConvert plug-in
MixConvert is a special plug-in that converts one multi-
channel audio source into another multi-channel destina-
tion. It is most frequently used to “downmix” a multi-chan-
nel surround mix into a format with fewer channels (a 5.1 
surround mix into a stereo mix for example).

This plug-in can be used as an insert effect in the Mixer like 
other plug-ins but it also has special functions. Nuendo au-
tomatically inserts MixConvert instead of the SurroundPan-
ner V5 when the channel (audio track, group channel, etc.) 
is routed to a destination with fewer audio paths. MixCon-
vert is also inserted in place of any aux send panner when 
the destination has a different audio path than the source.

! A panner instance cannot be opened in more than 
one window at once. If “Pinned window follows VST 
channel selection” is activated and you step through 
your channels (e. g. in the Mixer), those channels with 
“auxiliary” windows are skipped.

! The automation data for the SurroundPan plug-in 
and the SurroundPanner V5 are not compatible. If 
you switch to the new panner, you will have to delete 
any existing panner automation for the correspond-
ing track and write new automation data. If you want 
to keep working with the existing data you have to 
use the SurroundPan plug-in!
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The MixConvert plug-in is described in detail in the sepa-
rate PDF document “Plug-in Reference”.

There is one exception to this behavior. When a stereo 
channel is routed to a mono destination through the chan-
nel routing or an aux send routing, a normal stereo panner 
will appear. However, this panner will control the balance 
of the left and right channels as they are blended into the 
mono destination. The center position blends both chan-
nels together by equal amounts. With the pan set all the 
way to the left, only the left channel can be heard, and vice 
versa.

Exporting a surround mix
When you have set up a surround mix, you can choose to 
export it using the Export Audio Mixdown function. 

You have the following export options when working with 
a surround configuration:

• Export to “split” format, resulting in one mono audio file 
for each surround channel.

• Export to interleaved format, resulting in a single multi-
channel audio file (e.g. a 5.1 file, containing all six surround 
channels).

• Under Windows you can also export a 5.1 surround mix 
to a file in Windows Media Audio Pro format.
This is an encoding format tailored for 5.1 surround – see “Windows Me-
dia Audio Pro files (Windows only)” on page 480.

For details about exporting to files, see the chapter “Export 
Audio Mixdown” on page 473.
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Introduction
In essence, automation means recording the values for a 
particular Mixer or effect parameter. When you create your 
final mix, you will not have to worry about having to adjust 
this particular parameter control yourself – Nuendo will do 
it for you. Automation is a key feature when mixing in com-
plex, multi-track projects.

Working with automation curves
Within a Nuendo project, the changes in a parameter 
value over time are reflected as curves on automation 
tracks. 

About automation curves 
There are two kinds of automation curves: “ramp” and 
“jump”:

• Jump curves are created for on/off parameters such as 
Mute.

• Ramp curves are created for any parameter that gener-
ates continuous multiple values, such as fader or encoder 
movements, etc. 

Examples of jump and ramp automation curves 

About the static value line
When you are not using virgin territory (see “Virgin terri-
tory vs. the initial value” on page 245) and you open an 
automation track for the first time, it does not contain any 
automation events (unless you have previously adjusted 
the corresponding parameter with Write automation acti-
vated). This is reflected in the event display as a straight 
horizontal black line, the “static value” line. This line repre-
sents the current parameter setting.

• If you have manually added any automation events or 
used write automation for the corresponding parameter 
and then disable the reading of automation data, the auto-
mation curve will be grayed-out in the event display and 
the static value line will be used instead.
As soon as Read is enabled, the automation curve will become available.

Enabling and disabling the writing 
of automation data
You can automation enable tracks and Mixer channels in 
Nuendo by activating their automation Write buttons. 
Write (W) and Read (R) buttons for all plug-in effects and 
VST instruments can be found on the corresponding con-
trol panels.

• If you activate Write for a channel, virtually all Mixer pa-
rameters you adjust during playback for that specific 
channel are recorded as automation events.

• If Read is activated for a channel, all your recorded Mixer 
actions for that channel are performed during playback.

The Read and Write buttons for a track in the track list are 
the same as the Read and Write buttons in the corre-
sponding channel strip in the Mixer.

Note that the Read button is automatically enabled 
when you enable the Write button. This allows Nuendo to 
read existing automation data at any time. You can sepa-
rately deactivate Write if you want to only read existing 
data. It is not possible to activate Write and deactivate 
Read at the same time.

There are also global Read and Write indicator buttons 
(“Toggle Read/Write for all tracks”) in the common panel 
of the Mixer and at the top of the track list:

These buttons light up as soon as there is an enabled Read 
or Write button on any channel/track within your project. 
Furthermore, they can be clicked to activate or deactivate 
the Read/Write buttons of all tracks simultaneously.

The Write and Read buttons for a channel in the Mixer 
and for an automation track in the track list

The global Read/Write buttons in the Mixer, and in the 
track list
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You will also find global Read/Write buttons on the 
Automation panel, see “The Read/Write buttons” on page 
248.

Writing automation data 
There are two approaches you can use to create automa-
tion curves: manually (see “Manual writing of automation 
data” on page 241) and automatically (see “Automatic 
writing of automation data” on page 241). While manual 
writing makes it easy to quickly change parameter values 
at specific points without having to activate playback, au-
tomatic writing lets you work much like you would using a 
“real” mixer. 

With both methods, any applied automation data will be 
reflected in both the Mixer (a fader will move for example) 
and in the corresponding automation track curve. 

Automatic writing of automation data
Every action you perform is automatically recorded on au-
tomation tracks which you can later open for viewing and 
editing. 

To enable the recording of automation events, proceed as 
follows:

1. Open an automation track by clicking on the “Show/
Hide Automation” button of a track in the track list.

2. Enable the Write button for the track and adjust the 
desired parameters in the Mixer, in the Channel Settings 
window, or in the effect control panel while rolling through 
the project.
The value settings are recorded and displayed as a curve on the automa-
tion tracks. When automation data is being written, the color of the auto-
mation track changes to red and the delta indicator in the automation 
track shows the relative amount by which the new parameter setting de-
viates from any previously automated value.

3. When you are finished, stop playback and return to the 
position where you started playback.

4. Disable Write.
The Read button remains enabled.

5. Start playback.
All actions you recorded will be reproduced exactly.

When dragging a plug-in to a different insert slot on 
the same channel, any existing automation data will move 
with the plug-in. When you drag it to an insert slot on a 
different channel, any existing automation data will not be 
transferred to the new channel.

Manual writing of automation data
You can add automation events manually by drawing auto-
mation curves on an automation track. Proceed as follows:

1. Open an automation track by clicking on the “Show/
Hide Automation” button of a track in the track list.

2. In the track list, click on the automation parameter 
name and select the desired parameter from the pop-up 
menu.

3. Select the Pencil tool.
You can also use various modes of the Line tool for drawing curves, see 
below.

4. Click on the static value line. 
An automation event is added, read automation mode is automatically 
activated, and the static value line changes to a colored automation 
curve.

5. If you click and hold, you can draw a curve by adding 
many automation events.
Note that the track color in the track list changes to red to indicate that 
automation data is being written.

6. When you release the mouse button, the number of 
automation events is reduced, but the basic shape of the 
curve remains the same.
This “thinning out” of events is governed by the Reduction Level setting 
in the Settings section of the Automation panel, see “Reduction Level” 
on page 260.
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7. If you now activate playback, the automated parameter 
will change with the automation curve.
In the Mixer, the corresponding fader moves accordingly.

8. Repeat the procedure if you are not happy with the 
result.
If you draw over existing events, a new curve is created.

Apart from the Pencil tool, you can use the following tools 
to draw automation events:

• Arrow tool 
If Read is activated and you click on an automation track with the arrow 
tool, you can add automation events. Note that events introduced be-
tween two existing events that do not deviate from the existing curve are 
removed as soon as you release the mouse button (see “Reduction 
Level” on page 260).

• Line tool – Line mode
If you click on the automation track and drag with the Line tool in Line 
mode, you can create automation events in a line. This is a quick way to 
create linear fades, etc.

• Line tool – Parabola mode
To activate the Line tool in Parabola mode, click on the Line tool and click 
again to open a pop-up menu where you can select the Parabola option. If 
you click and drag on the automation track with the Line tool in Parabola 
mode, you can create more “natural” curves and fades. Note that the result 
depends on the direction from which you draw the parabolic curve.

• Line tool – Sine, Triangle, or Square mode
To activate the Line tool in these modes, click on the Line tool and click 
again to open a pop-up menu where you can select the desired option. If 
you click and drag on the automation track with the Line tool in Sine, Tri-
angle, or Square mode and snap to grid is activated, the period of the 
curve (the length of one curve “cycle”) is determined by the grid setting. 
If you press [Shift] and drag, you can set the period length manually, in 
multiples of the grid value.

The Line tool can only be used for ramp type automa-
tion curves.

Editing automation events
Automation events can be edited much like other events. 
You can cut, copy, paste, group, and nudge events, etc.

Selecting automation events
• To select a single automation event, click on it with the 
Arrow tool.
The event turns red, and you can drag it in any direction between two 
events.

• To select multiple events, you can either [Shift]-click on 
the events or drag a selection rectangle with the Arrow 
tool.
All events inside the selection rectangle will be selected.

Drawing a selection rectangle around events to select them.

• To select all automation events on an automation track, 
right-click the automation track in the track list and choose 
“Select All Events” from the context menu.

Removing automation events
There are several ways to remove events:

• By selecting events and pressing [Backspace] or [De-
lete] or selecting Delete from the Edit menu, or by clicking 
on an event with the Erase tool.
This will remove the events. The curve is redrawn to connect the remain-
ing events.

• By selecting a range (with the Range Selection tool), 
and pressing [Backspace] or [Delete] or selecting Delete 
from the Edit menu.
When “Use Virgin Territory” is enabled, this will create a gap. When “Use 
Virgin Territory” is disabled, this will remove the events within the range, 
but the curve will be redrawn to connect new events at the start and end 
of the selected range (see also “Gaps” on page 246).
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• By clicking on the automation parameter name in the 
track list and selecting “Remove Parameter” from the pop-
up menu.
This will remove all automation events from the automation track, and the 
automation track will be closed.

Automation track operations
Most of the tracks in your project have automation tracks, 
one for each automated parameter. Automation tracks are 
hidden by default. 

Opening automation tracks 
To open an automation track for a channel, proceed as fol-
lows:

• Position the mouse pointer over the lower left corner of 
the track and click the arrow icon (“Show/Hide Automa-
tion”) that appears.

• Right-click the track in the track list and select “Show 
Automation” from the context menu.

The event display shows a straight black horizontal line as 
well as a grayed out mirror image of the audio events’ wave-
form (or MIDI events for MIDI tracks). By default, the Vol-
ume parameter is assigned to the first automation track.

• To open another automation track, position the mouse 
pointer over the lower left corner of an automation track, 
and click the “+” sign (“Append Automation Track”) that 
appears.
By default, the new automation track shows the next parameter in the 
Add Parameter list (see below).

You can click the “Append Automation Track” button (the 
“+” sign) for the automation track several times to open 
additional automation tracks. 

Assigning a parameter to an automation track
Default parameters are already assigned to automation 
tracks when you open them, according to their order in the 
Add Parameter list.

To select which parameter an open automation track dis-
plays, proceed as follows:

1. Open an automation track and click on the automation 
parameter name.
A parameter list is shown. The contents depend on the track type.

• If the parameter you wish to automate is available on the 
pop-up menu, you can select it directly.

• If you wish to add a parameter not available on the pop-
up menu or if you want to view all parameters that can be 
automated, proceed with the next step.

Click here to open an 
automation track.
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2. Select “More…”.
The Add Parameter dialog opens. This dialog shows a list with all parame-
ters that can be automated for the selected channel (sorted into different 
categories), including the parameters for any assigned insert effects. To 
view the parameters in a category, click the “+” sign for the corresponding 
category folder.

The Add Parameter dialog for an audio track

3. Select a parameter from the list and click OK.
The parameter will replace the current parameter in the automation track.

Note that the “replacing” of the parameter displayed in the 
automation track is completely non-destructive. If the au-
tomation track contains any automation data for the pa-
rameter you just replaced, this data is there, although it is 
not visible. By clicking on the automation parameter name 
in the track list, you can switch back to the replaced pa-
rameter. On the pop-up menu, all automated parameters 
are indicated by an asterisk (*) after the parameter name.

Automated parameters

Repeat the above procedure to assign a parameter to 
each available automation track.

Tempo changes cannot be automated on automation 
tracks. This is done using the tempo recording function in 
the Tempo Track Editor, see “Recording tempo changes” 
on page 456.

Removing automation tracks 
• To remove an automation track together with all auto-
mation events, click the parameter name and select “Re-
move Parameter” from the pop-up menu.

• To remove all automation tracks from a track that do not 
contain automation events, select “Remove Unused Para-
meters” from any of its automation parameter name pop-up 
menus.

• To remove automation tracks, you can also use the De-
lete options on the Functions pop-up menu of the Automa-
tion panel, see “The Functions pop-up menu” on page 251.

Showing/hiding automation tracks
• To hide a single automation track, position the pointer 
over the top left border of the automation track in the track 
list and click the “Hide Automation Track” button (the “-” 
sign).

• To hide all automation tracks for a track, right-click the 
corresponding track, and select “Hide Automation” from 
the context menu.
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• To hide all automation tracks for all tracks in the track 
list, right-click any track and select “Hide All Automation” 
from the context menu.
This option is also available on the Track Folding submenu of the Project 
menu.

• To show or hide automation tracks, you can also use the 
options in the Show section of the Automation panel, see 
“The Show options” on page 260.

Showing only used automation tracks

If a lot of automation tracks are used, it may be impractical 
to have them all open in the track list. If you want to view 
only the automation tracks that are used (i. e. those that ac-
tually contain automation events), do one of the following:

• To close all automation tracks not containing automa-
tion events, right-click any track in the track list and select 
the “Show All Used Automation” option from the pop-up 
menu.
This option is also available on the Track Folding submenu of the Project 
menu. 

• To close all automation tracks for the selected track that 
do not contain any automation events, right-click a spe-
cific track and select the “Show Used Automation (Se-
lected Tracks)” option from the context menu.
Used automation tracks will be left open. 

Muting automation tracks

You can mute individual automation tracks by clicking their 
Mute buttons in the track list. This allows you to turn off 
automation for a single parameter.

The “Automation follows Events” setting
If you activate the “Automation follows Events” option on 
the Edit menu (or in the Preferences dialog, on the Editing 
page), automation events will automatically follow when 
you move an event or part on the track. 

This makes it easy to set up automation related to a spe-
cific event or part, rather than to a specific position in the 
project. For example, you can automate the panning of a 
sound effect event (having the sound pan from left to right, 
etc.) – if you need to move the event, the automation will 
automatically follow! 

The rules are:

• All automation events for the track between the start 
and end of the event or part are moved.
If there are automation events at the new position (to which you move the 
part or event), these are overwritten.

• If you copy an event or part, the automation events are 
duplicated as well.

Virgin territory vs. the initial value

Before we go into detail about the various modes and op-
tions available on the Automation panel, we need to ex-
plain how Nuendo handles those sections of your project 
in which you have not yet performed an automation pass. 

For parameter automation, Nuendo works either with an 
initial value or with “virgin territory”. 

It is very important that you understand the difference be-
tween these two concepts and their individual advantages 
and disadvantages before continuing.

! When we speak of “touching a control” in the follow-
ing sections, we mean both clicking a parameter 
control on the Nuendo program interface and physi-
cally touching a fader or other control on a remote 
control device.
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The initial value
An initial value is always used when “Use Virgin Territory” 
is disabled in the Automation Settings (see “Automation 
Preferences” on page 260).

When no automation data exists for a particular parameter, 
the starting point of an automation pass is saved as the ini-
tial value. When you punch out of the automation pass, it is 
this initial value to which the parameter will return.

This has one very important consequence: As soon as the 
initial value is set, the corresponding parameter is fully au-
tomated for the complete track, at any given timecode po-
sition of the project – even if your automation pass lasted 
only 2 seconds.

The straight line after the last automation event corresponds with the 
initial value.

When you release a control, it returns to the value defined 
by the automation curve – even when in Stop mode.

Virgin territory
Think of virgin territory as the “state” of the automation 
track before performing the first automation pass. When 
you enable the “Use Virgin Territory” option, no automa-
tion curve is displayed on the automation track, and you 
have full manual control of the parameter.

The idea here is that you find automation only where you 
actually perform an automation pass – there is no initial 
value to which the parameter can return.

Gaps

After an automation pass you will find virgin territory only 
to the right of the last automation event. “Empty” sections 
between two automation curves are referred to as “gaps” 
in the following sections. 

Only the dynamic change in the parameter is automated.

If you want to create gaps inside a section with automated 
values, proceed as follows:

1. Open the Automation Settings and make sure that 
“Use Virgin Territory” is enabled (see “Automation Prefer-
ences” on page 260).

2. Select the Range Selection tool.

3. On an automation track with existing automation data, 
select a range and press [Delete] or [Backspace].
A gap is created.

New events at the beginning and the end of the selection 
range mark the end point of the automation curve (to the 
left) and the start of the next automation curve (to the right 
of the gap).

• When you select one or more events of an automation 
curve with the Arrow tool and press [Delete] or [Back-
space], no gap is created.
Instead, the selected events are deleted. The curve between the deleted 
events is replaced by a new line connecting the two events to the left and 
right of the deleted events.
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The “Terminator” setting

You can “force” any automation track into using virgin ter-
ritory, by defining any automation event on the automation 
curve as the “terminator” point of this part of the curve. 
This will automatically delete the line between this event 
and the next one, creating a gap.

Note that this is independent of the setting for “Use 
Virgin Territory” – you can create gaps at any time.

• To define an event as the last point in an automation 
curve, select it by clicking on it, and in the Event info line in 
the Project window, set “Terminator” to Yes.

• When you set the “Terminator” option for the last (right-
most) automation event of an automation curve to “Yes”, 
any automation data to the right of this event (as defined 
by an initial value) is deleted.

If you select an 
event and set 
“Terminator” to 
Yes…

…a gap is created.
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The Automation panel

The Automation panel is a floating window, similar to the 
Mixer and Transport panel, and can be left open while you 
work. The Project window will always have the focus.

To show the Automation panel, open the Project menu 
and select the Automation Panel option or click the “Open 
Automation Panel” button on the Project window toolbar.

The Read/Write buttons 
In the upper part of the Automation panel, you will find 
Read and Write buttons. These are used to globally en-
able or disable the Read and Write buttons on all tracks.

• Click “Activate Read for all tracks” to enable all Read 
buttons on all tracks/channels of your project.
Clicking “Deactivate Read for all tracks” will disable all Read buttons.

• Click “Activate Write for all tracks” to enable all Write 
buttons (and, at the same time, all Read buttons) on all 
tracks/channels of your project.
Clicking “Deactivate Write for all tracks” will disable all Write buttons. 
The Read buttons will remain enabled.

Automation modes
Nuendo provides three different punch out modes for au-
tomation, available on the upper part of the Automation 
panel and on the Automation Mode pop-up menu on the 
Project window toolbar.

The three modes available are “Touch”, “Auto-Latch”, and 
“Cross-Over”. In all three modes, automation data will be 
written as soon as a parameter control is touched in play 
mode. They differ in the way the writing of automation data 
is ended, i. e. in their “punch out” behavior.

The automation mode set on the Automation panel or 
the Project window toolbar is used globally for all tracks of 
your project. If you want to select a different automation 
mode for individual tracks, select the track and on the 
“Track Automation Mode” pop-up menu in the Inspector 
choose the corresponding option.

Click here… …to open the Automation panel.

…and on the Project window toolbar.

Selecting the automation mode on the Automation panel…
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Note that you can change the automation mode at any time, 
i. e. in play or stop mode or during an automation pass. You 
can also assign key commands to the automation modes, 
see “Automation key commands” on page 261.

The current automation pass will always punch out as 
soon as one of the following conditions is met, indepen-
dent of which automation mode is selected:

• If you disable Write.
• If you stop playback.
• If you activate Fast Forward/Rewind.
• If the project cursor reaches the right locator in Cycle mode.
• If you click in the ruler to move the project cursor (this is user-

definable and can be controlled via the Automation panel, see 
“Automation Preferences” on page 260).

Touch

Typically, you use Touch mode in situations where you 
want to make a change lasting only a few seconds to an 
already set up parameter.

As the name implies, Touch will write automation data only 
for as long as you actually touch a parameter control – 
punch out occurs as soon as you release the control.

After punch out, the control will return to the previously set 
value. The Return Time setting (see “Automation Prefer-
ences” on page 260) determines how long it takes for the 
parameter to reach the previously set value.

Auto-Latch

In Auto-Latch mode, there is no specific punch out condi-
tion other than those valid in all modes, see above.

Auto-Latch is useful in situations where you want to keep 
a value over a longer period of time – for example when 
making EQ settings for a particular scene.

Once your pass has started, the writing of automation 
data continues for as long as playback lasts or Write is 
enabled. When you release the control, the last value is 
kept until you punch out.

The automation mode for On/Off switches is always 
Auto-Latch (even if another mode is selected globally or 
for the track).

Cross-Over

The Cross-Over mode is a kind of “manual return time” op-
tion (see “Automation Preferences” on page 260). The 
Cross-Over mode can be used in situations where you are 
not satisfied with an automation curve or with the automati-
cally applied return settings. Cross-Over mode allows you 
to perform a “manual return” to ensure smooth transitions 
between new and existing automation settings.

For Cross-Over, the punch out condition is crossing over 
an already existing automation curve after touching the 
parameter for a second time.

Like in Auto-Latch mode, once the automation pass be-
gins with the first touching of the parameter control, auto-
mation data is written for as long as playback lasts.

When you have found the correct value setting, you can 
release the fader – the automation pass continues, with 
the value setting remaining the same.
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Now, re-touch the fader and move it towards the original 
value. As soon as you cross the original curve, punch out 
occurs automatically.

Trim

Trim allows you to update data from a previous pass by 
adding or removing automation data.

Trim works for channel volume and aux send level ad-
justments.

When enabling Trim on the Automation panel, a trim curve 
is positioned in the exact middle position of your automa-
tion track. You can use the trim curve to modify the original 
automation curve. Just drag the trim curve up or down and 
add automation events to it. These increase or decrease 
the values of the original automation curve, but allow you 
to preserve the original data. 

Trim data is edited like any other automation data and it is 
stored with the project. When Trim is activated, all editing 
and recording affects the trim curve. When you deactivate 
Trim, the original automation curve will be reset and gets 
active so that you can edit it. 

You can use Trim either in Stop or in Play mode:

• In Stop mode, you can select one of the Fill options (see 
“The Fill options” on page 254) and edit the trim curve man-
ually by clicking on it and moving it up or down. The original 
automation curve is displayed in a lighter color and its val-
ues are merged with the trim curve. The resulting automa-
tion curve is displayed in a darker color. 

• In Play mode, the events of the original automation curve 
are trimmed as the project cursor passes over them.

Trim in Play mode, in combination with Fill to Punch

Freeze Trim

You can freeze your trim curve automatically or manually 
and render all trim data into a single automation curve. 

To freeze your trim curve automatically, open the Freeze 
Trim pop-up menu in the Automation Settings and select 
“On Pass End” to perform a freeze whenever a write oper-
ation is finished, or “On Leaving Trim Mode” to freeze the 
trim data when Trim mode is switched off (globally or indi-
vidually for a track).

Trim curve Original automation 
curve

Resulting automation 
curve
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To freeze your trim curve manually, select the correspond-
ing option on the Freeze Trim pop-up menu in the Automa-
tion Settings (see “Automation Preferences” on page 260). 
You have the following possibilities to freeze your trim data 
manually:

• On the automation track, click on the parameter name 
and select the “Freeze Trim” option from the pop-up menu 
to freeze a specific parameter of one track.

• Open the Functions pop-up menu on the Automation 
panel and select “Freeze All Trim Automation in Project” to 
freeze all tracks in the project.

• Open the Functions pop-up menu on the Automation 
panel and select “Freeze Trim Automation of Selected 
Tracks” to freeze all selected tracks.

The Functions pop-up menu
At the top right of the Automation panel, you will find the 
Functions pop-up menu, which contains a number of glo-
bal automation commands.

The following functions are available:
About the Global Snapshot options

It is possible to save Mixer settings for automatable mixer 
parameters. These can be reapplied later, e. g. if you have 
accidentally overwritten your parameters. 

The global snapshot options are a quick way to save a 
backup copy of your automatable Mixer parameters and to 
reapply them later. Snapshots can be used to store values 
only for parameters that have been changed. 

Snapshots are saved with the project.

You can only save one snapshot at a time. By storing a 
snapshot, a previously stored snapshot may be overwritten!

Function Description

Delete All Automation 
in Project

This removes all automation data from your 
project. 

Delete Automation of 
Selected Tracks

This removes all automation data for the selected 
track(s). 

Delete Automation in 
Range

This deletes all automation data between the left 
and right locators on all tracks. 

Fill Gaps on Selected 
Tracks

This option is used with virgin territories (see “Virgin 
territory vs. the initial value” on page 245). Select 
this option to fill any gaps in the automation curves 
of the selected tracks with a continuous value. 
The value of the last event (the end point) of a sec-
tion is used to fill the gap. This value is written 
across the gap up to one millisecond before the first 
event of the next automated section. A new event is 
inserted here; the value will be ramped to the next 
automated section.

Fill Gaps with Current 
Value (Selected 
Tracks)

This option is used with virgin territories (see “Vir-
gin territory” on page 246). Select this option to fill 
any gaps in the automation curves of the selected 
tracks. The gaps will be filled with the current value 
of the corresponding control.

Create Initial  
Parameter Events

This function creates and stores the initial automa-
tion values for each automatable parameter in the 
Mixer. For parameters that have not been auto-
mated yet, automation events are created at the 
current parameter position, i. e. at value 0.
As initial parameter events are created on all chan-
nels, all channels will have automation data, even if 
you did not add automation to them. If this is not 
what you want, use the Global Snapshot function 
instead (see “About the Global Snapshot options” 
on page 251).

Freeze All Trim Auto-
mation in Project

This freezes all trim automation for all tracks in the 
project, see “Freeze Trim” on page 250.

Freeze Trim Automa-
tion of Selected 
Tracks

This freezes all trim automation for the selected 
tracks, see “Freeze Trim” on page 250.

Global Snapshot: 
Store

Use this function to save all automatable Mixer pa-
rameters as a snapshot.

Global Snapshot: 
Apply

Use this function to apply the stored snapshot.

Global Snapshot: 
Remove

Use this function to remove the stored snapshot.

Function Description
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Working with Automation Passes
An automation pass begins with the first parameter that is 
written after activating Write automation and starting play-
back. It ends when playback stops, either when you click 
the Stop button or when the position cursor jumps to an-
other position (e. g. because Cycle or Arranger mode is 
activated). You can undo automation passes in the Auto-
mation Pass history.

To work with automation passes, proceed as follows: 

1. Enable the “Activate Automation Passes” button at the 
top right of the Automation panel. 
The Passes button is enabled to the right. 

2. Click the Passes button to open the automation pass 
history.
When you open the history for the first time, it will be empty.

3. Activate write automation and perform some actions.
The “Activate Automation Passes” button turns red to indicate that an 
automation pass is running.

4. When you have written automation passes that you 
want to undo, drag the horizontal line upwards with the 
mouse or use the key command [Ctrl]/[Command]-[Alt]/
[Option]-[Z] for “Undo Pass”. 
The corresponding automation events on the automation track are re-
moved and the entries in the Automation pass history are grayed out. The 
State column displays “Undone” instead of “Executed”.

5. If you want to redo automation passes again, drag the 
horizontal line downwards with the mouse or use the key 
command [Ctrl]/[Command]-[Alt]/[Option]-[Shift]-[Z] for 
“Redo Pass”.
The corresponding automation events on the automation track will be in-
serted and the State column shows “Executed” again.

Automation passes are not created when you write au-
tomation manually. If you want to undo manually written 
automation events use the Edit History instead (see “The 
Edit History dialog” on page 79).

Using Undo Branches

If you activate the “Use Undo Branches” option in the Au-
tomation Settings or in the Preferences dialog (General 
page), the use of branches is enabled. Branches are use-
ful if you want to experiment with different automation vari-
ations/settings.

! All automation that you performed manually as well 
as other edits and processes performed during or 
after the automation passes will also be undone. 
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A branch is a sequence of automation passes. In a branch 
each automation pass is represented by a rectangle with 
the number of the automation pass. Automation that you 
perform manually, as well as other edits and processes in 
between automation passes, are represented by smaller 
rectangles. These rectangles only serve as indicators, they 
cannot be used to undo the edits.

When you undo an automation pass and subsequently 
write new automation, a new branch is created and all fol-
lowing automation passes are gathered in the new branch. 

If you have two or more branches, you can choose to undo 
the automation passes of the separate branches in the au-
tomation pass history by activating and deactivating spe-
cific branches.

The automation pass history with two branches

To deactivate a specific branch, proceed as follows:

1. Click on a branch in the right section of the dialog to 
select it.
The actions of the selected branch are displayed in the left section of the 
dialog. 

2. Click the “Activate Selected” button to deactivate all 
subsequent branches.
The button turns gray and all automation passes from the subsequent 
branches are undone. The automation passes of the activated branch are 
redone until the branch ends, i. e. the first edit(s) of a following branch will 
be merged back into it. 

• If you want to activate a deactivated branch, select the 
desired branch and click the “Activate Selected” button. 
You can also double-click on a branch to select and acti-
vate it at the same time.

• If you want to undo and delete a branch, click the “Re-
move Inactive” button.
All branches will be removed. The actions of the inactive branch will dis-
appear completely whereas the actions of the active branches will be 
merged.

3. When you are done, click “Activate Automation 
Passes” to return to the regular Automation panel.

The automation pass history is not saved with the 
project, i. e. if you close your project, the history is deleted.

The Join options

When several editors work on the same project simulta-
neously, running automation passes often have to be in-
terrupted. The Join options help you to resume write 
automation on controls that were active at the point where 
the transport stopped by storing which parameters were 
punched in on stop. Nuendo allows you to resume inter-
rupted automation passes.

Branches

Automation 
pass

Manual automation 
or other edits

! The removing of inactive branches cannot be undone!

! The Join options are not available in Touch mode!
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The following Join options are available:

Join Now

If you hit Stop and want to resume automation manually, 
proceed as follows: 

1. Start playback and watch the automation curve.

2. When the cursor reaches the desired position, click 
Join Now on the Automation panel.
All parameters from the last pass are punched in and the last value is 
written for the whole section. All previous automation events will be over-
written. 

Auto Join

If you hit Stop and want to resume automation automati-
cally, proceed as follows: 

1. Activate “Auto Join” on the Automation panel.

2. Start playback.
All parameters from the last pass are punched in automatically at the po-
sition where you hit stop. This position is indicated by the Join indicator 
(see below).

Join indicator

The Join indicator shows the timecode position where the 
last automation pass was stopped, i. e. the point where the 
Auto Join will automatically occur. When automation is re-
sumed, this indicator is updated.

The Fill options

The Fill options define what happens in a specific section 
of your project when you punch out of a running automa-
tion pass.

The Fill options write one particular value across a defined 
section of your automation track – any previously created 
data within this section is overwritten.

The following Fill options are available:

To Punch

Let’s say you are rolling, in realtime, over a scene cut and 
volume must be softer in the next scene – you do not yet 
know how much softer, but the change in volume from the 
first to the second scene must be abrupt.

1. Select “Touch” as automation mode and click the “To 
Punch” button once to activate it as Fill option.
The “To Punch” button is highlighted. 

2. Start rolling somewhere during the first scene and 
touch the fader at the moment of scene change.
The automation pass is punched in.

3. Move the fader until you have found the volume setting 
you need in the second scene and release the fader to 
punch out.
The volume curve is set from the point of punch out back to where you 
punched in. The values written while moving the fader to find the right 
value are deleted, and the volume jumps at exactly the right moment from 
the value set in the first scene to the value found for the second scene.
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To Start

“To Start” is similar to the “To Punch” option, but with the 
following difference: When “To Start” is selected, punch-
ing out of automation will fill the automation track from 
where you punched out to the start of the project.

To End

Imagine you are automating volume for the background 
tracks of a two-minute scene. Rather than holding the 
fader for two minutes, you can proceed as follows: 

1. Select “Touch” as automation mode and click the “To 
End” button once to activate it as Fill option.
The “To End” button is highlighted. 

2. Start rolling and touch the parameter control to punch 
in the automation pass.

3. Move the fader until you have found the setting you 
want and release the fader.
This will punch out the writing of automation data. As you let go of the 
fader, the automation curve will take the found value setting, from where 
you punched out to the end of the project.

Loop

To use the Loop option, you must first set up a loop range 
with the left and right locators. When you then select 
Loop, punching out will set the found value within the 
range defined by the left and right locator.

Gaps

This option is used only in combination with virgin territory. 
This is explained in detail in the section “Virgin territory” on 
page 246. When “Gaps” is selected, punching out of au-
tomation will fill any gaps between previously written auto-
mation events with the last value found during the last 
automation pass.

! When “Trim” is active, the Gaps option will have no 
effect. This is because Trim will only modify already 
existing data.
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Fill combinations

You can also combine the various Fill options. 

• Combining “To Punch” and “To End” will fill the automa-
tion track from the punch in position to the end of the 
project.

• Combining “To Start” and “To End” will fill the automa-
tion track from the beginning to the end of the project.

• You can also combine the Fill options with the Preview 
options (see “The Preview options” on page 256), and 
when writing automation manually with the Pencil tool.
Editing automation events is explained in more detail in the section “Edit-
ing automation events” on page 242). This is a very fast and efficient way 
to move through your project.

Feel free to experiment!

One shot vs. continuous fill

The Fill options can be used in two different ways:

• When you click one of the Fill buttons, it is highlighted, 
and will be enabled during the next automation pass.
Afterwards, the option is disabled again.

• If you click a Fill button a second time, a lock symbol is 
displayed on the highlighted button, indicating that you 
are permanently in “Fill to X” mode and that the operation 
can be repeated as many times as you wish.
Clicking the button for a third time disables the corresponding Fill option.

Drawing curves with Fill enabled

You can use the Fill options on the Automation panel in 
combination with the Pencil tool. This provides you with an 
extremely powerful method for writing automation data 
manually:

1. Open an automation track and select the Pencil tool.

2. On the Automation panel in the Fill column select “To 
End”.

3. Click and draw to create an automation curve.

4. Release the mouse button.
At the moment of release, a final automation event is created. The auto-
mation curve is written from this last event through to the end of the 
project.

This procedure can be used with all the Fill options. 

The Preview options

The Preview options allow you to find new settings with-
out recording the steps needed to locate them.

This is useful if you want to audition changes on automa-
tion values without deleting any of the original automation 
data. When you have found the desired settings, you can 
punch the previewed value.
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The Preview workflow

The Preview workflow has three different phases: touch-
collecting the required parameters, finding the required 
values, and performing the actual automation pass. Pro-
ceed as follows:

1. In the Preview section click the Preview button.
The Preview button is highlighted. 

You can set the Preview mode permanently by clicking 
the Preview button two times. A lock symbol is displayed 
on the highlighted button. You can disable this by clicking 
the button for a third time.

2. Touch a parameter control.
Below the Preview button three other buttons (Suspend, Punch and 
Punch on Play) are displayed. You now have full manual control of the 
touch-collected parameter, suspending (but not deleting!) any previously 
recorded automation data. You may now touch-collect another parame-
ter, if you want to write data for several parameters during the same au-
tomation pass. 

• Note that each automation track has its own Preview 
button.

Clicking this button will enable Preview mode for this par-
ticular automation track. This is touch-collecting via auto-
mation tracks.

3. Play back the scene (you may want to loop it) and find 
the parameter setting(s) you want.

Touch the required parameter, start rolling, find the desired 
value and select Punch to start the new automation pass.

• If you want to compare the value found during preview 
with previously automated values, activate the Suspend 
option.
This plays back your audio material using the parameter values set before 
activating Preview. You can use the delta indicator in the automation track 
as an additional visual aid for comparing the values.

4. When you are happy with the values found, click the 
Punch button to start the new automation pass. 
The new value setting is recorded, from the point where you punched in 
to your punch out position (as defined by the automation mode setting).
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Punch vs. Punch on Play

When using the Punch option as described above, start-
ing playback and punching in are two separate actions. If 
you want to punch in when starting playback, activate 
Punch on Play. 

• Use Punch on Play when you cannot punch in on the fly 
– i. e. in situations where you need to find the punch in po-
sition in Stop mode. Once you have found the exact posi-
tion, enable Punch on Play and start playback from there.

• Punch is the option to use if you need to listen to the 
section before your desired punch in point and if this sec-
tion already contains automation data that you do not want 
to overwrite. Roll through this section and then punch in 
the automation pass.

• You can also use Punch in Stop mode. To create auto-
mation data in this way, Punch must be combined with 
one of the Fill modes (see “The Fill options” on page 254).

Auto Punch

As described in the section “Automation modes” on page 
248, when setting up a loop with the left and right loca-
tors, an automation pass will always punch out when 
reaching the right locator. 

When in Preview mode, you can also use the left and right 
locators to automatically punch in and out at defined posi-
tions, using the Auto Punch command.

• Use Auto Punch when you want the automation pass to 
begin and end at defined positions.

You can also use Auto Punch without enabling Preview 
mode, to set up a “safe zone” for previously written auto-
mation data: 

• Place the right locator at the beginning of an area you 
wish to protect and enable cycle mode. 
This will ensure that a running automation pass will always punch out be-
fore reaching this section of your project.

Touch Assist

When you use Preview mode, you may get into a situation 
where you change some parameters, but not others, al-
though they belong to the same group of parameters (e. g. 
EQ settings). To prevent you from forgetting some para-
meters while touch-collecting parameters for Preview (see 
also “The Preview workflow” on page 257), you can enable 
the Touch Assist option. You will find this option at the bot-
tom of the Preview column on the Automation panel.

When Touch Assist is enabled, the parameters of the fol-
lowing features are treated as groups:

• Channel EQ module (21 parameters total)
• Aux send on/off and send level
• Stereo panner
• Surround panner (Left-Right, Front-Rear, LFE)
• Insert plug-ins (only available for plug-ins with 32 or less 

parameters)

• Touch Assist ensures that touching one parameter in a 
group will “touch” all other parameters in that group as well.

• However, if you want to automate only one particular 
parameter, disable Touch Assist to prevent yourself from 
inadvertently overwriting any previously created automa-
tion data.

Changing VST presets in Preview mode

When changing a preset of a VST plug-in while in Preview 
mode, the change in the parameter settings caused by the 
preset change is recorded automatically as automation. 
Note that the plug-in must have 32 or less parameters for 
this to work.

! Enabling Touch Assist may lead to the creation of a 
large amount of automation data, causing a higher 
CPU load. Only use Touch Assist if the performance is 
still acceptable.
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The Punch Log section

This section of the Automation panel displays a list of re-
cent punch in operations performed in Preview mode.

By loading one of these log entries for the current track, 
you recall the corresponding touch-collected parameters 
and their values at the moment of punch in.

• To load the settings of a particular entry in the punch 
log, select it in the list and click Load.
The Preview button on the Automation panel and the “Preview mode” 
button on the corresponding automation track light up to indicate that 
this parameter is now in Preview mode. 

• You can rename any log entry by double-clicking it and 
entering a new name.

• To delete an entry, select it and click Delete.

• To specify how many log entries are displayed, use the 
“Max. Punch Logs” setting in the Automation Settings 
(Automation Settings section).
If this value is set to 10 entries, the eleventh punch event will overwrite 
the entry created for the first event, the twelfth will replace the second 
entry, etc. The maximum possible number of punch log entries is 100.

• You can prevent a particular entry from being overwrit-
ten by clicking in the right section for this entry, so that a 
checkmark is displayed.

• Punch log entries are saved with the current project.
Punch log data is always project-specific. There is no way to export log 
entries to another project.

Loading behavior

When loading a log entry, you add the corresponding pa-
rameter(s) to any other parameters that you have touch-
collected during the current Preview session. 

However, if you manually touch-collect a parameter, e. g. 
volume, and then add volume again by loading a punch 
log entry, the settings for volume from the punch log will 
be used, replacing any values set manually.

The Suspend options

The parameters or parameter groups selected here are 
excluded from the reading or writing of automation data – 
giving you full manual control of these parameters. 

The “Others” options refer to all parameters not cov-
ered by Volume, Pan, Mute, EQ, Sends, or Inserts.

Suspending Read

Imagine you have already automated several tracks. While 
working on the current track, you want one of the other 
tracks to be louder, to better identify a particular position 
in your audio material. By suspending Read for the Volume 
parameter, you regain full manual control and can set the 
volume to the required level.

• To suspend the reading of automation data for all para-
meters/parameter groups, click the All button at the bottom 
of the section.
When any of the options in the Suspend Read category are enabled, 
clicking All will disable these buttons.

Suspending Write

Imagine the following situation: To help you concentrate 
while working on a particular track, you mute several other 
tracks. However, because write automations are active on 
these tracks, this mute state is also automated during the 
next automation pass – a classic situation in mixing.

To avoid inadvertently excluding whole tracks from your 
mix in this way, you can exclude Mute from all automation 
writing. Simply click Mute in the Suspend Write category 
on the Automation panel.
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• To suspend the writing of automation data for all para-
meters/parameter groups, click the All button at the bot-
tom of the Suspend Write category.
When any of the options in the Suspend Write category are enabled, 
clicking All will disable these buttons.

• When an automation pass is in progress for a particular 
parameter and you write-suspend this parameter, it will 
punch out of the automation pass.

The Show options

The Show options on the Automation panel always affect all 
tracks. Clicking these buttons opens the automation tracks 
for the corresponding parameters, e. g. Volume or Pan. This 
makes it easy to look at your EQ settings on several tracks, 
for example.

• When you click either Volume, Pan, EQ, Sends, or In-
serts, this will open the corresponding automation track(s) 
for all tracks.
The automation tracks will be opened even if no automation data was re-
corded on these tracks.

• For parameter groups (i. e. Pan, EQ, Sends, and Inserts) 
you can step through the individual parameter sets by re-
peatedly clicking the respective button.

• When the Used Only button is enabled, clicking one of 
the options will show you only the corresponding automa-
tion tracks for which automation data has already been 
written.

• When you click Show Used, all automation tracks that 
contain automation data will be displayed.

• Hide All will hide all open automation tracks.

Automation Preferences
If you click the button in the bottom left of the Automation 
panel, you open the Automation Preferences. These are 
divided into General and Automation Settings. 

The following options are available:

General 

Automation Settings

Option Description

Use Undo Branches Activate this to gather automation passes in 
branches, see “Working with Automation Passes” 
on page 252.

Option Description

Show Data on Tracks Activate this to show audio waveforms or MIDI 
events on automation tracks. 
The events are displayed only if the “Show wave-
forms” option is enabled in the Preferences dialog 
(Event Display–Audio) and if “Part Data Mode” 
(Event Display–MIDI) is set to an option other than 
“No data”.

Use Virgin Territory Activate this if you want to use virgin territories, see 
“Virgin territory vs. the initial value” on page 245.

Continue Writing If you activate this option, the recording of automa-
tion will not be blocked when locating to a new po-
sition. For example, this can be used to perform 
multiple automation passes in Cycle mode or if you 
are using the arranger functions. 
If this option is deactivated and you write automa-
tion data and locate to another position in the 
project, the writing will be stopped until the mouse 
button is released or until a Stop command is re-
ceived. 

Return Time This determines how fast the automated parameter 
returns to any previously automated value when you 
release the mouse button. Set this to a value higher 
than 0 to prevent sudden jumps in your parameter 
settings (which may lead to crackles).

Reduction Level When punching out, this function will remove all 
superfluous automation events so that the automa-
tion curve contains only the events necessary to 
reproduce your actions.
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Hints and further options

Automation key commands
In the Key Commands dialog (opened from the File menu 
in Nuendo), in the Commands section on the left, you will 
find an Automation category which lists all automation 
commands to which you can assign key commands.

How to assign key commands is described in detail in the 
chapter “Key commands” on page 580.

About linking and automation
• Nuendo allows you to link, in the Mixer window, various 
parameters between different channels (see “Link/Unlink 
channels” on page 175).
When automating the settings of a channel that is linked to another 
channel in the Mixer, the parameters of the linked channel will NOT be 
automated.

• Also, in the Channel Settings window, you can make the 
send’s panorama settings follow the panorama settings 
displayed in the channel strip (by enabling the “Send 
Routing Panners follow Channel Panner” option in the 
Control Strip section, see “Setting pan for the sends” on 
page 206).
For linked panners of sends and channels, automating the channel pan-
ner will automate the send routing panner as well.

MIDI controller automation

Merging automation data
When working with Nuendo, it is possible to record auto-
mation data for MIDI controllers in two places: as MIDI 
part data and as data on an automation track. 

If you have such “conflicting” automation data, you can 
specify separately for every parameter how these will be 
combined during playback. This is done by selecting an 
Automation Merge Mode in the track list for the automa-
tion track.

The following options are available:

This pop-up menu is only available for controllers that 
can be recorded both for a part and a track. When the 
pop-up menu is not available in the track list, the current 
parameter will not cause any playback conflicts.

For a full list of all the parameters with potential automa-
tion data conflicts, open the MIDI Controller Automation 
Setup dialog, see below.

The settings you make for a controller are applied to all 
MIDI tracks that use this controller.

Max Punch Logs This specifies how many log entries are displayed. 
You can set values from 5 to 100, see also “The 
Punch Log section” on page 259.

Freeze Trim In this pop-up menu you can specify how to freeze 
your trim curve.
Select “Manually” if you want to freeze your trim 
curve manually. 
Select “On Pass End” if you want a freeze to be 
performed whenever a write operation is finished. 
Select “On Leaving Trim Mode” if you want the trim 
data to freeze automatically when the trim mode is 
switched off (globally or individually for a track).

Option Description

Option Description

Use Global 
Settings

When this is selected, the automation track uses the 
“global” Automation Merge Mode specified in the MIDI 
Controller Automation Setup dialog, see below.

Replace 1 -  
Part Range

When this is selected, the part data has playback prior-
ity over the automation track data, i. e. at the left and 
right part borders, the automation mode switches 
abruptly from part to track automation, and vice versa.

Replace 2 - Last 
Value Continues

Similar to the above, but part automation only begins 
when the first controller event within the part is reached. 
At the end of the part, the last controller value will be 
kept until an automation event is reached on the auto-
mation track.

Average When this is selected, the average values between part 
and track automation will be used.

Modulation In this mode, the automation track curve modulates the 
existing part automation, with higher curve points em-
phasizing the automation values and lower curve points 
reducing the automation values even further.
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MIDI Controller Automation Setup settings
In the MIDI Controller Automation Setup dialog, you can 
specify how existing MIDI automation is handled on play-
back and where new automation data is recorded, in a 
MIDI part or as track automation.

Proceed as follows:

1. On the MIDI menu, select “CC Automation Setup…”.
A dialog opens.

2. On the “Record Destination on conflict (global)” pop-
up menu, specify the record destination for MIDI controller 
data.

This determines which destination will be used if there is a 
“conflict”, i. e if MIDI controller data is received by Nuendo 
and both the Record and the Automation Write buttons 
are enabled. 

The following options are available:

3. On the “Automation Merge Mode (global)” pop-up 
menu, specify the global Automation Merge Mode, i. e. the 
mode that will be used for all automation tracks with the 
“Use Global Settings” setting, see above.

• In the table in the lower section of the dialog, you can 
specify the record destination and the Automation Merge 
Mode separately for all the available MIDI controllers. This 
gives you full control over the MIDI automation (destina-
tion as well as merge mode) in your project. 

4. Click in the Record Destination column for a MIDI 
controller to open the pop-up menu where you can 
choose where you want recorded data of this particular 
MIDI Controller to end up.

5. Click in the Automation Merge Mode column for a 
MIDI controller to specify what will happen with data for 
this specific controller on playback.

All settings you make in this dialog are saved with the 
project.

• When you create a new project, the default settings will 
be used. To save the current settings as default settings, 
click the “Save as Default” button. To return to the default 
settings, click the Load Default button.

Option Description

MIDI Part Select this to record MIDI part automation.

Automation 
Track

Select this to record the controller data on an automation 
track in the Project window.
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Background
Audio processing in Nuendo can be called “non-destruc-
tive”, in the sense that you can always undo changes or 
revert to the original versions. This is possible because 
processing affects audio clips rather than the actual audio 
files, and because audio clips can refer to more than one 
audio file. This is how it works:

1. If you process an event or a selection range, a new 
audio file is created in the Edits folder, within your project 
folder. 
This new file contains the processed audio, while the original file is unaf-
fected. 

2. The processed section of the audio clip (the section 
corresponding to the event or selection range) then refers 
to the new, processed audio file.
The other sections of the clip will still refer to the original file.

• Since all edits are available as separate files, it is possi-
ble to undo any processing, at any point and in any order!
This is done in the Offline Process History dialog, see “The Offline Pro-
cess History dialog” on page 275.

• Furthermore, the original, unprocessed audio file can 
still be used by other clips in the project, by other projects 
or by other applications.

Audio processing
Basically, you apply processing by making a selection and 
selecting a function from the Process submenu of the Au-
dio menu. Processing is applied according to the follow-
ing rules:

• When events are selected in the Project window or the 
Audio Part Editor, the processing will be applied to these 
events only.
Processing will only affect the clip sections that are referenced by the 
events.

• When an audio clip is selected in the Pool, the process-
ing will be applied to the whole clip.

• When you have made a selection range, the processing 
will be applied to this range only.
Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy 
(i. e. the event refers to a clip that is used by other events 
in the project), you are asked whether you want to create a 
new version of the clip or not.

Select “New Version” if you want the processing to affect the selected 
event only. Select “Continue” if you want the processing to affect all 
shared copies. 

If you activate “Please, don’t ask again”, any further pro-
cessing you do will conform to the selected method (“Con-
tinue” or “New Version”). You can change this setting at 
any time by using the “On Processing Shared Clips” pop-
up menu in the Preferences dialog (Editing–Audio page). 
Also, “Create New Version” will now be displayed as an 
option in the dialog for the processing function.

Common settings and features
If there are any settings for the selected Audio processing 
function, these will appear when you select the function 
from the Process submenu. While most settings are spe-
cific for the function, some features and settings work in 
the same way for several functions.

The “More…” button

If the dialog has a lot of settings, some options may be 
hidden when the dialog opens. To reveal these, click the 
“More…” button.

To hide the settings, click the button again (now labeled 
“Less…”).
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The Preview, Process, and Cancel buttons

These buttons have the following functionality:

Pre/Post-Crossfade

Some processing functions allow you to gradually mix the 
effect in or out. This is done with the Pre/Post-Crossfade 
parameters. For example, if you activate Pre-Crossfade and 
specify a value of 1000 ms, the processing is applied grad-
ually from the start of selection, reaching full effect 1000 ms 
after the start. Similarly, if you activate Post-Crossfade, the 
processing is gradually removed, starting at the specified 
interval before the end of the selection.

Acoustic Stamp

The Acoustic Stamp function is a convolution tool, which 
allows you to apply room characteristics (reverb) to the 
audio. This is done by processing the audio signal accord-
ing to an impulse response – generally a stereo or mono 
recording of a very short signal (the impulse) in a room or 
other location. As a result, the processed audio will sound 
as if it were played in the same location.

The dialog contains the following settings:

Impulse and Envelope display

This display shows the loaded impulse response (in white) 
and the Envelope (in red). You can zoom in vertically on 
the impulse response using the slider to the right of the 
display (this can be useful since impulse responses typi-
cally are very weak). Zooming does not affect the pro-
cessing in any way.

Load Impulse button

Clicking the “Load Impulse” button allows you to load an 
impulse response file from disk. These are ordinary WAV 
or AIFF audio files, with a maximum duration of 12 sec-
onds. The name of the currently loaded impulse response 
file is shown above the display.

• A number of demonstration impulse response files are 
included in the Nuendo program folder. 
For proper use of the Acoustic Stamp function, we recommend that you 
acquire files from a professional impulse response library.

Play Impulse button

Plays back the currently loaded impulse response.

Channel selector

If the currently loaded impulse response is a stereo file, 
this pop-up menu allows you to select whether the left 
channel, right channel or both (stereo) are used for the 
convolution process.

Button Description

Preview Allows you to listen to the result of the processing with the 
current settings. Playback will continue repeatedly until you 
click the button again (the button is labeled “Stop” during 
Preview playback). You can make adjustments during Pre-
view playback, but the changes are not applied until the start 
of the next “lap”. Some changes may automatically restart 
the Preview playback from the beginning.

Process Performs the processing and closes the dialog.

Cancel Closes the dialog without processing.

! The sum of the Pre-Crossfade and Post-Crossfade 
times cannot be larger than the length of the selection.

! This function requires a lot of processing power, es-
pecially when using the Preview function. If you are 
working with long impulse response files or stereo 
files, you may find that Preview playback stutters or 
stops. In that case, it is better to process the mate-
rial, listen to the result and modify it in the Offline 
Process History (see “The Offline Process History 
dialog” on page 275) if necessary.
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Envelope controls

The five sliders below the display are used for setting up 
the “reverb envelope”, that is, a gain curve modifying how 
the impulse response is applied over time, and thereby the 
reverb character. These settings are reflected in the red 
Envelope display above. The sliders have the following 
functionality:

Filter controls

The three sliders to the right allow you to tailor the tonal 
character of the processed sound. In essence, this is a 
graphic equalizer with three broad bands: the LPF slider 
governs the low frequency content, the BPF governs the 
midrange and the HPF governs the high frequency con-
tent.

• Setting a slider to 100 % means that the corresponding 
filter is “fully open”.
When all three sliders are set to 100 %, the processed audio is not fil-
tered at all.

Reset button

Sets all parameters in the upper section of the dialog to 
their default values.

Wet/Dry Mix

These two sliders allow you to specify the balance between 
wet (processed) and dry (original) signal in the resulting 
clip.

Normally the two sliders are “reverse-ganged”, so that 
raising the Wet mix slider lowers the Dry mix slider by the 
same amount. However, if you press [Alt]/[Option] and 
drag a slider, you can move it independently. This allows 
you to set 80 % dry and 80 % wet signal, for example. Be 
careful to avoid distortion.

Tail

This parameter allows you to “add space” after the original 
audio section, to avoid that the reverb tail is cut off. When 
the checkbox is activated, you can specify a tail length us-
ing the slider. The tail time is included when playing back 
with the Preview function, allowing you to find the appropri-
ate tail length. A good value would be the Reverb Length 
value, displayed in ms to the right of the Reverb Length 
parameter.

Pre and Post-Crossfade

See “Pre/Post-Crossfade” on page 265.

Envelope

The Envelope function allows you to apply a volume enve-
lope to the selected audio. The dialog contains the follow-
ing settings:

Curve Kind buttons

These determine whether the envelope curve consists of 
spline curve segments (left button), damped spline seg-
ments (middle button) or linear segments (right button).

Parameter Description

First Reflec-
tions

A level control for the first section of the reverb (the length 
of which is set with the next parameter, see below). Usu-
ally, this governs the volume of the first reflection(s) of the 
reverb.

First Ref. 
Length

This determines the length of the First Reflections section 
(the level of which is controlled by the previous parame-
ter). Set this so that it includes the first reflection in the 
impulse response (normally about 5 % of the total length).

Reverb Att. A level control for the end section of the reverb (the sec-
tion after the First Reflections, see above).

Reverb Length Governs the reverb time, in milliseconds.

Gain Allows you to adjust the gain of the impulse response. This 
may be necessary for optimal results, since different im-
pulse response files may be recorded at different levels.
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Envelope display

Shows the shape of the envelope curve. The resulting 
waveform shape is shown in dark gray, with the current 
waveform shape in light gray. You can click on the curve 
to add points, and click and drag existing points to change 
the shape. To remove a point from the curve, drag it out-
side the display.

Presets

If you have set up an envelope curve that you may want to 
apply to other events or clips, you can store it as a preset 
by clicking the Store button. 

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double-click on the 
name and enter a new one in the dialog that opens. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

Fade In and Fade Out
For a description of these functions, see the chapter 
“Fades, crossfades and envelopes” on page 112.

Gain

Allows you to change the gain (level) of the selected au-
dio. The dialog contains the following settings:

Gain

This is where you set the desired gain, between -50 and 
+20 dB. The setting is also indicated below the Gain dis-
play as a percentage.

Clipping detection text

If you use the Preview function before applying the pro-
cessing, the text below the slider indicates whether the 
current settings result in clipping (audio levels above 
0 dB). If that is the case, lower the Gain value and use the 
Preview function again.

• If you want to increase the level of the audio as much as 
possible without causing clipping, use the Normalize func-
tion instead (see “Normalize” on page 268).

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 265.

Merge Clipboard

This function mixes the audio from the clipboard into the 
audio selected for processing, starting at the beginning of 
the selection.

The dialog contains the following settings:

Sources mix

Allows you to specify a mix ratio between the original (the 
audio selected for processing) and the copy (the audio on 
the clipboard).

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 265.

! For this function to be available, you need to have cut 
or copied a range of audio in the Sample Editor first.
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Noise Gate

Scans the audio for sections weaker than a specified 
threshold level and replaces them with silence. The dialog 
contains the following settings:

Threshold

The level below which you want audio to be silenced. 
Levels below this value will close the gate.

Attack Time

The time it takes for the gate to open fully after the audio 
level has exceeded the threshold level.

Min. Opening Time

This is the shortest time the gate will remain open. If you 
find that the gate opens and closes too often when pro-
cessing material that varies rapidly in level, try raising this 
value.

Release Time

The time it takes for the gate to close fully after the audio 
level has dropped below the threshold level.

Linked Channels

This is available for stereo audio only. When it is activated, 
the Noise Gate is opened for both channels as soon as 
one or both channels exceed the Threshold level. When 
Linked Channels is deactivated, the Noise Gate works in-
dependently for the left and right channel.

Dry/Wet mix

Allows you to specify a mix ratio between “dry” and pro-
cessed sound.

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 265.

Normalize

The Normalize function allows you to specify the desired 
maximum level of the audio. It then analyzes the selected 
audio and finds the current maximum level. Finally it sub-
tracts the current maximum level from the specified level 
and raises the gain of the audio by the resulting amount (if 
the specified maximum level is lower than the current max-
imum, the gain will be lowered instead). A common use for 
Normalizing is to raise the level of audio that was recorded 
at too low an input level. The dialog contains the following 
settings:

Maximum

The desired maximum level for the audio, between -50 and 
0 dB. The setting is also indicated below the Gain display 
as a percentage.

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 265.

Phase Reverse
Reverses the phase of the selected audio, turning the 
waveform “upside down”. 

The dialog contains the following settings:

Phase Reverse on

When processing stereo audio, this pop-up menu allows 
you to specify which channel(s) are phase-reversed.

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 265.
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Pitch Shift

This function allows you to change the pitch of the audio 
with or without affecting its length. You can also create 
“harmonies” by specifying several pitches or apply pitch 
shift based on a user specified envelope curve.

When the Transpose tab is selected, the dialog contains 
the following parameters:

Keyboard display

This is a graphic overview of the transposition setting. 
Here, you can specify the transpose interval in semitones.

• The root note is indicated in red.
This has nothing to do with the actual key or pitch of the original audio, it 
just provides a way to display transpose intervals. You can change the 
root note by using the settings in the Pitch Shift Base section, or by 
pressing [Alt]/[Option] and clicking in the keyboard display.

• To specify a transpose interval, click on one of the keys.
The key is indicated in blue, and the program plays test tones in the base 
pitch and transpose pitch to give you an audible confirmation.

• If “Multi Shift” is activated (see below), you can click on 
several keys to create “chords”.
Clicking on a blue (activated) key removes it.

Pitch Shift settings

The “Semitones” and “Fine tune” settings allow you to 
specify the amount of pitch shift. You can transpose the 
audio ±16 semitones, and fine tune it by ±200 cents 
(hundredths of semitones).

Volume/Amplitude

Allows you to lower the volume of the pitch-shifted sound.

Multi Shift

When this is activated, you can add several transpose val-
ues, creating multi-part harmonies. This is done by adding 
intervals in the keyboard display (see above). Note that 
you cannot use the Preview function in Multi Shift mode.

• If the intervals you add make up a standard chord, this 
chord is displayed to the right.
Note, however, that to include the base pitch (the original, untransposed 
sound) in the processed result, you need to click the base key in the key-
board display as well, so that it is displayed in blue.

Listen Key/Chord button

Clicking this button plays a test tone pitched according to 
the activated interval key on the keyboard display. If “Multi 
Shift” is activated, this button is called “Listen Chord” and 
plays all activated intervals as a chord.

Pitch Shift Base

This allows you to set the root note (the red key in the key-
board display). It has nothing to do with the actual pitch, 
but is an aid for setting up intervals and chords.

Pitch Shift Mode

This is where you can make settings for the MPEX 4 
algorithm. You can choose between 7 quality settings: 

Option Description

Preview This mode should only be used for preview.

Mix Fast This mode is a very fast mode for preview. This works 
best with composite music signals mono or stereo mate-
rial.

Solo Fast Use this mode for single instruments (monophonic mate-
rial) and voice.

Solo Musical Same as above but higher quality.

Poly Fast Use this for processing monophonic and polyphonic ma-
terial. This is the fastest setting that gives still very good 
results. You can use this for drum loops, mixes, chords.

Poly Musical Use this for processing monophonic and polyphonic ma-
terial. This is the recommended MPEX default quality set-
ting. You can use this for drum loops, mixes, chords.

Poly Complex This high quality setting is quite CPU-intensive and should 
be used only when processing difficult material or for 
stretch factors above 1.3.
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Formant Mode 

If you are processing vocal material, activate this option in 
order to preserve the vocal characteristics of the pitch-
shifted audio and to avoid a a “chipmunk voice” effect.

Time Correction

When this is activated, the pitch shift process will not affect 
the length of the audio. When this is deactivated, raising the 
pitch will shorten the audio section and vice versa, much 
like changing the playback speed on a tape recorder.

Using envelope based Pitch Shift

When the “Envelope” tab is selected, you can specify an 
envelope curve on which the pitch shift will be based. This 
allows you to create pitchbend effects, pitch-shift different 
sections of the audio by different amounts, etc.

Envelope display

Shows the shape of the envelope curve over the wave-
form image of the audio selected for processing. Envelope 
curve points above the center line indicate positive pitch 
shift, while curve points below the center line indicate 
negative pitch shift. Initially, the envelope curve will be a 
horizontal, centered line, indicating zero pitch shift.

• You can click on the curve to add points, and click and 
drag existing points to change the shape. To remove a 
point from the curve, drag it outside the display.

Curve Kind

These buttons determine whether the envelope curve con-
sists of spline curve segments (left button), damped spline 
segments (middle button) or linear segments (right button).

Spline curve segment envelope

The same envelope with damped spline segments selected

The same envelope with linear segments selected

Range

This parameter determines the vertical pitch range of the 
envelope. If set to “4”, moving a curve point to the top of 
the display corresponds to pitch shifting by +4 semitones. 
The maximum range is +/-16 semitones. 

Transpose and Fine Tune

These parameters allow you to adjust the value of a curve 
point numerically:

1. Click on a curve point to select it.
The selected point is shown in red.

2. Adjust the Transpose and Fine Tune parameters to 
change the pitch of the curve point in semitones and 
cents, respectively.
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Pitch Shift Mode

These are the same parameters as on the Transpose tab, 
see “Pitch Shift Mode” on page 269.

Example

Let’s say that you wish to create a pitchbend effect, so 
that the pitch is raised linearly by exactly 2 semitones in a 
specific part of the selected audio.

1. Remove all curve points by clicking the Reset button.

2. Select a linear curve by clicking the Curve Kind button 
to the right.

3. Make sure that the Range parameter is set to 2 semi-
tones or higher.

4. Create a point where you want the pitchbend to start 
by clicking on the envelope line.
Since this is the starting point for the pitchbend, you want its pitch to be 
zero (the envelope line should still be straight). If necessary, use the Fine 
Tune parameter to set the curve point to 0 cents, because this point gov-
erns the start point, where you want the pitch transition to begin.

5. Create a new curve point at the horizontal position 
where you want the pitchbend to reach the full value.
This curve point determines the rise time of the pitchbend effect, i. e. the 
further away from the starting point the new point is positioned, the 
longer it will take for the pitchbend to reach the full value, and vice versa.

6. With the second point still selected, use the Trans-
pose and Fine Tune parameters to set the pitch to exactly 
2 semitones.

7. Create a new curve point to set the duration of the 
pitchbend, i. e. the time the pitch will remain transposed by 
2 semitones.

8. Finally, create a point where you want the pitchbend to 
end.
You do not have to create a new point if you are at the end of the audio 
file, since there is always an end point at the right side of the waveform 
display.

9. If necessary, make additional settings in the Pitch Shift 
Mode section, see “Pitch Shift Mode” on page 269.

10. Click Process.
The pitchbend is applied according to the specified settings.

Remove DC Offset
This function will remove any DC offset in the audio selec-
tion. A DC offset is when there is too large a DC (direct 
current) component in the signal, sometimes visible as the 
signal not being visually centered around the “zero level 
axis”. DC offsets do not affect what you actually hear, but 
they affect zero crossing detection and certain process-
ing, and it is recommended that you remove them.

There are no parameters for this function. Note that you 
can check for DC Offset in an audio clip using the Statis-
tics function (see “Statistics” on page 281).

Resample

The Resample function can be used for changing the 
length, tempo and pitch of an event.

The original sample rate of the event is listed in the dialog. 
Resample the event to a higher or lower sample rate by ei-
ther specifying a sample rate or by specifying the differ-
ence (as a percentage value) between the original sample 
rate and the desired new one.

• Resampling to a higher sample rate will make the event 
longer and cause the audio to play back at a slower speed 
with a lower pitch.

• Resampling to a lower sample rate will make the event 
shorter and cause the audio to play back at a faster speed 
with a higher pitch.

• You can audition the result of the resampling by enter-
ing the desired value and clicking “Preview”.
The event will then be played back as it will sound after the resampling.

• When you are satisfied with the preview result, click 
“Process” to close the dialog and apply the processing.

! It is recommended that this function is applied to 
complete audio clips, since the DC offset (if any) is 
normally present throughout the entire recording.
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Reverse
Reverses the audio selection, as when playing a tape 
backwards. There are no parameters for this function.

Silence
Replaces the selection with silence. There are no parame-
ters for this function.

Stereo Flip

This function works with stereo audio selections only. It al-
lows you to manipulate the left and right channel in various 
ways. 

The dialog contains the following parameters:

Mode

 

This pop-up menu determines what the function does:

Time Stretch

This function allows you to change the length and “tempo” 
of the selected audio without affecting the pitch. The dia-
log contains the following parameters:

Define Bars section

In this section, you set the length of the selected audio 
and the time signature:

Original Length section

This section contains information and settings regarding 
the audio selected for processing:

Option Description

Flip Left-Right Swaps the left and right channel.

Left to Stereo Copies the left channel sound to the right channel.

Right to Stereo Copies the right channel sound to the left channel.

Merge Merges both channels on each side for mono sound.

Subtract Subtracts the left channel information from the right. This 
is typically used as a “Karaoke effect”, for removing cen-
tered mono material from a stereo signal.

Option Description

Bars If you use the tempo setting (see below), specify the 
length of the selected audio here, in bars.

Beats If you use the tempo setting, specify the length of the se-
lected audio here, in beats.

Sign. If you use the tempo setting, specify the time signature 
here.

Option Description

Length in 
Samples

The length of the selected audio, in samples.

Length in 
Seconds

The length of the selected audio, in seconds.

Tempo in BPM If you are processing music, and know the actual tempo 
of the audio, you can enter it here as beats per minute. 
This makes it possible to time-stretch the audio to an-
other tempo, without having to compute the actual time 
stretch amount.
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Resulting Length section

These settings are used if you want to stretch the audio to 
fit within a specific time span or tempo. The values will 
change automatically if you adjust the Time Stretch Ratio 
(see below).

Seconds Range section

These settings allow you to set the desired range for the 
time stretch.

Time Stretch Ratio section

The Time Stretch Ratio determines the amount of time 
stretch as a percentage of the original length. If you use 
the settings in the Resulting Length section to specify the 
amount of time stretch, this value will change automati-
cally. The possible range depends on the “Effect” option:

• If the “Effect” checkbox is deactivated, the range is  
75–125 %.
This is the preferred mode if you want to preserve the character of the 
sound.

• If the “Effect” checkbox is activated, you can specify val-
ues between 10 and 1000 % (Realtime), or 50 and 200 % 
(MPEX 4). 
This mode is mainly useful for special effects, etc.

Algorithm section

In this section you can select a time stretch algorithm. The 
pop-up menu contains various presets based on the 
MPEX 4 and Realtime algorithms. 

• MPEX 4 mode
This mode is based on Prosoniq’s proprietary MPEX (Minimum Per-
ceived Loss Time Compression/Expansion) algorithm. This algorithm 
(which is also used in Prosoniq’s TimeFactory™ application) uses an arti-
ficial neural network for time series prediction in the scale space domain 
to achieve high end time and pitch scaling. This gives the best possible 
audio quality result. You can choose between 7 quality settings, see 
“Pitch Shift Mode” on page 269.

• Realtime mode
This is the algorithm used for the realtime time stretching features in Nu-
endo. Although this algorithm is optimized for time stretching in realtime, 
you can use it for offline processing as well. The Presets pop-up con-
tains the same presets as found in the Algorithm pop-up menu in the 
Sample Editor, see “Selecting an algorithm for realtime playback” on 
page 296.

Applying plug-ins
You can add plug-in effects in realtime during playback 
(see the chapter “Audio effects” on page 195). However, 
sometimes it is useful to “permanently” apply effects to 
one or several selected events. This is done in the follow-
ing way:

1. Make a selection in the Project window, the Pool or an 
editor.
Effects are applied according to the same rules as Processing (see 
“Common settings and features” on page 264).

2. Select “Plug-ins” from the Audio menu.

3. Select the desired effect from the submenu.
The Process Plug-in dialog opens.

About stereo and mono
If you are applying an effect to mono audio material, only 
the left side of the effect’s stereo output will be applied.

Option Description

Samples The desired length in samples.

Seconds The desired length in seconds.

BPM The desired tempo (beats per minute). For this to work, 
you have to know the actual tempo of the audio, and 
specify this (along with time signature and length in bars) 
in the Original Length section to the left.

Option Description

Range Allows you to specify the desired length as a range be-
tween two time positions.

Use Locators Clicking the diamond-shaped button below the Range 
fields sets the Range values to the left and right Locator 
positions, respectively.
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The process plug-in dialog

The process plug-in dialog for the StudioChorus effect

The upper section of the process plug-in dialog contains 
the effect parameters of the selected plug-in. For details 
on the parameters of the included plug-ins, see the sepa-
rate PDF document “Plug-in Reference”.

The lower section of the dialog contains settings for the 
actual processing. These are common to all plug-ins.

• If the lower section is hidden, click the “More…” button 
to display it.
Clicking the button again (now labeled “Less…”) will hide the lower 
section.

The following settings and functions are available in the 
common, lower section of the dialog:

Wet mix/Dry mix

These two sliders allow you to specify the balance be-
tween wet (processed) and dry (original) signal in the re-
sulting clip. 

Normally the two sliders are “reverse-ganged”, so that 
raising the Wet mix slider lowers the Dry mix slider by the 
same amount. However, if you press [Alt]/[Option] and 
drag a slider, you can move it independently. This allows 
you to set 80 % dry and 80 % wet signal, for example. Be 
careful to avoid distortion.

Tail

This parameter is useful if you are applying an effect that 
adds material after the end of original audio (such as re-
verb and delay effects). When the checkbox is activated, 
you can specify a tail length using the slider. The tail time 
is included when playing back with the Preview function, 
allowing you to find the appropriate tail length.

Pre/Post-Crossfade

These settings allow you to gradually mix the effect in or 
out. For example, if you activate Pre-Crossfade and spec-
ify a value of 1000 ms, the effect is applied gradually from 
the start of selection, reaching full effect 1000 ms after the 
start. Similarly, if you activate Post-Crossfade, the pro-
cessing is gradually removed, starting at the specified in-
terval before the end of the selection.

Preview button

Allows you to listen to the result of the processing with the 
current settings. Playback will continue repeatedly until 
you click the button again (the button is labeled “Stop” 
during Preview playback). You can change the effect set-
tings during Preview playback if needed.

Process button

Applies the effect and closes the dialog.

Cancel button

Closes the dialog without applying the effect.

! The sum of the Pre-Crossfade and Post-Crossfade 
times cannot be larger than the length of the selection.
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The Offline Process History dialog
If you want to remove or modify some or all processing 
from a clip, this can be done in the Offline Process History 
dialog. Processing that can be modified in the Offline Pro-
cess History dialog includes the functions on the Process 
menu, any applied plug-in effects, and Sample Editor op-
erations such as Cut, Paste, Delete and drawing with the 
Pencil tool.

Due to the clip-file relationship (see “Background” on 
page 264), it is even possible to modify or remove some 
processing “in the middle” of the Process History, while 
keeping later processing! This feature depends on the type 
of processing performed (see “Restrictions” on page 275).

Proceed as follows:

1. Select the clip in the Pool or one of its events in the 
Project window.
You can see which clips have been processed by checking the Status 
column in the Pool – the waveform symbol indicates that processing or 
effects have been applied to the clip (see “About the Status column sym-
bols” on page 322).

2. Select “Offline Process History…” from the Audio 
menu.
The Offline Process History dialog opens.

The left part of the dialog contains a list of all processing 
you have added to the clip, with the most recent opera-
tions at the bottom of the list. The “Start” and “Length” 
columns indicate which section of the clip was affected by 
each operation. The “Status” column indicates if the oper-
ation can be modified or undone.

3. Locate the operation you want to edit and select it by 
clicking on it in the list.

• To modify the settings of the selected processing, click 
the “Modify” button.
This opens the dialog for the processing function or applied effect, allow-
ing you to change the settings. This works just as when you applied the 
processing or effect the first time.

• To replace the selected operation with another pro-
cessing function or effect, select the desired function from 
the pop-up menu and click the “Replace By” button.
If the selected function has settings, a dialog will appear as usual. The 
original operation will then be removed and the new processing will be 
inserted in the Offline Process History.

• To remove the selected operation, click the “Remove” 
button.
The processing is removed from the clip.

• To undo the selected operation and remove the pro-
cessing from the clip click the “Deactivate” button.
The processing is removed from the clip, but the operation remains in the 
list. To redo the operation and apply the processing again, click the but-
ton, now renamed to “Activate”, again.

• To save the list of processing operations as a Batch 
Process, click the “Save As Batch” button.
See “Batch Processing” on page 276.

4. Click “Close” to close the dialog.

Restrictions
• If there are no settings for the processing function, you 
cannot modify it.

• If you have applied processing that changes the length 
of the clip (such as Cut, Insert or Time Stretch), you can 
only remove this if it is the most recent processing in the 
Offline Process History (at the bottom of the list in the di-
alog). If an operation cannot be removed or modified, this 
is indicated by an icon in the “Status” column. Also, the 
corresponding buttons will be grayed out.

• The list must contain at least two processing operations 
in order to be saved as a Batch Process (see “Batch Pro-
cessing” on page 276.
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Batch Processing
Nuendo features a Batch Processing function that lets you 
apply a chain of audio processing to one or several events 
in one go – in either the Project window or the Pool. Batch 
Processing is based on operations in the Offline Process 
History dialog, described above. That is, the list of applied 
processes in this dialog is what can be made to constitute 
a batch process.

Batch Processing is therefore a convenient way to apply 
the same effects with the same settings to several audio 
events in a project.

It can also be used to “store” effect settings for future use. 
You may for example have performed a series of elaborate 
audio processing with a good result, and want to retain 
the particular combination and settings of effects you ap-
plied, so that you may quickly and easily apply them again 
to other events in the future.

To set up a batch process, proceed as follows:

1. Apply the desired processing to an audio event or se-
lection range in the project.
Note that you must apply at least two audio processes to be able to set 
up a batch process.

From here, there are two ways to go:

• Pull down the Audio menu, and from the Batch Pro-
cesses submenu, select “Create from Process History…”, 
type in a name for the batch process in the dialog that 
opens, and click OK.

or…

• Pull down the Audio menu and select “Offline Process 
History”.
The Offline Process History dialog opens. In this dialog you can modify 
settings or remove operations as desired (see “The Offline Process His-
tory dialog” on page 275).

2. In the Process History Dialog, click “Save As Batch”, 
and then type in a name for the batch process in the dia-
log that opens and click OK.

Regardless of which of the above two methods you use, 
the batch process is now saved and available for use:

3. In the Project window, select all the audio events you 
want to process.
You can also make a selection range that spans multiple tracks and 
batch process the selection for all the audio events.

4. Pull down the Audio menu and open the Batch Pro-
cesses submenu.
At the top of the menu you can now find the name of the batch process 
you created. The menu will list the names of any batch processes you 
create, until you delete them (see below).

5. Select the batch process you want to apply from the 
menu.
All the selected events will now be processed accordingly.

Note that even if you clear the Offline Process History 
dialog of all the operations that make up a batch process, 
this will not affect the saved batch process. It will still con-
tain and perform the operations on which it was based 
when created.
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Managing Batch Processes
You can delete and rename created batch processes in 
the Manage Batch Processes dialog.

• Open the Audio menu and select “Manage…” from the 
Batch Processes submenu to open the Manage Batch 
Processes dialog.
The created batch processes are listed in the left column, and the oper-
ations each batch process contains are listed in the right column.

• To remove a batch process, just select it in the list and 
click “Delete”.

• To change the name of a batch process, select it in the 
list and click “Rename” and enter the new name.

Freeze Edits
The Freeze Edits function on the Audio menu allows you 
to make all processing and applied effects permanent for 
a clip:

1. Select the clip in the Pool or one of its events in the 
Project window.

2. Select “Freeze Edits…” from the Audio menu.

• If there is only one edit version of the clip (no other clips 
refer to the same audio file), the following dialog will appear:

If you select “Replace”, all edits will be applied to the orig-
inal audio file (the one listed in the clip’s Path column in 
the Pool). If you select “New File”, the Freeze Edits opera-
tion will create a new file in the Audio folder within the 
project folder (leaving the original audio file unaffected).

• If the selected clip (or the clip played by the selected 
event) has several edit versions (i. e. there are other clips 
referring to the same audio file), the following alert will 
appear:

As you can see, you do not have the option to Replace the 
original audio file in this case. This is because that audio 
file is used by other clips. Select “New File” to have a new 
file created in the Audio folder within the project folder.

! After a Freeze Edits, the clip refers to a new, single 
audio file. If you open the Offline Process History 
dialog for the clip, the list will be empty.
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Detect Silence

The Detect Silence function searches for silent sections in 
an event and either splits the event, removing the silent 
parts from the project, or creates regions corresponding 
to the non-silent sections. 

• To open the Detect Silence dialog, select one or several 
audio events in the Project window or the Audio Part Edi-
tor. On the Audio menu, open the Advanced submenu and 
select “Detect Silence”. 
If you select more than one event, the Detect Silence dialog allows you to 
process the selected events successively with individual settings or to 
apply the same settings to all selected events at once.

Adjustments in the waveform display
The upper part of the dialog displays a waveform image of 
the selected audio event. In case you have selected sev-
eral audio events, the waveform of the event that you have 
selected first is shown. You can make the following ad-
justments:

• With the zoom slider below the waveform to the right, 
zoom in and out on the waveform.
You can also click in the waveform, keep the mouse button pressed, and 
move the mouse for zooming. Move the mouse down to zoom in and 
move it up to zoom out.

• If you have zoomed in on the waveform, it may not be 
completely visible anymore. In this case, the scroll bar to 
the left of the zoom slider allows you to scroll through the 
waveform.
You can also use the mouse wheel for scrolling through the waveform.

• If the Linked option in the Detection section is deacti-
vated, you can use the green square at the beginning and 
the red square at the end of the audio file to graphically ad-
just the Open and Close Threshold values (respectively). 
When “Linked” is activated, you can use either square to 
adjust both values.
The Open and Close Threshold values in the Detection section reflect 
these changes.

Making settings and processing
The lower part of the Detect Silence dialog provides set-
tings for the detection and processing of “silent” sections. 
Proceed as follows:

1. Adjust the settings in the Detection section to the left.
The settings have the following functionality:

Setting Description

Open  
Threshold

When the audio level exceeds this value, the function 
“opens”, i. e. lets the sound pass. Audio material below 
the set level is detected as “silence”. Set this value low 
enough to open when a sound starts, but high enough to 
remove unwanted noise during “silent” sections.

Close  
Threshold

When the audio level drops below this value, the function 
“closes”, i. e. sounds below this level are detected as “si-
lence”. This value cannot be higher than the Open 
Threshold value. Set this value high enough to remove 
unwanted noise during “silent” sections.

Linked If this checkbox is activated, the Open and Close Thresh-
old values are always set to the same value.
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2. Click the Compute button.
The audio event is analyzed, and the waveform display is redrawn to indi-
cate which sections are considered “silent” according to your settings. 
Above the Compute button, the number of detected regions is displayed.

If you activate the Auto checkbox next to the Compute 
button, the audio event is analyzed (and the display is up-
dated) automatically every time you change the settings in 
the Detection section of the dialog. Deactivate this option 
when you are working with very long files, as this process 
might take some time.

3. Click “Preview” to listen to the result.
The event is played back repeatedly in its entire length, but with the 
“closed” sections silenced.

4. Adjust the settings in the Detection section until you 
are satisfied with the result.

5. In the Output section, activate the “Add as Regions” 
or the “Strip Silence” option, or both.
“Add as Regions” will create regions according to the non-silent sec-
tions. “Strip Silence” will split the event at the beginning and end of each 
non-silent section, and remove the silent sections in between.

If you activate the “Add as Regions” option, you can 
specify a name for the regions in the Region Name field. In 
addition to the name, the regions will be numbered, start-
ing with the number specified in the “Auto Number Start” 
field.

If you have selected more than one event, you can ac-
tivate the “Process all selected Events” checkbox to apply 
the same settings to all selected events. 

6. Click the Process button.
The event is split and/or regions are added.

If you have selected more than one event and did not 
activate the “Process all selected Events” option in the 
Output section, the dialog opens again after processing, 
allowing you to make separate settings for the next event.

The Spectrum Analyzer
This function analyzes the selected audio, computes the 
average “spectrum” (level distribution over the frequency 
range) and displays this as a two-dimensional graph, with 
frequency on the x-axis and level on the y-axis.

1. Make an audio selection (a clip, an event or a range 
selection).

2. Select “Spectrum Analyzer” from the Audio menu.
A dialog with settings for the analysis appears.

Min. time  
open

Determines the minimum time that the function will remain 
“open” after the audio level has exceeded the Open 
Threshold value.
If the audio contains repeated short sounds, and you find 
that this results in too many short “open” sections, try 
raising this value.

Min. time  
closed

Determines the minimum time that the function will remain 
“closed” after the audio level has dropped below the 
Close Threshold value.
Set this to a low value to avoid removing sounds.

Pre-roll Allows you to cause the function to “open” slightly before 
the audio level exceeds the Open Threshold value. In 
other words, the start of each “open” section is moved to 
the left according to the time you set here.
This is useful to avoid removing the attack of sounds.

Post-roll Allows you to cause the function to “close” slightly after 
the audio level drops below the Close Threshold value.
This is useful to avoid removing the natural decay of 
sounds.

Setting Description
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The default values give good results in most situations, but 
you can adjust the settings if you like:

3. Click the Process button.
The spectrum is computed and displayed as a graph.

4. You can adjust the display with the settings in the dis-
play window:

5. If you move the mouse pointer over the graph, a cross-
hair cursor follows the graph curve and the display in the 
upper right corner shows the frequency/note and level at 
the current position.
To compare the level between two frequencies, move the pointer to one 
of the frequencies, right-click once and move the pointer to the second 
frequency. The delta value (the difference in level between the current 
position and the right-click position) is displayed in the upper right corner 
(labeled “D”).

• If you analyze stereo audio and selected the “Stereo” op-
tion in the first dialog, the graphs for the left and right chan-
nel are superimposed in the display, with the left channel 
graph in white and the right channel graph in yellow.
The display in the upper right corner shows the values for the left channel 
– to see the right channel values, hold down [Shift]. An “L” or “R” is dis-
played to indicate which channel values are shown.

6. You can leave the window open or close it by clicking 
the “Close” button.
If you leave it open and the “Active” checkbox is ticked, the result of the 
next Spectrum Analysis will be displayed in the same window.

Option Description

Size in Samples The function divides the audio into “analysis blocks”, the 
size of which is set here. The larger this value, the higher 
the frequency resolution of the resulting spectrum.

Size of Overlap The overlap between each analysis block.

Window used Allows you to select which window type is used for the 
FFT (Fast Fourier Transform, the mathematical method 
used for computing the spectrum). 

Normalized 
Values

When this is activated, the resulting level values are 
scaled, so that the highest level is displayed as “1” (0 dB).

From Stereo When analyzing stereo material, there is a pop-up menu 
with the following options:
Mono mix – the stereo signal is mixed to mono before 
analyzing.
Mono left/right – the left or right channel signal is used 
for analysis.
Stereo – both channels are analyzed (two separate 
spectrums will be displayed).

Setting Description

dB When this is activated, the vertical axis shows dB values. 
When it is deactivated, values between 0 and 1 are shown.

Freq. log When this is activated, frequencies (on the horizontal axis) 
are displayed on a logarithmic scale. When it is deactivated, 
the frequency axis is linear.

Precision Indicates the frequency resolution of the graph. This value 
cannot be changed here, but is governed by the Size in 
Samples setting in the previous dialog.

Frequency/
Note

Allows you to select whether you want the frequencies to be 
displayed in Hertz or with note names.

Min. Sets the lowest frequency shown in the graph.

Max. Sets the highest frequency shown in the graph. By adjusting 
the Min and Max values, you can take a closer look at a 
smaller frequency range.

Active When this is activated, the next Spectrum Analysis will appear 
in the same window. When deactivated, new Spectrum Anal-
ysis results will appear in separate windows.

Setting Description
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Statistics

The Statistics function on the Audio menu analyzes the 
selected audio (events, clips or range selections) and dis-
plays a window with the following information:

Item Description

Min. Sample 
Value

The lowest sample value in the selection, as a value be-
tween -1 and 1 and in dB.

Max. Sample 
Value

The highest sample value in the selection, as a value be-
tween -1 and 1 and in dB.

Peak 
Amplitude

The largest sample value (in absolute numbers) in the se-
lection, in dB.

DC Offset The amount of DC Offset (see “Remove DC Offset” on 
page 271) in the selection, as a percentage and in dB.

Estimated 
Resolution

Even though an audio file is in 16 or 24 bits, it may have 
been converted from a lower resolution. The Estimated 
Resolution value makes an educated guess about the ac-
tual audio resolution, by computing the smallest level dif-
ference between two samples.

Estimated 
Pitch

The estimated pitch of the audio selection.

Sample Rate The sample rate of the audio selection.

Min. RMS 
Power

The lowest loudness (RMS) measured in the selection.

Max. RMS 
Power

The highest loudness (RMS) measured in the selection.

Average The average loudness over the whole selection.
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Window overview

The Sample Editor allows you to view and manipulate audio 
by cutting and pasting, removing, or drawing audio data, 
and by processing or applying effects (see the chapter “Au-
dio processing and functions” on page 263). This editing is 
“non-destructive”: The actual file (if created or imported 
from outside the project) will remain untouched so that you 
can undo modifications or revert to the original settings at 
any time using the Offline Process History dialog (see “The 
Offline Process History dialog” on page 275).

The Sample Editor also contains most of the AudioWarp 
related functions, i. e. the realtime time stretching as well as 
the pitch-shifting functions in Nuendo. These can be used 
to match the tempo of audio loops to the project tempo 
(see “AudioWarp: Tempo matching audio” on page 293).

Another special feature of the Sample Editor is hitpoint 
detection. Hitpoints allow you to create “slices”, which 
can be useful in many situations, for example, if you want 
to change the tempo without affecting the pitch (see 
“Working with hitpoints and slices” on page 299).

The VariAudio features allow you to edit monophonic vocal 
recordings in pitch and time, as easily as editing MIDI in the 
Key Editor. In these realtime pitch modifications the transi-
tions are kept so that the sound remains natural. The pitch 
detection and correction is “non-destructive”, i. e. you can 
always undo modifications or revert to the original versions, 
see “VariAudio” on page 302 for details.

The term “loop” is used throughout this chapter and in 
this context usually means an audio file with a musical time 
base. That means that the length of the loop represents a 
certain number of bars and beats at a certain tempo. Play-
ing the loop back at the right tempo in a cycle set to the 
correct length will produce a continuous loop without gaps.
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Opening the Sample Editor
To open the Sample Editor, double-click an audio event in 
the Project window or the Audio Part Editor, or double-
click an audio clip in the Pool. You can have more than 
one Sample Editor window open at the same time.

Double-clicking an audio part in the Project window 
opens the Audio Part Editor, even if the part contains a sin-
gle audio event only. The Audio Part Editor is described in a 
separate chapter, see “The Audio Part Editor” on page 314.

The toolbar

To the right of the tools, the estimated length of your audio 
file is displayed in bars and beats (PPQ) together with the 
estimated tempo and the time signature. If you want to use 
Musical Mode, always verify that the length in bars corre-
sponds to the audio file you imported. If necessary, listen 
to your audio and enter the correct bar length. The Algo-
rithm pop-up menu allows you to select an algorithm for 
the realtime time stretching (see “Selecting an algorithm 
for the flattening” on page 312).

You can customize the toolbar by right-clicking it and us-
ing the context menu to hide or show items. For further in-
formation about configuring the toolbar, see “Using the 
Setup options” on page 572.

The info line
The info line is displayed below the toolbar. It shows infor-
mation about the audio clip:

Initially, length and position values are displayed in the for-
mat specified in the Project Setup dialog. For information 
about configuring the info line, see “Using the Setup op-
tions” on page 572. 

• To show or hide the info line, click the “Set up Window 
Layout” button on the toolbar and activate or deactivate 
the Info Line option.

The Sample Editor Inspector
On the left in the Sample Editor, you will find the Sample 
Editor Inspector. It contains tools and functions for work-
ing in the Sample Editor. 

For more information on the handling of the various In-
spector tabs, see the chapter “The Project window” on 
page 38.

Audition, Loop, and 
Volume controls

Set up Window 
Layout

Solo Editor
Acoustic Pitch 
Feedback

Suspend Auto-
Scroll when editing

Auto-ScrollShow Audio 
Event

Show 
Regions

Snap on/off

Snap to Zero 
Crossing

Musical 
Mode

Tool buttons

Global Transpose statusAudio format and length

Selected display format 

Number of edits made to the clip

Zoom factor

Realtime status

Original pitch and deviation

Pitch and deviation

Current selection range
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The Definition tab

The Definition tab helps you to adjust the audio grid and 
define the musical context of your audio. This is useful if 
you have an audio loop or audio file that you want to match 
to the project tempo, see “AudioWarp: Tempo matching 
audio” on page 293. If the Definition tab is open, a second 
ruler is displayed, showing the musical structure of your 
audio.

The AudioWarp tab

The AudioWarp tab lets you perform timing settings for 
your audio. This includes applying swing and manually 
changing the rhythm of the audio by dragging beats to 
time positions in the grid (see “Free Warp” on page 297).

• If you click the “Disable Warp Changes” button, any 
warp modifications you have made are disabled, allowing 
you to compare the modified sound with the original 
sound of your audio. 
However, the display does not change. The time stretch applied by the 
Musical Mode is not disabled by this. “Disable Warp Changes” is deac-
tivated when you reset your warp operations or when you close the Sam-
ple Editor. It will not be recalled when reopening the Sample Editor.

The VariAudio tab 

On this tab you can edit single notes of your audio file and 
change their pitch and/or timing, in a way that is similar to 
the editing of MIDI notes (see “Understanding the wave-
form display in VariAudio” on page 302). Furthermore, you 
can extract MIDI from your audio (see “Functions – Extract 
MIDI…” on page 311).

• If you click the “Disable Pitch Changes” button, any 
pitch modifications you have made are disabled, allowing 
you to compare the modified sound with the original 
sound of your audio. 
However, the display does not change. “Disable Pitch Changes” is deacti-
vated when you reset your pitch or warp operations or when you close the 
Sample Editor. It will not be recalled when reopening the Sample Editor.

The Hitpoints tab

On this tab, the transients or hitpoints of the audio can be 
marked and edited (see “Working with hitpoints and 
slices” on page 299). Hitpoints allow you to slice your au-
dio, and to create groove quantize maps from your audio. 
You can also create markers, regions, and events based 
on hitpoints.

Disable Warp Changes

Disable Pitch Changes
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The Range tab

On this tab you will find functions for working with ranges 
and selections (see “Making selections” on page 289).

The Process tab

This tab regroups the most important audio editing com-
mands from the Audio and Edit menus. For further infor-
mation on the options contained in the Select Process 
and Select Plug-in pop-up menus, see the chapter “Audio 
processing and functions” on page 263.

The Overview line

The Overview line displays the whole clip. The section cur-
rently shown in the main waveform display of the Sample 
Editor (the viewing area) is indicated by a rectangle in the 
Overview line, and the current selection range is also 
shown. If the “Show Audio Event” button is activated on the 
toolbar, event start/end and snap point are shown in the 
Overview line.

• To view other sections of the clip, move the viewing 
area in the Overview line.
Click in the lower half of the viewing area and drag to the left or right to 
move it.

• To zoom in or out, horizontally, resize the viewing area 
by dragging its left or right edge.

• To define a new viewing area, click in the upper half of 
the Overview and drag a rectangle. 

The ruler
The Sample Editor ruler is located between the Overview 
line and the waveform display. The ruler is explained in de-
tail in the section “The ruler” on page 47. When the Defi-
nition tab is open, an additional ruler displays the musical 
structure of the audio file.

The waveform display and the level scale

The waveform display shows the waveform image of the 
edited audio clip according to the wave image style set in 
the Preferences dialog (Event Display–Audio page), see 
“Adjusting how parts and events are shown” on page 60. 
To the left of the waveform display a level scale is shown, 
indicating the amplitude of the audio.

Event Start Event End

Viewing area

Selection

Snap Point
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• You can select whether the level is shown as a percent-
age or in dB.
This is done by opening the level scale pop-up menu at the top of the 
level scale and selecting an option. 

• Select the “Show Half Level Axis” option on the context 
menu of the waveform display, if you want the half level 
axes to be shown.

Operations

Zooming
Zooming in the Sample Editor is done according to the 
standard zoom procedures, with the following special 
notes to keep in mind:

• The vertical zoom slider changes the vertical scale rela-
tive to the height of the editor window, in a way similar to 
the waveform zooming in the Project window (see “Zoom 
and view options” on page 58).
The vertical zoom will also be affected if the “Zoom Tool Standard Mode: 
Horizontal Zooming Only” preference (Editing–Tools page) is deactivated 
and you drag a rectangle with the Zoom tool.

The following options relevant to the Sample Editor are 
available on the Zoom submenu of the Edit menu or the 
context menu:

• When the VariAudio tab is active (see “VariAudio” on 
page 302), you can also zoom by holding down [Alt]/[Op-
tion] while drawing a selection rectangle around the seg-
ments that you want to zoom in on. You can zoom out by 
holding down [Alt]/[Option] and clicking in an empty area 
of the waveform.

• The current zoom setting is shown in the info line, as a 
“samples per screen pixel” value.

You can zoom in horizontally to a scale of less than one 
sample per pixel! This is required for drawing with the Pen-
cil tool (see “Drawing in the Sample Editor” on page 292).

• If you have zoomed in to one sample per pixel or less, 
the appearance of the samples depends on the 
“Interpolate Audio Images” option in the Preferences dia-
log (Event Display–Audio page).
If the option is deactivated, single sample values are drawn as “steps”. If 
the option is activated, they are interpolated to a “curve” form.

Half level axis

Option Description

Zoom In Zooms in one step, centering on the position cursor.

Zoom Out Zooms out one step, centering on the position cursor.

Zoom Full Zooms out so that the whole clip is visible in the editor.

Zoom to 
Selection

Zooms in so that the current selection fills the editor 
display.

Zoom to 
Selection (Horiz.)

Zooms in horizontally so that the current selection fills 
the editor display.

Zoom to Event Zooms in so that the editor shows the section of the 
clip corresponding to the edited audio event. This is 
not available if you have opened the Sample Editor 
from the Pool (in which case the whole clip is opened 
for editing, not an event).

Zoom In/Out 
Vertically

This is the same as using the vertical zoom slider (see 
above).

Undo/Redo 
Zoom

These options allow you to undo/redo the last zoom 
operation. 
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Auditioning
While you can use the regular play commands to play 
back audio when the Sample Editor is open, it is often 
useful to listen to the edited material only.

When auditioning, audio is routed to the Control Room 
(if activated) or to the Main Mix (the default output bus). 
For information about routing, see “Routing” on page 168.

Clicking the Audition icon on the toolbar plays back the 
edited audio, according to the following rules:

• If you have made a selection, this selection will be played back.
• If there is no selection and “Show Event” is deactivated, play-

back will start at the cursor position.
• If the Audition Loop icon is activated, playback will continue 

repeatedly until you deactivate the Audition Loop icon. Other-
wise, the section will be played back once.

There is a separate Play button for auditioning regions, 
see “Auditioning regions” on page 291.

Using the Speaker tool

If you click somewhere in the waveform display with the 
Speaker (“Play”) tool and keep the mouse button pressed, 
the clip is played back from the position where you click. 
Playback will continue until you release the mouse button.

Using Acoustic Feedback

If you activate the “Acoustic Pitch Feedback” button on 
the toolbar, the audio will be played back when you edit it 
vertically, i. e. when you change the pitch. This way you 
can easily audition your modifications. 

Using key commands

If you activate the “Playback Toggle triggers Local Pre-
view” option in the Preferences dialog (Transport page), 
you can start/stop auditioning by pressing [Space]. This is 
the same as clicking the Audition icon on the toolbar.

The Sample Editor also supports the “Preview start” 
and “Preview stop” key commands in the Media category 
of the Key Commands dialog. These key commands stop 
the current playback, whether you are in normal playback 
or in audition mode.

Scrubbing

The Scrub tool allows you to locate positions in the audio 
by playing back, forwards, or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse 
button pressed.
The project cursor is moved to the position where you clicked.

3. Drag to the left or right.
The audio is played back. The speed and pitch of the playback depend 
on how fast you drag.

Adjusting the snap point
The snap point is a marker within an audio event. It is used 
as a reference position when you move events with snap 
activated, so that the snap point is “magnetic” to whatever 
snap positions you have selected.

By default, the snap point is set at the beginning of the au-
dio event, but often it is useful to move the snap point to a 
“relevant” position in the event, such as a downbeat.

To adjust the snap point, proceed as follows:

1. Activate the “Show Audio Event” option on the tool-
bar, so that the event is displayed in the editor.

2. If needed, scroll until the event is visible, and locate 
the “S” flag in the event.
If you have not adjusted this previously, it is located at the beginning of 
the event.
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3. Click on the “S” flag and drag it to the desired position.
You can also adjust the snap point by setting the project cursor at the de-
sired position, and selecting “Snap Point To Cursor” on the Audio menu.

The snap point will be set to the position of the cursor. 
This method can also be used in the Project window and 
the Audio Part Editor.

It is also possible to define a snap point for a clip (for 
which there is no event yet).

To open a clip in the Sample Editor, double-click it in the 
Pool. After having set the snap point you can insert the 
clip into the project from the Pool or the Sample Editor 
with the set snap point position.

Making selections
To select an audio section in the Sample Editor, click and 
drag with the Range Selection tool.

• If “Snap to Zero Crossing” is activated on the toolbar, 
the selection’s start and end are always at zero crossings.

• You can resize the selection by dragging its left and 
right edge or by [Shift]-clicking.

• The current selection is indicated in the corresponding 
fields on the Range tab of the Sample Editor Inspector.
You can fine-tune the selection by changing these values. Note that the 
values are relative to the start of the clip, rather than to the project timeline.

Using the Select menu

On the Select menu on the Range tab and in the Select 
submenu of the Edit menu you find the following options:

! When you set the grid start on the Definition tab, the 
snap point is moved to the grid start (see “Manual 
Adjust” on page 295).

! Events and clips can have different snap points. If 
you open a clip from the Pool you can edit the clip 
snap point. If you open a clip from within the project 
window, you can edit the event snap point. The clip 
snap point serves as a template for the event snap 
point. However, it is the event snap point that is 
taken into account when snapping.

Option Description

Select All Selects the whole clip.

Select None Selects no audio (the selection length is set to “0”).

Select in Loop Selects all audio between the left and right locator.

Select Event Selects only the audio that is included in the edited event. 
This is grayed out if you have opened the Sample Editor 
from the Pool (in which case the whole clip is opened for 
editing, not an event). 
If the VariAudio tab is open and your audio file is split into 
separate segments (see “Segments mode” on page 
304), all segments are selected. 

Locators to 
Selection 
(Range tab  
only)

Sets the locators to encompass the current selection. 
This is available if you have selected one or several 
events or made a selection range.

Locate Selection 
(Range tab only)

Moves the project cursor to the beginning or end of the 
current selection. For this to be available, you must have 
selected one or more events or parts, or made a selec-
tion range.

Loop Selection 
(Range tab only)

This activates playback from the start of the current se-
lection and keeps starting over again when reaching the 
selection end.

A selected range
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Editing selection ranges
Selections in the Sample Editor can be processed in sev-
eral ways. 

If you attempt to edit an event that is a shared copy (i. e. 
the event refers to a clip that is used by other events in the 
project), you are asked whether you want to create a new 
version of the clip.

• Select “New Version” if you want the editing to affect 
the selected event only. Select “Continue” if you want the 
editing to affect all shared copies.

If you activate the “Please, don’t ask again” option in 
the dialog, any further editing will conform to the selected 
method (“Continue” or “New Version”). You can change 
this setting at any time with the “On Processing Shared 
Clips” pop-up menu in the Preferences dialog (Editing–
Audio page).

• Any changes to the clip are shown in the Offline Pro-
cess History, making it possible to undo them later (see 
“The Offline Process History dialog” on page 275).

Cut, Copy, and Paste

The Cut, Copy, and Paste commands (on the Edit menu, 
on the Process tab of the Sample Editor Inspector, or in 
the main Edit menu) work according to the following rules:

• Selecting Copy copies the selection to the clipboard.

• Selecting Cut removes the selection from the clip and 
moves it to the clipboard.
The section to the right of the selection is moved to the left to fill the gap.

• Selecting Paste copies the data from the clipboard into 
the clip.
If there is a selection in the editor, this is replaced by the pasted data. If 
there is no selection, the pasted data is inserted starting at the project 
cursor. The section to the right of the line is moved to make room for the 
pasted material.

Delete

Selecting Delete (on the Edit menu, on the Process tab of 
the Sample Editor Inspector, or in the main Edit menu) re-
moves the selection from the clip. The section to the right 
of the selection is moved to the left to fill the gap.

Insert Silence

Selecting “Insert Silence” (on the Edit menu, on the Pro-
cess tab of the Sample Editor Inspector, or in the Range 
submenu of the main Edit menu) inserts a silent section 
with the same length as the current selection, at the selec-
tion start.

• The selection is not replaced, but moved to the right to 
make room. 
If you want to replace the selection, use the “Silence” function instead 
(see “Silence” on page 272).

Processing

The Processing features (on the Select Process menu, on 
the Process tab of the Sample Editor Inspector, or in the 
Process submenu of the Audio menu) can be applied to 
selections in the Sample Editor, as well as the effects (on 
the Select Plug-in menu on the Process tab of the Sample 
Editor Inspector or in the Plug-ins submenu of the Audio 
menu). For more information, see the chapter “Audio pro-
cessing and functions” on page 263. 

Creating a new event from the selection using 
drag & drop

To create a new event that plays only the selected range, 
proceed as follows:

1. Make a selection range.

2. Drag the selection range to an audio track in the 
Project window.

From Start 
to Cursor (Edit 
menu only)

Selects all audio between the clip start and the project 
cursor.

From Cursor 
to End (Edit 
menu only)

Selects all audio between the project cursor and the 
end of the clip. For this to work, the project cursor must 
be within the clip boundaries.

Equal Pitch -  
all Octaves/
same Octave

This function requires that the audio event has been an-
alyzed using the VariAudio features and that one or sev-
eral notes are selected. These options select all notes of 
this event that have the same pitch as the currently se-
lected note(s) (in any octave or in the current octave).

Left Selection 
Side to Cursor 
(Edit menu only)

Moves the left side of the current selection range to the 
project cursor position. For this to work, the cursor must 
be within the clip boundaries. This function is not avail-
able for VariAudio segments.

Right Selection 
Side to Cursor 
(Edit menu only)

Moves the right side of the current selection range to 
the project cursor position (or the end of the clip, if the 
cursor is to the right of the clip). This function is not 
available for VariAudio segments.

Option Description
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Creating a new clip or audio file from the selection

To extract a selection from an event and either create a 
new clip or a new audio file, proceed as follows:

1. Make a selection range.

2. Open the context menu and select “Bounce Selec-
tion” from the Audio submenu.

A new clip is created and added to the Pool, and another 
Sample Editor window opens with the new clip. This clip 
refers to the same audio file as the original clip, but con-
tains the audio corresponding to the selection range only.

Working with regions
Regions are sections within a clip. One of the main uses 
for regions is Cycle recording, in which the different 
“takes” are stored as regions (see “Recording audio in cy-
cle mode” on page 99). You can also use this feature for 
marking important sections in the audio clip. Regions can 
be dragged into the Project window from the Sample Edi-
tor or the Pool to create new audio events. 

Regions are best created, edited, and managed in the 
Sample Editor.

Creating and removing regions

1. Select the range that you want to convert into a region.

2. Click the “Set up Window Layout” button and activate 
the Regions option.
The regions list is displayed on the right.

3. Click the Add Region button above the regions list (or 
select “Event or Range as Region” from the Advanced 
submenu of the Audio menu).
A region is created, corresponding to the selected range.

4. To name the region, double-click on it in the list and 
enter a new name.
Using this procedure, regions can be renamed at any time.

• When you click on a region in the regions list, it is in-
stantly displayed in the Sample Editor.

• To remove a region from a clip, select it in the list and 
click the Remove Region button above the list.

Creating regions from hitpoints

If your audio event contains calculated hitpoints, you can 
choose to automatically create regions from hitpoints. This 
can be useful to isolate recorded sounds. For further infor-
mation on hitpoints, see “Working with hitpoints and 
slices” on page 299.

Editing regions

The region selected in the list is displayed in gray in the 
waveform display and the overview line.

There are two ways to edit the start and end positions of a 
region:

• Click and drag the region start and end handles in the 
waveform display (with any tool).
When you move the pointer over the handles, it automatically changes to 
indicate that you can drag the handles.

• Edit the Start and End positions in the corresponding 
fields in the regions list.
The positions are shown in the display format selected for the ruler and 
info line, but are relative to the start of the audio clip rather than the 
project timeline.

Auditioning regions

You can listen to a region by selecting it in the list and 
clicking the Play Region button above the list. The region 
will play back once or repeatedly, depending on whether 
the Loop icon on the toolbar is activated or not.

You can also listen to a region by selecting it in the list and 
clicking the Audition icon on the toolbar. This way you can 
preview separate regions by clicking on them in the list or 
by selecting them with the up/down arrow keys on your 
computer keyboard.
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Making selections from regions

If you select a region in the list and click the Select Region 
button above, the corresponding section of the audio clip 
is selected (as if you had selected it with the Range Se-
lection tool) and zoomed. This is useful if you want to ap-
ply processing to the region only. 

You can also double-click a region in the Pool to have 
its audio clip opened in the Sample Editor with the area of 
the region automatically selected.

Creating audio events from regions

To create new audio events from regions using drag & 
drop, proceed as follows:

1. In the list, click on the region and keep the mouse but-
ton pressed.

2. Drag the region to the desired position in the project 
and release the mouse button.
A new event is created.

• You can also use the “Events from Regions” function 
from the Advanced submenu of the Audio menu (see “Re-
gion operations” on page 79).

Exporting regions as audio files

If you create a region in the Sample Editor, the region can 
be exported to disk as a new audio file. This is done from 
the Pool, see “Exporting regions as audio files” on page 
330.

Drawing in the Sample Editor
It is possible to edit the audio clip at sample level by draw-
ing with the Pencil tool. This can be useful if you need to 
manually edit out a spike or click, etc.

Proceed as follows:

1. Zoom in to a zoom value lower than 1.
This means that there is more than one screen pixel per sample.

2. Select the Pencil tool.

3. Click and draw at the desired position in the waveform 
display.
When you release the mouse button, the edited section is automatically 
selected.

The Pencil tool cannot be used when the VariAudio 
tab is open.

Options and settings

Show Audio Event
When the “Show Audio Event” button is activated on the 
toolbar, the section corresponding to the edited event is 
highlighted in the waveform display and the Overview. The 
sections of the audio clip not belonging to the event are 
shown with a gray background.

• In this mode, you can adjust the start and end of the 
event in the clip by dragging the event handles in the 
waveform display.

Snap

The Snap function helps you to find exact positions when 
editing in the Sample Editor by restricting horizontal 
movement and positioning to certain grid positions. You 
turn Snap on or off by clicking the Snap button in the 
Sample Editor toolbar. 

The Sample Editor Snap function is independent of 
the Snap setting in the Project window toolbar or other 
editors. It has no effect outside the Sample Editor.

Snap to Zero Crossing

When this option is activated, editing is done at zero 
crossings (positions in the audio where the amplitude is 
zero). This helps you to avoid pops and clicks which might 
otherwise be caused by sudden amplitude changes.

If hitpoints have been calculated, these are also taken 
into account when snapping to zero crossings.

! This button is only available if you have opened the 
Sample Editor by double-clicking an audio event in 
the Project window or the Audio Part Editor. It is not 
available if you have opened the audio event from the 
Pool.
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The Sample Editor function “Snap to Zero Crossing” 
is independent of the same setting in the Project window 
toolbar or other editors. It has no effect outside the Sam-
ple Editor.

Auto-Scroll

When the Auto-Scroll option is activated on the Sample 
Editor toolbar, the waveform display will scroll during play-
back, keeping the project cursor visible in the editor.

This setting is independent of the Auto-Scroll setting 
in the Project window toolbar or other editors.

AudioWarp: Tempo matching audio
AudioWarp means realtime time stretching functions in 
Nuendo. The main AudioWarp features are tempo match-
ing audio loops to the project tempo and matching up an 
audio clip with fluctuating tempo to a fixed tempo.

Musical Mode
If you want to tempo match an audio loop to the project 
tempo, you will normally work with loops with straight 
beats. In this case you only need to activate the Musical 
Mode on the toolbar. 

The Musical Mode is one of the key AudioWarp features. 
It allows you to lock audio clips to the project tempo by 
using realtime time stretching. This is very useful if you 
want to use loops in your project without worrying too 
much about timing.

When Musical Mode is activated, audio events will adapt 
to any tempo changes in Nuendo, just like MIDI events.

You can activate Musical Mode on the AudioWarp tab, the Definition 
tab, and the toolbar.

It is also possible to activate/deactivate Musical Mode 
from within the Pool by clicking the corresponding check-
box in the Musical Mode column. 

To tempo match an audio loop to the project tempo, pro-
ceed as follows: 

1. Import your loop into the project and double-click it to 
open the Sample Editor.
If you open the Definition tab and take a look at the rulers, you will see 
that the project tempo grid (upper ruler) and the grid of your audio (lower 
ruler) do not match.
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2. Activate the Musical Mode button on the toolbar.
Your clip is warped and stretched automatically to adapt it to the project 
tempo. The rulers reflect the change.

In the Project window, the audio event is now shown with 
a note symbol and a double arrow in the upper right cor-
ner to indicate that Musical Mode is activated.

The Musical Mode state is saved with the project. This al-
lows you to import files into the project with Musical Mode 
already activated. The tempo is also saved when exporting 
files.

Auto Adjust
If you want to use an audio file with unknown tempo or if 
the beat of your loop is not straight, you have to change 
the “definition” of this audio file first. This is done with the 
Auto Adjust function on the Definition tab of the Sample 
Editor Inspector.

The Auto Adjust function quantizes your audio automati-
cally, i. e. the transients are moved to exact note values in 
the audio grid. 

Proceed as follows:

1. Open the Sample Editor and define a selection range 
for your audio clip. 
Alternatively, you can define a range by setting the start and end of the 
audio event. 

2. Open the Definition tab and click the Auto Adjust 
button.
The transients, i. e. the significant positions of your audio are moved to 
exact note values in the audio grid.

3. Activate the Musical Mode button on the toolbar.
Your clip is warped and stretched automatically to adapt it to the project 
tempo. The rulers reflect the change.

You can see that the event snap point is moved to the 
start of the selected range. If you take a look at the lower 
ruler, you will see that red vertical lines are shown. These 
indicate that your audio has been aligned to bar and beat 
positions.

! Nuendo supports ACID® loops. These loops are 
standard audio files but with embedded tempo/length 
information. When ACID® files are imported into Nu-
endo, Musical Mode is automatically activated and the 
loops will adapt to the project tempo.
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Manual Adjust
You might have a very special loop where the automatic 
function does not lead to satisfying results. In this case 
you can manually adjust the grid and tempo of your audio 
file. Proceed as follows:

1. Open the Definition tab in the Sample Editor Inspector 
and activate the Manual Adjust tool.

2. Select a suitable value from the Grid pop-up menu.
This determines the grid resolution for your audio. The vertical lines of the 
grid represent bar positions, and the red vertical lines beat positions.

3. Move the mouse pointer to the beginning of the audio 
file until the tooltip “Set Grid Start” is displayed.
The mouse pointer turns into a double arrow to indicate that you can edit 
the time grid for the audio file.

4. Click and drag to the right to set the grid start at the 
first downbeat, and release the mouse button.
The lower ruler (for the audio) changes to reflect your edits. 

5. Audition the file to determine where the second bar in 
the sample begins.

6. In the upper part of the waveform, move the mouse 
pointer to the vertical line nearest to the second bar so 
that the tooltip “Stretch Grid” and a blue vertical line are 
shown.
The functionality of the Manual Adjust tool changes depending on its po-
sition, e. g. if applied in the lower part of the waveform on a vertical line, it 
is used to set a bar position, see below.

7. Click and drag the blue vertical line to the left or right 
to the position of the first downbeat in the second bar and 
release the mouse button.
The beginning of the next bar is set, and all following bars are stretched 
or compressed by the same amount.

8. Check the positions of the following bars and, if nec-
essary, move the mouse pointer over the grid lines in the 
lower part of the waveform until the tooltip “Set Bar Posi-
tion (Move Following Bars)” and a green vertical line are 
shown.
This allows you to set the bar positions. When you drag the mouse, the 
beginning of the next bar is set, and the tempo of the previous bar is 
changed.

9. Now have a look at the single beats in between the 
bars and, if necessary, move the mouse pointer to a beat 
position to adjust them.
The Set Beat Position function is displayed with a light blue line. Drag it 
until the single beat position is aligned with the waveform, and release 
the mouse button. 
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• If you are not satisfied with a specific edit, you can hold 
down any modifier key and click on the adjusted grid line 
(bar or beat).
The Eraser tool appears together with a tooltip indicating that you can re-
move your edit.

When you are done, you can activate Musical Mode to ad-
just your audio loop to the project tempo.

Applying swing
If you find that your audio sounds too straight, e. g. after 
having quantized it with the Auto Adjust function, you can 
add swing. Proceed as follows:

1. Activate Musical Mode.

2. On the AudioWarp tab, select a suitable grid resolu-
tion from the Resolution pop-up menu.
This defines the positions that the swing is applied to. If you select 1/2, 
the swing is applied in steps of half notes, if you select 1/4, it is applied 
in steps of quarter notes, etc.

3. Move the Swing fader to the right to offset every sec-
ond position in the grid.
This creates a swing or shuffle feel. 

Depending on how far you move the fader to the right and 
what grid resolution you chose, this function offers every-
thing from half-note swing to 64th-note swing. 

Selecting an algorithm for realtime playback
In the Algorithm pop-up menu on the toolbar you can se-
lect the algorithm preset to be applied on realtime play-
back. This setting affects warp changes in Musical Mode, 
FreeWarp, Swing, as well as VariAudio warping and 
pitching (only the Solo preset can be used).

On this pop-up menu you can find various options that 
govern the audio quality of the realtime time stretching. 
There are presets that allow you to manually set warp pa-
rameters:

Option Description

Drums This mode is best for percussive sounds, because it does not 
change the timing of your audio. Using this option for pitched 
audio will lead to noticeable artifacts. In this case, you can try 
the Mix mode.

Plucked Use this mode for audio with transients and a relatively stable 
spectral sound character (e. g. plucked instruments).

Pads Use this mode for pitched audio with slower rhythm and a sta-
ble spectral sound character. This minimizes sound artifacts, 
but the rhythmic accuracy is not preserved.

Vocals This mode is suitable for slower signals with transients and a 
prominent tonal character (e. g. vocals).

Mix This mode preserves the rhythm and minimizes the artifacts 
for pitched material which does not meet the above criteria 
(i. e. with a less homogenous sound character).  
This is selected by default for audio that is not categorized.

Advanced This allows for a manual tweaking of the time stretching pa-
rameters. By default, the settings that are shown when you 
open the dialog are those of the last preset used (except if the 
Solo mode has been selected, see below). The Advanced 
settings are described more in detail below this table.

Solo This mode preserves the timbre of the audio. Only use it for 
monophonic material (solo woodwind/brass instruments or 
solo vocals, monophonic synths or string instruments that do 
not play harmonies).
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If you select the Advanced menu item, a dialog opens 
where you can manually adjust the three parameters that 
govern the sound quality of the time stretching:

Free Warp
The Free Warp tool allows you to create warp tabs. Warp 
tabs are a kind of marker or anchor that can be attached to 
musically relevant time positions in an audio event, for ex-
ample the first beat of every bar. Warp tabs can be dragged 
to the corresponding time positions in the project, and the 
audio will be stretched accordingly. 

A typical application of warp tabs is to use them to syn-
chronize audio to video (see the chapter “Audio editing to 
picture” on page 535).

You can also use warp tabs for further tweaking after hav-
ing activated Musical Mode.

Using the Free Warp tool 
Warp tabs are created using the Free Warp tool on the Au-
dioWarp tab of the Sample Editor, but can also be created 
from hitpoints (see “Creating warp tabs from hitpoints” on 
page 298). In this example, we will show how a file with 
slightly varying tempo can be locked to a steady tempo by 
using warp tabs. It illustrates the general methods of using 
warp tabs and the Free Warp tool. But you can of course 
use warp tabs for other operations than aligning downbeats 
to grid positions. With the Free Warp tool, you can literally 
stretch any region within a sample to any position!

Proceed as follows:

1. Open the audio file that you wish to process in the 
Sample Editor.

2. Activate the “Snap to Zero Crossing” button on the 
Sample Editor toolbar.
When you activate this button, warp tabs will snap to zero crossings and 
hitpoints (if shown).

3. On the Definition tab, click the Auto Adjust button.

4. Line up the audio file so that the first beat of the first 
bar (in the audio event) starts on the first beat of a bar in 
the project.

• If the audio file does not start on a downbeat, you can 
use the Event Start handle in the Sample Editor and adjust 
the position in the Project window so that the first down-
beat in the sample is aligned with the first beat of a bar in 
the grid.
Now the first musical downbeat should be aligned with the first beat of a 
bar in the project. 

The next step is to find out where the first warp tab needs 
to be added. Activate the metronome click on the Trans-
port panel and play back your audio clip to determine po-
sitions where its tempo drifts from the project tempo. 

Parameter Description

Grain size The realtime time stretching algorithm splits the audio into 
small pieces called “grains”. This parameter determines the 
size of the grains. For material with many transients, use low 
Grain size values for best results. 

Overlap Overlap is the percentage of the whole grain that will overlap 
with other grains. Use higher values for material with a stable 
sound character.

Variance Variance is also a percentage of the whole length of the 
grains, and sets a variation in positioning so that the overlap-
ping area sounds smooth. A Variance setting of 0 will pro-
duce a sound akin to time stretching used in early samplers, 
whereas higher settings produce more (rhythmic) “smear-
ing” effects but less audio artifacts.

! If the VariAudio tab is open, only the warp handles 
are shown.

! When you activate or deactivate Musical Mode or 
select another Resolution value, all your warp modifi-
cations will be lost.
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5. Play back the audio file and determine where the first 
beat of a bar in the audio event does not match the corre-
sponding ruler position in the project.
If you find it difficult to pinpoint an exact position in the audio event, you 
can use the Scrub tool and/or zoom in the view.

6. On the AudioWarp tab, select the Free Warp tool, 
place the pointer at the position of the beat that you want 
to adjust, click, and hold.
When you place the mouse pointer in the waveform display, it changes 
to a clock with arrows on either side and a vertical line in the middle, 
which represents the pointer. 

7. With the mouse button still pressed, drag the warp tab 
to the desired position in the ruler and release the mouse 
button.
A warp tab is added and your beat should be perfectly aligned with the 
corresponding position in the project. If the position where you clicked 
was off, you can adjust it by dragging the handle.

You can also first add warp tabs at the relevant musi-
cal positions and change their positions later, see “Editing 
warp tabs” on page 298.

Next to the warp tab handle in the ruler, a number is 
shown. This number indicates the warp factor, i. e. the 
amount of stretch. Warp factor numbers higher than 1.0 
indicate that the audio region preceding the warp tab is 
expanded and will play back slower. Warp factor numbers 
lower than 1.0 indicate that the audio region preceding 
the warp tab is compressed and will play back faster.

8. Repeat the described steps to align the first beat in 
each bar to the corresponding ruler position.

You only have to add warp tabs where the downbeat 
in the audio file drifts from the ruler position and/or if you 
want to lock a warp tab so that it is not moved when edit-
ing other points. 

Editing warp tabs

Moving the destination of existing warp tabs

To move the destination position of a warp tab (and thus 
stretch or compress the audio), select the Free Warp tool 
and position the pointer on the warp line in the waveform, 
click and drag. 

Moving the insert position of existing warp tabs

If you wish to change the insert position of a warp tab in 
the audio, click and drag the warp tab handle in the ruler. 
This will change the warping.

Disabling warp tabs

You can disable all warp modifications by clicking the 
“Disable Warp Changes” button on the AudioWarp tab or 
by setting up and using the “VariAudio - Disable Warp 
Changes” key command in the Key Commands dialog, 
Sample Editor category (see “Key commands” on page 
580). 

Deleting warp tabs

To delete a warp tab, hold down [Alt]/[Option] so that the 
pointer becomes an eraser and click on the warp tab. To 
delete several warp tabs, hold down [Alt]/[Option] while 
drawing a selection rectangle.

Resetting warp modifications

To reset your Free Warp edits, click the Reset button on 
the AudioWarp tab. This also resets the “Disable Warp 
Changes” button on the same tab.

If Musical Mode is activated, only Free Warp edits are 
reset.

Creating warp tabs from hitpoints

You can also create warp tabs from hitpoints by selecting 
“Create Warp Tabs from Hitpoints” on the Realtime Pro-
cessing submenu of the Audio menu.
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Working with hitpoints and slices
Hitpoint detection is a special feature of the Sample Edi-
tor. It detects attack transients in an audio file and adds a 
type of marker, i. e. a “hitpoint”, at each transient. These 
hitpoints allow you to create “slices”, where each slice 
ideally represents each individual sound or “beat” in a loop 
(drum or other rhythmic loops work best with this feature). 
When you have successfully sliced the audio file, you can 
do a number of useful things with it:

• Change the tempo without affecting the pitch.
• Extract the timing (a groove map) from a drum loop. The 

groove map can then be used to quantize other events.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the 

basic feel.
• Extract sounds from loops.

You can further edit these slices in the Audio Part Editor. 
You can, for example:

• Remove or mute slices.
• Change the loop by reordering, replacing, or quantizing slices.
• Apply processing or effects to individual slices.
• Create new files from individual slices using the “Bounce 

Selection” function on the Audio menu.
• Transpose in realtime and stretch slices.
• Edit slice envelopes.

Hitpoints are only displayed in the waveform if the Hit-
points tab is open.

Using hitpoints
The main functionality of using hitpoints to slice up a loop 
is to make a loop fit the tempo of a song, or alternatively to 
create a situation that allows the song tempo to be 
changed while retaining the timing of a rhythmic audio 
loop, just like when using MIDI files. 

Which audio files can be used?

Here are some guidelines as to what type of audio files are 
suited for slicing using hitpoints:

• Each individual sound in the loop should have a notice-
able attack.
Slow attacks, legato playing, etc. may not produce the desired result.

• Poorly recorded audio might be difficult to slice correctly.
In these cases, try to normalize the files or to remove DC Offset.

• There may be problems with sounds drowned in smear-
ing effects, like short delays.

Calculating hitpoints and slicing a loop

Before proceeding, check if your audio file is suited for 
slicing using hitpoints, see above. Proceed as follows:

1. Open the Hitpoints tab and select an option from the 
Use pop-up menu. 
The Use pop-up menu on the Hitpoints tab affects which hitpoints are 
shown and is a useful tool for removing unwanted hitpoints.  
The following options are available:

If you select one of the options of the Use pop-up menu 
(except “All”), a second ruler that displays the musical 
structure of the audio file is shown below the ordinary ruler. 

2. Move the Sensitivity slider to the right to add hitpoints 
or to the left to remove unwanted hitpoints until one indi-
vidual sound is played between two hitpoints.
If your main reason for slicing the loop is to change the tempo, you gen-
erally need as many slices as you can get, but never more than one per 
individual “hit” in the loop. If you want to create a groove, try to get ap-
proximately one slice per eighth note, sixteenth note, or whatever the 
loop requires (see “Creating groove quantize maps” on page 301).

In the next step, the loop will be adapted to the project 
tempo set in Nuendo.

3. On the Hitpoints tab, click the Create Slices button or 
select “Create Audio Slices from Hitpoints” from the Hit-
points submenu of the Audio menu. 

Option Description

All All hitpoints are shown (taking the Sensitivity slider into ac-
count).

1/4, 1/8,  
1/16, 1/32

Only hitpoints that are close to the selected note value posi-
tions within the loop are shown (e. g. close to exact sixteenth 
note positions). Again, the Sensitivity slider is taken into ac-
count.

Metric Bias This is like the “All” mode, but all hitpoints that are close to 
even meter divisions (1/4, 1/8, 1/16, etc.) get a “sensitivity 
boost” – they are visible at lower sensitivity settings. This is 
useful if you are working with dense or cluttered material with 
a lot of hitpoints, but you know that the material is based on a 
strict meter. By selecting Metric Bias it is easier to find the hit-
points close to the meter position (although most other hit-
points are also available, at higher sensitivity settings).
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The following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that the sections between the 

hitpoints become separate events, all referring to the same 
original file.

• The audio event is replaced by an audio part, containing the 
slices (double-click the part to view the slices in the Audio 
Part Editor).

• The loop is automatically adapted to the project tempo. This 
takes the specified loop length into account: e. g., if the loop 
was one bar long, the part is resized to fit exactly one bar in 
the Nuendo tempo, and the slices are moved accordingly, 
keeping their relative positions within the part.

• In the Pool, the sliced clip is shown with a different icon. Drag-
ging the sliced clip from the Pool to an audio track creates an 
audio part with the slices adapted to the project tempo, just as 
above.

4. Activate cycle playback on the Transport panel.
The loop should now play back seamlessly at the tempo set in the project!

Hitpoints and tempo settings

The musical time base setting and the project tempo af-
fect how your loops are played back. 

• Make sure that the “Musical time base” button in the 
track list or Inspector is activated (the button shows a note 
symbol – see “Switching between musical and linear time 
base” on page 63). This way the loop will follow any fur-
ther tempo changes.

• If the project tempo is slower than the original tempo of 
the loop, there may be audible gaps between each slice 
event in the part.
To remedy this, you can use the Close Gaps function on the Advanced 
submenu of the Audio menu, see “Close Gaps” on page 302. Also con-
sider activating auto fades for the corresponding audio track – fade-outs 
set to about 10 ms will help eliminate any clicks between the slices when 
you play back the part. See “Auto fades and crossfades” on page 120 for 
details.

• If the project tempo is higher than the loop’s original 
tempo, you may want to activate auto crossfades for the 
track.
You can use the Close Gaps functions in this case as well, see “Close 
Gaps” on page 302.

The slices in the Audio Part Editor. Here, the project tempo was higher 
than the loop’s original tempo – the slice events overlap.

Setting hitpoints manually

If you cannot get the desired result by adjusting the sensi-
tivity, try to set and edit hitpoints manually. 

Proceed as follows:

1. Zoom in on the waveform at the point where you wish 
to add a hitpoint.

2. Select the Edit Hitpoints tool to audition the area and 
make sure that the start of the sound is in view.

3. Activate “Snap to Zero Crossing” on the Sample Edi-
tor toolbar.
By finding zero crossings in the waveform (positions where the amplitude 
is close to zero), manually added slices will not insert any clicks or pops. 
All hitpoints calculated by the program are automatically placed at zero 
crossings.

4. Press [Alt]/[Option] so that the mouse pointer changes 
to a pencil tool and click just before the start of the sound.
A new hitpoint appears. Manually added hitpoints are locked by default.

• If you notice that a hitpoint was either placed too far away 
from the start of the sound or too far into the sound, you can 
move it by dragging the hitpoint to the new position.

! When you create slices, all events referring to the 
edited clip are also replaced.

! “Snap to Zero Crossing” may alter the timing. In 
some cases it is better to deactivate it, especially if 
you just want to generate a groove quantize map. 
However, if you create slices afterwards, auto fades 
are necessary.
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5. Audition the slices by pointing and clicking in any slice 
area.
The pointer changes to a speaker icon and the corresponding slice is 
played back from the beginning to the end.

• If you hear a single sound split into two slices you can 
disable an individual slice by clicking on the handle of the 
corresponding hitpoint.
The hitpoint handle gets smaller and its line disappears to indicate that it 
is disabled. To reactivate a disabled hitpoint, click on the hitpoint handle 
again.

• If you hear “double hits” (e. g. a snare hit being followed 
by a hi-hat hit within the same slice), you can add further 
hitpoints manually, or you can move the Sensitivity slider 
to the right until the hitpoint appears and lock the hitpoint 
by holding down [Ctrl]/[Command] or [Shift] and clicking 
on its handle. 
Locked hitpoints are displayed in a darker color. After locking the hitpoint 
you can drag the sensitivity slider to the original setting and the locked 
hitpoint will remain shown. You can unlock a locked hitpoint by clicking 
on its handle.

• If you want to delete a hitpoint, hold down [Ctrl]/[Com-
mand] and click on it. If you want to delete several hit-
points, hold down [Ctrl]/[Command] and drag a selection 
rectangle.
You can also hold down [Shift] and click to delete hitpoints.

Creating groove quantize maps
You can generate groove quantize maps based on the 
hitpoints that you have created in the Sample Editor. 
Groove quantizing is not meant for correcting errors, but for 
creating rhythmic feels. This is done by comparing your re-
corded music with a “groove” (a timing grid generated from 
the file) and moving the appropriate notes so that their tim-
ing matches the one of the groove. In other words, you can 
extract the timing from an audio loop and use it for quantiz-
ing MIDI parts (or other audio loops, after slicing them).

Proceed as follows:

1. Check the audio tempo and define the audio grid.

2. Create and edit hitpoints as described above.
Try to get approximately one slice per eighth note, sixteenth note, or 
whatever the loop requires. It can be helpful to use one of the note value-
based options on the Use pop-up menu (see “Calculating hitpoints and 
slicing a loop” on page 299).

You do not have to create slices – just set up the hit-
points.

3. When you have finished setting the hitpoints, click the 
Create Groove button on the Hitpoints tab or select “Cre-
ate Groove Quantize from Hitpoints” from the Hitpoints 
submenu of the Audio menu.
The groove is extracted.

4. If you now pull down the Quantize Type pop-up menu 
in the Project window you find an additional item at the 
bottom of the list, with the same name as the file from 
which you have extracted the groove.
This groove can now be selected as a base for quantizing, just like any 
other quantize value, see “The quantizing functions” on page 392.

5. If you want to save the groove, open the Quantize 
Setup dialog and store it as a preset.

You can also create grooves from a MIDI part by se-
lecting the part and dragging it on the grid display in the 
middle of the Quantize Setup dialog or by selecting “Part 
to Groove” from the Advanced Quantize submenu of the 
MIDI menu.

Other hitpoint functions
On the Hitpoints tab of the Sample Editor Inspector and 
on the various submenus of the Audio menu, you will also 
find the following functions:

Create Markers

If an audio event contains calculated hitpoints, you can 
click the Create Markers button on the Hitpoints tab to 
add a marker on the active marker track for each hitpoint. If 
your project has no marker track, it will be added and acti-
vated automatically (see “Using markers” on page 136). 
Markers can be useful to snap to hitpoints, e. g. for locat-
ing hitpoints and for using the Time Warp tool (see “The 
Time Warp tool” on page 459).

Create Regions

If your audio event contains calculated hitpoints, you can 
click the Create Regions button on the Hitpoints tab to 
automatically create regions from hitpoints. This can be 
useful to isolate recorded sounds.

Create Events

When you wish to create separate events according to 
the hitpoints for a file, you can click the Create Events but-
ton on the Hitpoints tab and use any method you like to 
set hitpoints.
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The created slices are shown as separate events in 
the Project window.

Close Gaps

This function from the Advanced submenu of the Audio 
menu is useful if you have sliced a loop for tempo changes 
and you change the project tempo. Lowering the project 
tempo below the loop’s original tempo creates gaps be-
tween the slices – the slower the tempo, the wider the 
gaps. Increasing the project tempo over the loop’s original 
tempo compresses the slices using the time stretch func-
tion and creates overlaps. In both cases, you can use the 
Close Gaps function.

Proceed as follows:

1. Set the desired tempo.

2. In the Project window select the part containing the 
slices.

3. From the Advanced submenu of the Audio menu se-
lect “Close Gaps”.
Time stretch is applied to each slice to close the gaps. Depending on the 
length of the part and the algorithm set in the Preferences dialog (Edit-
ing–Audio page), this can take a while.

4. The waveform is redrawn and the gaps are closed!
If you open the Pool, you will see that new clips were created, one for 
each slice.

If you decide to change the tempo again after using the 
Close Gaps function, undo the Close Gaps operation or 
start over again, using the original, unstretched file. 

In the Audio Part Editor or Project window you can 
also use Close Gaps on audio events. This will stretch the 
audio event to the start position of the next event.

VariAudio
With the AudioWarp features, editing audio in the time 
domain has become significantly easier. However, editing 
pitch was limited to having just one single numeric “trans-
pose” value per event or part.

VariAudio offers completely integrated vocal editing and 
pitch alteration of individual notes in monophonic vocal re-
cordings and can solve intonation and timing problems 
with only a few mouse clicks. It was developed and opti-
mized specifically to be used with monophonic vocal re-
cordings. Though the detection and stretching of notes of 

other monophonic audio recordings, such as those of a 
saxophone, may work well, the quality of the end result de-
pends greatly on the generic condition and structure of 
the recording’s texture. 

And how does it work? First, the vocal line is analyzed and 
split into segments shown as graphic representation of 
the notes sung. After the detection process is complete, 
the recognized notes can be modified entirely “non-de-
structively” so that any modifications to the audio material 
can be undone.

VariAudio allows you to change your audio on the vertical 
axis (see “Changing the pitch” on page 306) and on the 
horizontal axis (see “Warping segments” on page 309).

Understanding the waveform display in 
VariAudio
When you open monophonic vocal recordings in the Sam-
ple Editor and activate the Segments or the Pitch & Warp 
tool on the VariAudio tab, your audio is analyzed and seg-
mented to display the tonal portions, i. e. the notes sung or 
played. This process is called segmentation. The segmen-
tation allows you to easily associate the audio with your lyr-
ics and to introduce pitch and timing changes. 
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In between the different segments you may find gaps 
where non-tonal portions have been detected. Such gaps 
can be caused by non-tonal portions of the audio, e. g. 
breath sounds.

At the beginning of the waveform, you can see a gap where no segment 
is shown. 

The audio waveform displayed on the VariAudio tab is 
always shown as mono, even if you have opened a stereo 
or multi-channel file.

The vertical position of a segment indicates its average 
pitch. If the Pitch & Warp tool is active and you move the 
mouse pointer over a segment, a piano keyboard is dis-
played, showing the found pitches.

Furthermore, if you move the mouse pointer over a seg-
ment and the zoom factor is high enough, the average 
pitch – note name and fine tuning in cent steps (100ths of 
a semitone) – is shown on top of the segment. When you 
select a segment, this is also shown in the info line.

Note pitches represent the perceived fundamental fre-
quency of a sound. The note A4 is perceived to be of the 
same pitch as a sine wave of 440 Hz. The notation of 
pitches is a logarithmic frequency scale. The table below 
shows the relation between pitch (note name) and 
frequency in Hz:

The average pitch of a segment is calculated from its micro-
pitch curve. Micro-pitch curves represent the progression 
of the pitch for the tonal portion of the audio. 

The horizontal position of a segment indicates the time 
position and the length. 

You can navigate through the segments by using the left/
right arrow keys on your computer keyboard.

You can zoom in on the segments that you want to edit by 
holding down [Alt]/[Option] while drawing a selection 
rectangle. To zoom out hold down [Alt]/[Option] and click 
in an empty area of the waveform. If you hold down [Alt]/
[Option] and double click in an empty area, the display will 
be zoomed out to show all segments.

Audio waveform Segments

Gap

…a piano 
keyboard is 
shown in the 
waveform.

If you move the 
mouse over a 

segment…

Note name Fine tuning in cents

C4 C#4/ 
Db4

D4 D#4/
Eb4

E4 F4 F#4/ 
Gb4

261.63 277.18 293.66 311.13 329.63 349.23 369.99

G4 G#4/ 
Ab4

A4 A#4/ 
Bb4

B4 C5

392.00 415.30 440.00 466.16 493.88 523.25

Micro-pitch curves
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Applying editing, offline processes, and 
VariAudio
The following offline processes and edits that affect the 
length of the audio file may lead to the reanalysis of the 
audio material:

• Options on the Select Process menu, on the Process 
tab of the Sample Editor Inspector, or in the Process sub-
menu of the Audio menu that can be applied to selections.

• Effect processing using the options on the Select Plug-
in menu on the Process tab of the Sample Editor Inspec-
tor or in the Plug-ins submenu of the Audio menu (see the 
chapter “Audio processing and functions” on page 263).

• Cut, paste, and delete (see “Editing selection ranges” 
on page 290), or drawing notes (see “Drawing in the 
Sample Editor” on page 292).

If you apply editing that affects the audio itself (like cutting 
portions, etc.) to a file containing VariAudio data, the follow-
ing warning message is displayed:

• If you click “Proceed”, your edits are applied and you 
will lose your VariAudio data.
Click “Cancel” to return to your audio file without applying any changes.

If you apply offline processing to a file containing VariAudio 
data, the following warning message is displayed:

• If you click “Proceed”, your edits are applied, and you 
will lose your VariAudio data.
Click “Cancel” to return to your audio file without applying any changes.

• If you click “Proceed and Keep”, your edits are applied. 
Any VariAudio data in the audio file is kept.
Offline processes that may not affect existing VarioAudio data are Enve-
lope, Fade In/Out, Normalize, or Silence. 

• If you activate the “Please don’t display this warning 
again” option in one of these warning dialogs before pro-
ceeding, Nuendo will always proceed with the selected 
option. 
You can reactivate the warning messages by deactivating the “Inhibit 
warning when changing the Sample Data” or “Inhibit warning when apply-
ing Offline Processes” options in the Preferences dialog (VariAudio page).

Segments mode
If you activate Segments mode on the VariAudio tab, your 
audio file is analyzed and split into separate segments.

When you want to change the pitch of audio that includes 
non-tonal portions, e. g. consonants or effect sounds like 
reverberation, you may have to edit the segmentation in 
order to include the non-tonal portions in the segments. 
Otherwise, pitch modifications will only affect the tonal 
portions. 

Editing the segmentation includes changing the start and 
end position of a segment, cutting or gluing segments, 
and moving or deleting them. Just select the section of the 
file that you want to change, activate Segments mode, 
and edit the segmentation for the desired section. If you 
are not satisfied with your changes, you can go back to 
the original segmentation (see “Reset” on page 311).

In Segments mode, the segments are shown with a 
hatched background. You can toggle between “Pitch & 
Warp” and “Segments” mode (see “Pitch & Warp tool” on 
page 306) by pressing the [Tab] key.

! Because of the reanalysis any existing VariAudio 
data becomes invalid. Therefore, you should always 
apply offline processing or edits before using the 
VariAudio features.

! Due to the data gained during this process, the au-
dio and thus the size of your project can increase. 
Furthermore, the analysis of long audio files might 
take some time. 

! Editing the segmentation always leads to a recalcu-
lation of the segment’s pitch. Therefore, it is recom-
mended that you edit the segmentation before 
changing the pitch.
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The following paragraphs list the corrections that can be 
performed when Segments mode is activated.

Changing the note start or end point 

If you find that a note starts or ends too early or too late, 
e. g. when the reverb of a note or a consonant is not in-
cluded in the segment, proceed as follows:

1. On the VariAudio tab activate Segments mode.

2. To change the length of a segment, move the mouse 
pointer over the start/end of the segment.
The mouse pointer becomes a double arrow.

3. Click and drag the segment start/end to the left or right. 
The segment length changes accordingly. As the average pitch is recal-
culated, the segment may jump upwards or downwards. Snap will not be 
taken into account. 

You can drag the segment start/end only until it reaches 
the start/end of the next segment. Segments cannot over-
lap each other.

Cutting a segment

If you notice that a segment includes more than one note, 
proceed as follows:

1. On the VariAudio tab activate Segments mode.

2. Move the mouse pointer over the lower border of the 
segment that you would like to cut.
The mouse pointer becomes a scissor.

3. Click at the desired position to cut the segment.
The segment is cut accordingly taking Snap into account.

There is a minimum size for a segment. Very short seg-
ments cannot be cut.

Gluing segments

If you notice that a single note is spread over two seg-
ments, proceed as follows:

1. On the VariAudio tab activate Segments mode.

2. Hold down [Alt]/[Option] and move the mouse pointer 
over the segment that you want to glue to the next.
The mouse pointer becomes a glue tube. 

3. Click to glue the active segment to the next segment. 
If several segments are selected, they are all glued together. Snap is not 
taken into account.

! If the resulting segment pitch cannot be calculated 
because of an increase in non-tonal data, the seg-
ment will be deleted.

! When the resulting segment pitch cannot be calcu-
lated because of an increase in non-tonal data, the 
segment will be deleted.

! We recommend to correct the segmentation before 
pitching. If you glue together segments after changing 
the pitch (this includes manual pitch modifications, 
Quantize Pitch, and Straighten Pitch), your modifica-
tions are reset and the original pitch will be heard.

! If the resulting segment pitch cannot be calculated 
because of an increase in non-tonal data, the seg-
ment will be deleted.
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Moving segments horizontally

After cutting a segment it may be necessary to move seg-
ments horizontally, for example, if you notice that a note is 
at the wrong position. Proceed as follows:

1. On the VariAudio tab activate Segments mode.

2. Move the mouse pointer over the upper border of the 
segment.
The mouse pointer becomes a double arrow.

3. Click and drag the whole segment to the left or right.
The segment is moved accordingly. If several segments are selected, they 
are all moved together. Snap is not taken into account. 

You can only drag the segment start/end until it 
reaches the start/end of the next segment. Segments can-
not overlap each other.

Deleting segments

Sometimes it might be useful to delete segments. This is 
the case in situations where you want the original audio to 
be played back, e. g. for non-tonal portions or consonants.

• You can delete segments by selecting them in Seg-
ments mode and pressing [Backspace]. 

Saving the segmentation

The corrected segmentation is saved with the project, no 
additional saving is required. 

Pitch & Warp tool 
If you activate the Pitch & Warp tool on the VariAudio tab, 
you can change the pitch and the timing of your audio.

You can edit the pitch and timing of audio segments for 
corrective purposes but also creatively. VariAudio allows 
you to experiment freely with note pitches in order to 
change the melody with or without preserving a natural 
sound. Furthermore, you can change the timing of the 
audio. 

In Pitch & Warp mode, the segments are shown with a 
plain background. You can toggle between “Pitch & 
Warp” and “Segments” mode by pressing the [Tab] key.

There are some restrictions concerning the highest 
and lowest possible note pitch. You cannot choose note 
pitches above C5 and below E0.

Changing the pitch 

If you want to edit the pitch of a segment, proceed as 
follows:

1. On the VariAudio tab activate the Pitch & Warp tool.

2. Move the mouse pointer over the segment.
The mouse pointer becomes a hand symbol to indicate that you can 
change the pitch of the segment. If the zoom factor is high enough, a 
tooltip indicates the found note pitch and the segment’s deviation from 
this pitch in percent. 

! If the resulting segment pitch cannot be calculated 
because of an increase in non-tonal data, the seg-
ment will be deleted.

! Before changing the pitch or timing of your segments, 
make sure that the segments you want to change are 
correct (see “Segments mode” on page 304).
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There are three different modes that affect the way in which 
a note will snap to a certain pitch that can be accessed us-
ing the following modifier keys:

The default modifier key can be changed in the Prefer-
ences dialog (Editing–Tool Modifier page).

3. Drag the segment up or down to the desired pitch and 
release the mouse. However, be careful: The more the 
pitch deviates from the original pitch, the less likely it is 
that your audio sounds natural.
If the Solo algorithm is not turned on already, a warning appears informing 
you that Nuendo has selected it automatically. The segment is pitched ac-
cordingly. While dragging, the original micro-pitch curve of the segment is 
shown in orange. If several segments are selected, they are all pitched. 

You can also use the up/down arrow keys on your com-
puter keyboard to edit the note pitches. 

Proceed as follows:

• Use the up/down arrow keys to change the pitch in 
semitone steps.

• Hold down [Shift] while using the up/down arrow keys 
to change the pitch in cent steps.

Quantize Pitch

You can also quantize the audio pitch upwards or down-
wards to iteratively reduce the deviation from the nearest 
semitone position. 

Proceed as follows:

1. Select the segments that you want to quantize.

2. Move the Quantize Pitch slider to the right.
The selected segments are quantized iteratively. 

You can set up a key command for Quantize Pitch in the 
Sample Editor category of the Key Commands dialog (see 
“Key commands” on page 580). When using the key com-
mand, the segments are directly quantized to the next semi-
tone position.

Tilting the micro-pitch curve

Sometimes changing the pitch of the whole note segment 
is not enough. In these cases you will have to modify how 
the pitch changes inside the segment. This is indicated by 
the micro-pitch curve (see “Understanding the waveform 
display in VariAudio” on page 302). 

Proceed as follows:

1. On the VariAudio tab, activate the Pitch & Warp tool.

2. To change the micro-pitch of a segment, move the 
mouse pointer over the top left/right corner of the segment.
The mouse pointer becomes an up/down arrow. 

3. Drag upwards/downwards with the mouse to change 
the micro-pitch curve.

Option Description Default modifier

Absolute Pitch 
Snapping

Pitches the segment to the 
next semitone.

None

Relative Pitch 
Snapping

Snaps the segment in rela-
tion to its current deviation in 
cents, i. e. if the segment has 
a pitch of C3 and a deviation 
of 22 %, and you move it up 
by one semitone, it will be 
pitched to C#3 while keep-
ing the deviation of 22 %.

[Ctrl]/[Command]

No Pitch Snapping Lets you edit the pitch freely. [Shift]

! If you pitch-shift audio events with the Transpose op-
tions (see “The transpose functions” on page 129) 
the transposition is added to the pitch modifications 
that you introduced with the Pitch & Warp tool, even 
if this is not reflected in the segmentation display.

! The micro-pitch curve displays the progression of 
the pitch for the tonal portion of the segment. For 
non-tonal portions of the audio, micro-pitch curves 
cannot be shown. 

If the pitch falls at the end of the 
segment…

…activate the Pitch & Warp tool, 
point at the top right corner and 
drag upwards.
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If you want to change the pitch modulation only for the 
segment start or end, you can set an “anchor point” to 
specify which part of the segment is affected. Proceed as 
follows:

1. Move the mouse pointer over the top border of the 
segment.
The mouse pointer becomes an I-beam symbol.

2. Click at the position where you want to set an anchor.
A vertical line appears at the position where you clicked. A segment can 
only have one anchor.

3. Move the mouse pointer over the top left/right corner 
of the segment and drag upwards or downwards to tilt the 
micro-pitch curve.
The modulation curve is only changed from the segment border to the 
anchor.

• If you press [Alt]/[Option] while dragging up/down, the 
tilt anchor is used as an axis around which the micro-pitch 
curve can be rotated.

4. Repeat the steps above to set anchors and tilt the mi-
cro-pitch curve until you are satisfied with the result.

• If you want to remove a tilt anchor from a segment, hold 
down [Alt]/[Option], position the mouse pointer at the top 
border of the segment until it turns to a glue tube, and click.
The tilt anchor is deleted.

Straighten Pitch

If you want to compensate for the rise and fall of notes, i. e. 
the deviation of the micro-pitch curve from the representa-
tive pitch, you can use the Straighten Pitch slider. This cor-
rection comes in handy when a note is played flat (pitch 
rises) or sharp (the pitch falls) at the end. Proceed as fol-
lows:

1. Select the segments whose pitch you want to 
straighten.

2. Move the Straighten Pitch slider to the right.
The pitch of the selected segments is straightened. 

MIDI Input

You can change the pitch on the fly by selecting the seg-
ment you want to change and pressing a key on your MIDI 
keyboard or using the Virtual Keyboard (Nuendo Expan-
sion Kit only – see “The Virtual Keyboard (Nuendo Expan-
sion Kit only)” on page 89). 

Move the mouse over the top 
border and click to set an 
anchor…

…if you only want to compensate 
for the descending pitch at the end 
of the segment. 

If you set a tilt anchor…

…to indicate that you can rotate the 
micro-pitch curve.

…and press [Alt]/[Option], the mouse 
pointer becomes a diagonal arrow…

This micro-pitch looks a bit off. By moving the Straighten Pitch slider 
to the right…

…the micro-pitch curve is straightened. 
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Proceed as follows:

1. After having corrected the segmentation, select the 
segment for which you would like to change the pitch.

2. Activate the Pitch & Warp tool and click the MIDI Input 
button.

3. Press a key on your MIDI keyboard or use the Virtual 
Keyboard (Nuendo Expansion Kit only) to change the 
pitch of the segment.
The pitch of the segment changes according to the note you play. 

The MIDI Input function has two modes: Still mode and 
Step mode. You can switch between them by [Alt]/[Op-
tion]-clicking on the MIDI Input button:

• In Still mode you can select individual segments by click-
ing on them and change their pitch by pressing a MIDI key. 
You can also select several segments and press a MIDI key 
to change the pitch of several segments simultaneously. 
The pitch of the first selected segment is changed to the 
pitch of the MIDI note you play. The pitches of the other se-
lected segment are changed by the same amount.

• In Step mode you can step through the segments by 
selecting the first segment that you would like to change 
and pressing a MIDI key. The next segment will automati-
cally be selected afterwards. This allows you to work in a 
more creative way, for example, to develop completely 
new melody lines via MIDI.

4. When you are done, deactivate the MIDI Input button.

MIDI controller data like pitchbend or modulation are 
ignored.

Warping segments

Time correction, i. e. warping at segment level, is useful if 
you want to align a musical accent to a certain position, or 
change or quantize the timing of single segments in mono-
phonic vocal recordings. When warping audio segments, 
warp tabs will be created. These are shown on the VariAu-
dio and the AudioWarp tabs of the Sample Editor Inspec-
tor. (For information on warping complete audio files, see 
“Free Warp” on page 297.)

To warp a segment, proceed as follows:

1. On the VariAudio tab activate the Pitch & Warp tool.

2. To change the timing of a segment, move the mouse 
pointer over the start/end of the segment.
The mouse pointer becomes a double arrow and the warp tabs are dis-
played in the ruler.

3. Drag the start/end of the segment to the desired posi-
tion. 
If the Snap button is activated, the segment border will snap to the grid. 
When you drag the segment border, warp tabs are shown not only at the 
border but also at the adjacent segment borders to indicate which por-
tions of the audio are stretched/affected.

Warping a segment will also change the timing of the 
adjacent segments. 

Still mode is activated for MIDI Input. 

Step mode is activated for MIDI Input. 

! Any correction of the segmentation must be applied 
before warping segments.
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Timing modifications introduced this way will not 
adapt to the project tempo. If this is what you want, use 
Musical Mode (see “AudioWarp: Tempo matching audio” 
on page 293). 

• You can change the insert position of a warp tab in the 
audio by clicking and dragging the warp tab handle in the 
ruler. This will change the warping (see “Editing Warp 
tabs” on page 310).

• Hold down [Shift] (by default) to delete warp tabs. To 
delete a warp tab, hold down the tool modifier so that the 
pointer becomes an eraser and click on the warp handle. 

• If you are not satisfied with your changes, you can revert 
the timing of the selected segments by choosing the 
“Warp Changes” option from the Reset pop-up menu 
(see “Reset” on page 311). 

Editing Warp tabs 

In some cases the beginning of the waveform does not cor-
respond to the beginning of a segment, e. g. when the audio 
starts with non-tonal portions like breath sounds (see “Un-
derstanding the waveform display in VariAudio” on page 
302). But when it comes to warping, any changes you wish 
to make must affect the waveform as a whole.

You can of course change the segmentation to achieve 
this, but if you want to pitch your audio afterwards, this 
would affect also any non-tonal portions of the audio. If 
this is not what you want, proceed as follows:

1. Activate the Pitch & Warp tool and activate the Snap 
button.

In this example the beginning of the segment does not correspond to 
the beginning of the waveform.

2. Move the mouse pointer over the start of the segment 
so that it becomes a double arrow and drag the segment 
start to the beginning of the bar. 
The segment border snaps to the grid at the exact bar position.

Now the beginning of the segment matches the beginning 
of the bar, but we want the beginning of the waveform to 
match the beginning of the bar:

3. Point at the warp handle displayed in the ruler so that 
it turns into a double arrow and drag it to the beginning of 
the waveform.
The background is displayed in orange to indicate which part of the 
waveform is affected by the change.
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Now the beginning of the waveform matches the desired 
bar position.

Editing warp tabs can also be useful if you change the 
length of a segment that you have already warped. In this 
case, editing warp tabs can help you synchronize your au-
dio again.

Reset
This pop-up menu at the bottom of the VariAudio tab allows 
you to reset the modifications you performed with the Pitch 
& Warp tool. It also lets you reset the changes you made in 
Segments mode by reanalyzing the audio and returning to 
the original segmentation. The following options are avail-
able:

You can set up key commands for the reset and the re-
analyze function in the Sample Editor category of the Key 
commands dialog (see “Key commands” on page 580). 

Listening to your modifications
You can listen to the results of your modifications using 
the following methods:

• By activating Acoustic Feedback on the toolbar.
The segments are played back so that you can easily audition your pitch 
modifications while editing. 

• By using the Play tool on the toolbar.

• By using the Audition and the Audition Loop tool on the 
toolbar.

• By using cycle playback in the Project window.

If you want to compare the original to the modified audio 
(i. e. hear the audio without pitch or warp modifications), 
you have the following possibilities: 

• You can disable your pitch modifications by clicking the 
Disable Pitch Changes button on the VariAudio tab or by 
setting up and using the “VariAudio - Disable Pitch 
Changes” key command in the Key Commands dialog, 
Sample Editor category (see “Key commands” on page 
580).

• You can disable your warp modifications by clicking the 
Disable Warp Changes button on the AudioWarp tab or 
by setting up and using the “VariAudio – Disable Warp 
Changes” key command in the Key Commands dialog, 
Sample Editor category (see “Key commands” on page 
580).

Functions – Extract MIDI…
This function extracts a MIDI part from your audio. This is 
useful, if you have an audio event with a voice you like and 
you want to create an identical second voice with a MIDI 
instrument. The extracted MIDI part can then be used to 
print out notes from within the Score Editor (Nuendo Ex-
pansion Kit only) or to export it as a MIDI file (see “Export-
ing and importing standard MIDI files” on page 560). 

Before extracting MIDI from your audio you should 
correct the segmentation. Otherwise, you will have to cor-
rect segmentation errors later in the MIDI part. Transition 
changes, tilting the micro-pitch curve, Quantize Pitch, and 
pitch corrections will also be taken into account. 

The result depends on the quality and the characteristics 
of your audio.

Function Description

Pitch Changes If you select this option, pitch changes including micro-
pitch modifications with the Tilt Micro Pitches tool are re-
set either for the selected segments (if available) or for 
the whole file.

Warp 
Changes

If you select this option, warp changes are reset.

Pitch + Warp 
Changes

If you select this option, pitch, micro-pitch, and warp 
changes are reset either for the selected segments (if 
available) or for the whole file.

Reanalyze  
Audio

If you select this option, the audio is reanalyzed and all 
your segmentation changes are reset.
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Proceed as follows:

1. Open the VariAudio tab.

2. Open the Functions pop-up menu and select “Extract 
MIDI…”.
The “Extract MIDI” dialog opens.

3. Select an extraction mode in the corresponding pop-
up menu to include or exclude pitchbend events.

Pitchbend events are MIDI controller data that is saved in 
a MIDI file and that creates pitch transitions between MIDI 
notes. The following options are available:

4. Open the Destination pop-up menu and select an op-
tion to decide where the MIDI part will be placed.
The following options are available: 

If you have opened the Sample Editor from the Pool 
and the audio file does not form part of your project, the 
MIDI part will be inserted at the Project start position.

5. Click OK.
A MIDI part is created.

If your audio event references only a section of the au-
dio clip, only this range will be extracted.

You can also use a key command to extract your audio as 
MIDI. In this case no dialog opens and the settings that 
were used for the previous extraction are used instead. 
For further information on how to set up key commands, 
please refer to the chapter “Key commands” on page 580.

Flattening realtime processing
You can “flatten” realtime processing at any time. This can 
be done to serve two purposes: to reduce the CPU load 
and to optimize the sound quality of the processing. The 
flatten function takes the following into account:

• Warp modifications (see “Free Warp” on page 297 and 
“Warping segments” on page 309), even when Bypass is ac-
tivated. After the flattening, your Warp tabs will be lost. How-
ever, you can undo this function as usual.

• VariAudio pitch modifications (see “Changing the pitch” on 
page 306), even when Bypass is activated. In this case, the 
Realtime algorithm (Solo preset) will be used. After the flatten-
ing, your VariAudio data will be lost. However, you can undo 
this operation.

• Event transpose (see “Transposing individual parts or events 
using the info line” on page 133).

• Select the audio event(s) that you want to process and 
select “Flatten” from the Realtime Processing submenu of 
the Audio menu.
Also use this function before applying any offline processing. When the 
flatten processing is applied, a copy of the original file is automatically 
created in the Pool so that the original audio clip remains intact.

Selecting an algorithm for the flattening

When you flatten the realtime processing, you can use the 
MPEX 4 algorithm to process the audio, which may pro-
duce better sound quality than the realtime processing. 
Apart from offline processing, this is the only way to 
achieve polyphonic formant conserving pitch shifting.

Option Description

Just Notes and 
no Pitchbend 
Data

If you select this option, only notes will be included in the 
MIDI part.

Notes and 
Static Pitch-
bend Data

If you select this option, a pitchbend event will be created 
for every segment. Select a pitchbend value from 1 to 24 
in the Pitchbend Range field. When you are working with 
an external MIDI controller, it might be necessary to set it 
to the same value.

Notes and 
Continuous 
Pitchbend 
Data

If you select this option, pitchbend events that correspond 
to the micro-pitch curve will be created. Select a pitch-
bend value from 1 to 24 in the Pitchbend Range field. The 
setting should correspond to the same value on your MIDI 
controller or the VST instrument being controlled. 
Note that although the graphic representation of the pitch-
bend curve is smoothed, all pitchbend data is included.

Option Description

First Selected 
Track

If you select this option, the MIDI part will be placed on 
the first selected MIDI or instrument track. Note that any 
MIDI parts from previous extractions that are on this track 
will be deleted. 

New MIDI 
Track

If you select this option, a new MIDI track will be created 
for the MIDI part.

Project Clip-
board

If you select this option, the MIDI part is copied to the 
clipboard so that you can insert it at the desired position 
on a MIDI or instrument track in the Project window.
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Proceed as follows:

1. Select the audio event(s) you wish to process.

2. Select “Flatten” from the Realtime Processing sub-
menu of the Audio menu or use the corresponding button 
on the Process tab.
If you did not perform any pitch modifications, a dialog opens where you 
can select an algorithm for the processing. You can either select the 
MPEX 4 algorithm, which will produce the highest sound quality, or the 
Realtime algorithm which is much quicker but will not improve the audio 
quality of the processing (although it will reduce the CPU load).

This dialog will not open when the time stretching fac-
tor is outside the range of 0.5 and 2 or when you intro-
duced VariAudio pitch modifications. In these cases the 
Realtime algorithm will be used.

For the MPEX 4 algorithm the following quality settings 
are available:

The Realtime presets can be selected from the Algorithm 
pop-up on the Sample Editor toolbar, see “Selecting an 
algorithm for realtime playback” on page 296. 

3. Select an algorithm preset and click OK.
After the processing, any loop that was previously stretched in realtime 
or had been pitch shifted will play back exactly the same, but Musical 
Mode will be deactivated and the realtime pitch shifting will be set to 0.

The audio clip is now like any standard audio clip before 
applying realtime processing, i. e. it does not follow tempo 
changes. The flattening processing function is best used 
when you have determined the tempo or key of a project, 
but you can of course always adapt the audio to a new key 
or tempo. In this case, it is better to revert to the original 
audio clip rather than to process the already processed 
file again.

Unstretching audio files

By selecting “Unstretch Audio” from the Realtime Pro-
cessing submenu of the Audio menu, all realtime time 
stretching (by sizing or by warp tabs) is removed.

Note that realtime transpose (in the info line) and Musi-
cal Mode will not be removed by this.

Whether the “Unstretch Audio” menu item is available de-
pends on whether the time stretching has been applied at 
event or clip level: 

• If you have sized an audio event in the Project window 
using “Sizing Applies Time Stretch” (see “Resizing events 
using time stretch” on page 73), you can undo the time 
stretching by selecting the event in the Project window 
and then applying “Unstretch Audio”.
This removes all time stretching and warp tabs.

• When you have entered a tempo and/or length on the 
toolbar, this information is saved for the source clip.
These changes cannot be undone using “Unstretch Audio”.

Option Description

Preview Use this mode only for preview purposes.

Mix Fast This mode is a very fast mode for preview. This works best 
with composite music signals (mono or stereo material).

Solo Fast Use this mode for single instruments (monophonic mate-
rial) and voice.

Solo Musical Same as above but higher quality.

Poly Fast Use this for processing monophonic and polyphonic ma-
terial. This is the fastest setting that gives still very good 
results. You can use this for drum loops, mixes, chords.

Poly Musical Use this for processing monophonic and polyphonic ma-
terial. This is the recommended MPEX default quality set-
ting. You can use this for drum loops, mixes, chords.

Poly Complex This high quality setting is quite processor intense and 
should be used only when processing difficult material or 
for stretch factors above 1.3.
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Background
The Audio Part Editor allows you to view and edit the events 
inside audio parts. Essentially, this is the same type of edit-
ing that you do in the Project window, which means that 
this chapter contains a lot of references to the chapter 
“Working with projects” on page 51.

Audio parts are created in the Project window in one of 
the following ways:

• By selecting one or several audio events on the same 
track, and selecting “Events to Part” from the Audio menu.

• By gluing together two or more audio events on the 
same track with the Glue Tube tool.

• By drawing an empty part with the Pencil tool.

• By double-clicking between the left and right locators 
on an audio track.
With the last two methods, an empty part is created. You can then add 
events to the part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor
You open the Audio Part Editor by selecting one or more 
audio part(s) in the Project window and double-clicking 
on any one of them (or using the Edit-Open key command, 
by default [Ctrl]/[Command]-[E]). The Audio Part Editor 
can display several parts at once, and you can also have 
more than one Audio Part Editor open at the same time.

Double-clicking on an audio event in the Project 
window will open the Sample Editor (see “Opening the 
Sample Editor” on page 284).

Window overview

The toolbar
The tools, settings, and icons on the toolbar have the 
same functionality as in the Project window, with the fol-
lowing differences:

• A Solo button (see “Auditioning” on page 317).
• Separate tools for auditioning (Speaker) and scrubbing  

(see “Scrubbing” on page 317).
• No Line, Glue Tube or Color tools.
• Play and Loop icons and an Audition Volume control  

(see “Auditioning” on page 317).
• Independent Track Loop settings (see “The independent track 

loop function” on page 317).
• Part List controls for handling several parts: activating parts 

for editing, restricting editing to active parts only and showing 
part borders (see “Handling several parts” on page 318).

You can customize the toolbar by hiding or reordering 
its items, see “Using the Setup options” on page 572.

The ruler and info line
These have the same functionality and appearance as 
their counterparts in the Project window.

• You can select a separate display format for the Audio 
Part Editor ruler by clicking on the arrow button on the 
right and selecting an option from the pop-up menu.
For a list of the available formats, see “The ruler” on page 47.
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About lanes
If you make the editor window larger, this will reveal addi-
tional space below the edited events. This is because an 
audio part is divided vertically in lanes. 

Lanes can make it easier to work with several audio events 
in a part. Moving some of the events to another lane can 
make selection and editing much easier.

• To move an event to another lane without accidentally 
moving it horizontally, press [Ctrl]/[Command] and drag it 
up or down.

Overlapping events

Only one event per track can be played back at the same 
time! This means that if you have overlapping events (on 
the same lane or different lanes) these will cut each other 
off, according to the following rules:

• For events on the same lane, the ones that are on top 
(visible) will be played.
To move overlapping events to the front or back, use the Move to Front 
and Move to Back functions on the Edit menu.

• For events on different lanes, the event on the lowest 
lane gets playback priority.

The overlapping sections of the upper event will not be played because 
the event on the lower lane has playback priority!

Imagine the following situation: You have two overlapping 
audio events, with the top event audible during playback. 
What happens when you mute the audible event?

• By default, you will not hear the overlapped event when 
muting an event that has playback priority over another 
event.
This default behavior ensures that you do not suddenly hear audio events 
that previously were not part of your mix.

• In the Preferences dialog (Editing–Audio page) you will 
find the “Treat Muted Audio Events like Deleted” option. 
When you activate this option, any events overlapped by a 
muted event will become audible.

Operations

• Note that if a part is a shared copy (i. e. you have previ-
ously copied the part by [Alt]/[Option]-[Shift] and drag-
ging), any editing you perform will affect all shared copies 
of this part.
To indicate that it is a shared copy, a symbol is displayed in the part in 
the Project window (see “Aligning events” on page 69).

! Zooming, selecting and editing in the Audio Part Ed-
itor are done just as in the Project window (see the 
chapter “Working with projects” on page 51).
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Auditioning
There are several ways to listen to the events in the Audio 
Part Editor:

By using the Speaker tool

If you click somewhere in the editor’s event display with the 
Speaker tool and keep the mouse button pressed, the part 
will be played back from the position where you clicked. 
Playback will continue until you release the mouse button.

By using the Audition icon

The Audition and Audition Loop icons

Clicking the Audition icon on the toolbar plays back the 
edited audio, according to the following rules:

• If you have selected events in the part, only the section bet-
ween the first and last selected event will be played back.

• If you have made a range selection, only this section will be 
played back.

• If there is no selection, the whole part will be played back. If 
the project cursor is within the part, playback starts from the 
current cursor position. If the cursor is outside the part, play-
back starts from the beginning of the part.

• If the Audition Loop icon is activated, playback will continue 
until you deactivate the Audition icon. Otherwise, the section 
will be played back once.

• When auditioning with the Speaker tool or Audition 
icon, audio will be routed directly to the Control Room or 
to the Main Mix (the default output bus) if the Control 
Room is disabled. 

By using regular playback

You can of course use the regular playback controls while 
in the Audio Part Editor. Furthermore, if you activate the 
Solo Editor button on the toolbar, only the events in the 
edited part will be played back.

Using key commands

If you activate the “Playback Toggle triggers Local Pre-
view” option in the Preferences dialog (Transport page), 
you can start/stop auditioning by pressing [Space]. This is 
the same as clicking the Audition icon on the toolbar.

The Audio Part Editor also supports the key com-
mands “Preview start” and “Preview stop” in the Media 
category of the Key Commands dialog. These key com-
mands stop the current playback, no matter if you are in 
normal playback or in audition mode.

The independent track loop function
The independent track loop is a sort of “mini-cycle”, affect-
ing only the edited part. When the loop is activated, the 
events in the parts that are within the loop will be repeated 
continuously and completely independent – other events 
(on other tracks) are played back as usual. The only “inter-
action” between the loop and the “regular playback” is that 
the loop starts every time the cycle starts over again.

To set up the independent track loop, proceed as follows:

1. Turn on the loop by clicking the Independent Track 
Loop button on the toolbar.
If it is not visible, right-click the toolbar and add the Independent Track 
Loop Settings section – see “Using the Setup options” on page 572.

When the loop is activated, the cycle is not shown in the 
editor’s ruler. Now you need to specify the length of the 
loop:

2. [Ctrl]/[Command]-click in the ruler to set the start and 
[Alt]/[Option]-click to set the end of the loop.
You can also edit the loop start and end positions numerically in the 
fields next to the Loop button.

The loop is indicated in purple in the ruler.

The events will be looped as long as the Loop button 
is activated and the Audio Part Editor window is open.

Scrubbing
In the Audio Part Editor, the Scrub tool has a separate 
icon on the toolbar. Apart from that, scrubbing works ex-
actly as in the Project window (see “Scrubbing audio” on 
page 67).
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Handling several parts
When you open the Audio Part Editor with several parts se-
lected – all on the same track or on different tracks – they 
might not all “fit” in the editor window, which can make it 
hard to get an overview of the different parts when editing.

Therefore, the toolbar features a few functions to make 
working with multiple parts easier and more comprehen-
sive:

• The Part List menu lists all parts that were selected 
when you opened the editor, and lets you select which 
part is active for editing.
When you select a part from the list, it is automatically made active and 
centered in the display.

Note that it is also possible to activate a part by click-
ing on it with the Arrow tool.

• The button “Edit Active Part Only” lets you restrict edit-
ing operations to the active part only.
If you for example select “All” from the Select submenu of the Edit menu 
with this option activated, all events in the active part will be selected but 
not the events in other parts.

“Edit Active Part Only” activated on the toolbar

• You can zoom in on an active part so that it fills the 
screen by selecting “Zoom to Event” from the Zoom sub-
menu of the Edit menu.

• The button “Show Part Borders” can be used if you 
want to see clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, 
making the borders easily discernible. There are also two “markers” in 
the ruler with the name of the active part, marking its beginning and end. 
These can be moved freely to change the part borders.

“Show Part Borders” activated on the toolbar

• It is possible to cycle between parts, making them ac-
tive using key commands.
In the Key Commands dialog – Edit category, there are two functions: 
“Activate Next Part” and “Activate Previous Part”. If you assign key com-
mands to these, you can use them to cycle between parts. See “Setting 
up key commands” on page 581 for instructions on how to set up key 
commands.

Common methods

Assembling a “perfect take”
When you record audio in Cycle mode, either an event or 
a region (or both) is created for each recorded lap (see 
“Recording audio in cycle mode” on page 99). These 
events and regions are named “Take X”, where “X” is the 
number of the take. You can create a perfect take by put-
ting together sections of the different takes in the Audio 
Part Editor.

The procedure below will not work if you recorded 
with “Keep Last” mode selected on the Transport panel. In 
that case, only the last take will be kept on the track (al-
though the previous takes will be available as regions in 
the Pool).

First, you have to create an audio part from the takes. This 
procedure is slightly different depending on whether you 
choose to create events or regions.

Creating an audio part from events

1. In the Project window, use the Object Selection tool 
to draw a rectangle around the recorded events.
This is necessary, since clicking on the event may just select the event on 
top (the last take). If in doubt, check the info line – the info text must be 
shown in color.

2. Pull down the Audio menu and select “Events to Part”.
The events are converted to an audio part.

• Note that the events cycle record mode also makes it 
easy to combine different takes in the Project window – 
see “Create Events mode (Preferences)” on page 99.
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Creating an audio part from regions

1. In the Project window, select the event you recorded 
in Cycle mode.
After recording, this will play the last take.

2. Pull down the Audio menu and select “Events to Part”.
You are asked whether you want to “Create part using regions”.

3. Click “Regions”.
The regions are converted to an audio part.

Assembling a take

1. Double-click the part to open the Audio Part Editor.
Now, the different takes will be placed on different lanes, with the last 
take at the bottom.

2. Use the tools to cut out pieces of the takes and as-
semble the final result.
This can include splitting with the Scissors tool, resizing events with the 
Arrow tool or deleting with the Erase tool. 

• Remember that the events on the lowest lane have play-
back priority. 
Use the Audition icon to audition the result.

3. Close the Audio Part Editor.
You have now assembled a “perfect take”!

Options and Settings
The following options and settings are available in the 
Audio Part Editor:

• Snap
The Snap functionality in the Audio Part Editor is exactly the same as in 
the Project window, see “The Snap function” on page 48.

• Auto-Scroll
When Auto-Scroll is activated on the toolbar, the window will scroll dur-
ing playback, keeping the project cursor visible in the editor. This setting 
can be activated or deactivated individually for each window.

• Snap to Zero Crossing
When this option is activated, all audio edits are done at zero crossings 
(positions in the audio where the amplitude is zero). This helps you avoid 
pops and clicks which might otherwise be caused by sudden amplitude 
changes. 
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Background
Every time you record on an audio track, a file is created 
on your hard disk. A reference to this file – a clip – is also 
added to the Pool. Two general rules apply to the Pool:

• All audio and video clips that belong to a project are 
listed in the Pool.

• There is a separate Pool for every project.

The way the Pool displays folders and their contents is 
similar to the way the Mac OS X Finder and the Windows 
Explorer display folders and lists of files.

In the Pool you can, among other things, perform the fol-
lowing operations:

Operations that affect files on disk

• Importing clips (audio files can automatically be copied and/or 
converted)

• Converting file formats
• Renaming clips (this will also rename the referenced files on 

disk) and regions
• Deleting clips
• Preparing file archives for backup
• Minimizing files

Operations that only affect clips

• Copying clips
• Auditioning clips
• Organizing clips
• Applying audio processing to clips
• Saving or importing complete Pool files

Opening the Pool
You can open the Pool in any of the following ways:

• By clicking the “Open Pool Window” button on the 
Project window toolbar.
If this icon is not visible, you need to activate the “Media & Mixer Windows” 
option on the toolbar context menu first.

• By selecting “Pool” on the Project menu or “Open Pool 
Window” on the Media menu.

• By using a key command – by default [Ctrl]/[Command]-
[P].

The content of the Pool is divided into the following main 
folders: 

• The Audio folder
This contains all audio clips and regions currently in the project.

• The Clip Packages folder
This contains all imported or created clip packages.

• The Video folder
This contains all video clips currently in the project.

• The Trash folder 
Unused clips can be moved into the Trash folder for later permanent re-
moval from the hard disk.

These folders cannot be renamed or deleted from the 
Pool, but any number of subfolders can be added (see 
“Organizing clips and folders” on page 331).
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Window overview

Toolbar overview

The info line
Click the “Show Info” button on the toolbar to show or 
hide the info line at the bottom of the Pool window. It 
shows the following information:

• Audio Files – the number of audio files in the Pool
• Used – the number of audio files in use
• Total size – the total size of all audio files in the Pool
• External Files – the number of files in the Pool that do not re-

side in the project folder (e. g. video files)

The Pool window columns
Various information about the clips and regions can be 
viewed in the Pool window columns. The columns contain 
the following information:

About the Status column symbols

The Status column can display various symbols that relate 
to the clips status. The following symbols can be shown:

Column Description

Media This column contains the Audio, Video and Trash folders. 
If the folders are opened, the clip or region names are 
shown and can be edited. This column is always shown.

Used This column displays the number of times a clip is used in 
the project. If there is no entry in this column, the corre-
sponding clip is not used.

Audio folder: contains clips and regions

Clip Packages 
folder

Waveform image

Toolbar

Video 
folder

Trash 
folder

Open/Close all 
folders

View/Attributes 
pop-up menu

Show Info 
button

Project Folder 
path

Pool Record 
Folder path

Audition, Audition Loop, 
and Volume

Import and 
Search buttons

Status This column displays various icons that relate to the cur-
rent Pool and clip status. See “About the Status column 
symbols” on page 322 for a description of the icons.

Musical  
Mode

The checkbox in this column allows you to activate or de-
activate Musical Mode. If the Tempo column (see below) 
displays “???”, you have to enter the correct tempo be-
fore you can activate Musical Mode.

Tempo This shows the tempo of audio files, if available. If no 
tempo has been specified, the column displays “???”. 

Sign. This is the time signature, e. g. “4/4”.

Key This is the root key, if one was specified for the file.

Info This column shows the following information for audio 
clips: The sample rate, bit resolution, number of channels 
and the length in seconds. For regions, it displays start 
and end times in frames, and for video clips the frame 
rate, number of frames, and length in seconds.

Type This column shows the file format of the clip.

Date This column shows the date when the audio file was last 
changed.

Origin Time This column shows the original start position where a clip 
was recorded in the project. As this value can be used as 
a basis for the “Insert into Project” option in the Media or 
context menu (and other functions), you can change it if 
the Origin Time value is independent (i. e. not for regions). 
This can either be done by editing the value in the col-
umn, or by selecting the corresponding clip in the Pool, 
moving the project cursor to the new desired position 
and selecting “Update Origin” from the Audio menu.

Image This column displays waveform images of audio clips or 
regions. 

Path This column shows the path to the location of a clip on 
the hard disk.

Reel Name If you have imported an OMF file (see “Exporting and im-
porting OMF files” on page 556), it may include this at-
tribute, which is then shown in this column. The Reel 
Name describes the “physical” reel or tape from which 
the media was originally captured.

Symbol Description

This indicates the current Pool Record folder (see 
“Changing the Pool Record folder” on page 331).

This symbol is shown if a clip has been processed.

The question mark indicates that a clip is referenced in 
the project but missing from the Pool (see “About missing 
files” on page 328).

Column Description
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User Attributes

You can define your own attributes for elements in the 
Pool. This is handy when you have a large number of au-
dio files in the Pool. You can use the attributes to sort 
items in the Pool or merely keep track of some aspect of 
your project.

Simply select the “Define User Attributes” option from the 
View/Attributes pop-up menu and create as many new at-
tributes as you need. These attributes will then get their 
own columns in the Pool. Each attribute can be defined as 
checkbox, text field or number. You can then specify the 
user attributes for each file, thus categorizing them further. 
All user attributes you created are automatically available 
as search criteria in the Pool and can be added as sepa-
rate elements to the search pane (or replace the search 
criteria above the Location parameter, see above). This al-
lows for a very detailed search, helping you to master even 
the largest sound database.

Sorting the Pool contents

You can sort the clips in the Pool by name, date, etc. This 
is done by clicking on the corresponding column heading. 
Clicking again on the same heading switches between as-
cending and descending sort order.

Customizing the view

• You can specify which of the columns are shown or hid-
den by opening the View/Attributes pop-up menu on the 
toolbar and selecting/deselecting items.

• You can rearrange the order of the columns by clicking 
on a column heading and dragging the column to the left 
or right.
The mouse pointer changes to a hand when you place it on the column 
heading.

• The width of a column can also be adjusted by placing 
the pointer between two column headers and dragging 
left or right.
The pointer changes to a divider when you place it between two column 
headers.

This indicates that the clip file is external, i. e. located out-
side the current Audio folder for the project.

This indicates that the clip has been recorded in the cur-
rently open version of the project. This is useful for finding 
recently recorded clips quickly.

Symbol Description

The arrow indicates the sort 
column and sort order.
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Operations
Most of the Pool-related main menu functions are also 

available on the Pool context menu (opened by right-click-
ing in the Pool window).

Renaming clips or regions in the Pool
To rename a clip or a region in the Pool, select it and click 
on the existing name, type in a new name and press 
[Return].

This will also rename the referenced files on disk!

Renaming multiple clips or regions

You can also rename multiple clips or regions in the Pool 
using the “Rename…” command from the Edit menu.

1. Select one or more audio clips, video clips, or regions 
in the Pool. 
You can only select one type of object at a time.

2. From the Edit menu, select “Rename…”.
A dialog with several options for renaming objects automatically will open.

3. Set the parameters for renaming objects and press 
[Return].

Setting parameters of the Rename Object dialog

The Rename Object dialog provides a great deal of flexi-
bility and options when renaming multiple objects in Nu-
endo. In addition to simple prefix, suffix, and incremental 
numeric additions to names, you can remove certain char-
acters, include timestamp information and more.

Each of the eight fields found in the left section of the Re-
name Objects dialog can be used to add an element to 
the name generated for each object. 

The first line will create text or numbers at the left of the 
new name. The eighth and last line will create text or num-
bers at the very right of the new name.

Each of the eight lines can add one of the following ele-
ments including a prefix and suffix for each item (You can 
use a prefix to create a space separating items in the gen-
erated name.):

! Renaming a clip in the Pool is much preferred to re-
naming it outside Nuendo (for example on the com-
puter desktop). This way, Nuendo already “knows” 
about the change, and will not lose track of the clip 
the next time you open the project. See “About miss-
ing files” on page 328 for details about lost files.

Option Description

Free Text Any text you would like to include in the name.

Original Name The original name given to the object. There are options 
to remove all numbers or non-alpha numerics or just the 
ones on the left or right sides.

Number An increasing or decreasing number starting with a mini-
mum amount of digits and a starting number (i. e. 001, 
002 etc.).

Project Time The current location of the clip in the project window us-
ing any of the seven ruler formats (Bars+Beats, Time-
code, etc.).

Date The date that the file was created in several formats.

File Extension The file type.

Audio Bitsize The bit depth of the audio file.
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An example of the result is displayed in the bottom of the 
window for reference. All of these parameters can be 
saved as a preset as well.

Duplicating clips in the Pool
To duplicate a clip, proceed as follows:

1. Select the clip you wish to copy.

2. Select “New Version” on the Media menu.
A new version of the clip appears in the same Pool folder, with the same 
name but with a “version number” after it, to indicate that the new clip is 
a duplicate. The first copy made of a clip will get the version number “2” 
and so on. Regions within a clip are copied too, but keep their name. 

Inserting clips into a project
To insert a clip into a project, you can either use the Insert 
commands on the Media menu or use drag and drop.

Using menu commands

Proceed as follows:

1. Select the clip(s) you want to insert into the project.

2. Pull down the Media menu and select an “Insert into 
Project” option.
“At Cursor” will insert the clip(s) at the current project cursor position.  
“At Origin” will insert the clip(s) at their Origin Time position(s).

• Note that the clip will be positioned so that its snap 
point is aligned with the selected insert position.
You can also open the Sample Editor for a clip by double-clicking it, and 
perform the insert operation from there. This way you can set the snap 
point before inserting a clip.

3. The clip is inserted on the selected track or on a new 
audio track.
If several tracks are selected, the clip will be inserted on the first selected 
track.

Using drag and drop

When using drag and drop to insert clips into the Project 
window, please note the following:

• Snap is taken into account if activated.

• While you drag the clip in the Project window, its posi-
tion is indicated by a marker line and a numerical position 
box.
Note that these indicate the position of the snap point in the clip. For ex-
ample, if you drop the clip at the position 10.00, this will be where the 
snap point ends up. See “Adjusting the snap point” on page 288 for in-
formation on how to set the snap point.

• If you position the clip in an empty area in the event dis-
play (i. e. below existing tracks), a new track is created for 
the inserted event.

Deleting clips

Removing clips from the Pool

To remove a clip from the Pool without deleting it from the 
hard disk, proceed as follows:

1. Select the clip(s) and select “Delete” from the Edit 
menu (or press [Backspace] or [Delete]).
A prompt asks whether you want to move the clip to the Trash or remove 
it from the Pool.

• If you try to delete a clip that is used by one or more 
events, the program will ask you whether to remove these 
events from the project.
If you cancel, neither the clip nor the associated events are deleted.

2. In the window that opens, select “Remove from Pool”.
The clip is no longer associated with the project, but still exists on the hard 
disk and can be used in other projects, etc. This operation can be undone.

Sample rate The sample rate of the audio file.

Audio Tempo The audio tempo for that clip if it has been assigned.

User Attribute Any one of the custom attributes created in the Setup User 
Attributes dialog (see “User Attributes” on page 323).

! Duplicating a clip does not create a new file on disk, 
but a new edit version of the clip (referring to the 
same audio file).

Option Description

Snap point
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Deleting from the hard disk

To delete a file permanently from the hard disk, it must first 
be moved to the Trash folder:

1. Follow the instructions for deleting clips above, but 
click the Trash button instead of the Remove from Pool 
button.
Alternatively, you can drag and drop clips into the Trash folder.

2. On the Media menu, select “Empty Trash”.
A warning message is displayed.

3. Click “Erase” to delete the file on the hard disk perma-
nently.
This operation cannot be undone!

To retrieve a clip or region from the Trash folder, drag 
it back into an Audio or Video folder.

Removing unused clips

This function finds all clips in the Pool that are not used in 
the project. You can then decide whether to move them to 
the Trash folder (from where they can be permanently de-
leted) or to remove them from the Pool:

1. Select “Remove Unused Media” on the Media or con-
text menu.
A message appears asking you whether you want to move the file to the 
Trash or to remove it from the Pool.

2. Make your selection.

Removing regions

To remove a region from the Pool, select it and select “De-
lete” from the Edit menu (or press [Backspace] or [Delete]). 

For regions there is no alert if the region is used in the 
project!

Locating events and clips

Locating events via clips in the Pool

If you want to find out which events in the project refer to a 
particular clip in the Pool, proceed as follows:

1. Select one or more clips in the Pool.

2. Select “Select in Project” on the Media menu.
All events that refer to the selected clip(s) are now selected in the 
Project window.

Locating clips via events in the Project window

If you want to find out which clip belongs to a particular 
event in the Project window, proceed as follows:

1. Select one or more events in the Project window.

2. Pull down the Audio menu and select “Find Selected 
in Pool”.
The corresponding clip(s) are located and highlighted in the Pool.

Searching for audio files
The search functions can help you locate audio files in the 
Pool, on your hard disk or on other media. This works much 
like the regular file search, but with a couple of extra fea-
tures:

1. Click the Search button on the toolbar.
A search pane appears at the bottom of the window, displaying the 
search functions.

By default, the search parameters available in the search 
pane are “Name” and “Location”. For using other filter cri-
teria, see “Extended Search functionality” on page 327.

2. Specify the name of the file(s) to search for in the 
Name field.
You can use partial names or wildcards (*). Note that only audio files of 
the supported formats will be found.

3. Use the Location pop-up menu to specify where to 
search.
The pop-up menu will list all your local drives and removable media. 

! Before you permanently delete audio files from the 
hard disk, make sure that they are not used by an-
other project!
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• If you want to limit the search to certain folders, choose 
“Select Search Path” and select the desired folder in the 
dialog that opens.
The search will include the selected folder and all subfolders. Note also 
that folders you have recently selected using the “Select Search Path” 
function will appear on the pop-up menu, allowing you to quickly select 
them again.

4. Click the Search button.
The search is started and the Search button is labeled Stop – click this 
to cancel the search if needed.

When the search is finished, the files found are listed to 
the right.

• To audition a file, select it in the list and use the play-
back controls to the left (Play, Stop, Pause, and Loop).
If Auto Play is activated, selected files are automatically played back.

• To import a file into the Pool, double-click on it in the list 
or select it and click the Import button.

5. To close the search pane, click the Search button on 
the toolbar again.

Extended Search functionality

Apart from the search criterion Name, additional search fil-
ters and user attributes are available. The Extended Search 
options allows for a very detailed search, helping you to 
master even the largest sound database.

To use them, proceed as follows:

1. Set up a couple of user attributes using the “View/
Attributes” pop-up menu.

2. Click the Search button on the toolbar.
The Search pane is displayed in the lower part of the Pool window.

3. Move the mouse pointer over the “Name” text to the 
right of the name field and click on the arrow that appears.

4. The extended search pop-up menu opens.
It contains six options determining which search criterion is displayed 
above the Location field (Name, Size, Bitsize, Channels, Sample Rate or 
Date). It also contains all the user attributes you specified, as well as the 
Add Filter and Presets submenus.

The search criteria have the following parameters:

• Name: partial names or wildcards (*)
• Size: Less than, More than, Equal, Between (two values), in 

seconds, minutes, hours and bytes
• Bitsize (resolution): 8, 16, 24, 32
• Channels: Mono, Stereo and from 3 to 16
• Sample Rate: various values, choose “Other” for free setting
• Date: various search ranges

5. Select one of the search criteria in the pop-up menu to 
change the search option above the Location pop-up 
menu.

6. If you want to display more search options, select the 
desired element from the “Add filter” submenu.
This allows you, for example, to add the Size or the Sample Rate parame-
ters to the already displayed Name and Location parameters.

Move the mouse pointer over 
the “Name” text to the right of 
the name field and click…

…to show the extended search pop-up menu.
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• You can save presets of your search filter settings. To 
do this, click Save Preset on the Presets submenu and 
enter a name for the preset.

Existing presets can be found at the bottom of the list. To remove a 
preset, click on the preset to activate it, then select Remove Preset.

The Find Media window

Alternatively to the search pane in the Pool, you can open a 
stand-alone Find Media window by selecting the “Search 
Media…” option from the Media or context menu (also 
available from the Project window). This offers the same 
functionality as the search pane. 

• To insert a clip or region directly into the project from 
the Find Media window, select it in the list and choose one 
of the “Insert into Project” options from the Media menu.
The options are described in the section “Inserting clips into a project” 
on page 325.

• It is also possible to further refine the search options by 
including your user attributes in the search criteria. 
When user attributes have been defined, these will appear on the pop-
up menu (see above).

About missing files
When you open a project, the Resolve Missing Files dia-
log (see below) may open, warning you that one or more 
files are “missing”. If you click Close, the project will open 
anyway, without the missing files. In the Pool, you can 
check which files are considered missing. This is indi-
cated by a question mark in the Status column.

A file is considered missing under one of the following 
conditions:

• The file has been moved or renamed outside the pro-
gram since the last time you worked with the project, and 
you ignored the Resolve Missing Files dialog when you 
opened the project for the current session.

• You have moved or renamed the file outside the pro-
gram during the current session.

• You have moved or renamed the folder in which the 
missing files are located.

Locate missing files

1. Select “Find Missing Files…” from the Media or con-
text menu.
The Resolve Missing Files dialog opens. 

2. Decide if you want the program to try to find the file for 
you (Search), if you want to do it yourself (Locate) or if you 
want to specify in which directory the program will search 
for the file (Folder).

• If you select Locate, a file dialog opens, allowing you to 
locate the file manually.
Select the file and click “Open”.

• If you select Folder, a dialog opens to let you specify the 
directory in which the missing file can be found.
This might be the preferred method if you have renamed or moved the 
folder containing the missing file, but the file still has the same name. Once 
you select the correct folder, the program finds the file and you can close 
the dialog.

• If you select Search, a dialog opens to let you specify 
which folder or disk will be scanned by the program. 
Click the Search Folder button, select a directory or a disk and click the 
Start button. If found, select the file from the list and click “Accept”. 
Afterwards Nuendo tries to map all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e. g. if you have acciden-
tally deleted it from the hard disk), it will normally be indi-
cated with a question mark in the Status column in the 
Pool. However, if the missing file is an edit file (a file cre-
ated when you process audio, stored in the Edits folder 
within the project folder), it may be possible for the pro-
gram to reconstruct it by recreating the editing to the orig-
inal audio file.
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Proceed as follows:

1. Open the Pool and locate the clip(s) for which files are 
missing.

2. Check the Status column – if it says “Reconstructible”, 
the file can be reconstructed by Nuendo.

3. Select the reconstructible clips and select “Recon-
struct” from the Media menu.
The editing is performed and the edit files are recreated.

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or re-
constructed, you may want to remove these. For this, select 
“Remove Missing Files” from the Media or context menu. 
This will remove all missing files from the Pool as well as the 
corresponding events from the Project window.

Auditioning clips in the Pool
There are three ways to audition clips in the Pool:

• By using key commands.
If you activate the “Playback Toggle triggers Local Preview” option in the 
Preferences dialog (Transport page), you can use [Space] to audition. 
This is the same as clicking the Audition icon on the toolbar.

• By selecting a clip and activating the Audition button.
The whole clip will play back, unless you stop playback by clicking the 
Audition button again.

• By clicking somewhere in the waveform image for a clip.
The clip will play from the position in the waveform you click until the end 
of the clip, unless you stop playback by clicking the Audition button, or 
by clicking anywhere else in the Pool window.

The audio is routed directly to the Control Room, if acti-
vated. When the Control Room is deactivated, the audio is 
routed to the Main Mix (the default output) bus, bypassing 
the audio channel’s settings, effects and EQs. 

You can adjust the auditioning level with the miniature 
level fader on the toolbar. This does not affect the regular 
playback level.

If you have activated the Audition Loop button before you 
audition, the following will happen:

• When you click the Audition button to audition a clip, 
the clip is repeated indefinitely until you stop playback by 
clicking the Audition or Audition Loop button again.

• When you click in the waveform image to audition, the 
section from the point you clicked to the end of the clip is 
repeated indefinitely until you stop playback.

Opening clips in the Sample Editor
The Sample Editor allows you to perform detailed editing 
on the clip (see “The Sample Editor” on page 282). You 
can open clips in the Sample Editor directly from the Pool 
in the following ways:

• If you double-click a clip waveform icon or a clip name 
in the Media column, the clip opens in the Sample Editor.

• If you double-click a region in the Pool, its clip opens in 
the Sample Editor with the region selected.

One practical use for this is to set a snap point for a clip 
(see “Adjusting the snap point” on page 288). When you 
later insert the clip from the Pool into the project, you can 
have it be properly aligned according to the set snap 
point.

About the Import Medium dialog
The Import Medium dialog lets you import files directly into 
the Pool. It is opened from the Media or context menu or 
using the Import button in the Pool window.

This is a standard file dialog, where you can navigate to 
other folders, audition files, etc. The following audio file 
formats can be imported:

• Wave (Normal or Broadcast, see “Broadcast Wave files” on 
page 479)

• AIFF and AIFC (Compressed AIFF)
• REX or REX 2 (see “Importing ReCycle files” on page 554)
• Dolby Digital AC3 file (ac3 – if you have the Steinberg Dolby 

Digital Encoder installed in your system)
• DTS file (dts – if you have the Steinberg DTS Encoder in-

stalled in your system)
• SD2 (Sound Designer II) 
• MPEG Layer 2 and Layer 3 (MP2 and MP3 files – see “Im-

porting compressed audio files” on page 555)
• Ogg Vorbis (OGG files – see “Importing compressed audio 

files” on page 555)
• Windows Media Audio (Windows – see “Importing com-

pressed audio files” on page 555)
• Wave 64 (W64 files)
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They may have the following characteristics:

• Stereo or mono
• Any sample rate (although files with another sample rate than 

the one used in the project will play back at the wrong speed 
and pitch – see below).

• 8, 16, 24 bit or 32 bit float resolution.

Various video formats can be imported. For information 
about the supported video formats, see “Video file com-
patibility” on page 521.

It is also possible to use the commands on the Import 
submenu of the File menu to import audio or video files 
into the Pool.

When you select a file in the Import Medium dialog and 
click Open, the Import Options dialog opens.

It contains the following options:

• Copy File to Working Directory
Activate this if you want a copy of the file to be made in the Audio folder 
of the project, and have the clip refer to this copy. If the option is off, the 
clip will refer to the original file in the original location (and will thus be 
marked as “external” in the Pool – see “About the Status column sym-
bols” on page 322).

• Convert to Project section
Here you can choose to convert the sample rate (if the sample rate is dif-
ferent than the one set for the project) or the sample size, i. e. resolution 
(if the sample size is lower than the record format used in the project). 
The options are only available if necessary. Note that if you are importing 
several audio files at once, the Import Options dialog will instead contain 
a “Convert and Copy to Project if needed” checkbox. When this is acti-
vated, the imported files will be converted only if the sample rate is differ-
ent or the sample size is lower than the project’s.

• Split channels/Split multi-channel files
If this is activated, stereo and multi-channel files are split into a correspon-
ding number of mono files – one for each channel – and these will be im-
ported into the Pool. Note that if you use this option, the imported files will 
always be copied to the Audio folder of the project, as described above.

• Please, don’t ask again
If this is activated, files will always be imported according to the settings 
you have made, without this dialog appearing. This can be reset in the 
Preferences dialog (Editing–Audio page). 

You can always convert files later by using the Convert 
Files (see “Convert Files” on page 332) or Conform Files 
(see “Conform Files” on page 333) options.

About the Import Audio CD dialog
You can import tracks (or sections of tracks) from an au-
dio CD directly into the Pool by using the “Import Audio 
CD…” function on the Media menu. This opens a dialog in 
which you can specify which tracks are copied from the 
CD, converted to audio files and added to the Pool.

For details about the Import from Audio CD dialog, see 
“Importing audio CD tracks” on page 553.

Exporting regions as audio files
If you have created regions within an audio clip (see “Work-
ing with regions” on page 291), these can be exported as 
separate audio files. To create a new audio file from a re-
gion, proceed as follows:

1. In the Pool, select the region you wish to export.

2. On the Audio menu, select “Bounce Selection”.
A browser dialog opens.

3. Select the folder in which you want the new file to be 
created.
A new audio file is created in the specified folder. The file will have the 
name of the region and will automatically be added to the Pool.

If you have two clips that refer to the same audio file 
(different “versions” of clips, e. g. created with the “Convert 
to Real Copy” function), you can use the Bounce Selection 
function to create a new, separate file for the copied clip. 
Select the clip, select Bounce Selection, and enter a loca-
tion and name for the new file.
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Changing the Pool Record folder
All audio clips that you record in the project will end up in 
the Pool Record folder. The Pool Record folder is indi-
cated by the text “Record” in the Status column and by a 
red dot on the folder itself. 

By default, this is the main Audio folder. However, you can 
create a new Audio subfolder at any time and designate 
this as your Pool Record folder:

1. Select the Audio folder or any audio clip.
You cannot designate the Video folder (or any of its subfolders) as the 
Pool Record folder.

2. Select “Create Folder” on the Media or context menu.
A new empty subfolder named “New Folder” appears in the Pool.

3. Select the new folder and rename it as desired.

4. Select “Set Pool Record Folder” on the Media or con-
text menu, or click in the Status column of the new folder.
The new folder now becomes the Pool Record folder, and any audio re-
corded in the project will be saved in this folder.

Organizing clips and folders
If you accumulate a large number of clips in the Pool, it 
may sometimes be difficult to quickly find specific items. In 
such cases, organizing clips in new subfolders with suit-
able names that reflect the content can be a solution. For 
example, you could put all sound effects in one folder, all 
lead vocals in another, etc. Proceed as follows:

1. Select the type of folder, audio or video, for which you 
want to create a subfolder.
You cannot put audio clips in a video folder and vice versa.

2. Select “Create Folder” on the Media or context menu.
A new empty subfolder named “New Folder” appears in the Pool.

3. Rename the folder as desired.

4. Drag and drop the clips you wish to move to the new 
folder.

5. Repeat steps 1–4 as necessary.

Applying processing to clips in the Pool
You can apply audio processing to clips from within the 
Pool in the same way as to events in the Project window. 
Simply select the clip(s) and choose a processing method 
from the Audio menu. To find out more about audio pro-
cessing, see the chapter “Audio processing and func-
tions” on page 263.

Undoing processing
If you have applied processing to a clip, in the Project win-
dow, the Sample Editor, or in the Pool, this is indicated by 
the red and gray waveform symbol in the Status column. 
This processing can always be undone using the Offline 
Process History, see “The Offline Process History dialog” 
on page 275.

Freeze Edits
You can use the Freeze Edits function to create a new file 
with processing applied or to replace the original with a 
processed version, see “Freeze Edits” on page 277.

Minimize File
The “Minimize File” option on the Media or context menu 
allows you shrink the audio files according to the size of 
the audio clips referenced in a project. The files produced 
using this option only contain the audio file portions actu-
ally used in the project. This can significantly reduce the 
size of the project, if large portions of the audio files are 
unused. Therefore, the option is useful for archiving pur-
poses after you have completed a project.

This operation will permanently alter the selected au-
dio files in the Pool. This cannot be undone! If this is not 
what you want, you can use the “Back up Project” option 
on the File menu instead, see “Back up Project” on page 
54. This function also has the option of minimizing files, 
but copies all files into a new folder, leaving the original 
project untouched.
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Proceed as follows:

1. Select the file(s) you wish to minimize.

2. Select “Minimize File” on the Media menu.
An alert appears, informing you that the entire Edit History will be 
cleared. Click Minimize to proceed or Cancel to stop the process. 

3. After the minimizing is finished, another alert appears, 
because the file references in the stored project have be-
come invalid. 
Click Save Now to save the updated project or click Later to proceed 
with the unsaved project. 

Only the audio portions actually used in the project remain 
in the corresponding audio file(s) in the Pool Record folder.

Prepare Archive
The “Prepare Archive” option on the Media menu is useful 
if you want to archive a project. For detailed information 
about the Prepare Archive feature, see “Prepare Archive” 
on page 54.

Importing and exporting Pool files
You can import or export a Pool as a separate file (file ex-
tension “.npl”), by using the “Import Pool” and “Export 
Pool” options on the Media or context menu. 

When you import a Pool file, the file references in it are 
“added” to the current Pool.

Since the audio and video files are only referenced but 
not saved in the Pool file, the Pool import is only useful if 
you have access to all referenced files (which preferably 
have the same file paths as when the Pool was saved).

You can also save and open libraries. These are stand-
alone Pool files that are not associated with a project.

Working with libraries
You can use libraries to store sound effects, loops, video 
clips, etc., and transfer media from a library into a project 
by using drag and drop. The following library functions are 
available on the File menu:

New Library

Creates a new library. Just as when creating new projects, 
you will be asked to specify a project folder for the new li-
brary (in which media files will be stored). The library ap-
pears as a separate Pool window in Nuendo. 

Open Library

Opens a file dialog for opening a saved library file.

Save Library

Opens a file dialog for saving the library file (file extension 
“.npl”).

Convert Files

Selecting the “Convert Files” option on the Media or con-
text menu opens the Convert Options dialog which oper-
ates on selected files. Use the pop-up menus to specify 
which audio file attributes you want to keep and which you 
want to convert. The available settings are:

• Sample Rate
Keep as is, or convert to a sample rate between 8.000 and 96.000  kHz.

• Sample Width
Keep the sample width (resolution) as is, or convert to 16 Bit, 24 Bit or 
32 Bit Float.

• Channels
Keep as is, or convert the file to Mono or Stereo Interleaved.

• File Format
Keep as is, or convert to Wave, AIFF, Wave 64 or Broadcast Wave format.

Options

When you convert a file, you can use the Options pop-up 
menu to set one of the following options regarding what to 
do with the new file:

Option Description

New Files Creates a copy of the file in the audio folder and converts this 
new file according to the chosen attributes. The new file is 
added to the Pool, but all clip references will still point to the 
original, unconverted file.
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Conform Files
By using this command, you will change all selected files 
that have different file attributes than what is specified for 
the project, to conform to this standard.

Proceed as follows:

1. Select the clips in the Pool.

2. Select “Conform Files…” on the Media menu.
A dialog opens allowing you to choose between keeping or replacing the 
original unconverted files in the Pool. 

The following applies:

• Clip/event references in the Pool are always redirected to the 
conformed files.

• If any “keep” option is selected, original files remain in the 
Project’s Audio folder and new files are created.

• If you select the “Replace” option, files in the Pool and in the 
Project’s Audio folder are replaced.

Extract Audio from Video File
This Media menu item allows you to extract the audio from 
a video file on disk. It automatically generates a new audio 
clip that will appear in the Pool Record folder. The result-
ing clip will have the following properties:

• It will get the same file format and sample rate/width as 
in the current project.

• It will get the same name as the video file.

This function is not available for MPEG video files.

Replace 
Files

Converts the original file without changing clip references. The 
references are however saved with the next save action.

New + 
Replace in 
Pool

Creates a new copy with the chosen attributes, replaces the 
original file with the new one in the Pool and redirects the cur-
rent clip references from the original file to the new file. This is 
the option to select if you want your audio clips to refer to the 
converted file, but still want to keep the original file on disk 
(e. g. if the file is used in other projects).

Option Description
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Introduction
One of the biggest challenges in typical computer-based production environments is how to manage the ever-growing 
number of plug-ins, instruments, sounds, presets, etc. from multiple sources. Nuendo features an efficient database for 
media file management that allows you to handle all your media files from within your sequencer program.

The MediaBay is divided into several sections:

• Define Locations – Here, you can create “presets” for locations 
on your system that you want to scan for media files, see “Defin-
ing Locations” on page 338.

• Locations – Here, you can switch between the previously de-
fined Locations.

• Filters – Here, you can filter the Results list using a logical or 
an attribute filter, see “The Filters section” on page 345.

• Results – Here, all found media files are displayed. You can 
also filter the list and perform text searches, see “The Results 
list” on page 339.

• Previewer – This section allows you to preview the files shown 
in the Results list, see “Previewing files” on page 342.

• Attribute Inspector – In this section, you can view, edit and add 
media file attributes (or tags), see “The Attribute Inspector” on 
page 347.

By default, the Locations section, the Results list, the Pre-
viewer section and the Attribute Inspector are shown.

Accessing the MediaBay
To open the MediaBay, select the MediaBay command on 
the Media menu. You can also use the corresponding key 
command (by default F5).

Setting up the MediaBay window
You can show and hide the different sections of the 
MediaBay (except for the Results list). This is handy, as it 
allows you to save screen space and enables you to dis-
play only the information you need for your work.

The Previewer 
section

The Attribute 
Inspector 

The Define 
Locations 

section

The Locations section

The Filters 
section

The Results 
list
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Proceed as follows:

1. Click the “Set up Window Layout” button in the lower 
left corner of the MediaBay window.

A transparent pane appears, covering the window. In the center of it is a 
gray area containing checkboxes for the different sections.

2. Deactivate the checkboxes for the sections you want 
to hide from view. 
Any changes you make here are directly reflected in the MediaBay window. 
Note that the Results list cannot be hidden.

You can also use key commands for this: use the up/
down and left/right arrow keys to step through the check-
boxes and press [Space] to activate/deactivate the de-
sired checkbox.

3. When you are done, click outside the gray area to exit 
the Setup mode.
Alternatively, you can wait a few seconds for the pane to disappear auto-
matically.

• You can change the size of the individual MediaBay sec-
tions by dragging the divider line between two sections.

Working with the MediaBay
When working with many media files, the most important 
thing is to find the content you need quickly and easily. 
The MediaBay helps you find and organize your content in 
an effective and efficient way. After the first scan of the 
folders you have activated for scanning (which will take a 
certain time), all the files that were found are there for you 
to browse, tag or modify. 

At the beginning, all media files of the supported formats 
are listed in the Results section: far too many to get a 
good overview. However, by using the search and filter 
techniques, you get the desired results very quickly.

The first thing to do is to set up “Locations”, that is folders 
or directories on your system that contain media files. 
Usually, files are organized in a specific way on your com-
puter. For example, you might have folders reserved for 
audio content, folders for special effects, folders for com-
binations of sounds making up the ambience noise you 
need for a certain film take, etc. These can all be set as 
different Locations in the MediaBay, allowing you to limit 
the files available in the Results list according to context.

Whenever you expand your computer system (for exam-
ple, by adding new hard disks or an external volume con-
taining media files you want to work with), you should 
make it a habit to save the new volumes as Locations or 
add them to your existing Locations. Afterwards, you can 
hide the Define Locations section from view. That way, the 
MediaBay occupies less screen space and you can con-
centrate on the important thing: the Results list. 

For this list, you can specify which file types are displayed, 
see “Filtering according to media type” on page 339. If 
there are still too many files to choose from, you can nar-
row down the results using a text search function, see 
“Performing a text search” on page 340. This is often all it 
needs to display what you want, allowing you to proceed 
by previewing the files before inserting them into your 
project (see “Previewing files” on page 342). However, if 
you need very complex and detailed filtering, this is also 
possible using either attribute or logical filtering, see “The 
Filters section” on page 345. For filtering or searches, the 
use of attributes is recommended: By specifying specific 
attribute values for your files (categorizing them as pro-
duction sound, foley, special effects, etc.), you can con-
siderably speed up the browsing process, see “The 
Attribute Inspector” on page 347.

Finally, the files can be easily inserted into the project, by 
using drag & drop, by double-clicking or using the context 
menu options, see “Inserting the files into the project” on 
page 341.
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The Define Locations section

When you open the MediaBay for the first time, a scan for 
media files is performed on your system. You specify which 
folders or directories you want to be included in the scan by 
activating/deactivating the checkboxes for the folders in the 
Define Locations section. Depending on the amount of me-
dia files on your computer, the scan may take a while. All 
files that are found in the specified folders are shown in the 
Results list.

• To include a folder in the scan, activate its checkbox.

• To exclude a folder from the scan, deactivate its check-
box.

• To restrict the search to individual subfolders, activate/
deactivate their checkboxes.

The color of the checkmark helps you to identify which 
folders and subfolders are scanned:

• A white checkmark indicates that all subfolders are scanned.
• An orange checkmark indicates that at least one subfolder is 

excluded from the scan.

• To revert to scanning a complete folder (including all 
subfolders), click on an orange checkmark.
The checkmark becomes white, to indicate that all folders are scanned.

The scanning status for the individual folders themselves 
is indicated by the color of the folder icons:

• A red icon means that the folder is currently being scanned.
• A light blue icon means the folder has been scanned.
• A dark blue icon is displayed for folders which are excluded 

from the scan.
• An orange icon is displayed when the scanning process for 

the folder was interrupted.
• A yellow icon is displayed for folders that have not yet been 

scanned.

The scan result is saved in a database file. When you de-
activate the checkbox for a folder that has already been 
scanned, a message appears, allowing you to keep the 
gathered scan data in this database file or to completely 
remove the data for this folder from the database file. Se-
lect Keep if you want to keep the database entries, but 
want to exclude the folder from being scanned (when you 
trigger a re-scan for example). Select Remove if you do 
not want to use the contents of this folder in your projects.

• When you activate the “Please, don’t ask again” option, 
no further warning messages will be shown when you de-
activate other checkboxes, for as long as the program is 
running.
When you quit and re-launch Nuendo, these warning messages will be 
displayed again.

The VST Sound node
The Define Locations section provides a shortcut to user 
content and factory content files, including the preset 
folders: the VST Sound node.

• The folders below the VST Sound node represent the 
directories in which content files and track presets, VST 
presets, etc. are stored by default.
To find out the “true” location of a file, right-click on it in the Results list 
and select “Open in Explorer” (Win)/“Reveal in Finder” (Mac). This will 
open an Explorer/Finder window in which the corresponding file is high-
lighted. Please note that this function is not available for files which are 
part of a VST Sound archive.

Some subfolders of this folder 
are excluded from the scan.

All subfolders of this folder are 
included in the scan.
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Updating the display
You can update the display in two ways: by rescanning or 
by refreshing.

Rescanning

When you click the Rescan button, the selected folder is 
rescanned. If a folder contains a large number of media 
files, the scanning process may take some time. Use this 
function if you have made changes to the content of spe-
cific media folders and want to scan these folders again.

You can also rescan the selected folder by right-click-
ing on it and selecting Rescan Disk from the context menu.

Refreshing

In addition to the Rescan Disk option, the context menu 
for the selected node or folder in the Define Locations 
section also contains a Refresh Views option. This re-
freshes the display for this location without rescanning the 
corresponding media files.

This is useful in the following situations:

• When you have modified attribute values (see “Editing 
attributes (tagging)” on page 348) and want to update the 
Results list so that these values are displayed for the cor-
responding files.

• When you have mapped a new network drive, for exam-
ple, and want this to appear as a node in the Define Loca-
tions section. Simply select the Refresh Views option for 
the parent node and the new drive will appear in the Define 
Locations section (ready to be scanned for media files).

Defining Locations 
When you have set up the Define Locations section ac-
cording to your preferences, and the content is scanned, it 
is time to make it available in a meaningful way. For this, 
you can define locations, i. e. shortcuts to the folders you 
want to work with, that will be available from the Locations 
section for convenient access.

To define a location, proceed as follows:

1. In the list to the left, select the desired folder.

2. Click the Add button.
A naming dialog for the new location is displayed.

3. Accept the default name or enter a new name.

4. Click OK.
The new location is added to the Locations pop-up menu in the Loca-
tions section (see below).

5. Repeat these steps to add as many locations as you 
need.

Once you have set up your locations, you can hide the 
Define Locations section from view (see “Setting up the 
MediaBay window” on page 335), to save screen space.

Some Location presets are available by default. These 
are: “All Media” (the topmost node in the Define Locations 
section), “Local Harddisks” (the local harddisks in your 
computer system) and “VST Sound” (the folder in which 
Steinberg sound files, loops and presets are stored by 
default).

The Locations section
When you open the Locations pop-up menu and select a 
location, the media files found in that location are shown in 
the Results list. By switching between the locations you 
defined, you can quickly browse to the files you are look-
ing for.

• To change the browse location, simply select another 
location from the pop-up menu.
If the available Locations don’t yield the desired results or if the folder 
you want to scan for files is not part of any of the locations, define a new 
Location in the Define Locations section.

• To select the previous or next folder in a sequence of 
selected folders, use the “Previous/Next Browse Location” 
buttons.
These paths will be deleted when you close the MediaBay.

Previous/Next 
Browse Location

Browse Containing Folder

Click here to open the pop-up menu 
and select the desired Location.

Remove Browse Location Definition

Deep 
Results
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• To select the parent folder of the selected folder, click 
the “Browse Containing Folder” button.

• To remove a location from the pop-up menu, select it 
and click the “Remove Browse Location Definition” button.

• To show the files contained in the selected folder and 
any subfolders (without showing these subfolders), acti-
vate the Deep Results button.
When this button is deactivated, only the folders and files contained in 
the selected folder are shown.

The Results list
The Results list is at the heart of the MediaBay. Here, you 
will find all the files found in the selected location.

As the number of files displayed can be huge (the info 
field in the top right corner of the Results section shows 
the number of files found with the current filter settings), 
you might want to use any of the filter and search options 
in the MediaBay to narrow down the list. The available op-
tions are described below.

The maximum number of files that are displayed in the 
Results list can be set by specifying a new value for “Max-
imum Items in Results list” in the Preferences (see “Prefer-
ences” on page 352).

Filtering according to media type
The Results list can be set to display only a particular me-
dia type or a combination of media types.

• Click in the field where the currently displayed media 
types are shown (by default “All Media Types”) to open 
the Show Media Types dialog.
Here, you can activate the media types you want to be displayed in the 
Results list.

When you have filtered the list to show a particular media 
type, this is indicated by the corresponding icon to the left 
of media type field. When you have selected several 
media types, the Mixed Media Type icon is used.

The media types

In the “Show Media Types” dialog, you can activate the 
media types you want to be displayed in the Results list. 
The following types are available:

Option Description

Audio Files When this is activated, the list shows all audio 
files. The supported formats are .wav, .w64, .aiff, 
.aifc, .rex, .rx2, .mp3, .mp2, .ogg, .sd2, .wma 
(Windows only).

Clip Packages When this is activated, the list shows all clip pack-
ages (file name extension .package). Clip pack-
ages contain a number of audio parts and events, 
which make up a special sound. For more informa-
tion, see “Clip packages” on page 566.

MIDI Files When this is activated, the list shows all MIDI files 
(file name extension .mid).

Select this option to 
display all types.

Here, the last four media 
type selections you 
made are listed.

The media types you 
activate here are shown 
in the Results list.
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Setting up the Results list columns
For each media type, or for combinations of media types, 
you can specify the attribute columns that are displayed in 
the Results list. In most cases, you will probably only want 
to display a few main attributes in the Results list and use 
the Attribute Inspector to view the complete list of attribute 
values for the files.

Proceed as follows:

1. Select the media type (or combination of media types) 
that you want to make settings for.

2. Click the “Set up Result Columns” button and activate 
or deactivate the options on the submenus.

Activate the attributes that you want to be displayed in the Results list.

If you want to see none of the attributes of a certain 
category, choose the “Select None” option on the corre-
sponding submenu.

When the “Allow Editing in Results List” option is acti-
vated in the Preferences dialog, you can also edit attributes 
in the Results list. Otherwise this is only possible in the At-
tribute Inspector.

Performing a text search
You can limit the number of results in the Results list using 
the text search function. When you enter text in the Text 
Search field, only media files whose attributes match the 
entered text will be displayed.

For example, if you are looking for all audio loops relating 
to drum sounds, simply enter “drum” in the search field. 
The search results will contain loops with names such as 
“Drums 01”, “Drumloop”, “Snare Drum”, etc. Also, all me-
dia files with the Category attribute Drum&Percussion, or 
any other attribute that contains “drum” will be found.

When you enter text in the field, its background becomes 
red, to indicate that a text filter is active for the list. To re-
set the text filter, delete the text.

MIDI Loops When this is activated, the list shows all MIDI 
loops (file name extension .midiloop).

Pattern Banks  
(Nuendo Expansion 
Kit only)

When this is activated, the list shows all pattern 
banks (file name extension .patternbank). Pattern 
banks are generated by the MIDI plug-in Beat De-
signer. For more information, see “Previewing pat-
tern banks (Nuendo Expansion Kit only)” on page 
344 and the separate PDF document “Plug-in 
Reference”.

Track Presets When this is activated, the list shows all track pre-
sets for audio, MIDI, and instrument tracks (file 
name extension .trackpreset). Track presets are a 
combination of track settings, effects and mixer 
settings that can be applied to new tracks of vari-
ous types. For more information, see the chapter 
“Working with track presets” on page 356.

Plug-in Presets When this is activated, the list shows all VST pre-
sets for instrument and effect plug-ins. These pre-
sets contain all parameter settings for a particular 
plug-in. They can be used to apply sounds to in-
strument tracks and effects to audio tracks. For 
more information, see the chapter “Working with 
track presets” on page 356.

Video Files When this is activated, the list shows all video files. 
For information about the supported video formats, 
see “Video file compatibility” on page 521. 

Projects When this is activated, the list shows all project 
files (from Cubase, Nuendo, Sequel): .cpr, .npr, 
.steinberg-project.

Option Description Click here to open the pop-up menu.
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Boolean text search

You can also perform advanced searches, using boolean 
operators or wildcards. The following elements can be 
used:

These operators can also be used for Logical filtering 
with the “matches” condition selected, see “Applying a 
logical filter” on page 345.

The rating slider

Using the rating slider above the Results list, you can 
specify rating settings for your files, ranging from 1 to 5. 
This makes it possible to exclude certain files from the 
search according to their quality.

When you move the rating slider, the active rating filter is 
indicated in red. All files of this rating are displayed in the 
list.

The search in progress indicator
At the top right in the Results list you will find an indicator 
which shows whether the MediaBay is currently searching 
for files.

Resetting the list
When you have set up filters for the Results list, you can 
set everything back to default by clicking the Reset Re-
sults Filter button to the right of the Rating slider.

This will delete any text in the text search field, set the rat-
ing slider to display all files and deactivate all the media 
type filters.

Inserting the files into the project
You can insert files into the project by right-clicking on 
them and selecting one of the “Insert into project” options 
from the context menu, or you can double-click them. 
What happens next depends on the track type:

Audio files, MIDI loops, and MIDI files can be inserted into 
the project by double-clicking them in the Results list. They 
will be inserted on the active track, if this matches the file 
type or onto a new track if no corresponding track is active. 
The files will be inserted at the current project cursor posi-
tion.

Similarly, if you double-click on a track preset, it will be ap-
plied to the active track, if the track type matches the track 
preset. Otherwise, a new track will be inserted, containing 
the settings of the track preset.

If you double-click a VST preset, an instrument track is 
added to the project, containing an instance of the corre-
sponding instrument. For some VST presets, this will load 
the entire instrument settings, programs, etc. For others, 
only one program will be loaded, see “Applying instrument 
presets” on page 354.

When you double-click on a pattern bank (Nuendo Expan-
sion Kit only), a new MIDI track is created in the Project 
window, with an instance of the Beat Designer plug-in as 
insert effect which is using this pattern.

Option Description

And [+] [a and b] – When entering strings separated by “and” (or 
a plus sign), all files are found that contain both a and b. 
[And] is the default setting when no boolean operator is 
used, i. e. you can also enter [a b].

Or [,] [a or b] – When entering strings separated by “or” (or a 
comma), files are found that contain either a or b, or both.

Not [-] [not b] – When entering text preceded by “not” (or a mi-
nus sign), all files not containing b will be found.

Parentheses  
[( )]

[(a or b) + c] – Using parentheses, you can group text 
strings. In this example, files are found that contain c and 
either a or b.

Quotation 
marks [“ ”]

[“example text”] – With quotation marks, you can define 
sequences of several words. Files are found if they con-
tain this sequence of words.

! When you are searching for files whose name con-
tains a hyphen, put the search text in quotation 
marks, because otherwise the program will treat the 
hyphen as the boolean operator “not”.

With this setting, only files with a rating of at 
least 2 are displayed.

When this indicator is shown, a media search is in 
progress.
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Managing files in the Results list
• You can move/copy a file from the Results list to an-
other location by clicking on it and dragging it to another 
folder in the Define Locations section.
You will be asked whether you want to copy or move the file to the new 
location.

• You can change the display order in the Results list by 
clicking on a column heading, and dragging that heading 
to another position in the display.

• To delete a file, right-click it in the list and select Delete 
from the context menu.
A warning message is displayed, asking you to confirm that you really 
want to move this file to the operating system’s trash folder. The data you 
delete here will be permanently deleted from your computer, therefore be 
sure to delete only the files you do not want to use any more.

Previewing files
When you have sufficiently narrowed down the list of files, 
you will want to preview individual files to find out which 
one to use in your project. This is done in the Previewer 
section.

Note that some MediaBay-specific Preferences affect the 
playback of media files, see “Preferences” on page 352. 

The elements visible in this section and their functions 
depend on the type of media file.

Previewing audio files

To preview an audio file, click the Play button. What hap-
pens next depends on the following settings:

• When “Auto Play New Results Selection” is activated, 
any file you select in the Results list is automatically played 
back.

• When “Align Beats to Project” is activated, the file you 
selected for preview in the Results list is played back in 
sync with the project, starting at the project cursor posi-
tion. Note that this may apply realtime time stretching to 
your audio file.
When you import an audio file into your project for which “Align Beats to 
Project” is activated in the Previewer, Musical mode is automatically ac-
tivated for the corresponding track.

• When “Wait for Project Play” is activated, the Play and 
Stop functions from the Transport panel are synchronized 
with the Play and Stop buttons in the Previewer section.
This option is very useful for previewing audio loops. To use it to its full 
extent, set the left locator at the beginning of a bar, then start playing 
back the project using the Transport panel. The loops that you now se-
lect in the Results list will start together with the project in perfect sync. 
Play and Stop of the Previewer transport can still be used if needed.

Using selection ranges

In the Previewer for audio files, you can also specify selec-
tion ranges for audio files, allowing you to only preview 
this particular section and insert it into the project.

! When a file was deleted in the Explorer/Finder, it will 
still be displayed in the Results list, although it is no 
longer available to the program. To remedy this, you 
have to re-scan the corresponding folder.

! The Previewer section is not available for video files, 
project files, and audio track presets.

! Selection ranges cannot be used when the “Align 
Beats to Project” option is activated in the Previewer.

Preview 
level

Transport 
controls

Auto Play New 
Results Selection

Align Beats 
to Project

Wait for 
Project Play
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• To make a selection range, move the mouse over the 
upper part of the waveform, so that it turns into a pencil, 
click and drag.

• To remove the selection, drag both handles all the way 
to the left.

Previewing MIDI files

To preview a MIDI file (.mid), you first have to select an 
output device from the Output pop-up menu.

• “Auto Play New Results Selection” and “Align Beats to 
Project” work as for audio files, see above.

Previewing MIDI loops
To preview a MIDI loop file, click the Play button.

• “Auto Play New Results Selection” works as for audio 
files, see above.
MIDI loops are always played back in sync to the project.

Previewing VST presets and track presets for 
MIDI and instrument tracks

Track presets for audio tracks can only be previewed 
in the Presets browser (see “Loading track or VST presets 
in the Inspector or the context menu of the track” on page 
359).

Track presets for MIDI or instrument tracks and VST pre-
sets require MIDI notes for previewing. These notes can 
be sent to the track preset in the following way:

• Via MIDI Input
• Using a MIDI file
• Using the Memo Recorder
• Via the computer keyboard

These methods will be described in the following sections.

Previewing presets via MIDI Input

MIDI input is always active, i. e. when a MIDI keyboard is 
connected to your computer (and set up properly), you 
can directly start playing the notes to preview the selected 
preset.

Previewing presets using a MIDI file

Proceed as follows:

1. On the Sequence Mode pop-up menu, select “Load 
MIDI File”.

2. In the file dialog that opens, navigate to the desired 
MIDI file, and click Open.
The name of the MIDI file is displayed on the pop-up menu.

3. Click the Play button to the left of the pop-up menu.
The notes received from the MIDI file are now played back with the settings 
of the track preset applied.

The recently used MIDI files are kept on the menu, for 
quick access. To remove an entry from this list, select it on 
the menu and then select “Remove MIDI File”.

When the pencil is shown, 
you can click and drag to 
make a selection range.

You can drag the handles 
to adjust the borders of 

the selection range.

OutputTransport controls

Computer 
keyboard input

Sequence Mode 
pop-up menu

Transport 
controls

Preview Level 
fader
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Previewing presets using the Memo Recorder

The Memo Recorder function continually repeats a given 
sequence of notes as a loop.

To use the Memo Recorder, proceed as follows:

1. On the Sequence Mode pop-up menu, select Memo 
Recorder.

2. Enter the notes via the MIDI or computer keyboard.
The Play button is automatically activated and you will instantly hear the 
notes you play with the preset settings applied.

• When you stop playing notes and wait for 2 seconds, 
the note sequence you played until this moment will be 
played back in a continuous loop. 
To use another sequence, simply start entering notes again.

You cannot use the Memo Recorder when previewing 
presets using a MIDI file.

Previewing presets via the computer keyboard

Proceed as follows:

1. Activate the “Computer Keyboard Input” button.

The keyboard display in the Previewer section works in the 
same way as the Virtual Keyboard, see “The Virtual Key-
board (Nuendo Expansion Kit only)” on page 89.

2. Enter the notes via the corresponding keys on the 
computer keyboard.

Previewing pattern banks (Nuendo Expansion 
Kit only)
Pattern banks containing drum patterns can be created 
with the MIDI plug-in Beat Designer. Detailed information 
on the Beat Designer and its functions can be found in the 
chapter “MIDI effects” in the separate PDF document 
“Plug-in Reference”. One pattern bank contains 4 sub-
banks which in turn contain 12 patterns each. In the Pre-
viewer section for a pattern bank file, a keyboard-style 
display allows you to select a subbank (click on a number 
at the top) and a pattern (click on a key).

• To preview a pattern, select the pattern bank in the Re-
sults list. In the Previewer section, choose a subbank and 
pattern. Then click the Play button.
Note that subbanks can contain empty patterns. Selecting an empty pat-
tern in the Previewer section will have no effect. Patterns containing data 
are indicated by a circle in the upper part of the key in the display. 

• “Auto Play New Results Selection” works as for audio 
files, see above.

Previewing clip packages

For clip packages, the same options as for audio files are 
available (except the selection ranges), see above. The 
preview of clip packages has however certain limitations. 
For detailed information, see “Previewing clip packages” 
on page 567.

! When you activate the “Computer Keyboard Input” 
button, the computer keyboard is used exclusively for 
the Previewer sections, i. e. the usual key commands 
are blocked. The only exceptions are:  
[Ctrl]/[Command]-[S] (Save), Num [*] (Start/Stop 
Record), [Space] (Start/Stop Playback), Num [1] 
(Jump to left locator), [Delete] or [Backspace] 
(Delete), Num [/] (Cycle on/off), and [F2] (Show/
Hide Transport panel).

Transport 
controls

Preview 
level

Auto Play New 
Results Selection
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The Filters section
With the MediaBay, you can perform very refined file 
searches. You have two possibilities: Logical or Attribute 
Filtering.

You can also save your filter settings in a MediaBay 
Aspect, allowing for a quick recall of particular searches, 
see “MediaBay aspects” on page 351.

Applying a logical filter
Logical filtering is similar to working with the Logical Edi-
tor, see the chapter “The Logical Editor, Transformer, and 
Input Transformer” on page 431.

If you click the Logical button in the Filters section, you 
can set up complex conditions that must be met for files to 
be found. Here, you can search for a specific file attribute 
value, for example.

Proceed as follows:

1. In the Locations section, select the Location in which 
you want to search for files.

2. Activate the Logical search mode by clicking on the 
Logical button in the Filters section.
A condition line appears.

3. Click in the leftmost field, to open the Select Filter At-
tributes dialog.
The dialog shows an alphabetical list of file attributes you can choose 
from. At the top of the list, the MediaBay maintains an automatically gen-
erated list of the last 5 attributes selected during previous searches.

4. Select the attribute(s) you want to use, and click OK.

• Note that you can select more than one attribute. This 
creates an OR condition: the files found will match either 
one or the other attribute.

5. Click OK to set the attribute(s) to search for.

6. On the Condition pop-up menu next to the Attribute 
pop-up menu, select the desired option.

The following options are available:

7. Enter the text or number you are looking for in the field 
to the right.
The Results list is automatically updated, showing only the files that cor-
respond to your search conditions.

For all conditions except “range”, you can enter more 
than one string in the text field (separate the different 
search strings with a space). These strings form an AND 
condition, i. e. the files that are found will match all the 
strings entered in the field.

• To add another filter line, click the “+” button to the right 
of the text field.
This way, you can add up to five filter lines in which you can define further 
search conditions. Note that two or more filter lines form an AND condi-
tion, i. e. the files searched for must match the conditions defined in all fil-
ter lines. Click the “-” button for a filter line to remove it.

• To reset all search fields to their default settings, click 
the Reset Filter button in the top right corner of the Filters 
section.

Option Description

contains The search result must contain the text or number specified in 
the text field to the right.

omits The search result must not contain the text or number specified 
in the text field to the right.

equals The search result must correspond exactly to the text or number 
specified in the text field to the right, including any file extension. 
Text searches are not case-sensitive.

>= The search result must be higher than or equal to the number 
specified in the field to the right.

<= The search result must be lower than or equal to the number 
specified in the field to the right.

is empty Use this option to find files for which certain attributes have not 
been specified yet.

matches The search result must include the text or number entered in 
the text field to the right. You can also use boolean operators. 
This allows for a very advanced text search, see “Performing a 
text search” on page 340.

range When “range” is selected, you can specify a lower and an up-
per limit for the search result in the fields to the right.
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Advanced text search

You can also perform very advanced text searches using 
boolean operators. Proceed as follows:

1. Select the desired location.

2. Activate Logical filtering by clicking on the Logical but-
ton at the top of the Filters section.
A condition line appears.

3. Select the desired attribute on the Attributes pop-up 
menu, or leave the setting on “Any Attribute”.

4. Make sure that the condition is set to “matches”.

5. Specify the desired text in the field to the right using 
boolean operators.
The available options are described in the section “Performing a text 
search” on page 340.

Performing a context menu search
If you have selected a file in the Results list or the Attribute 
Inspector, which contains an attribute you are interested 
in, there is a very fast way to look for other files with the 
same attribute.

Right-click the selected file to open the context menu and 
select the attribute value from the “Search for…” sub-
menu. This way you can easily find all the files that have 
this value in common, for example if you want to view all 
files that were created on the same day.

This is the same as specifying a logical search string, 
see above. When you select any of the “Search for…” op-
tions, the Filters section automatically switches to Logical 
filtering and the corresponding filter condition line is dis-
played. To return to the previous settings, click the Go 
Back button in the Filters section.

Applying an attribute filter

The MediaBay allows you not only to view and edit some 
of the standard file attributes found in all computer files, 
but it also provides preconfigured attributes, or “tags”, 
that you can use to organize your media files, see “The At-
tribute Inspector” on page 347.

If you click the Attribute button, the Filters section displays 
all values found for a specific attribute. Selecting one of 
these values will result in a list of files all showing this par-
ticular attribute value. For example, you could look for sam-
ple rates and pick 44.1 kHz to give you a list of all files with 
that particular sample rate.

The advantages of the use of attributes become obvious 
when having to find a specific file in a large database, 
without knowing the name of that file.

When you activate Attribute filtering, the Filters section 
shows attribute columns, each with its own list of attribute 
values. If the columns are wide enough, the number of files 
that match this criteria is displayed to the right of the filter 
name.

You define an Attribute filter by clicking on the values in an 
attribute column: only the files that match the selected at-
tribute values are then shown in the Results list. Select 
more attribute values from other columns to further refine 
your filter.

! Some attributes are directly linked to each other (e. g. 
for each Category value, there are certain Sub Cate-
gory values available). Changing the value in one of 
these attribute column will give you different values in 
the other column!

! Each attribute column displays only the attribute val-
ues found in the currently selected location! This 
means that selecting another location may lead to 
the display of different attributes.
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• Selected attribute values in the same column form an 
OR condition.
This means that files must be tagged according to either one or the other 
attribute value to be displayed in the Results list.

Note that this is not true for the Character attribute, 
which always forms an AND condition, see below.

• Attribute values in different columns form an AND con-
dition.
This means that files must be tagged according to all these attribute val-
ues to be shown in the Results list.

Assigning attribute values to your files makes it easy to or-
ganize the media files. This is described in detail in the 
section “The Attribute Inspector” on page 347.

You can also create user attributes (see “Defining user 
attributes” on page 350) to create your own categories.

Further options for Attribute searches

• You can change which attribute type is displayed in 
each column by clicking on the column title and selecting 
another attribute from the context menu.

• You can select an attribute value, by clicking on it. To 
deselect it, click the value again.
Note that you can select more than one value in each attribute column.

• You can clear all settings in the attribute columns by 
clicking the Reset Filter button at the top right of the Fil-
ters section.
Clicking this button also resets the Results list.

The Attribute Inspector
Attributes (or “tags”) for media files are sets of metadata 
providing additional information on the file.

When you have selected one or more files in the Results 
list, the Attribute Inspector shows a two-column list of at-
tributes and their values. This is very handy to get a quick 
overview of a selected file (for example when you are step-
ping through the files in the Results list).

The different types of media files have different attributes: 
For example, for .wav audio files you will find attributes like 
name, length, size, sample rate, etc., while for .mp3 files, 
additional attributes such as artist or genre are available. 
In postproduction contexts, you would use attributes like 
Actor’s Text, Episode, Pull Factor, etc.

In this section, you can also edit the attribute values of 
files or enter new attribute values, see below.

The available attributes are divided into several groups 
(Media, Audio, Staff, etc.), so as to keep the list manage-
able and make it easy to find the desired element quickly.

You have access to the standard attributes and the pre-
configured attributes provided by Nuendo. Additionally 
you can define your own attributes and add these to your 
files.

Attributes can be shown in the Attribute Inspector in two 
different ways:

• Click the Dynamic button to show all available attribute 
values.
This list is automatically generated by Nuendo. Use this view if you want 
to see the attributes the selected files have already been tagged with.
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• Click the Defined button to show a configured set of at-
tributes for the selected media type.
In this mode, you can choose which attributes are displayed (regardless 
of whether corresponding values are available for the selected files). For 
more information on how to set up the list of displayed attributes, see 
“Managing the attribute lists” on page 350.

Editing attributes (tagging)
The search functions, especially the Attribute filter, become 
a truly powerful media management tool when making ex-
tensive use of tagging, i. e. when adding and editing at-
tributes.

Media files are usually organized in complex folder struc-
tures to provide a logical way of guiding the user to the 
desired files, with the folder and/or file names indicating 
the sound, recording location, etc.

To find a particular sound or loop in such a folder structure 
can be very time consuming – tagging is the answer! 

Editing attributes in the Attribute Inspector

In the Attribute Inspector, you can edit attribute values of 
the various media files. Attribute values can be chosen 
from pop-up lists, entered as text or numbers, or set to 
Yes or No.

Note that changing an attribute value in the Attribute 
Inspector will permanently change the corresponding file 
(unless the file is write-protected or part of a VST Sound 
archive).

You can edit attributes in the following way:

1. Select the file that you want to make settings for in the 
Results list.
The corresponding attribute values are displayed in the Attribute Inspector.

2. Click in the Value column for the attribute.

Depending on the selected attribute, the following hap-
pens:

• For most of the attributes, a pop-up menu opens from 
which you can choose a value. This can be a name, a 
number and an on/off state. For example, this is the case 
for the attributes Name, Family Name, or Author.
Some of the pop-up menus also have a “more…” entry to open a window 
with more attribute values. These attribute selection windows also fea-
ture a Text Search button that you can use to find specific values more 
quickly.

• For the Rating attribute, you can click in the Value col-
umn and drag left or right to modify the setting.

• For the Character attribute (Musical group), the Edit 
Character dialog opens.
Click a radio button on the left or the right side and then click OK to de-
fine values for the Character attribute.

3. Set the attribute to the desired value.

• Many attribute values can also be edited by double-
clicking in the Value column of the Attribute Inspector.
Simply enter/change the text or number setting in the field displayed for a 
value.

• To remove the attribute value from the selected files, 
right-click in the corresponding Value column and select 
“Remove Attribute” from the context menu.

• “Display only” attributes cannot be edited.
If this is the case, the file format probably does not permit changing this 
value, or changing a particular value makes no sense (e. g. you cannot 
change the file size in the MediaBay).

You can also select several files and make settings for 
them simultaneously (except for the name, which must be 
unique for every file).
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About the color scheme used in the Attribute Inspector

The colors used for the displayed values in the Attributes 
Inspector have the following meaning:

Information on the meaning of the colors used in the At-
tribute Inspector are also displayed in a tooltip when you 
move the mouse pointer over one of the color icons below 
the Attribute Inspector.

Editing attributes in the Results list

You can also edit attributes directly in the Results list. This 
allows you for example to assign tags to a library of loop 
files.

Proceed as follows:

1. In the Results list, select the file(s) for which you want 
to change an attribute value.

2. Click in the column for the value you want to change 
and make the desired settings.
As in the Attribute Inspector, you can choose a value from a pop-up 
menu, enter the new value directly, etc.

Editing the attributes of multiple files simultaneously

There is no limit as to how many files can be tagged at the 
same time, but you need to be aware that the tagging of a 
large amount of files in one go may take quite a while. This 
operation is executed in the background, so that you can 
continue with your work as usual. By looking at the At-
tribute Counter above the Results list, you can see how 
many files still have to be updated.

• If you close Nuendo before the Attribute Counter has 
gone down to zero, a dialog with a progress bar is dis-
played, indicating how long the updating process will take. 
You can choose to abort this process.
In this case only the files that were updated before you clicked “Abort” 
will have the new attribute values.

Editing the attributes of write-protected files

Media files may be write-protected due to a number of rea-
sons: They may belong to content that was provided by 
someone else who write-protected the files, you may have 
write-protected them yourself in order not to overwrite them 
accidentally, or the file format could restrict write operations 
by the MediaBay.

In the MediaBay, the write protection status of files is 
shown as an attribute in the Attribute Inspector and in the 
Write Protection column in the Results list.

However, there may be cases when you want to define at-
tributes for write-protected files. For example, you might 
want to apply attributes to the content files that came with 
Nuendo or you are working on the same files with several 
people and cannot modify these files. In these scenarios, 
you still want to be able to find files quickly and improve 
your workflow.

Therefore, it is possible to change the attribute values of 
write-protected files in the MediaBay. These changes are 
not written to disk though and occur in the MediaBay only.

Color Description

White This represents a “normal” attribute: One or more files are se-
lected in the Results list, and they have the same values.

Yellow Yellow color stands for an “ambiguous” attribute: Multiple files 
are selected in the Results list, and their values differ.

Orange This stands for an “ambiguous static attribute”: Multiple files 
are selected in the Results list, with differing values, and which 
cannot be edited.

Red Red values are displayed for a “static attribute”: One or more 
files are selected in the Results list, whose values cannot be 
edited.

! This is only possible if “Allow Editing in Results List” 
is activated, see “Preferences” on page 352.
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• When you specify attribute values for a file that is write-
protected, this is reflected in the Pending Tags column 
next to the Write Protection column in the Results list.
Note that if you rescan the MediaBay content and a media file on your 
hard disk has changed since the last scan, all pending tags for this file 
will be lost.

• If a file has pending tags, and you want to write the cor-
responding attributes to the file, you need to remove the 
write protection first, and then select the “Write Tags to 
File” command from the context menu.

If the Write Protection and/or the Pending Tags col-
umn are not visible, you may have to enable the corre-
sponding attributes for the file type in question in the 
Attribute Inspector.

• You can change the write-protection status of your me-
dia files, provided that the file type allows write operations 
and you have the necessary operation system permis-
sions: To set or remove the write protection attribute for a 
file, simply select the file in the Results list and select 
“Set/Remove Write Protection” from the context menu.

If you use other programs than Nuendo to change the 
write-protection status of a file, this will not be reflected in 
the MediaBay until you rescan the files!

Managing the attribute lists
In the Attribute Inspector, you can define which attributes 
are shown in the Results list and in the Attribute Inspector 
itself. For different media types, individual “attribute sets” 
can be configured.

Proceed as follows:

1. In the Attribute Inspector, click the Defined button.

2. Click the “Configure Defined Attributes” button to the 
right of the Defined button.
A number of controls are displayed.

3. Click the leftmost button below the Defined/Dynamic 
buttons to open the “Select Media Types” dialog, activate 
one or more of the media types, and click OK.
The Attribute Inspector now shows a list of all attributes available for 
these media types.

• If you have activated more than one media type, your 
settings affect all selected types. 
An orange checkmark indicates that the current display settings for an 
attribute differ for the selected media types.

• The display settings made for the Mixed Media Type op-
tion are applied whenever you select files of different me-
dia types (for example audio and MIDI files) in the Results 
list or the Attribute Inspector.

4. To select a certain attribute, activate the correspond-
ing checkbox.

• You can also select several attributes and activate/de-
activate their checkboxes in one go.

• You can reset the display settings you made by clicking 
the “Reset to Default” button in the top right corner.
This will reset the display settings for all media types to their default set-
tings.

To make settings for another media type, make sure to 
only select this type in the list in the dialog.

5. When you have set up the attributes for all the media 
types you are working with, exit the Configuration mode by 
clicking the “Configure Defined Attributes” button again.

Defining user attributes
If you find that the available attributes are not suitable for 
your work, you can define your own attributes and save 
these in the MediaBay database and the corresponding 
media files.

Proceed as follows:

1. In the Attribute Inspector, activate the Defined button 
and click the “Configure Defined Attributes” button to en-
ter configuration mode.
A number of controls are displayed.

2. Click the “Add User Attribute” button (the “+” sign).
A dialog opens.

The Type column shows 
whether the value for an 
attribute is a number, 
text, or a Yes/No switch.

The Precision column 
shows the number of 
decimals displayed for 
number attributes.
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3. Specify the type of the attribute.
Attributes can be of the types “Text”, “Number” or “Yes/No” switch. For 
“Number” attributes, you can specify how many decimals are displayed, 
by entering the corresponding value in the Precision field.

4. In the text field below, enter the name for the new at-
tribute.
Note that this is the name as it will be displayed in the program. Below 
the text field, you will see the name as it will be used internally (e. g. in the 
MediaBay database). This way, you will see immediately if a certain name 
is invalid and cannot be used.

5. Click OK.
The new attribute is added to the list of available attributes and will be 
displayed in the Attribute Inspector and the Results list.

• To remove a user attribute, select it in the attribute list 
and click the “Remove User Attribute” button (the “-” sign).
The attribute is removed from any attribute list.

• Nuendo recognizes all user attributes that are included 
in media files. For example, if you load content from an-
other user, who has assigned his own user tags to the 
files, these tags are also shown in the MediaBay.

MediaBay aspects
In Nuendo, it is possible to create multiple configurations, or 
“aspects”, of the MediaBay window, that can be recalled in-
stantly via the Media menu. These aspects can be config-
ured to suit your particular working situations. There might 
be times when you only want to work with certain sound ef-
fect files, that reside in a particular location for example. Ev-
ery item in the MediaBay that can be configured (i. e. all the 
sections and their settings) can be part of a MediaBay as-
pect. This way, you can specify which sections are visible, 
which media types are browsed for, which locations are be-
ing scanned, and so on. It is even possible to enter a search 
string and save it with the aspect.

Creating a new aspect
To add a new MediaBay aspect, proceed as follows:

1. On the Media menu, open the MediaBay Aspects sub-
menu and select “New Aspect…”.

2. In the naming dialog that opens, enter the name for the 
new MediaBay aspect and click OK.
The new MediaBay aspect window opens.

3. You can now configure the window to your liking.
By default, new MediaBay aspects show the same sections as the de-
fault MediaBay.

You do not have to save the MediaBay aspect. It is au-
tomatically saved when you close the window (or the pro-
gram).

Once an Aspect is created, it can be accessed via the 
Media menu.

Creating a new aspect based on an existing aspect

If you want to create a MediaBay aspect that differs only 
slightly from an existing aspect (e. g. if you want to specify 
another browse location, text string or another file type), 
you can base the new aspect on this existing aspect.

To do so, proceed as when creating a new Aspect (see 
above), but, instead of choosing “New Aspect”, select the 
Aspect you want to use as a basis from the Duplicate As-
pect submenu.

Example setup

Let’s say you want to set up a MediaBay aspect for work 
on production sound.

Proceed as follows:

1. Create a new MediaBay aspect, from scratch or 
based on an existing aspect.
A naming dialog opens.

2. Enter a name for the aspect. Click OK to close the di-
alog.
The new MediaBay aspect opens.
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3. In the Define Locations section, select the folder (or 
removable hard drive, etc.) containing the files with pro-
duction sound you want to work with and save it as Loca-
tion. 

4. Hide the Define Locations section to save screen 
space.

5. In the Locations section, select the Location you just 
created.
You can now also close this section.

6. In the Results list, specify the file type you want to 
browse by selecting it on the dialog.
For example, if you only have audio files with production sound, select 
Audio Files.

7. Hide the Attribute Inspector.

8. In the text search field above the displayed results, en-
ter the name of the sound or attribute you are looking for.

9. That’s it! You created a MediaBay aspect.

By cloning this aspect and changing the name string, 
you can quickly and easily set up search browsers for dif-
ferent situations (e.g. when searching sounds for explo-
sions, car crashes, creating monster voices).

Removing MediaBay Aspects
• To remove a MediaBay Aspect, open the Media menu, 
and on the MediaBay Aspects submenu, select Remove 
Aspect.

Preferences
In the Preferences dialog in Nuendo, you can find options 
and settings that control the global behavior of the pro-
gram. The Preferences dialog contains a special Media-
Bay page. These settings are also available from within the 
MediaBay.

To open the Preferences pane for the MediaBay, proceed 
as follows:

1. Click the MediaBay Preferences button in the lower 
left corner of the window.

• A transparent pane appears, covering the window. In 
the center of it is a gray area where the available prefer-
ences for the Locations section and the Results list are 
displayed.

2. Configure the MediaBay to your liking by activating/
deactivating the options.

The following options are available in the Locations sec-
tion:

Option Description

Show Managed 
Locations Only

Activate this to hide all folders that are not scanned 
for files. This will keep the tree view in the Define Lo-
cations section less cluttered.
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The following options are available in the Results section:

Key commands
You can display the available MediaBay key commands 
from within the MediaBay window. This is useful if you 
want to get a quick overview over the assigned and the 
available MediaBay key commands.

To open the Key Commands pane, proceed as follows:

1. Click the Key Commands button in the lower left cor-
ner of the window.

A transparent pane appears, covering the window. In the center of it is a 
gray area where the available key commands are displayed.

• If you only want to get an overview over the key com-
mands, you can exit the pane by clicking on its back-
ground (not in the gray area).

• If you want to assign or modify key commands, click in 
the gray area.
The Key Commands dialog opens, in which you can set up and edit key 
commands, see the chapter “Key commands” on page 580.

Working with MediaBay-related 
windows
The MediaBay concept can be found throughout the pro-
gram, for example when adding new tracks or when choos-
ing presets for VST instruments or effects. The workflow in 
all MediaBay-related windows is the same as in the Media-
Bay. Below follow a few examples.

Adding tracks
When you select one of the Add Track options on the 
Project menu, the following dialog opens:

The Add Track dialog for audio tracks

Use Current 
Selection as Base 
Location

Activate this to show only the selected folder and its 
subfolders. To switch back to the display of all folders, 
deactivate this option.

Scan Folders Only 
when MediaBay is 
Open

When this is activated, Nuendo only scans for media 
files when the MediaBay window is open.  
When this is deactivated, the folders are scanned in 
the background even when the MediaBay window is 
closed. However, Nuendo will never scan folders 
while playing back or recording.

Option Description

Maximum 
Items in 
Results List

Use this parameter to specify the maximum number of 
files that are displayed in the Results list. This avoids un-
manageably long lists of files.  
Note that the MediaBay does not warn you if the maxi-
mum number of files has been reached and there might 
be situations where a certain file you were looking for 
could not be found, because the maximum number of files 
was reached.

Allow Editing 
in Results List

When this is activated, you can also edit attributes in the 
Results list. When this option is deactivated, editing can 
only be done in the Attribute Inspector.

Show File 
Extensions in 
Results List

When this is activated, file name extensions (e. g. .wav or 
.cpr) are displayed in the Results list.

Option Description
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Click the Browse button to expand the dialog to show the 
Results list (as you can find it in the MediaBay). However, 
only file types that can be used in this context are shown.

You can also apply track presets to existing tracks. The di-
alog that opens in this case is the same as above.

Applying effect presets
When you have added an insert effect, you can choose 
from a variety of presets via the Presets pop-up menu for 
the effect slot. 

The Preset browser opens:

Applying instrument presets
When working with VST instruments, you can choose 
from a variety of presets via the Presets pop-up menu. 

The Preset browser opens:

VST presets for instruments can be divided into two 
groups: “presets” containing the settings of the whole plug-
in (for multi-timbral instruments, this means the settings for 
all sound slots as well as the global settings) and “pro-
grams” containing only the settings for one program (for 
multi-timbral instruments, this means only the settings for 
one sound slot). In the MediaBay, they can be recognized 
by their icons. This way, you can see directly whether a VST 
preset contains a single sound or more.

Working with Volume databases
Nuendo stores all media file information used in the 
MediaBay, such as paths and attributes, in a local data-
base file on your computer. However, in some cases, it 
might be necessary to browse and manage this kind of 
metadata on an external volume. For example, a sound ed-
itor might have to work both at home and in a studio, on 
two different computers. Therefore, he has stored his 
sound effects on an external storage medium. When he is 
working on a different computer, he wants to connect the 

Icon Description

This preset contains settings for all loaded programs.

This program only contains settings for the first or the se-
lected instrument slot.
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external device and directly browse its contents in the 
MediaBay, without having to scan the device again. This 
can be achieved by creating a volume database for the ex-
ternal device.

Volume databases are files that can be created for drives 
of your computer or for external storage media. They con-
tain the same kind of information about the media files on 
these drives as the regular MediaBay database.

Creating a volume database
To create a separate volume database file for a drive, pro-
ceed as follows:

1. In the Define Locations section of the MediaBay, se-
lect the external storage medium, drive or partition of your 
computer system that you want to create a database for.

2. Right-click on it and select “Create Volume Database” 
on the context menu.
The file information for this drive is now written into a new database file.

When the new database file is available, this is reflected 
by the symbol to the left of the drive name.

For these two volumes volume databases have been created.

Volume databases are automatically mounted when Nu-
endo is launched. They are shown in the Define Locations 
section and their data can be viewed and edited in the Re-
sults list, as for the other media files in the MediaBay.

Rescanning and refreshing

Use the Rescan and Refresh MediaBay functions for a vol-
ume database if you have modified the scan settings on a 
different system, for example, by activating additional fold-
ers for scanning.

Removing volume databases
When you have worked on another computer using an ex-
ternal hard disk and return to your own computer and con-
nect the external device again as part of your system 
setup, you do not need a separate volume database for it 
any more. Any data on this drive can then be included in 
the local database file again, by removing the extra data-
base file.

• To remove a database, right-click on it and select “Re-
move Volume Database” from the context menu.
This integrates the metadata in the local MediaBay database file and 
subsequently deletes the volume database file.

Depending on the size of the volume database, this 
might take a while.

Mounting and unmounting volume databases

When you launch Nuendo, all available volume databases 
are automatically mounted. Databases that are made 
available while the program is running have to be mounted 
manually via the command “Mount Volume Database” on 
the context menu. To unmount a volume database, select 
“Unmount Volume Database” from the context menu.

! You must select the topmost level (root) for this. You 
cannot create a database file for a lower-level folder.

! If the drive contains a large amount of data, this pro-
cess may take a while.
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Introduction
Track presets are templates from audio, MIDI or instrument 
tracks that can be applied to newly created or existing 
tracks of the same type. They contain sound and channel 
settings, and allow you to quickly browse, preview, select 
and change sounds, or reuse channel settings across 
projects. 

Track presets are organized in the MediaBay (see the 
chapter “The MediaBay” on page 334), where you can 
categorize them with attributes. 

Types of track presets
There are four kinds of track presets (audio, instrument, 
MIDI and Multi) and two kinds of VST presets (VST instru-
ment presets and VST effect plug-in presets). These are 
described in the following sections.

Track preset settings for volume, pan, input gain and 
input phase will be applied only when creating a new track 
from a track preset.

Audio track presets
Track presets for audio tracks include all settings that de-
fine the sound. You can use the factory presets as a start-
ing point for your own editing and save the audio settings 
that you optimized for an artist you often work with as a 
preset for future recordings. 

The following data is saved in audio track presets:

• Insert effects settings (including VST effect presets)
• EQ settings
• Volume + pan
• Input gain + phase

Instrument track presets
Instrument track presets offer both MIDI and audio fea-
tures and are the best choice when handling sounds of 
simple, mono-timbral VST instruments. Use instrument 
track presets for auditioning your tracks, or saving your 
preferred sound settings, for example. You can also ex-
tract sounds from instrument track presets for use in in-
strument tracks, “Extracting sound from an instrument 
track or VST preset” on page 360. 

The following data is saved in instrument track presets:

• Audio insert effects
• Audio EQ
• Audio volume + pan
• Audio input gain + phase
• MIDI insert effects
• MIDI track parameters
• Input Transformer settings
• The VST instrument used for the track
• Staff settings
• Color settings
• Drum map settings

MIDI track presets
MIDI tracks should be used for multi-timbral VST instru-
ments and external instruments. When creating MIDI track 
presets you can either include the currently set channel, or 
the currently set patch. See “Creating a track preset” on 
page 360 for details.

• To ensure that saved MIDI track presets for external in-
struments will work again with the same instrument, install 
the instrument as a MIDI device, see the separate PDF 
document “MIDI Devices”.

The following data is saved in MIDI track presets:

• MIDI modifiers (Transpose, etc.)
• MIDI inserts (FX)
• Output + Channel or Program Change
• Input Transformer settings
• Volume + pan
• Staff settings
• Color settings
• Drum map settings

Multi-track presets
You can use multi-track presets, for example, when re-
cording setups that require several microphones (a drum 
set or a choir, where you always record under the same 
conditions) and you have to edit the resulting tracks in a 
similar way. Furthermore, they can be used when working 
with layered tracks, where you use several tracks to gener-
ate a certain sound instead of manipulating only one track.
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If you select more than one track when creating a track 
preset, the settings of all selected tracks will be saved as 
one multi-track preset. Multi-track presets can only be ap-
plied if the target tracks are of the same type, number and 
sequence as the tracks in the track preset, therefore, they 
should be used in recurring situations with very similar 
tracks and settings.

VST (instrument) presets
VST instrument presets (extension “.vstpreset”) behave 
like instrument track presets and contain a VST instrument 
and its settings but no modifiers, MIDI inserts, inserts or 
EQ settings. You can extract sounds from VST presets for 
use in instrument tracks, see “Extracting sound from an in-
strument track or VST preset” on page 360. 

The following data is saved in VST instrument presets:

• VST instrument
• VST instrument settings

VST effect plug-ins are available in VST3 and VST2 for-
mat. Presets for these effects are also saved as VST pre-
sets. These that can be part of audio track presets (see 
“Audio track presets” on page 357).

In this manual, “VST presets” stands for VST3 instru-
ment presets, unless stated otherwise.

Pattern banks (Nuendo Expansion Kit only)
Pattern banks are presets created for the Beat Designer 
MIDI effect. They behave much like track presets. For de-
tailed information, see “Previewing pattern banks (Nuendo 
Expansion Kit only)” on page 344 and the chapter “MIDI ef-
fects” in the separate PDF document “Plug-in Reference”.

Applying track presets
When you apply a track preset, all the settings saved in 
the preset are applied. Track presets can be applied to 
tracks of their own type only, i. e. audio track presets to au-
dio tracks, etc. The only exception are instrument tracks: 
for these, VST presets are also available. Note that apply-
ing VST presets to instrument tracks leads to removal of 
modifiers, MIDI inserts, inserts, or EQs, since these set-
tings are not stored in VST presets.

Applying track or VST presets via drag and 
drop
1. Open the MediaBay from the Media menu.

2. Select a MIDI or instrument track preset, or a VST 
preset.

3. Preview the preset using the functions in the Pre-
viewer section (for further information, see “Previewing 
files” on page 342).

4. Drag and drop it onto a track of the same type.

! Once a track preset is applied, you cannot undo the 
changes! It is not possible to remove an applied pre-
set from a track and return to the previous state. If 
you are not satisfied with the track settings, you have 
to either edit the settings manually or apply another 
preset.
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You can also drag and drop track presets from the 
Windows Explorer or the Mac OS Finder, but in this case, 
no preview for track presets is possible.

Loading track or VST presets in the Inspector 
or the context menu of the track
1. In the Project window, select a track.

2. Click in the Load Track Preset field at the top of the In-
spector (above the track name) or right-click the track in 
the track list and select “Load Track Preset”.
The Presets browser opens.

3. Select a track or VST preset from the Results list.
If needed, filter the list by activating the attributes you are looking for in 
the Filters section. This section is similar to the Filters section in the Me-
diaBay, see “The Filters section” on page 335.

4. Start playback to preview the selected audio, MIDI, 
instrument track, or VSTpreset.
All settings from the track preset are applied in realtime to the selected 
track. If you set up your target track to a cycle and play back in loop, pre-
viewing will be very comfortable. Note that you cannot preview multi-
track presets.

5. When you have found the preset that you want, dou-
ble-click on it (or click outside the Presets browser).
The preset is applied.

• To return to the preset that was selected when you 
opened the Presets browser, click the “Revert to Last 
Setting” button.

Applying a multi-track preset
1. Select several tracks in your project. 
Multi-track presets can only be applied if track type, number, and se-
quence are identical for the selected tracks and the track preset.

2. Right-click the track to open the context menu and se-
lect “Load Track Preset”.
The Presets browser opens. Only multi-track presets corresponding to 
the selection of tracks in the project are shown. 

3. Select a multi-track preset from the Results list.

4. When you have found the preset that you want, dou-
ble-click on it (or click outside the Presets browser).
The preset is applied.

• To return to the preset that was selected when you 
opened the Presets browser, click the “Revert to Last Set-
ting” button.

Reloading track or VST presets
When you have modified the settings of a track or VST 
preset and are not satisfied with the results, you can revert 
to the default settings of the preset by clicking the “Re-
load Track Preset” button.

Applying inserts and EQ settings from track 
presets
Instead of handling complete track presets, it is also pos-
sible to apply insert or equalizer settings from track pre-
sets. 

Proceed as follows:

1. Select the desired track, open the Inspector or the 
Channel Settings window and click the VST Sound button 
on the Inserts or Equalizers tab/section.
The Preset Management pop-up menu opens. 

2. On the pop-up menu, select “From Track Preset…”.
The Presets browser opens, showing all available track presets that con-
tain inserts or EQ settings. 

3. Select a track preset and click outside the browser.

…to open the Presets browser.

Click here…
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For information on the general handling of inserts presets, 
see “Effect presets” on page 209. The general handling of 
EQ presets is described in the section “Using EQ pre-
sets” on page 166.

Extracting sound from an instrument track or 
VST preset
For instrument tracks, you can extract the “sound” of an 
instrument track preset or VST preset, that means the VST 
instrument and its settings.

Proceed as follows:

1. Select the instrument track to which you want to apply 
a sound.

2. Click the VST Sound button below the Output Rout-
ing field in the Inspector. 

The Presets browser opens, showing a list of all available 
presets. 

3. Select an instrument track preset or VST preset by 
double-clicking on it. 
The VST instrument and its settings (but no inserts, EQs, or modifiers) on 
the existing track are overwritten with the data of the track preset. The 
previous VST instrument for this instrument track is removed and the new 
VST instrument with its settings is set up for the instrument track. 

The VST instrument of an instrument track is not listed 
in the VST Instruments window. It only appears in the Plug-
In Information window, see “The Plug-in Information win-
dow” on page 213.

Creating a track preset
A track preset can be created from an existing audio, MIDI, 
or instrument track – or a combination of these. 

Proceed as follows:

1. In the Project window, select one or more tracks. 
If several tracks are selected, all of them are stored in one combined 
multi-track preset, see “Multi-track presets” on page 357.

2. Right-click one of the selected tracks in the track list 
and select “Save Track Preset” from the context menu.
The Save Track Preset dialog opens.

3. In the New Preset section, enter a name for the new 
preset.
The track preset file name extension .trackpreset is assigned automatically.

• If you want to save attributes for the preset, click the 
button below the “New Preset” section at the bottom left.
The Attribute Inspector section opens, allowing you to define attributes 
for the preset. For further information about attributes, see “The Attribute 
Inspector” on page 347.

• If you create a track preset for a MIDI track, you can de-
cide whether you want to include the MIDI channel or the 
MIDI patch.
Select “Include MIDI channel” when working with a pre-configured multi-
timbral external instrument (for example, a sampler). That way the correct 
channel will be called up. 
Select “Include MIDI Patch” when working with a multi-timbral external 
instrument (e. g. a MIDI expander), where all sounds are available on all 
channels so that the sounds (patches) can be changed on the fly.

4. Click OK to save the preset and exit the dialog.
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Track presets are saved within the application folder in the 
“Track Presets” folder (in default subfolders named accord-
ing to their track type: audio, MIDI, instrument, and multi).

You cannot change the default folders, but you can add 
further subfolders (by clicking the New Folder button).

In the MediaBay all presets are available under the (virtual) 
VST Sound node, see “The VST Sound node” on page 
337.

If you want to use a MIDI track preset for a pre-config-
ured VST instrument setup, load the VST instrument(s) in 
the VST Instruments window, select a VST instrument 
patch, save the track preset, and do not change the patch 
afterwards. To ensure this, use a template project with the 
VSTi setup included and save the sounds (track presets) 
of this template project in specific subfolders, as they only 
work within this setup.

Creating tracks from track presets 
or VST presets

Using drag and drop
1. Open the MediaBay from the Media menu.

2. Select a track or VST preset from the list of all presets. 

3. Start playback to preview the selected VSTpreset.
All settings are applied in realtime to the selected track. If you set up your 
target track to a cycle and play back in loop, previewing will be very com-
fortable. Note that you cannot preview multi-track presets.

4. Drag and drop the preset onto the track list in the 
Project window.
One or more (in case of multi-track presets) tracks are created. If you 
drag and drop a VST instrument preset, an instrument track is created.

You can also drag and drop from the Windows Ex-
plorer or the Mac OS Finder, but in this case, no preview 
for MIDI and instrument track presets is possible.

Using the Choose Track Preset dialog
1. Right-click the track list to open the context menu and 
on the Add Track submenu select “Add Track Using Track 
Preset…”.
The Choose Track Preset dialog opens, showing a list of the available 
presets.

2. Select a preset from the Results list.
The Results section of the Choose Track Preset dialog displays all pre-
set sounds for all track types and VST instruments.

• Using the Filters section, you can narrow down the list 
by selecting the attributes that you are looking for.
This section is similar to the Filters section in the MediaBay, see “The Fil-
ters section” on page 335.

• Open the Location Tree section to select the folder in 
which you want to look for presets.
To show the Location Tree section, click the “Set Up Window Layout” 
button and activate the Location Tree option.

3. To preview MIDI and instrument track presets or VST 
presets, you have to play MIDI notes on a MIDI keyboard 
or load a MIDI file because there is no track connected.
The previewing options are described in detail in the section “Previewing 
VST presets and track presets for MIDI and instrument tracks” on page 
343.

4. When you have found the right preset, click the Add 
Track button to close the dialog.
One or more tracks (in case of multi-track presets) are created.

Using the Add Track function
1. Right-click the track list and select one of the Add 
Track options on the context menu.

2. Click the Browse button to expand the Add Track 
dialog.
The Presets Browser opens. The options are the same as when applying 
a preset to an existing track, see “Loading track or VST presets in the In-
spector or the context menu of the track” on page 359. The view is fil-
tered to show only the corresponding track presets.

3. Select a track or VST preset.

4. Click the Add Track button to create the track.

This method is not available for multi-track presets.

! The Preview functions work in the same way in the 
MediaBay and its related dialogs. Note however that 
not all Preview functions available in the MediaBay 
are also available in the dialogs.
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Introduction
Nuendo can give you instant access to up to eight para-
meters of each audio, MIDI or instrument track. This is 
done with the aid of the so-called quick controls, set up 
on the Quick Controls Inspector tab for these tracks.

The Quick Controls tab can be used as a kind of track 
control center, an area in which your most important pa-
rameters are assembled in one place. This saves you from 
having to click your way through the various windows and 
sections pertaining to your track.

Also, Nuendo allows you to assign these quick controls 
very quickly to an external remote control device. This 
gives you manual control of your most important track 
parameters.

Setting up the Quick Controls tab

Assigning parameters to quick controls
The Quick Controls tab shows eight slots, one for each 
quick control. To start with, these slots are empty. 

Proceed as follows to assign track parameters to the 
quick control slots:

1. On the Quick Controls tab, click on the first quick con-
trol slot.
A context menu opens. It lists all parameters currently accessible for this 
particular track. 

2. Double-click the parameter that you want to assign to 
the first quick control slot.
The parameter name and its value are displayed in the slot. You can 
change the value by dragging the slider.

The track’s main volume parameter is assigned to quick control 1.

3. Repeat these steps for each quick control slot until all 
eight slots are associated with track parameters.

You can now control the 8 functions most important to 
you via one single Inspector section.

Editing the quick control slots
• To rename a quick control, double-click on the name in 
the slot to select it, enter a new name and press [Enter].

• To replace a parameter assignment with a different pa-
rameter, click on the corresponding quick control slot and 
double-click on a different parameter in the browser pop-
up menu list.
The parameter assignment in this slot is changed.

• To remove a parameter from a slot, double-click the pa-
rameter name to select it and press the [Delete] or [Back-
space] key. Confirm this operation by pressing [Enter] or 
click in the corresponding slot and select “No parameter” 
from the browser pop-up menu.
The parameter assignment is removed, and the quick control slot is empty.

Options and settings
• Quick control assignments are saved with the current 
project.

• Since quick control settings are part of the track setup, 
you can save them as track presets, allowing you to re-use 
your settings across different projects.
Track presets are described in the chapter “Working with track presets” 
on page 356.

• You can automate all parameter settings on the Quick 
Controls tab using the Read/Write Enable buttons (R and 
W) at the top right.
The automation features of Nuendo are described in detail in the chapter 
“Automation” on page 239.
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Setting up quick controls on an 
external remote controller
Quick controls become really powerful when used in com-
bination with a remote controller.

Setting up the connection between the slots on the Quick 
Controls Inspector tab and a remote control device is easy. 

Proceed as follows:

1. In Nuendo, open the Device Setup dialog from the De-
vices menu.

2. In the Devices list on the left, select the Quick Con-
trols option.

This will open the Quick Controls section on the right of 
the dialog:

3. With your remote control device connected to Nuendo 
via MIDI, select the corresponding MIDI port on your com-
puter in the MIDI Input pop-up (or select “All MIDI Inputs”).
If your remote controller has its own MIDI input and supports MIDI feed-
back, you can connect your computer to the device input. Then, select 
the corresponding MIDI port in the MIDI Output pop-up menu.

4. Click “Apply” to apply your settings.

5. Select “QuickControl1” in the “Control Name” column.

6. Move the control (knob, fader or other) on your remote 
control device that you want to use for the first quick con-
trol.

7. In the Device Setup dialog, click the Learn button.

8. Repeat the last 3 steps for the other quick controls.

You have now associated the slots on the Quick Control 
tab with control elements on your external remote control-
ler. Moving a control element will automatically change the 
value of the parameter assigned to the corresponding 
quick control.

• The remote controller setup for quick controls is saved 
globally, i. e. independent of any projects.
If you have various remote controllers, you can store and load several 
quick control setups using the Export and Import buttons.

Quick controls and automatable 
parameters
The quick controls feature has one special extension: you 
can use quick controls not only to access certain parame-
ters of the current track, but also to control all automatable 
parameters. This makes it possible to use the Quick Con-
trols tab of a dedicated track as a kind of “mini mixer”, 
controlling parameters on other tracks. Use this function 
with caution, however, as you might accidentally modify 
parameters on other tracks.

Proceed as follows:

1. Create a new, empty audio track and open its Quick 
Controls tab.
This track has no events or parts.

2. Hold down the [Ctrl]/[Command] key and click on the 
slot for quick control 1.
The parameter selection context menu opens, but it lists not the parame-
ters of the current track, but all automatable parameters.
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3. Open the VST Mixer folder.

The pop-up menu lists all channels available in the Mixer 
of your current project. 

4. Now assign a parameter of one particular channel to 
quick control 1, and another parameter of another channel 
to quick control 2.

Here, quick controls 1–8 have been set up to control the main volume 
of eight audio tracks.

The Quick Controls tab has become a “secondary” mixer, 
dedicated to quick-controlling parameters on other tracks.

! Quick controls that are assigned that way cannot 
work when saved as track presets.
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Introduction
It is possible to control Nuendo via MIDI. A large number 
of MIDI control devices is supported. This chapter de-
scribes how to set up Nuendo for remote control. The 
supported devices are described in the separate PDF 
document “Remote Control Devices”.

• There is also a Generic Remote Device option, allowing 
you to use any MIDI controller to remote control Nuendo.
How to set this up is described in the section “The Generic Remote de-
vice” on page 369.

Setting Up

Connecting the remote device
Connect the MIDI output on the remote unit to a MIDI in-
put on your MIDI interface. Depending on the remote unit 
model, you may also need to connect a MIDI Out on the 
interface to a MIDI In on the remote unit (this is necessary 
if the remote unit features “feedback devices” such as in-
dicators, motorized faders, etc.).

If you are recording MIDI tracks, you do not want any MIDI 
data from the remote unit to be accidentally recorded as 
well. To avoid this, you should make the following setting:

1. Open the Device Setup dialog from the Devices menu.

2. Select “MIDI Port Setup” in the list on the left.

3. Check the table on the right and locate the MIDI input 
to which you have connected the MIDI remote unit.

4. Deactivate the checkbox in the “In ‘All MIDI Inputs’” 
column for that input, so that the State column reads 
“Inactive”.

5. Click OK to close the Device Setup dialog.

Now you have removed the remote unit input from the “All 
MIDI Inputs” group. This means that you can record MIDI 
tracks with the “All MIDI Inputs” port selected without risk-
ing to record the data from the remote unit at the same 
time.

Selecting a remote device
1. Open the Device Setup dialog from the Devices menu.

2. If you cannot find the remote device you are looking 
for, click on the plus sign in the top left corner and select 
the device from the pop-up menu.
The selected device is added to the Devices list.

• Note that it is possible to select more than one remote 
device of the same type.
If you have more than one remote device of the same type, these will be 
numbered in the Devices list. For example, to be able to use a Mackie 
Control Extender, you must install a second Mackie control device.

3. Select your MIDI control device model from the De-
vices list.
Depending on the selected device, either a list of programmable function 
commands or a blank panel is shown in the right half of the dialog window.

4. Select the correct MIDI input from the pop-up menu.
If necessary, select the correct MIDI output from the pop-up menu.

5. Click OK to close the dialog.
You can now use the MIDI control device to move faders and knobs, ac-
tivate Mute and Solo, etc. The exact parameter configuration depends on 
which external MIDI control device you are using.
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• In the Project window (track list) and the Mixer (bottom 
of channel strips) you will now see white stripes indicating 
which channels are currently linked to the remote control 
device.

Audio 10 can be remote controlled, while Audio 11 is not linked to the 
remote control device. 

Operations

Global options for remote controllers
In the Device Setup dialog, on the page for your remote 
device, some (or all) of the following global functions may 
be available (depending on your remote device):

Writing automation using remote controls
Automating the Mixer in Touch mode using a remote control 
device is done in the same way as when you operate on-
screen controls in Write mode. In order to replace existing 
automation data for a control in Touch mode, the computer 
needs to know how long the user actually “grabbed” or 
used the control. When doing this “on screen”, the program 
simply detects when the mouse button is pressed and re-
leased. When you are using an external remote control de-
vice without touch-sensitive controls, Nuendo cannot tell 
whether you “grab and hold” a fader or simply move it and 
release it.

Therefore, when you are using a device without touch-
sensitive controls and want to replace existing automation 
data, pay attention to the following:

• If you activate Write mode and move a control on the re-
mote control device, all data for the corresponding para-
meter is replaced from the position where you moved the 
control, up to the position where playback is stopped.
In other words, as soon as you move a control in Write mode, it remains 
“active” until you stop playback.

• Make sure that you move only the controller you want to 
replace.

Assigning remote key commands
For some remote devices, you can assign any Nuendo 
function (to which a key command can be assigned) to 
generic buttons, wheels, or other controls. 

Proceed as follows:

1. Open the Device Setup dialog and select your remote 
device.
On the right side of the window you will find a three column table. This is 
where you assign commands.

2. Use the Button column to locate a remote device con-
trol or button to which you wish to assign a Nuendo func-
tion.

3. Click in the Category column for the control and select 
one of the Nuendo function categories from the pop-up 
menu.

4. Click in the Command column and select the desired 
Nuendo function from the pop-up menu.
The available items on the pop-up menu depend on the selected category.

5. Click “Apply” when you are done.

! Sometimes communication between Nuendo and a 
remote device is interrupted or the handshaking pro-
tocol fails to create a connection. To re-establish 
communication with any device in the Devices list, 
select it and click the Reset button in the lower part 
of the Device Setup dialog. The “Send Reset Mes-
sage to all Devices” button at the top left of the dia-
log next to the “+” and “-” buttons will reset every 
device in the Devices list.

Option Description

Bank pop-up 
menu

If your remote device contains several banks, you can se-
lect the bank you want to use. 
The bank you select here is used by default when Nu-
endo is launched.

Smart Switch 
Delay

Some of the Nuendo functions (e. g. Solo and Mute) sup-
port the so called “smart switch” behavior: In addition to 
regular activation/deactivation of a function by clicking a 
button, you can also activate the function for as long as 
the button is pressed. Upon releasing the mouse button, 
the function is deactivated. 
This pop-up menu allows you to specify how long a but-
ton must be pressed before it goes into “smart switch” 
mode. When “Off” is selected, the “smart switch” func-
tion is deactivated in Nuendo.

Enable Auto 
Select

If this option is activated, touching a fader on a touch-
sensitive remote control device automatically selects the 
corresponding channel. On devices without touch-sensi-
tive faders, the channel gets selected as soon as you 
move the fader.
368
Remote controlling Nuendo



• Click “Reset” to revert to the default settings.

The selected function is now assigned to the button or 
control on the remote device.

A note about remote controlling MIDI tracks
While most remote control devices will be able to control 
both MIDI and audio channels in Nuendo, the parameter 
setup may be different. For example, audio-specific con-
trols (such as EQ) will be disregarded when controlling 
MIDI channels.

Accessing user panel parameters via remote 
control devices
Nuendo allows you to control external MIDI devices through 
user device panels. When you have assigned project pa-
rameters to a device panel to be displayed in the Mixer (i.e. 
when creating the panel, you must select the Channel Strip 
Size option in the Add Panel dialog), you can access these 
parameters through some of the remote control devices 
supported by Nuendo.

This feature is supported for the following devices:

• Steinberg Houston
• Mackie Control
• Mackie HUI
• Yamaha DM 2000
• CM Motormix
• SAC2K

These remote control devices provide an extra display 
page in the Inserts section for the selected channel.

This page is called User and is displayed as the 9th insert 
page for audio channels and as the 5th insert page for MIDI 
channels. It allows you to control the parameters assigned 
to your user device panel from your remote control device.

The Generic Remote device
If you have a generic MIDI controller, you can use this for 
remote control of Nuendo by setting up the Generic Re-
mote device:

1. Open the Device Setup dialog on the Devices menu.
If the Generic Remote device is not on the Devices list, you need to add it.

2. Click the “+” sign in the top left corner and select the 
“Generic Remote” device from the pop-up menu.

• When the Generic Remote device is added in the Device 
Setup dialog, you can open the corresponding window by 
selecting “Generic Remote” from the Devices menu.

3. Select the Generic Remote device in the Devices list 
to the left.
The settings for the Generic Remote device are displayed, allowing you 
to specify which control on your device should control which parameter 
in Nuendo.

4. Use the MIDI Input and Output pop-up menus to se-
lect the MIDI port(s) to which your remote device is con-
nected.
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5. Use the pop-up menu to the right to select a bank.
Banks are combinations of a certain number of channels, and are used be-
cause most MIDI devices can control only a limited number of channels at 
a time (often 8 or 16). For example, if your MIDI control device has 16 vol-
ume faders, and you are using 32 Mixer channels in Nuendo, you would 
need two banks of 16 channels each. When the first bank is selected you 
can control channel 1 to 16; when the second Bank is selected you can 
control channel 17 to 32.

6. Set up the table at the top according to the controls 
on your MIDI control device.
The columns have the following functionality:

• If you find that the table at the top holds too many or too 
few controls, you can add or remove controls with the Add 
and Delete buttons to the right of the table.

• If you are uncertain of which MIDI message a certain 
controller sends, you can use the Learn function.
Select the control in the upper table (by clicking in the Control Name co-
lumn), move the corresponding control on your MIDI device and click the 
Learn button to the right of the table. The MIDI Status, MIDI Channel, and 
Address values are automatically set to those of the moved control.

7. Use the table at the bottom to specify which Nuendo 
parameters you want to control.
Each row in the table is associated to the controller in the corresponding 
row in the first table (as indicated by the Control Name column). The 
other columns have the following functionality:

8. If necessary, make settings for another bank.
Note that you only need to make settings in the bottom table for this bank. 
The table at the top is already set up according to the MIDI remote device.

• If necessary, you can add banks by clicking the Add 
button below the Bank pop-up menu.
Clicking the Rename button allows you to assign a new name to the cur-
rently selected bank, and you can remove an unneeded bank by select-
ing it and clicking the Delete button.

Column Description

Control Name Double-clicking this field allows you to enter a descriptive 
name for the control (typically a name written on the con-
sole). This name is automatically reflected in the Control 
Name column in the lower table.

MIDI Status Clicking in this column pulls down a pop-up menu, allow-
ing you to specify the type of MIDI message sent by the 
control. The options are Controller, Program Change, Note 
On, Note Off, Aftertouch, and Polyphonic Pressure. Also 
available are Continuous Control NRPN and RPN, a way to 
extend the available control messages. The “Ctrl JLCoo-
per” option is a special version of a Continuous Controller 
where the 3rd byte of a MIDI message is used as address 
instead of the 2nd byte (a method supported by various JL-
Cooper remote devices).

MIDI Channel Clicking in this column opens a pop-up menu, allowing 
you to select the MIDI channel on which the controller is 
transmitted.

Address The Continuous Controller number, the pitch of a note, or 
the address of a NRPN/RPN Continuous Controller.

Max. Value The maximum value the control will transmit. This value is 
used by the program to “scale” the value range of the 
MIDI controller to the value range of the program para-
meter.

Flags Clicking in this column pulls down a pop-up menu, allow-
ing you to activate or deactivate three flags:
Receive – activate this if the MIDI message should be 
processed on reception.
Transmit – activate this if a MIDI message should be trans-
mitted when the corresponding value in the program 
changes.
Relative – activate this if the control is an “endless” rotary 
encoder, which reports the number of turns instead of an 
absolute value.

Column Description

Device Clicking in this column opens a pop-up menu, used for 
determining which device in Nuendo is controlled. The 
special “Command” option allows you to perform certain 
command actions by remote control. One example of this 
is the selection of remote banks.

Channel/
Category

This is where you select the channel to be controlled or, if 
the “Command” Device option is selected, the Command 
category.

Value/Action Clicking in this column pulls down a pop-up menu, allow-
ing you to select the parameter of the channel to be 
controlled (typically, if the “VST Mixer” Device option is 
selected, you can choose between volume, pan, send 
levels, EQ, etc.).
If the “Command” Device option is selected, this is where 
you specify the “Action” of the category.

Flags Clicking in this column pulls down a pop-up menu, allow-
ing you to activate or deactivate three flags:
Push Button – When activated, the parameter is only 
changed if the received MIDI message shows a value 
unequal to 0.
Toggle – When activated, the parameter value is switched 
between minimum and maximum value each time a MIDI 
message is received. The combination of Push Button and 
Toggle is useful for remote controls which do not latch the 
state of a button. One example is controlling mute status 
with a device on which pressing the Mute button turns it 
on, and releasing the Mute button turns it off. If Push But-
ton and Toggle are activated, the Mute status will change 
between on and off whenever the button is pressed on the 
console.
Not Automated – When activated, the parameter will not 
be automated. 
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9. When you are finished, close the Device Setup win-
dow.
Now, you can control the specified Nuendo parameters from the MIDI re-
mote device. To select another bank, use the pop-up menu in the Generic 
Remote window (or use a control on the MIDI remote device, if you have 
assigned one for this).

Importing and exporting remote setups

The Export button in the top right corner of the Generic 
Remote Setup window allows you to export the current 
setup, including the Control configuration (the table at the 
top) and all banks. The setup is saved as a file (with the file 
extension “.xml”). Clicking the Import button allows you to 
import saved remote setup files.

The last imported or exported remote setup will auto-
matically be loaded when the program starts or the Ge-
neric Remote control is added in the Device Setup dialog.

Track Quick Controls
If you have an external remote control device, you can set 
it up to control up to eight parameters of each audio track, 
MIDI track or instrument track, using the Track Quick Con-
trols feature in Nuendo. How to set up your device and 
how to assign parameters to it is described in the chapter 
“Track Quick Controls” on page 362.

Deactivating joysticks
When you have a joystick connected to your system, but 
do not want to use it with Nuendo, you can deactivate it:

1. Open the Device Setup dialog from the Devices menu.

2. Select the device in the list to the left in the dialog.
The corresponding settings are shown to the right.

3. You can now activate/deactivate the joystick by acti-
vating or deactivating the respective dialog option.

Apple Remote (Macintosh only)
Many Apple computers come with an Apple Remote Con-
trol, a small hand-held device akin to TV remote controls. It 
allows you to remotely control certain features in Nuendo.

Proceed as follows:

1. Open the Device Setup dialog and select Apple Re-
mote Control from the Add Device pop-up menu.

2. In the list on the right, the Apple Remote’s buttons are 
listed. For each button you can open a pop-up menu from 
which you can select a Nuendo parameter.
The parameter you select is assigned to the corresponding button on the 
Apple Remote.

By default, the Apple Remote always controls the applica-
tion that currently has the focus on your Macintosh com-
puter (provided that this application supports the Apple 
Remote).

• When the “Disable when application is not in front” op-
tion is not selected, the Apple Remote will control Nuendo 
even if it does not have the focus.
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Introduction
For each MIDI track, you can set up a number of track pa-
rameters, or modifiers, and MIDI effects. These affect how 
the MIDI data is played back, “transforming” MIDI events 
in realtime before they are sent to the MIDI outputs.

On the following pages, the available parameters and ef-
fects are described. Keep in mind:

• The actual MIDI events will not be affected – the changes 
happen “on the fly”.

• Since the modifier settings do not change the actual MIDI 
data on the track, they will not be reflected in the MIDI editors. 
To convert the track settings into “real” MIDI events, use the 
Freeze MIDI Modifiers function or the Merge MIDI in Loop 
function (see “Making your settings permanent” on page 397).

The Inspector – general handling
The MIDI modifiers and effects are set up in the Inspector 
(although some settings are available in the Mixer as well). 

• To show the Inspector, click the “Set up Window Lay-
out” button on the toolbar and activate the Inspector op-
tion.
The Inspector is displayed to the left of the track list.

• For MIDI tracks, several sections are available in the In-
spector. Which of these are displayed is determined in the 
setup context menu or the Setup dialog of the Inspector.
For information about setting up the Inspector, see “Using the Setup op-
tions” on page 572.

• You can fold or unfold the sections individually by click-
ing on the section name.
Clicking the name for a hidden section brings it to view and hides the 
other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or 
show a section without affecting other sections. [Alt]/[Option]-clicking a 
tab shows or hides all sections in the Inspector.

Folding or hiding (via the Setup dialog) a section does 
not affect the functionality but merely hides the section 
from view. This means your settings will still be active even 
if you fold or hide the Inspector settings.

The Inspector sections

Basic track settings
The topmost Inspector section contains the basic track 
settings. These settings either affect the basic functional-
ity for the track (mute, solo, enable record, etc.) or send 
out additional MIDI data to the connected devices (pro-
gram change, volume, etc.). The section contains all set-
tings that are available in the track list (see “The track list” 
on page 41), with a few additional parameters: 

Parameter Description

Track name 
field

Click once to show/hide the topmost Inspector section. 
Double-click to rename the track.

Edit button This opens the Channel Settings window for the track (a 
window showing a channel strip with volume fader and 
other controls, along with effect settings – see “Using 
Channel Settings” on page 163).

Mute/Solo 
buttons

Mutes or solos the MIDI track.

Read/Write 
buttons

Used for automating the track settings – see “Enabling and 
disabling the writing of automation data” on page 240.

Open Device 
Panels button

If the MIDI track is routed to a device with a panel, clicking 
this button opens the respective panel. For more informa-
tion, see the separate PDF document “MIDI Devices”.

Input trans-
former button

Opens the Input Transformer dialog, allowing you to trans-
form incoming MIDI events in realtime, see “The Input 
Transformer” on page 440.

Record enable 
button

Activate this to make the track ready for recording.
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Note that the functionality of the Bank and Patch selec-
tor settings (used for selecting sounds in the connected 
MIDI instrument) depends on the instrument to which the 
MIDI output is routed, and how you have set it up in the 
MIDI Device Manager. The MIDI Device Manager allows 
you to specify which MIDI instruments and other devices 
are connected to the various MIDI outputs, thus making it 
possible to select patches by name. See the chapter “Us-
ing MIDI devices” on page 380 for details about the MIDI 
Device Manager.

Many of the basic track settings are duplicated in 
“mixer channel strip form” in the MIDI Fader section of the 
Inspector (see below).

VST Expression section (Nuendo Expansion 
Kit only)
This section is used when working with the VST Expression 
features, see the chapter “VST Expression” in the Nuendo 
Expansion Kit manual.

MIDI Modifiers 

The settings on this tab affect the MIDI events on the track 
in realtime during playback. They will also be in effect if 
you play “live” with the track selected and record enabled 
(provided that “MIDI Thru Active” is activated in the Prefer-
ences dialog, MIDI page). This makes it possible, for exam-
ple, to transpose or adjust the velocity of your live playing.

If you want to compare the result of your modifier set-
tings with the “unprocessed” MIDI, you can use the Bypass 
button in the MIDI Modifiers section. When this is activated, 
the MIDI Modifiers settings will be temporarily disabled. A 
bypassed section is indicated by a yellow Bypass button.

Transpose

This allows you to transpose all notes on the track in semi-
tones. The available range is -127 to +127 semitones, but 
remember that the total range of MIDI note numbers is 0 
to 127. Furthermore, not all instruments can play back 
notes over the whole range. Therefore, extreme transposi-
tions can give rather strange and unwanted results.

• You can also transpose individual MIDI parts using the 
Transpose field in the info line.
The transposition in the info line (for the individual part) is added to the 
transpose value you have set up for the whole track in the Inspector.

Monitor 
button

When this is activated (and the “MIDI Thru Active” option 
is activated in the Preferences dialog, MIDI page), incom-
ing MIDI will be routed to the selected MIDI output.

Toggle Time-
base button

Switches between musical (tempo related) and linear 
(time related) time base for the track, see “Switching be-
tween musical and linear time base” on page 63.

Lock  
button

Activate this to disable all editing of all events on the 
track.

Lane Display 
Type button

Allows you to divide the tracks in lanes. For details about 
lanes, see “Recording audio in Stacked mode” on page 
101.

Volume Use this to adjust the level for the track. Changing this set-
ting will move the track’s fader in the Mixer window, and 
vice versa. See “Setting volume in the Mixer” on page 157 
for details about setting levels.

Pan Use this to adjust the panning of the track. 

Delay This adjusts the playback timing of the MIDI track. Posi-
tive values delay the playback while negative values 
cause the track to play earlier. The values are set in milli-
seconds.

In/Out/Chn  
pop-up menus

This is where you select MIDI input, MIDI output, and 
MIDI channel for the track.

Edit Instru-
ment button

If the MIDI track is routed to a VST instrument, clicking 
this button opens the control panel for the VST instru-
ment.

Bank and 
Patch Selector 
pop-up menu

Allows you to select a sound, see below. (If no bank is 
available, only the Patch selector is shown.)

Apply Track 
Preset button

Allows you to apply a track preset, see “Applying track 
presets” on page 358.

Parameter Description
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This setting is also affected by the global Transpose 
settings. For detailed information, see the chapter “The 
transpose functions” on page 129.

Velocity Shift

This setting lets you change the dynamics of all notes on 
the track. The value in this field is added to the velocity of 
each note message that is sent out (use negative values to 
lower the velocities). The range is -127 to +127 with 0 
representing no change in velocity.

Note that the effect of changing the velocity depends on 
the sound and instrument.

You can also adjust the velocity of events in individual 
MIDI parts using the Velocity field in the info line. The ve-
locity shift in the info line (for the individual part) is added 
to the velocity shift you have set up for the whole track in 
the Inspector.

Velocity Compression

This function multiplies the velocity values with the factor 
you specify. This factor is set using a numerator (left value) 
and a denominator (right value), resulting in a fractional 
number (1/2, 3/4, 3/2 etc.). For example, if you set the 
factor to 3/4, the velocities will be three quarters of their 
original values. This will also affect the difference in veloc-
ity between the notes, thus compressing or expanding the 
velocity scale. Typically, you would combine this setting 
with the Velocity Shift parameter. 

An example:

Let’s say you have three notes with the velocity values 60, 
90 and 120, and wish to “even out” the velocity differ-
ences somewhat. If you set the Velocity Compression 
value to 1/2, the notes will play back with the velocities 
30, 45 and 60. By adding 60 in the Velocity Shift field, the 
notes will play back with the velocities 90, 105 and 120, 
meaning you have compressed the velocity range. 

In a similar way, you can use Velocity Compression values 
greater than 1/1 together with negative values in the Ve-
locity Shift field, to expand the velocity range.

Length Compression

This value adjusts the lengths of all notes on the track. As 
with Velocity Compression, the value is set with a numer-
ator and denominator. For example, the value 2/1 means 
that all note lengths will be doubled, while 1/4 means all 
note lengths will be a quarter of the actual lengths.

Random

The Random settings let you introduce random variations 
to various properties of MIDI notes. Anything from very 
subtle variations to dramatic changes can be applied. 
There are two separate “random generators”, set up in the 
following way:

1. Pull down the Random pop-up menu and select which 
note property is randomized.
The options are position, pitch, velocity and length. 

Keep in mind that depending on the content of the 
track, certain parameter changes might not be immedi-
ately noticeable or have any effect at all (as would be the 
case if applying random length to a percussion track play-
ing “one-shot” samples for example). To best audition the 
random changes, choose a track with clearly defined 
rhythm and note content (as opposed to a string pad).

2. Set the desired range of random deviation by entering 
values in the two number fields.
The two values govern the limits of the randomization, so that the values 
will vary between the left value and the right value (you cannot set the left 
value higher than the right value). The maximum random range for each 
property is listed in the table below: 

You can make independent settings for the two random 
generators.

• To deactivate the Random function, pull down the Ran-
dom pop-up menu(s) and select “OFF”.

! Remember that the maximum velocity is always 127 
no matter how much you try to expand.

Property Range

Position -500 to +500 ticks

Pitch -120 to +120 semitones

Velocity -120 to +120 

Length -500 to +500 ticks
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Range

The Range function lets you specify a note (pitch) or ve-
locity range and either force all notes to fit within this 
range, or exclude all notes outside this range from play-
back. As with the Random function, there are two sepa-
rate Range settings. Set them up as follows:

1. Pull down the Range pop-up menu and select one of 
the following four modes:

2. Use the two fields to the right to set the minimum and 
maximum values.
These values will be shown as numbers (0–127) for the velocity modes 
and as note numbers (C-2 to G8) for the pitch modes.

Note that you can make independent settings for the 
two Range functions.

• To deactivate the Range function, pull down the Range 
pop-up menu(s) and select “OFF”.

MIDI Fader section
This contains a single channel strip, allowing you to set 
volume, pan, mute/solo and other parameters for the track, 
and a panel view of the active sends/inserts. This is a “mir-
ror” of the track’s channel strip in the Nuendo Mixer – see 
“MIDI channel strips” on page 174.

Notepad section
This is a standard notepad, allowing you to enter notes 
and comments about the track. Each track has its own 
notepad in the Inspector.

Network section
This contains controls related to Nuendo’s Network func-
tions, see “Networking” on page 482.

VST Instrument section
If the MIDI track is routed to a VST instrument, a new sub-
panel will appear at the bottom of the Inspector, labeled 
with the name of the VST instrument. Clicking this section 
shows a duplicate of the Inspector settings for the VST in-
strument channel. This makes it easy to adjust the channel 
settings for the VST instrument while you are editing the 
MIDI track.

• If the VST instrument has multiple outputs (and thus 
several Mixer channels), there will be a setting called 
“Output” at the top of the VST Instrument section.

New subpanels will also be added in the following cases:

• When a MIDI track is routed to an external instrument or effect 
that has an associated MIDI Device. In this case, the new sub-
panel will get the name of the device.

• When a MIDI track is routed to an effect plug-in that also re-
ceives audio data, i. e. that is used as an insert effect for an 
audio track (e. g. MIDI Gate), a subpanel for this audio track 
appears in the MIDI track inspector.

• If a MIDI track is routed to a plug-in assigned to a FX Channel 
track, a corresponding FX subpanel is added to the Inspector.

For an easy way to combine MIDI and VST instru-
ments, check out instrument tracks (see “VST instruments 
and instrument tracks” on page 215).

User Panel section
This allows you to display MIDI device panels, which are 
control panels for external hardware. This is described in 
the separate PDF document “MIDI Devices”.

Quick Controls section
This allows you to configure quick controls, e. g. to use re-
mote devices. See the chapter “Track Quick Controls” on 
page 362 for details.

Mode Description

Vel. Limit This function affects all velocity values outside the speci-
fied range. Velocity values below the Min setting (the 
lower limit of the range) are set to the Min value, and ve-
locity values above the Max setting are set to the Max 
value. Notes with velocity values within the set range are 
not affected. Use this if you want to force all velocity val-
ues to fit within a certain range.

Vel. Filter Velocity Filter works by excluding all notes with velocity 
values outside the specified range. Notes with velocity 
values below the Min setting or above the Max setting will 
not be played back. Use this to “isolate” notes with cer-
tain velocity values.

Note Limit This function allows you to specify a pitch range, and 
forces all notes to fit within this range. Notes outside the 
specified range are transposed up or down in octave 
steps until they fit within the range.
Note: If the range is too “narrow”, so that some notes 
cannot be fit within the range by octave-transposing, 
these notes will get a pitch in the middle of the range. For 
example, if you have a note with a pitch of F3, and the 
range is C4-E4, that note will be transposed to D4.

Note Filter Note Filter works by excluding all notes with pitches out-
side the specified range. Notes lower than the Min setting 
or higher than the Max setting will not be played back. 
Use this to “isolate” notes with certain pitches.
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MIDI effects
Nuendo comes with a number of MIDI effect plug-ins, ca-
pable of transforming the MIDI output from a track in vari-
ous ways.

Just like the MIDI modifiers, MIDI effects are applied in re-
altime to the MIDI data played back from the track (or to 
MIDI you play live “thru” the track).

What are MIDI effects?
Although a MIDI effect can be similar to an audio effect, it 
is important to remember that you’re not processing the 
sound resulting from MIDI playback, but the MIDI data (the 
“instructions” for how the music is played back). 

A MIDI effect will change properties of the MIDI events 
(e. g. change the pitch of notes) and/or generate new MIDI 
events (for example, a MIDI delay may add new MIDI 
notes, “echoing” the original notes).

The included MIDI effect plug-ins are described in the 
separate PDF document “Plug-in Reference”.

Insert and send effects
As with audio effects, there are two ways to route the MIDI 
events on a track to an effect:

If you add an insert effect, the MIDI events will be sent 
to the effect, which will process the data and pass it on to 
the track’s MIDI output (or to another insert effect). In 
other words, the MIDI events will be routed “through” the 
insert effect.

If you use a send effect, the MIDI events will be sent 
both to the track’s MIDI output and to the effect. That is, 
you will get both the unprocessed MIDI events and the 
output of the MIDI effect. Note that the effect can send its 
processed MIDI data to any MIDI output – not necessarily 
to the one used by the track.

There are separate sections in the Inspector for MIDI in-
serts and MIDI sends.

MIDI Inserts section

This allows you to add up to four MIDI insert effects. The 
section contains the following items:

Effects that display their controls in the Inspector can 
be opened in a separate control panel window by press-
ing [Alt]/[Option] and clicking the Edit button.

Item Description

Bypass button Click this to temporarily disable all insert effects for the 
track (useful for comparing with the unprocessed MIDI, 
etc.).

Inserts section 
tab

The symbol on the right of the tab has a blue background 
when an insert effect is activated.

Effect selec-
tion pop-up 
menu (x 4)

Selecting an effect from this pop-up menu automatically 
activates it and brings up its control panel (which can be 
a separate window or a number of settings below the in-
sert slot in the Inspector).
To remove an insert effect completely, select “No Effect”.

On button (x 4) Allows you to turn the selected effect on or off.

Edit button 
(x4)

Click this to bring up the control panel for the selected ef-
fect. Depending on the effect, this may appear in a sepa-
rate window or below the insert slot in the Inspector. 
Clicking the button again hides the control panel.
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MIDI Sends section

This allows you to add up to four MIDI send effects. Unlike 
audio send effects, you can select and activate send ef-
fects individually for each track. The section contains the 
following items:

Effects that display their controls in the Inspector can 
be opened in a separate control panel window by press-
ing [Alt]/[Option] and clicking the Edit button.

About presets
Several of the MIDI plug-ins come with a number of pre-
sets for instant use.

• To load a preset, select it from the Presets pop-up 
menu.

• To store your current settings as a preset, click on the 
“+” button (“Save Preset…”) to the right of the Presets 
menu.
You will be asked to specify a name for the preset. The saved preset will 
then be available for selection from the pop-up menu for all instances of 
that MIDI plug-in, in all projects.

• To remove a preset, select it and click on the “-” button 
(“Remove Preset”).

At the left and right borders of the Presets pop-up menu 
you will also find MIDI In and Out activity indicators. 
Whenever the plug-in receives or transmits MIDI data, the 
left or the right indicator will light up, respectively.

Item Description

Bypass button Click this to temporarily disable all send effects for the 
track (useful for comparing with the unprocessed MIDI, 
etc.).

Sends section 
tab

The symbol on the right of the tab has a blue background 
when a send effect is activated.

Effect selection 
pop-up menu 
(x 4)

Selecting an effect from this pop-up menu automatically 
activates it and brings up its control panel (which can be 
a separate window or a number of settings below the 
send slot in the Inspector).
To remove a send effect completely, select “No Effect”.

On button (x 4) Allows you to turn the selected effect on or off.

Pre/Post but-
ton (x4)

If this is activated, the MIDI signals will be sent to the 
send effects before the MIDI modifiers and insert effects.

Edit button (x4) Click this to bring up the control panel for the selected 
effect. Depending on the effect, this may appear in a 
separate window or below the sends slot in the Inspec-
tor. Clicking the button again hides the control panel.

Output pop-up 
menu (x4)

This determines to which MIDI output the effect will send 
the processed MIDI events.

Channel setting 
(x4)

This determines on which MIDI channel the effect will 
send the processed MIDI events.

Save and Remove 
Preset buttons

MIDI In and Out activity indicators
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Applying a MIDI insert effect – an example
Here is a step-by-step example of how to add a MIDI in-
sert effect to a MIDI track:

1. Select the MIDI track and open the Inspector.

2. Open the MIDI Inserts tab in the Inspector.

• Alternatively you can use the Mixer: bring up the ex-
tended Mixer panel and select “Inserts” on the view op-
tions pop-up menu for the track’s channel strip.

3. Click in one of the insert slots to open the MIDI effect 
pop-up menu.

4. Select the desired MIDI effect from the pop-up menu.
The effect is automatically activated (the power button for the insert slot 
lights up) and its control panel appears, either in a separate window or in 
the MIDI Inserts section below the slot (depending on the effect).

Now all MIDI from the track will be routed through the ef-
fect.

5. Use the control panel to make settings for the effect.
All included MIDI effects are described in the separate PDF document 
“Plug-in Reference”.

• You can bypass the insert effect by clicking its power 
button (above the insert slot).

• To bypass all insert effects for the MIDI track, use the 
bypass button in the MIDI Inserts section in the Inspector, 
in the Mixer channel strip or in the track list.

• To remove an insert effect, click in its slot and select 
“No Effect”.

Managing plug-ins
Selecting Plug-in Information from the Devices menu 
opens a window in which all loaded plug-ins, audio and 
MIDI, are listed.

• To view the MIDI effect plug-ins, click the MIDI Plug-ins 
tab.

• The leftmost column allows you to deactivate plug-ins.
This is useful if you have plug-ins installed that you do not want to use in 
Nuendo. Only plug-ins that are activated (ticked checkbox) will appear 
on the MIDI effect pop-up menus.
Note that plug-ins that are currently in use cannot be deactivated.

• The second column shows how many instances of each 
plug-in are currently used in the project.

• The remaining columns show various information about 
each plug-in and cannot be edited.
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Background
The MIDI Device Manager allows you to specify and set 
up your MIDI devices, making global control and patch 
selection easy.

But the MIDI Device Manager also features powerful edit-
ing functions that can be used to create MIDI device pan-
els. MIDI device panels are internal representations of 
external MIDI hardware, complete with graphics. The MIDI 
device panel editor provides all the tools you need to cre-
ate device maps where every parameter of an external de-
vice (and even an internal device like a VST instrument) 
can be controlled and automated from inside Nuendo.

For descriptions of how to create device maps and the 
powerful device panel editing features, see “About Device 
panels” on page 386. For additional information on how to 
create panels for VST instruments, see the separate PDF 
document “MIDI Devices”.

MIDI devices – general settings and 
patch handling
On the following pages, we will describe how to install 
and set up preset MIDI devices, and how to select 
patches by name from within Nuendo. For a description 
on how to create a MIDI device from scratch, please refer 
to the separate PDF document “MIDI Devices”.

About Program Change and Bank Select
To instruct a MIDI instrument to select a certain patch 
(sound), you send a MIDI Program Change message to 
the instrument. Program Change messages can be re-
corded or entered in a MIDI part like other events, but you 
can also enter a value in the Program Selector field in the 
Inspector for a MIDI track. This way, you can quickly set 
each MIDI track to play a different sound.

With Program Change messages, you are able to select 
between 128 different patches in your MIDI device. How-
ever, many MIDI instruments contain a larger number of 
patch locations. To make these available from within Nu-
endo, you need to use Bank Select messages, a system in 
which the programs in a MIDI instrument are divided into 

banks, each bank containing 128 programs. If your instru-
ments support MIDI Bank Select, you can use the Bank Se-
lector field in the Inspector to select a bank, and then the 
Program Selector field to select a program in this bank.

Unfortunately, different instrument manufacturers use dif-
ferent schemes for how Bank Select messages are con-
structed, which can lead to some confusion and make it 
hard to select the correct sound. Also, selecting patches 
by numbers this way seems unnecessarily cumbersome, 
when most instruments use names for their patches 
nowadays.

To help with this, you can use the MIDI Device Manager to 
specify which MIDI instruments you have connected by 
selecting from a vast list of existing devices or by specify-
ing the details yourself. Once you have specified which 
MIDI devices you are using, you can select to which par-
ticular device each MIDI track is routed. It is then possible 
to select patches by name in the track list or Inspector.

Opening the MIDI Device Manager
Select MIDI Device Manager from the Devices menu to 
bring up the following window:

List of connected MIDI devices. 
The first time you open the MIDI 
Device Manager, this list will be 
empty.

Use these 
buttons to 
install/remove 
devices.

Here you specify to which MIDI 
output the selected device is 
connected.

This button 
opens the 
selected 
device.

Use these buttons to import/
export XML Device setups.
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When you open the MIDI Device Manager for the first 
time, it will be empty (because you have not installed any 
devices yet). On the following pages we describe how to 
add a pre-configured MIDI device to the list, how to edit 
the settings and how to define a device from scratch.

Note that there is an important difference between in-
stalling a preset MIDI device (“Install Device”) and import-
ing a MIDI device setup (“Import Setup”):

• The presets do not include any device mapping of pa-
rameters and controls and no graphic panels.
They are simply patch name scripts. When you install a preset MIDI de-
vice, it is added to the Installed Devices list. For more information about 
patch name scripts, see the separate PDF document “MIDI Devices”.

• A device setup can include device mapping, panels 
and/or patch information. 
Device setups are also added to the list of installed devices when im-
ported. For more information about setups and device panels, see 
“About Device panels” on page 386. 

Defining a new MIDI device
If your MIDI device is not included in the list of pre-config-
ured devices (and is not a “plain” GM or XG device), you 
need to define it manually to make it possible to select 
patches by name.

1. In the MIDI Device Manager, click the Install Device 
button.
The Add MIDI Device dialog opens.

2. Select “Define New…” and click OK.
The “Create New MIDI Device” dialog opens. For a description of the op-
tions in this dialog, see the separate PDF document “MIDI Devices”. 

3. In the Identical Channels list, activate the MIDI chan-
nels you would like the device to use.
This means that the device will receive Program Change over any MIDI 
channel. For a description of Identical and Individual Channels, see the 
separate PDF document “MIDI Devices”.

4. Enter a name for the device at the top of the dialog, 
and click OK.
The device appears in the Installed Devices list, and the device node 
structure for the device is automatically shown in a new window.

5. Select Patch Banks from the pop-up menu at the top 
of the window.
As you can see, the list is currently empty.

6. Make sure that the Enable Edit checkbox is activated.
Now you can use the functions on the Commands pop-up menu on the 
left to organize the patch structure of the new device.

Installing a preset MIDI device
To install a preset MIDI device, proceed as follows:

1. Click the Install Device button.
A dialog opens listing all pre-configured MIDI devices. For now we as-
sume that your MIDI device is included in this list.

2. Locate and select the device in the list and click OK.

• If your MIDI device is not included in the list but is com-
patible with the GM (General MIDI) or XG standards, you 
can select the generic GM or XG Device options at the 
top of the list.
When you select one of these options, a name dialog will appear. Enter a 
name for the instrument and click OK.

The device now appears in the Installed Devices list to the 
left.

3. Make sure that the new device is selected in the list 
and open the Output pop-up menu.

4. Select the MIDI output that the device is connected to.

5. Click the Open Device button.
A separate window opens for the selected device, showing a node struc-
ture in the left half of the window. At the top of this structure is the device 
itself, and below it the MIDI channels used by the device. For more infor-
mation about the Device window, see the separate PDF document “MIDI 
Devices”.

6. Select Patch Banks from the pop-up menu at the top 
of the window. 
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The Patch Banks list in the left half of the window shows 
the patch structure of the device. This could simply be a 
list of patches, but it is usually one or several layers of 
banks or groups containing the patches (much like a 
folder structure on a hard disk for example).

• You can rename a device in the Installed Devices list by 
double-clicking and typing – this is useful if you have sev-
eral devices of the same model, and want to separate 
them by name instead of by number.

• To remove a device from the Installed Devices list, se-
lect it and click Remove Device.

Note that if there already exists a panel for the device, 
opening the device might open this panel first. In this 
case, click on the Edit (“e”) button to open the Device 
window.

About Patch Banks
Depending on the selected device, you may find that the 
Patch Banks list is divided in two or more main banks. 
Typically, these are called Patches, Performances, Drums, 
etc. The reason for having several patch banks is that dif-
ferent “types” of patches are handled differently in the in-
struments. For example, while “patches” typically are 
“regular” programs that you play one at the time, “perfor-
mances” may be combinations of programs, which could 
be split across the keyboard, layered, or used for multi-
timbral playback, and so on.

For devices with several banks, you will find an additional 
item labeled “Bank Assignment” in the pop-up menu at 
the top of the window. Selecting this opens a window in 
which you can specify for each MIDI channel which bank it 
should use.

The selection here will affect which bank is displayed 
when you select programs by name for the device in the 
track list or Inspector. For example, many instruments use 
MIDI channel 10 as an exclusive drum channel, in which 
case you would want to select the “Drums” (or “Rhythm 
Set”, “Percussion”, etc.) bank for channel 10 in this list. 
This would then let you choose between different drum 
kits in the track list or Inspector.

Limitations

There is no easy way to import a patch name script into an 
existing MIDI device. For a complex workaround based on 
XML editing, see the separate PDF document “MIDI De-
vices”.
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Selecting a patch for an installed device
If you return to the Project window at this point, you will 
find that the installed device has been added to the MIDI 
Output menus (in the track list and the Inspector). Now 
you can select patches by name, in the following way:

1. Pull down the Output menu (in the track list or Inspec-
tor) for the track you want to associate the installed device 
with, and select the device.
This directs the track to the MIDI output specified for the device in the 
MIDI Device Manager. The Bank and Program Selector fields in the track 
list and Inspector are replaced by a single Program Selector field that 
currently reads “Off”.

2. Click the Program Selector field to display a pop-up 
menu, hierarchically listing all the patches in the device.
The list is similar to the one displayed in the MIDI Device Manager. You 
can scroll the list up and down (if required), click the plus/minus signs to 
show or hide subgroups, etc.

You can also use a filter function here. For this, enter the 
search term in the Filter field, e.g. “drum”, and press [Re-
turn] to display all sounds with “drum” in the name.

3. Click a patch in the list to select it.
This sends the appropriate MIDI message to the device. You can also 
scroll the program selection up or down, as with any value.

Renaming patches in a device
The pre-configured devices list is based on the factory-
preset patches, i.e. the patches included in the device 
when you first bought it. If you have replaced some of the 
factory presets with your own patches, you need to modify 
the device so that the patch name list matches the actual 
device:

1. In the MIDI Device Manager, select the device in the 
Installed Devices list.

2. Click Open Device.
Make sure that Patch Banks is selected on the pop-up menu at the top of 
the window.

3. Activate the Enable Edit checkbox.
When this is turned off (default), you cannot edit the pre-configured de-
vices.

4. Use the Patch Banks display to locate and select the 
patch you want to rename.
In many instruments, the user-editable patches are located in a separate 
group or bank.

5. Click on the selected patch in the Patch Banks list to 
edit its name.

6. Type in the new name and click OK.

7. Rename the desired patches in this way, and finish by 
deactivating Enable Edit again (to avoid modifying the de-
vice by accident).

You can also make more radical changes to the patch 
structure in a device (adding or deleting patches, groups 
or banks), see below. For example, this is useful if you ex-
pand your MIDI device by adding extra storage media 
such as RAM cards.

Patch Structure
Patches are structured as follows:

• Banks are the main categories of sounds – typically patches, 
performances and drums, as described above.

• Each bank can contain any number of groups, represented by 
folders in the list.

• The individual patches, performances or drum kits are repre-
sented by presets in the list.
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The Commands pop-up menu contains the following 
items:

Create Bank

Creates a new bank at the highest hierarchical level of the 
Patch Banks list. You can rename this by clicking on it and 
typing a new name.

New Folder

Creates a new subfolder in the selected bank or folder. 
This could correspond to a group of patches in the MIDI 
device, or just be a way for you to categorize sounds, etc. 
When you select this item, a name dialog opens, allowing 
you to name the folder. You can also rename the folder af-
terwards by clicking it and typing in the list.

New Preset

This adds a new preset in the selected bank or folder. 

You can rename the preset by clicking it and typing a new 
name.

When the preset is selected, the corresponding MIDI 
events (Program Change, Bank Select, etc.) are shown in 
the event display to the right. The default setting for a new 
preset is Program Change 0 – to change this, proceed as 
follows:

• To change which Program Change value is sent out to 
select the patch, adjust the number in the Value column 
for the Program Change event.

• To add another MIDI event (e. g. Bank Select) click di-
rectly below the last event in the list and select a new 
event from the pop-up menu.
After adding a new event, you need to set its value in the Value column, 
as with Program Change.

• To replace an event, click on it and select another event 
from the pop-up menu.
For example, a MIDI device may require that a Bank Select message is 
sent first, followed by a Program Change message, in which case you 
would need to replace the default Program Change message with a 
Bank Select message and add a new Program Change after that.

• To remove an event, select it and press [Delete] or 
[Backspace].

Add Multiple Presets

This opens a dialog, allowing you to set up a range of pre-
sets to be added to the selected bank or folder.

Proceed as follows:

1. Add the event types required for selecting a patch in 
the MIDI device.
This is done just as when editing the settings for a single event: clicking 
in the event display brings up a pop-up menu from which you can select 
an event type.

2. Use the Range column to set up either a fixed value or 
a range of values for each event type in the list.
This requires some explanation:  
If you specify a single value in the Range column (e. g. 3, 15 or 127), all 
added presets will have an event of this type set to the same value.  
If you instead specify a value range (a start value and an end value, sep-
arated by a dash, e. g. 0–63), the first added preset will have an event set 
to the start value, the next value will be incrementally raised by one and 
so on, up to and including the end value.

The number of added presets depends on the Range 
setting.

! For details on which MIDI events are used for 
selecting patches in the MIDI device, consult its 
documentation.

! Different devices use different schemes for Bank 
Select. When you insert a Bank Select event, you 
should check the device’s documentation to find out 
whether to choose “CC: BankSelect MSB”, “Bank 
Select 14 Bit”, “Bank Select 14 Bit MSB-LSB 
Swapped” or some other option.
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3. Specify a Default Name below the event display.
The added events will get this name, followed by a number. You can re-
name presets manually in the Patch Banks list later.

4. Click OK.
A number of new presets have now been added to the selected bank or 
folder, according to your settings.

Other editing functions

• You can move presets between banks and folders by drag-
ging them to the Patch Banks list.

• You can remove a bank, folder or preset by selecting it in the 
Patch Banks list and pressing [Backspace].

• If you specify more than one bank, a Bank Assignment item is 
added to the pop-up menu at the top of the window. Use this 
to assign banks to the different MIDI channels (see “About 
Patch Banks” on page 383).

About Device panels
On the following pages we will describe how to use MIDI 
Device panels and the powerful MIDI device panel editing 
features of the MIDI Device Manager. 

We recommend that you first configure the patch 
banks, then export the device setup before editing the 
panels. This way, most of your settings will be saved in 
case of panel configuration problems. 

The panels are saved in XML format. For more information, 
see the separate PDF document “MIDI Devices”.

Basic concept
The panel editing features in the MIDI Device Manager can 
be seen as a separate application or entity within Nuendo. It 
allows you to build device maps complete with control pan-
els, including all parameters controllable from within Nu-
endo. Building more complex device maps requires that you 
are familiar with SysEx programming (see the separate PDF 
document “MIDI Devices”). But you can also create simpler 
panels by assigning MIDI Control Change messages to 
control objects, which does not require any programming 
skills.

Although these powerful editing features are there if you 
need them, you do not have to use them to use MIDI de-
vices.

Device panels in the program
In this section we will take a look at a pre-configured MIDI 
device panel to illustrate how it can be used in Nuendo. 
Several device maps can be found in the Knowledge Base 
on the Steinberg web site (http://knowledgebase.stein-
berg.net).

Opening a device setup

Proceed as follows to open a MIDI device setup:

1. Open the MIDI Device Manager from the Devices 
menu.

2. Click the “Import Setup” button.
A file dialog opens. 

3. Select a device setup file for import by navigating to 
the Device Maps folder (see above). 
The Device setup files are saved in XML format, for more information see 
the separate PDF document “MIDI Devices”.

4. Click Open. The Import MIDI Devices dialog opens 
where you can select one or several devices for import.
A device setup file can contain one or several MIDI devices.

5. Select a device and click OK. 
The device is added to the list of installed devices in the MIDI Device 
Manager. 
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6. Select the correct MIDI output from the Output pop-
up menu, select the device in the list and click the Open 
Device button.
The device control panel opens in a separate window. The Edit (“e”) but-
ton at the top opens the Edit Panel window, see the separate PDF doc-
ument “MIDI Devices”.

7. Close the Device panel and return to the Project 
window.

8. Select the device from the “Output Routing” pop-up 
menu for a MIDI track.
Note that for some devices, you may have to set the MIDI channel to 
“Any”.

Now the Device panel can be opened by clicking the 
Open Device Panels button in the Inspector or in the 
channel strip for the corresponding track in the Mixer.

Note that [Ctrl]/[Command]-clicking the Open Device 
Panels button allows you to open a subpanel via the panel 
browser pop-up menu.

Showing panels in the Inspector

1. In the Inspector, open the User Panel tab and click on 
the arrow on the right.
A “Panels” folder is shown with the selected device in a node structure 
below it. If you open all the folders, you can select any individual panel 
from the device that “fits” into the User Panel space.

2. Select a panel by double-clicking it in the list.
The panel opens in the Inspector.

If you cannot see any panels in the “Panels” folder, al-
though you have successfully set up a MIDI device with 
several panels, make sure that you selected the correct 
channel from the Channel pop-up menu, preferably “Any” 
to see all device panels. Also make sure that the panels fit 
into the space, otherwise they will not be available in the 
“Panels” folder.
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Showing panels in the Mixer

1. Open the Mixer and make sure that the extended 
channel view is shown.

2. Open the View options pop-up menu for the MIDI 
channel connected to the device and select “User Panel”.

3. Click the arrow next to the label “user” at the top of the 
extended section of the channel strip.
The Panels folder is displayed like in the Inspector, but with different 
available panels. Just like in the Inspector, the panel has to “fit” into the 
available space to be selectable.

4. Double-click to select a panel.
The panel is now shown in the extended section of the channel strip.

Automating device parameters

Automation works just like for normal audio and MIDI 
tracks:

1. Open the device control panel by clicking the Open 
Device Panels button in the Inspector.

2. Activate Write automation on the device panel.
You can automate the device by either moving knobs and sliders on the 
control panel or by drawing curves on the automation track for a selected 
parameter. 

3. If you now go back to the Project window, there will be 
a MIDI Device Automation track in the track list.
If the track is hidden, select “Show Used Automation” on the Track Fold-
ing submenu of the Project menu.

If you click in the name field, all parameters in the device 
are shown and can be selected for automation. 

• To open another automation track for the next parame-
ter on the pop-up menu, click the + button (“Append au-
tomation track”) at the bottom left of the automation track.

If you wrote automation but your MIDI device is not yet 
connected, the panel will not display any parameter 
changes when playing back the track with the Read but-
ton activated.
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About Studio Connections
Studio Connections is the name of an initiative led by 
Steinberg and Yamaha. The initiative intends to create 
industry standards for totally integrated system environ-
ments using software and hardware products.

First implementation stage of the Studio Connections 
open standard is the integration and support of Yamaha’s 
Studio Manager 2 (SM2) and Total Recall for compatible 
hardware devices. 

For further information about Studio Connections, please 
visit the website http://www.studioconnections.org.

If you have an SM2 component installed, there is an addi-
tional menu item on the Devices menu.

Total Recall

Total Recall means that you can save and recall all set-
tings of your hardware and software products by opening 
one integrated file in a DAW such as Nuendo or Cubase. 
Also you will have instant and organized access to hard-
ware editors.

When you load a project or switch to another active project 
that contains SM2 data, the Total Recall Synchronization 
dialog opens:

This dialog can also be opened any time from the Studio 
Manager’s Synchronize menu. Click OK for the Dump to 
start.

Virtual MIDI Devices

If you have a new OPT component (e. g. the DM2000) 
which uses a new special interface, you can access these 
components as virtual MIDI Devices in the MIDI track’s 
output routing (if the output of the OPT is configured).

When a MIDI track is routed to such a device, the “Open 
Device Panels” button becomes available.
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• Click the Open Device Panels button, to open the editor 
window for the device.

Please also refer to the separate documentation for 
the Studio Manager 2 and the OPT components.
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Introduction
This chapter describes the various MIDI processing func-
tions available on the MIDI menu. They offer various ways 
to edit MIDI notes and other events, either in the Project 
window or from within a MIDI editor.

MIDI functions vs. MIDI modifiers
In some cases, the result of a MIDI function can also be 
obtained by using MIDI modifiers and effects (see “MIDI 
realtime parameters and effects” on page 372). For exam-
ple, the operations “Transpose” and “Quantize” are avail-
able both as MIDI modifiers and as MIDI functions.

The main difference is that MIDI modifiers and effects do 
not affect the actual MIDI events on the track in any way, 
while MIDI functions change the events “permanently” 
(although recent changes can be undone). 

Use the following guidelines to decide which path to 
choose for operations that are available both as modifiers 
or effects and as functions:

• If you want to adjust a few parts or events only, use MIDI 
functions. The MIDI modifiers and effects affect the output 
of the whole track (although they can be made permanent 
in a specific area with the Merge MIDI in Loop function).

• If you want to experiment with different settings, use 
MIDI modifiers and effects.

• MIDI modifiers and effects settings are not reflected in 
the MIDI editors, since the actual MIDI events are not af-
fected. This can be potentially confusing; if you have trans-
posed notes using modifiers for example, the MIDI editors 
will still show the notes with their original pitch (but they will 
play back at their transposed pitch). Therefore, MIDI func-
tions are a better solution if you want to see the effects of 
your editing in the MIDI editors.

What is affected by the MIDI functions?
Which events are affected when you use a MIDI function 
depends on the function, the active window and the cur-
rent selection:

• Some MIDI functions only apply to MIDI events of a cer-
tain type.
For example, quantization only affects notes, while the Delete Controllers 
function only applies to MIDI controller events.

• In the Project window, the MIDI functions apply to all 
selected parts, affecting all events (of the relevant types) 
in them.

• In the MIDI editors, the MIDI functions apply to all se-
lected events. If no events are selected, all events in the 
edited part(s) will be affected.

The quantizing functions

What is quantizing?
Quantizing in its fundamental form is a function that auto-
matically moves recorded notes, positioning them on ex-
act note values:

However, quantizing is not only a method of correcting er-
rors, it can also be used creatively in various ways. For ex-
ample, the “quantize grid” does not have to consist of 
perfectly straight notes, some notes can automatically be 
excluded from quantizing, etc.

When quantizing MIDI, only MIDI notes are affected (no 
other event types). However, you can choose to move the 
controllers together with their respective notes by activating 
the “Move Controller” option in the Quantize Setup dialog, 
see “The Move Controller setting” on page 394.

For example, if you record a series of eighth notes, some of them may 
end up slightly beside the exact eighth note positions.

Quantizing the notes with the quantize 
grid set to eighth notes will move the 
“misplaced” notes to exact positions.
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Setting up quantize on the toolbar
At its most basic, setting up quantizing consists of select-
ing a note value from the Quantize pop-up menu on the 
toolbar (in the Project window or a MIDI editor).

This allows you to quantize to exact note values (straight, 
triplet or dotted notes) only. 

Setting up quantize in the Quantize Setup 
dialog
If you want more options than those available on the pop-
up menu, select “Quantize Setup…” from the MIDI menu 
(or “Setup…” from the Quantize pop-up menu) to open 
the Quantize Setup dialog.

Any settings you make in the dialog are immediately 
reflected in the Quantize pop-up menus. However, if you 
want your settings permanently available on the Quantize 
pop-up menus, you have to use the presets functions (see 
“Presets” on page 394).

The grid display in the middle of the dialog shows one bar 
(four beats), with blue lines indicating the quantize grid 
(the positions that notes will be moved to). Value changes 
in the grid, presets and quantize options will be graphically 
reflected here, see below. 

The Quantize Setup dialog contains the following settings:

The Grid and Type pop-ups

These are used to determine the basic note value for the 
quantizing grid. In other words, these have the same func-
tionality as the Quantize pop-up menu on the toolbar.

Swing

The Swing slider is only available when a straight note 
value is selected for the grid and Tuplet is off (see below). 
It lets you offset every second position in the grid, creating 
a swing or shuffle feel. When you adjust the Swing slider, 
the result is shown in the grid display.

A straight eighth note grid compared with a grid with 60 % swing.

Tuplet

Allows you to create more rhythmically complex grids by 
dividing the grid into smaller steps.

Magnetic Area

This allows you to specify that only notes within a certain 
distance from the grid lines are affected by quantizing.

• When the slider is set to 0 %, the Magnetic Area func-
tion is deactivated, i. e. all notes are affected by quantizing.
If you move the slider gradually to the right, you will note how the mag-
netic areas are shown around the blue lines in the grid display.

Only notes within the indicated zones will be affected by quantizing.
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Presets

The controls in the lower left corner of the dialog allow you 
to store the current settings as a preset, which will then be 
available on the Quantize menus on the toolbars. The 
usual preset procedures apply:

• To store the settings as a preset, click the Store button. 

• To load a stored preset into the dialog, simply select it 
from the pop-up menu. 
This is useful if you want to modify an existing preset.

• To rename the selected preset, double-click on the 
name and type in a new one. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

• You can also create presets by extracting existing 
grooves from a MIDI part. 
Just select the desired MIDI part and drag it on the grid display in the 
middle of the Quantize Setup dialog or open the Advanced submenu of 
the MIDI menu and select “Part to Groove” (see “Part to Groove” on 
page 396).

Apply and Auto

These functions allow you to apply quantizing directly from 
the dialog, see below.

The Non Quantize setting

This setting affects the result of the quantizing. It allows 
you to set a “distance” in ticks (120ths of sixteenth notes).

Events that already are within the specified distance from 
the quantize grid will not be quantized. This allows you to 
keep slight variations when you quantize, but still correct 
notes that are too far from the grid.

The Random Quantize setting

This setting affects the result of the quantizing. It allows 
you to set a “distance” in ticks (120ths of sixteenth notes).

Events will be quantized to random positions within the 
specified “distance” from the quantize grid, thus creating 
a more “loose” quantizing. Much like the Non Quantize 
setting, this allows for slight variations, while at the same 
time keeping notes from ending up too far from the grid.

The Iterative Strength setting

Here you specify how much the notes are moved towards 
the grid when using the Iterative Quantize function, see 
below.

The Move Controller setting

When this is activated, controllers related to notes (pitch-
bend, etc.) are automatically moved with the notes when 
these are quantized.

Applying quantize
There are several ways to apply the quantize:

• The standard method is to select “Over Quantize” from 
the MIDI menu (or using a key command, by default [Q]).
This quantizes the selected MIDI parts or notes according to the current 
Quantize pop-up menu setting.

• You can also apply quantizing directly from the Quantize 
Setup dialog, by clicking the “Apply Quantize” button.

• If you activate the “Auto” checkbox in the Quantize 
Setup dialog, any change you make in the dialog is imme-
diately applied to the selected MIDI parts or notes.
A great way of using this feature is to set up a playback loop, and adjust 
the settings in the dialog until you get the desired result. 

! If you do not want to apply the quantizing you have 
set up in the dialog, close the window by clicking its 
close button. 

! When you apply quantize, the result is based on the 
original position of the notes. Therefore, you can 
freely try out different quantize settings with no risk of 
“destroying” anything (see also “Undo Quantize” on 
page 395).
394
MIDI processing and quantizing



The Auto Quantize function
If you activate the Auto Q button on the Transport panel, 
all MIDI recordings you make are automatically quantized 
according to the settings you have made in the Quantize 
Setup dialog.

Iterative Quantize
Another way to apply “loose” quantization is to use the It-
erative Quantize function on the MIDI menu. It works like 
this:

Instead of moving a note to the closest quantize grid posi-
tion, Iterative Quantize moves it only part of the way. You 
specify how much the notes are moved towards the grid 
with the “Iterative Strength” setting in the Quantize Setup 
dialog.

Iterative Quantize also differs from “regular” quantization 
in that the operation is not based on the notes’ original po-
sitions but on their current, quantized position. This makes 
it possible to repeatedly use Iterative Quantize, gradually 
moving the notes closer to the quantize grid until you have 
found the desired timing.

Advanced Quantize functions

Quantize Lengths

This function (on the Advanced Quantize submenu of the 
MIDI menu) will quantize the length of the notes, without 
changing their start positions. At its most basic level, this 
function will set the length of the notes to the Length Quan-
tize value on the MIDI editor toolbar. However, if you have 
selected the “Quantize Link” option on the Length Quantize 
pop-up menu, the function will resize the note according to 
the quantize grid, taking the Swing, Tuplet and Magnetic 
Area settings into account. 

An example:

Length Quantize set to “Quantize Link”.

Some 16th notes.

Here, the quantize value has been set to straight 16th notes with Swing 
at 100 %.

Selecting Quantize Lengths will adjust the note lengths according to 
the grid. If you compare the result to the first figure above, you will find 
that notes that started within the odd sixteenth note “zones” show the 
longer grid length, and notes in the even zones have the shorter length.

Quantize Ends

The Quantize Ends function on the Advanced Quantize 
submenu will only affect the end positions of notes. Apart 
from that, it works just like regular quantizing, taking the 
Quantize pop-up menu setting into account.

Undo Quantize

As mentioned above, the original position of each quan-
tized note is stored. Therefore, you can make the selected 
MIDI notes revert to their original, unquantized state at any 
time by selecting Undo Quantize from the Advanced 
Quantize submenu. This is independent from the regular 
Undo History.

! This function is only available from within the MIDI 
editors.
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Freeze Quantize

There may be situations when you want to make the quan-
tized positions “permanent”. For example, you may want to 
quantize notes a second time, having the results based on 
the current quantized positions rather than the original po-
sitions. To make this possible, select the notes in question 
and select “Freeze Quantize” from the Advanced Quantize 
submenu. This makes the quantized positions permanent.

Part to Groove

With this function, you can extract the groove from a se-
lected MIDI part and turn it into a Quantize preset. 

You can also extract grooves from audio, using hitpoints 
(see “Creating groove quantize maps” on page 301), or 
audio parts, ReCycle (.rex) parts or drum parts that have 
been processed with the Detect Silence function. Since 
audio contains no velocity information, velocity will remain 
unchanged after applying a Groove that you extracted 
from audio.

In both cases, the resulting groove appears on the Quan-
tize menus and you apply it as any Quantize preset. You 
can also view and edit the resulting quantize settings in 
the Quantize Setup dialog.

Transpose
The Transpose item on the MIDI menu opens a dialog with 
settings for transposing the selected notes.

You can also use the transpose track for transposing, 
see “The transpose functions” on page 129.

Semitones

This is where you set the amount of transposition.

Scale Correction

Scale Correction transposes the selected notes by for-
cing them to the closest note of the selected scale type. 
This can be used for creating interesting key and tonal 
changes, either by itself or in conjunction with the other 
settings in the Transpose dialog.

• To activate Scale Correction, click the checkbox.

• Select a root note and scale type for the current scale 
from the upper pop-up menus.

• Select a root note and scale type for the new scale from 
the lower pop-up menus.
Make sure to select the correct root note if you want to keep the result in 
the same key as the original notes, or select an entirely different key if you 
want to experiment.

Keep Notes in Range

When this is activated, transposed notes will remain 
within the Upper and Lower Limit values.

• If a note ends up outside the limits after transposition, it 
will be shifted to another octave, keeping the correct 
transposed pitch if possible.
If this is not possible (if you have set a very narrow range between the 
Upper and Lower Limit), the note will be transposed “as far as possible”, 
i. e. to the Upper or Lower Limit note. If you set the Upper and Lower Lim-
its to the same value, all notes will be transposed to this pitch!

OK and Cancel

Clicking OK performs the transposition. Clicking Cancel 
closes the dialog without transposing.

! After you have performed a Freeze Quantize for a 
note, you cannot undo its quantization.
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Making your settings permanent
The settings described in the chapter “MIDI realtime pa-
rameters and effects” on page 372 do not change the 
MIDI events themselves, but work like a “filter”, affecting 
the music on playback. Therefore, you may want to make 
them permanent, i. e. convert them to “real” MIDI events, 
for example to transpose a track and then edit the trans-
posed notes in a MIDI editor. For this, you can use two 
commands from the MIDI menu:

• “Freeze MIDI Modifiers” – This applies all filter settings 
permanently to the respective track. 
With this function, the settings are “added” to the events on the track, 
and all modifiers will be set to zero.

• “Merge MIDI in Loop” – This merges all selected tracks 
(or parts) to create a new track.
The settings are applied during the merge and will still be displayed later 
in the respective menus.

These two functions are described in the following sec-
tions.

Freeze MIDI Modifiers
The “Freeze MIDI Modifiers” function affects the following 
settings for MIDI tracks:

• Several settings on the main tab of the Inspector (program 
and bank selection and the Delay parameter).

• The settings on the MIDI Modifiers tab (i. e. Transpose, Veloc-
ity Shift, Velocity Compression and Length Compression).

• The settings on the MIDI Inserts tab (if, e. g., you are using an ar-
peggiator and want to convert the added notes to real events).

The following settings for MIDI parts are taken into account 
as well:

• The Transpose and Velocity settings for parts displayed on the 
info line – the Volume setting is not taken into account. 

To use the “Freeze MIDI Modifiers” function, proceed as 
follows:

1. Select the desired MIDI track.

2. Pull down the MIDI menu and select “Freeze MIDI 
Modifiers”.
The Inspector settings will be converted to MIDI events and inserted at 
the beginning of the part(s). All notes of the part(s) will be modified ac-
cordingly and the Inspector settings will be reset.

Merge MIDI in Loop
The “Merge MIDI in Loop” function combines all MIDI 
events on all unmuted tracks, applies MIDI modifiers and 
effects and generates a new MIDI part, containing all the 
events as you would hear them play back. Proceed as 
follows:

1. Make sure only the desired MIDI track(s) are unmuted.
If you only want to include events from a single track in the merge opera-
tion, you may want to solo the track.

2. Set up the left and right locators to encompass the 
area you want to merge.
Only events starting within this area will be included.

3. Select the track on which you want the new part to be 
created.
This can be a new track or an existing track. Data in the cycle area on the 
track can be kept or overwritten (see below).

4. Select “Merge MIDI in Loop” from the MIDI menu.
A dialog opens with the following options:

5. Click OK.
A new part is created between the locators on the destination track, con-
taining the processed MIDI events.

Option Description

Include Inserts If this is activated, any MIDI insert effects currently acti-
vated for the track(s) will be applied.

Include Sends If this is activated, any MIDI send effects currently acti-
vated for the track(s) will be applied.

Erase 
Destination

If this is activated, all MIDI data between the left and right 
locators on the destination track will be deleted.

Include Chase If this is activated, events placed outside the selected part 
but relating to it will be included in the processing, e. g. a 
Program Change right before the left locator. For details 
about chase events, see “About Chase” on page 88.
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Applying effects to a single part

Normally, the MIDI modifiers and effects affect a whole 
MIDI track. This may not always be what you want – you 
may want to apply some MIDI effects to a single part for 
example (without having to create a separate track for that 
part only). The Merge MIDI in Loop function can help:

1. Set up your MIDI modifiers and MIDI effects the way 
you want them for the part.
This will of course affect the whole track, but focus on the part for now.

2. Set the locators to encompass the part.
Simply select the part and choose Locators to Selection from the Trans-
port menu (or use the corresponding key command, by default [P]).

3. Make sure that the track holding the part is selected in 
the track list.

4. Select Merge MIDI in Loop.

5. In the dialog that opens, activate the desired effect op-
tions, make sure that Erase Destination is activated and 
click OK.
Now a new part is created on the same track, containing the processed 
events. The original part is deleted.

6. Turn off or reset all MIDI modifiers and effects, so that 
the track plays back as usual.

Dissolve Part
The Dissolve Part function on the MIDI menu allows you to 
separate MIDI events according to channels or pitches:

• When you work with MIDI parts (on MIDI channel “Any”) 
containing events on different MIDI channels, activate the 
“Separate Channels” option.

• To separate MIDI events according to pitch, activate the 
“Separate Pitches” option.
Typical examples are drum and percussion tracks, where different 
pitches usually correspond to separate drum sounds.

When dissolving a part into either separate channels 
or separate pitches, you can automatically remove the si-
lent (empty) areas of the resulting parts by activating the 
“Optimized Display” checkbox in the Dissolve Part dialog. 
This option is not available when “Dissolve to Sublanes” is 
activated, see “Dissolving to sublanes” on page 399.

Dissolving parts into separate channels
Setting a track to MIDI channel “Any” will cause each MIDI 
event to play back on its original MIDI channel, rather than 
a channel set for the whole track. There are two main situ-
ations when “Any” channel tracks are useful:

• When you record several MIDI channels at the same 
time.
You may for example have a MIDI keyboard with several keyboard zones, 
where each zone sends MIDI on a separate channel. Recording on an 
“Any” channel track allows you to play back the recording with different 
sounds for each zone (since the different MIDI notes play back on sepa-
rate MIDI channels).

• When you have imported a MIDI file of Type 0.
MIDI files of Type 0 contain only one track, with notes on up to 16 different 
MIDI channels. If you were to set this track to a specific MIDI channel, all 
notes in the MIDI file would be played back with the same sound; setting 
the track to “Any” will cause the imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on 
different MIDI channels and distributes the events into new 
parts on new tracks, one for each MIDI channel found. This 
allows you to work with each musical part individually.

Proceed as follows:

1. Select the parts containing MIDI data on different 
channels.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that opens, select the “Separate Chan-
nels” option.

Now, for each MIDI channel used in the selected parts, a 
new MIDI track is created and set to the corresponding 
MIDI channel. Each event is then copied into the part on 
the track with the corresponding MIDI channel. Finally, the 
original parts are muted.
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An example:

This part contains events on MIDI channels 1, 2, and 3.

Selecting “Dissolve Part” creates new parts on new tracks, set to 
channels 1, 2, and 3. Each new part contains only the events on the 
respective MIDI channel. The original MIDI part is muted.

Dissolving parts into separate pitches
The Dissolve Part function can also scan MIDI parts for 
events of different pitches, and distribute the events into 
new parts on new tracks, one for each pitch. This is useful 
when the different pitches are not used in a melodic con-
text, but rather for separating different sounds (e. g. MIDI 
drum tracks or sampler sound FX tracks). By dissolving 
such parts, you can work with each sound individually, on 
a separate track. 

Proceed as follows:

1. Select the parts containing MIDI data.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that opens, select the “Separate Pitches” 
option.
A new MIDI track is created for each used pitch in the selected parts. 
The events are then copied into the parts on the track for the corres-
ponding pitch. Finally, the original parts are muted.

Dissolving to sublanes
In the lower right section of the Dissolve Part dialog, you 
will find the “Dissolve to Sublanes” option. When this is 
activated, the part will not be dissolved onto different 
tracks but onto different sublanes of the original track, al-
lowing for a better management of MIDI material that “be-
longs together”.

This is useful when working with drums for example, as it al-
lows you to split up a part into different drum sounds and 
edit these independently. When you have made the desired 
modifications, you can reassemble all your drums into one 
part using the Bounce MIDI command, see below.

This option is especially handy when working with instru-
ment parts on instrument tracks. “Normal” dissolving would 
lead to a number of different tracks each routed to a sepa-
rate instance of the connected VST instrument. When dis-
solving parts to sublanes, the parts will still reside on the 
same track, with all parts using the same VST instrument in-
stance.

Bounce MIDI
With this function, you can combine MIDI parts on several 
lanes to a single MIDI part. This can be used to reassem-
ble a drum part that you dissolved onto several lanes for 
editing, see above. Simply select the MIDI parts on the dif-
ferent lanes that you want to combine and select “Bounce 
MIDI” on the MIDI menu.

During the bounce process, any muted parts will be re-
moved. If transpose and velocity values were specified for 
the parts, these are taken into account as well.

Repeat Loop
With this function, the events inside the independent track 
loops will be repeated until the end of the part, i. e. the 
notes that were previously only played repeatedly are now 
actual notes on the MIDI track. Events to the right of the 
independent track loop (within the same part) will be re-
placed by this function. For more information about inde-
pendent track loops, see “The independent track loop” on 
page 409.
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Other MIDI functions
The following items can be found on the Functions sub-
menu of the MIDI menu:

Legato
Extends each selected note so that it reaches the next 
note.

You can specify a gap or overlap for this function with the 
“Legato Overlap” setting in the Preferences dialog (Edit-
ing–MIDI page).

When using Legato with this setting, each note will be extended to end 
5 ticks before the next note.

When you activate “Legato Mode: Selected Only”, the 
length of the note will be adjusted so that it reaches the 
next selected note, allowing you, for example, to only apply 
Legato to your bass line (when playing on a keyboard).

Fixed Lengths

This function resizes all selected notes to the length set 
with the Length Quantize pop-up menu on the MIDI editor 
toolbar.

Delete Doubles
This function removes double notes, i. e. notes of the same 
pitch on the exact same position from the selected MIDI 
parts. Double notes can occur when recording in Cycle 
mode, after Quantizing, etc.

Delete Controllers
This function removes all MIDI controllers from the se-
lected MIDI parts.

Delete Continuous Controllers
This function removes all “continuous” MIDI controller 
events from the selected MIDI parts. Therefore, “on/off” 
events such as sustain pedal events are not removed.

Delete Notes
Allows you to delete very short or weak notes. This is use-
ful for automatically removing unwanted “ghost notes” af-
ter recording. Selecting “Delete Notes…” opens a dialog 
in which you set up the criteria for the function.

The parameters have the following functionality:

Minimum Length

When the Minimum Length checkbox is activated, the note 
length is taken into account, allowing you to remove short 
notes. You can either specify the minimum length (for notes 
to be kept) in the value field or by dragging the blue line in 
the graphical length display below.

• The graphical length display can correspond to 1/4 bar, 
one bar, two bars or four bars.
You change this setting by clicking in the field to the right of the display.

In this case, the whole length display corresponds to two bars, and the 
Minimum Length is set to 32nd notes (60 ticks).

! This function is only available from within the MIDI 
editors.
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Minimum Velocity

When the Minimum Velocity checkbox is activated, the ve-
locity of notes is taken into account, allowing you to re-
move weak notes. You specify the minimum velocity (for 
notes to be kept) in the value display.

Remove when under

This setting is only available when both Minimum Length 
and Minimum Velocity is activated. By clicking in this field, 
you select whether both the length and the velocity criteria 
must be met for notes to be deleted, or whether one of the 
criteria will suffice.

OK and Cancel

Clicking OK performs the automatic delete according to 
the rules set up. Clicking Cancel closes the dialog without 
deleting notes.

Restrict Polyphony
Selecting this item opens a dialog in which you can spec-
ify how many “voices” are used (for the selected notes or 
parts). Restricting the polyphony this way is useful when 
you have an instrument with limited polyphony and want to 
make sure all notes will be played. The effect is achieved 
by shortening notes as required, so that they end before 
the next note starts.

Pedals to Note Length
This function scans for Sustain pedal on/off events, length-
ens the affected notes to match the Sustain pedal off posi-
tion, and then removes the Sustain Controller on/off events.

Delete Overlaps (mono)
This function allows you to make sure that no notes of the 
same pitch overlap (i. e. that one starts before the other 
ends). Overlapping notes of the same pitch can confuse 
some MIDI instruments (a new Note On is transmitted be-
fore the Note Off is transmitted). This command can then 
be used to automatically solve the problem.

Delete Overlaps (poly)
This function shortens notes when required, so that no 
note begins before another ends. This happens regard-
less of which pitch the notes have.

Velocity
This function opens a dialog that allows you to manipulate 
the velocity of notes in various ways.

The following types of velocity processing are available:

Add/Subtract

This simply adds a fixed number to the existing velocity 
values. You set the value (positive or negative) with the 
Amount parameter.

Compress/Expand

Compresses or expands the “dynamic range” of MIDI notes 
by scaling the velocity values according to the Ratio setting 
(0–300 %). The principle behind this is that multiplying dif-
ferent velocity values with a factor higher than 1 (over 
100 %) will also make the differences between velocity val-
ues greater, while using a factor lower than 1 (under 100 %) 
will make the differences smaller. In short:

• To compress (“even out” velocity differences), use ratio 
values below 100 %.
After compression, you would probably want to add a velocity amount 
(with the Add/Subtract function) to maintain the average velocity level. 

• To expand (create greater difference in velocity), use ra-
tio values above 100 %.
Before you expand, you may want to adjust the velocity with the Add/
Subtract function, so that the average velocity is somewhere in the mid-
dle of the range. If the average velocity is high (near 127) or low (near 0), 
expansion will not work properly, simply because velocity values can only 
be between 0 and 127!

Limit

This function allows you to make sure that no velocity val-
ues fall outside a given range (the Lower and Upper val-
ues). Any velocity values outside this range are raised/
lowered to exactly the Lower/Upper values.
401
MIDI processing and quantizing



Fixed Velocity
This function sets the velocity of all selected notes to the 
Insert Velocity value on the toolbar in the MIDI editors.

Thin Out Data
Thins out MIDI data. Use this to ease the load on your ex-
ternal MIDI devices if you have recorded very dense con-
troller curves, etc. 

You can also manually thin out the controller data by using 
the quantize function in the Key Editor.

Extract MIDI Automation
This is an extremely useful function as it allows you to 
quickly and easily convert the continuous controllers of 
your recorded MIDI parts into MIDI track automation data, 
making them available for editing in the Project window. 
Proceed as follows:

1. Select the desired MIDI part containing the continu-
ous controller data.

2. Select “Extract MIDI Automation”. (This command is 
also available on the Key Editor context menu.)
The controller data will automatically be removed from the controller lane 
in the editor.

3. In the Project window, open the automation track(s) 
for the respective MIDI track. You will find that an automa-
tion track has been created for each of the continuous 
controllers in the part.

This function can only be used for continuous controllers. 
Data such as Aftertouch, Pitchbend, or SysEx cannot be 
converted to MIDI track automation data.

Remember that to be able to hear the automation data, 
you have to activate the Read button for the respective au-
tomation track(s).

MIDI controller automation is also affected by the Au-
tomation Merge Mode, see “MIDI controller automation” 
on page 261.

Reverse
This function inverts the order of the selected events (or of 
all events in the selected parts), causing the MIDI music to 
play backwards. Note that the effect is different from re-
versing an audio recording. With MIDI, the individual notes 
will still play as usual in the MIDI instrument – it is only the 
order of playback that is changed.

Merge Tempo from Tapping
This function allows you to create a complete tempo track 
based on your tapping, see the section “Merge Tempo 
From Tapping” on page 459.
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Introduction
There are several ways to edit MIDI in Nuendo. You can use 
the tools and functions in the Project window for large-
scale editing, or the functions on the MIDI menu to process 
MIDI parts in various ways (see “What is affected by the 
MIDI functions?” on page 392). For hands-on graphical ed-
iting of the contents of MIDI parts, you use the MIDI editors:

• The Key Editor is the default MIDI editor, presenting 
notes graphically in an intuitive piano roll-style grid.
The Key Editor also allows for detailed editing of non-note events such 
as MIDI controllers. For more information, see “The Key Editor – Over-
view” on page 406.

• The Score Editor (Nuendo Expansion Kit only) shows 
MIDI notes as a musical score and comes with advanced 
tools and functions for notation, layout and printing.

• The Drum Editor (Nuendo Expansion Kit only) is similar 
to the Key Editor, but takes advantage of the fact that with 
drum parts, each key corresponds to a separate drum 
sound. 

• The List Editor shows all events in the selected MIDI 
parts as a list, allowing you to view and edit their properties 
numerically. It also allows you to edit SysEx messages.
For more information, see “The List Editor – Overview” on page 424 and 
“Working with SysEx messages” on page 427.

• The Edit In-Place function allows you to edit MIDI parts 
directly in the Project window.
This is similar to working in the Key Editor, but makes it easier to edit MIDI 
in context with other track types, see “The In-Place Editor” on page 422.

• You can also edit MIDI in the Project Browser.
Like the List Editor, the Project browser shows the events in a list and al-
lows you to perform numerical editing. However, you will probably find 
the List Editor better suited for MIDI editing, since it has various dedi-
cated features and functions for this. The Project Browser is described in 
the chapter “The Project Browser” on page 464.

You can define each of the editors mentioned above 
as your default MIDI editor, see below. 

Please note that features that are identical in these editors 
will be described in the Key Editor section. The sections 
about the In-Place Editor (see “The In-Place Editor” on 
page 422) and the List Editor (see “The List Editor – 
Overview” on page 424) describe the specific features of 
these editors only.

Opening a MIDI editor
There are two ways to open a MIDI editor:

• Select one or several parts (or a MIDI track, with no parts 
selected), pull down the MIDI menu and select Open Key 
Editor, Open Score Editor (Nuendo Expansion Kit only), 
Open Drum Editor (Nuendo Expansion Kit only), Open List 
Editor or Open In-Place Editor (or use the corresponding 
key command).
The selected parts (or all parts on the track, if no part was selected) will 
open in the chosen editor.

• Double-click a part to open it in the default editor.
Which editor opens depends on the Default Edit Action setting in the 
Preferences dialog (Event Display–MIDI page).

Nuendo Expansion Kit only: If the “Edit as Drums when 
Drum Map is assigned” option is activated and a drum 
map is selected for the edited track, the Drum Editor will 
open. This way you can double-click to open the Key Edi-
tor (or the Score Editor, List or In-Place Editor, depending 
on your preferences) but drum tracks will automatically 
open in the Drum Editor.

If the part you open for editing is a shared copy, any 
editing you perform will affect all shared copies of this 
part. Shared copies are created by pressing [Alt]/[Op-
tion]-[Shift] and dragging, or by using the Repeat function 
with the “Shared copies” option activated. In the Project 
window, shared copies are indicated by the part name in 
italics and an icon in the bottom right corner of the part.
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Handling several parts
When you open a MIDI editor with several parts (or a MIDI 
track containing several parts) selected, you might find it 
somewhat hard to get an overview of the different parts 
when editing.

For such cases the editor toolbar features a few functions 
to make working with multiple parts easier and more com-
prehensive:

• The Part List menu lists all parts that were selected when 
you opened the editor (or all parts on the track if no parts 
were selected), and lets you select which part is active for 
editing.
When you select a part from the list, it is automatically made active and 
centered in the note display.

Note that it is also possible to activate a part by select-
ing an event within this part with the Arrow tool.

• The button “Edit Active Part Only” lets you restrict edit-
ing operations to the active part only.
For example, if you select “All” from the Select submenu of the Edit menu 
with this option activated, only events in the active part will be selected. 
Similarly, if you select notes by dragging with the Arrow tool (making a 
selection rectangle), only the notes in the active part will be selected.

“Edit Active Part Only” is activated on the toolbar.

• You can zoom in on the active part so that it fills the 
screen by selecting “Zoom to Event” from the Zoom sub-
menu of the Edit menu.

• The button “Show Part Borders” can be used if you 
want to see clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, 
making the borders easily discernible. In the Key Editor, there are also two 
“markers” in the ruler with the name of the active part, marking its begin-
ning and end. These can be moved freely to change the size of the part.

“Show Part Borders” is activated on the toolbar.

• It is possible to cycle between parts (making them ac-
tive) using key commands.
In the Key Commands dialog – Edit category, you will find two functions for 
this: “Activate Next Part” and “Activate Previous Part”. If you assign key 
commands to these, you can use them to cycle between parts in the edi-
tors. For further information, see “Setting up key commands” on page 581.
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The Key Editor – Overview 

The toolbar
The toolbar contains tools and various settings for the Key 
Editor. The following toolbar elements are available:

You can show/hide most of the toolbar elements (ex-
cept for the “Set up Window Layout”, Solo Editor, and 
Acoustic Feedback buttons, which are always visible) by 
activating/deactivating the corresponding options on the 
context menu.

You can specify which toolbar items are shown and 
store/recall different toolbar configurations, see “Using 
the Setup options” on page 572.

Toolbar

Info line

Note 
display

Controller 
display

Ruler

Status line

Option Description

Set up Window 
Layout

Clicking this allows you to show/hide the status line and 
info line for the editor. This button is always available on 
the toolbar.

Solo Editor This is described in the section “The Solo Editor but-
ton” on page 409. This control is always available on 
the toolbar.

Acoustic Feed-
back

This is described in the section “Acoustic Feedback” on 
page 410. This control is always available on the toolbar.

Auto-Scroll This button activates/deactivates Auto-Scroll for the 
Key Editor, see “Auto-Scroll” on page 409.

Tool buttons These are the tools used for editing in the Key Editor.

Independent 
Track Loop

This button activates/deactivates the independent track 
loop, see “The independent track loop” on page 409.

Auto Select 
Controllers

Use this button to also select all available controller 
data for a note when selecting the note in the editor.

Part List The Part List allows you to switch between several se-
lected parts when working in the Key Editor, see “Han-
dling several parts” on page 405.

Indicate 
Transpositions

When this is activated, MIDI notes are displayed ac-
cording to their transposition settings, see “Indicate 
Transpositions” on page 133.

Insert Velocity Use this field to specify a velocity value for any notes 
that are entered in the editor.

Nudge Palette The Nudge buttons allow you to move or trim elements 
in the editor, see “Moving and transposing notes” on 
page 413.

Transpose 
Palette

The transpose buttons allow you to transpose the se-
lected notes, see “Moving and transposing notes” on 
page 413.

Snap/Quantize The Snap controls are described in the section “The 
Snap function” on page 48 and the quantize functions in 
the chapter “MIDI processing and quantizing” on page 
391.

Step/MIDI Input These controls are described in the sections “Editing 
notes via MIDI” on page 416 and “Step input” on page 
416.

Event Colors The Color options are described in the section “Color-
ing notes and events” on page 410.

Edit VST 
Instrument

This button opens the VST Instrument panel (if the track 
is routed to a VST instrument).

Option Description
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The status line
The status line is displayed below the toolbar in the Key 
Editor.

It displays the following information:

• To show or hide the status line, click the “Set up Win-
dow Layout” button on the toolbar and activate or deacti-
vate the Status Line option.

The info line

The info line shows information about the selected MIDI 
note. If several notes are selected, the values for the first 
note are displayed (in color). You can edit all values on the 
info line using regular value editing (see “Editing on the 
info line” on page 415 for details). Length and position 
values are displayed in the format currently selected for 
the ruler (see below).

• To show or hide the info line, click the “Set up Window 
Layout” button on the toolbar and activate or deactivate 
the Info Line option.

The ruler
The ruler shows the timeline, by default in the display format 
selected on the Transport panel. You can select a separate 
format for a MIDI editor ruler on the Ruler pop-up menu, 
opened by clicking the arrow button to the right of it. For a 
list of the available formats, see “The ruler” on page 47.

At the bottom of the pop-up menu, there are two addi-
tional items:

• If “Time Linear” is selected, the ruler, note display, and 
controller display will be linear in relation to time.
This means that if the ruler shows bars and beats, the distance between 
the bar lines will vary depending on the tempo.

• If “Bars+Beats Linear” is selected, the ruler, note display, 
and controller display will be linear in relation to tempo.
This means that if the ruler shows bars and beats, the distance between 
beats will be constant.

In most cases, you would set the display format to 
“Bars+Beats” and “Bars+Beats Linear” mode when 
editing MIDI.

The note display

The note display is the main area in the Key Editor. It con-
tains a grid in which MIDI notes are shown as boxes. The 
width of a box corresponds to the note length, and the 
vertical position of a box corresponds to the note number 
(pitch), with higher notes higher up in the grid. The piano 
keyboard to the left serves as a guide for finding the right 
note number. 

For a description of how to display colors in the note dis-
play, see “Coloring notes and events” on page 410.

Option Description

Mouse Time 
Position

This displays the exact time position of the mouse pointer, 
in the format selected for the ruler, allowing you to perform 
editing or to insert notes at exact positions.

Mouse Note 
Position

This displays the exact pitch of the mouse pointer posi-
tion, making it easier to find the right pitch when entering 
or transposing notes.

Current Chord 
Display

When the project cursor is positioned over notes making 
up a chord, this chord is displayed here.
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The controller display

The area at the bottom of the Key Editor window is the 
controller display. This consists of one or several control-
ler lanes, each showing one of the following properties or 
event types:

• Velocity values of the notes
• Pitchbend events
• Aftertouch events
• Poly Pressure events
• Program Change events
• SysEx events
• Articulations (see the chapter “VST Expression” in the Nuendo 

Expansion Kit manual).
• Any type of continuous controller event (see “Editing continu-

ous controllers on the controller lane” on page 421)

To change the size of the controller display, drag the di-
vider between the controller display and the note display. 
This will make the controller display larger and the note 
display smaller, or vice versa.

Velocity values are shown as vertical bars in the controller 
display, with higher bars corresponding to higher velocity 
values.

Each velocity bar corresponds to a note in the note display.

Events other than velocity values are shown as blocks, the 
heights of which correspond to the values of the events. 
The beginning of an event is marked by a curve point. To 
select an event, click on the curve point, so that it turns red.

Unlike notes, events in the controller display have no 
length. The value of an event in the display is “valid” until 
the start of the next event.

For a description of editing in the controller display, see 
“Editing in the controller display” on page 417.

Key Editor operations

Zooming
Zooming in the Key Editor is done according to the stan-
dard zoom procedures, using the zoom sliders, the Zoom 
tool or the Zoom submenu of the Edit menu.

• When you drag a rectangle with the Zoom tool, the result 
depends on the “Zoom Tool Standard Mode: Horizontal 
Zooming Only” option in the Preferences dialog (Editing–
Tools page).
If this is activated, the window will only be zoomed horizontally; if not, the 
window will be zoomed both horizontally and vertically.

Using the Trim tool
The Trim tool allows you to change the length of note 
events by cutting off the end or the beginning of notes. It 
is available in the Key Editor and in the List Editor.

Using the Trim tool means moving the note-on or the note-
off event for one or several notes to a position defined with 
the mouse. Proceed as follows:

1. Select the Trim tool on the toolbar.
The mouse pointer changes to a knife symbol.

2. Locate the notes that you wish to edit.

3. To edit a single note, click on it with the Trim tool. The 
range between the mouse pointer and the end of the note 
will be removed.
You can use the mouse note info on the status line to find the exact po-
sition for the trim operation.
408
The MIDI editors



4. To edit several notes, click and drag with the mouse 
across the notes.
A line is displayed. The notes will be trimmed along this line.

Trimming the end of three note events.

• By default, the Trim tool will cut off the end of notes. To 
trim the beginning of the note(s), press [Alt]/[Option] while 
dragging.

• If you press [Ctrl]/[Command] while dragging, you will 
get a vertical trim line, allowing you to set the same start or 
end time for all edited notes.

You can change the Trim tool key commands in the Pref-
erences dialog (Editing–Tool Modifiers page).

Note that when you trim the beginning of a note in the 
List Editor, the note may move to a different position in the 
list (since other events may now begin before the edited 
event).

Note that the trimmed note ends or starts do not snap 
to the grid.

Playing back
You can play back your music as usual when working in a 
MIDI editor. There are several features designed to make 
editing easier during playback.

The Solo Editor button

If you activate the Solo Editor button, only the edited MIDI 
parts will be heard during regular playback.

Auto-Scroll

As described in the section “Auto-Scroll” on page 50, the 
Auto-Scroll function makes the window “follow” the project 
cursor during playback, so that the current play position is 

visible at all times. However, when you are working in a 
MIDI editor, you may want to deactivate Auto-Scroll – this 
way, the events you are working with will stay visible.

The Auto-Scroll buttons in each MIDI editor are indepen-
dent of the Project window Auto-Scroll setting, which 
means that Auto-Scroll can be activated in the Project win-
dow and deactivated in the MIDI editor you are working in.

The independent track loop

The independent track loop is a sort of “mini-cycle”, affect-
ing only the MIDI part being edited. When the loop is acti-
vated, the MIDI events within the loop will be repeated 
continuously and completely independent – other events 
(on other tracks) will be played back as usual. The only “in-
teraction” between the loop and the “regular playback” is 
that every time the cycle starts over again, so does the loop.

To set up the independent track loop, proceed as follows:

1. Activate the loop by clicking on the Loop button on the 
toolbar.
If it is not visible, right-click the toolbar and add the Independent Track 
Loop Settings section – see “Using the Setup options” on page 572.

When the loop is activated, the cycle is not shown in the 
ruler. 

2. Now you need to specify the length of the loop. You 
have the following possibilities:

• [Ctrl]/[Command]-click and [Alt]/[Option]-click in the 
ruler to set the start and end of the loop, respectively.

• Click and drag in the upper part of the ruler to move the 
locators to the desired positions.

The independent track loop is indicated in purple in the 
ruler. When the corresponding options are activated on 
the context menu, the track loop start and end are also 
displayed in the Status line.

The MIDI events will be looped as long as the Loop 
button is activated and the MIDI editor window is open.

To turn the loop into actual MIDI notes, use the Repeat 
Loop function on the MIDI menu, see “Repeat Loop” on 
page 399.
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Acoustic Feedback

If the speaker icon on the toolbar is activated, individual 
notes will automatically be played back (auditioned) when 
you move or transpose them, or when you create new notes 
by drawing. This makes it easier to hear what you’re doing.

In the Preferences dialog (MIDI page), you can specify 
whether the Acoustic Feedback function takes into account 
any MIDI sends or inserts used for the track. Activate the 
“Audition through MIDI Inserts/Sends” option if you want 
the layering of MIDI instruments (by MIDI sends) to be ac-
tive within the MIDI editors as well. This way, the acoustic 
feedback of the editors sends the MIDI data not only to the 
output selected for the track, but additionally through any 
MIDI inserts and MIDI sends assigned to it. Note, however, 
that this also means that the MIDI events will be sent 
through any MIDI plug-ins assigned to this track.

Snap

The Snap function helps you find exact positions when 
editing in a MIDI editor. It does this by restricting horizon-
tal movement and positioning to certain positions. Opera-
tions affected by snap include moving, duplicating, 
drawing, sizing, etc.

• How Snap works depends on the Snap Type pop-up 
menu next to the Snap button.
See “The Snap function” on page 48.

• When the “Bars+Beats” display format is selected in 
the ruler, the snap grid is set by the Quantize value on the 
toolbar.
This makes it possible to snap not only to straight note values but also to 
swing grids set up in the Quantize Setup dialog (see “The quantizing 
functions” on page 392).

When any of the other display formats is selected in the 
ruler, positioning is restricted to the displayed grid, i. e. you 
can snap in finer increments by zooming in, and in coarser 
increments by zooming out the display.

Coloring notes and events
By using the Event Colors pop-up menu on the toolbar, 
you can select a color scheme for the events in the editor. 
The following options are available:

For all of the options except “Part” the pop-up menu also 
contains a “Setup…” option. This option opens a dialog in 
which you can specify the colors that are associated with 
which velocities, pitches, or channels, respectively.

Creating and editing notes
To draw in new notes in the Key Editor, you use the Pencil 
tool or the Line tool.

Drawing notes with the Pencil tool

With the Pencil tool, you insert single notes by clicking at 
the desired time (horizontal) and pitch position (vertical).

• When you move the pointer in the note display, its bar 
position is indicated on the status line, and its pitch is indi-
cated both on the status line and on the piano keyboard to 
the left.
This makes it easy to find the right note and insert position. For a descrip-
tion of how to show the status line, see “The status line” on page 407.

Option Description

Velocity The notes get different colors depending on their velocity 
values.

Pitch The notes get different colors depending on their pitch.

Channel The notes get different colors depending on their MIDI 
channel value.

Part The notes get the same color as their respective part in 
the Project window. Use this option when you are work-
ing with two or more tracks in an editor, to make it easier 
to see which notes belong to which track.

GridMatch The notes get different colors depending on their time 
position. For example, this mode makes it easy to see if 
the notes in a chord start at the exact same beat.
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• If Snap is activated, this determines the start position of 
the created note.

• If you click once, the created note will have the length 
set on the Length Quantize pop-up menu on the toolbar.
You can create a longer note by clicking and dragging. The length of the 
created note will be a multiple of the Length Quantize value.

Drawing notes with the Line tool

The Line tool can be used for creating series of contiguous 
notes. To do so, click and drag to draw a line and then re-
lease the mouse button.

To determine another mode for the Line tool you can 
click on the Line tool and click again to open a pop-up 
menu where you can select the desired option.

The button will change appearance according to the se-
lected mode.

Setting velocity values

When you draw notes in the Key Editor, the notes will get 
the velocity value set in the insert velocity field on the tool-
bar.

You can use one of four different methods for determining 
the velocity:

• When a tool modifier is assigned for the Select tool–
Edit Velocity action (in the Preferences dialog, Editing–
Tool Modifiers page), you can select one or more notes, 
press the modifier and click on one of the selected notes 
to change the velocity. 
The cursor changes into a speaker and, next to the note, a field with the ve-
locity value appears – the Note Velocity slider. Move the mouse pointer up 
or down to change the value. Value changes will be applied to all selected 
notes, as you can see in the controller lane. 

• Selecting a predefined velocity value from the insert ve-
locity pop-up menu.
The menu contains five different predefined velocity values. The “Setup…” 
item opens a dialog that allows you to specify which five velocity values are 
available on the pop-up menu. (This dialog can also be opened by select-
ing “Insert Velocities…” from the MIDI menu.)

• Manually entering the desired velocity value by clicking 
in the insert velocity field and typing in the desired value.

• Using a key command.
You can assign a key command to each of the five available velocity val-
ues in the Key Commands dialog (MIDI category – the items Insert Ve-
locity 1–5). This allows for quick switching between different velocity 
values when entering notes. See “Setting up key commands” on page 
581 for instructions on how to set up key commands.

Mode Description

Line This is the default mode for the Line tool. When this mode 
is selected, you click and drag to create a straight line, in 
any angle. When you release the mouse button a series 
of notes will be created, aligned with the line. If Snap is 
activated, the notes will be spaced and sized according 
to the Quantize value.

Parabola, Sine, 
Triangle, 
Square

These modes insert events along different curve shapes. 
While they can be used for creating notes, they are prob-
ably best suited for controller editing (see “Adding and 
editing events in the controller display” on page 419).

Paint Allows you to insert multiple notes by dragging with the 
mouse button pressed. If Snap is activated, the notes will 
be positioned and sized according to the Quantize and 
Length Quantize values. If you press [Ctrl]/[Command] 
while painting, movement will be restricted to horizontal 
(i. e. the painted notes will have the same pitch).
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Selecting notes

Selecting notes is done using any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply, like selecting by clicking on the 
note or using a selection rectangle. Note that when you press [Shift] and 
click on notes or draw a selection rectangle, these notes will be added to 
the overall selection. When you press [Ctrl]/[Command] and click on notes 
or draw a selection rectangle, these notes will be removed from the overall 
selection (standard Windows behavior).

• Use the Select submenu of the Edit menu or context 
menu.
The Select menu options are:

• You can also use the left and right arrow keys on the 
computer keyboard to step from one note to another.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several notes.

• To select all notes of a certain pitch, press [Ctrl]/[Com-
mand] and click on the desired key in the keyboard display 
to the left.

You can also press [Shift] and double-click on a note to select all the fol-
lowing notes of the same pitch – or use the Equal Pitch functions on the 
Select submenu.

• If the “Auto Select Events under Cursor” option is acti-
vated in the Preferences dialog (Editing page), all notes 
“touched” by the project cursor are automatically selected.

Toggle selections

If you want to toggle the selected elements within a selec-
tion rectangle, press [Ctrl]/[Command] and enclose the 
same elements within a new selection rectangle. Once 
you release the mouse button, the previous selection is 
deselected and vice versa.

Selecting controllers within the note range

You can select the controllers within the range of the se-
lected notes. The following applies:

• When the Auto Select Controllers button is activated 
on the toolbar, the controllers will always be selected 
when the respective notes are selected.

• When you select “Select Controllers in Note Range” on 
the Select submenu of the Edit menu, the controllers within 
the note range (i. e. between the first/leftmost and last/right-
most note) will be selected.
Please note that for this to work, only two notes have to be selected. All 
controllers within this range will be selected.

• A note range lasts until the start of the next note or the 
end of the part. 

• Selected controllers for notes are moved when the cor-
responding notes are moved.

Option Description

All Selects all notes in the edited part.

None Deselects all events.

Invert Inverts the selection – all selected events are deselected 
and all notes that were not selected are selected instead.

In Loop Selects all notes that are partially or completely inside the 
boundaries of the left and right locators (only visible if lo-
cators are set).

From Start  
to Cursor

Selects all notes that begin to the left of the project cur-
sor.

From Cursor  
to End

Selects all notes that end to the right of the project cur-
sor.

Equal Pitch –  
all Octaves

This function requires that a single note is selected. It se-
lects all notes of this part that have the same pitch (in any 
octave) as the currently selected note.

Equal Pitch –  
same Octave

As above, but selects notes of the exact same pitch only 
(same octave).

Select Con-
trollers in Note 
Range

Selects the MIDI controller data within range of the se-
lected notes, see below.

All notes of the 
corresponding pitch 
are selected.
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Moving and transposing notes

To move notes in the editor, use any of the following me-
thods:

• Select the notes and use the buttons on the transpose 
palette on the toolbar.

• Click and drag to a new position.
All selected notes will be moved, maintaining their relative positions. If 
Snap is activated, this determines to which positions you can move the 
notes, see “Snap” on page 410.

• Use the up and down arrow keys on the computer key-
board.
This method allows you to transpose the selected notes, without risking to 
move them horizontally. You can also use the Transpose function (see 
“Transpose” on page 396) for this. Note that pressing [Shift] and using the 
up and down arrow keys will transpose notes in steps of one octave. 
Transpose is also affected by the global transpose setting, see “The trans-
pose functions” on page 129.

• Use the Move to Cursor function on the Edit menu.
This moves the selected notes to the project cursor position.

• Select a note and adjust its position or pitch on the info 
line.
See “Editing on the info line” on page 415.

• Use the Move buttons in the Nudge palette on the tool-
bar.
This moves the selected note(s) by the amount set on the Quantize pop-
up menu.  
By default, the Nudge palette is not shown on the toolbar – see “Using 
the Setup options” on page 572 for more information.

Note that when you move selected notes to a different 
position, any selected controllers for these notes will move 
accordingly. For further information, see also “Moving and 
copying events” on page 420.

You can also adjust the position of notes by quantizing 
(see “The quantizing functions” on page 392).

Duplicating and repeating notes

Notes are duplicated much in the same way as events in 
the Project window:

• Hold down [Alt]/[Option] and drag the note(s) to a new 
position.
If Snap is activated, this determines to which positions you can copy 
notes (see “Snap” on page 410).

• Selecting Duplicate from the Edit menu creates a copy 
of the selected note and places it directly after the original.
If several notes are selected, all of these are copied “as one unit”, main-
taining the relative distance between the notes.

• Selecting “Repeat…” from the Edit menu opens a dia-
log, allowing you to create a number of copies of the se-
lected note(s).
This works like the Duplicate function, but you can specify the number of 
copies.

• You can also perform the Repeat function by dragging: 
Select the note(s) to repeat, press [Alt]/[Option], click the 
right edge of the last selected note and drag to the right.
The longer to the right you drag, the more copies are created (as indicated 
by the tooltip).

! Note also that you can restrict movement to horizon-
tal or vertical only by holding down [Ctrl]/[Command] 
while dragging.
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Using cut and paste

You can use the Cut, Copy and Paste options on the Edit 
menu to move or copy material within a part or between 
different parts. When you paste copied notes, you can ei-
ther use the regular Paste function or the function “Paste 
Time” from the Range submenu of the Edit menu.

• “Paste” inserts the copied notes at the project cursor position 
without affecting existing notes.

• “Paste Time” inserts at the project cursor position, but moves 
(and if necessary, splits) existing notes to make room for the 
pasted notes.

Resizing notes

To resize a note, use one of the following methods:

• Position the arrow tool at the start or end of the note, so 
that the pointer takes on the shape of a small double ar-
row. Click and drag to the left or right to resize the note.
This method allows you to resize the note from either direction.

• Click with the Pencil tool within the note box and drag 
to the left or the right (to make the note shorter or longer, 
respectively).

With both these methods, the resulting length will be a 
multiple of the Length Quantize value on the toolbar.

• Use the Trim Start/End buttons on the Nudge palette on 
the toolbar.
This resizes the selected note(s) by moving their start or end positions, in 
steps according to the Length Quantize value on the toolbar. By default, 
the Nudge palette is not shown on the toolbar – see “Using the Setup 
options” on page 572 for more information.

• Select the note and adjust its length on the info line.
See “Editing on the info line” on page 415 for details on info line editing.

• Use the Trim tool, see “Using the Trim tool” on page 408.

Splitting notes

There are three ways to split notes:

• Clicking on a note with the Scissors tool splits the note 
at the position you pointed (taking the Snap setting into 
account if activated).
If several notes are selected, they are all split at the same position.

• If you select “Split at Cursor” from the Edit menu, all 
notes that are intersected by the project cursor are split at 
the cursor position.

• If you select “Split Loop” from the Edit menu, all notes 
that are intersected by the left or right locator are split at 
the locator positions.

Gluing notes

Clicking on a note with the Glue Tube tool will “glue it to-
gether” with the next note of the same pitch. The result will 
be one long note spanning from the start of the first note 
to the end of the second note and with the properties (ve-
locity, etc.) of the first note.

Muting notes

Individual notes can be muted in the Key Editor, as op-
posed to muting an entire MIDI part in the Project window. 
This allows you to exclude notes from playback, but keep 
the option to bring them back again at any time. To mute a 
note, use one of the following methods:

• Click on it with the Mute tool.

• Drag a rectangle with the Mute tool, enclosing all notes 
you want to mute.

• Select the note(s) and choose Mute from the Edit menu. 
The default key command for this is [Shift]-[M].

Muted notes are “dimmed” in the note display.

To unmute a note, either click it or enclose it with the Mute 
tool, or select it and choose Unmute from the Edit menu. 
The default key command for this is [Shift]-[U].

Selecting “Paste Time” with this data on the clipboard 
and the project cursor here…

…will give you this.
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Deleting notes

To delete notes, either click on them with the Erase tool or 
select them and press [Backspace].

Editing on the info line
The info line shows the values and properties of the se-
lected events. If a single event is selected, its values are 
displayed on the info line. If several events are selected, 
the info line shows the values of the first of these events 
(in color).

You can edit the values on the info line using regular value 
editing. This allows you to move, resize, transpose or 
change velocity of events in a very precise manner. It is 
also possible to click in the Pitch or Velocity field in the 
info line and play a note on your MIDI keyboard – the pitch 
or velocity will be adjusted accordingly.

If you have several events selected and change a value, 
all selected events will be changed by the set amount.

If you have several events selected, hold down [Ctrl]/
[Command] and change a value, the change will be abso-
lute. In other words, the value setting will be the same for 
all selected events.

How the Key Editor handles drum maps 
(Nuendo Expansion Kit only)
When a drum map is assigned to a MIDI or instrument 
track (see the chapter “Editing Drums” in the NEK man-
ual), the Key Editor will display the drum sound names as 
defined by the drum map.

In Nuendo, the name of the drum sound is displayed in the 
following locations:

This allows you to use the Key Editor for drum editing, e. g. 
when editing drum note lengths (which may be necessary 
for some external instruments) or when editing several 
parts, to identify drum events.

In the info line, in the 
Pitch field.

In the event itself (provided that the 
zoom factor is high enough).

When dragging a note.

In the status line, in the Mouse 
Note Position field.
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How the Key Editor handles expression maps 
(Nuendo Expansion Kit only)
When an expression map is assigned to a MIDI track (see 
the chapter “VST Expression” in the NEK manual), the mu-
sical articulations defined for that map are displayed in the 
following locations of the Key Editor:

For more information, see the chapter “VST Expression” in 
the Nuendo Expansion Kit manual.

Editing notes via MIDI
You can change the properties of notes via MIDI. For ex-
ample, this can be a fast way to get the right velocity value, 
since you will hear the result even as you edit:

1. Select the note you want to edit.

2. Click the MIDI Input button on the toolbar to enable 
editing via MIDI.

3. Use the note buttons on the toolbar to decide which 
properties are changed by the MIDI input.
You can enable editing of pitch, note-on and/or note-off velocity.

With this setting, the edited notes will get the pitch and velocity values 
of the notes input via MIDI, but the note-off velocities will be kept as 
they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will get the pitch, velocity and/or note-off 
velocity of the played note.

The next note in the edited part is automatically selected, 
making it easy to quickly edit a series of notes.

• If you want another try, select the note again (e. g. by 
pressing the left arrow key on the computer keyboard) and 
again play a note on your MIDI instrument.

Step input
Step input, or step recording, is when you enter notes one 
at a time (or one chord at a time) without worrying about 
the exact timing. This is useful, for example, when you 
know the part you want to record but are not able to play it 
exactly as you want it.

Proceed as follows:

1. Click the Step Input button on the toolbar to activate 
Step Input mode.

2. Use the note buttons to the right to decide which 
properties are included when you input the notes.
For example, you may not want to include the velocity and/or note-off ve-
locity of the played notes. It is also possible to turn off the pitch property, 
in which case all notes will get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start po-
sition (the desired position of the first note or chord).
The step input position is shown as a blue line in the note display.

4. Specify the desired note spacing and length with the 
Quantize and Length Quantize pop-up menus.
The notes you input will be positioned according to the Quantize value 
and have the length set with the Length Quantize value. For instance, if 
you set Quantize to 1/8 notes and Length Quantize to 1/16 note, the 
notes will be sixteenth notes, appearing on each eighth note position.

In the info line.

In the event itself if the vertical zoom factor is high 
enough. If the horizontal zoom factor is high enough, 
the attribute description is also shown.

In the 
controller 

lane.
416
The MIDI editors



5. Play the first note or chord on your MIDI instrument.
The note or chord appears in the editor and the step input position ad-
vances one quantize value step.

If Move Insert Mode is activated, all notes to the right 
of the step input position will be moved to “make room” for 
the inserted note or chord.

Move Insert Mode is activated.

6. Continue in the same way with the rest of the notes or 
chords.
You can adjust the Quantize or Length Quantize value as you go along, 
to change the timing or note lengths. You can also move the step input 
position manually by clicking anywhere in the note display.

• To insert a “rest”, press the right arrow key on the com-
puter keyboard.
This advances the step input position one step.

7. When you are done, click the Step Input button again 
to deactivate step input.

Editing in the controller display

About controller lanes

By default, the controller display has a single lane, show-
ing one event type at a time. However, you can add lanes 
by clicking the “+” button or by opening the context menu 
and selecting “Create New Controller Lane”. The use of 
several controller lanes allows you to view and edit differ-
ent controllers at the same time.

The controller display with three lanes set up

• To remove a lane, click on the “-” sign or open the con-
text menu and select “Remove this Lane”.
This hides the lane from view – it does not affect the events in any way.

• If you remove all lanes, the controller display will be 
completely hidden.
To bring it back again, select “Create New Controller Lane” from the 
context menu.

• Editing the events in the controller display is much like 
editing automation data on an automation track in the 
Project window (except for velocity values, see “Editing 
velocity values” on page 418).

Selecting the event type

Each controller lane shows one event type at a time. To 
select which type is displayed, use the event type pop-up 
menu to the left of the lane.

• Selecting “Setup…” opens a dialog in which you can 
specify which continuous controller event types are avail-
able on the pop-up menu.

Controller types in this list are 
already listed on the pop-up 
menu.

Controller types in this list are 
not listed on the pop-up menu.

Click this button to add the 
selected controller type to the 
pop-up menu.

Click this button to remove the 
controller type selected in the left 
list from the pop-up menu.
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• Each MIDI track has its own controller lane setup (num-
ber of lanes and selected event types). 
When you create new tracks, they get the controller lane setup used last.

Controller lane presets

Once you have added the required number of controller 
lanes and selected the event types you need, you can 
store this combination as a controller lane preset. For ex-
ample, you can have a preset with one velocity lane only, 
another with a combination of velocity, pitchbend and 
modulation, and so on. This can make working with con-
trollers much quicker.

• To add the current controller lane setup as a preset, pull 
down the pop-up menu to the left of the horizontal scroll-
bar and select “Add”.
A dialog opens, where you can enter a name for the preset.

• To apply a stored preset, select it from the pop-up 
menu.
This immediately brings up the controller lanes and event types in the 
preset.

• To remove or rename presets, select “Organize…” from 
the pop-up menu.

Editing velocity values

When “Velocity” is selected, the lane shows the velocity of 
each note as a vertical bar.

Velocity values are edited with the Pencil or the Line tool. 
The different tools and Line tool modes offer several pos-
sibilities, as listed below:

The Arrow tool automatically switches to the Pencil 
tool when you move the pointer into the controller display. 
If you want to use the Arrow tool to select events in the 
controller display, press [Alt]/[Option].

If the Speaker icon (Acoustic Feedback) is activated 
on the toolbar, the notes will be played back when you ad-
just the velocity, allowing you to audition your changes.

• You can use the Pencil tool to change the velocity of a 
single note: click on its velocity bar and drag the bar up or 
down.
While you drag, the current velocity value is shown in the display to the left.

• You can use the Pencil tool or the Line tool in Paint 
mode to change the velocity values of several notes by 
painting a “freehand curve”.
When editing velocity, these two methods have the same functionality.

• Use the Line tool in Line mode for creating linear veloc-
ity ramps.
Click where you want the ramp to start and drag the cursor to where you 
want the ramp to end. When you release the mouse button, the velocity 
values are aligned with the line between the two points.

• Parabola mode works in the same way, but aligns the 
velocity values to a Parabola curve instead.
Use this for smooth, “natural” velocity fades, etc.
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• The remaining three Line tool modes (Sine, Triangle and 
Square) align the velocity values to continuous curve 
shapes (see below).

If there is more than one note at the same position 
(e. g. a chord), their velocity bars will overlap in the control-
ler lane. If none of the notes are selected, all notes at the 
same position will be set to the same velocity value when 
you draw. To edit the velocity of only one of the notes at 
the same position, first select the note in the note display. 
Now, editing will only affect the velocity of the selected 
note.

You can also adjust the velocity of a single note by select-
ing it and changing its velocity value on the info line.

Editing articulations (Nuendo Expansion Kit only)

It is also possible to add and edit musical expressions or 
articulations in the controller lane. This is described in de-
tail in the chapter “VST Expression” in the Nuendo Expan-
sion Kit manual.

Adding and editing events in the controller display

When any option other than “Velocity” is selected for a 
controller lane, you can create new events or edit the val-
ues of existing events using the Pencil tool or the Line tool 
in its various modes:

• Click with the Pencil tool or the Line tool in Paint mode 
to create a new event.

• Press [Alt]/[Option] and use the Pencil tool or the Line 
tool in Paint mode to modify the value of an event (without 
creating a new one).
Note that you can click and drag to change or add multiple events, draw 
controller curves, etc. You can press or release [Alt]/[Option] while draw-
ing, switching dynamically between “edit mode” and “create mode”.

If you want to enter or adjust a single event, click once 
with the Pencil tool or the Line tool in Paint mode.

If you want to “paint a curve”, drag with the tool in the con-
troller lane (keeping the mouse button pressed):

With the Pencil tool and the Line tool in Paint mode, the 
quantize value determines the “density” of created control-
ler curves (if Snap is activated, see “Snap” on page 410). 
For very smooth curves, use a small quantize value or turn 
off Snap. However, this will create a very large number of 
MIDI events, which can cause MIDI playback to “stutter” in 
some situations. A medium-low density is often sufficient.

• Clicking and dragging with the Line tool in Line mode 
shows a line in the controller lane, and creates events with 
values aligned to this line.
This is the best way to draw linear controller ramps. If you press [Alt]/
[Option], no new events are created – use this mode for modifying exist-
ing controller curves.

When you move the pointer in the controller lane, the corresponding 
value is displayed in this field.

Converting a controller curve to a ramp using the 
Line tool.
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• The Parabola mode works in the same way, but aligns 
the values to a parabola curve instead, giving more “natu-
ral” curves and fades.
Note that the result depends on the direction from which you draw the 
parabola.

• In Parabola mode, you can use modifier keys to deter-
mine the shape of the parabola curve.
If you press [Ctrl]/[Command], the parabola curve will be reversed. If you 
press [Alt]/[Option]-[Ctrl]/[Command] while Snap is activated, you can 
change the position of the whole curve (in both cases the snap value for 
the positioning will be a quarter of the quantize value). If you press [Shift], 
the exponent will be increased or decreased.

In Line and Parabola modes, the length quantize value 
determines the “density” of created controller curves (if 
Snap is activated). For very smooth curves, use a small 
length quantize value or turn off Snap. To avoid over-
dense controller curves (which may cause MIDI playback 
to “stutter”), use a medium-low density.

• The Sine, Triangle and Square modes create events 
with values aligned to continuous curves.
In these modes, the quantize value determines the period of the curve 
(the length of one curve “cycle”) and the length quantize value deter-
mines the density of the events (the lower the length quantize note value, 
the smoother the curve).

• In Sine, Triangle and Square mode you can also use 
modifier keys to determine the shape of the curve.
If you press [Ctrl]/[Command] you can change the phase of the beginning 
of the curve, if you press [Alt]/[Option]-[Ctrl]/[Command] while snap is ac-
tivated you can change the position of the whole curve (in both cases the 
snap value for the positioning will be a quarter of the quantize value).

You can also set the curve period freely by holding 
down [Shift] when you insert events in Sine, Triangle or 
Square mode. Activate Snap, [Shift]-click and drag to set 
the length of one period. The period length will be a multi-
ple of the quantize value.

• In Triangle and Square mode, you can press [Shift]- 
[Ctrl]/[Command] to change the maximum position of the 
triangle curve (to create sawtooth curves) or the pulse of 
the square curve. As in other modes, you can press [Alt]/
[Option] if you want to change the existing events rather 
than creating new ones. Again, the snap value for the po-
sitioning will be a quarter of the quantize value.

Moving and copying events

You can move or duplicate events in a controller lane, 
much like you can with notes:

1. Click with the Arrow tool to select the events you want 
to cut or copy.
You can also click and drag to create a selection rectangle encompassing 
the desired events.

2. Click on a curve point and drag the events to move 
them.
If Snap is activated, this determines to which positions you can move the 
events (see “Snap” on page 410). 

! Remember that a non-note event does not have a 
length – it is “valid” until the next event (see “The 
controller display” on page 408).
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Using cut, copy and paste

You can use the standard Cut, Copy and Paste options 
on the Edit menu to move or copy events in the controller 
display:

1. Select the events you want to cut or copy.

2. Select Cut or Copy from the Edit menu.

3. If you want to paste the events into another MIDI part, 
open that part in another Key Editor window.

4. Position the project cursor where you want to paste 
the events.

5. Select Paste from the Edit menu.
The events on the clipboard are added, starting at the project cursor po-
sition, maintaining their relative distances. If a pasted event ends up at 
the same position as an existing event of the same type, the old event is 
replaced. 

Deleting events in the controller display

You delete events by clicking on them with the Erase tool 
or by selecting them and pressing [Backspace]. Please 
note:

• Deleting a controller event makes the last event before 
this valid up until the next event. It does not “zero” any 
controller changes.

• You can delete notes by deleting their velocity bars in 
the controller display.
Please be aware that if there is more than one note on the same position, 
there may still only be one velocity bar visible – make sure that you delete 
only the desired notes!

Editing continuous controllers on the controller lane

When a continuous controller is selected for a controller 
lane, additional data is displayed on the controller lane. 
This is due to the fact that MIDI controller data can be re-
corded (or entered) either for an automation track or for a 
MIDI part (see “MIDI controller automation” on page 261).

The following applies:

• In the event type pop-up menu, an asterisk is displayed 
next to the controller name if automation data already ex-
ists for this controller.
This can be either controller data you entered in a MIDI editor (the data 
will then be displayed on the controller lane), or controller data recorded 
on an automation track in the Project window (in which case no events 
are displayed on the controller lane). 

• If conflicting controller data exists in two different 
places, you can specify what will happen on playback by 
making settings for the Automation Merge Mode (see 
“Merging automation data” on page 261). The resulting 
curve is displayed in addition to the curve you entered on 
the controller lane.

• On the controller lane, you can also see the controller 
curve that is applied before the part starts. That way, you 
know which controller value (if any) is currently being used 
at the starting point of the part so that you can choose the 
start value accordingly. 
Note that this value also depends on the Automation Merge Mode.

! When the Auto Select Controllers button is activated 
in the Key Editor toolbar, selecting notes will also se-
lect the corresponding controller events. Moving 
events (either using cut/copy/paste or drag & drop) 
in the note display will also move the corresponding 
controller events (see also “Selecting controllers 
within the note range” on page 412).

Controller curve entered on 
the controller lane

Resulting controller curve (if controller 
automation was also recorded on a 
track). These values depend on the 
selected Automation Merge Mode.

The controller curve before the part starts. This curve depends on the 
existing controller data (if any) and on the selected Merge Mode.
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Adding and editing Poly Pressure events

Poly Pressure events are special, in that they “belong to” a 
specific note number (key). That is, each Poly Pressure 
event has two editable values: the note number and the 
amount of pressure. Therefore, when Poly Pressure is se-
lected on the event type pop-up menu, there are two value 
fields to the left of the controller display, one for the note 
number and one for the amount.

To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Set the note number by clicking on the keyboard dis-
play.
The selected note number is displayed in the upper value field to the left 
of the controller display. Note that this only works for the topmost lane. If 
you have selected “Poly Pressure” for several controller lanes, you have 
to type in the desired note number directly in the lower value field to the 
left of each lane. 

3. Use the Pencil tool to add a new event, just as when 
adding regular controller events.

To view and edit existing Poly Pressure events, proceed 
as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Click on the arrow button next to the note number field 
to the left of the controller lane.
A pop-up menu appears, listing all note numbers for which there already 
are Poly Pressure events.

3. Select a note number from the pop-up menu.
The Poly Pressure events for the selected note number are shown in the 
controller lane.

4. Use the Pencil tool to edit the events as usual.
Press [Alt]/[Option] to edit existing events without adding any new ones.

• Poly Pressure events can also be added and edited in 
the List Editor.

The In-Place Editor
The In-Place Editor makes it possible to edit MIDI parts di-
rectly in the Project window, for quick and efficient editing 
in context with other tracks. 

To open the In-Place Editor for one or more selected 
tracks, you have the following possibilities:

• Select “Open In-Place Editor” on the MIDI menu.

• Use the Edit In-Place key command, by default [Ctrl]/
[Command]-[Shift]-[I].

• To open the In-Place Editor for a single MIDI track, click 
the corresponding Edit In-Place button in the track list (if 
necessary, expand the track list to display the button).

This expands the MIDI track to show something like a min-
iature Key Editor, allowing you to edit MIDI notes and con-
trollers.

• To zoom or scroll the In-Place Editor, point at the left 
part of the piano keyboard display so that the pointer 
changes to a hand. Now you can click and drag to the 
right or left to zoom in or out vertically, and drag up or 
down to scroll the editor.

• Clicking on the gray triangle in the upper right corner of 
the track list for the edited track brings up a local toolbar 
with some settings specific to the In-Place Editor.

For descriptions of these settings, see “The toolbar” on page 406.
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• Just like in the Key Editor, you can edit velocity or con-
tinuous controllers at the bottom of the In-Place Editor.
To change which controller type is shown, click in the controller name 
field directly below the piano keyboard and select a controller type from 
the pop-up menu. To add or remove controller lanes, right-click below 
the controller name field and select an option from the context menu.

• When you select a MIDI note, the Project window info 
line shows information about that note, just like the info 
line in the Key Editor.
You can perform the same editing here as on the Key Editor info line, see 
“Editing on the info line” on page 415.

• The Snap button and Snap Type pop-up menu on the 
Project window toolbar govern snapping in the In-Place 
Editor, but the snap grid is set using the Quantize pop-up 
menu.

• To close the In-Place Editor for one or several selected 
tracks, you can use the Edit In-Place key command, by de-
fault [Ctrl]/[Command]-[Shift]-[I].

• To close the In-Place Editor for one track, you can click 
the Edit In-Place button in the track list or double-click be-
low the controller display in the In-Place Editor.

Working with parts 

If you work with parts in the In-Place Editor, the following 
editing functions are available:

• You can change the length of the parts by clicking on the 
lower part edges (so that the mouse pointer changes to a 
double arrow) and dragging it to the left or right.

• You can drag and drop notes between parts.
• You can change the length of notes by clicking on them and 

dragging the double arrow to the left or right.
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The List Editor – Overview

The toolbar
The toolbar contains several items that are the same as in 
the Key Editor (edit solo, snap, quantize settings, etc.). 
These are described earlier in this chapter. The following 
toolbar items are unique to the List Editor:

• The Insert pop-up menu is used when creating new 
events.
This is where you determine what type of event to add (see “Inserting 
events” on page 425).

• The List Editor contains an additional Value display (see 
below).

The List Editor has no info line (numerical editing is avail-
able in the list instead).

If you see an empty or incomplete list of items although 
the items are visible in the Key Editor, check if you have ac-
tivated any filters (see “Filtering” on page 426).

The Filters bar
Similar to the sections in the Project window, the Filters 
bar can be shown/hidden via the “Set up Window Layout” 
button (see “The status line” on page 407). The Filters bar 
allows you to hide events from view, based on their type 
and other properties (see “Filtering” on page 426).

The status line
This is the same as in the Key Editor (see “The status line” 
on page 407), except for the Current Note Position op-
tion, which is not available in the List Editor.

The event list
This lists all events in the selected MIDI part(s), in the or-
der (from top to bottom) in which they are played back. 
You can edit the event properties by using regular value 
editing, see “Editing in the list” on page 425.

The event display
This shows the events graphically. The vertical position of 
an event in the display corresponds to its entry in the list 
(i. e. to the playback order), while the horizontal position cor-
responds to its actual position in the project. This is where 
you add new parts or events, drag to move them, etc.

The value display
This display shows the “value” of each event, allowing for 
easy viewing and graphical editing. Typically, the value 
shown is the “Data 2” or “Value 2” property (amounts to 
MIDI controller events, velocity for notes, etc.). You can 
show or hide this display by clicking the “Show List Value 
View” button on the toolbar.

Event display

Event list

Value 
display

Ruler

Toolbar

Filters bar
Status line
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List Editor operations

Customizing the view
You can click and drag the divider between the list and 
the event display to make one area wider and the other 
narrower. Furthermore, the list can be customized in the 
following ways:

• You can change the order of the columns by dragging 
the column headings.

• You can resize columns by dragging the dividers be-
tween the column headings.

Setting the display format

Just like in the Project window, you set the display format 
(bars+beats, seconds, etc.) by right-clicking in the ruler 
and selecting an option from the pop-up menu. This set-
ting affects both the ruler and all start, end and length val-
ues shown in the list.

Zooming

You can change the horizontal magnification in the event 
display by using the zoom slider below the display or the 
Zoom tool (the magnification glass).

Inserting events
To add a new event to the edited part, proceed as follows:

1. Use the Insert Type pop-up menu on the toolbar to se-
lect the event type.

2. Select the Pencil tool and click in the event display at 
the desired position (relative to the ruler).
If you are creating note events, you can click and drag to set the length of 
the note.

The new event appears in the list and in the display. Its 
properties will be set to default values, but can be ad-
justed in the list.

• Notes will get the insert velocity value set in the insert 
velocity field on the toolbar, see “Setting velocity values” 
on page 411.

Editing in the list
The list allows you to perform detailed numerical editing of 
the events properties. The columns have the following 
functionality:

Column Description

L An arrow in this column indicates the event that starts 
closest before the project cursor position. If you click in 
this column for an event, the project cursor is moved to 
the start of that event. Double-clicking moves the cursor 
position and starts/stops playback – useful for audition-
ing when editing in the list.

Type The event type. This cannot be changed.

Start The start position of the event, shown in the format se-
lected for the ruler. Changing this is the same as moving 
the event. Note that moving the event past any other 
event in the list will re-sort the list (the list always shows 
the events in the order they are played back).

End This is only used for note events, allowing you to view and 
edit the end position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of 
the note – changing this resizes the note and automati-
cally changes the End value as well.

Data 1 This is the “data 1” or “value 1” property of the event. The 
content of this depends on the event type – for notes, this 
is the pitch, for example. Where applicable, the values are 
shown in the most relevant form. For instance, the Data 1 
value for notes is shown as a note number in the format 
selected in the Preferences dialog (Event Display–MIDI 
page). For further information, see also the table in the 
section “Editing in the value display” on page 427.

Data 2 This is the “data 2” or “value 2” property of the event. The 
content of this depends on the event type – for notes, this 
is the note-on velocity value, for example. For further in-
formation, see also the table in the section “Editing in the 
value display” on page 427.

Data 3 This is the “data 3” or “value 3” property of the event. This 
value is only used for note events, where it corresponds 
with the note-off velocity.

Channel The MIDI channel of the event. Note that this setting is 
normally overridden by the channel setting for the track. 
To make a MIDI event play back on “its own” channel, set 
its track to channel “Any” in the Project window.

Comment This column is used for some event types only, providing 
an additional comment about the event.
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• You can edit several events at once. If several events 
are selected and you edit a value for one event, the other 
selected events’ values will be changed as well.
Normally, any initial value differences between the events will be main-
tained – i. e. the values will change by the same amount. If you press [Ctrl]/
[Command] when you edit, however, all events will get the same value.

For SysEx (system exclusive) events, you can only edit 
the position (Start) in the list. However, when you click the 
Comment column, the MIDI SysEx Editor opens, in which 
you can perform detailed editing of system exclusive 
events (see “Working with SysEx messages” on page 
427).

Editing in the event display
The event display allows you to edit the events graphically 
using the tools on the toolbar. You can edit single events 
as well as several selected events simultaneously.

• To move an event, click and drag it to a new position.
Note that moving the event past any other event in the display will re-sort 
the list (the list always shows the events in the order they are played 
back). As a result, the vertical position of the event in the display will 
change as well.

• To make a copy of an event, press [Alt]/[Option] and 
drag it to a new position.

• To resize a note, select it and drag its end point with the 
Arrow tool as in the Project window.
This only works with notes.

• To mute or unmute an event, click on it with the Mute 
tool.
You can mute or unmute several events in one go by enclosing them in a 
selection rectangle with the Mute tool.

• You can select a color scheme for the events with the 
Event Colors pop-up menu on the toolbar.
This affects how all MIDI events are shown in the List and Key editors – 
see “Coloring notes and events” on page 410.

• To delete an event, select it and press [Backspace] or 
[Delete], or click on it with the Erase tool in the event dis-
play.

Filtering
The Filters bar is displayed below the toolbar in the List 
Editor. It contains two sections. On the left, you can find 
controls for setting up complex filters, and on the right, 
you can exclude certain event types from being displayed.

To show or hide the Filters bar, click the “Set up Window 
Layout” button on the toolbar and activate or deactivate the 
Filters option.

The Show section (complex filtering)

On the left of the Filters bar, you find the Show pop-up 
menu. This can be used to filter the event display based 
on complex criteria. Proceed as follows:

1. Select one or more events that have the desired prop-
erties.

2. Pull down the Show pop-up menu and select one of 
the options.

• In the top section, the following options are available:

• In addition to these options, the menu also gives you ac-
cess to the presets available in the Logical Editor. Using 
the “Setup…” item, you can directly open the Logical Edi-
tor. In this editor, you can create very complex filter set-
tings (see the chapter “The Logical Editor, Transformer, 
and Input Transformer” on page 431).

When you apply any of the Logical presets or use the Log-
ical Editor to create filter settings yourself, only the events 
that meet the specified criteria will be visible.

Option Description

No Focus Select this to deactivate this filtering function.

Event Types Only events with the type of the selected event will be 
shown. This is the same as activating event types in the 
Hide section.

Event Types 
and Data 1

Only events of the same type and with the same “Data 1” 
value will be shown. For example, if a note event is se-
lected, only notes with the same pitch are shown. If a 
controller event is selected, only controllers of the same 
type are shown.

Event 
Channels

Only events with the same MIDI channel value as the se-
lected event will be shown.
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The Hide section (filtering out event types)

The Hide section on the Filters bar allows you to hide spe-
cific event types from view. For example, it may be hard to 
find note events if the part contains a lot of controller data. 
By hiding the controllers, the list becomes more manage-
able.

• To hide an event type, activate the corresponding 
checkbox on the Filters bar.

• To hide all event types except one, press [Ctrl]/[Com-
mand] and click the checkbox of the event type you want 
to view.
If you [Ctrl]/[Command]-click again, all checkboxes are cleared.

The event types remain hidden even if you hide the Fil-
ters bar. To make sure that you see all events, show the 
Filters bar and verify that all checkboxes are deactivated 
and that the Show pop-up menu is set to “No Focus”.

Filtering events out does not remove, mute, or change 
the events in any way.

Editing in the value display
The value display to the right of the event display is a tool 
for quick viewing and editing of multiple values, e. g. veloc-
ities or controller amounts. The values are shown as hori-
zontal bars, with the bar length corresponding to the value.

A velocity ramp in the value display

You edit the values by clicking and dragging. Note that the 
pointer automatically takes on the shape of the Pencil tool 
when you move it over the value display – you do not have 
to select the Pencil tool for this.

• To show or hide the value display, click the “Set up Win-
dow Layout” button on the toolbar and activate or deacti-
vate the Value Display option.

Exactly which value is shown for an event depends on the 
event type. The following table shows what is displayed 
and edited in the Data columns and the value display:

• For note events there will also be a value in the Data 3 
column, which is used for note-off velocity.

• Note that for SMF and text events no values are dis-
played.

Working with SysEx messages
SysEx (System Exclusive) messages are model-specific 
messages for setting various parameters of a MIDI device. 
This makes it possible to address device parameters that 
would not be available via normal MIDI syntax.

Every major MIDI manufacturer has its own SysEx identity 
code. SysEx messages are typically used for transmitting 
patch data, i. e. the numbers that make up the settings of 
one or more sounds in a MIDI instrument.

Nuendo allows you to record and manipulate SysEx data 
in various ways. The following sections point to various 
features that help you manage and create SysEx data.

To learn about the possibilities of the MIDI Device Man-
ager for controlling your device, see the chapter “Using 
MIDI devices” on page 380.

Event type Data 1 Data 2 Value display

Note Pitch 
(note number)

Note-on  
velocity

Velocity

Controller Controller type Controller  
amount

Controller  
amount

Program  
Change

Program  
number

Not used Program  
number

Aftertouch Aftertouch 
amount

Not used Aftertouch amount

Pitchbend Bend amount Not used Bend amount

SysEx Not used Not used Not used
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Bulk dumps

Recording a bulk dump in Nuendo

In any programmable device, the settings are stored as 
numbers in computer memory. Change those numbers, 
and you will change the settings.

Normally, MIDI devices allow you to dump (transmit) all or 
some settings in the device’s memory in the form of MIDI 
SysEx messages. A dump is therefore (among other 
things) a way of making backup copies of the settings of 
your instrument: sending such a dump back to the MIDI 
device will restore the settings. 

If your instrument allows the dumping of a few or all of its 
settings via MIDI by activating some function on the front 
panel, this dump will probably be recordable in Nuendo.

1. Open the Preferences dialog from the File menu (on 
the Mac, this is located on the Nuendo menu) and select 
the MIDI–MIDI Filter page.
This allows you to govern which MIDI event types are recorded and/or 
thru-put.

2. Make sure that recording of SysEx data is not filtered, 
by deactivating the SysEx checkbox in the Record section. 
The SysEx checkbox in the Thru section can be left as it is 
(by default activated).

This way, SysEx messages will be recorded but not echoed back out to 
the instrument (which might lead to unpredictable results).

3. Activate recording on a MIDI track and initiate the 
dump from the front panel of the instrument.

4. When done recording, select the new part and open 
the List Editor from the MIDI menu.
This allows you to check that the SysEx dump was recorded – there 
should be one or several SysEx events in the part/event list.

Transmitting a bulk dump back to a device
1. Make sure that the MIDI track with the System Exclusive 
data is routed to the device.
You may want to check your device’s documentation to find details about 
which MIDI channel should be used, etc.

2. Solo the track.
This might not be necessary, but it is a good safety measure.

3. Make sure that the device is set up to receive SysEx 
messages (often, receiving SysEx is turned off by default).

4. If necessary, put the device in “Standby to Receive 
System Exclusive” mode.

5. Play back the data.

Some advice
• Do not transmit more data than you need. If all you want is a 

single program, do not send them all, it will only make it harder 
to find the one you want. Usually, you can specify exactly what 
you want to send.

• If you want the sequencer to dump the pertinent sounds to 
your instrument each time you load a project, put the SysEx 
data in a silent “count-in” before the project itself starts.

! If your MIDI instrument does not offer a way to initiate 
a dump “by itself”, you have to send a Dump Request 
message from Nuendo to start the dump. In that case, 
use the MIDI SysEx Editor (see “Editing SysEx mes-
sages” on page 429) to insert the specific Dump Re-
quest message (see the instrument’s documentation) 
at the beginning of a MIDI track. When you activate 
recording, the Dump Request message will be played 
back (sent to the instrument), the dump will start and 
be recorded as above.
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• If the dump is very short (for instance, a single sound) you can 
put it in the middle of the project to re-program a device on the 
fly. However, you can achieve the same effect by using Program 
Change. This is definitely preferable, since less MIDI data is 
sent and recorded. Some devices may be set up to dump the 
settings for a sound as soon as you select it on the front panel.

• If you create parts with useful SysEx dumps, you can put these 
on a special muted track. When you want to use one of them, 
drag it to an empty unmuted track and play it back from there.

• Do not transmit several SysEx dumps to several instruments at 
the same time.

• Make a note of the current device ID setting of the instrument. 
If you change this, the instrument may refuse to load the dump 
later.

Recording SysEx parameter changes
Often you can use SysEx to remotely change individual set-
tings in a device, e. g. open a filter, select a waveform, 
change the decay of the reverb, etc. Many devices are also 
capable of transmitting changes made on the front panel as 
SysEx messages. These can be recorded in Nuendo, and 
thus incorporated into a regular MIDI recording.

Here’s how it works: let’s say you open up a filter while 
playing some notes. In that case, you will record both the 
notes and the SysEx messages generated when you 
opened of the filter. When you play it back, the sound 
changes exactly like it did when you recorded it.

1. Open the Preferences dialog from the File menu, se-
lect the MIDI–MIDI Filter page and make sure that SysEx 
is recorded, i. e. the SysEx checkbox in the Record section 
is deactivated.

2. Make sure that the instrument is actually set to trans-
mit changes of front panel controls as SysEx messages.

3. Record normally.
When you’re done, you can check that the events were recorded pro-
perly in the List Editor.

Editing SysEx messages
While SysEx events are shown in the List Editor/Project 
Browser, their entire content is not (only the beginning of 
the message is displayed in the Comment column for the 
event). Also, you cannot edit the event (other than moving 
it) as you can with other event types in the List Editor.

Instead, you have to use the MIDI SysEx Editor for this.

• To open the MIDI SysEx Editor for an event, click in the 
Comments column for the event in the List Editor/Project 
Browser.

The display shows the entire message on one or several 
lines. SysEx messages always begin with F0 and end with 
F7 with a number of arbitrary bytes in between. If the mes-
sage contains more bytes than fit on one line, it continues 
on the next. The Address indication to the left helps you 
find out on which position in the message a certain value 
resides.

You can edit all values except for the first (F0) and last one 
(F7).

Selecting and viewing values
To select a value, either click on it or use the cursor keys. 
The selected byte is displayed in various formats:

• In the main display, values are shown in hexadecimal format.
• To the right of this, values are shown in ASCII format.
• At the bottom of the dialog, the selected value is shown in 

ASCII, binary, and decimal formats.
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Editing a value
The selected value can be edited directly in the main dis-
play or in the ASCII, decimal, and binary displays. Just 
click on it and type in the desired value as usual.

Adding and deleting bytes
Using the Insert and Delete buttons or their corresponding 
computer keyboard keys, you can add and delete bytes 
from the message. Inserted data will appear before the se-
lection.

To delete the complete SysEx message, select it in the 
List Editor and press [Delete] or [Backspace].

Importing and exporting data

The Import and Export buttons allow you to get SysEx data 
from disk and to export the edited data to a file. The file 
has to be in “MIDI SysEx” (.SYX) binary format. Only the 
first dump in a SYX file will be loaded.

This format should not be confused with MIDI files, which 
have the extension .mid.
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Introduction
Most of the time you will perform your MIDI editing graph-
ically in one of the MIDI editors. But there are times when 
you want more of a “search and replace” function on MIDI 
data, and that’s where the Logical Editor comes in.

The principle of the Logical Editor is this:

• You set up filter conditions to find certain elements.
This can be elements of a certain type, with certain attributes or values or 
on certain positions, in any combination. You can combine any number of 
filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed.
The options include Transform (changing properties of the found ele-
ments), Delete (removing the elements), Insert (adding new elements 
based on the found positions of other elements) and more.

• You set up a list of actions, which specify exactly what 
is done.
This is not necessary for all functions. For example, the Delete function 
does not require any additional action specifications – it simply removes 
all found elements. The Transform function on the other hand requires 
that you specify which properties are changed and in which way (trans-
pose notes by a certain amount, adjust velocity values, etc.).

By combining filter conditions, functions and the specific 
actions, you can perform very powerful processing.

To master the Logical Editor, you need some knowledge 
about how MIDI messages are structured. However, the 
Logical Editor also comes with a rich selection of presets, 
allowing you to access its processing powers without 
delving into its more complicated aspects, see “Working 
with presets” on page 440.

About the Transformer MIDI effect
The Transformer effect is a realtime version of the Logical 
Editor, allowing you to apply editing to the events played 
back from a track “on the fly”. The Transformer contains 
virtually the same settings and functions as the Logical 
Editor – where there are differences between the two, this 
is clearly stated on the following pages.

For details on how to open the Transformer (and other 
MIDI effects), see “MIDI realtime parameters and effects” 
on page 372.

About the Input Transformer
This too is very similar to the Logical Editor. Just like the 
Transformer effect, the Input Transformer works in realtime. 
However, the Input Transformer filters out and transforms 
MIDI data as it is recorded. In other words, the settings you 
make in the Input Transformer will affect the actual MIDI 
events you record.

The Input Transformer is described in the section “The In-
put Transformer” on page 440. However, we recommend 
that you make yourself familiar with the Logical Editor first, 
since they share many features and principles.

About the Project Logical Editor
There is also a “Project Logical Editor” available via the 
Edit menu. This is described in the chapter “The Project 
Logical Editor” on page 442.

Opening the Logical Editor
1. Select the desired parts or events.
What will be affected by the operation depends on the current selection.

• In the Project window, edits using the Logical Editor are ap-
plied to all selected parts, affecting all events (of the relevant 
types) in them.

• In the MIDI editors, edits using the Logical Editor are applied 
to all selected events. If no events are selected, all events in 
the edited part(s) will be affected.

You can change the selection while the Logical Editor 
window is open.

2. Select “Logical Editor…” from the MIDI menu.

! Studying the included presets is an excellent way to 
learn the workings of the Logical Editor! Many of them 
can also be used as starting points when you set up 
your own editing operations using the Logical Editor.
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Window overview

Setting up filter conditions

General procedure
The upper list is where you set up the filter conditions, de-
termining which elements to find. The list can contain one 
or several conditions, each on a separate line.

• To add a new condition, click the “+” button below the 
list.
A new line is added at the bottom of the list. If there are many lines, you 
may need to use the scrollbar to the right to view them.

• To remove a condition, select it and click the “-” button 
below the list.

If you have already defined filter conditions and/or ap-
plied a preset, but want to start again from scratch, you 
can initialize the settings by selecting the Init option from 
the Presets pop-up menu.

You set up a filter condition line by clicking in the columns 
and selecting options from the pop-up menus that appear. 
Here is a brief description of the columns:

• You can also set up filter conditions by dragging MIDI 
events directly into the upper list.
If the list contains no entries, a MIDI event dragged into this section will 
form conditions including the state and type of the event. If it contains 
entries, the dragged event will initialize the matching parameters. For ex-
ample, if a length condition is used, the length will be set according to 
the length of the event.

Conditions

Depending on the Filter Target setting, the following 
options can be selected in the Condition column:

Column Description

Left bracket This is used for “bracketing” several lines together when 
creating conditions with multiple lines and the boolean 
operators And/Or, see “Combining multiple condition 
lines” on page 436.

Filter Target Here you select which property to look for when finding 
elements. Your choice here affects the available options 
in the other columns as well, see below!

Function pop-up 
menu

Filter conditions list Presets pop-up menu

Apply button (not 
available in the 
Transformer)

Action List

Condition This determines how the Logical Editor compares the 
property in the Filter Target column to the values in the 
Parameter columns (see below). The available options 
depend on the Filter Target setting.

Parameter 1 Here you set which value the element properties are 
compared to (depending on the Filter Target).  
For example, if the Filter Target is “Position” and Condi-
tion is “Equal”, the Logical Editor will look for all elements 
starting at the position you specify in the Parameter 1 col-
umn.

Parameter 2 This column is only used if you have selected one of the 
“Range” options in the Condition column. This allows you 
to find all elements with values inside (or outside) the 
range between Parameter 1 and Parameter 2.

Bar Range/
Time Base 
(Logical Editor 
only)

This column is only used if the Filter Target is set to “Posi-
tion”. If one of the “Bar Range” options is selected in the 
Condition column, you use the Bar Range/Time Base col-
umn to specify “zones” within each bar (for example, allow-
ing you to find all elements on or around the first beat of 
every bar). If any of the other Condition options is selected, 
you can use the Bar Range/Time Base column to specify 
the time base (PPQ, Seconds, etc.). See “Searching for el-
ements at certain positions (Logical Editor only)” on page 
434 for details.

Right bracket This is used for “bracketing” several lines together, see 
“Combining multiple condition lines” on page 436.

bool This allows you to insert the boolean operators And/Or, 
when creating conditions with multiple lines, see “Com-
bining multiple condition lines” on page 436.

Condition Elements will be found if their Filter Target 
property…

Equal …has the exact same value as set up in the Parameter 1 
column.

Unequal …has any value other than the one set up in the Parame-
ter 1 column.

Bigger …has a value higher than the one set up in the Parameter 
1 column.

Bigger or 
Equal

…has a value that is the same as or higher than the one 
set up in the Parameter 1 column.

Column Description
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The Conditions for the “Property” filter target are dif-
ferent, see “Searching for properties” on page 436.

Below, the different Filter Targets (and their correspond-
ing Condition and Parameter options) are described in 
more detail.

Searching for elements at certain positions 
(Logical Editor only)
Selecting “Position” in the Filter Target column lets you 
find elements starting at certain positions, either relative to 
the start of the song or within each bar.

• If you select any condition other than the Range or Bar 
Range options, you set up a specific position (in PPQ, sec-
onds, samples, or frames) in the Parameter 1 column. Use 
the Bar Range/Time Base column to specify the time base.

Here, the Logical Editor will find all elements at 1.1.1. in the project.

• If you select Inside Range or Outside Range in the Con-
dition column, you set the start position of the range in the 
Parameter 1 column and the end position in the Parameter 
2 column. You can also change the time base using the 
Bar Range/Time Base column.
The Logical Editor will then find all elements inside or outside this posi-
tion range.

• If you select one of the Bar Range options in the Condi-
tion column, the Bar Range/Time Base column will show a 
graphic bar display. You specify the range within the bar 
by clicking and dragging in the bar display (the specified 
Bar Range is indicated in blue).
The Logical Editor will then find all elements starting inside or outside 
this Bar Range, in all bars (within the current selection).

Here, the Logical Editor will find elements starting around the second 
beat in each bar.

Searching for notes of certain lengths  
(Logical Editor only)
Only note events have lengths (actually, a note is made up 
of separate note-on and note-off events but in Nuendo it 
is considered as a single event with a length). Therefore, 
the “Length” Filter Target is only valid if you’re specifically 
searching for notes – there has to be another condition 
line with the Filter Target “Type”, Condition “Equal” and 
Parameter 1 set to “Note”. See “Combining multiple con-
dition lines” on page 436 for details about using multiple 
filter conditions.

Less …has a value lower than the one set up in the Parameter 
1 column.

Less or Equal …has a value that is the same as or lower than the one 
set up in the Parameter 1 column.

Inside Range …has a value that is between the values set up in the Pa-
rameter 1 and Parameter 2 columns. Note that Parameter 
1 should be the lower value and Parameter 2 the higher.

Outside 
Range

…has a value that is not between the values set up in the 
Parameter 1 and Parameter 2 columns.

Inside Bar 
Range (Logi-
cal Editor only)

…is within the “zone” set up in the Bar Range/Time Base 
column (Position only), in each bar within the current se-
lection.

Outside Bar 
Range (Logi-
cal Editor only)

…is outside the “zone” set up in the Bar Range/Time 
Base column (Position only), in each bar within the cur-
rent selection.

Before Cursor 
(Logical Edi-
tor only)

…is before the song cursor position (Position only).

Beyond Cur-
sor (Logical 
Editor only)

…is after the song cursor position (Position only).

Inside Track 
Loop (Logical 
Editor only)

…is inside the set track loop (Position only).

Inside Cycle 
(Logical Edi-
tor only)

…is inside the set cycle (Position only).

Exactly match-
ing Cycle 
(Logical Edi-
tor only)

…exactly matches the set cycle (Position only).

Note is equal 
to

…is the note specified in the Parameter 1 column, re-
gardless of octave (Pitch only). For example, lets you find 
all C notes, in all octaves.

Condition Elements will be found if their Filter Target 
property…
434
The Logical Editor, Transformer, and Input Transformer



Searching for Value 1 or Value 2
A MIDI event is composed of several values. What is dis-
played for Value 1 and 2 depends on the type of event:

System Exclusive events are not included in the table 
above, since they do not use value 1 and 2.

Since value 1 and 2 have different meanings for different 
events, searching for value 2 = 64 would both find notes 
with the velocity 64 and controllers with the amount 64, 
etc. If this is not what you want, you can add an additional 
filter condition line with the Filter Target “Type”, specifying 
which type of events to find (see below).

The general procedures when searching for value 1 or 2 
are:

• If you select any Condition other than the Range options, 
you set up a specific value in the Parameter 1 column.

Here, the Logical Editor will find all events with a value 2 less than 80.

• If you select Inside Range or Outside Range in the Con-
dition column, the range consists of the values between 
Parameter 1 and Parameter 2.
Note that Parameter 1 should have the lower value.

Searching for note pitch or velocity

If you add another condition line with the Filter Target 
“Type”, Condition “Equal” and Parameter 1 set to “Note”, 
the Logical Editor will “know” you are searching for pitch 
or velocity. This has the following benefits:

• The Filter Targets Value 1 and Value 2 will be displayed as 
“Pitch” and “Velocity” respectively, making it easier to grasp 
the function of the filter condition.

• Pitch values in the Parameter columns will be displayed as 
note names (C3, D#4, etc.). When entering pitch values you 
can either type a note name or a MIDI note number (0–127).

• When Value 1 (pitch) is selected as Filter Target, an additional 
option appears in the Condition column: “Note is equal to”. 
When this is selected, you specify a note name in the Para-
meter 1 column but without any octave number (C, C#, D, D#, 
etc.). The Logical Editor can then find all notes of a certain key, 
in all octaves.

See “Combining multiple condition lines” on page 436 for 
more info on working with multiple filter condition lines.

Searching for controllers

There is similar extended functionality when searching for 
controllers: If you have added an additional “Type = Con-
troller” condition line, the Logical Editor will “know” you 
are searching for controllers. The Parameter 1 column will 
then show the names of the MIDI controllers (Modulation, 
Volume, etc.) when Value 1 is selected as Filter Target.

Searching for MIDI channels
Each MIDI event contains a MIDI channel setting (1–16). 
Normally, these settings are not used, since the MIDI event 
plays back on the MIDI channel set for its track. However, 
you can come across MIDI parts with events set to different 
channels, for example in the following scenarios:

• If you have recorded MIDI from an instrument sending on sev-
eral different channels (e. g. a master keyboard with different 
key zones).

• If you have imported a MIDI file of type 0 (with a single track, 
containing MIDI events with different channel settings).

Searching for MIDI channel values is straightforward; you 
select a Condition and enter a MIDI channel (1–16) in the 
Parameter 1 column (and, if you have selected one of the 
Range Conditions, a higher channel in the Parameter 2 
column, creating a value range).

Event type Value 1 Value 2

Notes The Note Number/
Pitch.

The velocity of the note.

PolyPressure The key that was 
pressed.

The amount of pressure for 
the key.

Controller The type of Controller, 
displayed as a number.

The amount of Control 
Change.

Program Change The Program Change 
number.

Not used.

Aftertouch The amount of pressure. Not used.

Pitchbend The “fine tune” of the 
bend. Not always used.

The coarse amount of bend.

! This is particularly useful when searching for note 
pitch or velocity values, as described below.
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Searching for element types
Selecting Type as the Filter Target allows you to find ele-
ments of a certain type only.

• The Condition column contains only three options: Equal, Un-
equal and All Types.

• Clicking the Parameter 1 column displays a pop-up menu, list-
ing the available types (Note, Poly Pressure, Controller, etc.).

The Logical Editor will find all elements matching or not 
matching the selected type (depending on the Condition).

Searching for properties
On the Filter Target pop-up menu, you will find an option 
called Property. This allows you to search for properties 
that are not part of the MIDI standard but rather Nuendo-
specific settings.

When the Property option is selected, the Condition col-
umn has two options: “Property is set” and “Property is 
not set”. Which property to look for is selected in the Pa-
rameter 1 column. The options are “muted”, “selected” 
and “empty”. Two examples:

Here, the Logical Editor will find all muted events.

Here, the Logical Editor will find all events that are selected and muted.

Searching for event contexts
On the Filter Target pop-up menu, you will find an option 
called “Last Event”. This can be used to perform context-
dependent searches (especially useful in the Input Trans-
former).

“Last Event” indicates the state of an event which has al-
ready passed the Input Transformer/Logical Editor. The 
condition has to be combined with Parameter 1 and Pa-
rameter 2. 

Below, you will find a few examples on how the Last Event 
filter target can be used.

Here, the action will only be performed when the sustain 
pedal is down:

In this example, the action will be performed when the note 
C1 is pressed (the “Note is playing” condition is only avail-
able in the Input Transformer and in the Transformer effect):

In this example, the action will be performed after playing 
the C1 note:

Combining multiple condition lines
As described above, you can add condition lines by click-
ing the “+” button below the list. The result of combining 
condition lines depends on the boolean And/Or operators 
and the brackets.

The bool column

By clicking in the “bool” column to the right in the list, you 
can select a boolean operator: “And” or “Or”. A boolean 
operator combines two condition lines and determines the 
result in the following way:

• If two condition lines are combined with a boolean And, 
both conditions must be fulfilled for an element to be found.

The Logical Editor will only find elements that are notes and start at the 
beginning of the third bar.

! As mentioned above, selecting Type = Note or  
Type = Controller adds some additional functionality 
to the Logical Editor. You should make it a habit to 
add a Type condition when applicable.

Filter Target Condition Parameter 1 Parameter 2

Last Event Equal MIDI Status 176/Controller

Last Event Equal Value 1 64

Last Event Bigger Value 2 64

Filter Target Condition Parameter 1 Parameter 2

Type is Equal Note 

Last Event Equal Note is playing 36/C1

Filter Target Condition Parameter 1 Parameter 2

Last Event Equal Value 1 36/C1
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• If two condition lines are combined with a boolean Or, 
one of the conditions (or both) must be fulfilled for an ele-
ment to be found.

The Logical Editor will find all events that are notes (regardless of their 
position) and all events starting at the beginning of the third bar 
(regardless of their type).

When you add a new condition line, the boolean setting 
defaults to And. Therefore, if all you want to do is set up 
two or more conditions that all must be met for an element 
to be found, you do not have to think about the boolean 
column – just add the required lines and make the usual 
filter settings.

Using brackets

The bracket (parenthesis) columns let you enclose two or 
more condition lines, dividing the conditional expression 
into smaller units. This is only relevant when you have 
three or more condition lines and want to use the boolean 
Or operator. This is how it works:

• Without brackets, the conditional expressions are eval-
uated according to their order in the list.

In this case the Logical Editor will find all MIDI notes with the pitch C3, 
as well as all events (regardless of their type) set to MIDI channel 1.

Maybe you wanted to find all notes that either had the 
pitch C3 or the MIDI channel 1 (but no non-note events)? 
Then you need to add some brackets:

• Expressions within brackets are evaluated first.
If there are several layers of brackets, these are evaluated “from the inside 
out”, starting with the innermost brackets.

You add brackets by clicking in the bracket columns and 
selecting an option. Up to triple brackets can be selected.

Selecting a function

The pop-up menu at the bottom of the Logical Editor is 
where you select the function – the basic type of editing 
to be performed.

Below, the available options are listed. Note that some 
options are not available in the Transformer effect.

Delete

Deletes all elements found by the Logical Editor. In the case 
of the Transformer, this function will remove (or “mute”) all 
found elements from the “output stream” – the actual ele-
ments on the track are not affected.

Transform

Changes one or several aspects of the found elements. 
You set up exactly what is changed in the action list, see 
“Specifying actions” on page 438.

Insert

This will create new elements and insert these into the 
part(s) (Logical Editor) or the output stream (Transformer). 
The new elements will be based on the elements found by 
the Logical Editor’s filter conditions, but with any changes 
you have set up in the action list applied. 

Another way of expressing this is that the Insert function 
copies the found elements, transforms them according to 
the action list and inserts the transformed copies among 
the existing elements.

Insert Exclusive

This will transform the found elements according to the 
action list. Then, all elements that were not found (that did 
not meet the filter conditions) are deleted (Logical Editor) 
or removed from the output stream (Transformer).
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Copy (Logical Editor only)

This will copy all found elements, transform them accord-
ing to the action list and paste them into a new part on a 
new MIDI track. The original events are not affected.

Extract (Logical Editor only)

This works like Copy, but will cut the found events instead. 
Or in other words, Extract will transform all found events 
and move them to a new part on a new MIDI track.

Select (Logical Editor only)

This will simply select all found events, highlighting them 
for further work in the regular MIDI editors.

Specifying actions

The lower list in the Logical Editor window is the action 
list. This is where you specify any changes that are made 
to the found events (relevant for all function types except 
Delete and Select).

The handling of the action list is similar to the filter condi-
tion list, but without the brackets and booleans. You sim-
ply add lines by clicking the “+” button below the list, and 
fill out the columns as required. To remove a superfluous 
action line, select it and click the “-” button.

Action Target
This is where you select the property that is changed in 
the events:

The Position and Length parameters are interpreted 
via the time base setting in the Bar Range/Time Base col-
umn, with the exception of the Random setting, which 
uses the time base of the affected events.

Operation
This setting determines what to do with the Action Target. 
The options on this pop-up menu are different depending 
on the selected Action Target. Below, all available opera-
tions are listed:

Add

Adds the value specified in the Parameter 1 column to the 
Action Target.

Subtract

Subtracts the value specified in the Parameter 1 column 
from the Action Target.

Multiply by

Multiplies the Action Target value with the value specified 
in the Parameter 1 column.

Divide by

Divides the Action Target value by the value specified in 
the Parameter 1 column.

Round by

This “rounds” the Action Target value using the value 
specified in the Parameter 1 column. In other words, the 
Action Target value is changed to the closest value that 
can be divided by the Parameter 1 value.

Option Description

Position  
(Logical Editor 
only)

Adjusting this value will move the events.

Length  
(Logical Editor 
only)

Lets you resize the events (notes only).

Value 1 This adjusts value 1 in the events. As described in the sec-
tion “Searching for Value 1 or Value 2” on page 435, what 
is displayed for value 1 depends on the event type. For 
notes, value 1 is the pitch.

Value 2 This adjusts value 2 in the events. As described in the sec-
tion “Searching for Value 1 or Value 2” on page 435, what 
is displayed for value 2 depends on the event type. For 
notes, value 2 is the velocity value.

Channel Allows you to change the MIDI channel setting, see 
“Searching for MIDI channels” on page 435.

Type Allows you to change the event type, e. g. transform after-
touch events to modulation events.

Value 3 This adjusts value 3 in the events, which is used for han-
dling of Note-off velocity when searching for properties, 
see “Searching for properties” on page 436.

Option Description
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For example, if the Action Target value is 17 and Parame-
ter 1 is 5, the result of rounding will be 15 (the closest 
value that can be divided by 5). Another word for this type 
of operation would be “quantizing”, and it is actually possi-
ble to use it for this, by setting the Action Target to “Posi-
tion” and specifying a quantize value with Parameter 1 (in 
ticks, with 480 ticks per quarter note).

Set Random Values between

This will set the Action Target value to a random value 
within the range specified with Parameter 1 and 2.

Set Relative Random Values between

This will add a random value to the current Action Target 
value. The added random value will be within the range 
specified with Parameter 1 and 2. Note that these can be 
set to negative values.

For example, if you set Parameter 1 to -20 and Parameter 
2 to +20, the original Action Target value will get a ran-
dom variation, never exceeding ±20.

Set to fixed value

This sets the Action Target to the value specified in the 
Parameter 1 column.

Add Length (Logical Editor only)

This is only available when Action Target is set to Position. 
Furthermore, it is only valid if the found events are notes 
(and thus have a length). When Add Length is selected, 
the length of each note event will be added to the Position 
value. This can be used for creating new events (using the 
Insert function) positioned relative to the end positions of 
the original notes.

Transpose to Scale

This is only available when Action Target is set to Value 1, 
and when the filter conditions are specifically set up to 
find notes (a “Type = Note” filter condition line has been 
added). When “Transpose to Scale” is selected, you can 
specify a musical scale using the Parameter 1 and 2 col-
umns. Parameter 1 is the key (C, C#, D, etc.) while Pa-
rameter 2 is the type of scale (major, melodic or harmonic 
minor, etc.).

Each note will be transposed to the closest note in the se-
lected scale.

Use Value 2

This is only available when Action Target is set to Value 1. 
If this option is selected, the Value 2 setting in each event 
will be copied to the Value 1 setting.

This is useful, for example, if you are transforming all Mod-
ulation controllers to Aftertouch events (since controllers 
use Value 2 for their amount, while Aftertouch uses Value 
1 – see “Searching for Value 1 or Value 2” on page 435).

Use Value 1

This is only available when Action Target is set to Value 2. 
If this option is selected, the Value 1 setting in each event 
will be copied to the Value 2 setting.

Mirror

This is only available when Action Target is set to Value 1 
or Value 2. When this option is selected, the values will be 
“mirrored” around the value set in the Parameter 1 col-
umn.

In the case of notes, this will invert the scale, with the key 
set in the Parameter 1 column as “center point”.

Linear Change in Loop Range (Logical Editor only)

This will affect events within the loop range (between the 
left and right locators) only. It will create a linear “ramp” of 
values (replacing the original values) starting at the value 
in the Parameter 1 column and ending at the Parameter 2 
value.

This can be used for creating linear controller sweeps, ve-
locity ramps, etc.

Relative Change in Loop Range (Logical Editor only)

As with the previous option, this will create a ramp of val-
ues, affecting events in the loop range only (i. e. between 
the locators). However, here the changes are “relative”, 
meaning that values will be added to the existing values.

In other words, you set up a value ramp starting at Para-
meter 1 and ending at Parameter 2 (note that the Parame-
ter values can be negative). The resulting value ramp is 
then added to the existing values for the events within the 
loop range.
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For example, if you apply this to note velocities with Para-
meter 1 set to 0 and Parameter 2 set to -100, you create 
a velocity fade-out, keeping the original velocity relations:

Applying the defined actions
Once you have set up filter conditions, selected a function 
and set the required actions (or loaded a preset), you ap-
ply the actions defined with the Logical Editor by clicking 
the Apply button.

Logical Editor operations can be undone just like any 
other editing.

Working with presets
The Presets pop-up menu at the top of the window allows 
you to load, store, and manage Logical Editor presets.

• To load a preset, select it from the Presets pop-up 
menu. If available, an explanatory text appears to the right 
of the menu. When setting up your own presets, you can 
click in this area and enter a description.

• You can also select Logical Presets directly from the 
MIDI menu.
This allows you to apply a preset to the selected MIDI part, without hav-
ing to open the Logical Editor.

• It is also possible to select and apply Logical Presets 
from within the List Editor (from the Mask menu).

Storing your own settings as a preset
If you have made Logical Editor settings that you want to 
use again, you can store them as a preset:

1. Click on the Store Preset button on the right of the 
Preset menu.
A dialog for specifying a name for the new preset is displayed.

2. Enter a name for the preset and click OK.
The preset is stored.

To remove a preset, load it and click on the Remove 
Preset button.

Organizing and sharing presets
The Logical Editor presets are stored within the applica-
tion folder in the Presets\Logical Edit subfolder. While 
these files cannot be edited “manually”, you can reorga-
nize them (e. g. putting them in subfolders) like any files.

This also makes it easy to share presets with other Nu-
endo users, by transferring the individual preset files.

The list of presets is read each time the Logical Editor 
is opened.

The Input Transformer
This function allows you to filter out and change MIDI data 
coming to a MIDI track before it is recorded. The Input 
Transformer is very similar to the Transformer MIDI effect, 
but contains four independent “modules”, for which you 
can set up different filtering and actions. You can activate 
any or all of these four modules.

Here are some of the things the Input Transformer allows 
you to do:

• Set up split keyboard combinations for recording left and right 
hands separately.

• Turn a controller like a foot pedal into MIDI notes (for playing 
bass drum the right way).

• Filter out one specific type of MIDI data on one MIDI channel 
only.

• Turn aftertouch into any controller (and vice versa).
• Invert velocity or pitch.

Again: four of these things can be done at the same time.

! In the Logical Editor, processing is not performed un-
til you click the Apply button. When using the Trans-
former MIDI effect, there is no Apply button – the 
current settings are automatically applied in realtime 
during playback or live playing.
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Opening the Input Transformer
To open the Input Transformer for a MIDI track, select the 
track and click the Input Transformer button in the Inspec-
tor to open the pop-up menu.

• Select Global to make Input Transformer settings that 
affect all MIDI inputs (and thereby all MIDI tracks).

• Select Local to make Input Transformer settings for this 
track only.

In both cases, the button lights up and the Input Trans-
former opens.

Handling the four modules
The Input Transformer is really four separate transformers, 
or modules.

• You select which module to view and make settings for 
by clicking the corresponding Module tab.

Module 1 selected for viewing and editing.

• The On/Off buttons next to the Module names deter-
mine which module(s) are active.

Here, Module 1 is inactive and Module 2 is active.

The Function pop-up menu
The Function pop-up menu contains two options: Filter 
and Transform.

• In Filter mode, only the filter conditions (the upper list) 
are taken into account. All events matching the conditions 
set up will be filtered out (excluded from the recording).

• In Transform mode, events matching the filter conditions 
will be transformed according to the settings in the action 
list (the lower list).

Setting up filtering and actions
This is done just like in the Logical Editor. Here is a brief 
rundown:

• Click the “+” button to add lines to the filter condition 
list or action list.
To remove a line, click it to select it and click the “-” button below the lists.

• Clicking the columns in the filter condition list opens 
pop-up menus allowing you to specify the conditions to 
match.

• Clicking the columns in the action list opens pop-up 
menus allowing you to specify how the found events are 
transformed (when Transform mode is selected).

For detailed descriptions of the filter conditions and action 
columns, see “General procedure” on page 433.

• The Input Transformer has no Apply button – the settings 
are active as soon as you activate the On/Off button of a 
module.
The settings made in the active modules will affect all MIDI data you 
record on the track.

Closing the Input Transformer window does not turn it 
off – you need to deactivate the On/Off buttons of all 
modules for this!

A lit Input Transformer button in the Inspector indicates that one or more 
modules are active.
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Introduction
On the Edit menu you will find the function “Project Logical 
Editor…”. This opens a Project Logical Editor for the entire 
project. It works similar to the Logical Editor on the MIDI 
menu, see the chapter “The Logical Editor, Transformer, 
and Input Transformer” on page 431. The most important 
difference is that the Logical Editor for MIDI works at the 
event level, whereas the Project Logical Editor works at the 
project level and is therefore a very powerful tool for “search 
and replace” functions in your entire project.

The MIDI events in the MIDI parts will not be affected 
by the Project Logical Editor operations. If you want to 
change MIDI notes or controller data, you have to use the 
Logical Editor.

With the Project Logical Editor, you can combine filter 
conditions with actions to create complex procedures, 
e. g. for special track type operations on tracks that are 
named identically. You can use its functions to delete all 
muted MIDI parts or to toggle the open state of all folder 
tracks in your project, etc. 

Included with the Project Logical Editor are a number of 
presets that give you an impression of the great possibili-
ties that this feature offers, see “Working with presets” on 
page 450. Many of them can also be used as starting 
points when you set up your own editing operations. 

The principle for the Project Logical Editor is this:

• You set up filter conditions to find certain elements.
This can be elements of a certain type, with certain attributes or values or 
on certain positions, in any combination. You can combine any number of 
filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed.
The options are Transform (changing properties of the found elements), 
Delete (removing the elements) and Select (selecting the found elements).

• You set up a list of actions, which specify exactly what 
is done.
This is not necessary for all functions. For example, the Delete function 
does not require any additional action specifications – it simply removes 
all found elements. 

• In the Macro pop-up menu you can choose an additional 
macro that will be executed after the actions you defined.
Use this to extend the possibilities offered by combining the filter condi-
tions and actions specified in the Project Logical Editor even further.

By combining filter conditions, functions, the specific ac-
tions, and additional macros, you can perform very power-
ful processing.

Opening the Project Logical Editor
1. Open the desired project.
All elements in the project will be affected, you do not have to make any 
selection.

2. Select “Project Logical Editor…” from the Edit menu.

Window overview

To understand the Project Logical Editor, it might be a good 
idea to start by exploring the included presets. These are 
found on the Presets pop-up menu at the top of the win-
dow. For information on how to create and handle your own 
presets, see “Working with presets” on page 450.

! The Project Logical Editor allows all kinds of settings 
that may not always make sense. Experiment a bit 
before applying your edits to important projects. You 
can undo the operations by using the Undo com-
mand on the Edit menu.

Function and Macro pop-up 
menus

Presets pop-up menu List of filter conditions

Action List Apply button
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Setting up filter conditions

General procedure
The upper list is where you set up the filter conditions, de-
termining which elements to find. The list contains one or 
several conditions, each on a separate line.

• To add a new condition, click the “+” button below the 
list.
The new line is added at the bottom of the list. If there are many lines, you 
may need to use the scrollbar to the right to view them.

• To remove a condition, select it and click the Delete 
button (-) below the list.

If you have already defined filter conditions and/or ap-
plied a preset, but want to start again from scratch, you 
can initialize the settings by selecting the Init option from 
the Presets pop-up menu.

You set up a filter condition line by clicking in the columns 
and selecting options from the pop-up menus that appear. 
Here is a brief description of the columns:

Below, the different Filter Targets (and their correspond-
ing Condition and Parameter options) are described in 
more detail.

Searching for Media types
1. Select “Media Type” in the Filter Target pop-up menu.
This allows you to find elements of certain types of media only. 

2. Open the pop-up menu in the Parameter 1 column 
and select the desired option.
When the Filter Target is set to Media Type, the pop-up menu lists the 
available media types. The following table lists what will be found:

Column Description

Left bracket This is used for “bracketing” several lines together when 
creating conditions with multiple lines and the boolean 
operators And/Or, see “Combining multiple condition 
lines” on page 447.

Filter Target Here you select which property to look for when finding 
elements. Your choice here affects the available options 
in the other columns as well, see below!

Condition This determines how the Project Logical Editor compares 
the property in the Filter Target column to the values in 
the Parameter columns. The available options depend on 
the Filter Target setting.

Parameter 1 Here you set which value the element properties are 
compared to (depending on the Filter Target).  
For example, if the Filter Target is “Position” and Condi-
tion is “Equal”, the Project Logical Editor will look for all 
elements starting at the position you specify in the Pa-
rameter 1 column.

Parameter 2 This column is only used if you have selected one of the 
“Range” options in the Condition column. Typically, this 
allows you to find all elements with values inside (or out-
side) the range between Parameter 1 and Parameter 2.

Bar Range/
Time Base

This column is only used if the Filter Target is set to “Posi-
tion”. If one of the “Bar Range” options is selected in the 
Condition column, you use the Bar Range/Time Base col-
umn to specify “zones” within each bar (allowing you to 
find all elements on or around the first beat of every bar, for 
example). If any of the other Condition options is selected, 
you can use the Bar Range/Time Base column to specify 
the time base (PPQ, Seconds, etc.). See “Searching for el-
ements at certain positions” on page 446 for details.

Right bracket This is used for “bracketing” several lines together, see 
“Combining multiple condition lines” on page 447.

bool This allows you to insert the boolean operators And/Or, 
when creating conditions with multiple lines, see “Com-
bining multiple condition lines” on page 447.

Media Type Description

Audio If no container type is specified, this finds audio events, 
audio parts and audio tracks.

MIDI If no container type is specified, this finds MIDI parts and 
MIDI tracks.

Automation If no container type is specified, this finds automation 
events and automation tracks.

Marker If no container type is specified, this finds marker events 
and marker tracks.

Transpose If no container type is specified, this finds transpose 
events and transpose tracks.

Arranger If no container type is specified, this finds arranger events 
and arranger tracks.

Tempo If no container type is specified, this finds tempo events 
and tempo tracks.

Signature If no container type is specified, this finds signature 
events and signature tracks.

Column Description
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3. Open the pop-up menu in the Condition column and 
select the desired condition. 
For media types, the following options are available:

For example, if you have set up the Project Logical Editor 
like this…

…it will find all marker events and tracks in the project.

Searching for Container types
1. Select Container Type in the Filter Target pop-up menu.
This allows you to find parts, events or tracks. 

2. Open the pop-up menu in the Parameter 1 column 
and select the desired option.
When the Filter Target is set to Container Type, the pop-up menu lists 
the available container types. The following table lists what will be found:

3. Open the pop-up menu in the Condition column and 
select the desired condition. 
For container types, the following options are available:

For example, if you have set up the Project Logical Editor 
like this…

…it will find all Folder tracks in the project.

Combining Media Type and Container Type
The combination of the filter targets Media Type and Con-
tainer Type represents a versatile tool for logical operations:

Here, the Project Logical Editor will find all MIDI and instrument parts in 
the project.

Here, the Project Logical Editor will find all automation tracks (not 
events) in the project whose name contains vol.

Here, the Project Logical Editor will find all MIDI and instrument parts 
(not tracks) in the project that are muted.

Here, the Project Logical Editor will find all MIDI and instrument parts 
(not tracks) or all audio events (not parts or tracks) in the project that 
are muted.

Searching for Names
1. Select Name on the Filter Target pop-up menu.

2. Enter the desired name, or a part of a name in the Pa-
rameter 1 column.

3. Open the pop-up menu in the Condition column and 
select the desired condition.
For names, the following options are available:

For example, if you have set up the Project Logical Editor 
like this…

…it will find all tracks in the project whose name contains 
“voc”.

Condition Description

Equal This finds the Media Type set up in the Parameter 1 column.

All Types This finds all Media Types.

Container Type Description

Folder Track This finds all folder tracks, included FX Channel and 
Group Channel folders.

Track This finds all track types.

Part This finds audio, MIDI, and instrument parts. Folder 
parts will not be found.

Event This finds automation points, markers, as well as au-
dio, arranger, transpose, tempo and time signature 
events.

Condition Description

Equal This finds the Container Type set up in the Parameter 1 
column.

All Types This finds all Container Types.

Condition Description

Equal This is the exact same text string as set up in the Parameter 
1 column.

Contains This contains the text specified in the Parameter 1 column.
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To take maximum advantage of this feature, we recom-
mend using a standard nomenclature in your projects 
(Drums, Perc, Voc, etc.). 

Searching for elements at certain positions
1. Select “Position” in the Filter Target pop-up menu.
This allows you to find elements starting at certain positions, either rela-
tive to the start of the project or within each bar.

2. Open the pop-up menu in the Condition column and 
select the desired condition. 
For positions, the following options are available: 

• If you select any condition other than the Range, Bar 
Range, Cursor, Loop or Cycle options, you set up a specific 
position (in PPQ, seconds, samples, or frames) in the Pa-
rameter 1 column. Use the Bar Range/Time Base column to 
specify the time base. Note that the position for Bar Range 
is measured in ticks related to the start of the bar. 

Here, the Project Logical Editor will find all elements at the PPQ 
position 5.1.1. in the project.

• If you select Inside Range or Outside Range in the Con-
dition column, you set the start position of the range in the 
Parameter 1 column and the end position in the Parameter 
2 column. You can also change the time base using the 
Bar Range/Time Base column.
The Project Logical Editor will then find all elements inside or outside this 
position range.

• If you select one of the Bar Range options in the Condi-
tion column, the Bar Range/Time Base column will show a 
graphic bar display. You specify the range within the bar 
by clicking and dragging in the bar display (the specified 
Bar Range is indicated in blue).
The Project Logical Editor will then find all elements starting inside or 
outside this Bar Range, in all bars (within the current selection).

Here, the Project Logical Editor will find elements starting around the 
second beat in each bar.

Searching for elements of certain lengths
1. Select Length in the Filter Target pop-up menu.
This allows you to find elements of a certain length only. The Length pa-
rameter is interpreted via the time base setting in the Bar Range/Time 
Base column, i. e. in PPQ, seconds, samples, or frames.

2. Open the pop-up menu in the Condition column and 
select the desired condition. 
For lengths, the following options are available:

Condition An element will be found if it…

Equal …has the exact same value as set up in the Parameter 1 
column.

Unequal …has any value other than the one set up in the Parame-
ter 1 column.

Bigger …has a value higher than the one set up in the 
Parameter 1 column.

Bigger or 
Equal

…has a value that is the same as or higher than the one 
set up in the Parameter 1 column.

Less …has a value lower than the one set up in the 
Parameter 1 column.

Less or Equal …has a value that is the same as or lower than the one 
set up in the Parameter 1 column.

Inside Range …has a value that is between the values set up in the Pa-
rameter 1 and Parameter 2 columns. Note that Parameter 
1 should be the lower value and Parameter 2 the higher.

Outside Range …has a value that is not between the values set up in the 
Parameter 1 and Parameter 2 columns.

Inside Bar 
Range

…is within the “zone” set up in the Bar Range/Time Base 
column, in each bar within the current selection.

Outside Bar 
Range

…is outside the “zone” set up in the Bar Range/Time 
Base column, in each bar within the current selection.

Before Cursor …is before the song Project position.

Beyond Cursor …is after the song Project position.

Inside Track 
Loop

…is inside the set track loop (see “The independent track 
loop function” on page 317).

Inside Cycle …is inside the set cycle.

Exactly match-
ing Cycle

…exactly matches the set cycle. Condition An element will be found, if it…

Equal …has the exact same value as set up in the Parameter 1 
column.

Unequal …has any value other than the one set up in the Parame-
ter 1 column.

Bigger …has a value higher than the one set up in the 
Parameter 1 column.

Bigger or 
Equal

…has a value that is the same as or higher than the one 
set up in the Parameter 1 column.
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If you select any condition other than the Range options, 
you set up a specific position in the Parameter 1 column.

Here, the Project Logical Editor will find all audio parts and events in 
the project with a length smaller than 200 samples.

Searching for properties
1. Select “Property” on the Filter Target pop-up menu.

2. Open the pop-up menu in the Condition column and 
select the desired condition. 
When the Property option is selected, the Condition column has two op-
tions: “Property is set”, and “Property is not set”. 

3. Open the pop-up menu in the Parameter 1 column 
and select the desired option.
This sets which property will be searched. The options are “Event is 
muted”, “Event is selected”, and “Event is Empty”. 

Note that “event” in this context refers to all the Project 
window elements that can be modified, e. g. MIDI parts, 
audio events and parts, or transpose, arranger, and auto-
mation events.

Three examples:

Here, the Project Logical Editor will find all muted MIDI and instrument 
parts.

Here, the Project Logical Editor will find all elements that are selected 
but not muted.

Here, the Project Logical Editor will find all selected audio parts that are 
empty.

Combining multiple condition lines
As described above, you can add condition lines by click-
ing the “+” button below the list. The result of combining 
condition lines depends on the boolean And/Or operators 
and the brackets.

The bool column

By clicking in the “bool” column to the right in the list, you 
can select a boolean operator: “And” or “Or”. A boolean 
operator combines two condition lines and determines the 
result in the following way:

• If two condition lines are combined with a boolean And, 
both conditions must be fulfilled for an element to be found.

The Project Logical Editor will only find MIDI tracks.

Less …has a value lower than the one set up in the 
Parameter 1 column.

Less or Equal …has a value that is the same as or lower than the one 
set up in the Parameter 1 column.

Inside Range …has a value that is between the values set up in the Pa-
rameter 1 and Parameter 2 columns. Note that Parameter 
1 should be the lower value and Parameter 2 the higher.

Outside Range …has a value that is not between the values set up in the 
Parameter 1 and Parameter 2 columns.

Condition An element will be found, if it…
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• If two condition lines are combined with a boolean Or, 
one of the conditions (or both) must be fulfilled for an ele-
ment to be found.

The Project Logical Editor will find all parts or events that match exactly 
the cycle.

Using brackets

The bracket (parenthesis) columns let you enclose two or 
more condition lines, dividing the conditional expression 
into smaller units. This is only relevant when you have 
three or more condition lines and want to use the boolean 
Or operator.

You add brackets by clicking in the bracket columns and 
selecting an option. Up to triple brackets can be selected.

• Without brackets, the conditional expressions are eval-
uated according to their order in the list.

Here, the Project Logical Editor will find all audio parts and events 
whose name contains perc as well as other parts and events (e. g. MIDI 
parts) whose name contains drums.

Maybe you want to find all audio parts and events that ei-
ther had the name perc or the name drums (but no other 
parts or events named drums)? Then you need to add 
some brackets:

Here, all audio parts or events will be found whose name contains perc 
or drums.

Expressions within brackets are evaluated first.

If there are several layers of brackets, these are evaluated “from the inside 
out”, starting with the innermost brackets.

Specifying actions

The lower list in the Project Logical Editor window is the 
action list. This is where you specify any changes that are 
made to the found elements, relevant for the function type 
Transform.

You can perform two different kinds of actions: track-
based actions (such as Track Operation, Name) and 
event-based actions (such as Position, Length, Name). 
There are also actions that only take effect on automation 
data (Trim).

The handling of the action list is similar to the filter condi-
tion list, but without the brackets and booleans. You sim-
ply add lines by clicking the “+” button, and fill out the 
columns as required. To remove a superfluous action line, 
select it and click the “-” button.

Action Target
This is where you select the property that is changed. The 
Operations determine what to do with the Action Target. 
Below, all available operations are listed:

Position

Adjusting this value will move the elements. This parameter 
is interpreted via the time base setting in the Bar Range/
Time Base column, with the exception of the Random set-
ting, which uses the time base of the affected events:

! When you add a new condition line, the boolean set-
ting defaults to And. Therefore, if all you want to do is 
set up two or more conditions that all must be met 
for an element to be found, you do not have to think 
about the boolean column – just add the required 
lines and make the usual filter settings.

Operation Description

Add Adds the value specified in the Parameter 1 column to the 
Position.

Subtract Subtracts the value specified in the Parameter 1 column 
from the Position.

Multiply by Multiplies the Position value with the value specified in the 
Parameter 1 column.

Divide by Divides the Position value by the value specified in the Para-
meter 1 column.

Round by This “rounds” the Position value using the value specified in 
the Parameter 1 column. In other words, the Position value is 
changed to the closest value that can be divided by the Pa-
rameter 1 value.
For example, if the Position value is 17 and Parameter 1 is 5, 
the result of rounding will be 15 (the closest value that can 
be divided by 5). Another word for this type of operation 
would be “quantizing”, and it is actually possible to use it for 
this, by specifying a quantize value with Parameter 1 (in ticks, 
with 480 ticks per quarter note).
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Length

Lets you resize the elements. This parameter is interpreted 
via the time base setting in the Bar Range/Time Base col-
umn, with the exception of the Random setting, which 
uses the time base of the affected events:

Track Operation

This lets you change the track status.

Name

This lets you rename the found elements. 

Trim

This Action Target is used for automation only and lets you 
trim the found elements.

Set Color

This lets you set the color for an element. For this Action 
Target the only Operation available is “Set to fixed value”. 
To use this, insert the name of a track color in the Param-
eter 1 column, e. g. “Color 7” to use dark green as track 
color.

Set Relative 
Random 
Values 
between

This will add a random value to the current Position value. 
The added random value will be within the range specified 
with Parameter 1 and 2. Note that these can be set to nega-
tive values.
For example, if you set Parameter 1 to -20 and Parameter 2 
to +20, the original Position value will get a random variation, 
never exceeding ±20.

Set to fixed 
value

This sets the Position to the value specified in the 
Parameter 1 column.

Operation Description

Add Adds the value specified in the Parameter 1 column to the 
Length.

Subtract Subtracts the value specified in the Parameter 1 column 
from the Length.

Multiply by Multiplies the Length value with the value specified in the 
Parameter 1 column.

Divide by Divides the Length value by the value specified in the Para-
meter 1 column.

Round by This “rounds” the Length value using the value specified in 
the Parameter 1 column. In other words, the Length value is 
changed to the closest value that can be divided by the Pa-
rameter 1 value.

Set to fixed 
value

This sets the Length to the value specified in the Parameter 
1 column.

Set Random 
Values 
between

This will add a random value to the current length. The 
added random value will be within the range specified with 
Parameter 1 and 2. 

Operation Description

Folder Opens, closes or toggles folders.

Record Enables, disables or toggles the record enable status.

Monitor Enables, disables or toggles the monitor status.

Solo Enables, disables or toggles the solo status.

Mute Enables, disables or toggles the mute status.

Read Enables, disables or toggles the read enable status.

Write Enables, disables or toggles the write enable status.

EQ Bypass Enables, disables or toggles the EQ bypass status.

Inserts Bypass Enables, disables or toggles the inserts bypass status.

Operation Description

Sends Bypass Enables, disables or toggles the sends bypass status.

Lanes Active Enables, disables or toggles the lanes active status.

Operation Description

Replace Replaces names with the text specified in the Parameter 1 
column.

Append Names will be appended with the string specified in the Pa-
rameter 1 column.

Prepend The name will be prepended with the string specified in the 
Parameter 1 column.

Generate 
Name

The name will be replaced by the text specified in the Param-
eter 1 column, followed by the number set with Parameter 2. 
The number will be increased by 1 for every found element. 

Replace 
Search 
String

You can specify a search string under Parameter 1 that is re-
placed by the text specified in the Parameter 2 column.

Operation Description

Multiply by Multiplies the Trim value with the value specified in the 
Parameter 1 column.

Divide by Divides the Trim value by the value specified in the Para-
meter 1 column.

Operation Description
449
The Project Logical Editor



Selecting a function

The left pop-up menu at the bottom of the Project Logical 
Editor is where you select the function – the basic type of 
editing to be performed.

The available options are:

Delete

Deletes all elements found by the Project Logical Editor.

When you delete automation tracks and undo this op-
eration by selecting Undo from the Edit menu, the automa-
tion tracks will be restored, but the tracks will be closed.

Transform

Changes one or several aspects of the found elements. 
You set up exactly what is changed in the action list.

Select 

This will simply select all found elements, highlighting 
them for further work in the Project window.

Applying Macros
In the Macro pop-up menu you can select a macro that 
will be executed automatically after completing the actions 
defined using the Filter and Action lists. This is useful if 
you would like to extend the already powerful Project Log-
ical Editor features even further.

To use this, you set up the macro that you need in the Key 
Commands dialog (see “Setting up key commands” on 
page 581) and then select it in the Project Logical Editor 
from the Macro pop-up menu.

For example, you can use the filter conditions to select all 
tracks that contain automation data for a certain automation 
parameter (such as “volume”) and use the macro “Select all 
on Track + Delete” to remove the automation events from 
these tracks (without deleting the tracks themselves).

Applying the defined actions
Once you have set up filter conditions, selected a function 
and set the required actions (or loaded a preset), you ap-
ply the actions defined with the Project Logical Editor by 
clicking the Apply button.

Project Logical Editor operations can be undone just like 
any other editing.

Working with presets
The Presets section in the upper left section of the win-
dow allows you to load, store and manage Project Logical 
Editor presets. A preset contains all settings in the win-
dow, which means you can simply load a preset, edit the 
settings (if necessary) and click Apply.

• To load a preset, select it from the Presets pop-up 
menu. If available, an explanatory text appears to the right 
of the menu. When setting up your own presets, you can 
click in this area to enter a description.

• You can also open the Edit menu and select Presets di-
rectly from the “Process Project Logical Editor” submenu. 
This allows you to apply a preset directly, without having 
to open the Project Logical Editor.

Storing your own settings as a preset
If you have made Project Logical Editor settings that you 
want to use again, you can store them as a preset:

1. Click the Store Preset button to the right of the Pre-
sets pop-up menu.
A dialog for specifying a name for the new preset is displayed.

2. Enter a name for the preset and click OK.
The preset is stored.

To remove a preset, load it and click the Remove Pre-
set button.
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Organizing and sharing presets
The Project Logical Editor presets are stored within the 
application folder in the Presets\Logical Edit Project sub-
folder. While these files cannot be edited manually, you 
can reorganize them (e. g. putting them in subfolders) like 
any files.

This also makes it easy to share presets with other Nuendo 
users, by transferring the individual preset files.

The list of presets is read each time the Project Logi-
cal Editor is opened.

Setting up key commands for your presets
If you have stored Project Logical Editor presets, you can 
set up key commands for them:

1. Pull down the File menu and select “Key Com-
mands…”.
The Key Commands dialog opens.

2. Use the list in the Commands column to navigate to 
the category “Process Project Logical Editor” and click 
the “+” sign to display the items in the folder.

3. In the list, select the item to which you wish to assign a 
key command, click in the “Type in Key” field and enter a 
new key command.

4. Click the Assign button above the field.
The new key command appears in the Keys List.

5. Click OK to exit the dialog.

For more information on Key Commands, see the chapter 
“Key commands” on page 580.
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Background
Whenever you create a new project, Nuendo will automat-
ically set the tempo and time signature for this project. The 
tempo and signature settings can be displayed in two 
ways: either on dedicated tracks in the Project window, or 
in the Tempo Track Editor.

Tempo modes
Before we go into detail about tempo and signature set-
tings, you should understand the different tempo modes.

For each track in Nuendo that can make use of this func-
tion, you can specify whether it is time-based or tempo-
based (see “Switching between musical and linear time 
base” on page 63). For tempo-based tracks, the tempo 
can either be fixed throughout the entire project (this is 
called “fixed tempo mode”) or follow the tempo track (this 
is called “tempo track mode”), which may contain tempo 
changes.

• To switch between fixed tempo mode and tempo track 
mode, use the Tempo button on the Transport panel:

When the Tempo button is lit (and the text “Track” is 
shown), the tempo follows the tempo track; when it is de-
activated (and the text “Fixed” is shown), a fixed tempo is 
used (see “Setting the fixed tempo” on page 456). You 
can also switch the tempo mode with the Activate Tempo 
Track button on the Tempo Track Editor toolbar.

In tempo track mode, the tempo cannot be changed on 
the Transport panel, i. e. the tempo information here is for 
display purposes only.

Signature events are always active, regardless of whether 
fixed tempo mode or tempo track mode is selected.

A note about tempo-based audio tracks
For tempo-based tracks, the start position of audio events 
on the timeline depends on the current tempo setting. How-
ever, it is important to realize that the actual audio (“within” 
the events) will play back as recorded, regardless of any 
tempo changes you make. Therefore, it is good practice to 
make the proper tempo and time signature settings before 
you start recording tempo-based audio.

• To make an already recorded audio track follow the 
tempo changes, you can use the Sample Editor, see the 
chapter “The Sample Editor” on page 282.
How well this works depends on the character of the audio recordings, 
since the hitpoint detection feature works best with fairly rhythmical 
material.

• To adapt the tempo track to time-based material, you 
can use the Time Warp tool, see “The Time Warp tool” on 
page 459.
This allows you to adjust the tempo track so that tempo-based material 
(e. g. positions in music) coincides with time-based material (positions in 
narration, video, etc.).

Tempo and signature display
You can view the current tempo and signature settings of 
your project in a number of ways:

• On the Transport panel.
See above, and the section “The Transport panel” on page 84.

• By displaying the tempo track and the signature track in 
the Project window.
Open the Project menu, select Add Track and the Signature and/or 
Tempo options.

• In the Tempo Track Editor.
Open the Project menu and select Tempo Track Editor, or [Ctrl]/[Com-
mand]-click the Tempo button on the Transport panel.
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About the tempo and signature tracks
The tempo track and the signature track allow you to view 
and edit tempo and signature data in the project context. 

• The Inspectors for these tracks show the positions and 
values of individual tempo curve points or signature 
events.

• The signature track’s background always shows bars.
This is independent of the ruler display format setting.

• In the track list for the tempo track, on the far right, you 
can specify the display range by clicking on the numbers 
at the top or bottom and dragging up or down.
Note that this does not change the tempo setting, but changes the dis-
play scale of the tempo track.

• You can lock the tempo track and the signature track to 
prevent unintentional editing.
Simply click the lock symbols in the track list to lock/unlock the tracks.

About the Tempo Track Editor

If you do not want to display two extra tracks in the Project 
window, you can also open the Tempo Track Editor to 
view and edit tempo and signature information.

The Tempo Track Editor has a toolbar, info line and ruler 
just like other editors in Nuendo, plus an area for the dis-
play of time signature events and a tempo curve display.

The toolbar

The toolbar contains various tools and settings:

• The tools for Object Selection, Erase, Zoom and Draw 
are used in the same way as in other editors. The Snap 
and Auto-Scroll functions also work exactly like in the 
Project window.
Note that in the Tempo Track Editor, the Snap function affects tempo 
events only. Time signature events always snap to the beginning of bars.

• The info line in the Tempo Track Editor allows you to 
change settings for selected time signature events, and 
the type and tempo of selected tempo curve points.

• The ruler in the Tempo Track Editor shows the timeline, 
and is similar to the ruler in the Project window. See “The 
ruler” on page 47 for details.

• The area below the ruler shows time signature events. 

• The main display shows the tempo curve (or, if fixed 
tempo mode is selected, the fixed tempo – see “Setting 
the fixed tempo” on page 456). To the left of the display 
you will find a tempo scale to help you quickly locate the 
desired tempo.
Note that the vertical “grid lines” in the tempo curve display correspond 
to the display format selected for the ruler.

Toolbar Info line Ruler

Time Signature area Tempo curve display

ToolsActivate Tempo 
Track

Auto-Scroll Snap on/off

Suspend Auto-Scroll when Editing

Show Info

Curve type for new 
tempo events

The selected tempo

Snap pop-up

Tempo recording slider Open Process Tempo dialog

Open Process Bars dialog
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Editing tempo and signature
You can use the options of the Tempo Track Editor or the 
tempo and signature tracks to edit tempo and signature 
settings. The descriptions given below are valid in both 
cases. The only exception is the tempo recording slider 
(see below) which is available only in the Tempo Track 
Editor.

Editing the tempo curve

Adding tempo curve points

1. Use the “Insert curve” pop-up menu (on the toolbar of 
the Tempo Track Editor) or the “Type of New Tempo 
points” pop-up menu in the track list for the tempo track to 
select whether you want the tempo to change gradually 
from the previous curve point to the new one (“Ramp”) or 
change instantly to the new value (“Jump”).
You can also set this to Automatic. In this case, the types of existing tempo 
curve points will be used when inserting new points at the same position.

2. Select the Pencil tool.

3. Click and drag in the tempo curve display to draw a 
tempo curve.
When you click, the tempo display on the toolbar shows the tempo value. 
If Snap is activated on the toolbar, this determines at which time posi-
tions you can insert tempo curve points, see “The Snap function” on 
page 48.

• You can also click on the tempo curve with the Arrow 
tool.
This adds a single point with each click.

Tempo values can also be automatically inserted by the 
Beat Calculator, see “The Beat Calculator” on page 458.

Selecting tempo curve points

Curve points can be selected as follows:

• Using the Arrow tool.
The standard selection techniques apply.

• Using the Select submenu of the Edit menu.
The options are:

• You can also use the left and right arrow keys on the 
computer keyboard to go from one curve point to the next.
If you press [Shift] and use the arrow keys, you can select several points 
at the same time.

Editing tempo curve points

Curve points can be edited in the following ways:

• By clicking and dragging horizontally and/or vertically 
with the Arrow tool.
If several points are selected, all of them are moved. If Snap is activated 
on the toolbar, this determines to which time positions you can move 
curve points, see “The Snap function” on page 48.

• By adjusting the tempo value in the tempo display on the 
Tempo Track Editor toolbar, in the Inspector or on the info 
line.

Selecting several points and changing the tempo value 
in the info line leads to a relative adjustment of the tempo 
values.

! This section assumes that you are working in tempo 
track mode, i. e. the Tempo button must be activated 
on the Transport panel.

Insert curve set to “Ramp” Insert curve set to “Jump”

Option Description

All Selects all curve points on the tempo track.

None Deselects all curve points.

In Loop Selects all curve points between the left and right locator.

From Start 
to Cursor

Selects all points to the left of the project cursor.

From Cursor 
to End

Selects all points to the right of the project cursor.

! We recommend using the Bars+Beats display for-
mat when editing tempo curves. Otherwise, you may 
get confusing results. This is because moving a point 
will change the relationship between tempo and 
time. If you move a tempo point to the right and drop 
it at a certain time position, the mapping between 
tempo and time will be adjusted. Since you have 
changed the tempo curve, the moved point will ap-
pear at another position. 
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Adjusting the curve type

You can change the curve type of a tempo curve segment 
at any time, using the following method:

1. With the Arrow tool, select all curve points within the 
segment you want to edit.

2. In the info line, click below the word “Type” to switch 
the curve type between “Jump” and “Ramp”.
The curve sections between the selected points are adjusted.

Removing tempo curve points

To remove a curve point, either click on it with the Erase 
tool or select it and press [Backspace]. The first tempo 
curve point cannot be removed.

Recording tempo changes

The Tempo Recording slider on the toolbar of the Tempo 
Track Editor allows you to record tempo changes “on the 
fly”: simply start playback and use the slider to raise or 
lower the tempo at the desired positions. This is useful for 
creating natural sounding ritardandos, etc.

Setting the fixed tempo
When the tempo track is deactivated, the tempo track 
curve is grayed out (but still visible). Since the tempo is 
fixed throughout the whole project, there are no tempo 
curve points. Instead, the fixed tempo is displayed as a 
horizontal black line in the tempo curve display.

To set the tempo in fixed mode:

• Adjust the value numerically in the tempo display on the 
Tempo Track Editor toolbar or in the track list.

• On the Transport panel, click on the tempo value to se-
lect it, enter a new value and press [Enter].

Adding and editing time signature events
• To add a time signature event, click in the time signature 
area/track with the Pencil tool. 
This adds a default 4/4 time signature event at the closest bar position. 
Remember: When the Arrow tool is selected, pressing [Alt]/[Option] will 
give you the Pencil tool.

• To edit the value of a time signature event, select it and 
adjust the value on the info line, or double-click the event 
and enter a new value.
Note that there are two controls for the signature display; the left one ad-
justs the numerator and the right one adjusts the denominator.

• To move a time signature event, click and drag it with 
the Arrow tool.
Note that you can [Shift]-click to select multiple events. Also note that 
time signature events can only be positioned at the start of bars. This is 
also true if Snap is deactivated.

• To remove a time signature, either click on it with the 
Erase tool or select it and press [Backspace] or [Delete].
The first time signature event cannot be removed.

Exporting and importing tempo tracks
You can export the current tempo track for use in other 
projects by selecting “Tempo Track” from the “Export” 
submenu of the File menu. This allows you to save the 
tempo track information (including time signature events) 
as a special XML file (file extension “.smt”).

To import a tempo track, select “Tempo Track” from the 
Import submenu of the File menu. Note that this replaces 
all tempo track data in the current project (although the 
operation can be undone if needed).
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Process Tempo
Process Tempo allows you to define a specific length or 
end time for a set range, and the tempo track will automati-
cally set a tempo that will fit the range in the specified time. 

Proceed as follows:

1. Specify a region or range that you wish to process by 
setting the left and right locators, either in the Tempo 
Track Editor or in the Project window. 

2. Click on the Process Tempo button (either in the 
Tempo Track Editor or on the tempo track).
The Process Tempo dialog opens.

3. In the Process Range fields, the specified range is 
shown, in Bars and Beats (PPQ) and in a time format, 
which can be selected from the Time Display Format 
pop-up menu.
The range defined in step 1 will already be set, but you can edit the range 
by adjusting the values in the Process Range fields if you wish.

Now you can either specify a new range length or a new 
range end time. What to choose depends on whether the 
range should have a specific length or whether it should 
end at a specific time position.

4. Enter the desired End or Length in the corresponding 
fields of the New Range section.
You can select a time format for the new range in the Time Display For-
mat pop-up menu.

5. Click Process.
Now the tempo track is automatically adjusted, and the range will have 
the specified duration.

The Process Bars dialog 
The Process Bars dialog (opened from the Tempo Track 
Editor or the signature track) uses the global “Insert 
Silence” and “Delete Time” functions from the Range sub-
menu of the Edit menu. However, the necessary ranges (or 
parameters) are calculated using a musical “bars+beats-
based” environment. The function also ensures that the 
time signatures stay “in sync” after these operations. This 
allows for a much more intuitive approach when inserting, 
deleting or replacing “time” while working with a project set 
to the Bars+Beats time type.

The dialog contains the following elements:

Option Description

Bar Range The Bar Range display shows the bar range within the 
project as well as its length. Click on the right edge of the 
green indicator and drag it to the right to enlarge the range. 
You can also use the Start and Length value fields (see 
below). 
The arrow pair in this section marks the length of the cur-
rent project. The area to the right marks the bar range that 
can be added (500 bars max.).

Bar Range – 
Start

This is where you specify the start position for the bar 
range. Click on the arrows to raise/lower the value or 
click directly in the value field to enter the value manually.

Bar Range – 
Length

This is where you specify the length of the bar range. 
Click on the arrows to raise/lower the value or click di-
rectly in the value field to enter the value manually.

Action – 
Insert Bars

When you select this action, clicking the Process button 
will insert the specified number of empty bars with the set 
time signature at the start position specified above.

Action – 
Delete Bars

When you select this action, clicking the Process button 
will delete the specified number of bars, beginning at the 
start position specified above.

Action – 
Reinterpret 
Bars

When you select this action, clicking the Process button 
will reinterpret the bar range to fit the specified time signa-
ture. This is very special in the sense that both bars+beats 
positions of the notes and the tempo are being changed to 
fit the new time signature, but the playback of the notes will 
stay just the same. 
For example, if you want to reinterpret a bar with the time 
signature 3/4 so that it gets the time signature 4/4, quarter 
notes will become half note triplets. If you reinterpret a bar 
with the time signature 4/4 to attain 3/4, you will get qua-
druplets.
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The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of 
freely recorded audio or MIDI material. It also allows you to 
set the tempo by tapping.

Calculating the tempo of a recording
1. In the Project window, make a selection that covers an 
exact number of beats of the recording.

2. Select “Beat Calculator…” from the Project menu.
The Beat Calculator window appears.

3. In the Beats field, enter the number of beats that the 
selection encompasses.
The corresponding tempo is calculated and displayed in the BPM field.

• If you need to adjust the selection, you can go back to 
the Project window, leaving the Beat Calculator open.
To re-calculate the tempo after adjusting the selection, click Refresh.

4. You can also insert the calculated tempo into the 
tempo track by clicking one of the buttons in the lower left 
corner of the Beat Calculator window.
Clicking “At Tempo Track Start” will adjust the first tempo curve point, 
while “At Selection Start” will add a new tempo curve point at the selec-
tion’s start position, using the “Jump” curve type (see “Adding tempo 
curve points” on page 455).

Using Tap Tempo
The Tap Tempo function allows you to specify a tempo by 
tapping:

1. Open the Beat Calculator.

2. If you want to tap the tempo to some recorded mate-
rial, activate playback.

3. Click the Tap Tempo button.
The Tap Tempo window appears.

4. Tap the tempo on the Spacebar of the computer key-
board or with the mouse button.
The tempo display will update the calculated tempo between each tap.

5. Click OK to close the Tap Tempo dialog.
The tapped tempo is now shown in the Beat Calculator’s BPM display. 
You can insert it into the tempo track as described above.

Action – 
Replace Bars

When you select this action, clicking the Process button 
will cause the time signature of the specified bar range to 
be replaced by the one you specify in this dialog. 

Action – 
Signature

This lets you specify the time signature for the action you 
select on the Action pop-up menu (except for the Delete 
Bars action).

Process Click on this button to apply your changes to the speci-
fied bar range.

Close Clicking this button without clicking on “Process” first will 
close the dialog without applying your settings.

Option Description

! If fixed tempo mode is selected when you insert the 
calculated tempo, the fixed tempo will be adjusted, 
regardless of which button you click.
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Merge Tempo From Tapping
This function allows you to create a complete tempo track 
based on your tapping. Typically, you would use this if you 
have an audio file with no tempo mapping and want to be 
able to add other material afterwards, etc.

1. Create an empty time-based MIDI track and, while 
playing back your audio material, tap the new tempo on 
your MIDI keyboard and record the created notes onto the 
new MIDI track.
Note that you must create note events – pedal events cannot be used for 
this function.

2. Play back the audio and check that the timing of the 
MIDI notes corresponds to that of the audio. 
If necessary, edit the MIDI notes in an editor.

3. Select the MIDI part (or the individual notes in an edi-
tor) that you want to use for the calculation.

4. Select “Merge Tempo From Tapping” from the Func-
tions submenu of the MIDI menu.
A dialog opens.

5. In the dialog, specify what type of note (1/2, 1/4, etc.) 
you tapped during the recording.
If you activate the “Begin at Bar Start” option, the first note will automati-
cally start at the beginning of a bar when calculating the new tempo curve.

6. Click OK.
The project’s tempo is adjusted to the tapped notes.

7. Open the Project menu and select “Tempo Track” to 
check that the new tempo information is reflected in the 
tempo curve.

Another way of creating a tempo map for freely re-
corded audio would be to use the Time Warp tool, see 
below.

The Time Warp tool
The Time Warp tool lets you adjust the tempo track so that 
“musical time-based” material (positions related to the 
tempo) matches “linear time-based” material (positions in 
time). Some typical applications:

• When you have recorded music (audio or MIDI) without 
tempo reference or metronome click, the Time Warp tool 
can be used for creating a tempo map that fits the record-
ing (allowing you to rearrange or add other material).

• When you are creating music for a movie and want to 
match certain positions in the video with certain positions 
in the music.

The Time Warp tool makes use of the fact that tracks can 
be based on time positions (linear time base) or positions 
related to tempo (musical time base), see “Switching be-
tween musical and linear time base” on page 63 for a de-
scription of these modes.

Basic procedure
You use the Time Warp tool to drag a musical position (a 
position in bars+beats format) to a certain position in time. 
This can be done in the Project window or in an editor, as 
described below. Here is the general procedure:

1. Make sure tempo track mode is active.
You cannot use the Time Warp tool in fixed tempo mode.

2. Select the Time Warp tool.

Bars+Beats format is automatically selected for the ruler in the active 
window, and the ruler is shown in brown.

3. Click in the window at a musical position and drag it 
so that it matches a position in the material you are editing 
– e. g. the start of an event, a certain “hit” within an audio 
event, a frame in a video clip, etc.
When you click with the Time Warp tool, it snaps to the grid in the window.

Dragging the start of the bar to the start of the audio event.
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While you are dragging, the track(s) you are editing are 
temporarily switched to linear time base. This means that 
the contents of the tracks remain at the same time posi-
tions regardless of the tempo (there is an exception to this 
in the Project window, see below).

4. When you release the mouse button, the musical posi-
tion you clicked on matches the time position you dragged 
it to.
This is because the Time Warp tool changed the last tempo event on the 
tempo track (and/or added new ones, depending on window and usage), 
thereby scaling the tempo track to fit.

Rules
• When you use the Time Warp tool, the tempo value of 
the last tempo event (before the click position) is adjusted.

• If later tempo events exist, a new tempo event will be 
created at the click position. This way, the later tempo 
event(s) will not be moved.

• If you press [Shift] and use the Time Warp tool, a new 
tempo event is created at the click position.
[Shift] is the default modifier for this – you can adjust this in the Prefer-
ences dialog (Editing–Tool Modifiers page).

• If you use the Time Warp tool in an editor, a tempo event 
will be created at the start of the edited part or event. Only 
the currently edited track will be affected – but note that 
events to the right of the edited events or parts (on the ed-
ited track) will be affected as well.

• If you have made a selection range and use the Time 
Warp tool within that range, the tempo changes will be 
confined to that range.
This means tempo events will be inserted at the start and end of the se-
lection range, if needed – useful if you need to adjust the tempo within a 
certain area but want all material outside that range to stay in place.

• When you click with the Time Warp tool, it snaps to the 
tempo grid in the window.

• When you drag the tempo grid to a new position, it can 
be magnetic to events in the window.
In the Project window, this requires that Snap is activated and “Events” 
is selected on the Snap Type pop-up menu – the grid will then snap to 
the start and end of events or parts, and to markers. In the Sample Editor, 
this requires that Snap is activated – the grid will then snap to hitpoints 
(if any). In the MIDI editors, this requires that Snap is activated – the grid 
will then snap to the start and end of notes.

• The function will create tempo values up to 300 bpm.

Viewing and adjusting tempo events
When you select the Time Warp tool, the ruler of the ac-
tive window is shown in brown. Existing tempo events are 
shown in the ruler as “flags” with the tempo values dis-
played.

This helps you see what’s going on, but you can also use 
this for editing the tempo track:

• If you press the create/erase modifier key (by default 
[Shift]) and click on a tempo event in the ruler, it is deleted.

• You can click on a tempo event in the ruler and drag to 
move it.
This automatically edits the tempo value in the event so that elements to 
the right keep their positions.

• If you press [Alt]/[Option] and move (or delete) a tempo 
event in the ruler, the tempo value is not adjusted – this 
means elements to the right will be moved.
This is the default modifier key for this – you can adjust it in the Prefer-
ences dialog (Editing–Tool Modifiers page).

Using the Time Warp tool in the Project window
In the Project window, there are two modes for the Time 
Warp tool. To select the desired option, click on the Time 
Warp tool and click again to open a context menu. The 
available options are:

• Warp Grid
This is the default mode. If you use it, all tracks are temporarily switched 
to linear time base. This means that all tracks will keep their absolute time 
positions when you adjust the tempo track.

• Warp Grid (musical events follow)
If you use this mode, no tracks are switched to linear time base. This 
means that all tracks that are not set to linear time base will follow the 
changes you make to the tempo track.
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Matching a musical score to video

Here’s an example of how to use the Time Warp tool in 
“musical events follow” mode. Let’s say you are creating 
the music for a film. You have a video track, an audio track 
with a commentary and some audio and/or MIDI tracks 
with your music. Now you want to match the position of a 
musical cue to a position in a video film. The musical cue 
is located in bar 33. There are no tempo changes in the 
project (yet).

1. Make sure tempo track mode is selected on the Trans-
port panel.

2. Now you need to locate the position in the video. If you 
do not need very high precision, you can simply locate it 
looking at the thumbnails on the video track – otherwise 
you can pinpoint the exact position and add a marker to 
the marker track (that you can snap to later on).
You can also make a note of the exact position and add an extra ruler 
track set to show the timecode.

3. Make sure that the correct tracks are set to linear time 
base or musical time base, respectively.
In our example, we want the video track and the audio track with a com-
mentary voice-over to be linear time-based (as well as the marker track, if 
used). All other tracks should be set to musical time base. You change 
this by clicking the time base button in the track list or Inspector.

4. Set up the Grid Type pop-up menu as desired.
When you click with the Time Warp tool, it snaps to the selected grid. In 
this case, you will find the musical cue at the start of bar 33, so we can 
set the grid to “Bar”.

• Note that this affects the snapping to the ruler (tempo 
grid) when you click! In addition, the tool can be “magnetic” 
to events in the Project window when you drag – for this, 
you need to activate the Snap function, open the Snap 
Type pop-up menu, and select “Events”. 
In our example, this would be useful if you created a marker at the de-
sired position in the video – when you drag the grid (see below), it will 
snap to the marker.

5. Click on the Time Warp button and click again to open 
a pop-up menu.

6. Select the “Warp Grid (musical events follow)” mode.

7. Click in the event display at the start of bar 33 and 
drag to the desired position in the video.
As mentioned above, this can mean dragging to a position indicated by 
the thumbnails on the video track, to a marker on the marker track or to a 
time position on an additional ruler track.

When you drag, the ruler is scaled – and the music tracks 
will follow.

8. Release the mouse button.
If you look in the ruler at the beginning of the project, you will see that the 
first (and only) tempo event has been adjusted.

9. Try playing back.
The musical cue should now happen at the correct position in the video.

Let’s say you need to match another cue to another posi-
tion later on in the video. If you simply repeat this proce-
dure, you will find that the first cue gets out of sync – 
since you are still changing the first (and only) tempo 
event on the tempo track!

You need to create a “lock point” – a tempo event at the 
first cue position:

10. Press [Shift] and click with the Time Warp tool in the 
event display at the cue position.
In our case, this is bar 33.

A tempo event (with the same value as the first one) is 
added at that position.

Musical time base selected Linear time base selected
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11. Now match the second musical cue to the correct 
video position by dragging the musical position to the 
desired time position as before.
The new tempo event is edited – the first tempo event is unaffected and 
the original cue is still matched.

• If you know you are going to match several cues this 
way, make it a habit to press [Shift] each time you use the 
Time Warp tool to match positions.
This adds a new tempo event – that way, you do not have to add tempo 
events afterwards as described above.

About snapping

If Snap is activated in the Project window and “Events” is 
selected on the Snap Type pop-up menu, the Time Warp 
tool will be magnetic to events when you drag the tempo 
grid. This makes it easier to snap a tempo position to a 
marker, the start or end of an audio event, etc.

Using the Time Warp tool in an audio editor
Using the Time Warp tool in the Sample Editor or Audio 
Part Editor is different from using it in the Project window, 
in the following ways:

• When you use the Time Warp tool, a tempo event is 
automatically inserted at the beginning of the edited event 
or part. This tempo event will be adjusted when you warp 
the tempo grid with the tool. 
This means that material before the edited events will not be affected.

• Only the default mode for the Time Warp tool is avail-
able. 
This means that when you use the tool, the edited track is temporarily 
switched to linear time base.

Making a tempo map for a “free” recording

The following example shows how to use the Time Warp 
tool in the Sample Editor to create a tempo map matching 
freely recorded music. Let’s say you have recorded a 
drummer, playing without a metronome – this typically 

means the tempo varies ever so slightly. To be able to add 
more material and easily rearrange the recorded audio, 
you want the tempo in Nuendo to match the recorded 
drum track:

1. If necessary, move the recorded event.
Move it so that the first downbeat (“one”) happens at the start of the bar 
– zoom in if needed.

2. Open the drum recording in the Sample Editor and 
make sure Hitpoint mode is not selected.
The Time Warp tool cannot be used in Hitpoint mode. However, if you 
have calculated hitpoints already, these will be visible when the Time 
Warp tool is selected (see below).

3. Set the zoom so that you can see the individual drum 
hits clearly.
To achieve this type of “visual” beat matching, it is important to have a 
fairly clean recording, such as the drum track in this example.

4. Select the Time Warp tool.

You have already matched the first downbeat with the 
start of a bar. However, if the recording starts before the 
first downbeat (with a fill, some silence, etc.), you want to 
“lock” the first downbeat so that it stays in position:

5. Press [Shift] and click in the event at the position of 
the first downbeat (the start of the bar).
When you press [Shift], the pointer turns into a pencil. Clicking adds a 
tempo event at the first downbeat – when you later adjust the tempo with 
the Time Warp tool, the first downbeat will stay in place. Note that if the 
event starts exactly on the first downbeat (no audio before the “one”), 
you do not need to do this. This is because a tempo event is automati-
cally added at the start of the edited event.

6. Now, locate the start of the next bar in the ruler. 

7. Click at that position in the event display and drag to 
the downbeat of the second bar in the recording.
When you click, the pointer will snap to the ruler grid.

By dragging the grid, you changed the tempo value in the 
tempo event at the first downbeat. If the drummer held a 
fairly consistent tempo, the following bars should now 
match pretty well, too.

8. Check the following bars and locate the first position 
where the audio drifts from the tempo.
462
Editing tempo and signature



Now, if you simply adjusted that beat in the tempo grid to 
match the beat in the recording, the tempo event at the 
first downbeat would be changed – this would ruin the 
match in the previous bars! We need to lock these by in-
serting a new tempo event.

9. Locate the last beat that is in sync.
This would be the beat just before the position where the audio and 
tempo drift apart.

10. Press [Shift] and click at that position to insert a tempo 
event there.
This locks this matched position. The material to the left will not be affected 
when you make adjustments further along.

11. Now match the tempo grid to the next (unmatched) 
beat by clicking and dragging with the Time Warp tool.
The tempo event you inserted in step 10 will be adjusted.

12. Work your way through the recording this way – when 
you find that the recording drifts from the tempo, repeat 
steps 9 to 11 above.

Now the tempo track follows the recording and you can 
add more material, rearrange the recording, etc.

Matching to hitpoints

If you have calculated hitpoints for the audio event you are 
editing, these will be shown when the Time Warp tool is 
selected.

• The number of hitpoints shown depends on the Hitpoint Sen-
sitivity slider setting you have made in Hitpoint mode.

• If you activate the Snap to Zero Crossing button on the tool-
bar, the Time Warp tool will snap to hitpoints when you drag 
the tempo grid.

• You can use the Create Markers from Hitpoints function (on 
the Hitpoints submenu of the Audio menu) to create markers 
at the hitpoint positions. This can be useful when using the 
Time Warp tool in the Project window, as the tool will be mag-
netic to markers (if the Snap Type is set to Events).

Using the Time Warp tool in a MIDI editor
This is very similar to using the tool in an audio editor:

• When you use the Time Warp tool, a tempo event is automat-
ically inserted at the beginning of the edited part – this tempo 
event will be adjusted when you warp the tempo grid with the 
tool. Material before the edited part will not be affected.

• Only the default mode for the Time Warp tool is available. So 
when you use the tool, the edited MIDI track is temporarily 
switched to linear time base.

• The rulers in the MIDI editors can be set to “Time Linear” or 
“Bars+Beats Linear” mode (see “The ruler” on page 407) – 
the Time Warp tool requires Time Linear mode. If necessary, 
the ruler mode will be switched when you select the Time 
Warp tool.

• If Snap is activated on the toolbar in the MIDI editor, the tool 
will snap to the start and end of MIDI notes when you drag the 
tempo grid.

Typically, you would use the Time Warp tool in a MIDI 
editor to match the Nuendo tempo to freely recorded MIDI 
material (much like the audio example above).
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Window Overview

The Project Browser window provides a list based repre-
sentation of the project. This allows you to view and edit all 
events on all tracks by using regular value editing in a list.

Opening the Project Browser
You open the Project Browser by selecting “Browser” from 
the Project menu. The Browser window can be open while 
you are working in other windows; any changes made in the 
Project window or an editor are immediately reflected in the 
Project Browser and vice versa.

Navigating in the Browser
You use the Project Browser much like you use the Win-
dows Explorer and Mac OS X Finder for browsing folders 
on your hard disk:

• Click on an item in the Project Structure list to select it 
for viewing.
The contents of the item are shown in the event display.

• Items with hierarchical substructures can be folded out 
by clicking the “+” symbols or the “closed folder” symbols 
in the Project Structure list.
When the substructure of an item is revealed, a “-” symbol or an “open 
folder” symbol is shown instead – click this to hide the substructure.

• To reveal or hide all substructures in the Project Struc-
ture list, use the buttons “(+) All” and “(–) All” above the list.

• The actual editing is done in the event display, using 
regular value editing techniques.
There is one exception: You can rename items in the Project Structure 
list by clicking on their names and typing.

Customizing the view
You can drag the divider between the Project Structure 
list and the event display to make one of them wider and 
the other narrower. Furthermore, the event display can be 
customized in the following ways:

• You can change the order of the columns by dragging 
the column headings to the left or right.

• You can resize columns by dragging the dividers be-
tween the column headings.

• To select a display format for all position and length val-
ues, use the Time Format pop-up menu.

Project Structure 
list. This is where 

you navigate 
through the project.

Event display. This is 
where you view and 
edit parts, events and 
regions.

Add pop-up menu and Add button for  
creating new parts, events and regions.

Filter pop-up menu, used for 
MIDI editing

Time Format (display format) 
pop-up menu
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• You can sort events in the display by columns, by click-
ing the column heading.
For example, if you want to sort events by their start positions, click that 
column heading. An arrow appears in the column heading, indicating that 
events are sorted by that column. The direction of the arrow indicates 
whether the events are sorted in ascending or descending order. To 
change the direction, click the column heading again.

Importing files via the MediaBay
You can also import audio, video and MIDI files into the 
Project Browser via the MediaBay using drag and drop.

You can only import into existing tracks. This means, for 
example, that a video track has to exist in the Project win-
dow prior to importing a video file in the Project Browser.

For more information about the MediaBay, see “The Media-
Bay” on page 334.

About the Sync Selection option
If the “Sync Selection” checkbox is activated (on the 
Project Browser toolbar), selecting an event in the Project 
window automatically selects it in the Project Browser, and 
vice versa. This makes it easy to locate events in the two 
windows.

Editing tracks

Editing audio tracks
Audio tracks can have two “subitems”: Track Data and 
Automation. 

• The Automation item corresponds to the automation track in 
the Project window, and contains the track’s automation 
events (see “Editing automation tracks” on page 468).

• The Track Data item corresponds to the actual audio track in 
the Project window. It contains audio events and/or audio 
parts, which in turn can contain audio events.

Note that if you have not performed any automation or 
opened an automation track, the Browser will only contain 
the audio data.

The following parameters are available for the different 
items:

The list columns for audio events

Parameter Description

Name Allows you to change the name of the event. Double-click-
ing on the waveform image beside it opens the event in the 
Sample Editor.

File The name of the audio file referenced by the event’s au-
dio clip.

Start The start position of the event. If the event belongs to an 
audio part, you cannot move it outside the part.

End The end position of the event. 

Snap The absolute position of the event’s snap point. Note that 
adjusting this value will not change the position of the snap 
point within the event – instead it is another way of moving 
the event!

Length The length of the event. 

Offset This determines “where in the audio clip” the event starts. 
Adjusting this value is the same as sliding the contents of 
the event in the Project window (see “Sliding the con-
tents of an event or part” on page 74). 
You can only specify positive Offset values, since the 
event cannot start before the start of the clip. Likewise, it 
cannot end after the end of the clip. If the event already 
plays the whole clip, the Offset cannot be adjusted at all.

Volume The volume of the event, as set with the Volume handle or 
on the info line in the Project window.

Fade In
Fade Out

The length of the fade-in and fade-out areas respectively. 
If you use these settings to add a fade (where there pre-
viously was none), a linear fade will be created. If you ad-
just the length of an existing fade, the previous fade 
shape will be maintained.

Mute Click in this column to mute or unmute the event.

Image Displays a waveform image of the event inside a gray box 
corresponding to the clip. The image is scaled according 
to the width of the column.
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The list columns for audio parts

Creating audio parts

When the “Audio” item of an audio track is selected in the 
Project Structure list, you can create empty audio parts on 
the track by clicking the Add button on the toolbar. This 
will insert a part between the left and right locator.

Editing MIDI tracks
Just like audio tracks, MIDI tracks can have two “subitems”: 
Track Data and Automation.

• The Track Data item corresponds to the actual MIDI track in 
the Project window and can contain MIDI parts (which in turn 
can contain MIDI events).

• The Automation item corresponds to the automation track in 
the Project window, and contains the track’s automation 
events (see “Editing automation tracks” on page 468).

Note that if you have not performed any automation or 
opened an automation track, the Browser will only contain 
the MIDI data.

When editing the Track Data, the following parameters are 
available:

The list columns for MIDI events

The list columns for MIDI parts

Parameter Description

Name The name of the part. Double-clicking on the part symbol 
beside it opens the part in the Audio Part Editor.

Start The start position of the part. Editing this value is the 
same as moving the part in the Project window.

End The end position of the part. Editing this value is the same 
as resizing the part in the Project window.

Length The length of the part. Editing this value is the same as 
resizing the part in the Project window.

Offset This adjusts the start position of the events within the part. 
Adjusting this value is the same as sliding the contents of 
the part in the Project window (see “Sliding the contents of 
an event or part” on page 74). Setting a positive Offset 
value is the same as sliding the contents to the left, while a 
negative Offset corresponds to sliding the contents to the 
right.

Mute Click in this column to mute or unmute the part.

Parameter Description

Type The type of MIDI event. This cannot be changed.

Start The position of the event. Editing this value is the same as 
moving the event.

End This is only used for note events, allowing you to view and 
edit the end position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of 
the note – changing this resizes the note and automati-
cally changes the End value as well.

Data 1 The property of this value depends on the type of MIDI 
event:
For notes, this is the note number (pitch). This is displayed 
and edited as a note name and an octave number, with the 
values ranging between C-2 and G8.
For controller events, this is the type of controller, dis-
played in words. Note that you can edit this by entering a 
number – the corresponding controller type is automati-
cally displayed.
For pitchbend events, this is the fine adjustment of the 
bend amount.
For poly pressure events, this is the note number (pitch).
For other event types, this is the value of the event.

Data 2 The property of this value depends on the type of MIDI 
event:
For notes, this is the note-on velocity.
For controller events, this is the value of the event.
For pitchbend events, this is the coarse bend amount.
For poly pressure events, this is the amount of pressure.
For other event types, this is not used.

Channel The event’s MIDI channel, see “Notes” on page 106.

Comment This column is used for some event types only, providing 
an additional comment about the event.

Parameter Description

Name The name of the part.

Start The start position of the part. Editing this value is the 
same as moving the part.

End The end position of the part. Changing this is the same as 
resizing the part (and will automatically affect the Length 
value as well).

Length The length of the part. Changing this resizes the part and 
automatically changes the End value.

Offset This adjusts the start position of the events within the 
part. Adjusting this value is the same as sliding the con-
tents of the part in the Project window (see “Sliding the 
contents of an event or part” on page 74). Setting a pos-
itive Offset value is the same as sliding the contents to 
the left, while a negative Offset corresponds to sliding the 
contents to the right.

Mute Click in this column to mute or unmute the part.

Parameter Description
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For SysEx (system exclusive) events, you can only edit 
the position (Start) in the list. However, clicking the Com-
ment column opens the SysEx Editor, in which you can 
perform detailed editing of system exclusive events. For a 
description of this, see “Working with SysEx messages” 
on page 427.

Filtering MIDI events

When you are editing MIDI in the Project Browser, the large 
number of different MIDI events displayed can make it hard 
to find the events you want to edit. The Filter pop-up menu 
allows you to select a single event type for display.

When this option is selected, only Controller events will be shown in 
the event display. To show all event types, select the top item (“---”) 
from the menu.

Creating MIDI parts

When a MIDI track is selected in the Project Structure list, 
you can create empty MIDI parts on the track by clicking 
the Add button. This will insert a part between the left and 
right locator.

Creating MIDI events

You can use the Project Browser to create new MIDI 
events:

1. Select a MIDI part in the Project Structure list.

2. Move the project cursor to the desired position for the 
new event.

3. Use the Add pop-up menu above the event display to 
select which type of MIDI event to add.

4. Click the Add button.
An event of the selected type is added to the part, at the project cursor 
position. If the cursor is outside the selected part, the event is added at 
the beginning of the part.

Editing automation tracks
All kinds of Nuendo automation (the automation tracks for 
MIDI, instrument, audio, group, and FX channel tracks, or 
the individual automation tracks for VST instruments, 
ReWire channels, or input and output busses) are handled 
in the same way in the Project Browser. Each Automation 
item in the Project Structure list will have a number of sub-
entries, one for each automated parameter. Selecting one 
of these parameters in the Project Structure list shows its 
automation events in the list:

You can use the two columns in the list to edit the position 
of the events and their values.

Editing the video track
When the video track is selected in the Project Structure 
list, the event display lists the video events on the track, 
with the following parameters:

Column Description

Name The name of the video clip that the event refers to.

Start The start position of the event. Editing this value is the 
same as moving the event.

End The end position of the event. Editing this value is the 
same as resizing the event, and will automatically change 
the Length value as well.
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Editing marker tracks
Marker events have the following parameters:

You can insert markers on the selected marker track by 
selecting “Marker” or “Cycle Marker” from the Add pop-up 
menu and clicking the Add button. Regular markers will be 
added at the current project cursor position while cycle 
markers will be added between the current left and right 
locator positions.

The Project Browser only displays the default attributes.

For further information on markers and marker tracks, refer 
to the chapter “Using markers” on page 136.

Editing the tempo track
When the tempo track is selected in the Project Structure 
list, the event display shows the events on the tempo 
track, with the following parameters:

You can add new tempo events by clicking the Add but-
ton. This creates a jump-type event with the value 120 
bpm at the project cursor position. Make sure that there is 
no other tempo event at the current cursor position.

Editing time signatures
When “Signature track” is selected in the Project Structure 
list, the event display shows the time signature events in the 
project:

You can add new time signature events by clicking the 
Add button. This creates a 4/4 event, at the beginning of 
the bar closest to the project cursor position. Make sure 
that there is no other time signature event at the current 
cursor position.

Deleting events
The procedure for deleting events is the same for all differ-
ent track types:

1. Click on an event (or a part) in the Event display to se-
lect it.

2. Select Delete from the Edit menu or press [Delete] or 
[Backspace].

Length The length of the event. Editing this value is the same as 
resizing the event, and will automatically change the End 
value as well.

Offset This determines “where in the video clip” the event starts.
Note that the event cannot start before the start of the 
clip, or end after the end of the clip. Thus, if the event al-
ready plays the whole video clip, the Offset cannot be ad-
justed at all.

Column Description

Description The name of the marker. This can be edited for all markers 
except the left and right locator.

Start The position of “regular” markers or the start position of 
cycle markers.

End The end positions of cycle markers. Editing this value is 
the same as resizing the cycle marker, and will automati-
cally change the Length value as well.

Length The length of cycle markers. Editing this value is the same 
as resizing the marker, and will automatically change the 
End value as well.

ID The number of the marker. For regular (non-cycle) mar-
kers, this corresponds to the key commands used for 
navigating to the markers. For example, if a marker has 
ID 3, pressing [Shift]-[3] on the computer keyboard will 
move the song position to that marker. By editing these 
values, you can assign the most important markers to key 
commands.
Note that you cannot edit the “L” and “R” marker IDs (left 
and right locator) or assign IDs 1 and 2 to markers (since 
these are reserved for the locators).

Column Description

Parameter Description

Position The position of the tempo event. You cannot move the 
first event on the tempo track.

Tempo The tempo value of the event.

Type This indicates whether the tempo jumps to the value of 
the event (“Jump” type) or whether it changes gradually 
from the previous tempo event, creating a ramp (“Ramp” 
type), see “Editing the tempo curve” on page 455.

Parameter Description

Position The position of the event. Note that you cannot move the 
first time signature event.

Signature The value (time signature) of the event. 

! Note that you cannot delete the first tempo event or 
the first time signature event.
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Overview
The track sheet provides a text-form “flow-chart” repre-
sentation of the Project. It lists all audio (and video) tracks 
and their contents, and can easily be printed out. 

To open the Track Sheet window, select “Track Sheet” 
from the Project menu.

The actual track sheet is displayed in the lower part of the 
window. It contains the following items:

• The leftmost time column contains a list of time posi-
tions in the display format selected in the Project Setup 
dialog.
The time positions relate to start and end times of audio or video events 
or parts on the tracks.

• The following columns display the tracks in the order 
they appear in the track list.
Only audio and video tracks are shown.

• The events are listed in their corresponding track col-
umns in the order they appear (starting at the top).

• For each event, the start and end times are shown, with 
a vertical line binding the two together.

Viewing the pages in the track sheet
If your project is large (i. e. there are many tracks and/or 
many events) or if you are working with a large scale factor 
(see below), the resulting track sheet may have more than 
one page.

The more tracks you have, the larger the number of pages 
next to each other (horizontally). The more events you 
have, the larger the number of pages below each other.

To select which page is visible in the Track Sheet window, 
you use the “Y Page” and “X Page” fields in the upper left 
part of the Track Sheet window. Think of the Track Sheet 
as divided into rows and columns, with “Y Page” deter-
mining which row is viewed and “X Page” determining the 
column. The numbers in parenthesis show the total num-
ber of rows and columns, respectively.

• The size and proportions of the Track Sheet pages are 
set with the Page Setup dialog, see “Printing the track 
sheet” on page 472.

In this case, the page in row 2 and column 3 is shown:

X
Y

1 2 3 4

1

2
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Adjusting the view
The two sliders at the bottom of the Track Sheet window 
have the following functionality:

• The slider in the lower left corner is the scale slider.
Use this to adjust the actual size of the track sheet contents (including 
the font sizes). This will also affect the number of tracks and events 
shown on each page. 

• The slider in the lower right corner governs the display 
zoom.
This affects how much of the track sheet is shown in the Track Sheet 
window – the printout is not affected.

You can also adjust the width of the columns by dragging 
the edges of the “Timecode” and “Tracks” fields at the top 
of the window – this resizes the corresponding columns in 
the Track Sheet.

Resizing the track columns. If the Timecode and Tracks fields are 
hidden, click the “More” button.

Additional settings
• The “Pen Width” determines the thickness of the verti-
cal lines that bind together the start and end times for 
events and parts.

• If the track sheet is more than one page wide, you can 
use the “Timecode Column” pop-up menu to determine 
whether the time column only appears on the first page, 
on each new page, or not at all.

The following settings can be shown or hidden by clicking 
the “More/Less” button.

Printing the track sheet
Printing is done using the standard procedures:

1. On the File Menu, select the “Page Setup…” option.
The Page Setup dialog opens.

2. Make sure that the correct page size and page orien-
tation are selected.
You may also want to make additional printer settings, following the stan-
dard Windows/Mac procedures.

3. Select “Print...” from the File menu.
Make the desired printer settings in the dialog that opens, and click OK. 
The track sheet is printed.

Setting Description

Project By default, this is the name of the current project, but you 
can adjust this if you like. The project name will be shown 
in the top left corner of each track sheet page.

Editor The editor name you enter will be shown below the 
project name in the track sheet.

Heading Allows you to enter a heading (shown centered at the top 
of each track sheet page).

Do not show 
end times if 
length is 
under...

If this checkbox is ticked, the track sheet will not display 
the end times of events shorter than the time specified in 
the field to the right. This is useful if you have many short 
events, like spot effects, where only the start time is of 
any relevance.

No leading 
zeroes

By default, the time positions of events will be listed in a 
syntax with “leading zeroes”. For example, if the display 
format is seconds, hours and minutes will be listed as 
“01”, “02” etc. If this is activated, the time column will not 
display the leading zeroes.

Merge events if 
gap is less or 
equal...

If events on a track are lined up end to end – i. e. there is 
no gap between them – they will be considered as a sin-
gle event in the track sheet. By defining a value in this 
box, you can specify how large a gap between events has 
to be for them to be considered as separate events. If 
gaps between events are smaller than or equal to the 
value you specify, they will be listed as a single event. 
Otherwise they will be listed as separate events.

Name Filter This allows you to filter out certain event names of your 
choice so that they are not displayed in the track sheet. 
Click in the text field and type in the name(s) – to enter 
several names, separate each with a semi-colon (;). Par-
tial names are OK, so if you want to filter out the event 
name “Crossfade”, for example, you could just write 
“Cross”. However, this would filter out other events start-
ing with the word cross as well – e. g. “Crosstalk” would 
also be filtered out.

Setting Description
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Introduction
The Export Audio Mixdown function in Nuendo allows you 
to mix down audio from the program to files on your hard 
disk in a number of formats. In the Channel Selection sec-
tion, you can choose which channels (or busses) to ex-
port. By activating the “Channel Batch Export” option you 
can choose to mix down several channels in one go. For 
each channel, an individual file will be created.

The following channel types are available:

• Output channels
For example, if you have set up a stereo mix with tracks routed to a stereo 
output bus, mixing down that output bus will give you a mixdown file con-
taining the whole mix. Similarly, you can mix down a complete surround 
bus, either to a single multi-channel file or to one file per surround chan-
nel (by activating the Split Channels option).

• Audio track channels
This will mix down the channels for the tracks, complete with insert ef-
fects, EQ, etc. This can be useful for turning a number of events into a 
single file, or to convert tracks with insert effects into audio files (that are 
less CPU-intensive). Simply export the track and re-import the file into 
the project.

• Any kind of audio-related Mixer channel
This includes VST instrument channels, instrument tracks, effect return 
channels (FX channel tracks), group channels, and ReWire channels. 
There are many uses for this – for example, you can mix down an effect 
return track or turn individual ReWire channels into audio files.

Please note the following:

• The Export Audio Mixdown function mixes down the 
area between the left and right locators or ranges defined 
by cycle markers.

• When you mix down, you get what you hear – mutes, 
Mixer settings, record enable, and insert effects are taken 
into account.
Note though that you will only include the sound of the channels you se-
lect for mixdown.

• MIDI tracks are not included in the mixdown!
To make a complete mixdown containing both MIDI and audio, you first 
need to record all your MIDI music onto audio tracks (by connecting the 
outputs of your MIDI instruments to your audio inputs and recording, as 
with any other sound source).

Mixing down to audio files
1. Set up the left and right locators to encompass the 
section you want to mix down.
You can also set up a cycle marker accordingly.

2. Set up your tracks so that they play back the way you 
want.
This includes muting unwanted tracks or parts, making manual Mixer set-
tings and/or activating the R (Read) automation buttons for some or all 
Mixer channels.

3. Pull down the File menu and select “Audio Mixdown…” 
from the Export submenu.
The Export Audio Mixdown dialog opens.

4. In the Channel Selection section to the left, select the 
channels you want to mix down. The list contains all output 
and audio-related channels available in the project (see 
“About the Channel Selection section” on page 475).
Activate the Channel Batch Export option if you want to mixdown several 
channels at once.

5. If you want to export a cycle marker range instead of 
the area between the left and right locators, activate the 
Export Cycle Marker(s) option and select the correspond-
ing marker(s).
Only the cycle markers of the active track can be selected. On export, 
you get one audio file for each section defined by a cycle marker. Please 
keep in mind that working with channel batch export and cycle markers 
might lead to a high file number. For example, exporting five tracks and 
three cycle markers leads to 15 new audio files.
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6. In the File Location section at the top you can set up 
the naming scheme for the exported files and select a path 
for the mixdown files.
For details about the naming options, see “About the File Location sec-
tion” on page 476.

7. Select an entry from the File Format pop-up menu and 
make additional settings for the file to be created.
This includes codec settings, meta data, sample rate, bit depth, etc. The 
available options depend on the selected file format, see “The available 
file formats” on page 478.

8. In the Audio Engine Output section, specify whether 
you want to export all subchannels of a multi-channel bus 
as separate mono files (Split Channels), downmix all sub-
channels to one mono file (Mono Downmix), or export only 
the left and right channels of a multi-channel bus to a ste-
reo file (L/R Channels).
For details about the settings relating to the audio engine, see “About the 
Audio Engine Output section” on page 477.

9. Activate Realtime Export if you want the export to hap-
pen in realtime (see “About the Audio Engine Output sec-
tion” on page 477).

10. If you want to automatically import the resulting audio 
files back into Nuendo, activate any of the checkboxes in 
the “Import into Project” section.
For details about the available options, see “About the Import into Project 
section” on page 478.

11. If you activate Update Display, the meters will be up-
dated during the export process.
This allows you to check for clipping, for example.

12. Click Export.
A dialog with a progress bar is displayed while the audio file or files are 
being created. To cancel the operation, you can click the Abort button.

• During the realtime export of a single channel, the Audi-
tion Volume fader is displayed in the progress dialog (see 
“About the Audio Engine Output section” on page 477). It 
allows you to adjust the Control Room volume. 
Note that this fader is only available if the Control Room is activated.

• If the “Close Window after Export” option is activated, 
the dialog will be closed automatically.

• If you have activated any of the options in the “Import 
into Project” section, the mixdown file(s) will be imported 
back into the same or a new project.
When playing back the reimported file in the same Nuendo project, mute 
the original tracks so that you only hear the mixdown.

The Export Audio Mixdown dialog
Below you will find detailed descriptions of the different 
sections of the dialog and the corresponding functions.

About the Channel Selection section
The Channel Selection section shows all output and au-
dio-related channels available in the project. These chan-
nels are organized in a hierarchical structure that allows 
you to easily identify and select the channels you want to 
export. The different channel types are listed below each 
other, with channels of the same type being grouped in a 
node (e. g. instrument tracks).

• You can activate/deactivate channels by clicking on the 
checkboxes in front of the channel names.

• If Channel Batch Export is activated, you can also acti-
vate/deactivate all channels of the same type by clicking 
on the checkbox in front of the channel type entry.

• If Channel Batch Export is activated, you can select/de-
select several channels in one go using the [Shift] and/or 
[Ctrl]/[Command] modifiers and then clicking on any of 
the checkboxes for the highlighted channels.
Note that this toggles the activation status of a channel, i. e. all selected 
channels that were previously activated will be deactivated and viceversa.

• If your project contains a large number of channels, it 
might get difficult to find the desired channels in the 
Channel Selection section. To simplify the process of se-
lecting several channels, you can filter the display. Simply 
type in the desired text (e. g. “voc” to show all tracks con-
taining vocals) in the Filter field below the tree view.

! If you set the export range in such a way that the ef-
fects applied to a preceding event (e. g. reverb) reach 
into the next, these will be heard in the mixdown (even 
though the event itself is not included). If you do not 
want this, you need to mute the first event before ex-
porting.
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About the Cycle Marker Selection section
If you have already setup cycle markers to organize your 
project (see “Cycle markers” on page 137), or if you want 
to export different subsections of a project in one go, it 
might be useful to define the export range based on cycle 
markers. This is done in the Cycle Marker Selection sec-
tion at the bottom left of the window.

• To select the export range, activate the “Export Cycle 
Marker(s)” option and select the desired marker(s) from 
the list.
A checkmark in front of the marker ID indicates that a cycle marker is se-
lected.

• If you have selected several cycle markers and click the 
Export button, the ranges defined by these markers are 
exported one after the other, starting with the topmost 
marker in the list.

If “Export Cycle Marker(s) is activated, the Naming 
Scheme pop-up menu (see below) contains two more 
elements: Cycle Marker Name and Cycle Marker ID.

About the File Location section
In the File Location section you can specify a name and a 
path for the exported files. Furthermore, you can define the 
naming scheme for the exported files.

At the right of the Name and the Path fields there are two 
pop-up menus with a number of options:

Naming Options

• Select “Set to Project Name” to set the Name field to 
the project name.

• Activate the “Auto Update Name” option to add a num-
ber to the specified file name every time you click the Ex-
port button.

Path Options

• Select “Choose…” to open a dialog in which you can 
browse for a path and enter a file name. 
The file name will automatically be shown in the Name field.

• Select an entry from the Recent Paths section to reuse 
a path specified for a previous export.
This section is only shown after an export has been completed. With the 
“Clear Recent Paths” option you can delete all entries from the Recent 
Paths section.

• Activate the “Use Project Audio Folder” option to save 
the mixdown file in the project’s Audio folder.

Naming Scheme

Clicking the “Naming Scheme…” button opens a separate 
pop-up window. Here you can choose a number of ele-
ments that will be combined to form the file name. Depend-
ing on the settings in the Channel Selection and Marker 
Selection sections, the following elements are available: 
Name, Project Name, Mixer Index, Channel Type, Channel 
Name, and Counter, as well as Cycle Marker Name and Cy-
cle Marker ID.

The elements are defined as follows:

! When using multiple marker tracks, this section al-
ways shows the cycle markers from the track that 
has the focus.

Element Description

Name The name that you entered in the Name field (in the File 
Location section).

Mixer Index The number of the Mixer channel.

Channel Type The type of audio-related channel that is being exported.

Channel Name The name of the exported channel.

Project Name The name of the Nuendo project.

Counter This is only available for batch export. Use this to include 
an incrementing number in the generated files names in 
order to create unique file names.

Cycle Marker 
Name

This is only available for cycle marker exports. This is the 
name as shown in the Marker window or the info line in 
the Project window.

Cycle Marker 
ID

This is only available for cycle marker exports. This is the 
ID as shown in the Project window and the Marker sec-
tion of the Export Audio Mixdown dialog.
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By combining the available naming elements, you can 
make sure that all the files of a batch are exported with 
unique names. If you have set up a naming scheme that 
would result in identical file names, a warning message 
appears when you click the Export button.

• To add an element, press the “+” button on the far right, 
and to remove an element from the naming scheme click 
the corresponding “-” button.
You can also remove an element by dragging it out of the Elements sec-
tion.

• To rearrange the sequence, simply click on an element 
and drag it to a different position.

• To choose a different element for a certain position, 
click on the element name and select a new entry from the 
pop-up menu.
The elements can only be used once in a naming scheme. The pop-up 
menu therefore shows only those elements that are still available. 

Below the Elements section you will find some additional 
options:

The field below these options shows a preview of what the 
resulting file names will look like. For example, if you set up 
the elements as follows:

<Project Name> - <Channel Name> - <Cycle Marker 
Name>

This could result in a file name such as the following:

Reel2 - Dialogue - Scene15.wav

To close the Naming Scheme pop-up window, simply 
click anywhere outside the pop-up window. The gener-
ated name will now also be shown to the right of the 
“Naming Scheme…” button.

About the File Format section
In the File Format section, you can select the file format for 
your mixdown files and make additional settings that are 
different for each file type. For details, see “The available 
file formats” on page 478.

About the Audio Engine Output section
The Audio Engine Output section contains all the settings 
related to the output of the Nuendo audio engine. The fol-
lowing options are available:

Option Description

Separator Allows you to enter any character sequence to be used 
as a separator between the naming elements (e. g. a hy-
phen enclosed in spaces).

Leading Zeros This controls how many leading zeros the Counter and 
Mixer Index components will have. For example, if you set 
this to “2”, the numbers from 1 to 10 will be written as 
001 to 010.

Counter Start 
Value

Here you can enter a number that is used as the first 
Counter value.

Option Description

Sample Rate 
(uncom-
pressed file 
formats only)

This setting determines the frequency range of the ex-
ported audio – the lower the sample rate, the lower the 
highest audible frequency in the audio. In most cases, 
you should select the sample rate set for the project, 
since a lower sample rate will degrade the audio quality 
(mainly reducing the high frequency content) and a higher 
sample rate will only increase the file size, without adding 
to audio quality. Also consider the future usage of the file: 
If you plan to import the file into another application, for 
example, you should select a sample rate supported by 
that application.
If you are making a mixdown for CD burning, you should 
select 44.100 kHz, since this is the sample rate used on 
audio CDs.

Bit Depth (un-
compressed 
file formats 
only)

Allows you to select 8, 16, 24 bit or 32 bit (float) files. If 
the file is an “intermediate mixdown” that you plan to re-
import and continue working on in Nuendo, we recom-
mend that you select the 32 bit (float) option.
32 bit (float) is a very high resolution (the same resolution 
as used internally for audio processing in Nuendo), and 
the audio files will be twice the size of 16 bit files.
If you are making a mixdown for CD burning, use the 16 
bit option, as CD audio is always 16 bit.
In this case, we recommend that you activate the UV-
22HR dithering plug-in (see the separate PDF document 
“Plug-in Reference” for details). This reduces the effects 
of quantization noise and artifacts from being introduced 
when converting the audio down to 16 bit.
8 bit resolution should only be used if required, since it 
results in limited audio quality. 8 bit audio may be suitable 
in some multimedia applications, etc.

Mono 
Downmix

Activate this if you want to downmix all the subchannels 
of a stereo or surround channel or bus to a single mono 
file. To avoid clipping, the following summing rules are 
applies:
Stereo: The panning law as defined in the Project Setup 
dialog is applied (see “About the “Stereo Pan Law” set-
ting” on page 162). Surround: The channels are summed 
and then divided through the number of channels used (in 
case of a 5.1. channel = (L+R+C+Lfe+Ls+Rs)/6).

Split Channels Activate this if you want to export all subchannels of a 
multi-channel bus as separate mono files.
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About the Import into Project section
In this section you will find several options for importing 
the resulting mixdown files back into the existing or into a 
new project:

• If you activate the Pool checkbox, the resulting audio file 
will automatically be imported back into the Pool as a clip.
Use the Pool Folder option to specify in which Pool folder the clip will 
reside.

• If you activate the Audio Track option as well, an audio 
event that plays the clip will be created and placed on a 
new audio track, starting at the left locator.
If you activate the Audio Track, the Pool option will automatically be acti-
vated as well, and deactivating the Pool option also deactivates the Au-
dio Track option.

• If you activate the “Create New Project” option, a new 
project is created that contains one audio track for each of 
the exported channels, as well as the signature and tempo 
track of the original project. Note that if this is activated, 
the Pool and Audio Track options are disabled.
The tracks will have the corresponding mixdown file as audio event. The 
track names will be identical with the export channel names. Note that 
the new project will be the active project.

The Create New Project option is only available if you 
have selected an uncompressed file format and the Use 
Project Audio Folder option is deactivated.

About the Import Options dialog

If you activate any of the options in the “Import into Project” 
section, the Import Options dialog will open for each ex-
ported channel when the export is complete. For a detailed 
description of the options in this dialog see “About the Im-
port Medium dialog” on page 329. 

The available file formats
The following pages describe the different export file for-
mats, as well as their options and settings. 

• AIFF files (see “AIFF files” on page 478).
• AIFC files (see “AIFC files” on page 479).
• Wave files (see “Wave files” on page 479).
• Wave 64 files (see “Wave 64 files” on page 479).
• Broadcast Wave files (see “Broadcast Wave files” on page 

479).
• MP3 files (see “MPEG 1 Layer 3 files” on page 479).
• Ogg Vorbis files (see “Ogg Vorbis files” on page 480).
• Windows Media Audio Pro files (Windows only, see “Win-

dows Media Audio Pro files (Windows only)” on page 480).

Most of the settings described below for AIFF files are 
available for all file types. Where this is not the case, you 
will find additional information in the corresponding sec-
tion.

AIFF files
AIFF stands for Audio Interchange File Format, a standard 
defined by Apple Inc. AIFF files have the extension “.aif” 
and are used on most computer platforms.

For AIFF files the following options are available:

L/R Channels Activate this if you want to export only the left and right 
subchannels of a multi-channel bus into a stereo file.

Realtime 
Export

Activate this if you want the export to happen in realtime, 
in which case the process will take at least the same time 
as regular playback.
Some VST plug-ins, external instruments and effects re-
quire this in order to have enough time to update cor-
rectly during the mixdown – consult the plug-in 
manufacturers if uncertain.
When Realtime Export is activated, the exported audio 
will be played back via the Control Room. Depending on 
the CPU and disk speed of your computer, it may not be 
possible to export all channels simultaneously if Realtime 
Export is activated. If an error occurs during the realtime 
export, the program will automatically stop the process, 
reduce the number of channels and start again. After-
wards the next batch of files is exported. This is repeated 
as often as needed to export all selected channels.
Due to this splitting of the export process in “runs”, the 
realtime export might take longer than the actual playback 
would.

Option Description

! Note that the Wave 64 file format is the only format 
that allows you to export files with a resulting size of 
more than 2 GB.

Option Description

Insert Broad-
cast Wave 
Chunk

This allows you to include information about the date 
and time of creation, a timecode position (allowing you 
to insert exported audio at the correct position in other 
projects, etc.) along with author, description and refer-
ence text strings in the exported file.
Some applications may not be able to handle files with 
embedded info – if you get problems using the file in an-
other application, deactivate the option and re-export.
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AIFC files
AIFC stands for Audio Interchange File Format Com-
pressed, a standard defined by Apple Inc. These files sup-
port compression ratios as high as 6:1 and contain tags in 
the header. AIFC files have the extension “.aifc” and are 
used on most computer platforms. 

AIFC files support the same options as AIFF files.

Wave files
Wave files have the extension “.wav” and are the most 
common file format on the PC platform. 

Wave files support the same options as AIFF files and 
have one additional option:

• Don’t Use Wave Extensible Format
The Wave Extensible format contains additional metadata, such as the 
speaker configuration. It is an extension to the normal Wave format that 
some applications may not be able to handle.  
If you get problems using the Wave file in another application, activate 
this option and re-export.

Wave 64 files
Wave 64 is a proprietary format developed by Sonic 
Foundry Inc. In terms of audio quality, Wave 64 files are 
identical to standard Wave files, but in the file headers 
Wave 64 files use 64-bit values for addressing where 
Wave files use 32-bit values. The consequence of this is 

that Wave 64 files can be considerably larger than standard 
Wave files. Wave 64 is therefore a good file format choice 
for really long recordings (file sizes over 2 GB), e. g. live sur-
round recordings. Wave 64 files have the extension “.w64”.

Wave 64 files support the same options as AIFF files.

Broadcast Wave files
Concerning audio, Broadcast Wave files are the same as 
regular Wave or Wave 64 files, but with additional meta 
data. To create a Broadcast Wave file, select either Wave 
or Wave 64 as the file format and activate the Insert Broad-
cast Wave Chunk option. Click Edit if you wish to edit the 
chunk information, otherwise the defaults as specified in the 
Preferences dialog (Record–Audio–Broadcast Wave 
page) will be used. Broadcast Wave files have the exten-
sion “.wav”.

Broadcast Wave files support the same options as regular 
Wave files.

MPEG 1 Layer 3 files
MPEG 1 Layer 3 files have the extension “.mp3”. By use of 
advanced audio compression algorithms, MP3 files can 
be made very small, yet maintaining good audio quality.

In the File Format section, the following options are avail-
able for MPEG 1 Layer 3 files:

Edit button By clicking this button the “Broadcast Wave Chunk” di-
alog opens where you can enter additional information 
that will be embedded in the exported files. Note that in 
the Preferences dialog (Record–Audio–Broadcast 
Wave page) you can enter default text strings for author, 
description and reference that will automatically be dis-
played in the “Broadcast Wave Chunk” dialog.

Insert iXML 
chunk

This allows you to include additional project-related 
metadata (e. g. project name, author and project frame 
rate) in the exported file.
Some applications may not be able to handle files with 
embedded info – if you get problems using the file in an-
other application, deactivate the option and re-export.
Note: In the Project Setup dialog you will find the fields 
Author and Company that you can use to include the 
corresponding data in the iXML chunk. These fields are 
also available in the Preferences dialog (General–Per-
sonalization page). 

Option Description

Option Description

Bit Rate fader By moving this fader, you can select a bit rate for the 
MP3 file. As a rule, the higher the bit rate, the better the 
audio quality and the larger the file. For stereo audio, 
128 kBit/s is often considered to result in “good” audio 
quality.

Sample Rate 
pop-up menu

On this pop-up menu you can select a Sample Rate for 
the MP3 file.

High Quality 
Mode option

When this is activated, the encoder will use a different 
resampling mode, which can give better results de-
pending on your settings. In this mode, you cannot 
specify the Sample Rate, but only the Bit Rate for the 
MP3 file.

Insert ID3 Tag 
option

This allows you to include ID3 Tag information in the 
exported file. 

Edit ID3 Tag 
button

When you click this, the ID3 Tag dialog opens, in which 
you can enter information about the file. This additional 
information will be embedded as text strings in the file, 
and can be displayed by most mp3 playback applica-
tions.
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Ogg Vorbis files
Ogg Vorbis is an open source, patent-free audio encoding 
and streaming technology, offering compressed audio 
files (extension “.ogg”) of small size, but with compara-
tively high audio quality.

In the File Format section you will find only one setting: the 
Quality fader. The Ogg Vorbis encoder uses variable bit 
rate encoding, and the Quality setting determines be-
tween which limits the bit rate will vary. Generally speak-
ing, the higher the Quality setting, the higher the sound 
quality but also the larger the files.

Windows Media Audio Pro files 
(Windows only)
This is a continuation of the Windows Media Audio format 
developed by Microsoft Inc. Due to the advanced audio co-
decs and lossless compression used, WMA Pro files can 
be decreased in size with no loss of audio quality. Further-
more, WMA Pro features the possibility of mixing down to 
5.1 surround sound. The files have the extension “.wma”.

When you select “Windows Media Audio File” as the file 
format, you can click the “Codec Settings…” button to 
open the “Windows Media Audio File Settings” window.

Note that the configuration options may vary, depending 
on the chosen output channel(s).

General tab

In the Input Stream section, you set the sample rate (44.1, 
48 or 96 kHz) and the bit resolution (16 bit or 24 bit) of the 
encoded file. Set these to match the sample rate and bit 
resolution of the source material. If no value matches that 

of your source material, use the closest available value 
that is higher than the actual value. For example, if you’re 
using 20 bit source material, set the bit resolution to 24 bit 
rather than 16 bit.

The setting in the Channels field depends on the cho-
sen output and cannot be changed manually. 

The settings in the Encoding Scheme section are used for 
defining the desired output from the encoder, e. g. a stereo 
or a 5.1 surround file. Make settings appropriate for the in-
tended use of the file. If the file will be downloaded or 
streamed on the Internet, you might not want too high bit 
rates, for example. See below for descriptions of the op-
tions.

• Mode

The WMA Pro encoder can use either a constant bit rate 
or a variable bit rate for encoding to 5.1 surround, or it can 
use lossless encoding for encoding to stereo. The options 
on this menu are as follows:

• Bit Rate/Quality

This menu allows you to set the desired bit rate. The avail-
able bit rate settings vary depending on the selected 
mode and/or output channels (see above). If the Variable 
Bitrate mode is used, the menu allows you to select from 
various levels of quality, with 10 being the lowest and 100 
the highest. Generally, the higher the bitrate or quality you 
select, the larger the final file will be. The menu also shows 
the channel format (5.1 or stereo).

Mode Description

Constant Bitrate This will encode to a 5.1 surround file with a constant 
bit rate (set in the Bit Rate/Channels menu, see be-
low). Constant bit rate is preferably used if you want to 
limit the size of the final file. The size of a file encoded 
with a constant bit rate is always the bit rate times the 
duration of the file.

Variable Bitrate Encodes to a 5.1 surround file with a variable bit rate, 
according to a quality scale (the desired quality is set in 
the Bit Rate/Quality menu, see below). When you en-
code with variable bit rates, the bit rate fluctuates de-
pending on the character and intricacy of the material 
being encoded. The more complex passages in the 
source material, the higher the bit rate – and the larger 
the final file.

Lossless Encodes to a stereo file with lossless compression.
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Advanced tab

• Dynamic Range Control

These controls allow you to define the dynamic range of 
the encoded file. The dynamic range is the difference in 
dB between the average loudness and the peak audio 
level (the loudest sounds) of the audio. These settings af-
fect how the audio is reproduced if the file is played on a 
Windows computer with a player from the Windows Me-
dia series, and the “Quiet Mode” feature of the player is 
activated to control the dynamic range.

The dynamic range is automatically calculated during the 
encoding process, but you can specify it manually as well.

To manually specify the dynamic range, first put a check-
mark in the box to the left by clicking in it, and then enter 
the desired dB values in the Peak and Average fields. You 
can enter any value between 0 and -90 dB. Note, how-
ever, that it is usually not recommended to change the Av-
erage value, since this affects the overall volume level of 
the audio and therefore can have a negative effect on the 
audio quality.

The Quiet Mode in a Windows Media player can be set to 
one of three settings. Below, these settings are listed to-
gether with an explanation of how the Dynamic Range set-
tings affect them:

• Off: If Quiet Mode is off, the dynamic range settings that were 
automatically calculated during the encoding will be used.

• Little Difference: If this is selected and you have not manually 
changed the dynamic range settings, the peak level will be 
limited to 6 dB above the average level during playback. If you 
have manually specified the dynamic range, the peak level will 
be limited to the mean value between the peak and average 
values you specified.

• Medium Difference: If this is selected and you have not manu-
ally changed the dynamic range settings, the peak level will be 
limited to 12 dB above the average level. If you have changed 
the dynamic range, the peak level will be limited to the peak 
value you specified.

• Surround Reduction Coefficients

Here you can specify which amount of volume reduction, if 
any, is applied to the different channels in a surround en-
coding. These settings affect how the audio is reproduced 
on a system incapable of playing back the file in surround, in 
which case the surround channels of the file will be com-
bined into two channels and played back in stereo instead.

The default values should produce satisfactory results, but 
you can change the values manually if you wish. You can 
enter any value between 0 and -144 dB for the surround 
channels, the center channel, the left and right channels 
and the LFE channel, respectively.

Media tab

In these fields you can enter a number of text strings with 
information about the file – title, author, copyright informa-
tion and a description of its contents. This information will 
then be embedded in the file header and can be displayed 
by some Windows Media Audio playback applications.

For more information about surround sound and en-
coding, see the chapter “Surround sound” on page 226.
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Introduction
This chapter describes how you can use Nuendo’s net-
working technology to collaborate with other users of Nu-
endo in a peer-to-peer network.

The “owner” of a project can share it with any number of 
users via LAN (Local Area Network) connections and/or 
WAN (Wide Area Network) connections via standard net-
work protocols.

This allows several separate users to work on a project 
simultaneously and coordinate their efforts, as well as 
exchange ideas and suggestions.

Using Nuendo to collaborate in a network requires that:

• All users have the same version of Nuendo.
• All computers are either connected via LAN or via the Internet 

through IP addresses.

What can I use the Networking 
functions for?
The networking technology in Nuendo allows collabora-
tion with, and exchange of, MIDI, video, and audio data – 
i. e. it is possible to exchange and edit MIDI, video, and au-
dio. Marker tracks and instrument tracks are also included 
in a shared project. As of this writing, it is not possible to 
exchange any Mixer settings.

Even though the networking technology allows for collab-
oration via WAN connections over the Internet, it is prima-
rily designed for use in a LAN workgroup. It can also be 
used for collaboration over the Internet (see below).

Sound Designer II and Networking

Networking protocol and ports
In addition to TCP/IP, the Nuendo networking technology 
uses the standard network protocol UDP (User Datagram 
Protocol - primarily used to broadcast messages over a 
network).

Since the technology uses the standard protocols and 
calls of the operating system, no special hardware or driv-
ers are required to use it, aside from a working NIC card.

Nuendo uses three ports in your system for establishing 
communication, broadcasting messages and transferring 
data between users: UDP port 6990, TCP port 6991 and 
TCP port 6992. These ports need to be open for network 
communication to be possible.

Considerations for Internet use
As previously mentioned, the Nuendo networking func-
tions are designed mainly for use in local area networks, 
but it is also possible to use them over the Internet.

In this case, there are a few things to keep in mind and 
some system settings you may need to make:

• If a network is to be created with any users connected 
via the Internet, all users need to know the respective IP 
addresses of the other computers in the network, and use 
these to establish the connection.
See “Setting up WAN connections” on page 485 for details about how 
to use the IP address of a computer to establish network communication 
with it in Nuendo.

• There may also be issues that need to be resolved re-
garding firewalls and/or computers connected to the In-
ternet via private subnets.

If your computer is behind a firewall

In a LAN, Nuendo uses the UDP port 6990 to establish 
communication with the other computers. Over the Inter-
net however, Nuendo does not use this port. Instead, con-
nection and communication is established and handled via 
TCP/IP messages sent to the TCP ports 6991 and 6992.

This means that the TCP ports 6991 and 6992 must be 
open on all computers. Firewalls may block messages to 
these ports, thus making connection impossible. Consult 
the documentation for your firewall (or operating system) 
for information about how to open ports – or contact your 
network administrator.

! Please note that using Sound Designer II (SD2) files 
in projects shared over a network may lead to unpre-
dictable results, and is not recommended.
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If your computer is in a subnet that uses NAT

If your computer resides in a subnet that uses NAT (Net-
work Address Translation), all computers in the subnet 
share the same external IP address, while the individual 
computers in the subnet have internal IP addresses.

In this case, you must set up a port mapping from the ex-
ternal ports 6991 and 6992 to your internal ports 6991 
and 6992 - i. e. the actual ports on your computer, as op-
posed to the ports of the subnet.

If computers are in different NAT subnets

If you want to collaborate with users whose computers re-
side in different subnets that use NAT (see above), it might 
be a good solution to set up a VPN (Virtual Private Net-
work). A VPN allows secure communication between net-
works, using the Internet for transferring data.

It is beyond the scope of this document to go into any de-
tails on how to set up a VPN, but make sure that your VPN 
will act as a single network and that the ports 6991, 6992, 
and, if possible, 6990 are open.

The network dialogs
The following sections give you a short overview of the 
network dialogs and their use:

Project Sharing and Permissions
Open this dialog, if you want to specify the user permis-
sions for the active project before sharing it, either on a 
project basis, a track basis or both.

Shared Projects
Open this dialog, if you want a list of all identified users 
and shared projects in the network. This allows you to 
share your own projects as well as join projects shared by 
other users. Furthermore, the dialog offers the possibility 
of connecting to WAN (Wide Area Network) users.

User Manager
Open this dialog, if you want to set up lists of users, define 
their read and write permissions and save the settings as 
a permission preset. The presets can then be loaded in 
the “Project Sharing and Permissions” dialog, letting you 
share a project with the settings of the permission preset.

Selecting a user name
When your computer meets the criteria for communicating 
with other computers (see above), this is how you quickly 
go about establishing network communication and share a 
project with others:

1. Launch Nuendo.

2. Activate the network by opening the Network menu 
and activating the “Active” option.
This establishes network communication and introduces your computer 
to any computers already present in the network. Your computer now 
needs to have a unique ID for identification (see below).

3. A dialog opens where you can enter a unique user 
name to identify your computer in the network.
This is the name that will be displayed in all the network dialogs to iden-
tify you to the other users in a network.

4. Click Yes to enter your user name.
A dialog opens where you can enter your user name.

• If you do not enter a user name at this point, the network 
will not be activated.

! Each user in a network must specify a user name, or 
network name, in order to be identified in the network. 
You can also change the name later (see “Selecting a 
user name – alternative method” on page 485).
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5. Click in the text field, type in a name of your choice 
and click OK.
If the network has already been created, the original creator – or admin-
istrator – may have already decided on user names for all participants. If 
so, ask the administrator for yours and enter it. For more information 
about selecting user names for other participants, see “Creating a per-
mission preset” on page 487.

If a name you enter is already in use on another com-
puter in the network, you will be prompted to select an-
other name.

When you have entered a user name, you can load or cre-
ate a project that you want to share with the other users.

6. Click the “Share Project” option in the toolbar, or open 
the “Project Sharing and Permissions” dialog from the 
Network menu and activate the “Share Project” option.
The project is now shared and all other users have full access to it. See 
“Sharing projects” on page 487 for more details about sharing projects 
and what you can do in this dialog.

Selecting a user name – alternative method
If you did not specify a user name or if you need to change 
it, proceed as follows:

1. Open either the User Manager dialog or the Shared 
Projects dialog from the Network menu.
In the top left corner of both dialogs you will find the Network Name text 
field.

Entering a network name in the User Manager dialog and in the Shared 
Projects dialog.

2. Click in the text field, type in a name of your choice 
and press [Return].
This is the name that will be displayed in all the network dialogs to iden-
tify you to the other users in a network.

Once you have entered a user name and this has been es-
tablished in the network, it should not be changed unless 
absolutely necessary! To use an analogy, this is similar to 
registering for an Internet service or discussion forum – 
once you have registered under a specific name, you can-
not log in under another name, unless you create a new 
account.

Setting up a network
The following is a description of how to set up a network 
with both LAN and WAN connections.

• For LAN connections, all computers must be part of the same 
network and communicate properly.

• For WAN connections, all computers must have a working In-
ternet connection and a public IP address.

If your intended network meets these criteria, proceed as 
follows.

Setting up LAN connections
If you want to connect to other users via a LAN, you only 
have to make sure that all computers actually use the 
same LAN, that they are communicating properly via the 
TCP/IP protocol, and that you have activated the network 
by checking the “Active” item on the Network menu. If the 
computers are unable to communicate, contact your net-
work administrator, or consult the network documentation 
for your operating system.

Setting up WAN connections
If you want to connect to other users over the Internet, you 
have to open a WAN connection to each. This requires 
that all users have a working Internet connection and a 
public IP address (see “Considerations for Internet use” 
on page 483).

WAN connections are set up in the Shared Projects dia-
log in the following way:

1. Make sure the “Active” item on the Network menu is 
checked.
This initiates network communication with the other participants.

2. Open the Shared Projects dialog from the Network 
menu.

! The following user names “Guest”, “Administrator”, 
“Admin” and “Anonymous” are reserved and cannot 
be used.
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3. Click the “Add WAN Connection” button in the toolbar.
A dialog opens, requesting the Domain Name or the IP address of the 
computer you want to connect to. 

The “Add WAN Connection” button

4. Type in the IP address/Domain Name of the computer 
you want to connect to and click OK.
An item called “Global IP Network” now appears in the dialog. This lists 
either the IP address of the computer to which you have connected, or 
the domain name of its Internet service provider.

5. Repeat this procedure for every user you want to con-
nect to over the Internet.

If a computer is dynamically allocated an IP address by 
its Internet service provider – as opposed to having a per-
manent IP address – you will have to repeat the above pro-
cedure each time the computer receives a new IP address!

• You can remove a WAN connection by selecting it and 
clicking the “Remove WAN Connection” button.

The “Remove WAN Connection” button

• You can remove the entire “Global IP Network” item by 
selecting it and pressing [Delete] or [Backspace].
This will also remove any existing WAN connections.

Should you be unable to establish a WAN connection, first 
verify that you entered the IP address correctly. Connection 
problems may also occur for the following reasons:

• Your computer and/or the computer you’re trying to 
connect to is protected by a firewall.

• Your computer and/or the computer you’re trying to 
connect to does not have the necessary ports open.

For information about communication via the Internet, see 
“Considerations for Internet use” on page 483.

Updating the network information
If all users in a network are online and have entered user 
names (see “Selecting a user name” on page 484), you 
can do the following to update the network information in 
Nuendo:

• Open the Shared Projects dialog and click the “Rescan 
Network” button to update the network information.

At this point, the following will happen:

• The item “Users in Local Network” is updated to display a list 
of all the online users connected via LAN, along with their user 
names.

• The item “Global IP Network” is updated to display a list of all 
the online users connected via WAN, along with their user 
names.

If the user list is not updated as it should, this is probably 
because the computers in the network are not communi-
cating properly.

Information about users that are offline will not be up-
dated.

Verify Communication
Whenever project information needs to be updated over 
the network, Nuendo will first check if the connection with 
all project participants is still working. This check is per-
formed in the background with a preset timeout period.

When participants do not respond within this timeout pe-
riod, a “Commit Failed” message is displayed. At this 
stage, no further action is performed, as the problem 
might be temporary (e. g. Laptop unplugged). If the prob-
lem persists, however, you can call the “Verify Communi-
cation” function via the Network menu.
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When this function is called, a dialog shows the progress 
of the checking process. 

• When all project participants are found, a dialog lists all 
project participants and their response times (i. e. the time it 
took for their computers to respond to the check). If the re-
sponse times were longer than the standard timeout, or if a 
participant was not found who you know is in fact online 
and waiting for network information, you may want to click 
on “Adjust timer”. This will change the timeout threshold in 
Nuendo to a longer setting, allowing for participants with 
slower response times to be found.

• If project participants are not found because they are 
offline, a dialog will be shown allowing you to remove 
these users from the workgroup.

Transfer Status
Transfer of network data always is performed in the back-
ground. If you want to check on the progress of your trans-
fer processes, you can open the Transfer Status window by 
pulling down the Network menu and selecting “Transfer 
Status…”.

As you upload or download project data, the Transfer Sta-
tus window displays progress bars for every track in the 
project. The Transfer Status window features Cancel but-
tons for each of the transfer operations. Use these to stop 
any transfer operation.

Sharing projects
When you want to share a project with others, you first 
decide which users you want to have access to the 
project, and then specify their read and write permissions.

To set up a list of users and their read and write permis-
sions choose one of the following methods:

• Create a permission preset containing all the settings.
Storing permission presets is practical since they let you apply the same 
list of users and their permissions to future projects.

• Set up users and their permissions manually for each 
project.
This method also allows you to specify permissions for separate tracks in 
a project, as opposed to the entire project.

• Load the default permissions to let all the participants in 
a network have access to a project.
See “About the Default Permissions preset and the Guest user” on page 
488 for more information.

We will first describe all of these methods here, and then 
proceed to describe how you go about sharing a project.

Creating a permission preset
In the User Manager dialog, read and write permission 
settings for users can be stored in permission presets. 
These can then be applied to other projects, i. e. the users 
will automatically get read and write permissions accord-
ing to the settings stored in the permission preset.

• Read permission allows users to view and play back 
shared projects or tracks but not make any changes to 
them.

• Write permission allows users to make any changes to 
shared projects or tracks.
It is not possible to have write permission without also having read per-
mission.

Proceed as follows to create a permission preset:

1. From the Network menu open the User Manager dialog.
This is described in detail in the section “User Manager” on page 484.

2. Below the “Permission Presets” column click the plus 
sign.
A dialog for the naming of the new permission preset opens.
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3. Type in the desired name and click OK.
The permission preset is created and added to the list.

The “User Pool” column to the right lists all the users who 
have entered a user name, and who have been online and 
established in the network at some point (note that users 
do not have to be online to be listed here).

However, there may also be instances when you want to 
add a user who is offline and has not been established in 
the network. If this is the case, the user is not available in 
the User Pool list, but you can still add him to a permission 
preset in the following way:

4. Below the “User Pool” column click the plus sign.
A user with a generic name – “User #” – is added to the list.

5. Type in the desired name.
The user you’re adding may have decided on a user name and entered it, 
as described in “Selecting a user name – alternative method” on page 
485, but has been offline and therefore not yet established in the network. 
In this case, you can enter that name if you know it. Otherwise, enter a 
name of your own choice and later let the user know which name to use.

The next step is to add users to the permission preset.

6. Make sure the preset is selected in the “Permission 
Presets” column.

7. In the “User Pool” column, select the user(s) you want 
to add to the permission preset.
To select several users, hold down [Shift] or [Ctrl]/[Command] and click 
on the user names.

8. When you have selected the user(s) you want to add, 
click the Arrow symbol to the left of the “User Pool” column.
The users you selected will now be added to the “User” column in the 
middle of the dialog.

The next thing to do is to define the read and write permis-
sions for the added users. In the Read and Write columns, 
the read and write permissions for each user can be spec-
ified. By default each added user has both read and write 
permission.

9. If you do not want a user to have read or write permis-
sion, click the corresponding column to deactivate the 
permissions.

Having write permission automatically means to also 
have read permission.

When you have added the desired users and specified 
their read and write permissions, the preset is complete. 
The permission preset will now be available for use, see 
also “Loading a permission preset” on page 490.

Permission presets apply to entire projects – i. e. when a 
permission preset is loaded, the read and write permission 
settings in it are valid for the entire project. However, you 
can also specify separate permissions for each track, see 
“Setting up permissions for separate tracks” on page 489.

It is also possible to create a permission preset in the 
Project Sharing and Permissions dialog, see “Saving the 
settings as a permission preset” on page 489.

Removing permission presets and users

Below each column to the right is a Remove button (the 
trash icon). You can remove one or several permission 
preset(s) or user(s) (including the “Guest” user – see be-
low) from the respective columns by selecting them and 
clicking this icon.

About the Default Permissions preset and the Guest user

The “Default Permissions” preset cannot be removed. You 
can use it either as is, or you can modify it as you wish by 
adding and removing users. By default, it contains one 
user – “Guest” – with both read and write permission.

• If “Guest” is added to a permission preset, anyone in the 
network can utilize the Guest permissions.
Therefore, if you share a project that has Guest as a user, anyone in the 
network can join it with the corresponding permissions.

If you want to share a project with everyone in a net-
work and let everyone have both read and write permis-
sion for the entire project, the easiest and quickest way to 
do this is to use the Default Permissions preset as is.
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Setting up users and permissions manually
Instead of creating a permission preset in the User Manager 
dialog, you can use the “Project Sharing and Permissions” 
dialog to manually set up which users should be allowed to 
share a project, and what read and write permissions they 
should have.

It is not possible to add users who have not yet been 
established in the network (see “Creating a permission 
preset” on page 487). If this is what you want, use the 
“User Manager” dialog.

Proceed as follows:

1. Open the “Project Sharing and Permissions” dialog 
from the Network menu.

2. In the “All Users” column to the right, select the 
user(s) you want to share the project with.
All users in the network that have entered user names and are estab-
lished in the network are listed, along with the default “Guest” user. To 
select several users, hold down [Shift] or [Ctrl]/[Command] and click on 
the user names.

3. Click the Add User to Permission List button above 
the column (the left button).
The selected users are added to the “User Name” column above the “All 
Users” column.

• To remove a user, select the user name in the “User 
Name” column and click the Delete User button below the 
column (the right button).
The user is removed from the “User Name” column. You can remove sev-
eral users at once. You should remove the “Guest” user if you do not 
want everyone in the network to have full access to the project.

4. In the “Project & Tracks” column, make sure the top 
item (the project name) is selected.
This way, the settings you make affect the entire project, rather than se-
parate tracks.

5. Define the project read and write permissions for the 
added users, by checking and unchecking the Read and 
Write permission columns (“r”, “w”) as desired.
Note that having write permission automatically means also having read 
permission.

These settings are valid for the entire project. If you want 
to specify read and write permissions separately for each 
track, see “Setting up permissions for separate tracks” on 
page 489.

Saving the settings as a permission preset

If you have manually added users and set up their read 
and write permissions for the project in the “Project Shar-
ing and Permissions” dialog, you can create a permission 
preset based on the settings you have made:

1. Click the plus sign to the left of the “Permission Pre-
sets” menu in the bottom right corner.
A dialog opens, allowing you to enter a name for the permission preset.

2. Type in the desired name and click OK.
The permission preset is saved and added to the menu. 

You can now also access this preset in the “User Manager” 
dialog, as described in the section “Creating a permission 
preset” on page 487.

Setting up permissions for separate tracks

The “Project Sharing and Permissions” dialog also offers 
the possibility of specifying read and write permissions 
separately for each track in the project.

Proceed as follows:

1. In the “Projects & Tracks” column, select the track(s) 
for which you want to make separate settings.
As you can see, the right part of the dialog now only contains a checkbox 
and the text “Override Project Permissions”.

2. Activate the “Override Project Permissions” option.

3. Add users and specify their read and write permis-
sions for the track(s) as described in the section “Setting 
up users and permissions manually” on page 489.

4. When you are done, select the top item (the project 
name) in the “Project & Tracks” column again.

Permission settings for separate tracks are not saved in a 
permission preset, but you can first load a preset with the 
project permissions (see “Loading a permission preset” on 
page 490) and then make settings for separate tracks.
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• To make separate track permissions in the project In-
spector, select a track in the track list, open the Network 
section in the Inspector and click the “Override Project 
Permissions” button (the key symbol).
This makes it possible to make read and write permission settings for the 
track directly in the Inspector.

Loading a permission preset
To load a permission preset for the active project, proceed 
as follows:

1. Open the “Project Sharing and Permissions” dialog 
from the Network menu.

2. In the bottom right corner of the dialog, click in the 
Permission Presets text box to open a pop-up menu.
The menu lists all available permission presets.

3. From the menu, select the permission preset you wish 
to use.
The users defined in the permission preset are now listed in the User 
Name column, and their read and write permissions are displayed.

You can now either use the settings of the loaded permis-
sion preset as they are for the shared project, or you can 
make manual adjustments on a project or track basis (see 
“Setting up users and permissions manually” on page 489).

Sharing a project
Once you have set up all the users and their permissions 
– i. e. loaded a permission preset and/or manually added 
users and specified their permissions for this particular 
project – you can share the project.

Using the “Project Sharing and Permissions” dialog

1. If it is not already active, activate the network by 
checking the “Active” option on the Network menu.

2. Open the “Project Sharing and Permissions” dialog 
from the Network menu.

3. Activate the “Share Project” option.
The project is now shared and available to the users you have specified.

• To revoke sharing of the project, deactivate the “Share 
Project” option.

You can at any time make changes in this dialog, i. e. add 
or remove users and change permissions, and then up-
date the shared project accordingly for all users by making 
the desired changes and clicking the “Commit” button.

Quick Sharing

If you just want to share a project with full read and write 
access for every user in the network without loading any 
permission preset or manually setting up users, the easi-
est way to do this is to click the “Share Project” button on 
the Project window toolbar (or activating “Share Project” 
in the “Project Sharing and Permissions” dialog). 

This is provided you have not made any changes to the 
“Default Permissions” preset. The reason is that the de-
fault permissions (with only the user “Guest”) grant all us-
ers full access (see “About the Default Permissions preset 
and the Guest user” on page 488).
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In the “Shared Projects” dialog

1. If it is not already active, activate the network by 
checking the option “Active” on the Network menu.

2. Open the “Shared Projects” dialog from the Network 
menu.

3. Click the “Share Active Project” button.
This will open the “Project Sharing and Permissions” dialog, to let you 
verify that all permissions are OK before sharing. You can then share the 
project in the dialog. When the active project is shared, it appears in the 
“My Shared Projects” folder.

The “Share Active Project” button

• To revoke sharing of a project, select it in the “My Shared 
Projects” folder and click the “Unshare Selected Project” 
button.

The “Unshare Selected Project” button

Deactivating a shared project
If you are sharing a project and want to stop working on it, 
you do this by deactivating the network. When you deacti-
vate the network during work with a shared project, the 
other users will be disconnected from it. However, sharing 
will not be revoked unless you specify it – meaning that 
the next time you connect to the network, the project will 
still be shared, allowing the other users to join it without 
you having to make permission settings and share it all 
over again.

1. To deactivate the network, pull down the Network menu 
and select “Active”, so that the checkmark is removed.

2. A dialog opens, asking you to confirm that you want to 
disconnect the network.
All the users will be disconnected from the project. The project will still 
be shared when you connect to the network again.

• To reactivate the network, check the “Active” option on 
the Network menu again.
A dialog opens, asking you to confirm that you want to reconnect the 
network. All the users with whom you previously shared the project will 
now be able to join it again.

About the project folder
When you’re sharing a project, you have to decide whether 
the project folder for it should be located on your local hard 
disk, or – if you’re sharing the project over a LAN and have 
access to a common file server – if it should be located on 
the server.

You should consider the following:

• If the project folder is located on your hard disk, the files 
it contains will be copied to the other users’ hard disks, 
and their project folders.
This way, work on the files will be done locally on the computer of each 
user, and the updated files are then copied to the hard disks of the other 
users.

• If you have access to a file server and place the project 
folder and its contents on it, the other users can specify 
this folder as the project folder when they join the project.
In this case, the project files will not be copied to the other users’ hard 
disks, but are instead accessed directly on the server. Working on the 
files directly on a server may be slower compared to working on them lo-
cally. On the other hand, the files will not have to be copied to each hard 
disk every time they are updated.

Where to put large media files
If you have a file server that is fast enough for connected 
workstations to call audio or video playback of files stored 
on this server, you should place large media files on this 
server to avoid excessive network traffic.

However, when you are using a Windows workstation, note 
that when you connect your file server using a drive letter 
(e. g. V:\), Nuendo will treat this server as a local drive, 
which means that any data from this server used in a shared 
project will always be copied over the Nuendo network.
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Therefore, try placing your large files on a file server and 
import them into Nuendo without using the “Copy File to 
Working Directory” option. The server path should now be 
displayed in the Pool.

Joining projects
The “Shared Projects” dialog lets you join projects shared 
by other users in the network.

This dialog lists all the established users in the network, 
and any projects they are sharing. For you to be able to 
join a project, the user sharing it must be online and have 
given you read and/or write access.

To join a project, proceed as follows:

1. Connect to the network by checking the “Active” op-
tion on the Network menu.

2. Open the “Shared Projects” dialog from the Network 
menu.

3. If necessary, click the “Rescan Network” button (the 
rightmost button on the toolbar).
Nuendo scans the network for any updated information about online users 
and/or shared projects, and refreshes the Shared Projects dialog accord-
ingly.

• The item “Users in Local Network” lists all the established us-
ers in a LAN.

• The item “Global IP Network” lists all the users with whom you 
have established WAN connections (see “Setting up WAN 
connections” on page 485).

4. If there are plus signs beside these items, this indi-
cates that a list of users can be displayed.

5. If a user is sharing projects, this is indicated by a plus 
sign beside the user name. Click this to display a list of the 
projects shared by this user.

If there are shared projects you can join, these are indicated 
by the text “You can join” in green.

6. To join a project, select it and click the “Join Project” 
button (or double-click the project name in the list).
A dialog opens, allowing you to specify the project folder.

The “Join Project” button

7. Select a project folder.
There may be two cases which require special approaches:

• If you are connected over a LAN, the owner of the project may 
have decided to keep the project files in a special, common 
project folder on a server. If this is the case, you will need to 
specify this folder as the Project folder.

• If the owner of the project keeps the project files in a project 
folder on a local hard disk, select a local folder on your hard 
disk. In this case, the project files will be copied to the project 
folder on your hard disk.

See “About the project folder” on page 491 for more in-
formation about the project folder in shared projects.

8. When you have selected a project folder, the project 
and the files are copied to your hard disk (unless you’re 
working on a server).
If you have access not to the entire project, but only separate tracks, only 
the tracks for which you have read or write permission will be loaded.

Downloading selected tracks

When you click the “Download Selected Tracks” button, 
you can select which tracks from which shared projects 
you want to download to your computer.

You will be asked whether you wish to create a new 
project. When you select No, the downloaded tracks will 
be added to your active project. Note that you cannot 
download tracks into a shared project.

Merging your project to the network project
When you click the “Merge Active Project to Selected 
Network Project” button, the currently active project will 
be merged with the selected Network project.

You will be asked whether you wish to download the 
shared project before merging. 
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• Clicking “No” allows you to simply commit your tracks 
without having to download all shared tracks. (Please stay 
connected until all others have received your tracks.)

• When you click “Yes”, you can join using your active 
project without having to create a new project locally. 

The Project Sharing and Permissions dialog for your local 
project will be displayed. When you are happy with all per-
mission settings, click on “Start Merge”. This will join the 
Network project and download all available tracks. When 
the download is complete, you can commit your tracks.

Disconnecting from projects
If you have joined a project and want to stop working on it, 
you do this by deactivating the network. When you deacti-
vate the network during work with a shared project, you 
will disconnect from it. However, you will still have access 
to the project in the future as long as the owner shares it 
with you. The next time you connect to the network, the 
project will still be shared with you (unless the owner has 
changed the permissions) and you can join it again.

1. Pull down the Network menu and select the Active 
item, so that it is not checked to deactivate the network.
A dialog will appear, asking you to confirm that you want to disconnect 
from the network.

2. Click “Yes”.
You will disconnect from the project.

• To reactivate the network, select “Active” on the Network 
menu again.
A dialog opens, asking you to confirm that you want to reconnect to the 
network. If the project is accessible on the network, you will rejoin it and 
all the project files will be loaded (see below).

Working with shared projects
Any user who has write access to the project or separate 
tracks in it can make changes and commit these to the 
other users. The communication and transfer of updated 
files is handled mainly in the Network section for each 
track in the Inspector.

The permission status of a track is indicated in the Inspec-
tor as follows:

• If the symbol on the right of the Network tab in the In-
spector is displayed in a lighter color, you have both read 
and write access to the track and can make changes to it.

• If the symbol on the right of the Network tab in the In-
spector is orange, you have only read access to the track, 
and cannot make changes to it.

The Network section contains several controls for net-
work-related track functions:

In addition to the above, the Network section also displays 
the user name of the owner of a project you join.

You can also customize Nuendo so that the four main 
network control buttons are available in the track list. This 
is done in the Track Controls Settings dialog, see “Cus-
tomizing track controls” on page 573.

Committing changes

To a track

When you have made changes to a track, proceed as fol-
lows to commit them and make them known to the users 
in the network:

1. Open the Network section for the track in the Inspec-
tor by clicking its tab.
If you have set things up so that the commit button is available in the 
track list, you do not have to use the Inspector.

2. Click the button “Commit changes on this track”.
The changes are committed to the network. 

If more than one track is selected, clicking this button 
for one selected track will commit the changes on all se-
lected tracks. For the owner of a project, this is also the 
way to update permission settings made directly in the In-
spector (see “Setting up permissions for separate tracks” 
on page 489).

Automatically 
apply updates

Get exclusive access 
(lock track)

Load available 
update

Commit changes 
on this track

Override project permissions 
– only available for the owner 
of the project (see “Setting 
up permissions for separate 
tracks” on page 489).
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To a project

If you have made changes to several tracks, or made other 
project changes, you will probably want to commit all 
changes at once:

• Pull down the Network menu and select “Commit 
Changes” to commit the changes over the network.
Alternatively, you can click the corresponding button on the Project win-
dow toolbar. See “Using the Setup options” on page 572 for information 
about how to customize the toolbar.

Loading changes
When other users have made changes to a track and 
committed them over the network, the “Load available up-
date” button in the network controls for the corresponding 
track lights up to indicate that you can load the changes 
and update the project.

The “Load available update” button is located in the Net-
work section of the Inspector. However, when working with 
shared projects, you will probably want to customize Nu-
endo so that it is also available in the track list (see above), 
since this makes it somewhat easier to get a visual overview 
of when committed changes are available.

You can use two different methods to load available 
changes to tracks over the network:

• Click the “Load available update” button in the Inspec-
tor or the track list.
This will load the available update for the track.

• Click the “Automatically apply updates” button in the In-
spector or the track list for one or more tracks.
This way, all changes committed to the track(s) by other users will be au-
tomatically loaded without requiring your intervention.

There is also a special method for loading changes made 
to the tempo and signature tracks, as well as loading new 
tracks:

• Click the “Sync project to network state” button in the 
Project window toolbar.
This button lights up to indicate that there are changes available. Click it 
to have any new tracks and any changes made to the tempo and signa-
ture tracks loaded.

By default, the Network controls are not visible in the 
toolbar. If you want them to be visible, you need to cus-
tomize the toolbar.

You can also undo an update! If you have loaded an 
available update, you can select “Undo Net Update” from 
the Edit menu. Similarly, you can “undo the undo” by se-
lecting “Redo Net Update”.

Locking tracks
If you have write permission for a track and want to pre-
vent other users from making changes to it, you can lock it 
for your own use only.

• To lock a track for your exclusive use, click the “Get ex-
clusive access” button for the track in the Inspector or the 
track list.

• To unlock a track, click the “Get exclusive access” but-
ton again so it is no longer lit.

The owner of a project can unlock a track, regardless of 
who locked it:

• When you click the “Get exclusive access” button for a 
locked track that was not locked by you, a warning mes-
sage appears.

• When you are the owner of the project or track, select 
“Release Lock” to unlock the track.
Other users can only click “Cancel” to leave the track locked.

About network communication problems
In any network, occasionally, connections may be lost.

When network communication with a participant fails, you 
can initiate a communication verification process, and at-
tempt to re-establish the lost connection, see “Verify 
Communication” on page 486. 

! Each time you commit a change to a track or project, 
network activity is initiated, slowing the network 
down. Depending on the speed of the network, it 
may take some time before the changes are distrib-
uted to all users and work can continue, so commit 
changes sparingly and only when necessary.
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After the verification process, a dialog lists the results of 
the verification process. Nuendo may either have been 
able to restore communication through the process, or still 
be unable to communicate with some participant(s). The 
dialog lists each participant with whom communication 
still failed (see below).

At this point, you will have to decide whether to remove 
the participant(s) from the network:

• If you suspect the communication problems are tempo-
rary, select “No” and wait to see if communications can be 
restored.
You can then later manually perform the verification process if you wish 
(see below).

• If you believe the communication problems are more se-
vere, for instance if the participant(s) have experienced a 
system or network crash, select “Yes”.
The participant(s) will then be removed from the network until able to re-
join again.

If the verification process does not solve the problem, the 
communication problems are probably of a more serious 
nature and may require re-configuration of the network 
settings (see “Setting up a network” on page 485).

You can also initiate the verification process manually 
by selecting “Verify Communication” from the Network 
menu.

Reconnecting participants to the Master Network project

When several users have joined a Network project and 
this is unexpectedly disconnected from the network (i. e. it 
is not disconnected by e.g. deactivating the Network or by 
closing the project), these participants can be automati-
cally reconnected. 

Proceed as follows:

1. Open the Master project again.
The program automatically searches 10 seconds for the other users in 
the network. When users are found, a dialog is displayed.

2. Select “Reconnect” if you want the other user(s) to be 
automatically reconnected.
When you click the “Unshare” button, the project is unshared.

This only works if the Master project has been saved. 

If you are unsure about the state of connection, it might be 
a good idea to unshare the project and to submit it as a 
new network project, in order to avoid conflicts.

Further options

Chatting with other users on the network
When you are connected to the network, it is possible to 
chat with other users to discuss changes you are making 
to shared projects. All network users can see the same 
chat window.

• To chat with all other users on the network, select 
“Open Global Chat”, type in your message in the window 
that opens and press [Return]. 

• To chat only with the users working on the currently 
shared project, select “Open Project Chat”, type in your 
message in the window that opens and press [Return]. 

Only messages entered after you joined the chat will 
be visible to you.

Opening projects with network settings
When you are loading a project containing network set-
tings and the network is deactivated in Nuendo, the fol-
lowing dialog opens:

• Click “Activate” to activate the network in Nuendo and 
try to reconnect the project.

• Click “Remove” to remove all network settings. 
You can choose this when you do not want to work in the network any 
longer, or if you have e.g. older projects with corrupt network settings.

• Click “Do Nothing” to open the project without chang-
ing any network settings.
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Background

What is synchronization?
Synchronization is the process of getting two or more de-
vices to play back together at the same exact speed and 
position. These devices can range from audio and video 
tape machines to digital audio workstations, MIDI sequenc-
ers, synchronization controllers, and digital video devices.

Synchronization basics
There are three basic components of audio/visual synchro-
nization: position, speed, and phase. If these parameters 
are known for a particular device (the master), then a sec-
ond device (the slave) can have its speed and position “re-
solved” to the first in order to have the two devices play in 
perfect sync with one another.

Position

The position of a device is represented by either samples 
(audio word clock), video frames (timecode), or musical 
bars and beats (MIDI clock).

Speed

The speed of a device is measured either by the frame rate 
of the timecode, the sample rate (audio word clock) or by 
the tempo of the MIDI clock (bars and beats).

Phase

Phase is the alignment of the position and speed compo-
nents to each other. In other words, each pulse of the 
speed component should be aligned with each measure-
ment of the position for the most accuracy. Each frame of 
timecode should be perfectly lined up with the correct sam-
ple of audio. Put simply, phase is the very precise position 
of a synchronized device relative to the master (sample ac-
curacy).

Machine control (transport control)
When two or more devices are synchronized, the question 
remains: how do we control the entire system? We need 
to be able to locate to any position, play, record, and even 
jog and scrub the entire system using one set of controls.

Machine control is an integral part of any synchronization 
setup. In many cases, the device simply called “the mas-
ter” will control the whole system. However, the term 
“master” can also refer to the device that is generating the 
position and speed references. Care must be taken to dif-
ferentiate between the two.

Master and slave
Calling one device the “master” and another the “slave” 
can lead to a great deal of confusion. The timecode rela-
tionship and the machine control relationship must be dif-
ferentiated in this regard.

In this document, the following terms are used:

• The “timecode master” is the device generating position infor-
mation or timecode.

• The “timecode slave” is any device receiving the timecode and 
synchronizing or “locking” to it.

• The “machine control master” is the device that issues trans-
port commands to the system. 

• The “machine control slave” is the device receiving those 
commands and responding to them.

For example, Nuendo could be the machine control mas-
ter, sending transport commands to an external device 
which in turn sends timecode and audio clock information 
back to Nuendo. In that case, Nuendo would also be the 
timecode slave at the same time. So calling Nuendo sim-
ply the master is misleading.

In most scenarios, the machine control slave is also 
the timecode master. Once it receives a play command, 
that device starts generating timecode for all the timecode 
slaves to synchronize to.

Timecode (positional references)
The position of any device is most often described using 
timecode. Timecode represents time using hours, min-
utes, seconds, and frames to provide a location for each 
device. Each frame represents a visual film or video frame.

Timecode can be communicated in several ways:

• LTC (Longitudinal Timecode) is an analog signal that can be 
recorded on tape. It should be used for positional information 
primarily. It can also be used for speed and phase information 
as a last resort if no other clock source is available.
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• VITC (Vertical Interval Timecode) is contained within a compos-
ite video signal. It is recorded onto video tape and is physically 
tied to each video frame.

• MTC (MIDI Timecode) is identical to LTC except that it is a 
digital signal transmitted via MIDI.

• Sony P2 (9-Pin, RS-422) Machine Control also has a timecode 
protocol that is mainly used for locating and is not nearly accu-
rate enough for speed and phase. It can be used in certain situ-
ations where there is no alternative.

The Nuendo SyncStation is capable of using 9-Pin 
timecode in a very accurate manner.

Timecode standards
Timecode has several standards. The subject of the various 
timecode formats can be very confusing due to the use and 
misuse of the shorthand names for specific timecode stan-
dards and frame rates. The reasons for this confusion are 
described in detail below. The timecode format can be di-
vided into two variables: frame count and frame rate.

Frame count (frames per second)

The frame count of timecode defines the standard with 
which it is labeled. There are four timecode standards:

• 24 fps Film (F)
This frame count is the traditional count for film. It is also used for HD video 
formats and commonly referred to as “24 p”. However, with HD video, the 
actual frame rate or speed of the video sync reference is slower, 23.976 
frames per second, so timecode does not reflect the actual realtime on the 
clock for 24p HD video.

• 25 fps PAL (P)
This is the broadcast video standard frame count for European (and other 
PAL countries) television broadcast.

• 30 fps non-drop SMPTE (N)
This is the frame count of NTSC broadcast video. However, the actual 
frame rate or speed of the video format runs at 29.97 fps. This timecode 
clock does not run in realtime. It is slightly slower by 0.1 %.

• 30 fps drop-frame SMPTE (D)
The 30 fps drop-frame count is an adaptation that allows a timecode dis-
play running at 29.97 fps to actually show the clock-on-the-wall-time of 
the timeline by “dropping” or skipping specific frame numbers in order to 
“catch the clock up” to realtime.

Confused? Just remember to keep the timecode standard 
(or frame count) and frame rate (or speed) separate.

Frame rate (speed)

Regardless of the frame counting system, the actual 
speed at which frames of video go by in realtime is the 
true frame rate.

In Nuendo the following frame rates are available:

• 23.9 fps
This frame rate is used for film that is being transferred to NTSC video 
and must be slowed down for a 2-3 pull-down telecine transfer. It is also 
used for the type of HD video referred to as “24 p”.

• 24 fps
This is the true speed of standard film cameras.

• 24.9 fps
This frame rate is commonly used to facilitate transfers between PAL and 
NTSC video and film sources. It is mostly used to correct for some error.

• 25 fps
This is the frame rate of PAL video.

• 29.97 fps
This is the frame rate of NTSC video. The count can be either non-drop 
or drop-frame.

• 30 fps
This frame rate is not a video standard anymore but has been commonly 
used in music recording. Many years ago it was the black and white 
NTSC broadcast standard. It is equal to NTSC video being pulled up to 
film speed after a 2-3 telecine transfer.

• 59.98 fps
This rate is also referred to as “60 p”. Many professional HD cameras 
record at 59.98 fps. While 60 fps could theoretically exist as a frame rate, 
no current HD video camera records at a full 60 fps as a standard rate. 

Frame count vs. frame rate

Part of the confusion in timecode stems from the use of 
“frames per second” in both the timecode standard and 
the actual frame rate. When used to describe a timecode 
standard, frames per second defines how many frames of 
timecode are counted before one second on the counter 
increments. When describing frame rates, frames per sec-
ond define how many frames are played back during the 
span of one second of realtime. In other words: Regard-
less of how many frames of video there are per second of 
timecode (frame count), those frames can be moving at 
different rates depending on the speed (frame rate) of the 
video format. For example, NTSC timecode (SMPTE) has 
a frame count of 30 fps. However, NTSC video runs at a 
rate of 29.97 fps. So the NTSC timecode standard known 
as SMPTE is a 30 fps standard that runs at 29.97 realtime.
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When transferring material between various video for-
mats and film, it becomes necessary to change the speed 
(frame rate) of one timecode standard so that video or film 
frames can line up in some mathematical relationship to 
the destination format. That is where all the various pull-
ups and pull-downs come from. Certain frame rates were 
created as a result of applying a pull-down. For example, 
23.976fps is actually 24fps pulled down by 0.1 %. For 
more information on pulls, see “About film transfers” on 
page 529 and “Compensating for speed changes in Nu-
endo” on page 531.

Clock sources (speed references)
Once the position is established, the next essential factor 
for synchronization is the playback speed. Once two de-
vices start playing from the same position, they must run at 
exactly the same speed in order to remain in sync. There-
fore, a single speed reference must be used and all devices 
in the system must follow that reference. With digital audio, 
the speed is determined by the audio clock rate. With 
video, the speed is determined by the video sync signal.

Audio clock
Audio clock signals run at the speed of the sample rate 
used by a digital audio device and are transmitted in sev-
eral ways:

Word clock

Word clock is a dedicated signal running at the current 
sample rate that is fed over BNC coaxial cables between 
devices. It is the most reliable form of audio clock and is 
relatively easy to connect and use.

AES/SPDIF Digital Audio

An audio clock source is embedded within AES and SPDIF 
digital audio signals. This clock source can be used as a 
speed reference. Preferably, the signal itself does not con-
tain any actual audio (digital black), but any digital audio 
source can be used if necessary.

ADAT Lightpipe

ADAT Lightpipe, the 8-channel digital audio protocol de-
veloped by Alesis, also contains audio clock and can be 
used as a speed reference. It is transmitted via optical ca-
bles between devices.

Do not confuse the audio clock embedded in the 
Lightpipe protocol with ADAT Sync, which has timecode 
and machine control running over a proprietary DIN plug 
connection.

Video sync
Video sync signals are transmitted over BNC coaxial con-
nections between devices and run at the frame rate of the 
video device.

There are two types of video sync signals:

• bi-level (also known as black burst)
• tri-level (used for HD video)

Complications arise when a video device is used as a 
speed reference. The video sync signal must be converted 
into an audio clock signal in order for audio devices to syn-
chronize at the correct speed. This can be accomplished as 
follows:

• Using a dedicated synchronizer such as the Nuendo 
SyncStation from Steinberg.
A dedicated synchronizer can take a video sync signal (among others) 
and generate either word clock or AES/SPDIF signals that may be used 
as an audio clock source.

• Using a house sync generator.
A master sync generator such as the Rosendahl Nanosync HD can simul-
taneously generate video sync and audio clock from the same source. This 
ensures that both video and audio devices fed by the sync generator will 
run at the same speed.

Some audio cards and interfaces can accept a video 
sync signal as an audio clock source, performing a similar 
function to a dedicated synchronizer. 

! Care must be taken to ensure that the incoming video 
sync frame rate matches that of the Nuendo project.
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MIDI clock
MIDI clock is a signal that uses position and timing data 
based on musical bars and beats to determine location 
and speed (tempo). It can perform the same function as a 
positional reference and a speed reference for other MIDI 
devices. Nuendo supports sending MIDI clock to external 
devices but cannot slave to incoming MIDI clock.

Frame edge alignment (phase)
There are 1600 samples of audio in one frame of video run-
ning at 48 kHz and 29.97 fps. Phase alignment adjusts the 
playback of Nuendo so that the precise sample of audio is 
lined up with the leading edge of the timecode frame.

While it is possible to have very good sync without proper 
phase alignment, it will not be sample-accurate. With Nu-
endo there are four ways of achieving sample-accurate 
(phase aligned) sync:

• Using Steinberg’s SyncStation synchronizer.
The SyncStation can resolve video sync, word clock, and timecode all in 
one unit with extensive machine control capabilities.

• Using Steinberg’s Time Base synchronizer.
The Time Base has the ability to align the audio clock with the incoming 
timecode.

• Using VST System Link.
VST System Link connects multiple workstations together using digital 
audio connections. System Link uses the sample clock for position and 
speed references, ensuring sample-accurate synchronization.

• ASIO Positioning Protocol (APP)
Specific ASIO audio cards that have built in timecode readers support 
Steinberg’s APP. APP is able to analyze the incoming timecode and com-
pare that to the sample clock to provide sample-accurate synchronization.

The Project Synchronization Setup 
dialog
Nuendo’s Project Synchronization Setup dialog provides a 
central place to configure a complex synchronized system. 
In addition to settings for timecode sources and machine 
control settings, project setup parameters are available 
along with basic transport controls for testing the system.

To open the Project Synchronization Setup dialog, pro-
ceed as follows:

• On the Transport menu, select the “Project Synchroni-
zation Setup…” option.

• On the Transport panel, [Ctrl]/[Command]-click the 
Sync button.

The dialog is organized into sections separating related 
groups of settings. The arrows shown between the vari-
ous sections of the dialog indicate how settings in one 
section influence settings in another section. In the follow-
ing, the available sections are described in detail.

The Machine Control Input Settings are linked to the Machine Control 
Input Source.

The Nuendo section
At the center of the Project Synchronization Setup dialog 
is the Nuendo section. It is provided to help you visualize 
the role that Nuendo takes in your setup. It shows which 
external signals enter or leave the application.

The only controls available in the Nuendo section are the 
transport controls and the Sync button at the bottom. 
These controls are duplicates of the ones found in the 
Transport panel and are made available in order to test 
various synchronization settings.

Sync button and transport controls in the Nuendo section

! MIDI clock cannot be used to synchronize digital au-
dio. It is only used for MIDI devices to play in musical 
sync with one another. Nuendo does not support be-
ing a MIDI clock slave.

! APP is only supported when Nuendo is a timecode 
slave.
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The two Project Setup sections
The Project Setup sections at the bottom left of the Project 
Synchronization Setup dialog are related to the active 
project in Nuendo. Therefore they are only visible if you 
have opened a project in Nuendo. Here you can change 
timecode parameters and project options that affect syn-
chronization. These settings are identical with the settings 
in the Project Setup dialog, see “The Project Setup dialog” 
on page 57.

Unlike the other settings in the Project Synchronization 
Setup dialog, which are applied globally, the Project 
Setup options are saved with the active project.

Applying changes to the project setup

When you change any of the parameters in the Project 
Setup sections, the title bar of the top section changes to 
“Apply”. Click anywhere on that title bar to apply your 
changes. If you close the Project Synchronization Setup 
dialog without applying your Project Setup changes, 
these will be lost.

Changing the Project Setup settings in the Project Syn-
chronization Setup dialog instead of the Project Setup di-
alog allows you to test your changes without having to exit 
the dialog.

Project Setup - Time
The “Project Setup - Time” section has six settings that 
relate to timecode and playback speed in Nuendo.

Project Start Time

This setting determines the timecode value at the start of 
the project. For example, many video timelines start at 
01:00:00:00 to allow for pre-roll and test tones prior to 
the one hour mark. In that case, a start time of 
00:55:00:00 might be appropriate.

Project Length

This setting determines how much timeline Nuendo allo-
cates to the project. Note that the more time is allocated, 
the more resources are used. Therefore it is advised to set 
the length to a reasonable amount for the current project.

Project Frame Rate

This setting determines both the timecode standard and 
frame rate for the project. Make sure that this setting 
matches the frame rate of any incoming timecode.

Sample Rate

This setting determines the sample clock speed of Nu-
endo’s audio engine. Ensure that this setting matches the 
sample rate of incoming word clock signals or other audio 
clock sources. For further information about this setting, 
refer to “The Project Setup dialog” on page 57.

Pull-Up/Pull-Down

This setting affects the speed of the audio transport in Nu-
endo. If Nuendo’s playback is slowed down or sped up via 
an external sample clock source, you need to adjust the 
time displays accordingly by selecting the correct pull fac-
tor. For detailed information on audio pull-up and pull-
down operations, see “Adjusting audio playback speed” 
on page 531.

Video Pull

This setting affects the video playback speed in Nuendo. 
The video playback rate may also be pulled up or down, 
depending on the need. For more information on video 
pull, see “Video pull-up and pull-down” on page 533.
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Project Setup - Display
Regardless of the technical needs of a project’s timeline, 
the user might want to see time information displayed in a 
different format. The settings in the “Project Setup - Dis-
play” section allow you to change how Nuendo’s timeline 
is displayed, but not the underlying timeline itself.

Display Format

This setting determines how Nuendo displays time in the 
Project window and the primary display of the Transport 
panel.

Display Time Offset

The value set in this field will be added or subtracted from 
the current timeline position. This setting is used for dis-
play only.

Bar Offset

This setting allows you to specify timeline display offsets 
in musical terms instead of timecode. The Bar Offset value 
is independent of the “Display Time Offset” value.

Timecode Source
The Timecode Source setting determines whether Nuendo 
is acting as timecode master or slave.

When set to “Internal Timecode”, Nuendo is the timecode 
master, generating all position references for any other 
device in the system. The other options are for external 
timecode sources. Selecting any of these, makes Nuendo 
a timecode slave when the Sync button is activated.

Internal Timecode

Nuendo generates timecode based on the project timeline 
and project setup settings. The timecode will follow the 
format specified in the Project Setup section.

MIDI Timecode

Nuendo acts as a timecode slave to any incoming MIDI 
timecode (MTC) on the port(s) selected in the MIDI Time-
code Settings section, now visible to the left of the Time-
code Source section.

Selecting “All MIDI Inputs” allows Nuendo to sync to MTC 
from any MIDI connection. You can also select a single 
MIDI port for receiving MTC.

9 Pin Sync 1 & 2

Timecode polling over Sony’s 9-Pin RS422 protocol can 
be used as a timecode source. For more information, see 
“Machine Control Output Settings – 9-Pin Control 1 and 
2” on page 505.

When you select one of the 9-Pin options, further settings 
become available in the “9-Pin Device Settings” section to 
the left of the Timecode Source section:

! Using 9-Pin timecode is not recommended without 
using Steinberg’s SyncStation hardware. In other sce-
narios it should only be used if no other timecode 
source is available.

Option Description

Serial Port  
pop-up menu

Use this pop-up menu to select the serial port corre-
sponding to the source of the 9-pin timecode.
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ASIO Audio Device

This option is only available with audio cards that support 
ASIO Positioning Protocol. These audio cards have an in-
tegrated LTC reader or ADAT sync port and can perform a 
phase alignment of timecode and audio clock.

VST System Link

VST System Link can provide all aspects of sample-accu-
rate synchronization between other System Link worksta-
tions. For information on configuring VST System Link, 
see “Working with VST System Link” on page 512.

Steinberg Time Base

The Time Base is a hardware synchronizer that can provide 
sample-accurate sync for Nuendo. Please refer to the doc-
umentation that comes with the unit for setup instructions.

Steinberg SyncStation

The SyncStation is a full-featured hardware synchronizer 
with extensive machine control capabilities that provides 
sample-accurate sync with a variety of external devices. 
Please refer to the documentation that comes with the unit 
for setup instructions.

Timecode Preferences
When MIDI Timecode, Steinberg Time Base, or Steinberg 
SyncStation is selected, the Timecode Preferences sec-
tion becomes available, providing several options for 
working with external timecode.

Lock Frames

This setting determines how many full frames of timecode 
it takes for Nuendo to try and establish sync or “lock”. If 
you have an external tape transport with a very short start-
up time, try lowering this number to make lock-up even 
faster. This option can only be set to multiples of two.

Drop Out Frames

This setting determines the amount of missed timecode 
frames it takes for Nuendo to stop. Using LTC recorded 
on an analog tape machine can result in some amount of 
drop outs. Increasing this number allows Nuendo to “free-
wheel” over missed frames without stopping. Lowering 
this number causes Nuendo to stop sooner once the tape 
machine has stopped.

Inhibit Restart ms

Some synchronizers still transmit MTC for a short period 
after an external tape machine has been stopped. These 
extra frames of timecode sometimes cause Nuendo to re-
start suddenly. The “Inhibit Restart ms” setting allows you 
to control the amount of time in milliseconds that Nuendo 
will wait to restart (ignoring incoming MTC) once it has 
stopped.

Jam-Sync

When the Jam-Sync option is activated, Nuendo will ignore 
any changes in timecode once it has started playback. This 
can be useful in special situations, such as synchronizing 
to broken timecode.

Control Play-
back Speed

When this option is activated, Nuendo will attempt to 
control the playback speed of the 9-pin device.

Displays follow 
locating device

When this option is activated, the Project cursor will 
follow the incoming timecode’s position. This is very 
helpful with tape-based devices as they locate much 
slower than non-linear systems. The cursor gives you a 
visual indication of the position of the tape machine at 
all times.

Option Description

! When Jam-Sync is enabled, the “Drop Out Frames” 
value is ignored so that Nuendo does not stop if 
timecode is interrupted.
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Auto-Detect Frame-Rate Changes

Nuendo can notify the user when the frame rate of time-
code changes at any point. This is helpful in diagnosing 
problems with timecode and external devices. This notifi-
cation will interrupt playback or recording. Deactivating 
this option will avoid any interruption in playback or re-
cording.

Machine Control Output Destination
When the Sync button on the Transport panel is activated, 
all transport commands (including movements of the cur-
sor in the Project window) are translated into machine con-
trol commands and routed according to the settings made 
in the “Machine Control Output Destination” section.

No Machine Control

When this option is selected, transport commands are not 
routed or sent to any device. This does not affect the op-
eration of the individual 9-Pin and MMC Device panels. 
They can still function regardless of the machine control 
destination. The machine control output destination only 
defines the routing of transport commands from Nuendo 
while sync is enabled.

MIDI Machine Control

When this option is selected and sync is enabled, all trans-
port commands from the Nuendo transport are routed to 
MMC devices connected to the MIDI ports that you de-
fined in the “Machine Control Output Settings” section 
(see “Machine Control Output Settings” on page 504).

9-Pin Control 1 and 2

When one of the 9-Pin Control options is selected and 
sync is enabled, transport commands from Nuendo are 
routed to the 9-Pin Device 1 or 2, as configured in the 
“Machine Control Output Settings” section (see “Machine 
Control Output Settings” on page 504).

Steinberg ‘Time Base’ and Steinberg SyncStation

When this option is selected and sync is enabled, trans-
port commands from Nuendo are routed to a connected 
Time Base or Nuendo SyncStation unit (respectively). 
Please refer to the documentation that comes with your 
unit for complete information on its operation.

Machine Control Output Settings
Each machine control destination has settings associated 
with it. These settings configure how the remote device 
will respond to transport commands from Nuendo.

Machine Control Output Settings – MIDI 
Machine Control

There are four settings associated with MIDI Machine 
Control Operation:

MMC Input and Output

The MMC Input and MMC Output settings determine 
which MIDI port in your system will send and receive 
MMC commands. Set both the input and output to MIDI 
ports that are connected to the desired MIDI device.

MMC Device ID

The MMC device ID should be set to the same number as 
the receiving device. You can also set the device ID to “All” 
if more than one machine is receiving MMC commands or if 
the device ID is not known.

! If there is a discrepancy between the project frame 
rate in Nuendo and incoming timecode, Nuendo 
might still be able to lock to the incoming timecode. If 
the user is unaware of these differences, problems 
can arise later in postproduction.
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Some devices can only listen to their specific IDs. 
Therefore, using the All option will not work with such 
devices.

Number of Audio Tracks

The number of audio tracks should be set to match the 
amount of available audio tracks in the destination device. 
This setting determines how many record-enable buttons 
are shown in the MMC Master panel (see below).

MMC Master panel

The MMC Master panel can be opened from the Devices 
menu. In order to use the MMC Master panel, proceed as 
follows:

• Open the Preferences dialog, select the MIDI Filter sec-
tion and make sure SysEx is activated in the Thru section.
This is necessary since MMC uses two-way communication (the tape re-
corder “replies” to the MMC messages it receives from Nuendo). By fil-
tering out SysEx Thru, you ensure that these MMC System Exclusive 
replies are not echoed back to the tape recorder.

• On the MMC Master panel, activate the Online button 
to use the transport buttons on the panel to control the 
transport of the device.
It is not necessary to have this activated in order to synchronize with the 
MMC device. It only affects operation of the MMC Master panel.

• You can use the buttons to the left on the MMC Master 
panel to arm tape tracks for recording.

• The “A1, A2, TC, VD” items refer to additional tracks 
usually found on video tape recorders.
Refer to the manual of your VTR device to see if these tracks are sup-
ported.

Machine Control Output Settings – 9-Pin 
Control 1 and 2

Serial Port

The two 9-Pin devices connect to your computer from 
available serial ports. Use the Serial Port pop-up menu to 
select the appropriate serial port.

Audio Track Count

Use this option to specify how many audio tracks are 
available. The 9-Pin Device panel will then contain the 
same amount of record-enable buttons.

‘Try to Recognize Device’ vs. ‘Use Generic Device’

The RS422 9-Pin protocol can control a wide variety of 
devices. Each device may have differing features. Nuendo 
has a library of device profiles that can be used with 9-Pin 
devices.

You can choose whether Nuendo will try to recognize the 
device by polling it and comparing that to its library, or you 
can use a generic device profile.

Auto Edit PRE/POST

Auto Edit is a feature of 9-Pin devices that allows for auto-
matic punch in and out on record-enabled tracks. The pre-
roll and post-roll times determine where the 9-Pin device 
will start and stop playback during an Auto Edit proce-
dure. For more information on Auto Edit, see “9-Pin Auto 
Edit” on page 508.

! PCs and Apple computers use different types of se-
rial ports. PCs typically provide a RS232 interface 
on a 9-Pin Dsub connection that must be converted 
to RS422 in order to interface with Sony 9-Pin de-
vices. Apple computers require a USB to RS422 se-
rial converter such as the Keyspan USA-19W.
505
Synchronization



Master Machine Control Preferences
There are five preference settings for Nuendo’s master 
machine control operation. They affect how the machine 
reacts to various commands from Nuendo.

Machine follows mouse edits

When this option is activated, moving the project cursor 
with the mouse results in transport commands so that the 
machine continuously locates to the new cursor position. 

If this causes a great deal of unnecessary tape winding, 
you can deactivate the option. In that case transport com-
mands are only sent to the machine when the mouse but-
ton is released.

Machine follows jog

When this option is activated, turning the jog wheel on the 
Transport panel or on a remote controller results in trans-
port commands so that the machine continuously locates 
to the new project cursor position.

Again, this might cause a great deal of unnecessary tape 
winding. If disabled, transport commands are only sent to 
the machine when the user stops moving the wheel.

Send ‘Shuttle’ instead of ‘FF/Rewind’

Many video decks respond differently to Shuttle com-
mands or FF/Rewind commands. FF/Rewind commands 
often result in the tape being released from the heads and 
the motors entering a high-speed wind mode. This takes a 
great deal of time, and the machine cannot read the time-
code on the tape while winding. Therefore position infor-
mation is lost. Activate this option if shuttle commands are 
preferred.

Send ‘Still’ instead of ‘Stop’

Similar to FF/Rewind commands, Stop commands result 
in the tape being released from the heads. Still commands 
on the other hand, also cause the transport to stop, but 
without releasing the tape from the heads. Activate this 
option if you want the picture from the video deck to be 
visible also in Stop mode or if you want the machine to 
enter playback mode faster.

Allow machine controlled cycle

When this option is activated, Nuendo starts playback at 
the left locator minus the pre-roll time and stops playback 
at the right locator plus the post-roll time. When repeating 
a section, Nuendo locates back to the pre-roll position 
and waits for the machine to reach that position before is-
suing a start command.

If this option is deactivated, the machine will not follow 
when Nuendo cycles. Upon reaching the right locator, Nu-
endo locates back to the left locator, but the machine con-
tinues playback.

Machine Control Input Source
Nuendo can respond to machine control commands from 
external MIDI and 9-Pin devices. Nuendo can follow in-
coming transport commands (locate, play, record) and re-
spond to record-enabling commands for audio tracks. 
This allows Nuendo to easily integrate into larger studio 
systems with centralized machine control and synchroni-
zation such as theatrical mixing stages.

MIDI Machine Control

When MIDI Machine Control is selected as the input 
source, several settings become available in the Machine 
Control Input Settings section:

Option Description

MMC Input Set this to the MIDI input that is connected to the 
master machine control device.
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Steinberg ‘Time Base’

When the Time Base unit is connected to Nuendo, there 
are various settings for machine control input. Please refer 
to the documentation that comes with the Time Base for 
complete information on its use.

Steinberg SyncStation

When the SyncStation is selected as the machine control 
input source, there are several options for how these com-
mands are routed within the SyncStation itself. Please re-
fer to the documentation that comes with the SyncStation 
for complete information on its use.

MIDI Timecode Destinations
Nuendo can send MTC to any MIDI port. Use this section 
to specify the MIDI ports to which MTC is routed. Devices 
that can lock to MTC will chase Nuendo’s timecode posi-
tion.

Some MIDI interfaces send MTC over all ports by de-
fault. If this is the case, only select one port of the interface 
for MTC.

MIDI Timecode Follows Project Time

Activate this option to ensure that the MTC output follows 
Nuendo’s time position at all times including looping, lo-
cating, or jumping while playing. If not, MTC will continue 
on without changing locations at a loop or jump point until 
playback stops.

Timecode Offset

This option allows you to specify an offset to be applied to 
outgoing MTC. The amount of offset will be added or sub-
tracted from the project’s current position before being 
transmitted.

MIDI Clock Destinations
Some MIDI devices like drum machines can match their 
tempo and location to incoming MIDI clock. Select any 
MIDI ports that you wish to output MIDI clock.

MIDI Clock Follows Project Position

Activate this option to ensure that the MIDI clock device 
follows Nuendo when looping, locating, or jumping while 
playing.

Some older MIDI devices might not respond well to 
these positioning messages and could take some time 
synchronizing to the new location.

Always Send Start Message

MIDI clock transport commands include Start, Stop, and 
Continue. However, some MIDI devices do not recognize 
the Continue command. By activating the “Always Send 
Start Message” option, you can avoid this problem with 
specific MIDI devices.

Send MIDI Clock in Stop Mode

Activate this option if you are working with a device that 
needs MIDI clock to run continuously in order to operate 
arpeggiators and loop generators.

MMC Output Set this to the MIDI output that is connected to the 
master machine control device.

MMC Device ID This determines the MIDI ID number that is used to 
identify the machine in Nuendo.

! The MMC protocol involves polling devices (request-
ing information) for their status which requires two 
way communication. While some functions may work 
with only one way communication, it is best to con-
nect both MIDI ports (input and output) of MMC 
devices. Refer to “MMC Master panel” on page 505 
to ensure that the MIDI filter is set up correctly.

Option Description
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Synchronized operation
Once you have connected all the devices that will be syn-
chronized, it is important to understand how Nuendo op-
erates in Sync mode. Sync mode is enabled by activating 
the Sync button on the Transport panel.

Sync mode
When you activate the Sync button, the following happens:

• Transport commands are routed to the machine control 
destination output as specified in the Project Synchroniza-
tion Setup dialog.
Locate, Play, Stop, and Record commands will now be sent to an exter-
nal device.

• Nuendo awaits incoming timecode from the chosen 
timecode source defined in the Project Synchronization 
Setup dialog in order to play.
Nuendo will detect incoming timecode, locate to its current position, and 
start playback in sync with the incoming timecode.

In a typical scenario, an external tape machine (e.g. a VTR) 
has its timecode output connected to Nuendo. Nuendo is 
sending machine control commands to the deck. When 
Sync is activated and you click Play on the Transport panel, 
a play command is sent to the VTR. The VTR in turn starts 
playback, sending timecode back to Nuendo. Nuendo then 
synchronizes to that incoming timecode.

If the “Machine follows mouse edits” option is activated and 
you change the project cursor position with the mouse or 
key command, machine control commands are sent to the 
remote deck so it will locate to the new position.

In this way, synchronized operation is somewhat invisible 
to the user. Just go about editing and mixing while the syn-
chronized devices chase all movements of the cursor au-
tomatically.

Nuendo’s Edit Mode will take advantage of this feature by 
locating the VTR to the start of the first selected event. For 
more information about Edit Mode, see “About the Edit 
Mode” on page 527.

9-Pin Auto Edit
Most 9-Pin devices such as VTRs have the capability of 
performing very accurate punch-ins and punch-outs on 
audio tracks. These punches are tied to video frames and 
are programmed using timecode. This type of recording is 
called an “Auto Edit”.

Nuendo can use its auto-punch feature to program Auto 
Edit functions of a VTR via 9-Pin control. The left and right 
locators in the Project window define the punch in and 
punch out of the Auto Edit. Provided that Nuendo is in 
Sync mode, pressing the Auto Edit button on the 9-Pin 
Device panel causes the punch-in to happen automatically.

Auto Edits can only happen on a timecode frame. 
Punching in or out in between video frames is not 
possible.

Auto Edit Pre-Roll and Post-Roll

Since VTRs require some amount of pre-roll time in order 
to get tape up to speed for proper recording, each 9-Pin 
device has options for setting a pre-roll and post-roll 
amount in seconds. The default values of 5 seconds pre-
roll and 2 seconds post-roll should work in most cases. 
You can change these values in the “Machine Control 
Output Settings” section, see “Machine Control Output 
Settings – 9-Pin Control 1 and 2” on page 505.

! With tape-based devices, synchronized operation 
will be slower due to the winding time necessary for 
the tape machine to locate to a new position.

! In order to use the 9-Pin Device panel to control an 
external deck, the Online button must be activated 
and tracks must be armed.
508
Synchronization



Example scenarios
To better understand how synchronization options can be 
utilized, three example scenarios are provided.

Personal music studio
In a personal music studio, the user might have the need of 
synchronizing with an external recording device such as a 
portable hard disk recorder used for live remote recordings.

In this example, MIDI will be used for timecode and ma-
chine control while the audio clock will be handled by 
Lightpipe digital audio connections.

• When the Sync button is activated, Nuendo sends 
MMC commands to the hard disk recorder.
Nuendo can remotely start playback of the recorder.

• The hard disk recorder is using audio clock from Nu-
endo’s audio interface as the speed reference.
It is also possible for Nuendo to use the audio clock from the recorder. 
The audio clock is carried over the Lightpipe digital audio connection 
that also carries audio signals.

• The hard disk recorder sends back MTC to Nuendo.
When the recorder begins playing, MTC is sent back to Nuendo which 
will sync to that timecode.

Sync settings for a personal music studio

To synchronize the devices in this example scenario, pro-
ceed as follows:

1. Make the connections as shown in the diagram above.
In this simple example, any device that uses MTC can be substituted.

2. Open the Project Synchronization Setup dialog and 
select “MIDI Timecode” as the timecode source.
When recording from the hard disk recorder into Nuendo, Nuendo will 
be the machine control master and the timecode slave, locking to incom-
ing MTC.

3. In the “Machine Control Output Destination” section, 
select the “MIDI Machine Control” option.
Nuendo will now send MMC commands to the hard disk recorder to locate 
and start playback.

4. In the “Machine Control Output Settings” section, as-
sign the MIDI input and output ports that are connected to 
the hard disk recorder.
Since MMC uses two-way communication, both MIDI ports should be 
connected. Be sure the MIDI filter does not echo SysEx data.

5. On the Transport panel, activate the Sync button.
This routes transport commands to the hard disk recorder via MIDI and 
sets Nuendo as the timecode slave.

6. On the hard disk recorder, enable MMC and MTC.
Follow the instructions on how to set up the unit to receive MMC com-
mands and transmit MTC.

7. In Nuendo, click the Play button.
The hard disk recorder should start playback and send MTC to Nuendo. 
Once Nuendo syncs to MTC, the status on the Transport panel should 
read “Lock” and show the current frame rate of incoming MTC.
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Postproduction suite
In audio for video postproduction, synchronization needs 
are an everyday concern. Very often users need to synchro-
nize with a 9-Pin VTR in order to work with video material. 
At the same time the audio clock has to be synchronized 
with the video clock source to ensure that both audio and 
video run at the same speed.

Finished audio can then be recorded back onto the digital 
audio tracks of a VTR in perfect sync with the video 
(known as a “layback”). In this example, 9-Pin machine 
control is used. The audio clock is a word clock signal 
generated by the house sync generator that also gener-
ates the video sync signal. Timecode is handled by a 
SMPTE to MTC reader (e. g. in the audio interface).

• The house sync generator creates both the video sync 
and audio word clock so that the VTR and Nuendo play at 
the same speed.
When laying back digital audio to the VTR, the AES signal will already be 
in sync with the VTR’s digital audio inputs.

• 9-Pin machine control is used to manipulate the VTR’s 
transport.
The VTR can shuttle, locate, play, and record from commands issued by 
Nuendo. Also, Nuendo can arm audio tracks on the VTR for layback.

• When the VTR enters play, LTC is fed back to Nuendo 
which locks to that incoming timecode.
If the LTC reader is part of an audio card that is APP compatible, sample-
accurate synchronization is possible in this scenario.

Sync settings for audio layback in a postproduction suite

These steps outline the process of “laying back” finished 
audio to the VTR. To configure Nuendo for this example 
setup, proceed as follows:

1. Make the connections as shown in the diagram above.
Ensure that video sync and word clock are tied to the same generating 
source!

2. Open the Project Synchronization Setup dialog and 
select either “ASIO Audio Device” or “MIDI Timecode” as 
the timecode source.
Depending on your system’s configuration, the sound card might have an 
LTC reader built into it or you may have to use a LTC to MTC converter 
interface to get timecode into Nuendo.

3. In the “Machine Control Output Destination” section, 
select 9-Pin Control 1 or 2.
Nuendo’s transport buttons will send commands to the VTR over the 
9-Pin RS422 connection.

4. From the Devices menu, select the 9-Pin Device 1 or 
2 option.
Using the Auto Edit feature, you will be able to perform laybacks to the 
VTR via digital audio connections. VTRs with digital audio tracks use 
48kHz as a standard sampling rate. Some decks only have 20 bit depth 
capacity so make sure to dither properly for the intended delivery format.

5. Click the Online button.
Now you can use the device panel to control the VTR.

6. Test the transport with the 9-Pin Device panel.
Ensure that all connections are working properly by testing the various 
transport buttons on the 9-Pin Device panel.

7. Record-enable the audio tracks that you wish to 
record to.
Most professional VTRs have four audio tracks. Many high-definition 
VTRs have eight for recording 6-channel surround sound plus a stereo 
downmix all on the same tape.

8. Play back the project and look at the meters on the 
VTR to ensure that proper recording levels are set.
That way you can also make sure that the digital audio connections are 
working properly.

9. Set the left and right locators to the punch in and 
punch out points.
Auto Edit uses the left and right locators to program the record in and out 
points of the VTR.
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10. Ensure that the pre-roll and post-roll times are appro-
priate for the VTR.
In most cases, the default values will be sufficient for the VTR to get up to 
speed before punching in.

11. On Nuendo’s Transport panel, activate the Sync button.
This turns Nuendo into a timecode slave. Once the VTR starts to play, 
Nuendo will sync to incoming timecode.

12. On the 9-Pin Device panel, click the Auto Edit button.
This starts the Auto Edit process. The tape transport locates to the set 
pre-roll position (by default, 5 seconds before the left locator) and starts 
playback. When the left locator is reached, the VTR enters record mode.

13. The Auto Edit is complete when the right locator is 
reached and the VTR goes out of record.
After reaching the right locator, the VTR continues playing for the set 
post-roll time (by default 2 seconds) before it stops.

Theatrical mixing stage
A theatrical mixing stage (also known as a dub stage) is a 
large theater-sized room used to create the final mixdown 
for feature films that will be presented in theaters with sur-
round sound. These types of studios are very complex, 
dealing with hundreds of audio tracks at once through 
large mixing consoles along with high-quality video and 
film playback systems.

In this example, Nuendo is only one part of a very large 
system of devices that need to be perfectly synchronized 
with one another. An external master 9-Pin controller will 
operate the transport of the entire system remotely from 
the console and timecode will be handled via 9-Pin inter-
face through the SyncStation. The audio clock will be ref-
erenced to tri-level HD video sync fed to the SyncStation 
which will output dedicated word clock to both Nuendo 
and the digital console.

• Audio clock is generated by the house sync generator.
In this example, video sync is being fed to the SyncStation as both a 
speed reference and a phase reference for sample-accurate sync. Word 
clock goes from the SyncStation to Nuendo and the digital console.

• The console is the machine control master, sending 
9-Pin control commands and status messages to the 
SyncStation.
The console controls the playback in Nuendo via the SyncStation. Nuendo 
is the timecode slave. The SyncStation is acting as a machine control 
slave.

• Timecode is fed to the SyncStation via 9-Pin and then 
via a USB connection to Nuendo (as MTC).
The SyncStation’s 9-Pin interface is capable of using 9-Pin timecode ef-
fectively for accurate synchronization. Direct serial port 9-Pin connections 
should not be used this way.

Sync settings for a theatrical mixing stage

To configure Nuendo for this example setup, proceed as 
follows:

1. Make the connections as shown in the diagram above.
In this example, the SyncStation handles many of the synchronization 
tasks. Please refer to the documentation that comes with the SyncSta-
tion for complete information on its operation.

2. Open the Project Synchronization Setup dialog and 
select the SyncStation as the timecode source.
The SyncStation sends MTC over the USB connection to Nuendo. The 
SyncStation will use its “Virtual Master” mode to generate timecode.
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3. In the “Machine Control Input Source” section, select 
the SyncStation option.
Provided that the SyncStation is set to route record and track arming 
commands to Nuendo, this will allow the digital console to record-enable 
audio tracks in Nuendo and enter record mode via 9-Pin commands sent 
to the SyncStation.

4. On the Transport panel, activate the Sync button.
Nuendo will await incoming timecode from the SyncStation.

5. Test the record-enable buttons on the console.
If configured properly, the corresponding audio tracks in Nuendo be-
come record-enabled.

6. Press play on the console’s transport control.
This will send the play commands to the SyncStation over 9-Pin and the 
SyncStation will start generating timecode to synchronize Nuendo.

Working with VST System Link
VST System Link is a network system for digital audio that 
allows you to have several computers working together in 
one large system. Unlike conventional networks it does not 
require Ethernet cards, hubs, or CAT-5 cables; instead it 
uses the kind of digital audio hardware and cables you 
probably already possess in your studio.

VST System Link has been designed to be simple to set 
up and operate, yet give enormous flexibility and perfor-
mance gains in use. It is capable of linking computers in a 
“ring” network (the System Link signal is passed from one 
machine to the next, and eventually returns to the first ma-
chine). VST System Link can send its networking signal 
over any type of digital audio cable, including S/PDIF, 
ADAT, TDIF, or AES, as long as each computer in the sys-
tem is equipped with a suitable ASIO compatible audio in-
terface.

Linking up two or more computers gives you vast possibil-
ities:

• Dedicate one computer to running VST instruments while re-
cording audio tracks on another.

• If you need lots of audio tracks, you may simply add tracks on 
another computer.

• You could have one computer serve as a “virtual effect rack”, 
running CPU-intensive send effect plug-ins only.

• Since you can use VST System Link to connect different VST 
System Link applications on different platforms, you can take 
advantage of effect plug-ins and VST instruments that are 
specific to certain programs or platforms.

Requirements
The following equipment is required for VST System Link 
operation:

• Two or more computers.
These can be of the same type or use different operating systems – it 
does not matter. For example, you can link an Intel-based PC to an Apple 
Macintosh without problems.

• Each computer must have audio hardware with specific 
ASIO drivers.

• The audio hardware must have digital inputs and out-
puts.
To be able to connect the computers, the digital connections must be 
compatible (i. e. the same digital formats and connection types must be 
available).

• At least one digital audio cable must be available for 
each computer in the network.

• A VST System Link host application must be installed 
on each computer.
Any VST System Link application can connect to another.

Additionally, use of a KVM switchbox is recommended.

Using a KVM switchbox

Whether you want to set up a multi-computer network or a 
small network in a limited space, it is a good idea to invest in 
a KVM (Keyboard, Video, Mouse) switchbox. With one of 
these you can use the same keyboard, monitor, and mouse 
to control each computer in the system, and you can switch 
between computers very rapidly. KVM switchboxes are not 
too expensive, and they are very easy to set up and operate. 
If you decide not to go this route, the network will function 
just the same, but you may end up doing a lot of jumping 
from one machine to the other while setting up!
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Making connections
Below, we assume that you are connecting two comput-
ers. Should you have more than two computers, it is still 
best to start with two and add the others one by one once 
the system is working – this makes troubleshooting easier 
if you run into problems. For two computers, you will need 
two digital audio cables, one in each direction:

1. Use the first digital audio cable to connect the digital 
output of computer 1 to the digital input of computer 2.

2. Use the other cable to connect the digital output of 
computer 2 to the digital input of computer 1.

• If a card has more than one set of inputs and outputs, 
choose whichever one that suits you – for simplicity usu-
ally the first set is best.

Synchronization
Before you proceed, you need to make sure that the clock 
signals on your ASIO cards are synchronized correctly. 
This is essential when cabling any kind of digital audio 
system, not just VST System Link.

The clock mode or sync mode is set up in the ASIO con-
trol panel of the audio hardware. Proceed as follows:

1. From the Devices menu, open the Device Setup dialog.

2. On the VST Audio System page, select your audio in-
terface from the ASIO Driver pop-up menu.
In the Devices list, the name of the audio interface now appears as a sub-
entry to the “VST Audio System” entry.

3. In the Devices list, select your audio interface.

4. Click the Control Panel button.
The ASIO control panel appears.

5. Open the ASIO control panel on the other computer 
as well.
If you are using another VST System Link host application on that com-
puter, check its documentation for details on how to open the ASIO con-
trol panel.

6. Now you need to make sure that one audio card is set 
to be the clock master and all other cards are set to be 
clock slaves (i. e. they listen for the clock signal coming 
from the clock master).
The naming and procedure for this differs depending on the audio hard-
ware – consult its documentation if required. If you are using Steinberg 
Nuendo ASIO hardware, all cards default to the AutoSync setting. In this 
case you must set one of the cards (and only one) to “Master” in the 
Clock Mode section of the control panel.

• Typically, the ASIO control panel for an audio card con-
tains some indication of whether or not the card receives a 
proper sync signal, including the sample rate of that signal.
This is a good indication that you have connected the cards and set up 
clock sync properly. Check your audio hardware’s documentation for de-
tails.

The only exception to this procedure is if you are using an 
external clock – from a digital mixing desk or a special 
word clock synchronizer, for example. In that case you 
must leave all your ASIO cards in clock slave or AutoSync 
mode and make sure that each of them is listening for the 
signal coming from the synchronizer. This signal is usually 
passed through your ADAT cables or word clock connec-
tors in a daisy chain fashion.

VST System Link and latency
The general definition of latency is the amount of time it 
takes any system to respond to whatever messages are 
sent to it. For example, if your system’s latency is high and 
you play VST instruments in realtime, you will get a notice-
able delay between when you press a key and when you 
hear the sound of the VST instrument. Nowadays, most 
ASIO-compatible audio cards are capable of operating 
with very low latencies. Also, all VST applications are de-
signed to compensate for latency during playback, making 
the playback timing tight.

However, the latency time of a VST System Link network 
is the total latency of all the ASIO cards in the system 
added together. Therefore it is extra important to minimize 
the latency times for each computer in the network.

! All digital audio cables by definition always carry a 
clock signal as well as audio signals, so you do not 
have to use a special word clock input and output for 
this (although you may find that you get a slightly 
more stable audio system if you do, especially when 
using multiple computers).

! It is very important that only one card is the clock 
master, otherwise the network cannot function cor-
rectly. Once you have set this up, all the other cards 
in the network will take their clock signal from this 
card automatically.
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The latency does not affect the synchronization – it is 
always perfectly in time. But it can affect the time it takes 
to send and receive MIDI and audio signals, or make the 
system seem sluggish.

To adjust the latency of a system, you adjust the size of the 
buffers in the ASIO control panel – the lower the buffer 
size, the lower the latency. It is best to keep to fairly low la-
tencies (buffer sizes) if your system can handle it – about 
12 ms or less is usually a good idea.

Setting up your software
Now it is time to set up your programs. The procedures 
below describe how to set things up in Nuendo. If you are 
using another program on the other computer, please re-
fer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the 
same sample rate. Select “Project Setup…” from the 
Project menu and make sure that the sample rate is the 
same in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications 
and route these to the digital inputs and outputs.
The number and configuration of the busses depend on your audio hard-
ware and on your needs. If you have a system with eight digital i/o chan-
nels (such as an ADAT connection), you could create several stereo or 
mono busses, a surround bus together with a stereo bus, or any combi-
nation you need. The important thing is that you should have the same 
configuration in both applications – if you have four stereo output busses 
on computer 1, you want four stereo input busses on computer 2, etc.

2. Set things up so that computer 1 plays back some 
audio.
For example, you could import an audio file and play it back in Cycle 
mode.

3. In the Inspector or Mixer, make sure that the channel 
containing the audio material is routed to one of the digital 
output busses.

4. On computer 2, open the Mixer and locate the corre-
sponding digital input bus.
The audio being played back should now “appear” in the program run-
ning on computer 2. You should see the input bus level meters moving.

5. Reverse this procedure so that computer 2 plays back 
and computer 1 “listens”.

Now you have verified that the digital connection works as 
it should.

From this point on in this chapter, we refer to the bus-
ses connected to the digital inputs and outputs as “VST 
System Link busses”.

Settings for the audio hardware

When you exchange VST System Link data between com-
puters, it is important that the digital information is not 
changed in any way between the programs. Therefore, 
you should open the control panel (or additional applica-
tion) for your audio hardware and make sure that the fol-
lowing conditions are met:

• If there are additional “format settings” for the digital 
ports that you use for VST System Link data, make sure 
that these are turned off.
For example, if you are using an S/PDIF connection for VST System Link, 
make sure that “Professional format”, Emphasis, and Dithering are turned 
off.

• If your audio hardware has a mixer application allowing 
you to adjust the levels of digital inputs and outputs, make 
sure that this mixer is disabled or that the levels for the 
VST System Link channels are set to ±0 dB.

• Similarly, make sure no other forms of DSP (pan, effects, 
etc.) are applied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hard-
ware, the Totalmix function allows for extremely complex 
signal routing and mixing in the audio hardware. This can 
in some situations lead to “signal loops” in which case the 
VST System Link will not work. If you want to make abso-
lutely sure this will not cause any problems, select the de-
fault or “plain” preset for the Totalmix function.

Activating VST System Link
Before you proceed, you need to make sure that VST Sys-
tem Link is set as the timecode source in the Project Syn-
chronization Setup dialog and that the desired Sync 
options are activated, see “Timecode Preferences” on 
page 503.

After setting up the inputs and outputs, you now need to 
define which input/output will carry the actual VST System 
Link information.
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The VST System Link networking signal is carried on only 
one bit of one channel. This means that if you have an 
ADAT-based system which normally carries eight channels 
of 24-bit audio, once you activate VST System Link you will 
have seven channels of 24-bit audio and one channel of 
23-bit audio (the least significant bit of this last channel will 
be used for networking). In practice this makes no discern-
ible difference to the audio quality, since you will still have 
around 138 dB headroom on this channel.

To set things up, open the VST System Link panel:

1. From the Devices menu, open the Device Setup dialog.

2. In the Devices list to the left, select the “VST System 
Link” entry.
The VST System Link settings are shown to the right of the Devices list.

3. Use the ASIO Input and ASIO Output pop-up menus 
to define which channel is the networking channel.

4. Activate the Active checkbox at the top left of the panel.

5. Repeat the steps above for every computer in the net-
work. 

As the computers are made active, you should see the 
Sending and Receiving indicators flashing on each active 
computer, and the name of each computer should appear 
in the list at the bottom of the pane. Each computer is as-
signed a random number – do not worry about this, it is 
just so the network knows internally which one is which.

• You can double-click on the name in bold (which is the 
name of the computer you are currently working on) and 
set it to whatever other name you wish.
This name will appear in the VST System Link window of every computer 
on the network.

If you do not see the name of each computer appear-
ing once you have made it active, you need to check your 
settings. Go through the procedure above again and 
make sure that all ASIO cards are listening to the digital 
clock signals correctly, and that each computer has the 
correct inputs and outputs assigned to the VST System 
Link network.

Putting the network online
After each computer’s name you will see whether it is on-
line or not. When a computer is online, it will receive trans-
port and timecode signals, and its sequencer application 
can be started and stopped by remote control. If it is off-
line, it can only be started from its own keyboard – it is ef-
fectively an independent machine, although it is still on the 
network.

Note that any computer can control any and all of the 
others – VST System Link is a peer-to-peer network and 
there is no absolute “master” computer.

To put all computers online, proceed as follows:

1. For all computers, activate the Online checkbox on the 
VST System Link page. 

2. Start playback on one computer to check that the sys-
tem is working – all computers should start almost instantly 
and play perfectly in time, with sample-accurate precision.

• The Offset Samples setting allows you to adjust whether 
one machine will play slightly ahead or behind the rest.
This is normally not needed, but occasionally with some hardware you 
may find that the lock is a few samples out. For now, leave it set to 0 – it 
will most likely be what you want.

• The Transfer Bits setting allows you to specify whether 
you want to transfer 24 or 16 bits. This allows you to use 
older audio cards which do not support transfer of 24 bits.

Receiving 
and 
Sending 
indicators
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VST System Link sends and understands all transport 
commands (such as play, stop, fast forward, rewind, etc.). 
This allows you to control the entire network from one 
computer without a problem – try it! If you jump to a loca-
tor point on one machine, all other machines will also in-
stantly jump to that locator point.

Scrubbing via VST System Link

You can scrub on one computer and have the video and 
audio on another computer scrub along. However, the 
playback on the linked systems may not be perfectly in 
sync while scrubbing and there are some further restric-
tions you should bear in mind when scrubbing via VST 
System Link:

• Use the jog/shuttle control on the Transport panel or a 
remote controller for scrubbing.
Scrubbing with the Scrub tool does not work over a VST System Link 
connection.

• Always use the system where you started scrubbing to 
control the scrubbing, e. g. change the scrub speed or 
stop scrubbing.
Changing the scrub speed on a remote system will only change the 
speed on the local system.

• You can start playback on all systems.
This stops scrubbing and enters playback on all systems in sync.

Using MIDI
As well as supplying transport and sync control, VST Sys-
tem Link also supplies up to 16 MIDI ports, with 16 chan-
nels each. To set this up, proceed as follows:

1. Use the MIDI Inputs and MIDI Outputs value fields to 
specify the number of MIDI ports you need.
The default value is 0 MIDI In and 0 MIDI Out ports.

2. In the Project window, create a MIDI track and open 
the Inspector (top section).

3. If you now pull down the Input or Output Routing pop-
up menu, you will find the specified System Link ports 
added to the list of MIDI inputs or outputs.

This allows you to route MIDI tracks to VST instruments 
running on another computer, as described in the applica-
tion examples (see “Using one computer for VST instru-
ments” on page 518).

The “Use Selected ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, 
there is a small possibility that you might run out of band-
width on your VST System Link network. This will manifest 
itself by notes “choking” or timing becoming erratic.

If this happens, you can devote more bandwidth to MIDI 
by activating the “Use Selected ASIO Ports for Data only” 
option on the VST System Link page of the Device Setup 
dialog. When this is activated, the VST System Link infor-
mation will be sent on the entire channel instead of just 
one bit, more than enough for all the MIDI you could ever 
hope to use. The downside is that you can no longer use 
this ASIO channel for audio transfer (do not connect it to a 
speaker!), thus leaving you with only 7 audio channels in 
our ADAT cable example. Depending on how you work, 
this might be a reasonable compromise.

! Make sure that all computers have their tempos set 
to the same value, otherwise your synchronization 
will be seriously skewed.
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Hearing the network audio
If you are using an external mixing desk, hearing your audio 
really is not an issue – just plug the outputs of each com-
puter into the desired channels on the external mixing 
desk, start playback on one of the computers, and you are 
good to go.

However, many people prefer to mix internally inside the 
computer and just use a desk for monitoring (or maybe not 
use any external mixer at all). In this case you will need to 
select one computer to be your “main mix computer” and 
send the audio from your other computers into this.

In the following example, we assume you are using two 
computers, with computer 1 as your main mix computer 
and computer 2 running two additional stereo audio 
tracks, an FX channel track with a reverb plug-in and a 
VST instrument plug-in with stereo outputs.

Proceed as follows:

1. Set things up so that you can listen to the audio play-
back from computer 1.
In other words, you need an unused set of outputs, e. g. an analog stereo 
output, connected to your monitoring equipment.

2. On computer 2, route each of the two audio tracks to 
a separate output bus.
These should be busses connected to the digital outputs – let’s call 
them Bus 1 and 2.

3. Route the FX channel track to another VST System 
Link bus (Bus 3).

4. Route the VST instrument channel to yet another bus 
(Bus 4).

5. Go back to computer 1 and check the corresponding 
four VST System Link input busses.
If you start playback on computer 2, the audio should “appear” on the in-
put busses on computer 1. However, to mix these audio sources you 
need actual Mixer channels.

6. Add four new stereo audio tracks on computer 1 and 
route these to the output bus you use for listening, e. g. to 
the analog stereo outputs.

7. For each of the audio tracks, select one of the four in-
put busses.
Now, each computer 2 bus is routed to a separate audio channel on 
computer 1.

8. Activate monitoring for the four tracks.

If you now start playback, the audio from computer 2 will 
be sent “live” to the new tracks on computer 1, allowing 
you to hear them together with any tracks you play back 
on computer 1.

For more information about Monitoring, see “About moni-
toring” on page 32.

Adding more tracks

What if you have more audio tracks than you have VST 
System Link busses (physical outputs)? Then you just use 
the computer 2 mixer as a submixer: Route several audio 
channels to the same output bus and adjust the output 
bus level if needed.

If your audio cards have multiple sets of input and out-
put connections, you can link up multiple ADAT cables 
and send audio via any of the busses on any of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the latency 
issue we mentioned earlier. The VST engine always com-
pensates for record latencies, but if you are monitoring 
through computer 1 you will hear a processing delay while 
you listen to signals coming from your other computers 
(not on your recording!). If your audio card in computer 1 
supports ASIO Direct Monitoring you should definitely turn 
this on. You can find the setting on the VST Audio System 
device panel for your hardware (see “ASIO Direct Monitor-
ing” on page 98). Most modern ASIO cards support this 
function. If yours does not, you may want to change the 
Offset Samples value on the VST System Link page to 
compensate for any latency issues.

Setting up a larger network
Setting up a larger network is not much more difficult than 
a two-computer network. The main thing to remember is 
that VST System Link is a daisy chain system. In other 
words, the output of computer 1 goes to the input of com-
puter 2, the output of computer 2 goes to the input of 
computer 3, and so on around the chain. The output of the 
last computer in the chain must always go back into the 
input of computer 1, to complete the ring.
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Once you have done this, the transmission of all the trans-
port, sync, and MIDI information to the whole network is 
handled pretty much automatically. However, where you 
may run into confusion in a large network is in the trans-
mission of audio signals back to a central mix computer.

If you have lots of hardware inputs and outputs on your 
ASIO cards, you do not have to send audio via the chain at 
all, but can transmit it directly to the master mix computer 
via one or more of its other hardware inputs. For example, if 
you have a Nuendo Digiset interface or 9652 card on com-
puter 1, you could use ADAT cable 1 for networking, ADAT 
cable 2 as a direct audio input from computer 2, and ADAT 
cable 3 as a direct audio input from computer 3.

You can also transmit audio via the ring system if you do 
not have enough hardware I/Os for direct audio transmis-
sion. For example, in a four-computer scenario you could 
send audio from computer 2 into a channel in the Mixer in 
computer 3, from there to a channel in the Mixer in com-
puter 4, and from there back to the master Mixer in com-
puter 1. This can certainly be tricky to set up, so for 
complex networks it is generally recommended to use 
ASIO cards with at least three separate digital I/Os. 

Application examples

Using one computer for VST instruments

In this example, one computer will be used as main record 
and playback machine, and another computer as a virtual 
synth rack. Proceed as follows:

1. Record a MIDI track into computer 1.

2. Once you have finished recording, route the MIDI out-
put of that track to VST System Link MIDI port 1.

3. On computer 2, open up the VST Instrument rack and 
assign an instrument to the first slot in the rack.

4. Route the VST instrument channel to the desired out-
put bus.
If you are using computer 1 as your main mixing computer, this would be 
one of the VST System Link output busses, connected to computer 1.

5. Create a new MIDI track in the Project window of 
computer 2 and assign the MIDI output of the track to the 
VST instrument you created. 

6. Assign the MIDI input of the track to be VST System 
Link port 1.
Now, the MIDI track on computer 1 is routed to the MIDI track on com-
puter 2, which in turn is routed to the VST instrument.

7. Now activate monitoring for the MIDI track on com-
puter 2, so that it will listen and respond to any MIDI com-
mands coming in.
In Nuendo, click the Monitor button in the track list or Inspector.

8. Start playback on computer 1.
It will now send the MIDI information on the track to the VST instrument 
loaded on computer 2.

Even with a slow computer you should be able to stack a 
whole bunch of extra VST instruments this way, expanding 
your sound palette considerably. Do not forget that VST 
System Link MIDI is also sample-accurate, and thus has 
much tighter timing than any hardware MIDI interface ever 
invented!

Creating a virtual effect rack

The effect sends for an audio channel in Nuendo can ei-
ther be routed to an FX channel track or to any activated 
group or output bus. This allows you to use a separate 
computer as a “virtual effect rack”, by setting the system 
up as follows:

1. On computer 2 (the machine you will use as effect 
rack), add a new stereo audio track.
You cannot use an FX channel track in this case, since the track must 
have an audio input.

2. Add the desired effect as an insert effect for the track.
Let’s say you add a high-quality reverb plug-in.

3. In the Inspector, select one of the VST System Link 
busses as input for the audio track.
You want to use a separate VST System Link bus, which will only be 
used for this purpose.

4. Route the channel to the desired output bus.
If you are using computer 1 as your main mixing computer, this would be 
one of the VST System Link output busses, connected to computer 1.

5. Activate monitoring for the track.

6. Go back to computer 1 and select a track to which 
you want to add some reverb.

7. Bring up the effect sends for the track in the Inspector 
or the Mixer.
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8. Open the Send Routing pop-up menu for one of the 
sends and select the VST System Link bus assigned to 
the reverb in step 3.

9. Use the Send slider to adjust the amount of effect as 
usual.

The signal will be sent to the track on computer 2 and pro-
cessed through its insert effect, without using any proces-
sor power on computer 1.

You can repeat the steps above to add more effects to the 
“virtual effect rack”. The number of effects available this way 
is only limited by the number of ports used in the VST Sys-
tem Link connection (and of course by the performance of 
computer 2, but given that it will not have to handle any re-
cording or playback, you should be able to use quite a lot of 
effects).

Getting extra audio tracks

All computers on a VST System Link network are locked 
with sample-accuracy. Therefore, if you find that the hard 
drive on one computer is not fast enough to run as many 
audio tracks as you need, you can record new tracks on 
one of the other computers instead. This would create a 
“virtual RAID system”, with several disks all operating to-
gether. All tracks will remain locked together just as tightly 
as if they were all running on the same machine. This 
means that you effectively have an unlimited track count! 
Need another 100 tracks? Just add another computer.

Dedicated Video Playback

Playback of high-resolution video can be taxing on a sys-
tem’s CPU. By dedicating one computer for video play-
back via System Link, you can free up resources on your 
main CPU for audio and MIDI processing. Since all trans-
port commands will respond on the VST System Link 
computers, scrubbing video is possible even when it is 
coming from another computer. Spotting sound effects to 
picture in Edit Mode will work the same way as it does on 
one computer. This is a viable and economic alternative to 
dedicated hard disk video systems like the Doremi V1.
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Introduction
Nuendo is a full-featured postproduction media tool that is 
capable of dealing with video content in several ways. You 
can work with video and create complete soundtracks from 
within Nuendo. The soundtrack can then be inserted into a 
video file, recorded onto video tape or exported as an audio 
file that can be married to the video or film later. This chap-
ter covers the video operations related to the video itself, 
like importing video files, playing back video, and applying 
speed changes to compensate for film transfers. How to 
create a soundtrack for a video file is described in the 
chapter “Audio editing to picture” on page 535.

Before you start
When working on a project involving a video file, you first 
need to set up your system according to your equipment 
and your demands. The following sections provide some 
general information about video file formats, frame rates, 
and video output devices. 

Video file compatibility
Because there are many types of video files, it can be dif-
ficult to determine if one will work on your system. There 
are two ways to figure out if Nuendo can play back a cer-
tain video file:

• Open the video file with QuickTime 7.1 or higher, be-
cause Nuendo uses QuickTime for playing back video 
files.

• Check the file information of a video file in the Pool. If 
the information reads “Invalid or not supported file!”, the 
video file is either corrupt or the format is not supported by 
the available codecs.

Video container formats

Video and other multi-media files come in a container for-
mat. This container holds various streams of information 
including video and audio, but also metadata such as syn-
chronization information required to play back audio and 
video together. Data regarding creation dates, authors, 
chapter markings, and more can also be held within the 
container format. The following container formats are sup-
ported by Nuendo:

Nuendo supports all these container formats, but prob-
lems may arise when the computer does not have the cor-
rect software to decode compressed video and audio 
streams within the container file. You must also know the 
type of codec that was used to create the video file.

Codecs

Codecs are methods of data compression used to make 
video (and audio) files smaller and more manageable for 
computers. In order to play back a video file, your com-
puter must have the correct codec installed in the operat-
ing system to decode the video stream.

! If you are not able to load a certain video file, you 
must use an external application to convert the file 
into a compatible format or install the required co-
dec. For more information on codecs, see the sec-
tion “Codecs” on page 521.

Format Description

MOV This is a QuickTime movie.

QT This is also a QuickTime movie, but it is only used in Windows.

MPEG-1 This is the first standard of the Moving Picture Experts Group 
for video and audio compression, used for making video CDs. 
Files of this container format can have the extensions “.mpg” 
or “.mpeg”.

MPEG-2 This container format is used for DVD authoring. It can also 
contain AC3 multi-channel audio and has the file extension 
“.m2v”.

VOB This format is used for DVD video and is based on MPEG-2, 
but has additional limitations and specifications.

MPEG-4 This format is based on the QuickTime movie standard, can 
contain various metadata for streaming, editing, local play-
back, and interchange of content. Its file extension is “.mp4”.

AVI This format is a multimedia container format introduced by 
Microsoft.

DV This is a video format used by camcorders.

! The names of codecs and container formats can be 
confusing. Because many container formats have the 
same names as the codecs they use within the file, 
make sure to differentiate the container format or file 
type (e. g. .mov or .dv) from the codec used within it.
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If you are not able to load a certain video file, the required 
codec is probably not installed on your computer. In this 
case, you can search the Internet (e. g. the Microsoft or 
Apple web sites) for video codecs.

Frame rates
Nuendo is capable of working with different types of video 
and film frame rates. For an overview about the supported 
frame rates, refer to the section “Frame rate (speed)” on 
page 498.

Video output devices
Nuendo supports several ways to play back video files. 
Viewing video files onscreen in the Video Player window 
may work just fine for many applications, but often it is 
necessary to display video in a large format for viewing 
small details and so others involved in the session can 
also see the video. Nuendo provides the ability to use sev-
eral types of video output devices to accomplish this.

Multi-head video cards

One of the most common methods is the use of a multi-
head video card installed in the computer. Multi-head 
video cards allow you to connect more than one computer 
monitor to the card, in some cases up to four. If you direct 
the video output of Nuendo to one of these outputs, the 
video file is displayed in fullscreen mode on a computer 
monitor or HD television screen. 

You can also use more than one video card to achieve 
the same result. The use of two dual display cards in one 
system (a total of four monitors) is a very common setup 
for film postproduction systems. One output is dedicated 
to video and the other three can be used for Nuendo and 
other applications.

Different video cards support different types of outputs in-
cluding standard VGA, DVI, S-Video, HDMI, and compo-
nent video. These options allow you to choose the type of 
monitor you use for video. HD televisions and digital pro-
jectors provide the largest viewing screens, but a normal 
computer monitor can function as a very high-quality video 
monitor as well.

Dedicated video cards

The use of a dedicated video card is also supported in 
Nuendo. These cards are normally used in video editing 
systems to capture video to disk and display it while edit-
ing. They usually have a high resolution and take some 
strain off the host CPU by providing video compression 
and decompression processing on the card. 

The Decklink cards by Blackmagic Design are auto-
matically recognized by Nuendo. Video will be sent di-
rectly to its output.

FireWire DV Output

You have the option to use FireWire ports on the computer 
to output DV video streams to external converters such as 
various camcorders and standalone FireWire to DV con-
version units. These units can be connected to a television 
or projector for large format viewing. The FireWire protocol 
is capable of transporting data at high speed and is the 
most common standard for communicating with video-
related peripheral equipment.

! Under Windows, it is important that you connect 
your device to the FireWire port before launching 
Nuendo. Otherwise it may not be detected properly 
by Nuendo.
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Preparing a video project in Nuendo
The following sections describe the basic operations nec-
essary for preparing a Nuendo project involving video. It is 
advisable to store your video files on a separate hard drive 
from your audio files. This can help prevent data streaming 
problems when using high-resolution video with many au-
dio tracks. 

Importing video files
Importing a video file into your project is very straight for-
ward once you know that you have a compatible video file. 

Video files are imported in the same manner as audio files:

• By using the File menu (Import–Video File).
In the Import Video dialog, you can activate the “Extract Audio From 
Video” option. This imports any embedded audio streams to a newly cre-
ated audio track positioned below the video track. The new track and the 
clip will get the name of the video file. The new audio event will start at 
the same time as the video event, so that they are in sync with each other. 
If there is no audio stream within the container file, you will get the error 
message “No compatible audio stream found in file”. Click OK and the 
video stream will continue to be imported.

If you try to import a non-supported video file with the 
Import Video option, the Import Video dialog displays the 
text “Invalid or not supported file!”.

• By importing to the Pool first and then dragging to the 
Project window (see “The Pool” on page 320 for details).

• By using drag and drop from the Windows Explorer, the 
Mac OS Finder, the Pool, or the MediaBay.

When importing video files via the Pool or by using 
drag and drop, Nuendo can automatically extract the au-
dio from a video file. Whether this happens, depends on 
the “Extract Audio on Import Video File” setting in the 
Preferences dialog (Video page). For further information 
about extracting audio from a video file, see “Extracting 
audio from a video file” on page 528.

When importing video, Nuendo automatically creates 
a thumbnail cache file. The generated file is stored in the 
same folder as the video file and gets the name of the file 
with the suffix “.vcache”.

Adopting the video frame rate
When using video files within Nuendo, it is important to 
adjust the project’s frame rate to that of the imported 
video. This ensures that the time displays of Nuendo cor-
respond to the actual frames in the video. If the frame rate 
of an imported video file differs from the frame rate set for 
the project, the video event shows a warning.

In order to match the two frame rates, you have to adjust 
the frame rate in the Project Setup dialog. 

To adopt the video frame rate, proceed as follows:

1. Pull down the Project menu and select “Project 
Setup…”.

2. In the Project Setup dialog, click the “Get From Video” 
button.
Provided that the video file has a frame rate supported by Nuendo, it is 
automatically detected and applied to the project. If the project contains 
several video files with different frame rates, the project frame rate is ad-
justed to the frame rate of the first video event on the upper video track.

The project frame rate setting will change to that of the 
video file and the project start time will be altered to reflect 
the change in frame rate if needed. For example, when the 
project frame rate is switched from 30 fps to 29.97 fps, the 
start time is changed so that all the events currently in the 
project remain at the same positions in relation to realtime. 
If you want the project start time to remain the same, you 

! In Nuendo, you may work with multiple video files of 
differing frame rates and formats on the same video 
track. There can be two video tracks per project. As-
suming you have the proper codecs installed, all 
video files can be played back in one project, but 
note that proper synchronization of audio and video 
events is ensured only if the frame rate of the video 
file matches the project frame rate (see below).
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must manually change it back after clicking the “Get From 
Video” button. In this case, it is important that the video 
event is snapped to the timeline to ensure proper position-
ing and synchronization within the project.

Nuendo can only detect the supported frame rates 
(these are the frame rates listed in the Frame Rate pop-up 
menu in the Project Setup dialog). Video files with non-sup-
ported frame rates can be played back, but the time dis-
plays are not correct in this case and proper positioning is 
not guaranteed. Furthermore, audio and video may not be in 
sync. Therefore, we recommend that you use an external 
application to convert the video file to a frame rate sup-
ported by Nuendo.

If you have more than one video file in a project, it is advis-
able that all video files have the same frame rate consis-
tent with the project frame rate. Nevertheless, you can 
work with multiple video files of differing frame rates, but in 
this case you should always change the project frame rate 
to the frame rate of the video file that you are editing at the 
moment. This is done in the Project Setup dialog by se-
lecting the correct frame rate from the Frame Rate pop-up 
menu.

Video files in the Project window
Video files are displayed as events/clips on a video track, 
with thumbnails representing the frames in the film. There 
can be two video tracks per project. 

In the track list and Inspector, you find the following but-
tons:

Some of these buttons may not be visible in the track 
list. With the Track Controls Settings dialog you deter-
mine which buttons are displayed in the track list, see the 
section “Customizing track controls” on page 573.

About thumbnails
The individual thumbnail images are positioned exactly at 
the beginning of the corresponding frame. When you 
zoom in and there is enough space between the frames, 
the thumbnail is repeated as many times as there is free 
space available. Thus, you can always see a thumbnail re-
gardless of how much you zoom in.

Thumbnail Memory Cache Size

In the Preferences dialog on the Video page, you can en-
ter a value for the “Thumbnail Memory Cache Size”. This 
determines how much memory is available for displaying 
“real” thumbnails. The currently shown image is buffered 
in the thumbnail memory cache. Whenever you move to 
another image and there is no memory capacity left, the 
“oldest” picture in the cache is replaced by the current 
one. If you have long video clips and/or work with a large 
zoom factor, you may have to raise the “Thumbnail Mem-
ory Cache Size” value.

About thumbnail cache files

When importing video, Nuendo automatically creates a 
thumbnail cache file. The cache file is used in situations 
where the processor load is very high and the correct re-
drawing or realtime calculation of thumbnails might use 
system resources necessary for editing or processing. 
When you zoom in on the thumbnails, you see that they 
are in a lower resolution, i. e. the pictures are not as clear 

Show frame 
numbers

Mute 
video

Show 
thumbnails

Lock

Button Description

Mute Video When this is activated, video playback is disabled, but 
playback of any other events in the project continues. 
This increases the performance of Nuendo when realizing 
operations that do not require watching the video.

Show Frame 
Numbers

When this is activated, each thumbnail is shown with the 
corresponding video frame number.

Show 
Thumbnails

With this button you can activate/deactivate the thumb-
nails of a video track.

Lock When this is activated, the video event will be locked, see 
the section “Locking events” on page 74.
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as when they are calculated. When the processes that 
rely heavily on the computer CPU are finished, the frames 
are automatically recalculated, i. e. the program automati-
cally switches between realtime calculation of the pictures 
and using the cache file.

There are situations where no thumbnail cache file 
can be generated, e. g. if you import a video file from a 
folder that is write-protected. If you have access to the 
host folder at a later stage, you can generate a thumbnail 
cache file manually.

Manually generating thumbnail cache files

If no thumbnail cache file could be generated during im-
port or if you have to “refresh” a thumbnail cache file of a 
certain video file, because the file has been edited with an 
external video editing application, you have the possibility 
to generate the thumbnail cache file manually.

To create a thumbnail cache file manually, you have the 
following possibilities:

• In the Pool, right-click on the video file that you want to 
create a thumbnail cache file for and select the “Generate 
Thumbnail Cache” option from the context menu.
A thumbnail cache file is created, or, in case there already existed a 
thumbnail cache file for the video file, it is “refreshed”.

• In the Project window, open the context menu for the 
video event, and select “Generate Thumbnail Cache” from 
the Media submenu.

• Pull down the Media Menu and select “Generate Thumb-
nail Cache”.

“Refreshing” an already existing thumbnail cache file 
can be done only from within the Pool.

The thumbnail cache file is generated in the back-
ground so that you can continue working with Nuendo.

Playing back video

To check if your video equipment is capable of playing 
back a video from within Nuendo, open the Video Player 
page in the Device Setup dialog. If your system does not 
meet the minimum video requirements, a corresponding 
message will be displayed. For further information on the 
Device Setup dialog, see below.

Video is played back together with all other audio and 
MIDI material, using the Transport controls. If you work 
with two video tracks in your project, the file on the lower 
track is played back. To watch a video file that is posi-
tioned on the upper video track, change the order of the 
tracks or mute the lower video track.

Video settings in the Device Setup dialog
In the Device Setup dialog you determine which device is 
used for playing back video files. You can switch between 
different output devices during playback.

The Video Player page in the Device Setup dialog

! For playing back video files, you must have QuickTime 
7.1 or higher installed on your computer. There is a 
freeware version and a “pro” version, which offers ad-
ditional video conversion options. The player engine is 
the same in both versions, so for mere playback in Nu-
endo there is no need to purchase the “pro” version. 

! You need a video card that supports OpenGL (ver-
sion 2.0 recommended) for proper video playback. A 
card with OpenGL 1.2 can also be used, but might 
put restrictions on the video functionality. 
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To set up a video output device, proceed as follows:

1. Pull down the Devices Menu and select “Device 
Setup…” to open the Device Setup dialog, and select the 
Video Player page.

2. In the Active column, activate the checkbox for the de-
vice that you want to use for playing back video. 
All devices in your system that are capable of playing back video are 
listed. The Onscreen Window device serves for playing back the video 
file on your computer monitor. For further information on output devices, 
see the section “Video output devices” on page 522.

3. From the pop-up menu in the Format column, select 
an output format.
For the Onscreen Window output, only a “fixed” format is available. For 
the other output devices, you can select different output formats for play-
back depending on the device.

4. Adjust the Offset setting to compensate for process-
ing delays.
Due to delays while processing video, the video image may not match 
with the audio in Nuendo. By using the Offset parameter, you can com-
pensate for this effect. The Offset value indicates how many milliseconds 
the video will be delivered earlier in order to compensate for the process-
ing time of the video material. Each hardware setup can have different 
processing delays, so you must try out different values to determine 
which value is appropriate. 

The Offset value can be set individually for each out-
put device. It is saved globally for each output device and 
is independent of the project.

The offset is only used during playback. It is defeated 
in stop and scrub mode so that you always see the correct 
video frame.

• If the quality of the video image is not a critical factor or 
if you are experiencing performance problems, try lower-
ing the value on the Video Quality pop-up menu.
Although higher quality settings make the video display sharper and 
smoother, they also lead to an increased processor load.

Playing back video on the computer screen
The Video Player window is used for playing back video 
on your computer screen.

• To open the Video Player window, pull down the De-
vices menu and select Video Player.

Setting the window size and video quality

To resize the Video Player window and/or change the play-
back quality of the video, select the appropriate option on 
the context menu of the Video Player window.

The following options are available:

Option Description

Fullscreen 
Mode

The window is enlarged to occupy the whole (computer) 
screen. If you are working with more than one monitor, you 
can move the Video Player window to an extra monitor. 
Thus, you can work with Nuendo on one monitor and let 
the video play back on another monitor. You can exit 
fullscreen mode via the window’s context menu or by 
pressing [Esc] on your computer keyboard.

Quarter Size The window size is reduced to a quarter of the actual size.

Half Size The window size is reduced to half the actual size.

Actual Size The window size corresponds to the size of the video.
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• Drag the borders, just like when resizing other windows.

The higher the resolution, the more processing power 
is needed for playback. If you need to reduce the proces-
sor load, you can reduce the size of the Video Player win-
dow, or lower the value on the Video Quality submenu.

Setting the aspect ratio

Resizing the Video Player window by dragging its borders 
may lead to a distorted image. To prevent this, you can set 
an aspect ratio for video playback.

• From the Aspect Ratio submenu of the Video Player 
context menu, select one of the following options:

When the video is played back in fullscreen mode, the 
aspect ratio of the video is always kept.

Scrubbing video

You can scrub video events, i. e. play them back forwards 
or backwards at any speed. This is done by clicking in the 
Video Player window and moving the mouse to the left or 
to the right.

You can also use the Scrub controls on the Transport 
panel or a jog wheel on a remote controller for scrubbing 
video events, see the sections “The shuttle speed control” 
on page 87 and “Project scrubbing – the jog wheel” on 
page 87.

Editing video
Video clips are played back by events just as audio clips 
are. You can use all the basic editing operations on video 
events, just as with audio events. You can take a single 
event and copy it many times for the creation of mix varia-
tions. A video event may also be trimmed using the event 
handles to remove a countdown for instance. Furthermore, 
you can lock video events just like other events in the 
Project window, and you can edit video clips in the Pool 
(see the chapter “The Pool” on page 320). 

It is not possible to fade or crossfade video events. Fur-
thermore, you cannot use the Draw, Glue, and Mute tools 
with a video event.

Windows only: If you find that you are unable to edit a 
video file copied from a CD, this might be due to the fact 
that files copied from CD are write-protected by default. 
To remove the write-protection, in the Windows Explorer, 
open the Properties dialog and deactivate the “Read-
Only” option.

About the Edit Mode
When you are editing audio material to a video, it is impor-
tant to know how each audio edit relates to the exact frame 
of video where it occurs. Video playback follows the Nu-
endo transport, i. e. the video frame at the current project 
cursor position is shown in the Video Player window. How-
ever, if you perform event or range-based editing tasks you 
will get no visual feedback. The special Edit Mode solves 
this problem, allowing you to edit audio while getting con-
tinuous visual feedback on the video display. For further in-
formation on the Edit Mode, see the section “Edit Mode” on 
page 545.

Double Size The window is enlarged to twice the actual size.

Video Quality This submenu allows you to change the quality of the video 
image. Higher settings make the video display sharper and 
smoother, but lead to an increased processor load.

Option Description

None The aspect ratio of the video is not kept when resizing the 
window. The image is enlarged/reduced to occupy the 
whole Video Player window.

Internal The Video Player window can be resized at will, but the as-
pect ratio of the video is kept and black borders are dis-
played around the video image to fill the window.

External The resizing of the Video Player window is limited accord-
ing to the aspect ratio of the video image, i. e. the video im-
age always fills the full window and its aspect ratio is kept.

Option Description
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Extracting audio from a video file
If a video file contains audio, the audio stream can be ex-
tracted. As always when importing audio material, a dialog 
is displayed allowing you to select different import options 
(see the section “Audio file import options” on page 64). 
The extracted audio stream is added to the project on a 
new audio track and can be edited like all other audio mate-
rial, see the chapter “Audio editing to picture” on page 535.

There are several ways to extract audio from a video file:

• By activating the “Extract Audio From Video” option in 
the Import Video dialog (see the section “Importing video 
files” on page 523).

• By using the “Audio from Video File” option on the Im-
port submenu of the File menu.
This will insert an audio event starting at the project cursor position on 
the selected audio track. If no audio track is selected, a new one will be 
created.

• By activating the “Extract Audio on Import Video File” 
option in the Preferences dialog (Video page).
This will automatically extract the audio stream from any video file during 
import.

• By using the “Extract Audio from Video File” option on 
the Media menu.
This creates an audio clip in the Pool, but does not add any events to the 
Project window. 

Replacing the audio in a video file
Once you have edited all audio and MIDI data to the video 
and created a final mix (see the chapter “Audio editing to 
picture” on page 535), you will need to put the new audio 
back with the video. You can do this by embedding the 
audio in another stream within the video container file.

To replace the audio stream in a video file, proceed as fol-
lows:

1. Place the left locator at the start of the video file in Nu-
endo. This will ensure that your audio and video streams 
are synchronized.

2. Pull down the File menu and select the Audio Mixdown 
option from the Export submenu to export the audio file 
you wish to insert into the video container file (for detailed 
information on this function, see the chapter “Export Audio 
Mixdown” on page 473).

3. From the File menu, select “Replace Audio in Video 
File…”.
A file dialog opens prompting you to locate the video file.

4. Select the video file and click Open.
Next, you are prompted to locate the corresponding audio file. This 
should be the one you created above.

5. Select the audio file and click Open.
The audio is added to the video file, replacing its current audio stream.

Once the process is completed, open the video file in a 
native media player and check for proper synchronization.

! These functions are not available for MPEG-1 and 
MPEG-2 video files.
528
Video



About film transfers
When working on film projects, video postproduction edi-
tors typically transfer the film footage to video for use with 
computer video editing systems. Once the film has been 
edited, it can be transferred back to film for presentation in 
theaters or may remain in video format for television broad-
cast and release on videotape or DVD.

Pull-up and pull-down
When film footage is transferred to video, the frame rate 
must be converted from 24 fps to either 25 fps (PAL/SE-
CAM) or 29.97 fps (NTSC). This process introduces a 
slight speed change as a result of the mathematical rela-
tionships between the different frame rates.

When a specific speed change is applied to either audio 
or video, this is called a “pull-down” or “pull-up” depend-
ing on the direction of the change. The specific amount 
and direction depend on the type of transfer the film un-
derwent. For example, transfers to PAL/SECAM and 
NTSC each require a different speed change in order to 
keep the audio in sync. 

The film to NTSC conversion is done as a 2-3 pull-down 
and the film is running at 23.98 fps to maintain the exact 
2:3 relationship. As a result the film is running ~0.1 % 
slower in NTSC TV.

These speed changes must also be applied to the audio 
recorded along with the film, in order for the audio to re-
main in sync with the picture. Sometimes the speed 
change is applied at the same time as the film transfer and 
is recorded directly on the videotape. This allows the video 
editor to hear the audio along with the transferred video 
while editing.

However, speed changes also result in pitch changes. 
Furthermore, this may lead to artifacts in the audio, due to 
the fact that a direct digital transfer from the field recorder 
to videotape is not possible without performing either a 
sample rate conversion or an analog transfer.

Therefore, most audio engineers prefer to use the original 
source material when working with film audio. Once the 
original audio has been digitally transferred into Nuendo, 
the speed change must be compensated for in order to 
keep the audio in sync with the video. Nuendo has the 

flexibility to apply these speed changes independently to 
either the audio or video. Both methods are described in 
detail in the section “Compensating for speed changes in 
Nuendo” on page 531.

The telecine process
A telecine machine is the device used to transfer film to 
videotape. It transfers images from each frame of film to 
frames of video in a very specific way. Having a clear un-
derstanding of this process will help alleviate the confu-
sion surrounding pull-up and pull-down sample rates and 
keeping film audio in sync.

Film frames vs. video fields

One of the first things that needs to be understood is how 
video signals are formatted in general. Each frame or sin-
gle image of a video signal is composed of two video 
“fields”, each containing half of the image. The first field 
contains all the odd horizontal lines of resolution and the 
second field contains the even horizontal lines of the im-
age. This is called “interlacing” and is needed to minimize 
the flicker effect that would result if the image was pre-
sented all at once.

Because the film frame is a single, complete image (like a 
35 mm photograph), there are no fields involved. The tele-
cine machine must transfer part of the film image to one 
field and then the rest to another field of video. This may 
sound simple at first but as you will see, it can become 
quite complex.

Transferring film to PAL/SECAM video

Film transfers to PAL/SECAM video are relatively straight-
forward. Film runs at 24 fps and PAL video runs at 25 fps. 
If you speed up film by roughly 4 % (or 4.16 %, to be pre-
cise), it will be running at 25 fps. So, film transfers to PAL 
video result in a 4 % “pull-up” in speed. The audio must 
also be pulled up by 4 % in order to remain in sync with 
the video.
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When properly done, the first frame of film will be trans-
ferred to both fields of the first frame of video and so on. 
All that is needed is the 4 % increase in speed for this to 
be a one-to-one transfer. 

If the project is going to be returned to film for the final 
presentation, the audio can be slowed back down to nor-
mal speed when transferring back to film in order to pre-
serve the fidelity and performance values of the original 
material.

Transferring film to NTSC video

Transferring film at 24 fps to NTSC video at 29.97 fps pre-
sents a few more difficulties than the PAL transfer. Simply 
speeding up film to 29.97 fps would cause both the visual 
and audio elements to become too fast and high-pitched 
to be usable. There is no neat mathematical relationship 
between 24 fps and 29.97 fps. Another method was de-
vised called the 2-3 pull-down.

What is 2-3 pull-down?

The 2-3 pull-down is a combination of speed change and 
frame-to-field-counting that results in a smooth transfer to 
NTSC video without any unwanted or noticeable pitch 
changes in the audio. Here are the steps involved during 
the process:

1. The film speed is slowed or “pulled” down to 23.976 fps 
(-0.1 %).
At this speed there is a mathematical relationship between 23.976 and 
29.97.

2. The first frame of film is transferred to the first two 
fields of video.

3. The second frame of film is transferred to three fields 
of video, the two fields of the second video frame and just 
the first field of the third video frame.
This is where the “2-3” part of the name comes from. Each alternating 
frame of film is transferred to two fields of video, then three fields of 
video, and so on. 

4. The third film frame is transferred to the second field of 
video frame three and the first field of video frame four.

This is a block diagram of the 2-3 pull-down process. Notice that 4 
frames of film are transferred to 5 frames of video using the 2-3 field 
technique.

5. The remaining film frames are transferred in this man-
ner, alternating between 2 and 3 fields of video, until the 
end of the transfer.
After four frames of film have been transferred this way, an even five 
video frames will be created. Over the course of one second, 24 frames 
of film and 30 frames of video will have gone by. Because they are run-
ning at -0.1 %, the actual frame rate is 29.97 video frames per second, 
the NTSC standard.

It is important to have a clear understanding of 2-3 pull-
down in order to make accurate decisions regarding audio 
pull-down and video pull-up when working with NTSC film 
transfers in Nuendo. 

! The only downside to PAL transfers is that a 4 % in-
crease in the speed will result in a 4 % increase in the 
pitch as well! This could affect the perception of a 
character’s delivery of a line or the timbre of sound 
effects or musical tonalities. If the final project is to 
remain in the video format, pitch-correcting this 
anomaly might be necessary.
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Film speed is faster than NTSC video speed. When the 
audio is pulled down, it allows production audio (DAT 
tapes or files from a field recorder) from a film shoot to 
play back in sync with NTSC video. Even though 29.97 fps 
is a faster frame rate than 24 fps (film speed), the video is 
running -0.1 % slower than the original film due to the 2-3 
transfer process and hence the need to slow the audio 
down a bit.

Compensating for speed changes in 
Nuendo
In Nuendo, there are two basic ways to compensate for 
speed changes due to film transfers. The first is by adjust-
ing the playback speed of the audio to match the speed of 
the video. The second is to adjust the speed of the video 
file to match the original speed of the film and production 
audio in Nuendo.

Adjusting audio playback speed
When adjusting audio playback speed to match the video, 
there are two scenarios based on the two video formats 
that film is transferred to, NTSC and PAL/SECAM. Be-
cause the telecine process for each video format results in 
different speed changes, there are two types of playback 
adjustments possible. For NTSC, the speed change is 
down -0.1 %. For PAL/SECAM, the change is up 
+4.1667 %.

Audio pull-down -0.1 % (NTSC)

When working on a film project that has been transferred 
to NTSC video, most audio engineers prefer to use the 
original source tapes from the film shoot in order to retain 
the highest quality and fidelity. Audio that has been trans-
ferred to the videotape during the film transfer has suf-
fered a generation loss and speed change.

Because the video is running -0.1 % slower than the orig-
inal film, the audio must also be slowed down by the same 
amount as the film in order to remain in sync. 

In most cases, to slow down audio playback in Nuendo, 
an external sample clock source will be needed to “pull” 
the clock speed down by 0.1 %.

For this to work, your audio card must be set to external 
sync and connected to the clock device via word clock, 
VST System Link, or some other clocking method. Fur-
thermore, you have to “tell” Nuendo that it is being syn-
chronized with an external clock source. This is done in 
the Device Setup dialog, see “Selecting a driver and mak-
ing audio settings in Nuendo” on page 19.

Because video and audio playback speeds are indepen-
dent in Nuendo, the video will remain at the same speed 
while the audio is slowed down (pulled down). This ensures 
that the production audio and film transfer remain in sync.

Either you receive an OMF, AES 31, or OpenTL file that 
contains audio from the original source tapes conformed 
to the edited video or you have to record the source tapes 
into Nuendo yourself. In both cases, you have audio in Nu-
endo that is edited to the picture but will not stay in sync 
with the video unless you pull down the sample rate. 

! Many video editors working with NTSC video refer to 
30 fps as “film speed” as opposed to 24 fps. The rea-
son for this is, if you speed NTSC video (29.97 fps) 
up by 0.1 %, you are running at the same speed as 
the original film at 24 fps. Conversations regarding 
this can often get very confusing. Make sure that you 
have a clear understanding of the material you are 
working with when dealing with film transfers and 
frame rates. It will avoid many mistakes and save 
time in the long run.

! When Nuendo is running at a non-standard sample 
rate (47.952 kHz = 48 kHz pull-down), digital trans-
fers into Nuendo from external equipment must be 
made with the external equipment locked to the same 
sample clock as your audio card. Most devices are ca-
pable of a 0.1 % change in sample rate and will func-
tion normally. 

! Any audio mixdowns that are exported from Nuendo 
when the sample clock is pulled down, will play back 
in other applications and devices faster because that 
sample clock will be running at the standard 48 kHz.
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The idea is that when you have completed the audio mix 
for your film project, the video will be sped back up to film 
speed for the final transfer back to film and your audio mix 
can then be played at the standard 48 kHz sample rate (no 
pull-down) and will remain in sync with the picture.

Using this method preserves the quality of the original au-
dio recording made during filming and allows for a digital 
mixdown transfer at film speed without any generation 
loss or sample rate conversion.

Audio pull-up +4.1667 % (PAL/SECAM)

Audio pull-up (+4.1667 %) is the same concept applied 
to PAL/SECAM video transfers. Because the film is sped 
up by 4.1667 % during transfer, audio in Nuendo must be 
running at +4.1667 % speed in order to remain in sync 
with the video during editing and mixing. 

In this case, the external clock must be set to +4 % 
varispeed.

Once the project is complete, Nuendo’s sample rate can be 
returned to normal (48 kHz) for the final mixdown at film 
speed. Once again, this allows for a digital transfer of the fi-
nal master at the correct speed for theatrical presentation.

Non-standard audio pulls

It is also possible to use pulled sample rates that do not fit 
one of the above scenarios. These sample rates would 
only need to be used in exceptional circumstances when 
an error has occurred elsewhere in the process of making 
a film. These settings can be used to correct for sync er-
rors made at another studio or problems with video editing 
systems. Just about anything is possible. 

• -4 % pull-down
If a film project was transferred to PAL/SECAM video and the audio ed-
iting and mixing was performed at video speed (48 kHz) without using 
audio pull-up, the final mix would be running at video speed not film 
speed. In this case a -4 % pull-down can be used to correct this and get 
the audio running at film speed again. The downside to this is that the fi-
nal transfer to film would either have to be analog or through a sample 
rate converter in order to be recorded with the film.

• +0.1 % pull-up
This pull-up is not normally used except in situations similar to the one de-
scribed above but for NTSC video. It can be used to correct the speed of 
a project finished at video speed (without pull-down) prior to transferring it 
to film. Because film is moving 0.1 % faster than NTSC video, the audio mix 
can be sped up to film speed using +0.1 % pull-up for the transfer.

• Other pull-up/pull-down options
There may be other scenarios where non-standard pull-ups and pull-
downs can be used to correct mistakes. Nuendo provides further pull-
up/pull-down options for such situations in the Project Setup dialog and 
the respective section in the Project Synchronization Setup dialog (see 
below).

Adjustments in Nuendo when applying audio speed 
changes

When the audio clock of your audio card is being slowed 
down or sped up from an external clock source, Nuendo 
cannot know that it is running slower or faster than normal. 
The time displays (minutes:seconds, timecode) will be-
come inaccurate because they are based on a sample 
count, not the independent clock source.

Nuendo provides an adjustment of the timeline to compen-
sate for these changes. This setting is found in the Project 
Setup dialog as well as in the Project Synchronization 
Setup dialog in the “Project Setup - Time” section.

! Steinberg’s Nuendo SyncStation is capable of 
varispeed and has presets for the 4.1667 % neces-
sary with PAL film transfers and the -0.1 % for NTSC.

! All the examples used here are with 48 kHz as the 
standard sample rate for the film and video industry. 
However, it is possible to accomplish the same tasks 
using 44.1 kHz, 88.2 kHz, 96 kHz (this is double the 
standard sample rate and commonly used for higher 
fidelity), 176.4 kHz and 192 kHz, provided you have an 
external clock device capable of pulling these higher 
sample rates.
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It makes no difference whether you make your Audio 
Pull-up/Pull-down settings in the Project Setup dialog or 
the Project Synchronization Setup dialog. If you use the 
Project Synchronization Setup dialog, your adjustment is 
reflected in the Project Setup dialog, and vice versa.

Whenever you apply an audio pull to Nuendo from an ex-
ternal clock, also set “Audio Pull-up/Pull-down” to the 
corresponding setting. This allows Nuendo to recalculate 
the sample count to reflect the adjusted sample rate. 

For example, if the setting is switched from no pull-down to 
-0.1 % pull-down, events on the timeline will appear longer 
because the sample rate has been slowed down. The 
event display will show the accurate length of events rela-
tive to timecode, minutes, and seconds. 

In the Project window, the status line below the tool-
bar also indicates whether Audio pull-up or pull-down is 
applied to this project.

When you change the setting for Audio Pull-up/Pull-down 
and there are audio events in the timeline already, Nuendo 
prompts you to choose whether or not to keep the original 
sample start times.

• Select No to let the events follow the timecode and min-
utes:seconds clock change and remain at their SMPTE 
start times.

• Select Yes to force Nuendo to leave events at the same 
sample start time regardless of the clock speed change.

Video pull-up and pull-down
Nuendo also provides a method to adjust for film transfers 
by speeding up or slowing down playback of the video 
files in your project. Depending on the situation, it can be 
helpful to make the video file play back at film speed and 
not adjust the audio playback at all.

Adjusting the video playback speed back to film reverses 
the process used when adjusting audio playback speed. 
For NTSC video, the video playback speed must be ad-
justed up +0.1 % back to film speed.

Altering the video playback speed is done in the Project 
Synchronization Setup dialog (“Project Setup - Time” sec-
tion). You have two options: 0.1 % pull-up and 0.1 % pull-
down.

Video +0.1 % pull-up for NTSC

Because NTSC video is running -0.1 % slower than the 
original film, pulling the video speed back up by +0.1 %, 
returns it to original film speed. With the video now run-
ning at the correct film speed, audio originally recorded at 
48 kHz on the film shoot will remain in sync with the video. 
Additionally, the final mix can be digitally transferred back 
to film at 48 kHz without the need for an analog copy or 
sample rate conversion.

Video -0.1 % pull-down (non-standard)

Pulling the video speed down for an NTSC video is a non-
standard procedure and would not happen under normal 
circumstances. It is possible to pull down a video file that 
is running at 24 fps -0.1 % so it matches with material run-
ning at NTSC video speed. The resulting frame rate is 
23.976 fps.

Speeding up or slowing down the video speed is only 
possible if the video is running through a “computer video 
card”. If a professional genlocked video card is used, the 
video playback speed is derived from the genlock input.
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What is 23.976 fps used for?

The world of digital video formats is ever changing and the 
results are new developments for every media professional 
involved in movies, television, corporate video, and more. 
With the advent of HD cameras that are capable of record-
ing at several different frame rates internally, the options 
available to cinematographers have become staggering.

Because the look of film running at 24 fps is unique, many 
HD productions are filmed at 24 fps to mimic the look of 
film on video. Because the speed change from 24 fps to 
29.97 fps NTSC is such an odd one (requiring the 0.1 % 
pull-down), designers of these cameras have developed a 
method of recording that allows the camera to record like 
film but also output a NTSC video signal at the same time 
without any speed change. They record at 23.976  fps 
which translates to 24  fps pulled down -0.1 %.

Working with video tape recorders
Whenever you are interfacing Nuendo with external hard-
ware, some additional computer hardware may be neces-
sary. In the case of using video tape recorders (VTRs) with 
Nuendo, a device capable of dealing with SMPTE time-
code, word clock, video reference clock, MIDI machine 
control, and Sony 9-Pin machine control protocols will be 
needed.

The most important aspect of working with VTRs is the 
ability to maintain the best possible synchronization be-
tween Nuendo and the tape machine. Using a device such 
as Steinberg’s SyncStation will provide the best results.

Regardless of your hardware setup, Nuendo will have to be 
configured to synchronize with the VTR. For further informa-
tion on how to synchronize Nuendo with external equip-
ment, see the chapter “Synchronization” on page 496. 

Tips
There are so many variables within the boundaries of a 
multi-media project that only years of experience can cope 
with all of them. However, here are a few tips and good 
ideas you can use to help eliminate some common issues.

Preproduction planning

The most important tip for making postproduction go 
smoothly for a TV commercial, feature film or even Internet 
media creation is good use of preproduction planning. Try 
and meet with all the people involved in a project prior to 
starting in order to decide how the work will flow once you 
get into postproduction. Determining frame rates for film 
and video, film transfer issues, what format the location 
audio will be recorded in, delivery formats and other de-
tails including a working copy of the script will be invalu-
able to any postproduction audio professional.

TC Burn-In

The timecode burn-in window (BITC) is a section of the 
video image that contains timecode numbers for each 
frame of video from the original video editor. Using this, it 
is possible to align a video perfectly in Nuendo so that all 
the timecode numbers line up exactly. 

Timecode burn-in window in a video image
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Introduction
Nuendo has been designed from the ground up as a pro-
duction tool with features that are catered to working with 
video and film. The depth and versatility of Nuendo’s de-
sign allow you to work very precisely and yet retain the 
freedom and ease that allows greater creativity in creating 
music and sound design for film and video.

In this chapter, real world situations that you would en-
counter while working with video will be explained. These 
include the preparation of a video project, the addition of 
sound design elements, the conforming of audio material 
to picture changes, and the creation of tempo maps that 
are synchronized with video for use in scoring music to 
picture. Finally, the editing tools in Nuendo will be dis-
cussed as they relate to video postproduction techniques. 

Video timeline and the grid
When working with video, every audio event and part is 
synchronized to the picture. Unlike music editing with an 
even grid of bars and beats to work with, video uses a 
much smaller increment of time as a basic grid: video 
frames. Since there are a finite number of video frames in 
each video, the frame becomes the basic measuring block 
for editing.

Video frames are numbered using SMPTE timecode. De-
pending on the frame rate of the video, there will be a cer-
tain amount of frames per second and then 60 seconds 
per minute, and 60 minutes per hour. SMPTE is displayed 
using colons to separate each division of time.

SMPTE timecode in the Time Display: showing 1 hour, 3 minutes, 47 
seconds, 12 frames, and 25 subframes.

Film frames can be displayed as SMPTE numbers or in 
feet and frames (a traditional method used by film editors). 
Nuendo also offers a user-definable frame rate for special-
ized frame rates including Varicam HD video. For more in-
formation on all the frame rates and time displays 
available, see “Frame rate (speed)” on page 498.

Subframes and days
Nuendo can also display the time between frames by us-
ing the subframe division which divides each frame into 
80 subframes. Subframes appear separated from frames 
by a period. In order to see subframes displayed you must 
activate “Show Timecode Subframes” in the Preferences 
dialog (Transport page). If this is activated, subframes will 
be displayed wherever timecode is shown including the 
Transport panel, Project window, dialogs, Project 
Browser, Pool, and the SMPTE Generator plug-in.

In case a project crosses the 24 hour mark, Nuendo will 
automatically display a day number to the left of the 
SMPTE display separated by a space, no colon. It can be 
necessary to use days in timecode even when the project 
is shorter than 24 hours. For example, during live events 
that take place in the evening, if the central timecode gen-
erator for the event is running “time-of-day” SMPTE that 
correlates to the actual time on the clock, the time display 
may cross the 24 h mark at midnight. In that case, all time-
code values after midnight will have a “1” displayed in the 
days position.

Time-of-day SMPTE that has crossed midnight or the 24 hour mark 
shows the day number “1” to the left of the SMPTE value. Note that 
subframes are not displayed in this image.

Drop-frame SMPTE
Drop-frame timecode is used for the 29.97 fps frame rate 
used by the NTSC video standard and the 30 fps frame 
rate. Since this frame rate does not correlate exactly to the 
actual time passing on the clock, a system has been de-
vised that omits certain frame numbers in order to match 
the displayed time with the time of day. Nuendo distin-
guishes this frame count by separating the frame number 
with a semicolon instead of a colon. When you see time-

! In the Project Setup dialog, make sure that the frame 
rate of the project matches that of the video. It is 
possible for Nuendo to detect the video frame rate 
for you, see the chapter “Video” on page 520.
536
Audio editing to picture



code displayed anywhere in Nuendo with a semicolon, 
you are using drop-frame timecode. This is the only indi-
cation besides looking at the Project Setup dialog, that 
you are using drop-frame timecode.

Drop-frame SMPTE timecode display with frames separated by a 
semicolon.

When the Project window’s time display is set to time-
code, the grid options change. The choices are:

• Subframe (1/100th of a frame)
• 1/4 frame (25 subframes)
• 1/2 frame (50 subframes)
• 1 frame
• 2 frames
• 1 second

These grid options allow editing, nudging and moving of 
events, fades and automation data in increments that re-
late to the video frames you can see.

Conforming production audio
Conforming audio to picture describes the process of ed-
iting and placing audio files in sync with the video. Once 
you have imported your video file or synchronized Nuendo 
with a VTR or other external video playback system, the 
next step is to get production audio imported and running 
in sync with the video. Production audio refers to any 
sound that was originally recorded during the filming or 
video taping process. This includes sounds and music 
added by the video editor in order to get an idea of the fin-
ished product.

Audio coming from a video editing session can come in a 
variety of formats. How to match the audio timecode val-
ues of these different formats to those used by the video 
editing suite will be described in the following sections.

Reference audio
Reference audio can be any audio that has been assem-
bled and mixed in the video editing suite, usually as a 
guide for audio editors. It may be embedded in a video file, 
be a separate audio file or be recorded on tracks of a 
video tape recorder (VTR). 

If the audio file is available in the Pool or the MediaBay, 
proceed as follows to conform it to the video file:

• Open the Media menu and select the “At Timecode Po-
sition…” option from the “Insert into Project” submenu.
A window opens, where you need to enter the timecode value corre-
sponding to the beginning of the video file. The reference audio file then 
lines up with the video file.

• Provided that the video file was inserted at the original 
timecode position and that the audio file contains origin 
timecode information, you can also use the “At Origin” 
command from the “Insert Into Project” submenu.

If you have already imported your audio file onto a track, 
proceed as follows to conform it to the video file:

• Activate the Snap On/Off button, open the Snap Type 
pop-up menu, and select “Events”. When you now drag 
the audio event to the start of the video event, the two 
events are aligned automatically.

Once the reference audio file has been inserted into posi-
tion, check the sync of audio to video throughout the 
length of the project. If there are any issues, it is best to fix 
them before you go on editing. Problems with timecode 
frame rates, sample rates and synchronization to external 
tape machines can wreak havoc on a production if they 
are discovered late in the process.

Multi-channel media
Multi-channel media can contain multiple tracks of audio 
edited by the video editing suite. Multi-channel media in-
terchange formats help you get the audio from one work-
station to another. This is useful, when the audio edited by 
the video editor is complex and has elements that you 
want to use in the final project. Nuendo is capable of han-
dling OMF, AAF, OpenTL, and AES31 files for this type of 
exchange.
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The most commonly used format, the OMF file, comes in 
two basic formats: files with embedded audio and files 
that refer to external audio media. Both formats store infor-
mation about where to place each piece of audio in the 
timeline. Each format has its strengths and weaknesses 
and the choice of which one to use will depend on the cir-
cumstances, see “File handling” on page 552. 

After importing the OMF, align your video file to play in 
sync with the OMF audio. Here is where any reference au-
dio embedded in the video file will come in handy. By lis-
tening to both the OMF audio and reference audio tracks, 
you will easily be able to tell if everything is in sync.

Since the OMF audio was created during the video edit, 
its timecode values should be correct. Adjusting the posi-
tion of the video and reference audio to match the OMF 
audio would be the common method of aligning the two 
together. To ensure that the video event and reference au-
dio events remain in sync with one another during editing, 
group them or move them into a folder track and move the 
folder track events.

When aligning reference audio from a video file to im-
ported OMF audio, try panning the reference audio to one 
side and the OMF audio to the other. This makes it easier 
to discern whether one source is ahead of the other as 
they get closer to perfect sync. A comb filtering effect can 
be heard when two identical sources become very close 
in sync with one another. 

Once the OMF audio is imported and all video and audio 
events are synchronized together, you are ready to begin 
adding new elements and creating the complete sound-
track.

EDLs
EDLs (Edit Decision Lists) are lists of edits created by the 
video editing suite. These text files contain timecode and 
source tape information that can be used to align audio 
events to a reference video file in Nuendo. Each step de-
scribes a complete editing task including:

• The type of edit (audio, video or both).
• The source material (tape number, audio file name or video file 

name).
• The start and ending source timecode values. 
• The start and ending destination timecode values.

The source material must have correct timestamps in or-
der for the EDL timecode values to be valid. This can be 
achieved using timecode DAT machines, video tape ma-
chines, or field recorders, provided that the device is able 
to create audio files with embedded timestamps. The files 
can then be directly imported in Nuendo and placed in the 
project “at origin”. When using a video tape machine, Nu-
endo has to be synchronized to the machine in order to 
record audio into the project at the correct timecode posi-
tions, thereby giving the audio files the correct times-
tamps.

The information contained in the EDL can be used in Nu-
endo to place audio events in the Project window at the 
specific timecode positions that correspond to the edits 
made in the video editing suite. Depending on the length 
of the program material and the number of edits, this pro-
cess can be time-consuming but also allows for the most 
precise control over the source material and synchroniza-
tion.

Since original source tapes and recordings are used, the 
maximum quality of those recordings can be maintained. 

To conform an EDL edit, proceed as follows:

1. Create a folder track for the source material.
Having all your source material in one consolidated area will lessen con-
fusion later in the process.

2. Create an audio track for each source tape.
For DAT and video tape machines, having a separate track for each tape 
will prevent overlap of audio with the same timecode values and also 
keep things organized. 

3. Name each track the same name as the source tape it 
comes from. 
Each audio file you record on that track gets the name of the source tape 
it came from.

4. Make sure that Nuendo is synchronized to the tape 
machine.
This ensures that the audio file is placed at the correct timecode position 
in the Project window.

5. Record all the significant portions of each source tape 
into Nuendo.
If only a portion of a source tape is used in the EDL, record that section 
into Nuendo. 
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6. Import any audio files from a field recorder, open the 
Media menu and from the “Insert into Project” submenu 
select “At Origin”.
Create as many tracks as necessary to prevent overlaps. Once the file has 
been placed “at Origin”, it can be used as a source for EDL conforming.

An excerpt from a CMX EDL 

7. Use the Range Selection tool to create a selection on 
the proper source track based on the two source time-
code values.
This can be done via manual entry in the info line. In this example, enter 
00:21:29:19 for the range start and 00:21:35:21 for the range end.

8. Open the Edit menu and select Copy.
The source material is copied into the clipboard.

9. Use the Range Selection pop-up menu to switch 
range selections.
Using the two different range selections (A and B) will keep the source 
and destination times separate (see also “The Range Selection pop-up 
menu” on page 78). This is similar to a four-point editing model used by 
many video and audio editors, see “Four-point editing with the Range 
Selection tool” on page 540.

10. With the Range Selection tool, create a selection on a 
destination track using the two destination timecode values.
This can be done via manual entry in the info line. It is only necessary to de-
fine the destination in timecode since the paste function will automatically 
place an audio event of the correct size as determined by the source 
range.

The amount of destination tracks should be deter-
mined by the number used in the EDL. Some EDL formats 
only allow the use of 4 destination tracks. Your needs may 
vary according to the project itself. The main concern is 
getting the audio events in sync with the video. Once that 
is completed, placing audio events on various tracks is up 
to the user.

11. Open the Edit menu and select Paste.
This places the source material at the destination location. Check for 
sync with the video and reference audio.

12. Repeat as needed until the entire EDL is conformed.
Depending on the size of the EDL and number of edits, this process may 
take some time to be completed.

Once you have successfully imported video and reference 
audio and conformed any production audio to the video, 
you are ready to begin adding new sound elements and 
creating the final soundtrack.

Adding sound design elements
Sound design elements can come from a variety of sources 
including sound effect libraries on CD or hard drives, field 
recordings and even the production audio source tapes. In 
order to add these sounds to your project, they must be im-
ported into the Pool or recorded into Nuendo from a tape 
machine.

Create various folders within the Pool to help organize 
all the sound files used in your Project. With feature length 
films, the amount of audio can be staggering. Finding spe-
cific audio files can become daunting quickly unless you 
properly organize your project. Nuendo’s MediaBay is de-
signed to help you organize all your sound files so that 
they are instantly accessible to you and can be quickly 
searched.

Placing events to picture
Select one of the following methods to place your audio 
events to picture:

• Select the audio file in the Pool, open the context menu 
and select the “At Timecode Position” command from the 
“Insert into Project” sub-menu.
The audio event is inserted at the specified timecode position on the top-
most selected track in the Project window. The right timecode number 
could come from an EDL or a cue list created earlier or from a locator po-
sition or marker. 

• View the video using the shuttle and scrub tools, set the 
left locator at the position where you want to place the au-
dio event and set the cursor to the left locator. Select the 
audio file in the Pool, open the Media menu and from the 
“Insert into Project” submenu select the “At Cursor” op-
tion.

• Activate the Edit Mode on the Transport menu, drag the 
audio events out of the Pool and place them on a track.
Edit Mode will cause the video to follow the event as you move it in the 
Project window. Drag the event to the right video frame. You can use the 
Snap function to keep the audio event lined up with each timecode frame 
as you drag it into position.
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• Use four-point editing with the Range Selection tool.
This is described below.

Four-point editing with the Range Selection tool 

It is often necessary to go through a large sound file to 
find a specific sound effect. This is especially true for field 
recordings with multiple takes of each sound and dead air 
time in between. In this situation, it might be best to set up 
an area in the project consisting of several “work” tracks 
that can be used to sort out various sound files and pre-
pare them for use in the final soundtrack.

Using the Range Selection tool, a four-point editing model 
can be used to cut out ranges of the work tracks and paste 
them onto the proper tracks lined up with specific video 
frames. Proceed as follows:

1. Create a folder track and name it “Work Tracks”.
This folder track will host several audio tracks that can be used as a 
scratch pad for editing sound effects and preparing them for use in the 
project.

2. Create several tracks to work on.
You might need mono, stereo, and 5.1 audio tracks depending on the 
source material you are working with.

A folder track with four stereo work tracks can be used to edit various 
sound files before they are placed to picture.

3. Drag the various audio files onto these work tracks.
Many sound effects libraries contain several versions of a particular 
sound effect. These can be auditioned and chosen directly on the work 
tracks. We recommend to place them at a time in the project that is after 
the end of the program material. This prevents your work tracks from get-
ting inadvertently included in the final mix.

4. With the Range Selection tool, select the audio you 
want to use with the picture and press [Ctrl]/[Command]-
[C] to copy it to the clipboard.
You can place several sound effects lined up together and select them 
all with the Range Selection tool for editing.

Selecting the desired sound effect with the range selection tool using 
selection A.

5. Use the Range Selection pop-up menu to switch 
range selections.

Switching the range to selection B.

6. Define the destination range for selection B.
Using the key commands [E] (Left Selection Side to Cursor) and [D] 
(Right Selection Side to Cursor), you can define the range selection on 
the fly while watching the video.

7. Press [Ctrl]/[Command]-[V] to paste the clipboard 
data to the new location.
Note that you can set up a macro that combines the copy and paste pro-
cesses. This can considerably speed up your work.

One very handy feature in using selections A and B is the 
ability to retain the view of each selection. If your work area 
is far away from the edit insertion point in the video (A is far 
away from B), zooming in closely to either location will leave 
the other outside the Project window viewing area. Chang-
ing selections between A and B will also cause the viewing 
area of the Project window to switch between the two loca-
tions instantly. This is really the key to this technique, allow-
ing you to move quickly between source and destination 
audio while retaining two selections for editing.
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Adjusting events to picture
Once audio events have been placed to picture, their 
fades, durations and positions can be fine-tuned. 

Nuendo’s nudge features are designed just for this type of 
use. As the nudge buttons are not displayed on the tool-
bar by default, you have to right-click on the toolbar and 
select “Nudge Palette” from the context menu to access 
them.

Using the nudge buttons you can incrementally adjust the 
position (move) and size (trim) of your events. Depending 
on Arrow tool mode, the nudge buttons will trim the events 
by moving the boundaries (Normal Sizing) or moving the 
contents inside the event (Sizing moves contents). 

The size of the nudge increment is determined by the grid 
settings in the Project window. A typical nudge setting for 
picture editing would be 1 frame. However, even though 
the video’s resolution might be no more than one frame, 
half-frame or even quarter-frame amounts could be nec-
essary to accurately time events to picture. 

Edit Mode is extremely helpful for fine-tuning event place-
ment to picture. Since the video follows each edit you 
make with the mouse, you can instantly see where in the 
video your edit is taking place, whether that be the start 
position of an event, snap point or fade duration. This 
makes editing to picture fluid and more creative.

The Range Selection tool offers additional methods of ed-
iting including Cut Head, Cut Tail, Crop and Adjust Fades 
to Range. In Edit Mode, creating and adjusting the range 
will chase video so defining a range can be done visually 
to picture.

Conforming to picture changes
During the postproduction process, it is often necessary 
to make changes to the overall timeline of a project. When 
any change is made to the video, i. e. when video is cut or 
inserted, those changes must be reflected in the audio as 
well. 

This can be achieved with the Range Selection tool. The 
key is to retain the relative positions of every event in the 
project after the edit is performed. For example, if a portion 
of video is removed, removal of events on all tracks includ-
ing markers, MIDI, automation, and tempo tracks is neces-
sary for everything to remain in sync after the edit point.

Picture cut
To make a picture change involving the removal of existing 
video, proceed as follows:

1. Determine the starting point and duration of the sec-
tion to be removed.
This information should come from the video editor in the form of timecode 
values specifying the start point and duration of each cut. When several 
changes are made to a video, information about those changes comes in 
the form of a “change list”. Reference video and audio can also be used to 
figure this out and also double check the edit once it is complete.

2. Select the Range Selection tool and on the Edit 
menu–Select submenu, choose “Select All”.
This automatically selects all different types of tracks in your project in-
cluding MIDI, Marker, Tempo, and Video. 

3. Deselect the video track with the new edited version 
and lock this and any other reference track.
This prevents accidental editing.

4. In the Range Start field in the info line, enter the start-
ing frame of the video change edit.
This is the first video frame to be removed. You can also locate the cur-
sor to the starting frame and press [E] (“Left Selection Side to Cursor”). 
Make sure that Snap is active, Snap Type is set to “Grid” and Grid Type 
is set to “1 frame”.
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5. In the Range Length field in the info line, enter the du-
ration of the cut.
Now the range selection encompasses all the events in the project that 
are to be removed together with the old video. 

The range has been defined for the cut on all tracks.

6. On the Edit menu–Range submenu, select “Cut Time”.
This will remove the selected area and move all the following events to 
the left by the same amount, filling the gap. The audio should now play in 
sync with the new video from the edit point on to the end.

The edit is complete. All events to the right have been moved to fill the 
gap.

Once the edit is complete, import the new video file and 
check the sync of audio to video through the edit point. 
Reference audio from the new video can be useful for 
checking your edits.

Picture insert
To make a picture change involving the addition of video 
material, proceed as follows:

1. Locate the insertion point where the video has been 
added.
This information comes from the video editor’s change notes.

2. Select the Range Selection tool and on the Edit 
menu–Select submenu, choose “Select All”.
This automatically selects all tracks in your project. 

3. In the Range Start field in the info line, enter the start-
ing frame of the insertion.
You can also locate the cursor to the starting frame and press [E] (“Left 
Selection Side to Cursor”). 

4. In the Range Length field in the info line, enter the du-
ration of the inserted video.
This creates a selection of the same size as the inserted video.

5. On the Edit menu–Range submenu select “Insert Si-
lence”.
Blank space is inserted and all events will be moved to the right to make 
room.

Synchronize tempo maps to picture
You can use the Time Warp feature in Nuendo to create 
tempo maps that are synchronized with video for use in 
scoring music to picture. When scoring to picture, tempo 
changes in the music often need to follow specific visual 
elements on screen. Using the Time Warp feature with 
Edit Mode allows you to make these changes easily while 
viewing video.

For further information, see “Matching a musical score to 
video” on page 461.

! Once the new video and reference audio have been 
placed in the Project window, you may lock those 
tracks to prevent inadvertent editing later.
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Using standard Nuendo tools for 
postproduction purposes
In this section the Nuendo editing tools related to video 
postproduction techniques are described. 

Inserting audio into the project
The options listed below can be used with video to place 
audio events precisely at the video frame you choose.

Select your audio events in the Pool and use the “Insert 
into Project” options from the Media menu to place them 
in the Project window.

These options are described in detail in the section “In-
serting clips into a project” on page 325.

Using the Marker window as a spotting list
In the following section we will describe how to add mark-
ers and use the Marker window to position your audio 
events.

A spotting list is created by viewing a film or video and de-
termining where certain sound effects and other audio el-
ements will go during postproduction. The list consists of 
timecode values and descriptions of the sounds that will 
go there. For example:

In this list, there are three timecode locations and various 
sounds that are needed at those points in the video. Dur-
ing editing, sound effects could simply be placed using 
these timecode values and be relatively close to final posi-
tion without much effort. To make it even faster, use the 
Marker window as a spotting list.

As you view a video in Nuendo, have the Marker window 
open, and as you “spot” places where sound effects need 
to be inserted, add a marker. With the Marker window 
open, you will see the newly created marker in the list. 
Once you complete the description and enter it, you can 
create another marker instantly, making it possible to cre-
ate an entire spotting list on-the-fly in Nuendo.

After importing sound effects from a library or field record-
ings, they can be placed in the project using the Insert at 
Cursor option, moving the cursor to each marker by dou-
ble-clicking in the very left column of the Marker window 
next to the desired number.

The Marker window used as a built-in spotting list

While the positioning of the audio events in this case might 
not be exact, it will quickly get audio in close proximity to the 
needed position. Fine tuning can be done later with other 
editing tools and features.

For further information, please refer to the chapter “Using 
markers” on page 136.

Event handles
The event handles (fade in, fade out, and volume) are ex-
tremely useful for working with picture since their functions 
are tied to the event itself. When the event moves, so do the 
fades and volume level.

Since the event fades and volume are handled in real time, 
you can hear the results of your edits instantly. As long as 
you let go of the event handle before the cursor reaches 
the event during playback, you hear the result of your edit. 
Being able to edit while playback continues gives you 
more time and freedom to work while others are still listen-
ing to the playback.

For further information, please refer to the chapter “Fades, 
crossfades and envelopes” on page 112.

Timecode Description

01:07:36:15 Footsteps on concrete

01:07:53:02 Telephone rings

01:08:06:07 Explosion outside
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Event envelopes
For even more control, the event envelope provides an-
other type of volume control over the audio event. Instead 
of controlling only fade ins and outs or the overall volume 
of the event, envelopes can alter the volume of audio any-
where within the event. 

To access the event envelope, select the Pencil tool and 
simply click within any audio event. A volume envelope line 
appears with a new curve point. Unity gain (no change) is 
where the envelope line is at the very top of the event. Any 
curve points below indicate gain reduction at that point. 
The waveform display reflects the change in volume for vi-
sual feedback as you edit. You can add as many curve 
points as you like by clicking again with the Pencil tool, 
giving you the ability to contour the volume of the event 
very precisely. To remove a curve point, drag it with the 
Pencil tool outside the event.

An event envelope with several curve points. Notice that the volume 
curve with fades and the overall volume is still displayed. The combination 
of the envelope and volume curve will determine the final audio level for 
each event.

For further information, please refer to the chapter “Fades, 
crossfades and envelopes” on page 112.

Range selection
Using the Range selection tool to edit audio to picture 
opens up many other possibilities and functionality. When 
you make selections with the Range selection tool, the 
info line displays the start, end and length of the selection. 

The length indication is a handy timecode calculator when 
the project timeline is viewed in timecode. The start and 
end track numbers are also shown, outlining the top and 
bottom of the selection. All the values in the info line are 
editable.

• Altering the start moves the selection without changing its 
length.

• Altering the end changes the length of the selection.
• Altering the length changes the end time to match the desired 

length.
• Altering the first track number will change the number of the 

topmost track in the selection.
• Altering the last track will change the number of the bottom 

track in the selection. All tracks in between these two will be 
included in the selection.

The info line while using the Range selection tool. Notice the top and 
bottom track numbers at the right of the display.

It is also possible to select non-contiguous tracks in a 
range selection by [Alt]/[Option]-clicking within the bor-
ders of the selection on the track you wish to add to the 
range. Only that track area will be added. This can be re-
peated to add other tracks to the range.

Non-contiguous range selection. The track placement of this data is 
retained in the clipboard.

! One advantage to both the event handles (volume 
curve) and the event envelope is that their effects oc-
cur prior to the audio signal entering the mix engine of 
Nuendo. For example, if you have a compressor plug-
in on a track in Nuendo and you increase the volume 
of an event on that track by using the volume handle, 
the compressor plug-in will see a greater input signal, 
altering its gain reduction accordingly. This can be 
very advantageous, e. g. when evening out levels in di-
alog tracks.
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There are also functions that let you alter the range selec-
tion using the cursor, event boundaries, left and right loca-
tors, and the start and end of the project. These functions 
are found in the Edit menu–Select submenu.

When these operations are assigned to key commands, 
the increase in speed and efficiency for creating range se-
lections can be considerable. The various options of the 
Select submenu are described in detail in the section 
“Range editing” on page 77.

By using these commands in various combinations, it is 
possible to create range selections quickly based on event 
boundaries, cursor and locator positions, and on-the-fly 
“capturing” during playback. These workflow improvements 
can become indispensable for many postproduction tasks.

For a description of the options on the Range submenu of 
the Edit menu, see “Editing selection ranges” on page 78.

Range editing
Once you have a range selection defined, there are many 
editing operations that can be performed to the selection. 
Some of these range edits have been designed expressly 
for postproduction in order to streamline workflow and in-
crease efficiency and creativity. Others include the stan-
dard editing functions cut, copy and paste along with 
mouse operations to move selected audio (see “Range 
editing” on page 77).

You can also use the “Cut Head” and “Cut Tail” functions 
on the Edit menu for the editing of ranges and events, see 
“Using Cut Head and Cut Tail” on page 71. Furthermore 
you can use the “Adjust Fades to Range” command on 
the Audio menu, see “Creating and adjusting fades with 
the Range Selection tool” on page 113.

Edit Mode
When editing to video, it is always important to know how 
each edit relates to the exact frame of video where it oc-
curs. Video playback follows the Nuendo transport, so 
that the video frame at the current project cursor position 
is shown, during playback and in Stop mode (e. g. if you 

move the project cursor manually or use fast forward/re-
wind). However, if you perform event or range-based edit-
ing tasks you will get no visual feedback. The special Edit 
Mode solves this problem, allowing you to edit audio while 
getting continuous visual feedback on the video display:

• If you activate “Edit Mode” on the Transport menu, the 
project cursor will automatically follow when you make se-
lections or perform editing operations (such as moving, 
resizing, adjusting fades, etc.).
Because the video automatically follows the project cursor, you will in-
stantly get a visual feedback when you edit! This makes it very easy to 
move an audio event to a certain spot in the video, for example.

• To avoid obscuring the view, the project cursor is hid-
den from the event display in Stop mode if Edit Mode is 
activated.
However, it is always displayed in the ruler.

Listed below are some examples of how you can use Nu-
endo’s Edit Mode for matching audio and MIDI to video.

Edit Mode: Arrow tool

When editing events with the Arrow tool, Edit Mode 
causes the video to follow your motions as you drag 
events and event handles. For instance, when you click 
and drag one or more events, the video will follow the left 
edge of the first event while you drag, giving you visual 
feedback on the position in the video. This is very helpful 
while placing sound effects to picture since you can see 
things in the video as you move sounds around in the 
Project window. Lining up sound effects to their visual 
counterparts becomes quite easy and quick.

Edit Mode follows the snap point of each audio event. If 
the snap point has not been modified, it remains at the 
start of the event. It can often be necessary to align a por-
tion of audio in the middle of the event. Adjusting the snap 
point to a position in the audio event that is timing sensi-
tive will allow you to use Edit Mode to visually line up that 
position to the video. 

For example, the sound of a car skidding to a stop might 
be easily timed to picture by lining up the end of the skid 
sound with the stopping of the car in the video. The car 
might come into the frame after the skidding had begun, 
thereby making it very difficult to align the sound quickly 
without a starting point reference. The snap point over-

! Range editing can affect any type of event in the 
Project window including video, MIDI, markers, and 
automation data. When performing edits that affect 
the entire timeline (editing picture changes for in-
stance) range edits can be very effective.
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comes this problem by allowing you to reference another 
point in the audio event. By moving the snap point to the 
end of the skidding sound, Edit Mode can be used to line 
that point with the stopped car on screen.

When adjusting fade handles, the video will follow the po-
sition of the fade handle as you move it, allowing you to 
position fades exactly in time with the video.

Edit Mode: Range Selection tool

When making range selections, Edit Mode causes the 
video to follow the range as you make the selection. 

If you have a video section and an audio event for it that 
does not quite fit, you can use time stretch to change the 
length of the audio:

1. Position the start of the audio event at the correct po-
sition according to the video.

2. In Edit Mode, select the Range Selection tool and 
double-click on the audio event.
This creates a selection range that spans the whole audio event.

3. Click the right edge of the selection range and drag to 
adjust it to the desired length.
While you are dragging, the project cursor position follows the right 
edge of the range, allowing you to pinpoint the desired end position in 
the video.

4. Use “Locators to Selection” (on the Transport menu) 
to set the locators to the selection range you just made.

5. With the Arrow tool, select the audio clip to be 
stretched.

6. On the Audio menu–Process submenu, select “Time 
Stretch”.
The Time Stretch dialog opens.

7. Click the “Use Locators” button.
The time stretch ratio is set up so that the audio event will fit the locator 
range.

8. Make the desired settings and click Process.
The audio is stretched or compressed to fit the range.

If you want the audio to fade in, reaching full volume at a 
certain position in the video, and fade out at another posi-
tion, here is a quick way of achieving this:

1. In Edit Mode, select the Range Selection tool.

2. Make a selection range in the audio event, roughly cov-
ering the section that you want to be played at full volume.

3. Click and drag the edges of the selection range so 
that they exactly correspond to the end of the fade-in and 
the start of the fade-out, respectively.
While you are dragging, the project cursor position follows the edge of 
the range, allowing you to pinpoint the desired fade-in and fade-out po-
sition in the video.

4. Pull down the Audio menu and select “Adjust Fades to 
Range”.
The fade-in and fade-out handles of the audio events are automatically 
adjusted.

When using the fade handles of an audio event in Edit 
Mode, the cursor will follow their position as well, allowing 
you to adjust fades to picture in this manner.

Edit Mode: Nudge commands

Nudging of events or range selections will also cause the 
video to move to the nudge position. All nudge commands 
(start, position, and end) will have this behavior in Edit 
Mode.

Text editing
For extremely precise editing, text entry may be used to 
perform most editing tasks in Nuendo. The info line in the 
Project window gives you instant access to any selected 
event’s data including start and end points, duration, off-
set, snap point, fade-in, and fade-out durations. Addition-
ally, the Project Browser allows text editing of each event 
in the project in a list view including automation data, 
video events, and markers.

! Make sure that you do not exceed the 75 % to 125 % 
limit!

! This assumes that the audio event is already posi-
tioned and sized correctly according to the video.
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Text editing can be useful when conforming audio to edit 
decision lists (EDLs) created by video editors. A list of au-
dio files will be shown with source and destination time-
code values that can be used to place audio events in 
Nuendo.

An EDL with source and destination timecode values.

For further information, please refer to the chapter “Using 
markers” on page 136.
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Introduction
ReWire and ReWire2 are special protocols for streaming 
audio between two computer applications. Developed by 
Propellerhead Software and Steinberg, ReWire provides 
the following possibilities and features:

• Realtime streaming of up to 64 separate audio channels 
(256 with ReWire2), at full bandwidth, from the “synthe-
sizer application” into the “mixer application”.
In this case, the “mixer application” is of course Nuendo. An example of a 
“synthesizer application” is Propellerhead Software’s Reason.

• Automatic, sample accurate synchronization between 
the audio in the two programs.

• The possibility to have the two programs share one au-
dio card and take advantage of multiple outputs on that 
card.

• Linked transport controls that allow you to play, rewind, 
etc., either from Nuendo or from the synthesizer applica-
tion (provided it has some kind of transport functionality).

• Automatic audio mixing functions of separate channels 
as required.
In the case of Reason, for example, this allows you to have separate 
mixer channels for the different devices.

• Additionally, ReWire2 offers the possibility to route MIDI 
tracks in Nuendo to the other application, for full MIDI con-
trol.
For each ReWire2 compatible device, a number of extra MIDI outputs 
will be made available in Nuendo. In the case of Reason, this allows you 
to route different MIDI tracks in Nuendo to different devices in Reason, 
with Nuendo serving as the main MIDI sequencer.

• The overall load on your system is much reduced, com-
pared to when using the programs together in the conven-
tional way.

Launching and quitting
When using ReWire, the order in which you launch and 
quit the two programs is very important:

Launching for normal use with ReWire
1. First launch Nuendo.

2. Enable one or several ReWire channels in the ReWire 
Device dialog for the other application.
This is described in detail in the section “Activating ReWire channels” on 
page 550.

3. Launch the other application.
It may take slightly longer for the application to start when you are using 
ReWire.

Quitting a ReWire session
When you are finished, you also need to quit the applica-
tions in a special order:

1. First quit the synthesizer application.

2. Then quit Nuendo.

Launching both programs without using 
ReWire
We cannot think of any scenario, in which you would need 
to run Nuendo and the synthesizer application simulta-
neously on the same computer, without using ReWire, but 
you can:

1. First launch the synthesizer application.

2. Then launch Nuendo.

Please note that the two programs now compete for 
system resources such as audio cards, just as when run-
ning either with other, non-ReWire audio applications.
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Activating ReWire channels
ReWire supports streaming of up to 64 separate audio 
channels, while ReWire2 supports 256 channels. The ex-
act number of available ReWire channels depends on the 
synthesizer application. Using the ReWire Device panels 
in Nuendo, you can specify which of the available chan-
nels you want to use:

1. Pull down the Devices menu and select the menu item 
with the name of the ReWire application. All recognized 
ReWire compatible applications will be available on the 
menu.
The ReWire panel appears. This consists of a number of rows, one for 
each available ReWire channel.

2. Click on the power buttons to the left to activate/de-
activate the desired channels.
The buttons light up to indicate activated channels. Please note that the 
more ReWire channels you activate, the more processing power is re-
quired.

• For information about exactly what signal is carried on 
each channel, see the documentation of the synthesizer 
application.

3. If desired, double-click on the labels in the right col-
umn, and type in another name.
These labels will be used in the Nuendo Mixer to identify the ReWire 
channels.

Using the transport and tempo 
controls

Basic transport controls
When you run ReWire, the transports in the two programs 
are completely linked. It does not matter in which program 
you play, stop, fast forward or rewind. However, recording 
(if applicable) is still completely separate in the two appli-
cations.

Loop settings
If there is a loop or cycle facility in the synthesizer applica-
tion, that loop will be completely linked to the cycle in Nu-
endo. This means that you can move the start and end point 
for the loop or turn the loop on or off in either program, and 
this will be reflected in the other.

Tempo settings
As far as tempo goes, Nuendo is always the master. This 
means that both programs will run in the tempo set in Nu-
endo.

However, if you are not using the tempo track in Nuendo, 
you can adjust the tempo in either program, and this will 
immediately be reflected in the other.

! This is only relevant if the synthesizer application has 
some sort of built-in sequencer or similar.

! If you are using the tempo track in Nuendo (i. e. the 
Tempo button is activated on the Transport panel), 
you should not adjust the tempo in the synthesizer 
application, since a tempo request from ReWire will 
automatically deactivate the tempo track in Nuendo!
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How the ReWire channels are 
handled in Nuendo
When you activate ReWire channels in the ReWire De-
vice panels, they will become available as channel strips in 
the Mixer. The ReWire channel strips have the following 
properties:

• ReWire channels appear to the right of the other audio 
and MIDI channel strips in the Mixer.

• ReWire channels may be any combination of mono and 
stereo, depending on the synthesizer application.

• ReWire channels have the same functionality as regular 
audio channels.
This means you can set volume and pan, add EQ, insert effects and sends 
and route the channel outputs to groups or busses (done in the Inspector). 
However, ReWire channels have no monitor buttons.

• All ReWire channel settings can be automated using 
the Read/Write buttons.
When you write automation, channel automation tracks will automatically 
appear in the Project window. This allows you to view and edit the auto-
mation graphically, just as with VST instrument channels, etc.

• You can mix down the audio from ReWire channels to a 
file on your hard disk with the Export Audio Mixdown func-
tion (see “Mixing down to audio files” on page 474).
You can export the output bus to which you have routed the ReWire 
channels. You can also export individual ReWire channels directly – 
“rendering” each ReWire channel to a separate audio file.

Routing MIDI via ReWire2

When using Nuendo with a ReWire2-compatible appli-
cation, additional MIDI outputs will automatically appear 
on the MIDI Output pop-up menus for MIDI tracks. This 
allows you to play the synthesizer application via MIDI 
from Nuendo, using it as one or several separate MIDI 
sound sources.

The MIDI outputs for a Reason song. Here, each output goes directly to 
a device in the Reason rack.

• The number and configuration of MIDI outputs depends 
on the synthesizer application.

Considerations and limitations

Sample rates
Synthesizer applications may be limited to audio playback 
in certain sample rates. If Nuendo is set to a sample rate 
other than those, the synthesizer application will play back 
at the wrong pitch. Consult the documentation of the syn-
thesizer application for details.

ASIO drivers
ReWire works well with ASIO drivers. By using the Nuendo 
bus system you can route sounds from the synthesizer 
application to various outputs on an ASIO compatible audio 
card.

! This feature is only available with ReWire2-compati-
ble applications.
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Importing audio
In Nuendo audio can be imported in a variety of different 
formats. For example, you can import tracks from audio 
CDs, or import audio files saved in different formats (com-
pressed and uncompressed).

For information on audio file import preferences, see “Audio 
file import options” on page 64. For information on how to 
import audio files into the Pool and import options, see 
“About the Import Medium dialog” on page 329.

Importing audio CD tracks
You can import audio from audio CDs into Nuendo 
projects in two ways:

• To import the CD tracks directly into project tracks, 
choose the “Audio CD…” option from the Import sub-
menu of the File menu.
The imported audio CD track(s) are inserted on the selected audio 
track(s) at the project cursor position.

• To import the CD tracks into the Pool, select “Import 
Audio CD…” from the Media menu.
This might be the preferred method if you want to import several CD 
tracks in one go.

Selecting one of the Import Audio CD menu items brings 
up the following dialog:

To import one or more tracks, proceed as follows:

1. If you have more than one CD drive, select the correct 
one from the Drives pop-up menu at the top left.
On opening the CD, the program tries to retrieve the track names from 
CDDB (a CD database). If no connection to CDDB can be established 
or the CD track names are not found, you can manually change the ge-
neric track name in the Default Name field.

2. Windows only: Activate the “Secure Mode” option if 
you want to use a Secure Read mode.
Use this if you encounter problems when trying to import an audio CD. 
Error checking and correction will be done during the process. Note that 
this mode will take more time.

3. In the Windows version, select the data transfer speed 
from the Speed pop-up menu.
While you normally want to use the fastest possible speed, you may have 
to select a slower speed for flawless audio extraction.

4. Activate the Copy checkbox for every audio file you 
want to import.
You can also select a copy section for every file, see below.

5. Click on the Copy button to create a local copy of the 
audio file(s) or section(s).
The copied files are listed at the bottom of the dialog. By default, im-
ported audio CD tracks will be stored as Wave files (Windows) or AIFF 
files (Mac) in the Audio folder of the current project. To change the 
folder, click Destination Folder and select a different folder from the dia-
log. During copying, the Copy button is labeled “Stop”; click it to stop 
the process.

6. Click OK to import the copied audio files into the 
project, or click Cancel to stop the import and discard the 
copied files.

• If you import more than one audio file into project tracks, 
a dialog opens in which you have to choose whether to in-
sert the tracks on one track or on different ones. 
The new track(s) are displayed in the Project window. New audio clips 
are created and added to the Pool.

The columns in the “Import from Audio CD” dialog have 
the following functionality:

Column Description

Copy Activate the checkbox in this column for the track you 
want to copy/import. To activate more than one check-
box, click and drag over the checkboxes (or press [Ctrl]/
[Command] or [Shift] and click).

# This is the track number.
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By default, complete tracks are selected.

• If you want to copy and import a section of an audio CD 
track only, select the track in the list and specify the start 
and end of the selection to be copied by dragging the 
handles in the copy selection ruler.

Note that you can import sections of several audio CD 
tracks by selecting them in turn and adjusting the selec-
tion. The start and end settings for each track are dis-
played in the list.

• You can audition the selected audio CD track by click-
ing the Play button.
The track will be played back from selection start to selection end (or un-
til you click the Stop button). 

• The Play from left Marker (down arrow) and Play to 
Right Marker (up arrow) buttons allow you to audition the 
start and end of the selection only.
The down arrow button will play a short snippet beginning at the start of 
the selection, while the up arrow button will play a snippet starting just 
before the end of the selection.

• To open the CD drive, click on the Eject button at the 
top of the dialog. 

Importing Audio from video files
While you can automatically extract the audio when im-
porting a video file (see “About thumbnail cache files” on 
page 524), it is also possible to import the audio from a 
video file without importing the video itself:

1. Pull down the File menu, open the Import submenu 
and select “Audio from Video File…”.

2. In the file dialog that opens, locate and select the 
video file and click Open.
The audio in the selected video file is extracted and converted to a Wave 
file in the project’s Audio folder.

• A new audio clip is created and added to the Pool. In 
the Project window, an event referencing the audio file is 
inserted on the selected track at the project cursor posi-
tion. If no track was selected, a new track is created.
This works just like importing regular audio files.

For importing video files, see “Importing video files” on 
page 523.

Importing ReCycle files
ReCycle by Propellerhead Software is a program designed 
especially for working with sampled loops. By “slicing” a 
loop and making separate samples of each beat, ReCycle 
makes it possible to match the tempo of a loop and edit the 
loop as if it was built of individual sounds. Nuendo can im-
port two file types created by ReCycle:

• REX files (export file format of the first versions of ReCycle, 
extension “.rex”).

• REX 2 files (file format of ReCycle 2.0 and later, extension 
“.rx2”).

Proceed as follows:

1. Select an audio track and move the project cursor to 
where you want the imported file to start.
You probably want to import REX files to tempo based audio tracks, since 
this will allow you to change the tempo later on (having the imported REX 
file automatically adjust).

2. Select “Audio File…” from the Import submenu of the 
File menu.

CD Track as 
shown

When you import an audio CD track, the file is named ac-
cording to this column. The names are pulled automati-
cally from CDDB, if possible. You can rename a track by 
clicking in the CD Track column and typing a new name. 
You can also apply a generic name to all audio CD tracks, 
if no name was available in CDDB.

Length The length of the audio CD track in minutes and seconds.

Size The file size of the audio CD track in MB.

Copy Start You can copy a section of a track if you like. This indi-
cates the start of the section to be copied in the track. By 
default, this is set to the start of the track (0.000) but you 
can adjust this on the copy selection ruler (see below).

Copy End Indicates the end of the section to be copied in the track. 
By default, this is set to the end of the track but you can 
adjust this on the copy selection ruler (see below).

Column Description

Play
Stop

Play from Left Marker

Play to Right Marker

Start of selection handle End of selection handle

! For this to work, the REX Shared Library needs to be 
installed on your system. If this is not the case, you will 
find the corresponding installer on the installation 
DVD (in the “Additional Content\Installer Data” folder).
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3. On the file type pop-up menu in the file dialog, select 
REX File or REX 2 File.

4. Locate and select the file you want to import, and click 
Open.
The file is imported and automatically adjusted to the current Nuendo 
tempo. 

Unlike a regular audio file, the imported REX file will con-
sist of several events, one for each “slice” in the loop. The 
events will automatically be placed in an audio part on the 
selected track and positioned so that the original internal 
timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you 
can edit each slice separately by muting, moving and re-
sizing events, adding effects and processing, etc.
You can also adjust the tempo and have the REX file automatically follow 
(provided that its track is tempo based).

You can achieve similar results by using Nuendo’s 
own loop slicing features, see “Working with hitpoints and 
slices” on page 299.

Importing compressed audio files
Nuendo can import (and export, see “Mixing down to audio 
files” on page 474) several common audio compression 
formats. The procedure is the same as when importing any 
non-compressed audio file, with one important thing to 
note:

• When you import a compressed audio file, Nuendo cre-
ates a copy of the file and converts this to Wave format 
(Windows) or AIFF format (Mac OS X) before importing it. 
The original compressed file will not be used in the project.
The imported file is placed in the designated project Audio folder.

The following file types are supported:

MPEG audio files

MPEG, which stands for Moving Picture Experts Group, is 
the name of a family of standards used for encoding au-
dio-visual information (e. g. movies, video, music) in a digi-
tal compressed format. 

Nuendo can read two types of audio MPEG files: MPEG 
Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Currently, 
mp3 is the most common of these formats, while the mp2 
format is mostly used in broadcast applications.

Ogg Vorbis files

Ogg Vorbis is an open and patent-free format that offers 
very small audio files maintaining comparatively high audio 
quality. Ogg Vorbis files have the extension “.ogg”.

Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by 
Microsoft, Inc. Due to advanced audio compression algo-
rithms, Windows Media Audio files can be made very 
small, maintaining good audio quality. The files have the 
extension “.wma”.

For exporting Audio, see the chapter “Export Audio 
Mixdown” on page 473.

! The resulting Wave/AIFF file will be several times 
larger than the original compressed file.
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Exporting and importing OMF files
Open Media Framework Interchange (OMFI) is a platform 
independent file format intended for the transfer of digital 
media between different applications. Nuendo can import 
and export OMF files (file extension “.omf”), allowing you 
to use Nuendo in conjunction with other audio and video 
applications.

Exporting OMF files
When exporting tracks and files as OMF, you should con-
sider setting up your project to use mono tracks and mono 
files, to allow compatibility with audio applications that 
provide limited support for interleaved audio files. See 
“Converting audio tracks (multi-channel to mono and vice 
versa)” on page 563 for more information.

1. Pull down the File menu, open the Export submenu 
and select “OMF…”.
The Export Options dialog opens.

The Export Options dialog for OMF files

2. Use the track list to the left to select the tracks that 
you want to include in the exported file.
To select all tracks, click the “Select All” button. Normally, the whole 
project is included – to export the range between the locators only, 
activate “From Left to Right Locator”.

• When referencing media files (see below), you can set 
the referenced output path by entering it in the “Media 
Destination Path” field or by clicking on “Browser…” and 
choosing it in the file dialog that opens.
All file references will be set to this path. You can create references to 
media destinations that do not exist on the system you are currently 
working with, making it easy to prepare files for use in projects on an-
other system or in a network environment.

3. If you want to create copies of all the media files, 
choose the “Copy Media” option.
By default, the copied audio files are placed in a subdirectory in the ex-
port destination folder. To specify a different location for the copied files, 
use the “Media Destination Path” field.

4. If you want to copy only the portions of audio files that 
are used in the project, activate “Consolidate Events”. 
You can also define handle lengths in milliseconds to include audio out-
side each event boundary for later fine tuning. If you do not have any han-
dles when consolidating audio files, you will not be able to adjust fades 
or edit points when the project is imported in another application.

5. Select “1.0 File” or “2.0 File”, depending on which 
OMF version is supported by the application in which you 
plan to import the file.

• Select whether you want to include all audio data in the 
OMF file (“Export All to One File”) or use references only 
(“Export Media File References”).
If you choose “Export All to One File”, the OMF file will be totally “self-
contained”, but possibly very large. If you choose “Export Media File Ref-
erences”, the file will be small, but the referenced audio files must be 
available for the receiving application.

6. If you selected the “2.0 File” option above, you can 
choose whether to include the volume settings and fades 
for the events (as set up with the event volume and fade 
handles) as well as the clip names – to include these in 
the OMF file, activate “Export Clip Based Volume”, “Use 
Fade Curves” and/or “Export Clip Names”.

7. Specify a sample size (resolution) for the exported files 
(or use the current project settings).

8. If you activate “Quantize Events to Frames”, the event 
positions in the exported file will be moved to exact frames.

9. Click OK, and specify a name and location in the file 
dialog that opens.

The exported OMF file will contain (or reference) all audio 
files that are played in the project (including fade and edit 
files). It will not include unused audio files referenced in 
the Pool, or any MIDI data. Video files are not included.
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Importing OMF files
1. Pull down the File menu, open the Import submenu 
and select “OMF…”.

2. In the file dialog that opens, locate the OMF file and 
click Open.

• If there is already an open project, a dialog opens in 
which you can select whether a new project is created for 
the file.
If you select “No”, the OMF file will be imported into the current project.

3. If you choose to create a new project, a file dialog 
opens in which you can select the project folder.
Select an existing project folder or create a new one.

4. The Import Options dialog opens, allowing you to 
choose a track for the import.

• Activating the “Import all media files” option allows you 
to import media that is not referenced by events.

• Activating the “Import Clip Gain as Automation” option 
imports volume automation and envelopes of the Volume 
Automation Track of each track.

• “Import at Timecode Position” will insert the elements 
contained in the OMF file at their original timecode posi-
tions.
This is useful when you want to position every imported element at its ex-
act timecode position, i. e. as it was saved in the OMF file. This way, the 
elements will end up at their correct time positions even when Nuendo 
uses a different frame rate than the OMF file. This is usually required in a 
picture-related context.

• “Import at Absolute Time” will insert the elements con-
tained in the OMF file starting at the timecode position 
saved in the file and keeping the relative distances be-
tween the elements.
This is required when the relative positioning of the elements inside the 
OMF file needs to be maintained after importing it into the Nuendo time-
line (even if Nuendo is set to a different frame rate than the OMF file). 
This is usually required in music contexts, where the timing between ob-
jects has highest priority.

• If the OMF file contains video event information, you are 
asked whether you want to create Markers at the start po-
sition of the video events.
This allows you to manually import the video files, using the Markers as 
position references.

A new, untitled project is created (or tracks are added to 
the existing project), containing the audio events of the im-
ported OMF file.

Exporting and importing AAF files
The Advanced Authoring Format (AAF) is a multimedia file 
format used to exchange digital media and meta data be-
tween different systems and applications across multiple 
platforms. Designed by the top media software compa-
nies, this format will help media creators by allowing them 
to exchange projects between applications without losing 
valuable meta data such as fades, automation and pro-
cessing information.

Exporting AAF files
1. Select “AAF…” from the Export submenu of the File 
menu.

2. You can choose which tracks will be exported from 
your project by clicking in the export column for each track 
name in the list.
A checkmark will appear next to each track that will be exported. You 
may also click the “Select All” button to select every track in the project 
for export.

3. If you wish to only export the portion of project that is 
between the left and right locators, activate the “From Left 
to Right Locator” checkbox.
If an event crosses over the left or right locator, it will be trimmed in the 
AAF file to the point of the locator. Only the portions of events that lie 
within the boundaries of the locators will be included in the exported file.

4. If you want to create copies of all the media files, 
choose the “Copy Media” option.
By default, the copied audio files are placed in a subdirectory in the ex-
port destination folder. To specify a different location for the copied files, 
use the Media Destination Path field.

5. If you want to copy only the portions of audio files that 
are used in the project, activate “Consolidate Events”. 
You can also define handle lengths in milliseconds to include audio out-
side each event boundary for later fine tuning. If you do not have any han-
dles when consolidating audio files, you will not be able to adjust fades 
or edit points when the project is imported in another application.

Even when selecting neither of the above two options, 
you can still enter a media destination path. All file refer-
ences will be set to this path. You can create references 
to media destinations that do not exist on the system you 
are currently working with, making it easy to prepare files 
for use in projects on another system or in a network envi-
ronment.
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6. In the Options section, you have the choice of export-
ing all data to one file or to create media references to files 
from within the AAF file.
Exporting only one file makes transfers simpler, but, at the time of writing of 
this manual, certain applications cannot handle single AAF files. Check 
with each software manufacturer for up-to-date information regarding AAF 
support in other applications.

7. You can specify the Sample Size by using the pop-up 
menu. 
This defaults to keeping the same setting as the project.

8. You can quantize events to frame boundaries by acti-
vating the “Quantize Events for Frames” option.
Quantizing events to frame boundaries is sometimes necessary when ex-
porting projects to video workstations that limit the accuracy of edits to 
the frame. Any events that begin or end not on a frame boundary can ex-
hibit odd behavior or be moved when imported into a workstation of this 
type.

Importing AAF files
1. Select “AAF…” from the Import submenu of the File 
menu.

2. Once you have selected a valid AAF file, Nuendo will 
ask you if you wish to create a new project. Choosing Yes 
will import tracks into a new project.

3. Select a directory or create one for the new project. 
If you choose not to create a new project, the imported tracks will be 
added to the currently active project.

4. In the dialog that opens, select the tracks you wish to 
import by clicking in the Import column next to each track.
You can also click the Select All button to import all tracks in the AAF file.

5. Click OK.
The import process will begin. Depending on the size of the imported 
project and if the files are embedded or referenced, the import process 
may take a while.

Exporting and importing AES31 files
The AES31 standard is an open file interchange format, de-
veloped by the Audio Engineering Society as a means of 
overcoming format incompatibility issues between different 
audio hardware and software. It can be used for transferring 
projects via disk or network from one workstation to an-
other, retaining time positions of events, fades, etc.

AES31 uses the widely used Microsoft FAT32 file system 
with Broadcast Wave as the default audio file format. This 
means that an AES31 file can be transferred to and used 
with any digital audio workstation that supports AES31, 
regardless of the type of hardware and software used, as 
long as the workstation can read the FAT32 file system 
and Broadcast Wave files (or regular Wave files).

Exporting AES31 files
1. Select “AES31…” from the Export submenu of the 
File menu.

2. Specify a name and location for the file and click Save.
The exported file will contain all Audio Track data, including audio file ref-
erences. If any of the audio events in your project has realtime fades (as 
set up with the fade handles for the events), these will automatically be 
converted to fade audio files and stored in a fades folder next to the 
AES31 file.

The following will not be included in the resulting AES file:

• Any Mixer settings or automation made in Nuendo. 
• MIDI Tracks.

The saved file will be an XML file (but with the extension 
“.adl”, for audio decision list) – this means you can open it 
in any text editor to check file references, etc.

Importing AES31 files
1. Select “AES31…” from the Import submenu of the 
File menu.

2. Navigate to the location of the AES31 file (extension 
“.adl”), select it and click Open.
You are prompted to select or create a project folder for the new project.

3. After specifying the name and location of the project 
folder, the new project opens containing all the audio 
tracks and events stored in the AES31 file.
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Exporting and importing OpenTL files
OpenTL is a file exchange format originally developed for 
Tascam hard disk recording systems. OpenTL facilities also 
exist in a variety of DAWs, making Nuendo project transfer 
reliable and solid. For example, a common use of OpenTL is 
to convert hassle free between Nuendo and Pro Tools. If 
you import or export an OpenTL file to/from Nuendo, the re-
sulting project will contain all audio files, edits, and track 
names made in the Tascam device or DAW, with all events 
positioned sample accurately on the time line.

OpenTL implementation in Tascam® MMR-8, 
MMP-16 and MX-2424
All three Tascam devices work with either two types of 
disk volume formats: FAT32 (Windows standard) or 
HFS+ (Mac OS standard). For proper Nuendo compati-
bility it is necessary that each and every MMR-8/MMP-16 
be running OS v5.03 and MX-2424 v3.12. A number of 
crucial OpenTL updates only appear in these machine op-
erating systems, and only this setup can assure reliable 
Nuendo exchange.

Audio file formats are volume type dependent: for FAT32 
this is BWF (*.wav) and for HFS+ this is SDII. OpenTL 
files can only be transferred within file systems of the 
same format which means that it is not possible to import 
an OpenTL project exported from Mac (HFS+) into a 
Windows system (FAT32) or vice versa, unless you use a 
conversion utility (e. g. MM-EDL).

Nuendo for Windows supports OpenTL FAT32/BWF. 
Nuendo for Mac OS X supports OpenTL HFS+/SDII as 
well as FAT32/BWF. MMR-8, MMP-16, and MX-2424 
support OpenTL projects sourcing or targeting Nuendo 
PC with up to 999 mono tracks.

Exporting OpenTL files
First, make sure all audio files (in the Pool) and tracks (in 
the Project window) in the project are in mono (split ste-
reo tracks and stereo interleaved audio files to dual mono) 
and all 16-bit or all 24-bit. The OpenTL specification does 

not include support for 32-bit audio files. If the Pool con-
tains 32-bit audio files, these will not be exported. Make 
sure all referenced audio files are located on the drive to 
which you want to export the OpenTL file.

1. Select “OpenTL…” from the Export submenu of the 
File menu.
In the dialog that opens, activate the “Copy Media” or the “Consolidate 
Events” option to guarantee that all audio is exported. Locate the target 
hotswap FAT32 disk, select the appropriate project folder and click Open.

2. Select a name and location for the new file and click 
Save.
The exported file will contain all audio track data, including file references, 
clip based volume automation, fade-in, fade-out, and crossfades. 

3. Now you can mount the carrier in the Tascam device 
and load the project.

The following will not be included in the resulting OpenTL 
EDL file: 

• Any realtime mixing, EQ, effects settings, breakpoint automa-
tion tracks

• MIDI tracks made in Nuendo

The following is a basic OpenTL specification description:

• Maximum number of mono tracks: 999
• Supported sample rates (Hz): 44056, 44100, 44144, 47952, 

48000, 48048, 42294, 42336, 45938, 45983, 46034, 
46080, 50000, 50050, 88200, 96000

• Bit depth: 16, 24
• Audio file types: BWF (Broadcast Wave format), WAVE 

(Standard Wave), SDII (Sound Designer II)
• Volume formats: FAT32, NTFS, HFS+
• Automation support: clip based volume, breakpoint volume 

and mute
• Fade support: fade in, fade out, and cross fade
• Frame rates (Fps): 24/24, 23.976/24, 24.975/25, 25/25, 

29.97/DF, 29.97/NDF, 30/DF, 30/NDF 

! When exporting OpenTL files on PC, do not change 
the DF or NDF frame notation after you have set the 
project start time. Make sure that all audio files in the 
Pool have the same sample rate, bit depth, and that 
all are set to Broadcast Wave file type.
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Importing OpenTL files
1. Select “OpenTL…” from the Import submenu of the 
File menu.

2. Navigate to the location of the OpenTL file, select it 
and click Open.

3. You are prompted to select or create a project folder 
for the new project.
After specifying the name and location of the project folder, the new 
project opens containing all the audio files stored in the OpenTL file and 
their associated edits. Save the imported file as a Nuendo project. 

4. Open the Pool, and select “Prepare Archive…” from 
the Pool context menu. 
This will copy any necessary external audio files into the local Nuendo 
project directory. For more information, see “Prepare Archive” on page 54.

5. Select the Save option from the File menu. 

Importing XSend projects from 
Liquid
For Liquid users, XSend provides a means to export a Liq-
uid sequence directly to a Nuendo workstation either on 
the same machine, over a network or via portable media 
such as DVD-R.

The XSend options and features are available only if XSend 
is installed on your computer. You can either install XSend 
during the Nuendo installation process, or at a later point in 
time using the XSend installer supplied on the Nuendo pro-
gram DVD. Also, make sure that the XSend plug-in is acti-
vated in the Plug-in Information window.

Proceed as follows to import XSend files:

1. You must designate the XSend Incoming folder by se-
lecting the XSend preferences from the Nuendo File 
menu.
A dialog opens, allowing you to browse your system to select a folder 
where exported Liquid projects will be stored.

2. Export the Liquid project to the Nuendo system.
This can be done directly over a network if the two systems are con-
nected by one. No file sharing is needed. All file transfers are handled by 
XSend. Refer to the Liquid system’s documentation for more information 
on how to do this. You may also export the sequence to portable media 
such as DVD-R or CD-R discs for transfer when no network is available.

3. On the File menu–Import submenu, select “XSend…”.
Navigate to the exported Liquid sequence which will be an XSD file type.

4. You will be asked if you wish to create a new project.
Choose Yes if you want to import the XSend sequence into a blank 
project. If you choose No, the imported sequence will be appended to 
the currently active project. The new audio tracks are displayed below 
the lowest track or channel in the project. In either case, both audio and 
video files can be included in the XSend sequence, providing a conve-
nient means to receive entire projects from Liquid users.

Exporting and importing standard 
MIDI files
Nuendo can import and export standard MIDI files, which 
makes it possible to transfer MIDI material to and from virtu-
ally any MIDI application on any platform. When you import 
and export MIDI files, you can also specify whether certain 
settings associated with the tracks are included in the files 
(automation tracks, volume and pan settings, etc.). 

Exporting MIDI files
To export your MIDI tracks as a standard MIDI file, pull 
down the File menu and select “MIDI File…” from the Ex-
port submenu. A regular file dialog opens, allowing you to 
specify a location and name for the file.

When you have specified a location and a name for the file, 
click “Save”. The Export Options dialog opens, allowing you 
to specify a number of options for the file, e. g. what is in-
cluded in the file, its type and its resolution (see below for a 
description of the options).

The Export Options dialog

You will also find most of these settings in the Preferences 
dialog (MIDI–MIDI File page). If you set these up in the 
Preferences dialog, you only need to click OK in the Ex-
port Options dialog to proceed.
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The dialog contains the following options:

The MIDI file will include the tempo information of the 
project (i. e. it will include the tempo and time signature 
events of the Tempo Track Editor or, if the tempo track is 
deactivated on the Transport panel, the current tempo and 
time signature).

Inspector settings other than those specified in the 
Export options are not included in the MIDI file! To include 
these, you need to convert the settings to “real” MIDI events 
and properties by using the Merge MIDI in Loop function for 
each track, see “Merge MIDI in Loop” on page 397.

Importing MIDI files
To import a MIDI file from disk, proceed as follows:

1. Select “MIDI File…” from the Import submenu of the 
File menu.

2. If there is already an open project, a dialog opens in 
which you can select whether a new project is created for 
the file.
If you select “No”, the MIDI file will be imported into the current project.

3. Locate and select the MIDI file in the file dialog that 
opens and click Open.

• If you choose to create a new project, select the project 
folder.
Select an existing project folder or create a new one.

The MIDI file is imported. The result depends on the con-
tents of the MIDI file and the Import Options settings in the 
Preferences dialog (MIDI–MIDI File page). The Import Op-
tions are as follows:

Option Description

Export 
Inspector 
Patch

If this is activated, the MIDI patch settings in the Inspec-
tor – Bank Select and Program Select (used for selecting 
sounds in the connected MIDI instrument) are included 
as MIDI Bank Select and Program Change events in the 
MIDI file.

Export 
Inspector 
Volume/Pan

If this is activated, Volume and Pan settings made in the 
Inspector are included as MIDI Volume and Pan events in 
the MIDI file.

Export  
Automation

If this is activated, the automation data (as heard during 
playback) are converted to MIDI controller events and in-
cluded in the MIDI file, see the chapter “Automation” on 
page 239. This also includes automation recorded with 
the MIDI Control plug-in (see the separate PDF docu-
ment “Plug-in Reference”). 
Note that if a continuous controller (e. g. CC7) has been 
recorded but the Read button is deactivated for the auto-
mation track (i. e. the automation is effectively switched 
off for this parameter), only the part data for this controller 
will be exported.
If this option is deactivated and the Automation Read but-
ton is activated, no Continuous Controllers are exported. 
If the Read button is deactivated, the Controller data of 
the MIDI part are exported (these will now be handled like 
“regular” part data).
In most cases it is recommended to activate this option.

Export 
Inserts

If this is activated and you are using any MIDI plug-ins as 
insert effects, the modifications to the original MIDI notes 
that occur as a result of the effect(s) will be included in 
the MIDI file. A MIDI delay, for example, will produce a 
number of repeats to a MIDI note by actually adding addi-
tional, “echoing” notes at rhythmic intervals – these notes 
will be included in the MIDI file if the option is activated.

Export  
Sends

If this is activated and you are using any MIDI plug-ins as 
send effects, the modifications to the original MIDI notes 
that occur as a result of the effect(s) will be included in 
the MIDI file.

Export Markers If this is activated, any markers you have added (see “Us-
ing markers” on page 136) will be included in the MIDI 
file as standard MIDI file marker events.

Export as  
Type 0

If this is activated, the MIDI file will be of type 0 (all data on 
a single track, but on different MIDI channels). If you do not 
activate this option, the MIDI file will be of Type 1 (data on 
separate tracks). Which type to choose depends on what 
you want to do with the MIDI file (in which application or 
sequencer it should be used, etc.).

Export  
Resolution

You can specify a MIDI resolution between 24 and 960 
for the MIDI file. The resolution is the number of pulses, or 
ticks, per quarter note (PPQ) and determines the preci-
sion with which you will be able to view and edit the MIDI 
data. The higher the resolution, the higher the precision. 
Choose the resolution depending on the application or 
sequencer with which the MIDI file will be used, though, 
since certain applications and sequencers may not be 
able to handle certain resolutions.

Export Locator 
Range

If this is activated, only the range between the locators 
will be exported. 

Export  
includes Delay

If this is activated, the delay of the MIDI track will be in-
cluded in the MIDI file. For more information about the 
Delay option, see “Basic track settings” on page 373.

Song name for 
Type 0

You can use this text field to change the name of the MIDI 
file as displayed when loading this file in a keyboard.

Option Description

Extract First 
Patch

If this is activated, the first Program Change and Bank 
Select events for each track are converted to Inspector 
settings for the track.

Extract First 
Volume/Pan

If this is activated, the first MIDI Volume and Pan events 
for each track are converted to Inspector settings for the 
track.

Import Con-
troller as Auto-
mation Tracks

If this is activated, MIDI controller events in the MIDI file 
will be converted to automation data for the MIDI tracks. If 
this is deactivated, controller data for the MIDI Parts will 
be imported.

Option Description
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• It is also possible to import a MIDI file from disk by drag-
ging and dropping it from the Windows Explorer or the 
Mac OS Finder into the Project window. The Import Op-
tions apply as well.

Support for the Yamaha XF data format
Nuendo supports the Yamaha XF format. XF is an exten-
sion of the standard MIDI file format that allows saving of 
song-specific data with a MIDI file of type 0.

When importing a MIDI file containing XF data, this data is 
placed in parts on separate tracks called “XF Data”, “Chord 
Data”, or “SysEx Data”. You can edit such a part in the List 
Editor (e. g. to add or change lyrics).

Nuendo can also export XF data as part of a MIDI file of 
type 0. If you do not want to export the XF data together 
with the MIDI data, mute or delete the track(s) containing 
the XF data.

Exporting and importing MIDI loops
Nuendo allows you to import MIDI loops (file extension 
“.midiloop”) and to save instrument parts as MIDI loops. 
MIDI loops are handy, as they contain not only MIDI notes 
and controllers, but also the associated VST instrument 
and instrument track preset settings.

How to import and export MIDI loops is described in detail 
in the chapter “VST instruments and instrument tracks” on 
page 215.

Exporting and importing track 
archives 
You can export Nuendo tracks (audio, FX, group, instru-
ment, MIDI, and video) as track archives for import into 
other Nuendo projects. All the information associated with 
the tracks will be exported (Mixer channel settings, auto-
mation tracks, parts and events, etc.). If you select the 
“Copy” option (see below), a separate “media” folder will 
be created, containing copies of all referenced audio files.

Project-specific settings (such as tempo) are not part 
of the exported track archives.

For creating track presets from tracks, see “Working 
with track presets” on page 356.

Exporting tracks as track archives
1. Select the tracks you wish to export.

2. Pull down the File menu, open the Export submenu 
and choose “Selected Tracks…”.

3. You are prompted to choose between two options:

• Click Copy to include copies of the media files in the ex-
port.
A file dialog opens in which you can choose an existing empty folder or 
create a new folder for saving the track archive (as XML file) and its me-
dia subfolder, which will contain any associated audio or video files.

Import to Left 
Locator

If this is activated, the imported MIDI file will be placed so 
that it starts at the position of the left locator – otherwise 
it will start at the beginning of the project. Note that if you 
choose to have a new project created automatically, the 
MIDI file will always start at the beginning of the project.

Import Markers If this is activated, standard MIDI file markers in the file 
will be imported and converted to Nuendo markers.

Import 
dropped File 
as single Part

If this is activated and you drag and drop a MIDI file into 
the project, the whole file will be placed on a single track.

Ignore Master 
Track Events 
on Merge

If this is activated and you import a MIDI file into the cur-
rent project, tempo and signature track data in the MIDI 
file are ignored. The imported MIDI file will play according 
to the current tempo and signature tracks in the project.
If this option is deactivated, the Tempo Track Editor will 
be adjusted according to the tempo information in the 
MIDI file.

Auto Dissolve 
Format 0

If this is activated and you import a MIDI file of type 0 into 
the project, the file will automatically be “dissolved”: For 
each embedded MIDI channel in the file, a separate track 
will be inserted in the Project window. 
If this is deactivated, only one MIDI track will be created. 
This track will be set to MIDI Channel “Any”, allowing all 
MIDI events to play back on their original channels. You 
can also use the “Dissolve Part” function on the MIDI 
menu to distribute the events onto different tracks with 
different MIDI Channels at a later stage.

Import to 
Instrument 
tracks

If this is activated and you drag a MIDI file into the project, 
an instrument track is created instead of a MIDI track. 
Furthermore, the program will load the corresponding 
track preset for the instrument track (based on the pro-
gram change events included in the MIDI file).

! Do not change the order of events within the XF data 
or the event data itself, unless you have a lot of expe-
rience with XF data.

Option Description
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• Click Reference to include merely a reference to the 
files in the export.
A file dialog opens in which you can choose an existing folder for saving 
the track archive (as single XML file).

4. Click OK to save the track archive.

Importing tracks from a track archive
The Import Track Archive function lets you import tracks 
exported from another Nuendo project.

Note that the sample rates of the active project and 
the track archive have to match. If necessary, you have to 
convert the sample rate, see below. 

1. Pull down the File menu, open the Import submenu 
and select “Track Archive…”.

2. In the file dialog that opens, select the XML file and 
click Open.
The Import Options dialog opens.

In the Project Settings area, you can see a comparison between the 
settings of the track archive and the active project.

3. Click in the Import column on the left to select the de-
sired track(s) or click “Select all Tracks”.
A checkmark is shown for all selected tracks.

4. Choose which media files to use. 

• Select “Use Media Files From Archive” if you want to 
import the track without copying the media files into your 
project folder.

• Select “Copy Media To Project Folder” if you want to 
import the media files into your project folder. 
For the “Perform Sample Rate Conversion” option, see below.

5. Click OK.
The tracks are imported, complete with all contents and settings.

Sample rate conversion on track archive import

A track archive may contain media files with a sample rate 
that is different from the sample rate of your currently ac-
tive project. You can see the sample rate difference in the 
Project Settings area.

• To convert the sample rate of a track archive to the sam-
ple rate used in the active project on import, select the 
“Copy Media To Project Folder” option and then “Perform 
Sample Rate Conversion”.

Unconverted files with another sample rate than the 
one used in the project will play back at the wrong speed 
and pitch.

Converting audio tracks (multi-
channel to mono and vice versa)

Splitting multi-channel tracks
When your project contains multi-channel tracks (e. g. ste-
reo or surround tracks), you can split these into several 
mono tracks. This is useful in the following situations:

• When you want to export the tracks of your project for 
further processing in an application that only supports 
mono tracks.

• When you want to create a project from multi-channel 
tracks that are not stereo or surround (polyphonic mono).
This format is often used for production sound, created by a field re-
corder, for example.

• When you want to edit individual channels of a multi-
channel file.
This allows you to access the individual channels from your remote con-
trol console.

The number of mono tracks that is created during this pro-
cess depends on the number of channels comprised in 
the multi-channel file. The multi-channel audio material of 
the source track is split into mono events which are in-
serted on the new tracks. In the project’s Audio folder, a 
subfolder called Split is created which contains the new 
mono files.
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To split a multi-channel track, proceed as follows:

1. If you only want to split particular multi-channel tracks, 
select them in the Project window.
If you want to split all multi-channel tracks of your project, you do not 
have to make a selection.

2. On the Project menu, open the Convert Tracks sub-
menu and select “Multi-Channel to Mono…”.
A dialog opens.

3. On the Source Tracks pop-up menu, select whether 
you want to split all or only the selected multi-channel 
tracks.

4. On the Options pop-up menu, you can specify what 
happens when the multi-channel file is split.
The following options are available:

The option below allows you to decide how the created 
files will be named.

• Activate “Use Numbers For File Names” if you want the 
tracks and files to get the name of the source track, fol-
lowed by a number.
This is useful if you are working with source files that do not contain ste-
reo or surround material, but polyphonic mono audio.

• Deactivate this if you want the file and track names to be 
followed by letters, denoting the corresponding speaker 
channels, e. g. “Audio 01_L” and “Audio 01_R”.
This is useful if you are working with true multi-channel files. Note that if 
the source track was connected to an output bus with a matching chan-
nel configuration, the new mono tracks are automatically routed to the 
corresponding channels within this output bus.

5. Click OK.
The track is split into the corresponding number of mono tracks.

You can also split several multi-channel tracks simul-
taneously.

Notes

• The number of tracks created always corresponds to 
the channel configuration of the source track, even if the 
channel configurations of the source track and the source 
file do not match. For example if a 5.1 surround file is in-
serted on a stereo track, two new tracks containing the 
first two mono files are created. (However, in the project’s 
Audio folder, you will find six mono files, one for each 
channel in the original 5.1 file.) Likewise, if the source 
track configuration is 5.1, but contains a stereo file, six 
tracks are created, but only the first two contain files.

• All channel settings of the source tracks are copied to 
the tracks created by the split operation.

Converting mono tracks into multi-channel 
tracks
Just as it is possible to split multi-channel tracks into sep-
arate mono tracks, you can convert mono tracks into multi-
channel tracks.

This is useful in the following situations: 

• When working with dual-mono tracks from other appli-
cations, e. g. Pro Tools. 
Converting these into interleaved tracks makes further editing and mixing 
more convenient.

Option Description

Keep Source 
Tracks

New mono tracks are inserted below the source tracks. 

Mute Source 
Tracks

As above, but the source tracks are muted.

Delete 
Source 
Tracks

New mono tracks are inserted and the source tracks are 
deleted.

Create New 
Project

A new project is created, containing only the resulting split 
tracks.

! When a multi-channel source track contains a mono 
file and you perform a split, this mono file is copied 
onto the first two destination tracks. However, since 
panning information is not considered during the 
split, the volume of the new mono file may not corre-
spond to that of the file on the original track.
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• If you have recorded a stem of multi-mono surround 
tracks.
Saving the recordings in one interleaved file allows you to assign this 
“stem” to one single channel in the Mixer (facilitating editing as well as 
giving you a better overview).

The selected destination format and the order of the tracks 
in the track list determines which tracks are combined.

Requirements

• The number of source tracks and the destination format 
must match, i. e. the source tracks must “fit evenly” into a 
number of multi-channel files of the selected destination 
format.
4 mono files can be converted into 2 stereo files or into one multi-chan-
nel file in LRCS format, for example. The tracks are combined according 
to their order in the track list (but they do not have to be adjacent). For 
stereo, the first two mono tracks (counted from the top) make up stereo 
track 1, the next two make up stereo track 2, and so on. 

• The tracks which are combined have to reside on the 
same level in the track list, i. e. either on the top level or 
within the same folder track.

• The mono source tracks must match in terms of channel 
settings and automation, i. e. they must hold the same edits.
The program tolerates minor discrepancies (you get a warning message 
and the settings of the topmost track of each group are used). However, 
when the channel settings differ considerably, the function cannot be ap-
plied. In this case, you should check whether you have selected the cor-
rect tracks.

• If the separate audio events have different volume enve-
lopes, these are calculated into the new clip.

This function always combines the “raw” audio into 
new files. Therefore, the source tracks must have the 
same channel settings, otherwise the result would sound 
differently. To combine mono files with different channel 
settings, use the Audio Mixdown function instead, see the 
chapter “Export Audio Mixdown” on page 473.

Performing the conversion

To convert several mono tracks into one or more multi-
channel tracks, proceed as follows:

1. If you only want to convert particular mono tracks, se-
lect them in the Project window.
If you want convert all mono tracks in your project, you do not have to se-
lect them.

2. On the Project menu, Convert Tracks submenu, select 
“Mono to Multi-Channel…”.
A dialog opens.

3. On the Source Tracks pop-up menu, specify whether 
you want to combine all mono tracks in your project or 
only the selected mono tracks.

4. On the Options pop-up menu, you can specify what 
happens when the files are combined.
The following options are available:

! You cannot convert mono tracks containing audio 
parts. Only audio events are supported.

! You cannot convert tracks containing events in 
Musical mode. Therefore, make sure that Musical 
mode is not activated for any of the events.

! You should not raise the level of the source events 
over 0 dB, or clipping will occur in the created files. 
The only exception to this are files in 32-bit-float for-
mat (however, these are not supported by all applica-
tions). 

Option Description

Keep Source 
Tracks

A new multi-channel track is inserted below the last 
source track.

Mute Source 
Tracks

As above, but the source tracks are muted.

Delete Source 
Tracks

A new multi-channel track is inserted and the source 
tracks are removed from the project.

Create New 
Project

A new project is created, containing one or more multi-
channel tracks with the new files.
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5. On the Destination Format pop-up menu, select the 
format for the multi-channel file or files.
Note that the number of selected tracks must match this format. If you 
have selected fourteen mono tracks, for example, you can select Stereo 
or one of the 7-channel surround formats. If the number of tracks and the 
destination format do not match, a warning message is displayed and the 
process is aborted.

6. Click OK.
The corresponding number of multi-channel tracks is created. Events re-
siding at the same position on the timeline are converted into a multi-
channel event on the new track. If the lengths of the source events do not 
match exactly, the overlap will be included in the new events. In the 
project’s Audio folder, a subfolder called Merge is created which con-
tains the new multi-channel files.

If the outputs of the mono tracks are routed to sepa-
rate channels within one output bus, this bus will be se-
lected as output for the multi-channel track.

Clip packages
In postproduction it is common practice to create sounds 
by combining or “layering” several different sound compo-
nents (e. g. for explosions, background atmospheres, or 
effect sounds). Usually, these sound combinations are be-
ing reused at a later stage. This might be in the same 
project (e. g. for recurring situations within one movie), or a 
different project (such as a later episode of a series or for 
a different production). When working with these sound 
combinations, the audio engineers need to be able to 
modify the separate sound components, in order to make 
adjustments due to last minute changes in the setup, for 
example.

Using clip packages in Nuendo
In Nuendo, you can create the above-mentioned “sounds” 
by arranging, editing and grouping their components (i. e. 
audio events or parts) in the Project window. These 
groups can then be selected, moved and copied as one. 

However, groups are not reflected in the Pool or the 
MediaBay. Furthermore, they are restricted to a single 
project and cannot be exported for use in other projects 
(other than as audio mixdown).

To be able to manage all components making up a special 
sound in Nuendo, you can save them in “clip packages”. 
This has the following advantages:

• Clip packages for a project can be easily saved and loaded, 
e. g. in other projects.

• Clip packages can be archived for later use.
• Clip packages are an easy way to transfer all components of a 

special sound between users or computers.

Clip packages are container files that include all the se-
lected audio material (as opposed to mere file references). 
Therefore, they can be used “as they are” without running 
the risk of using incomplete sounds due to missing files. 
However, this does not apply to sound content from VST 
Sound archives, see below.

Considerations

• Clip packages contain copies of the audio files. Any 
offline processes you applied to the audio are saved in the 
file and cannot be modified or undone later.

• Clip packages contain volume and pan automation of 
the audio, as well as any fades, crossfades and volume 
envelopes. Insert or send effects or EQ settings of the 
corresponding tracks are not included.

• Imported or exported clip packages are automatically 
added to the Pool.

• Clip packages contain only the portion of an audio clip 
that is actually used by an event. This section is extended 
by 2 seconds at the beginning and the end of the event so 
that you are still able to adjust the event borders.

! Audio clips set to musical time base (see “Switching 
between musical and linear time base” on page 63) 
are always copied in entirety into the clip package.

! If a clip package contains audio material from VST 
Sound archives, this is not copied into the clip pack-
age. In this case, a reference to the original VST 
Sound archive is saved. For these clip packages to 
work in another project or studio, the referred VST 
Sound files need to be present on the system.
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Creating (exporting) clip packages
When you have created the desired sound in the Project 
window, you can transform it into a clip package. 

Proceed as follows:

1. Select the audio that makes up the sound. You can 
either select audio events and parts or create a selection 
range. 
If you create a selection range which includes empty space before the 
audio, this is included in the file.

• If you want to include your automation data in the clip 
package, make sure to read-enable the corresponding 
track before exporting the clip package.

Only audio material will be part of the clip package. If 
any other material is selected, this will be ignored.

2. On the File menu, open the Export submenu and se-
lect “Clip Package…”. 
You can set up a key command for this in the Key Commands dialog (File 
category).

The Export Clip Package dialog opens.

3. In the upper section of the dialog, you specify the 
folder in which to save the clip package.

• To save the clip package in the default folder (the “Clip 
Packages” folder within the Project folder), click on the 
button in the top right of the dialog to open a pop-up 
menu and select “Use Project’s Clip Packages Folder”.

• To save the clip package in another folder than the de-
fault folder, click on the button in the top right of the dialog 
to open a pop-up menu and select “Choose Folder…”.
At the bottom of the menu, the last 5 locations are available. 

4. In the Attributes Inspector section, you can specify 
certain attribute values for your clip package.
To open the Attributes Inspector, click the button at the bottom left of the 
dialog.

• Click on an attribute value field to open a pop-up menu 
with the available values or double-click to enter an at-
tribute value as text.
For detailed information on working with attributes, see “The Attribute In-
spector” on page 347.

5. In the Name field at the bottom of the dialog, enter the 
name for your sound.

6. Click OK to save the clip package and close the dialog.

Previewing clip packages

Clip packages can be previewed in the MediaBay and in 
the Pool. For this purpose, a mixdown file is created to-
gether with the clip package. For the preview file, all events 
and tracks that are not part of the clip package are muted 
and all insert effects and EQs are bypassed. Please note 
that only the Main Mix output bus is used for the mixdown. 
The mixdown will be in the format set for the Main Mix bus.

In some cases what you hear during preview differs from 
what you hear when you load the actual clip package. This 
happens in the following situations:

• If you have included audio events or parts in the clip 
package that are located on tracks for which the effects 
have been “frozen” (see “Freezing (rendering) insert effects 
for a track” on page 202). These effects will be heard in the 
preview although they are not part of the clip package.

• If you have included tracks that are set to a different out-
put than the Main Mix bus, these will not be heard in the 
mixdown although they are part of the clip package. 

• If automation data for the Bypass Effect parameter has 
been recorded for tracks, this effect will be heard in the 
preview, although it is not part of the actual clip package.
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Importing
Clip packages can be imported as follows:

• You can drag and drop clip packages from the Windows 
Explorer or Mac OS Finder, from the MediaBay or from the 
Pool into the Project window.

• You can double-click on a clip package in the MediaBay 
to insert it at the Project cursor.

• You can use the MediaBay context menu and select 
where to insert the clip package in the active project: at a 
specific timecode position, at the cursor, the left locator or 
at origin (the same position as in the original project).
There is one thing to note: When importing a clip package that contains 
events from tracks set to musical timebase, the musical positions (bars 
and beats) of the events and not the timecode positions are taken into 
account. This might not always be what you want (e. g. when working on 
projects with a different tempo).

• You can open the Import submenu of the File menu, and 
select “Clip Package…”.
In the dialog that opens, select the clip package you want to import.

• You can select the clip package in the Pool, and select 
one of the “Insert into Project” options from the Media 
menu (or the Pool context menu) to insert the package at 
the corresponding position.

• You can also use the regular Copy and Paste commands 
to copy a clip package from the Windows Explorer/Mac 
OS Finder, the MediaBay, or the Pool into the Project win-
dow.

• You can add clip packages to the Pool (without insert-
ing them into the project) using the regular import func-
tion, see “About the Import Medium dialog” on page 329.

What happens on import?

When you import a clip package, the following happens:

• The corresponding audio parts and events are copied 
to the project folder.

• In the Project window, events are inserted that corre-
spond to the original events. These events will be grouped.

• The first event is inserted on the selected track. If no 
track is selected, new tracks are added below the existing 
tracks and the events are inserted on these.
The order of the tracks is the same as in the original project.

• If the sample rate of the audio files within the clip pack-
age does not correspond to the sample rate of the project 
into which it is inserted, the files are automatically converted 
to the project sample rate.

• If automation data for volume and pan was saved in the 
clip package, a corresponding automation curve is cre-
ated together with the event.
On import, you will be asked if you want to insert the automation, allowing 
you to decide whether you want to replace any existing automation data.

• Automation data for the SurroundPanner is only applied 
correctly on import when a target track with the correct 
surround format is selected.

Clip packages in the MediaBay
Clip packages can be managed like other media types in 
the MediaBay, see the chapter “The MediaBay” on page 
334.

• You can filter the MediaBay Results list to show only 
clip packages.
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Clip packages in the Pool
In the Pool, clip packages are available in a separate 
folder (see the chapter “The Pool” on page 320).

• The Pool functions “Prepare Archive”, “Export Pool”, 
“Import Pool”, and “New Library” will include any clip 
packages you created or imported.

• The Info column displays the length of the clip package 
and the text you entered for the “Content Summary” at-
tribute (if any).

Contrary to other file types, clip packages do not have 
a direct counterpart in the Project window. When you in-
sert them into a project from within the Pool, the clip pack-
ages are separated into the audio events and parts they 
contain. Therefore, it is impossible to show the selected 
clip package in the Project window: simply because it 
does no longer exist as such.
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Background
The user can customize the appearance and functionality 
of Nuendo in various ways.

User configurable items described in this chapter are:

• Workspaces
By storing different window combinations as workspaces, you can 
quickly switch between different working modes – see “Workspaces” on 
page 571.

• Setup dialogs
Several parts of the user interface (toolbars, Transport panel, Inspector, 
info lines and Channel Settings windows) provide a Setup dialog, where 
you can configure which items of the respective window area or panel 
are to be shown or hidden and where they are located – see “Using the 
Setup options” on page 572.

• Track list
The controls shown in the track list can be set for each track type – see 
“Customizing track controls” on page 573.

• Configuration of main menu items
You can hide items not needed on the main menus – see “Configuring 
the main menu items” on page 575.

• Appearance
The general look of the program can be adjusted – see “Appearance” on 
page 576.

• Track and event colors
You can adjust which colors are used – see “Applying colors in the Project 
window” on page 577.

This chapter also contains a section describing where 
your preferences and settings are stored (see “Where are 
the settings stored?” on page 579), to help you transfer 
your customized settings to another computer.

Workspaces
A configuration of Nuendo windows is called a “work-
space”. A workspace stores the size, position and content 
of all windows, allowing you to quickly switch between dif-
ferent working modes via the menu or by using key com-
mands. For example, you may want as large a Project 
window as possible when you are editing, whereas you 
may want the Mixer and effect windows open during mix-
down. Workspaces are listed and managed on the Work-
spaces submenu of the Window menu.

Editing the active workspace
There is always one workspace active, even if you have 
not saved any. To make changes to the active workspace, 
you simply set up the windows as desired – including 
opening, closing, moving and sizing windows, and adjust-
ing zoom and track height. The changes are automatically 
stored for the active workspace.

• To keep a workspace from being accidentally changed, 
select “Lock Active Workspace” from the Workspaces 
submenu.
A locked workspace will keep its original window settings. You may 
change the current window layout on the screen, but the next time you 
select the workspace again, the originally stored layout is recalled.

Creating a new workspace
1. Pull down the Window menu and open the Work-
spaces submenu.

2. Select “New Workspace”.

3. In the dialog that opens, enter a name for the work-
space.

4. Click OK.
The workspace is stored and will appear on the submenu. It is now the 
active workspace.
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5. Set up the windows you want to include in the new 
workspace.
This may include opening, moving and sizing windows, and adjusting 
zoom and track height.

Activating a workspace
1. Pull down the Window menu and open the Work-
spaces submenu.

2. Select a workspace from the list on the submenu.
The windows are closed, opened, moved and/or resized according to the 
stored workspace.

• You can also activate workspaces by using the corre-
sponding key commands (see “Key commands” on page 
580). 

Organizing workspaces and presets
If you select “Organize…” from the Workspaces submenu, 
the Organize Workspaces dialog opens.

The list to the left shows the workspaces in the active 
project, while the list to the right shows the workspace pre-
sets. While workspaces are stored with each project, work-
space presets can be stored globally, allowing you to set 
up a number of workspaces for use in any project. Work-
space presets store the position and size of the main win-
dows only – project-specific windows are not included.

• In the Workspaces list to the left, you can rename work-
spaces (by double-clicking and typing) and lock or unlock 
them.

• The arrow buttons between the two lists allow you to 
copy the selected workspace to a workspace preset, or 
vice versa.

• The buttons below each list let you add, remove, or ac-
tivate workspaces or presets.
You can also activate a workspace or a preset by double-clicking in its 
number column.

• Normally, when you use key commands to activate 
workspaces, they relate to the order in the workspace list, 
e. g. the key command for “Workspace 1” selects the first 
workspace on the list and so on. However, if you activate 
the Use IDs checkbox, you can enter a number (1–9) in 
the ID column for each workspace. 
This number will be used as reference when you are using key com-
mands, so that the key command for “Workspace 1” recalls the work-
space with ID 1.

• Workspace presets are not only saved globally, but also 
included in the project. If you open a project on a different 
system, by default the global presets stored on this sys-
tem are shown in the list to the right. To see the presets 
included in your project, activate the “Show Project Pre-
sets” option.

• Activate the “Auto Instantiate Presets” option to convert 
all global workspace presets automatically into workspaces 
when you create a new project or open a project.

• To close the dialog, click the OK button.
Note that you can continue working in other windows with the Organize 
Workspaces dialog open.

Using the Setup options
You can customize the appearance of the following ele-
ments:

• Transport panel
• Info line
• Channel Settings window
• Toolbars 
• Inspector

The setup context menus
If you right-click the Transport panel, the toolbars, the info 
lines, or the Inspector, the respective setup context menu 
opens. For Channel Settings windows, these options are 
found in the dialog’s context menu, on the Customize 
View submenu. Here, you can activate/deactivate ele-
ments as desired.

The following general options are available on the setup 
context menus:

• “Show All” makes all items visible.

• “Default” resets the interface to the default setting.
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• “Setup…” opens the Setup dialog (see below).

If presets are available, they can be selected on the lower 
half of the menu.

The info line setup context menu

The Setup dialogs
If you select “Setup…” from the setup context menus, the 
Setup dialog opens. This allows you to specify which ele-
ments are visible/hidden and to set the order of the ele-
ments. You can also save and recall setup presets in this 
dialog.

The dialog is divided into two sections. The left section 
displays the currently visible items and the right section 
displays the currently hidden items.

• You can change the current show/hide status by select-
ing items in one section and then use the arrow buttons in 
the middle of the dialog to move them to the other section.
Changes are applied directly.

• By selecting items in the “Visible Items” list and using 
the Move Up and Move Down buttons, you can reorder 
the items list.
Changes are applied directly. To undo all changes and revert to the stan-
dard layout, select “Default” on the setup context menu.

• If you click the Save button (disk icon) in the Presets 
section, a dialog opens, allowing you to name the current 
configuration and save it as a preset.

• To remove a preset, select it on the presets pop-up 
menu and click the trash icon.

• Saved configurations are available for selection from the 
Presets pop-up menu in the Setup dialog or directly from 
the setup context menu.

Customizing track controls
For each track type you can configure which track con-
trols are shown in the track list. You can also specify the 
order of controls and group controls so that they are al-
ways shown adjacent to each other. This is done using the 
Track Controls Settings dialog.

Opening the Track Controls Settings dialog
There are two ways to open the dialog:

• Right-click a track in the track list and select “Track 
Controls Settings…” from the context menu.
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• Click the arrow in the bottom right corner of the track 
list and select “Track Controls Settings…”.

Setting the track type
The settings made in the Track Controls Settings dialog 
apply to the selected track type, which is shown in the 
menu display in the top left corner of the dialog.

• To change the track type, click the arrow to the right in 
the menu display and select a track type from the pop-up 
menu.
All settings made in the dialog will apply to all tracks (current and subse-
quent) of the selected type.

The Track Type pop-up menu in the Track Controls Settings dialog

Always make sure that you have selected the desired 
track type when editing the track controls!

Removing, adding, and moving track controls
The dialog is divided into two sections. The left section 
displays controls currently visible in the track list, and the 
right section displays the controls currently hidden.

• You can hide controls from the track list by selecting 
them in the list to the left and clicking the Remove button. 
To show hidden elements, select them in the list to the 
right and click the Add button.
Click OK to apply the changes.

All controls can be removed except the Mute and Solo 
buttons.

• By selecting controls in the “Visible Controls” list and 
using the Move Up and Move Down buttons, you can 
change the order of the list.
Click OK to apply the changes.

Grouping track controls
If you resize the track list, the position of the controls will 
change dynamically to accommodate as many controls as 
possible in the available space (given that Wrap Controls is 
activated – see below). By grouping several track controls 
you ensure that they are always positioned side by side in 
the track list. 

To group controls, proceed as follows:

1. Make sure that you have selected the correct track type.

2. In the “Visible Controls” section, select at least two 
controls.
You can only group controls that are adjacent to each other in the list. To 
group controls that are currently not adjacent in the list, use the Move 
Up/Down buttons first.

3. Click Group.
A number is displayed in the Group column for the grouped controls. The 
first group created has the number 1, the second 2, and so on.

4. Click OK.
The controls are now grouped.

• You can ungroup controls by using the Ungroup button. 
Please note that this will remove the selected element and 
the elements below it in the list from this group. To remove 
an entire group, select the first (topmost) element belong-
ing to this group and click the Ungroup button.
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About Wrap Controls
This is activated by default. Wrap Controls allows the 
controls to be dynamically repositioned when resizing the 
track list. That is, as many controls as possible will be dis-
played depending on the current size of the track list.

If you deactivate Wrap Controls, the positions of the con-
trols are fixed, regardless of the size of the track list. In this 
mode, you may have to resize the tracks vertically (by drag-
ging the dividers between them) to display all the controls.

About the Length column
The Length column in the Visible Controls list allows you 
to set the maximum length for certain text fields, e. g. 
Name. To change the setting, click on the number in the 
Length column and type in a new value.

Resetting track list settings
You have two possibilities to reset the settings:

• Click Reset to restore all default track controls settings 
for the selected track type.

• Click Reset All to restore all default track controls set-
tings for all track types.

Saving presets
You can save track controls settings as presets for later 
recall:

1. Click on the Save button (the “+” sign) to the right of 
the Presets pop-up menu.
A dialog opens, asking you to type in a name for the preset.

2. Click OK to save the settings as a preset.
Saved presets are available for selection from the Presets pop-up menu 
and from the pop-up menu in the top left corner of the track list.

• To remove a preset, select it in the Track Controls Set-
tings dialog and click the Delete button (the “-” sign).

Nuendo comes with a number of Track Controls Set-
tings presets available.

Configuring the main menu items

You can configure what items are shown on the main 
menus and submenus, and even hide entire menus. By 
customizing the menus you can hide items relating to pro-
gram functions you never use, to customize the program 
according to your needs. For example, if you never use the 
Networking features in Nuendo, you can hide the entire 
Network menu from view.

1. Open the Preferences dialog and select the Configu-
ration page.
The Configuration page contains two parent folders; “Main Menu”, which 
contains folders for all main menus, and “Command Categories” which 
contains folders for all Command categories. This section will only de-
scribe how to configure Main Menu items, not Command Categories, 
see “Turning key commands off” on page 582.

2. Click on the “+” sign for a folder item, e. g. the File 
folder.
As you can see, all commands and submenus on the File menu are listed 
in the Name column.

! Configuring the main menus is a feature intended for 
experienced Nuendo users. Do not hide menus or 
menu items unless you are sure that you do not need 
them!
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• In the Menu column you can decide which File menu 
items to hide from view, by clicking in the column beside 
the corresponding menu item you wish to hide.
If you click the “On” item in the Menu column for an item, it changes to 
“Off” and vice versa. All menu items set to “Off” will be hidden when you 
click Apply or OK.

• Certain essential menu items on the File and Edit menus 
cannot be hidden, such as Save, Open, Close, Undo/Redo, 
etc.
For these items there is no entry in the Menu column.

• If you set a main menu folder (as opposed to a menu 
item) to Off in the Menu column, the entire menu will be 
hidden from view.
The exception to this is if the main menu folder contains non-removable 
menu items, in which case all hideable items on the menu will be set to 
Off, but the menu will still be visible.

• The Command column sets the key command On/Off 
status for the corresponding menu item.
If this is set to Off, any assigned key command for the item will be disabled 
(see “Turning key commands off” on page 582 for more information).

• You can save menu configurations as preference pre-
sets, either separately or together with other Preferences 
dialog settings.

• By using the above methods, you can customize all 
main menus to your liking.
To apply the changes without exiting the dialog click “Apply”. Click OK to 
apply the changes and exit the dialog.

• To restore all menu items to their default setting (which 
is visibility and key commands on for all menus and menu 
items), click the Defaults button.
Note that the Defaults button only restores the settings on the currently 
selected page (the Configuration page in this case) to their default set-
tings. If you have changed settings on another page of the Preferences 
dialog, these are not reset.

Appearance
In the Preferences dialog, you find a page called Appear-
ance. It contains the following subpages:

General 

The controls on the General page affect the appearance of 
the windows that surround the controls and workspaces in 
Nuendo. 

• Color Intensity determines how rich the background 
colors are, from gray to blue. 

• Color Lightness lightens or darkens the background.

• The Color Tone slider changes the background color.

• Button Brightness can be used to separately lighten or 
darken the buttons.

Meters

The coloring of meters in Nuendo can be controlled in so-
phisticated ways. Multiple colors can help to visually indi-
cate what levels are being reached, e. g. in a channel of 
the VST Mixer. To do this, the meter on the Appearances–
Meters page has color handles that allow you to define 
what color the meter will have at a given signal level.

The Appearances–Meters page in the Preferences dialog
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• The default setting has two color handles. Each color 
handle has a unique color that gradually shifts as the 
meter moves toward the next color handle.
You can click on any color handle and move its position on the meter 
scale. If you hold down [Shift] while moving the handle with the mouse, it 
will move ten times slower for more precise positioning. You may also 
nudge the color handle’s position with the Arrow Up/Down keys. Holding 
[Shift] while nudging will move the color handle ten times faster.

• You can add color handles by [Alt]/[Option]-clicking 
anywhere along the side of the meter scale. To remove a 
color handle, [Ctrl]/[Command]-click the handle.
By adding more color handles to the meter scale, you can define colors 
for more specific signal levels. Try adding two color handles very close to 
one another. You can make the meter color change more rapidly at a 
specific signal level this way.

• To change the color of a handle, select the handle by ei-
ther clicking on it or by jumping to it with the [Tab] key 
(hold down [Shift] and press the [Tab] key to jump back-
wards). Then use the hue and brightness controls on the 
right side to alter the handle’s color.
The currently selected color handle is indicated by a black triangle on its 
left side.

Work Area 

The work areas in Nuendo are those places where the ac-
tual data are displayed such as the Project window event 
display. In these areas, there are items such as vertical 
and horizontal grid lines that can be altered in intensity by 
the controls found on this page.

Applying colors in the Project 
window
You can use color scheming for an easier overview of 
tracks and events in the Project window. Colors can be 
applied individually to tracks and events/parts. If you color 
a track, the corresponding events and parts are displayed 
in the same color. However, you can also color events and 
parts differently, “overriding” the applied track color.

In the following sections you will learn how to set up pref-
erences to color tracks automatically, how to color parts 
or events manually, how to determine whether you want to 
color the events themselves or their background, and how 
to customize the color palette for selecting colors.

Applying track colors automatically
In the Preferences dialog (Editing–Project & Mixer page), 
you can find the “Auto Track Color Mode” option.

This offers you several options for automatically assigning 
colors to tracks that are added to the project.

Coloring tracks, parts, or events manually
You can color each track, part, or event in the Project win-
dow individually by using the Select Colors pop-up menu 
on the toolbar. Parts and events can also be colored using 
the Color tool.

About the Select Colors pop-up menu

1. In the Project window, select the item you want to color.
You can select tracks, parts, or events.

2. On the toolbar, open the Select Colors pop-up menu 
and select a color.
The selected color is applied to all selected items. However, note that 
the selected tracks are ignored when you use the Select Colors pop-up 
menu to color the selected parts or events.

Option Effect

Use Default 
Event Color

The default color (gray) is assigned. 

Use Previous 
Track Color

Analyzes the color of the selected track and uses the 
same color for the new track.

Use Previous 
Track Color 
+1

Analyzes the color of the selected track and uses the color 
that comes next in the color palette for the new track.

Use Last 
Applied Color

Uses the color that is selected in the Select Colors pop-
up menu.

Use Random 
Track Color

Uses the color palette as a basis to assign track colors 
randomly.
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About the Color tool

1. Open the Select Colors pop-up menu and select a 
color. 

2. On the toolbar, select the Color tool.

3. Click on the desired parts and events to assign the 
color. 
The color is applied to the parts and events and overrides the default 
track color (if used).

• If you press [Ctrl]/[Command] and click on a part/event 
with the Color tool, a color palette is displayed allowing 
you to select a color for the event.

• If you press [Alt]/[Option], the Color tool cursor be-
comes a pipette, which can be used to select the current 
color of a part/event in order to apply it to another part/
event.

About the Similar Tracks options

You can use the selected color of one track to colorize 
other tracks of the same type (e. g. all audio tracks). 

Set up the desired color for a track of a certain track type 
and right-click this track in the track list to open a context 
menu. Depending on your settings and selections you can 
choose one of the following options:

• Use Color for Similar Tracks
When you select this, all tracks of the same type get the same color. 

• Use Color for Similar Selected Tracks
Use this to apply the same color to tracks within a selection. The color of 
the topmost track in the selection is then applied to other tracks of the 
same type within the selection.

Customizing the event background
On the Event Display page in the Preferences dialog, you 
find the “Colorize Event Background” option.

This option affects the display of events in the Project 
window.

• When this is activated, the events and parts in the event 
display will have the selected background color.

• When this is deactivated, the event “content” (e. g. MIDI 
events or audio waveforms) is displayed in the selected 
color and the event background is gray. 

The Project Colors dialog
In the Project Colors dialog you can select a different set of 
colors for items in the Project window. 

To open the Project Colors dialog, open the Select Colors 
pop-up menu on the toolbar and choose “Select Colors…”.

Adding and editing individual colors

In the Project Colors dialog, you can fully customize the 
color palette. To add new colors to the color palette, pro-
ceed as follows:

1. Add a new color by clicking the Insert New Color 
button.

2. In the Project Colors section, click the newly created 
color field to activate the new color for editing.

Remove Selected 
Color

Insert New 
Color
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3. Use the Standard Colors or Modify Color sections to 
specify a new color. 
To do this, pick a different color from the color palette, drag the cursor in 
the color circle, move the handle in the color meter, or enter new RGB 
values as well as values for hue, saturation, and luminosity manually.

4. Click the Apply button. 
The color setting is applied to the selected color field in the Project Colors 
section. 

Every color in the Project Colors section can be edited 
this way.

Setting intensity and brightness

To increase or decrease the intensity and the brightness 
of all colors, use the corresponding buttons in the Project 
Colors section.

Saving and resetting color settings 

• To return to your project colors, click the “Reset To Cur-
rent Project Defaults” button.

• To save the current set as default, click the “Save Cur-
rent Set as Program Defaults” button.

• To apply the default set, click the “Load Program De-
faults to Current Set” button.

• To return to Nuendo’s standard color palette, click the 
“Reset Current Set to Factory Settings” button.

Where are the settings stored?
As you have seen, there are a large number of ways in 
which you can customize Nuendo. While some of the set-
tings you make are stored with each project, others are 
stored in separate preference files.

If you need to transfer your projects to another computer 
(e. g. in another studio), you can bring all your settings 
along by copying the desired preference files and install-
ing them on the other computer.

It is a good idea to make a backup copy of your prefer-
ence files once you have set things up the way you want! 
This way, if another Nuendo user wants to use his or her 
personal settings when working on your computer, you 
can restore your own preferences afterwards.

• Under Windows XP, preference files are stored in the 
folder “\Documents and Settings\<user name>\Applica-
tion Data\Steinberg\Nuendo 5\”.
If you run the 64 bit version of Nuendo, this folder is called “Nuendo 64 bit”. 
On the Start menu, you will find a shortcut to this folder for easy access.

• Under Windows Vista and Windows 7, preference files 
are stored in the following location: “\Users\<user 
name\AppData\Roaming\Steinberg\Nuendo 5\”.
On the Start menu, you will find a shortcut to this folder for easy access.

• Under Mac OS X, preference files are stored in the fol-
lowing location: “/Library/Preferences/Nuendo 5/” under 
your home directory.
The full path is: “/Users/<user name>/Library/Preferences/Nuendo 5/”.

The RAMpresets.xml file, which contains various 
presets settings (see below), is saved when exiting the 
program. 

Program functions (e. g. crossfade) or configurations 
(e. g. panels) not used in the project will not be stored.

Some of the preferences are not stored in the default pref-
erences folder. A list can be found in the article “Files for 
the program settings and preferences” in the Steinberg 
Knowledge Base.

To open the Knowledge Base, browse to the Steinberg 
web site, click “Support” and choose “Knowledge Base” 
in the list on the left.

Increase/decrease intensity for all colors

Increase/decrease brightness for all colors

Reset Current Set to 
Factory Settings

Save Current Set as Program 
Defaults

Load Program Defaults to Current Set
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Introduction
Most of the main menus in Nuendo have key command 
shortcuts for certain items on the menus. In addition, there 
are numerous other Nuendo functions that can be per-
formed via key commands. These are all default settings.

You can customize existing key commands to your liking, 
and also add commands for many menu items and func-
tions that currently have no key command assigned. 

You can find out for which functions key commands can 
be assigned by looking in the Key commands dialog (see 
below), or by checking the tooltip for a particular interface 
element. If a tooltip shows [!] at the end, you can assign a 
key command to this function. Assigned key commands 
are shown in the tooltips in square brackets.

How are key commands settings saved?

Every time you edit or add any key command assignment, 
this is stored as a global Nuendo preference – not as part 
of a project. If you edit or add a key command assignment, 
any subsequent projects that you create or open will use 
these modified settings. However, the default settings can 
be restored at any time by clicking the Reset All button in 
the Key Commands dialog.

In addition, you can save complete or partial key commands 
settings as a “key commands file”, which is stored sepa-
rately and can be imported into any project. This way you 
can quickly and easily recall customized settings, when 
moving projects between different computers, for example. 
The settings are saved in an XML file on the hard disk.

How to save key commands settings is described in the 
section “Saving complete key commands settings as pre-
sets” on page 584.

Setting up key commands

Adding or modifying a key command
In the Key Commands dialog you will find all main menu 
items and a large number of other functions, arranged in a 
hierarchical way similar to the Windows Explorer and Mac 
OS Finder. The function categories are represented by a 
number of folders, each containing various menu items 
and functions. When you open a category folder by click-
ing the “+” sign beside it, the items and functions it con-
tains are displayed with the currently assigned key 
commands.

To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Com-
mands…”.
The Key Commands dialog opens.

2. In the Commands list on the left, choose a category.

3. Click the “+” sign to open the category folder and dis-
play the items it contains.
Note that you can also click the “global” “+” and “-” signs in the top left 
corner to open and close all category folders at once.

! You can also assign tool modifier keys, i. e. keys that 
change the behavior of various tools when pressed. 
This is done in the Preferences dialog – see “Setting 
up tool modifier keys” on page 586.
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4. In the list, select the item to which you want to assign 
a key command.
Already assigned key commands are shown in the Keys column as well 
as in the Keys section in the top right corner.

5. Alternatively, you can use the search function in the 
dialog to find the desired item.
For a description of how to use the search function, see below.

6. When you have found and selected the desired item, 
click in the “Type in Key” field and enter a new key com-
mand.
You can choose any single key or a combination of one or several modi-
fier keys ([Alt]/[Option], [Ctrl]/[Command], [Shift]) plus any key. Just 
press the keys you want to use.

7. If the key command you enter is already assigned to 
another item or function, this is displayed below the “Type 
in Key” field. 
You can either ignore this and proceed to assign the key command to 
the new function instead, or you can select another key command.

8. Click the Assign button above the field.
The new key command appears in the Keys List.

9. Click OK to exit the dialog.

You can set up several different key commands for the 
same function. Adding a key command to a function that 
already has another key command will not replace the key 
command previously defined for the function. If you wish 
to remove a key command, see below.

Turning key commands off

Nuendo also gives you the option of turning key com-
mands off, meaning that even if a function has a key com-
mand assigned to it, you can disable the key command.

To turn off a key command, proceed as follows:

1. Open the Preferences dialog from the File menu (un-
der Mac OS X it is located on the Nuendo menu) and se-
lect the Configuration page.
As you can see, the Configuration page contains two main folders; “Main 
Menu” and “Command Categories”.

• The “Main Menu” folder contains a number of subfolders, which 
each contain items found on the main menus in Nuendo.

• The “Command Categories” folder also contains a number of 
subfolders, each of which contains a number of program func-
tions not available on any of the main menus.

All the items and functions in the subfolders can have key 
commands assigned to them. The column to the right, la-
beled “Command”, allows you to set the On/Off status for 
the corresponding items. This indicates whether it is pos-
sible to use assigned key commands for the items or not.

2. Click on the “+” sign beside one of the main folders to 
open it and list the subfolders it contains.

3. Open the desired subfolder by clicking its “+” sign, 
navigate to the item for which you want to disable the as-
signed key command, and select it.

! If the key command you enter is already assigned to 
another function, you will get a warning message 
asking if you really want to reassign the command to 
the new function.

Key commands are displayed here.
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4. Click in the “Command” column beside the item to set 
the status to “Off”.
Now it will not be possible to use any key command assigned to that 
menu item or function.

5. Repeat this for all items or functions for which you 
want to disable key commands.

Note that if you set an entire subfolder to “Off” in this 
way, all the items or functions it contains will automatically 
be set to “Off” as well. If this is not what you want, you can 
reset separate items in the subfolder to “On”.

6. When you’re done, click OK to close the Preferences 
dialog and apply the changes.

Searching for key commands
If you want to know which key command is assigned to a 
certain function in the program, you can use the Search 
function in the Key Commands dialog:

1. Click in the search text field at the top left of the dialog 
and type in the function for which you want to know the 
key command.
This is a standard word search function, so you should type the command 
as it is spelled in the program. Partial words can be used; to search for all 
quantize related commands, type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon).
The search is conducted and the first matching command is selected 
and displayed in the Commands list below. The Keys column and the 
Keys list show the assigned key commands, if any.

3. To search for more commands containing the word(s) 
you entered, click the Search button again.

4. When you are done, click OK to close the dialog.

Removing a key command
To remove a key command, proceed as follows:

1. Use the list of categories and commands to select the 
item or function for which you wish to remove a key com-
mand.
The key command is shown in the Keys column and the Keys list.

2. Select the key command in the Keys list and click the 
Delete button (the trash icon).
You are asked whether you really want to remove the key command.

3. Click Remove to remove the selected key command.

4. Click OK to close the dialog.

Setting up macros
A macro is a combination of several functions or com-
mands to be performed in one go. For example, you can 
select all events on the selected audio track, remove DC 
offset, normalize the events and duplicate them, all with a 
single command.

Macros are set up in the Key Commands dialog as follows:

1. Click the Show Macros button.
The macro settings are shown in the lower part of the dialog. To hide 
these from view, click the button (now renamed Hide Macros) again.

2. Click New Macro.
A new, unnamed macro appears in the Macros list. Name it by typing the 
desired name. You can rename a macro at any time by selecting it in the 
list and typing in a new name.

3. Make sure that the macro is selected, and use the cat-
egories and commands in the upper half of the dialog to 
select the first command you want to include in the macro.

4. Click Add Command.
The selected command appears in the list of commands in the Macros 
section.

5. Repeat the procedure to add more commands to the 
macro.
Note that commands are added after the currently selected command in 
the list. This allows you to insert commands “in the middle” of an existing 
macro.

A macro with three commands

• To remove a command from the macro, select it in the 
Macros list and click Delete.

• Similarly, to remove an entire macro, select it in the 
Macros list and click Delete.
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After you have closed the Key Commands dialog, all mac-
ros you have created appear at the bottom of the Edit menu 
in the Macros submenu, available for instant selection.

You can also assign key commands to macros. All macros 
you have created appear in the upper section of the Key 
Commands dialog under the Macros category – just se-
lect a macro and assign a key command as with any other 
function.

Saving complete key commands settings as 
presets
As mentioned above, any changes made to the key com-
mands (and macros) are automatically stored as a Nuendo 
preference. However, it is also possible to store key com-
mands settings separately. This way, you can store any 
number of different key command settings, complete or 
partial, as presets for instant recall.

Proceed as follows:

1. Set up the key commands and macros to your liking.
When setting up key commands, remember to click “Assign” to make the 
changes.

2. Make sure that “Store Selected Items Only” is not ac-
tivated.
This option is for saving partial key commands settings only (see below).

3. Click the Save button next to the Presets pop-up 
menu.
A dialog opens, allowing you to type in a name for the preset. 

4. Click OK to save the preset.
Your saved key commands settings are now available on the Presets 
pop-up menu.

Saving partial key commands settings
It is also possible to save partial key commands settings. 
This is useful for example if you have made settings that 
only relate to a specific project or settings that you wish to 
apply only in certain situations. When you apply a saved 
partial preset you only change the specific saved settings, 
while all other key commands settings will be left un-
changed.

When you have set up the key commands and macros, 
proceed as follows to save the partial settings as a preset:

1. Activate the “Store Selected Items Only” option.
When this is activated, a new “Store” column appears in the Commands 
list.

2. Click in the Store column for the key commands items 
you wish to save.
Note that if you check an entire category folder (as opposed to separate 
commands) all commands it contains will automatically also be selected. 
If this is not what you want, deselect the commands you do not want to 
include.

3. Click the Save button (the disk icon) next to the Pre-
sets pop-up menu.
A dialog opens, allowing you to type in a name for the Preset.

4. Click OK to save.
Your saved key commands settings will now be available from the Preset 
pop-up menu for your future projects.
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Loading saved key command settings
To load a key command preset, simply select it from the 
Presets pop-up menu.

The key command settings you load will replace the 
current key command settings for the same functions (if 
any). If you have macros of the same name as those stored 
in the preset you load, these will be replaced too. 
If you want to be able to revert to your current settings 
again, make sure to save them first, as described above!

Loading earlier key commands settings 

If you have saved key commands settings with an earlier 
program version, it is possible to use them in Nuendo 5, 
by using the “Import Key Command File” function, which 
lets you load and apply saved key commands or macros:

1. Open the Key Commands dialog.

2. Click the “Import Key Command File” button to the 
right of the Presets pop-up menu.
A standard file dialog opens.

3. In the file dialog, use the “Files of type” pop-up menu 
to specify if you want to import a key commands file 
(“.key”) or a macro commands file (extension “.mac”).
When you have imported an older file, you might want to save it as a pre-
set (see above) to be able to access it from the Presets pop-up menu in 
the future.

4. Navigate to the file you want to import and click “Open”.
The file is imported.

5. Click OK to exit the Key Commands dialog and apply 
the imported settings.
The settings in the loaded key commands or macros file now replace the 
current settings.

About the “Reset” and “Reset All” functions

These two buttons in the Key Commands dialog will both 
restore the default settings. The following rules apply:

• “Reset” will restore the default key command setting for 
the function selected in the Commands list.

• “Reset All” will restore the default key commands for all 
commands.

Using Alternative Key Sets
As an alternative to saving and loading key commands 
settings as previously described, you can set up and save 
“alternative key sets”. This allows you to switch between 
different key commands settings “on the fly” while you are 
working in the program, instead of having to go into the 
Key Commands dialog to change them.

About the preset Alternative Key Sets

By default, Nuendo contains two different key sets:

• “Markers” is actually not an alternative key set, but rather the 
default key set that you can switch back to at any time (see 
below).

• “Shuttle” is a specialized, alternative key set containing key 
commands settings for all of the Transport panel’s Shuttle 
controls.

You can edit and save these under the same names to re-
place them with your own settings if you wish, but it is ad-
vised that you instead create additional key sets for your 
specific needs.

! Note that the “Reset All” operation will cause any 
changes made to the default key commands to be 
lost! If you want to be able to revert to these settings 
again, make sure to save them first!
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Saving an Alternative Key Set

Here’s how to create and save an Alternative Key Set:

1. Open the Key Commands dialog from the File menu.

2. Set up the key commands and macros the way you 
want them.

3. Decide whether you want to save complete or partial 
settings by activating/deactivating “Store Selected Items 
Only”.

4. Click the Store Alternative Set button (the disk icon) in 
the Alternative Key Sets section.
A dialog opens, allowing you to type in a name for the Preset. 

5. Type in a name for the key set and click OK to save it.
The saved key set appears in the list of alternative key sets.

Editing an Alternative Key Set

To edit a saved key set, proceed as follows:

1. Select the key set in the list and click the “Open” but-
ton (the folder icon) in the Alternative Key Sets section.
The key set is now activated, and the key commands settings are changed 
accordingly.

2. Make the desired changes.

3. Click the Store Alternative Set button (the disk icon) in 
the Alternative Key Sets section.
The key set is saved with the updated settings.

Removing a saved Alternative Key Set

• To remove a saved key set, select it in the list and click 
the “Remove” button (the trash icon) in the Alternative Key 
Sets section.
A dialog opens asking if you want to remove the key set or cancel the op-
eration.

Switching between Alternative Key Sets

You switch between different key sets in the program by 
using the key command assigned to the function “Toggle 
Alternate Key Commands”, located in the File subfolder in 
the Key Commands dialog.

The default key command for this function is [Ctrl]/[Com-
mand]-[F5], but you can of course change this to any key 
command that suits you best. See “Adding or modifying a 
key command” on page 581 for instructions on how to 
change key commands.

• When you press the key command for the function, the 
name of the loaded key set is briefly shown on top of the 
Project window.

• Each time you press the key command, you switch to 
the next available alternative key set.

Setting up tool modifier keys
A tool modifier key is a key you can press to get an alter-
nate function when using a tool. For example, clicking and 
dragging an event with the Arrow tool normally moves it – 
holding down a modifier key (by default [Alt]/[Option]) 
while dragging will copy it instead.

The default assignments for tool modifier keys can be 
found in the Preferences dialog (Editing–Tool Modifiers 
page). Here, you can also edit them:

1. Open the Preferences dialog and select the Editing–
Tool Modifiers page.
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2. Select an option in the Categories list, and locate the 
action for which you want to edit the modifier key.
For example, the “Copy” action mentioned above resides in the category 
“Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the 
Assign button.
The current modifier keys for the action are replaced. If the modifier keys 
you pressed are already assigned to another tool, you will be asked 
whether you want to overwrite them. If you do, this will leave the other 
tool without any modifier keys assigned.

5. When you’re done, click OK to apply the changes and 
close the dialog.

The default key commands
Below, the default key commands are listed according to 
category.

• Note that it is possible to switch key commands for 
menu items and other functions on and off, see “Turning 
key commands off” on page 582.

Audio category

Automation category

Devices category

Edit category

! Nuendo Expansion Kit only: When the Virtual Key-
board is displayed, the usual key commands are 
blocked because they are reserved for the Virtual Key-
board. The only exceptions are: [Ctrl]/[Command]-[S] 
(Save), Pad [*] (Start/Stop Record), [Space] (Start/
Stop Playback), Pad [1] (Jump to left locator), [Delete] 
or [Backspace] (Delete), Pad [/] (Cycle on/off), [F2] 
(Show/Hide Transport panel), and [Alt]/[Option]-[K] 
(Show/Hide Virtual Keyboard).

Option Key command

Adjust Fades to Range [A]

Auto-Grid [Shift]-[Q]

Crossfade [X]

Find Selected in Pool [Ctrl]/[Command]-[F]

Option Key command

Open Panel [F6]

Redo Pass [Ctrl]/[Command]-[Alt]/[Option]-
[Shift]-[Z]

Toggle Read Enable All Tracks [Alt]/[Option]-[R]

Toggle Write Enable All Tracks [Alt]/[Option]-[W]

Undo Pass [Ctrl]/[Command]-[Alt]/[Option]-[Z]

Option Key command

Mixer [F3]

Video [F8]

Virtual Keyboard 
(Nuendo Expansion Kit only)

[Alt]/[Option]-[K]

VST Connections [F4]

VST Instruments [F11]

VST Performance [F12]

Option Key command

Auto-Scroll [F]

Copy [Ctrl]/[Command]-[C]

Cut [Ctrl]/[Command]-[X]

Cut Time [Ctrl]/[Command]-[Shift]-[X]

Delete [Delete] or [Backspace]

Delete Time [Shift]-[Backspace]

Duplicate [Ctrl]/[Command]-[D]

Edit In-Place [Ctrl]/[Command]-[Shift]-[I]

Group [Ctrl]/[Command]-[G]

Insert Silence [Ctrl]/[Command]-[Shift]-[E]

Left Selection Side to Cursor [E]

Lock [Ctrl]/[Command]-[Shift]-[L]

Move to Cursor [Ctrl]/[Command]-[L]

Mute [M]

Mute Events [Shift]-[M]

Mute/Unmute Objects [Alt]/[Option]-[M]

Open Default Editor [Ctrl]/[Command]-[E]

Open Score Editor 
(Nuendo Expansion Kit only)

[Ctrl]/[Command]-[R]

Open/Close Editor [Return]
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Editors category

File category

Media category

MIDI category

Navigate category

Paste [Ctrl]/[Command]-[V]

Paste at Origin [Alt]/[Option]-[V]

Paste Time [Ctrl]/[Command]-[Shift]-[V]

Record Enable [R]

Redo [Ctrl]/[Command]-[Shift]-[Z]

Repeat [Ctrl]/[Command]-[K]

Right Selection Side to Cursor [D]

Select All [Ctrl]/[Command]-[A]

Select None [Ctrl]/[Command]-[Shift]-[A]

Snap On/Off [J]

Solo [S]

Split At Cursor [Alt]/[Option]-[X]

Split Range [Shift]-[X]

Undo [Ctrl]/[Command]-[Z]

Ungroup [Ctrl]/[Command]-[U]

Unlock [Ctrl]/[Command]-[Shift]-[U]

Unmute Events [Shift]-[U]

Option Key command

Show/Hide Infoview [Ctrl]/[Command]-[I]

Show/Hide Inspector [Alt]/[Option]-[I]

Show/Hide Overview [Alt]/[Option]-[O]

Option Key command

Close [Ctrl]/[Command]-[W]

New [Ctrl]/[Command]-[N]

Open [Ctrl]/[Command]-[O]

Quit [Ctrl]/[Command]-[Q]

Save [Ctrl]/[Command]-[S]

Save As [Ctrl]/[Command]-[Shift]-[S]

Save New Version [Ctrl]/[Command]-[Alt]/[Option]-[S]

Toggle Alternate Key Commands [#] or [Ctrl]/[Command]-[F5]

Option Key command

Option Key command

Open MediaBay [F5]

Preview Cycle On/Off [Shift]-Pad [/]

Preview Start [Shift]-[Enter]

Preview Stop [Shift]-Pad [0]

Search MediaBay [Shift]-[F5]

Option Key command

Quantize [Q]

Option Key command

Add Down:
Expand/Undo selection in the Project 
window to the bottom/ Move se-
lected event in the Key Editor down 
1 octave

[Shift]-[Down Arrow]

Add Left:
Expand/Undo selection in the Project 
window/Key Editor to the left

[Shift]-[Left Arrow]

Add Right:
Expand/Undo selection in the Project 
window/Key Editor to the right

[Shift]-[Right Arrow]

Add Up:
Expand/Undo selection in the Project 
window to the top/Move selected 
event in the Key Editor up one octave

[Shift]-[Up Arrow]

Down:
Select next in the Project window/
Move selected event in the Key 
Editor one semitone down

[Down Arrow]

Left:
Select next in the Project window/
Key Editor

[Left Arrow]

Right: 
Select next in the Project window/
Key Editor

[Right Arrow]

Up:
Select next in the Project window/ 
Move selected event in the Key 
Editor one semitone up

[Up Arrow]

Bottom
Select bottom track in the track list

[End]

Top: 
Select top track in the track list

[Home]

Toggle Selection [Ctrl]/[Command]-[Space]
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Nudge category

Project category

Tool category

Transport category
Option Key command

End Left [Alt]/[Option]-[Shift]-[Left Arrow]

End Right [Alt]/[Option]-[Shift]-[Right Arrow]

Left [Ctrl]/[Command]-[Left Arrow]

Right [Ctrl]/[Command]-[Right Arrow]

Start Left [Alt]/[Option]-[Left Arrow]

Start Right [Alt]/[Option]-[Right Arrow]

Option Key command

Open Browser [Ctrl]/[Command]-[B]

Open Markers [Ctrl]/[Command]-[M]

Open/Close Pool [Ctrl]/[Command]-[P]

Open Tempo Track Editor [Ctrl]/[Command]-[T]

Setup [Shift]-[S]

Show/Hide Track Colors [Shift]-[C]

Option Key command

Delete tool [5]

Draw tool [8]

Drumstick tool  
(Nuendo Expansion Kit only)

[0]

Glue tool [4]

Mute tool [7]

Next Tool [F10]

Play tool [9]

Previous Tool [F9]

Range tool [2]

Select tool [1]

Split tool [3]

Zoom tool [6]

Option Key command

Auto Punch In [I]

Auto Punch Out [O]

Cycle Pad [/]

Exchange time formats [.]

Fast Forward [Shift]-Pad [+]

Fast Rewind [Shift]-Pad [-]

Forward Pad [+]

Input Left Locator [Shift]-[L]

Input Position [Shift]-[P]

Input Right Locator [Shift]-[R]

Input Tempo [Shift]-[T]

Insert Marker [Insert] (Win)

Locate Next Event [N]

Locate Next Marker [Shift]-[N]

Locate Previous Event [B]

Locate Previous Marker [Shift]-[B]

Locate Selection [L]

Locators to Selection [P]

Loop Selection [Shift]-[G]

Metronome On [C]

Nudge Cursor Right [Ctrl]/[Command]-Pad [+]

Nudge Cursor Left [Ctrl]/[Command]-Pad [-]

Panel (Transport panel) [F2]

Play Selection Range [Alt]/[Option]-[Space]

Recall Cycle Marker 1 to 9 [Shift]-Pad [1] to Pad [9]

Record Pad [*]

Retrospective Record [Shift]-Pad [*]

Return to Zero Pad [.] or Pad [,] or Pad [;]

Rewind Pad [-]

Set Left Locator [Ctrl]/[Command]-Pad [1]

Set Marker 1 [Ctrl]/[Command]-[1]

Set Marker 2 [Ctrl]/[Command]-[2]

Set Marker 3 to 9 [Ctrl]/[Command]-Pad [3] to [9] or 
[Ctrl]/[Command]- [3] to [9]

Set Right Locator [Ctrl]/[Command]-Pad [2]

Start [Enter]

Start/Stop [Space]

Stop Pad [0]
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Windows category

Workspace category

Zoom category

To Left Locator Pad [1]

To Marker 1 [Shift]-[1]

To Marker 2 [Shift]-[2]

To Marker 3 to 9 Pad [3] to [9] or [Shift]-[3] to [9]

To Right Locator Pad [2]

Use External Sync [T]

Option Key command

Inline: Key Commands [Shift]-[F4]

Inline: Settings [Shift]-[F3]

Inline: View Layout [Shift]-[F2]

Lock/Unlock Active Workspaces [Alt]/[Option]-Pad [0]

New [Ctrl]/[Command]-Pad [0]

Organize [W]

Workspace 1 to 9 [Alt]/[Option]-Pad [1] to [9]

Option Key command

Lock/Unlock Active Workspace [Alt]/[Option]-Pad [0]

New [Ctrl]/[Command]-Pad [0]

Organize [W]

Workspace 1-9 [Alt]/[Option]-Pad [1-9]

Option Key command

Zoom Full [Shift]-[F]

Zoom In [H]

Zoom In Tracks [Alt]/[Option]-[Down Arrow]

Zoom Out [G]

Zoom Out Tracks [Alt]/[Option]-[Up Arrow] or 
[Ctrl]/[Command]-[Up Arrow]

Zoom to Event [Shift]-[E]

Zoom to Selection [Alt]/[Option]-[S]

Zoom Tracks Exclusive [Z] or [Ctrl]/[Command]- 
[Down Arrow]

Option Key command
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A
AAF files 537, 557
ACID® loops 294
Acoustic Feedback 410

Sample Editor 288
VariAudio 311

Activate next Marker Track 144
Activate Next/Previous Part 405
Activate previous Marker Track 144
Activate Project button 52
Active (Activating network) 484
ADAT Lightpipe 499
Add Track 61
Add WAN Connection 486
Adjust Fades to Range 113
Adjusting audio events to 

picture 541
Advanced Quantize 395
Advanced settings 25
AES/SPDIF Digital Audio 499
AES31 files 537, 558
Aftertouch

Deleting 421
Editing 419
Recording 106

AIFF files 478
Algorithm

Sample Editor 296
All MIDI Inputs 23
Alt/Option key 10
Alternative Key Sets 585
Any (MIDI channel settings) 104
Apogee UV22HR 201
Appearance 576

General 576
Meters 576

Apple Remote 371
Applying effects 273
Archiving 54, 332
Arranger tracks

Adding 123
Creating a chain 124
Flattening 126
Renaming events 123

ASIO
Direct Monitoring 21, 98

ASIO 2.0 21, 98

ASIO driver
About 13
DirectX Setup 13, 20
Externally clocked 20
Generic Low Latency driver 13
Installing 14

ASIO meter 25
Aspect ratio

Video Player window 527
Attributes

About 347
Defining 350
Editing in the MediaBay 348
Filtering marker attributes 140
Managing lists 350
Marker 139

Audio
Pull-down 531
Pull-up 531

Audio buffer size 25
Audio channels

Copying settings 166
Mixing down to file 474
Saving settings 168

Audio clips
About 264
Creating new versions 325
Definition 66
Deleting 325
Locating events 326
Managing in Pool 324
Opening in the Sample Editor 329

Audio clock
About 499

Audio effects
About 196
Applying 273
Editing 208
External 208
For output busses (Master 

inserts) 201
Freezing 202
Inserts 197
Organizing in subfolders 213
Post-fader inserts 197
Pre/Post-fader sends 205

Recording with 101
Saving 210
Selecting presets 209, 223
Sends 204
Surround 227
Tempo sync 197
Using VST System Link 518

Audio events
Copy selections 290
Create from regions 292
Cut selection 290
Definition 66
Editing in Browser 466
Editing in Sample Editor 284
Editing selections 290
Fade handles 113
Making selections 289
Paste selection 290
Show in Sample Editor 292
Slicing 300
Volume handles 114

Audio files
Converting 332
Deleting permanently 326
Exporting 474
Format for recording 93
Formats 329
Import options 65
Importing into Pool 329
Importing into Project window 64
Locating missing 328
Reconstructing missing 328
Removing missing 329

Audio hardware
Connections 17
Setup application 19

Audio loops
Tempo matching 294, 295

Audio parts
About 40
Creating by gluing events 72
Creating from events 65
Drawing 65
Editing in Audio Part Editor 315
Editing in Project Browser 466
Sliding contents 74

Audio to MIDI 311
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AudioWarp
About 293
Musical mode 293
Tab 285
Unstretch Audio 313

Auditioning
Acoustic Feedback 288
Audio Part Editor 317
MIDI editors 410
Pool 329
Project window 67
Sample Editor 288
Speaker tool 288
Using key commands 288, 317

Auto Adjust
Sample Editor 294

Auto Edit (9-Pin) 508
Auto Fades 120

Global settings 120
Track settings 121

Auto Monitoring modes 97
Auto Quantize 105
Auto Save 54
Auto Select Events under Cursor

MIDI editors 412
Project window 68

Automatic MIDI Record 
Quantize 105

Automation
Auto-Latch mode 249
Cross-Over mode 249
Delta indicator 241
Editing in Project Browser 468
Gap 246
Join 253
MIDI Controller 261
Opening automation tracks 243
Showing and hiding 243
SurroundPanner V5 236
Tempo 244, 456
Touch mode 249
Touch-collecting parameters 257
Trim 250

Automation events
About 240
Editing 242
Removing 242
Selecting 242

Automation follows Events 245
Automation Merge Modes 261
Automation tracks

Assigning parameters to 243
Hiding and showing 244
Muting 245

Auto-Scroll 50, 409
Crossfades 118
Sample Editor 293

B
Back up Project 54
Backup (.bak) files 54
Bank assignments 383
Bank Select 381
Bars+Beats Linear

MIDI editors 407
Batch export

Audio channels 474
Beat Calculator 458
Bit Resolution (Recording) 93
Bounce (Export Audio) 474
Bounce MIDI 399
Bounce Selection

Pool 330
Project window 75
Sample Editor 291

Brightness 576
Broadcast Wave files

Exporting 479
Recording 93

Busses
About 28
Adding 30
Adding child busses 31
Mixing down to file 474

Bypass
AudioWarp 311
Effect sends 206
Inserts 198
Pitch changes 311
SurroundPanner V5 236

C
Channel Overview 166

Insert effects 199
Channel Settings windows

Customizing 572
Channels

MIDI 103, 104
Chase events 88
Chatting options 495
Child busses 31

In surround configuration 229
Cleanup 55, 553
Click button 109
Clip packages

About 566
Creating (Exporting) 567
Importing 568
Previewing 567

Clips, see “Audio clips”
Clock sources 499
Close Gaps

Sample Editor 302
Close project 52
Color pop-up menu

MIDI editors 410
Project window 577

Color tool
Project window 578

Colorize Event Background 60
Committing changes 493
Computer keyboard display

Virtual Keyboard 89
Conforming

Audio to picture 537
EDLs 538
Files 333
Multi-channel media 537
Reference audio 537
To picture changes 541, 542

Connecting
Audio 17
MIDI 22

Constrain Delay Compensation 225
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Control Room
About 180
Configuring 180
Disabling 183
Exclusive port assignment 182
Features 180
Main Mix 188
Operations 180
Preferences 190
Suggested settings 189

Control Room channels
About 181
Creating 181
External inputs 182, 188
Inserts 187
Monitor sources 181
Monitors 181, 188
Phones 182
Studios 182
Talkback 182, 188

Control Room Mixer
Configuring 187
Monitor sources 188
Overview 184
Studio Sends 190

Control Room Overview 193
Controller display

About 408
Adding and removing lanes 417
Controller lane presets 418
Editing events 419
Editing velocity 418
Selecting event type 417

Controllers
Deleting 421
Editing 419
Recording 106
Showing 61

Convert Files 332
Convert to MIDI 312
Convert to Real Copy 71
Converting MIDI to CC track 

automation 402
Count-in 108
CPR files 52
Create Audio Images During 

Record 98

Create events (Cycle Rec Mode) 99
Create MIDI track when loading 

VSTi 216
Create new controller lane 417
Create Regions (Cycle Rec 

Mode) 100
Creating new projects 52
Crop 79
Crossfades

Auto Zoom 118
Auto-Scroll 118
Changing the length 119
Creating 116
Editing in dialog 117
Equal Gain 118
Equal Power 118
Move Audio 119
Move Fade 119
Nudging 119
Overlap 118
Presets 118
Removing 116
Resizing 119
Simple Crossfade Editor 117
Splice Point 118
Symmetric Fades 117

CSH files 54
CSV files

Exporting 148
Importing 147

Ctrl/Command key 10
Cursor, see “Project cursor”
Cut Head 71
Cut Tail 71
Cut Time 79
Cycle

About 86
Record modes 105
Recording 92
Recording audio 99
Recording MIDI 105

Cycle markers
About 137
Adding in Marker window 138

Drawing 143
Editing with tools 137
Resizing 143
Using 137
Zooming 137

D
DC Offset 271
Deactivate

Inserts 198
Deactivate Punch In on Stop 108
Default MIDI editor 404
Default output bus 31
Default permissions 488
Default template 53
Default track time type 63
Definition tab

Sample Editor 285
Delay compensation

About 197
Constraining 225

Delete
Audio files from disk 326
Continuous Controllers 400
Controllers 400
Doubles 400
Events in Project window 75
MIDI controllers 400, 421
MIDI notes 415
Notes 400
Time 79

Delete Overlaps
Audio 76, 101
Mono (MIDI) 401
Poly (MIDI) 401

Detect Silence 278
Device panels

About 386
Inspector 43
Mixer 161

Device ports
Selecting for busses 30
Setting up 29

Direct Monitoring
Control Room 194
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Direct Routing
About 171
Multiple destinations 172
Switching destinations 172

Disable Pitch Changes 311
Disable sends 206
Disable Track 87
Disable Warp Changes 298
Disk meter 25
Display format 47
Dissolve Part

Audio 65
MIDI 398

Dithering 201
Dividing the track list 63
Drag Delay 69
Draw

Hitpoints 300
In Sample Editor 292
MIDI controllers 419
MIDI notes 410
Parts 65

Drop-Frame
Video 536

Duplicate
Events and parts 71
MIDI notes 413
Tracks 62

E
Edit Active Part Only 405
Edit button

Audio channel strips 163
Audio track Inspector 42
MIDI channel strips 174
MIDI track Inspector 373

Edit Decision List, see “EDL”
Edit In-Place 422
Edit mode

Arrow tool 545
Nudge commands 546
Range selection tool 546
Video 545

Editing via MIDI 416
Edits folder 264
EDL

About 538
CMX3600 files 146

Importing 146
Recommendations 147
Scenes 146
Text editing 546

eLicenser
About 14
Control Center (eLC) 14
License Activation 14
License Transfer 14

Enable Record on Selected Track 91
Enable Solo on Selected Track 75
Enable Track 88
Enlarge Selected Track 59
Envelope

Process 266
Realtime 121

EQ
Bypassing 166
Making settings 164
Presets 166

Equal Gain
Crossfades 118

Equal Pitch (Selection) 412
Equal Power

Crossfades 118
Erase tool 75
Event as Region 79
Event envelopes

Video 544
Events

Aligning 69
Audio 66
Create from hitpoints 301
Duplicating 71
Envelopes 121
Grouping 74
Locking 74
Moving 69
Muting 75
Overlapping in audio part 316
Overlapping in Project window 69
Removing 75
Renaming 72
Renaming all on track 61
Resizing 72
Resizing with time stretch 73

Selecting 67
Sliding contents 74
Splitting 72

Events (Snap mode) 49
Events from Regions 79
Events to Part 65
Export Audio

Channel Selection 475
Cycle Marker 476
File Naming 476
Introduction 474
L/R Channels 478
Mono Downmix 477
Realtime Export 478
Sample Rate 477
Split Channels 477

Export Audio Mixdown 474, 475
Export Options (MIDI files) 560
Export selected tracks 562
Exporting

AAF 557
AES31 558
CSV files 148
Markers 145
Markers as track archive 150
Markers via MIDI 149
MIDI files 560
OMF 556
OpenTL file 559
Tempo track 456

External effects 208
About 32
Favorites 35
Freezing 35
Missing plug-ins 35
Setting up 33

External instruments
About 32
Favorites 35
Freezing 35
Missing plug-ins 35
Setting up 34

Externally clocked 58
Extract Audio from Video 528, 554
Extract MIDI (VariAudio) 311, 312
Extract MIDI Automation 402
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F
Fade handles 113
Fade In to Cursor 113
Fade In/Out functions 114
Fade Out to Cursor 113
Fades

Apply defaults 114
Auto Fades 120
Creating 113
Editing in dialog 115
Presets 115
Processing 114
Removing 114
With Range Selection tool 113

Feet and frames 536
Fill Loop 71
Film frames, see “Frames”
Film Transfers

About 529
Filter (MIDI) 107
Filter (Project Browser) 468
Filter bar 426
Find missing files 328
Find Selected in Pool 326
Firewall 483
FireWire DV Output 522
Fixed Lengths 400
Fixed Tempo 453
Fixed Velocity 402
Folder parts 66
Folder tracks

Moving tracks into 66
Muting and soloing 66

Frame count 498
Frame rates

Drop-Frame 536
Get From Video 523
Mismatch 523
Synchronization 498

Frames
Feet and frames 536
Film frames 536
Subframes 536

Free Warp
About 297
Using the Free Warp tool 297

Freeze
Edits 277
Quantize 396
Tracks 202
VST instruments 220

FX channel tracks
About 203
Adding effects for 203
Mixing down to file 474
Routing sends to 204
Setting up 203

FX channels
Setting up 32

G
Gain 267
Gap 246
Generic Low Latency driver 13
Generic Remote Device 369
Get exclusive access (lock 

track) 494
Global (Input Transformer) 441
Global IP Network 486
Glue Tool

MIDI editors 414
Project window 72

Grid (Snap mode) 48
Grid Relative (Snap mode) 49
Groove Quantize

From audio 301
Group 74
Group channel tracks

About 39
Using effects 201

Group channels 170
Setting up 32

Guest user 488

H
Hard disk

Considerations 24
Hardware setup

Control panel (Mac) 20
Control panel (Win) 20

Hitpoints
About 299
And tempo settings 300
Calculating 299
Close gaps 302
Create events 301
Create markers 301
Create regions 291, 301
Editing manually 300
Metric Bias 299
Tab 285
Use pop-up menu 299
Using 299

Horizontal Zooming Only 58

I
Importing

AAF 557
AES31 558
Audio CD 330
Audio files 64
Audio from Video file 554
CSV files 147
EDL files 146
Markers 145
Markers as track archive 150
Markers via MIDI 149
Medium in Pool 329
MIDI files 560
MPEG files 555
Ogg Vorbis files 555
OMF 556
OpenTL file 559
REX files 554
Tempo track 456
Track Archive 562
Video files 64, 523
WMA files 555
XSend 560

Impulse Response file 265
Independent track loop

Audio Part Editor 317
MIDI editors 409

Indicate Transpositions 133
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Info line
Customizing 572
Key Editor 407
Pool 322
Project window 45
Sample Editor 284

Initialize Channel 167
Input busses

About 28
Adding 30
Mixer 153

Input gain
About 158
Setting record level 96

Input levels 18, 96
Input phase

About 159
Input ports 21
Input selection

Multiple audio channels 169
Multiple MIDI channels 103

Input Transformer 440
Inputs

Audio 29
MIDI 103

Insert effect combinations
Saving 211

Insert effects (Audio) 197
Insert into Project 328

Video 543
Insert pop-up menu 425
Insert Silence

Project window 79
Sample Editor 290

Insert Velocity (MIDI Editors) 411
Inserts

Bypassing vs. deactivating 198
External inputs 188
Monitor channels 188
Side-Chain 208
Talkback channel 188

Inspector
Audio tracks 43
Customizing 572
Folder tracks 43
General controls 42

Handling 41
MIDI tracks 373
Subpanels 376
Transpose track 44

Inspector network controls 493
Instrument Freeze 220
Intensity (Appearance) 576
Interpolate Audio Images 287
Iterative Quantize 395

J
Jog wheel 87
Join options

Auto Join 253
Join indicator 253
Join now 253

Join project 492

K
Keep Last

Audio cycle recording 99
MIDI cycle recording 105

Key commands
About 581
Alternative Key Sets 585
Conventions 10
Default 587
Importing 585
Loading 585
Markers 145
Modifying 581
Removing 583
Resetting 585
Saving 584
Searching for 583

L
LAN 483, 485
Lanes

Audio Part Editor 316
Stacked Audio Recording 101
Stacked MIDI Recording 105

Latency 24
Monitoring 97
VST System Link 513

Left locator 86
Legato 400

Length
Adjustment 107
Compression 375
Crossfades 119
Quantize 411

Level faders 157
Level meters

Input 96
Post-fader mode 96
Settings 167

Level scale
Half level axis 286
Sample Editor 286

LFE
SurroundPanner V5 234

Libraries 332
Line mode

Automation 242
MIDI controllers 419
MIDI velocity 418

Linear Record Mode
Audio 98
MIDI 104

Linear time base 63
List Editor

Adding events 425
Editing in the list 425
Editing in the value display 427
Filtering 426

Loading changes 494
Local (Input Transformer) 441
Local On/Off 22
Locate when clicked in empty 

space 85
Locators 86
Lock 74
Lock Event Attributes 74
Lock Record 111
Logical Editor

About 432
Actions 438
Filter conditions 433
Functions 437
Opening 432
Presets 440
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Loop
Audio Part Editor 317
MIDI editors 409

M
M button 75
Mac OS X

Port activation 30
Port selection 30
Retrieving channel names 30

Machine control
About 497
Input source 506
Output destinations 504
Output settings 504
Preferences 506

Macros 583
Magnetic Area 393
Magnetic Cursor (Snap mode) 49
Magnifying Glass tool 58
Main Mix

Control Room 183
Setting up 31

Manual Adjust
Sample Editor 295

Map Input Bus Metering to Audio 
Track (in Direct Monitoring) 97

Marker IDs
Assigning to key commands 141
Reassigning 142

Marker list
Navigating 139

Marker track
Adding 142
Editing markers 142
Exporting CSV files 148
Importing CSV files 147
Importing EDL files 146
Moving 142
Multiple marker tracks 143
Removing 142
Scene detection 146

Marker window
Assigning marker IDs to key 

commands 141
Details view 141
Displaying attributes 139

Editing attributes 139
End column 139
Filter markers 138
Filtering attributes 140
ID column 139
Locate column 139
Position column 139
Reassign marker IDs 142
Reordering columns 140
Setting up attributes 140
Track pop-up menu 138
Type pop-up menu 138

Markers
About 44, 137
Adding cycle markers 142
Adding in Marker window 138
Adding on the fly 142
Attributes 139, 140, 141
Copying sections 143
Create from hitpoints 301
Drawing cycle markers 143
Drawing on marker track 142
Editing in Project Browser 469
Editing on marker track 142
Exporting 145
Exporting via MIDI 149
Exporting via track archive 150
Filtering in the Marker 

window 138
ID numbers 141
Importing 145
Importing EDL CMX3600 file 146
Importing track archives 150
Importing via MIDI 149
Key commands 145
Making range selections 143
Marker track 142
Marker window 138
Move to different track 138
Moving 138, 143
Moving sections 143
Project window 143
Range selection 143
Removing 138, 143
Resizing cycle markers 143
Selecting 142
Snapping to 49

Media interchange formats 537
MediaBay

About 335
Attribute filtering 346
Attribute Inspector 347
Boolean text search 341
Defining Locations 337, 338
Defining User Attributes 350
Editing attributes 348
Filter section 345
Key commands 353
Locations section 338
Logical filtering 345
Preferences 352
Preview section 342
Previewer section 342
Results section 339
Scanning operations 337
Sections 335
Showing/Hiding sections 335
Using external storage 

volumes 354
Volume databases 354
VST Sound node 337
Window layout 335

Memory 24
Menus

Customizing 575
Merge Clipboard 267
Merge MIDI in Loop 397
Merge Record Mode

Audio 98
MIDI 104

Merge Tempo from Tapping 402, 
459

Meters 167
Coloring of 576
Input level 96
Post-fader mode 96
Settings 167

Metric Bias
Hitpoints 299

Metronome
Activating 108
Precount 108
Settings 109
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MIDI
Channel Settings 174
Extract from Audio 311

MIDI Channel
Settings 104

MIDI channel
“Any” 104
Selecting for tracks 104
Send effects 378

MIDI clock
Destinations 507
Synchronization 500

MIDI Controller Automation 
Setup 262

MIDI Device Manager 381
MIDI devices

Defining new for patch 
selection 382

Editing patches 384
Installing 382
Selecting patches 384

MIDI effects
About 377
Deactivating 379
Inserts 377
Presets 378
Sends 378

MIDI files 560
MIDI filter 107
MIDI Input

MIDI editors 416
Sample Editor 308

MIDI Input Transformer 440
MIDI inputs

Renaming 103
Selecting for tracks 103

MIDI interface
Connecting 22
Installing 15

MIDI Modifiers 374
MIDI notes

Deleting 415
Drawing 410
Editing velocity 418
Moving 413
Muting 414
Quantizing 392

Resizing 414
Selecting 412
Splitting and gluing 414
Transpose (Function) 396
Transposing (in editor) 413

MIDI outputs
Renaming 103
Selecting for tracks 104
Send effects 378

MIDI parts
About 40
Drawing 65
Editing 404
Editing in Project Browser 467
Sliding contents 74

MIDI ports
Setting up 23

MIDI Record Catch Range 107
MIDI reset 106
MIDI Thru 103
MIDI Thru Active 22
MIDI timecode

Destinations 507
MIDI tracks

Channel Settings window 174
MIDI Modifiers 374
Settings 373

Minimize Files 331
Missing Ports dialog 52
Mix (Cycle Record mode) 105
MixConvert

Extended mixer view 161
In surround setups 237

Mixer
Audio channels 160
Channel strip width 157
Channel types 153, 155
Channel view sets 156
Common panel 154
Direct Routing 171
Extended channel strips 154, 155
Input gain 158
Input phase 159
Input/Output channels 153
Link/Unlink channels 175
MIDI channels 174
Multiple mixer windows 152

Opening 152
Panning 162
Saving settings 168
Solo and Mute 159
View options 155
Volume 157

Mixing down to audio file 474
MMC Master panel 505
Modifier keys 10, 586
Modulation

Virtual Keyboard 89
Monitor button

Audio tracks 97
MIDI tracks 103

Monitor sources
About 181
Selecting 188

Monitoring
About 21

Monitoring modes 97
Move Audio

Crossfades 119
Move Controller (Quantize 

setting) 394
Move Fade

Crossfades 119
Move Hitpoints 300
Move Markers to Track 138
Move to Back/Front 69
Move to Cursor 69
Move to Origin 69
MP3 files

Exporting 479
Importing 555

MPEG files
Audio 555
Video 521

MPEX
Pitch Shift 269
Time Stretch 273

Multi-channel tracks
Export 474
Split 563
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Multiple marker tracks
About 143
Activate next Marker Track 144
Activate previous Marker 

Track 144
Focussed track 143
Insert and name Marker 144
Locking 144
Naming 143
Selected track 143
Using 144

Multiple routing destinations 172
Musical Mode

Pool 293
Sample Editor 293

Musical time base 63
Mute

Events in Project window 75
MIDI notes 414
Mixer 159
Pre-Send 205
Surround channels 232
Tool 75
Tracks 75

My Shared Projects 491

N
NAT 484
Navigating

Marker list 139
NEK (Nuendo Expansion Kit) 10
Network name 484
Noise Gate 268
Non Quantize setting 394
Normal Record Mode

Audio 98
MIDI 104

Normal Sizing 72
Normalize

Audio effect 268
Note Velocity

Slider 411
Notes, see also “MIDI notes”
NPL files

Libraries 332
Pool files 332

NTSC
Video 536

Nudge buttons 87
Crossfades 119
MIDI editors 413
Project window 69

Numeric keypad 85

O
Octave Offset

Virtual Keyboard 89
Offline Process History 275
Offline processing

VariAudio 304
Ogg Vorbis files

Exporting 480
Importing 555

OMF files 537, 556
On Import Audio Files 65
On Processing Shared Clips 264
On Startup setting 56
Open Config App 20
Open Document Options dialog 56
Opening projects 52
OpenTL files 537, 559
Optimizing the hard disk

Windows 15
Option/Alt key 10
Output busses

About 28
Adding 30
Mixer 153
Mixing down to file 474
Surround 229

Output ports 21
Output selection

Multiple audio channels 169
Multiple MIDI channels 104

Outputs
Audio 29
MIDI 103

Over Quantize 394
Overlap

Crossfades 118
Overlapping events

Audio Part Editor 316
Project window 69

Override Project Permissions 489
Overwrite (Cycle Record mode) 105

P
Padlock symbol 74
Panning

Bypass 163
Multi-channel audio 163
Stereo Pan Law 162
Stereo pan modes 162

Parabola mode
Automation 242
MIDI controllers 420
MIDI velocity 418

Part Data mode 61
Parts, see “Audio parts” or “MIDI 

parts”
Paste at Origin 71
Paste Time

MIDI editing 414
Selection ranges 79

Patch Banks 383
Pattern banks

Previewing in MediaBay 344
Peak Hold Time (option) 167
Pedals to Note Length 401
Pencil tool 65
Permission preset

Creating in Project Sharing & 
Permissions dialog 489

Creating in User Manager 
dialog 487

Loading 490
Removing in User Manager 

dialog 488
Permissions

Default preset 488
Presets 487
Setting up for tracks 489
Setting up manually 489

Phase Reverse 268
Piano keyboard display

Virtual Keyboard 89
Pitch & Warp

Changing the pitch 306
VariAudio tab 306

Pitch Shift 269
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Pitchbend
Deleting 421
Editing 419
Recording 106
Virtual Keyboard 89

Placing audio events to picture
About 539
Four-point editing 540

Play tool
Project window 67

Playing back video 525
On computer screen 526
On external output device 525

Plug and Play
ASIO devices 19

Plug-in delay compensation 197
Plug-in Information window

MIDI plug-ins 379
VST plug-ins 213

Plug-ins
Applying 273
Getting info 213
Installing VST 2.x 212
Organizing 213
RAM limitation 24, 196
Surround 227

Poly Pressure events 422
Polyphony (Restricting) 401
Pool

About 321
Auditioning 329
Convert Files 332
Duplicating clips 325
Handling audio clips 324
Import Medium 329
Importing Pool files 332
Locate missing files 328
Record folder 331
Search Filters 327
Search Functionality 327
Searching for User Attributes 328
Status column icons 322

Popup Toolbox on Right Click 100
Position markers

About 137
Post-roll 108
Pre/Post-Crossfade 265

Precount 108
Pre-fader sends 205
Preferences

About 81
Popup Toolbox on Right 

Click 100
Presets 81
Transferring 579

Prepare Archive 54, 332
Pre-roll 108
Previewing

Track presets 358, 359
Prg field 384
Process Bars 457
Process tab

Sample Editor 286
Process Tempo 457
Processing

About 264
Plug-ins 273
Settings and functions 264
Undoing 275

Program Change 381
Project Browser 465
Project cursor

Auto-Scroll 50
Moving 85
Selecting events with 68
Snapping to 49

Project folder 491
Project Logical Editor

About 443
Actions 448
Filter conditions 444
Functions 450
Macros 450
Opening 443
Overview 443
Presets 450

Project overview line 46
Project scrubbing 87
Project Setup

Dialog 57
Synchronization settings 501

Projects 52
Activating 52
Auto Save (command) 54
Backup 54
Opening 52
Save as Template (command) 53
Saving 53
Template 53

Pull-down
Audio 531
Video 533

Pull-up
Audio 531
Video 533

Punch In 92
Punch Out 92

Q
Quantize

About 392
Applying 394
Automatic during recording 105
Creating grooves from audio 301
Ends 395
Lengths 395
Pitch (VariAudio) 307
Setting on toolbar 393
Setup dialog 393
Undo 395

Quick Zoom 59

R
RAM 24
Random (MIDI Modifier) 375
Random Quantize setting 394
Range (MIDI Modifier) 376
Range editing

Video 545
Range selection

Video 544
Range Selection tool 77
Range selection tool

Creating fades 113
Range tab

Sample Editor 286
RCP 483
Realtime Export 475, 478
Realtime mode (time stretch) 273
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Reconstruct 328
Record Catch Range 107
Record enable 91
Record file type 93
Record folder 95
Record format 93
Record mode

Audio 98
Lock 111
MIDI 104
Unlock 111

Record Time Max display 111
Recording

From busses 95
In MIDI editors 107
Levels 18
RAM limitation 24, 94
Tempo changes 456

Recovering recordings 111
ReCycle files 554
Redo Net Update 494
Redo Zoom 60
Regions

About 291
Auditioning 291
Create from Hitpoints 291, 301
Creating 291
Creating from events 79
Creating with Detect Silence 279
Editing 291
Exporting as audio files 292, 330
Removing 291

Relative snapping 49
Release Driver when Application is in 

Background 20
Remote control

Accessing user panels 369
Key commands 368
Setting up 367
Writing automation 368

Remove
Automation 242
Crossfades 116
DC Offset 271
Empty Tracks 62

Fades 114
Markers in the Marker window 138
Missing files 329
WAN Connection 486

Repeat
Events and parts 71
Loop 399
MIDI notes 413

Replace Audio in Video File 528
Replace Record Mode

Audio 98
MIDI 104

Rescan Network 486
Reset 106
Reset (VariAudio) 311
Reset Mixer 167
Resize crossfades 119
Restrict Polyphony 401
Retrospective Record 107
Return To Start Position on Stop 87
Reverse 272
Reverse (MIDI function) 402
Reverse shots

SurroundPanner V5 234
Revert 53
ReWire

About 549
Activating 550
Channels 551
Routing MIDI 551

REX files 554
Right locator 86
Root key 131
Routing

Direct Routing 171
Effect sends 204
Effect sends (Panning) 206
For surround setup 229
Group channels 170

Ruler
About 47
Adding additional time scales 47
Ruler tracks 47
Sample Editor 286

S
S button 75
Sample Editor

Audio clip information 284
AudioWarp tab 285
Audition 288
Definition tab 285
Free Warp 297
General operations 287
Hitpoints tab 285
Info line 284
Inspector 284
MIDI Input 308
Opening 284
Options and settings 292
Overview 286
Process tab 286
Range tab 286
Regions 291
Ruler 286
Toolbar 284
VariAudio tab 285
Zooming 287

Sample rates 58
Save 53
Save New Version 53
Scissors tool

MIDI editors 414
Project window 72

Scrubbing
Events in Project window 67
Events in Sample Editor 288
Project 87

Search Functionality in Pool 327
Search key commands 583
Segments

Changing note start/end 
point 305

Cutting segments 305
Deleting 306
Gluing 305
Moving horizontally 306
Saving the segmentation 306
VariAudio 304

Select Tool
Show Extra Info 40
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Selecting
Events in Project window 67
MIDI notes 412

Send effects (Audio) 203
Set Pool Record Folder 331
Set Record Folder 95
Set root key for unassigned 

events 131
Share project 490
Shared copy 71
Show All Used Automation 245
Show Audio Event 292
Show Controllers 61
Show Data on Small Track 

Heights 61
Show Event Names 60
Show Event Volume Curves 

Always 113
Show Filter View 426
Show Part Borders 405
Show Timecode Subframes 536
Shuffle (Snap mode) 49
Side-Chain

Drag & drop 208
Using 207

Signal levels 96
Silence 272
Simple Crossfade Editor 117
Sine mode

Automation 242
MIDI editing 420

Sizing Applies Time Stretch 73
Sizing Moves Contents 72
Slices

About 299
Creating 299, 300

SMPTE
Drop-Frame 536
Timecode 536
Time-of-day 536

Snap
MIDI editors 410
Project window 48
Sample Editor 292
Track Heights 59

Snap MIDI Parts to Bars 107

Snap point
Setting for clips in Pool 329
Setting in Project window 48
Setting in Sample Editor 288

Snap to Zero Crossing
Audio Part Editor 319
Preference setting 49
Sample Editor 292

Solo
Audio Part Editor 317
Folder tracks 66
MIDI editors 409
Mixer 159
On Selected Track 75
Surround channels 232
Tracks 75

Solo Defeat 159
Solo Record in MIDI Editors 107
Sound Designer II and 

Networking 483
Sound sources

Position in surround field 231
Speaker icon

MIDI editors 410
Speaker tool

Audio Part Editor 317
Project window 67
Sample Editor 288

Spectrum Analyzer 279
Splice Point 118

Offset 119
Split at Cursor

MIDI editors 414
Project window 72

Split Loop
MIDI editors 414
Project window 72

Splitting
Events 72
MIDI Events 72
Range 79
Tracks 563

Spotting list 543
Square mode

Automation 242
MIDI editing 420

Stacked Cycle Recording
Audio 101
MIDI 105

Start Record at Left Locator 92
Startup options 56
Static Value Line (Automation) 240
Stationary cursors 50
Statistics 281
Step Bar (Key command) 85
Step Input 416
Stereo Flip 272
Stereo Pan Law 162
Stereo panning 162
Stop after Automatic Punch Out 108
Straighten Pitch (VariAudio) 308
Strip Silence 279
Studio Connections 389
Studio Cue Mix 191
Studio Manager 389
Studio Sends

Adjusting the volume 192
Configuring 190
Outputs 193
Studio Cue Mix 191

Surround
About 227
Applying plug-ins 227
Automation 236
Counter shots 234
Disable speakers 232
Exporting to file 238
Inspector 230
LFE level 230, 234
MixConvert 237
Mixer 230
Output bus configuration 229
Panning 233
Positioning sounds 230
Routing 229
Setup 18
Solo/Mute speakers 232
Supported configurations 227
SurroundPanner V5 230

SurroundPanner V5
About 230
Constant power 237
Pinning mode 237
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Suspend Auto-Scroll 50
Sample Editor 293

Suspend VST3 plug-in processing 
when no audio signals are 
received (VST3) 196, 221

Swing 393
Sample Editor 296

Sync Selection 466
Synchronization

9-Pin devices 502
About 497
Audio to picture 537
Nuendo SyncStation 503
Operation (Sync mode) 508
Phase 500
Recording in Sync mode 92
Setting up 500
Speed references 499
Timecode 497
Timecode preferences 503
Timecode source 502

System Exclusive
About 427
Bulk Dumps 428
Editing 429
Recording parameter changes 429

T
Tap Tempo 458
TCP/IP 483
Telecine process

About 529
Templates 53
Tempo

About 453
Calculating 458
Editing 455
Editing in Project Browser 469
Importing and exporting 456
Setting in Fixed mode 456
Tapping 458

Tempo based tracks 63
Tempo maps

Video 542
With Time Warp tool 542

Tempo matching audio 293
Tempo recording 244, 456

Thick Fade Lines 113
Thin Out Data 402
Thumbnails

About 524
Manually generating thumbnail 

cache files 525
Thumbnail cache files 524
Thumbnail Memory Cache 

Size 524
Tilting the micro pitch curve 307
Time based tracks 63
Time Display 536
Time display 85, 536
Time format 47
Time Linear

MIDI editors 407
Time Scales 47
Time Signature

About 453
Editing 456

Time Stretch 272
Time Warp tool 459

Tempo maps to picture 542
Timecode

SMPTE 536
Standards 498
Synchronization 497

Time-of-day
SMPTE 536

Toggle Track List 63
Tool modifier keys 586
Toolbar

Audio Part Editor 315
Customizing 572
Key Editor 406
List Editor 424
Pool 322
Project window 44
Sample Editor 284

Toolbox
On right click 100

Track Archive
Importing 562

Track Controls Settings 573

Track list
About 41
Customizing 573
Dividing 63

Track list network controls 493
Track pop-up menu

Markers 138
Track presets

Previewing 358, 359
Removing 358

Track Quick Controls 371
About 363
Assigning parameters 363
Controlling the Mixer 364
Remote Control setup 364
Removing 363
Renaming 363
Replacing 363

Track Sheet 471
Track types 39
Tracks

Adding 61
Audio channel configuration 94
Changing the height 59
Disabling/Enabling 87
Freezing 202
Importing/Exporting 562
Locking 74
Musical/Linear time base 63
Removing 62
Selecting 62

Transfer Status 487
Transferring

Projects and settings 579
Tracks between projects 562

Transformer (MIDI effect) 432
Transparent events 61
Transport menu

Functions 84
Playback options 88

Transport panel
Customizing 572
Display format 85
Hiding and showing 84
Key commands 85
Overview 84
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Transpose
Info line 46
MIDI function 396
MIDI Modifier 374

Transpose track
About 130

Triangle mode
Automation 242
MIDI editing 420

Trim buttons 73
Trim tool 408
Tuplet

Quantize Setup 393
Type pop-up menu 138

U
UDP 483
Undo

Processing 275
Quantize 395
Recording 98
Zoom 60

Undo Net Update 494
Ungroup 74
Unlock 74
Unlock Record 111
Unshare Selected Project 491
Unstretch Audio 313
Update Origin 322
USB-eLicenser

About 14
Use File Extension in File Dialog 53
Use Mouse Wheel for Event volume 

and Fades 113
Use Selected ASIO Ports for Data 

only 516
User name 484, 485
User panels 43

Audio tracks 161
Users in Local Network 486
UV22HR 201

V
VariAudio

About 302
Applying editing 304
Audition 311
Bypass 311

Changing the pitch 306
Changing the timing 309
Editing Pitch/Warp 306
Editing segments 304
Extract MIDI 311
Quantize Pitch 307
Reset 311
Segments 302
Straighten Pitch 308
Waveform display 302

VariAudio tab
Sample Editor 285

Velocity
Editing 418
Editing via MIDI 416
Info line 46
MIDI function 401
Virtual Keyboard 89

Velocity Compression 375
Velocity Shift

MIDI Modifier 375
Verify Communication 486, 494
Video

Adding Sound 539
Adjusting audio events to 

picture 541
Adopting frame rate 523
Aspect Ratio 527
Audio pull-up/pull-down 531
AVI 521
Bi-level signals 499
Codecs 521
Conforming production audio 537
Conforming to picture 

changes 541
Container formats 521
Device Setup 525
DV 521
Edit mode 545
Editing 527
EDL 538
Event envelopes 544
Event handles 543
Extracting audio from 528
File compatibility 521
Four-point editing 540
Importing 523

Insert into Project 543
MOV 521
MPEG-1 521
MPEG-2 521
MPEG-4 521
Muting 524
Output devices 522
Picture changes 541
Placing audio events to 

picture 539
Playback 525
Pull-down 533
Pull-up 533
QT 521
Replace audio 528
Scrubbing 527
Show Frame Numbers 524
Show Thumbnails 524
Synchronization 499
Tempo maps 542
Text editing 546
Thumbnails 524
Tracks 524
Tri-level signals 499
Using the Marker window 543
VOB 521
Working with ranges 544, 545

Video frames, see “Frames”
Video Player window 526

Aspect ratio 527
Setting the video quality 526
Setting the window size 526

Video timeline 536
Video track

Editing in Project Browser 468
Virtual Keyboard

About 89
Computer keyboard display 89
Description 89
Modulation 89
Note velocity level 89
Octave Offset 89
Piano keyboard display 89
Pitchbend 89

Volume curve 121
Volume handle 114
VPN 484
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VST
Input ports 21
Output ports 21

VST 3
Suspend VST3 plug-in 

processing when no audio 
signals are received 196, 221

VST Audio System 19
VST Channel Settings 163
VST Connections 28

About 28
Editing 36
Exclusive port assignment 182
Presets 31
Studio tab 181

VST instrument channel
Setting up 216

VST instruments
Activating 217
Browsing for sounds 222
Channels 217
Freezing 220
Presets for instruments 221
Saving presets 224
Using VST System Link 518

VST Performance window 25
VST plug-ins

Getting info 213
Installing 212

VST presets
Removing 358

VST System Link
About 512
Activating 514
Connections 513
Latency 513
MIDI 516
Putting computers online 515
Requirements 512
Setting up sync 513
Settings 514

W
WAN 483, 485
Warp tabs

Creating from hitpoints 298
Deleting 298
Editing 298
Moving 298
Moving insert position 298
Reset 298

Warping segments
VariAudio 309

Wave files 479
Wave64 files 479
Waveform display

Sample Editor 286
Waveform zooming 59
Window layouts 571
Windows

Defragmenting 15
Windows Media Audio files

Exporting 480
Importing 480, 555
Surround format (Pro) 480

WMA files
Importing 555

WMA Pro files 480
Word clock

About 499
Workspaces 571
Wrap Controls (Track list) 59

X
XSend

Installing 560

Z
Zero Crossings 49
Zoom N Tracks 59
Zoom Tool Standard Mode 58
Zoom while Locating in Time 

Scale 58
Zooming

About 58
History 60
Presets 60
Sample Editor 287
To cycle markers 137
Track height 59
Waveforms 59
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